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Quick Start Guide

Logging into the Web Service
The web server captures data from the DXM Controller using either a cellular connection or an Ethernet connection. Users collect
and view the data or update and manage the DXM Controller using a web browser.

Within a few minutes of your purchase, you will receive an email with your authorization code and details regarding the data
subscription service. If the authorization code is not received within 10 minutes, please check your spam folder or contact Banner
Engineering at 1-888-373-6767 to obtain the code.

Use both the website and the DXM Configuration Software to set up and configure your data collection. Use the latest version of
your browser (Google Chrome is recommended) and enter the URL: https://bannercds.com. The login page appears.

 

 

Create an Account
Follow these steps to create an account.

1. Click on Sign Up.
2. Click on Enter Authorization Code and Create Account.
3. A prompt will appear requesting the Authorization Code that was delivered in an email, an Email address, Company name,

User Name, and Password.
4. Click Sign Up and agree to the Terms & Conditions when prompted.

Create a New Gateway
After you log into the Banner Cloud Data Services website, the Gateway screen displays. Follow these steps to create a new
monitoring site.

1. Click on +New Gateway.

Create a new Gateway/site for each device that will be sending data to the web server.

 

 

A Create New Gateway prompt appears.
2. Verify Traditional is selected for the Configuration.
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3. Enter a site name.
4. Click Create.

The Gateway/Site appears in the listing of devices on the Gateways screen.
5. Click Edit Gateway (pencil icon) next to your Gateway/Site name.

The Gateway detail window appears.
6. Copy the Site ID number located at the top of this window.

The Site ID number created by the web server is a required parameter in the configuration of the DXM Controller. The Site
ID is the address the webserver uses to store the data pushed from the DXM Controller.

7. Click Save.

Modifying the XML Configuration File
Use the DXM Configuration Software to configure the operation of the DXM Controller.

Launch the DXM Configuration Software software. You can use one of these three screens to modify registers:

• Local Registers—Edits individual registers
• Modify Multiple Registers—Edits multiple registers at the same time
• Local Registers in Use—Edits individual registers

Refer to the DXM Configuration Software Instruction Manual for more details.

Edit Registers Using the Local Registers in Use Screen
Use this screen to modify the parameters of any local registers being used.

 

 
1. Go to the Local Registers > Local Registers in Use > Edit Register section of the bottom of the screen.

A list of the local registers being used displays.
2. Under the Selected Register box, select the register to define or modify. You may select the register by using the up/down

arrows, directly entering a register number into the field, or clicking within the corresponding row in the Local Registers in
Use table.
Only Local Registers that have already been changed from their default configuration are displayed in the Local Registers
In Use table.

3. Using the drop-down lists, assign a name, register group, change the units, or make other configuration changes to this
register.

4. To push register values to the web server, set Cloud Permissions to read.
If Cloud Permissions are set to Read, the web server only views data from the device and cannot write data to the device.
If the permissions are set to Write, the web server only writes to the device and cannot read the data. If the permissions are
set to Read/Write, the web server can read the data from the device and write to the device from the web.

The changes are automatically applied within the software, not the XML file. To change another register, use the up or down arrows
to select another register number. To save these changes to the XML file, go to File > Save.

Modify Multiple Registers
Modify a range of registers from the Local Registers > Local Registers in Use > Modify Multiple Registers screen.

Select which parameter fields to modify. Most parameters have three selections.
• Unchanged—no changes
• Default—change to default settings
• Set—modify parameter. Other selections will appear based on the parameter.

Figure 1. Modify Multiple Registers screen
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1. Enter the Starting register and Ending register.
2. Select the value to change using the drop-down list next to each value.
3. Enter the new value in the field provided.
4. To push register values to the web server, set Cloud Permissions to read.

If the Cloud Permissions are set to Read, the web server only views data from the device and cannot write data to the
device. If the permissions are set to Write, the web server only writes to the device and cannot read the data. If the
permissions are set to Read/Write, the web server can read the data from the device and write to the device from the web.

5. Click Modify Registers to save and apply the changes.

Configure the Cloud Settings
1. To configure the connection to the web server, go to the Settings > Cloud Services screen.

 

 
2. Copy and paste the Site ID.

The Site ID is that long string of numbers and letters from the Banner Cloud Data Services website.
3. Verify the Server Name/IP is set to push.bannercds.com and the Page is set to /push.aspx for sending to the website.

To push to the demo website, set the Server Name/IP to demopush.sensonix.net.
4. Set the Cloud Push Interval to a value appropriate for your application.

The Cloud Push Interval determines how often the device pushes the data to the web. The faster the push interval, the
more data is sent to the site. Cellular plans can only push at an interval of 5 minutes or longer, while Ethernet connections
can push at an interval of 1 minute or longer. The Sample Count specifies how many times the data is gathered within the
Cloud Push Interval.

For example, if the Cloud Push Interval is 15 minutes and the Sample Count is set to 3, then during each data push (every
15 minutes), 3 samples are sent to the web. This is one sample every 5 minutes.

5. Save the configuration file by going to File > Save.

File names must be no more than 30 characters long, and should not contain any spaces or special characters.
6. With a USB cable connected to the device, go to the Device > Connection Settings menu.
7. Select the appropriate Comm Port and click Connect.
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If multiple comm ports are visible, try each one until the software is able to connect to the device.

8. Go to Device > Send Configuration to the Device to upload the new XML file.

Upload the XML Configuration File to the Website
To upload an XML configuration file to the website, follow these instructions.

1. At the webserver, select the Home screen.
 

 
2. On the row displaying your new site, click the Edit Gateway (pencil) icon.
3. Select Update XML.
4. Click Choose File and select the file that was just updated to the DXM and click Save.

Figure 2. Example file selection screen that may not represent your specific kit

After the XML file is loaded into the webserver, the webserver uses the register names and configurations defined in the
configuration file.

5. Click on the Site Name link to go to the configured registers to see the values uploaded by the DXM Controller.
The same XML configuration files is now loaded on both the DXM Controller and the Website. After some time, the data
should be seen on the website.

Completing these steps creates continuity between the site created on the website with the DXM used in the field. The DXM
pushes data to the website, which can be viewed at any time.

Refer to the Banner Cloud Data Services Instruction Manual to review all the features available for monitoring, comparing data, and
establishing warnings/alarms on the website. To access a demo version of the website please contact your local Banner distributor
and follow the instructions in the technical note: Connecting to the Banner Cloud Data Services Demo Site for modified instructions
on how to send data to the demo site.

Web Services Features
For more information on each of these features, see the Banner Cloud Data Services (CDS) Instruction Manual.

Compare Graphs of Multiple Registers—Compare two or more register values on the same time graph.

Create FTP Backups or Download Data for Backup—Back up registers, upload logs, alarms, updates, and audits to an FTP
address that can be accessed with a username and password created by the user.

Create New Companies and Users—This feature is only available with certain subscriptions. Limits may be placed on the number
of companies or users a subscription can have.

Create Spreadsheet Tables—Create data tables to view numbers in a spreadsheet-style format.

  Banner Cloud Data Services
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Set Alarms—Set alarms when a register reaches or is compared to a certain numerical value. Alarms can also be used for
connectivity problems, MAC alerts, geofence alerts, or register limits. If an alarm is activated, emails can be sent automatically to
preset addresses.

Updating Script or XML via Web—Download an XML file from the DXM or upload a new XML to the DXM without having the device
connected to a computer via USB.

Use Log Viewer for Viewing Past Data—Display graphs of data logged to the SD card, backed up previously to an FTP site, or
downloaded.

View Graph of Individual Registers—View a graph of register values over time.

Write to Registers via Website—Set Cloud Permissions to Write or Read/Write in the DXM Configuration to write to the DXM from
the website. Instead of using the LCD on the DXM or waiting for an input value, users can write certain register values directly to
the DXM from the cloud site.

Banner Engineering Corp. Software Copyright Notice
This software is protected by copyright, trade secret, and other intellectual property laws. You are only granted the right to use the software and only for the purposes described by
Banner. Banner reserves all other rights in this software. For so long as you have obtained an authorized copy of this software directly from Banner, Banner grants you a limited,
nonexclusive, nontransferable right and license to use this software.

You agree not to use, nor permit any third party to use, this software or content in a manner that violates any applicable law, regulation or terms of use under this Agreement. You agree
that you will not reproduce, modify, copy, deconstruct, sell, trade or resell this software or make it available to any file-sharing or application hosting service.

Disclaimer of Warranties. Your use of this software is entirely at your own risk, except as described in this agreement. This software is provided "AS-IS." To the maximum extent permitted
by applicable law, Banner, it affiliates, and its channel partners disclaim all warranties, expressed or implied, including any warranty that the software is fit for a particular purpose, title,
merchantability, data loss, non-interference with or non-infringement of any intellectual property rights, or the accuracy, reliability, quality or content in or linked to the services. Banner
and its affiliates and channel partners do not warrant that the services are secure, free from bugs, viruses, interruption, errors, theft or destruction. If the exclusions for implied warranties
do not apply to you, any implied warranties are limited to 60 days from the date of first use of this software.

Limitation of Liability and Indemnity. Banner, its affiliates and channel partners are not liable for indirect, special, incidental, punitive or consequential damages, damages relating to
corruption, security, loss or theft of data, viruses, spyware, loss of business, revenue, profits, or investment, or use of software or hardware that does not meet Banner minimum systems
requirements. The above limitations apply even if Banner and its affiliates and channel partners have been advised of the possibility of such damages. This Agreement sets forth the entire
liability of Banner, its affiliates and your exclusive remedy with respect to the software use. You agree to indemnify and hold Banner and its affiliates and channel partners harmless from
any and all claims, liability and expenses, including reasonable attorney's fees and costs, arising out of your use of the Services or breach of this Agreement (collectively referred to as
"Claims"). Banner reserves the right at its sole discretion and at its own expense, to assume the exclusive defense and control of any Claims. You agree to reasonably cooperate as
requested by Banner in defense of any Claims.
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1 System Overview

1.1 System Overview for the B1 Models
Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for
the Industrial Internet of Things (IIoT).
 

Connectivity
Cellular

Sure Cross Radios
Ethernet

USB
RS-485 Master
RS-485 Slave

RS-232
CAN

User Interface
LCD Screen

LED Indicators

I/O
Universal Inputs
Discrete Outputs
Courtesy Power
Switch Power

Logic Controller
Action Rules

Programming Language
Scheduler

Push to the Cloud
Data Logging

SMS and Email
SMS Control

 

Inputs/Outputs—On-board universal and programmable I/O ports connect to local sensors, indicators, and control
equipment.

• Universal Inputs
• Discrete outputs
• Courtesy power
• Switch power
• Battery backup
• Solar controller

Connectivity—The DXM's wired and wireless connectivity options make it easy to share data between local and remote
equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing
and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and
control equipment.

Wired Connectivity
Ethernet: Modbus TCP or Ethernet/IP
Field Bus: Modbus RS-485 Master/Slave, RS-232, or
Controller Area Network (CAN)

Wireless Connectivity
Sure Cross Wireless Radio: DX80 900 MHz, DX80
2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4 GHz
Cellular modem: LTE (United States) or GSM (outside
the United States)

Logic Controller—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute
concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller
supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation
systems.

Action Rules
Supports simple logic, arithmetic and thresholding
Use for low complexity solutions
SMS text message Notifications
E-mail Notifications
Push data on conditions

Text Programming Language
ScriptBasic
Use when Action Rules can't supply a solution

Scheduler
Time/calendar-based events
Astronomical clock

Data Logging
Cyclic Data/Event logging
E-mail log files

SMS Commanding
Read/Write Local Registers
Upload data to the cloud-based data service
Reboot controller
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User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system
status and setup, view user selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure
the user programmable LEDs to indicate the status of the DXM, processes, or equipment.

User programmable LCD
Binding Sure Cross radios
Conducting a Site Survey
Viewing sensor information
Viewing the system's status

User Defined LED indicators

1.2 System Overview for the B2 Models
Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for
the Industrial Internet of Things (IIoT).
 

Connectivity
Cellular

Sure Cross Radios
Ethernet

USB
RS-485 Master
RS-485 Slave

User Interface
LCD Screen

LED Indicators

I/O
Universal Inputs
Discrete Outputs
Courtesy Power
Switch Power

DC Latching Outputs
Analog Outputs

SDI-12 Sensor Interface

Logic Controller
Action Rules

Programming Language
Scheduler

Push to the Cloud
Data Logging

SMS and Email
SMS Control

 

Inputs/Outputs—On-board universal and programmable I/O ports connect to local sensors, indicators, and control
equipment.

• Universal Inputs
• Discrete outputs
• Courtesy power
• Switch power

• Battery backup
• Solar controller
• DC latching outputs
• SDI-12 sensor interface

Connectivity—The DXM's wired and wireless connectivity options make it easy to share data between local and remote
equipment. The cellular modem option eliminates the need for IT infrastructures to connect remote equipment for sensing
and control. The integrated Sure Cross® wireless radio enables Modbus connectivity to remote sensors, indicators, and
control equipment.

Wired Connectivity
Ethernet: Modbus/TCP or Ethernet/IP
Field Bus: Modbus RS-485 Master/Slave

Wireless Connectivity
Sure Cross Wireless Radio: DX80 900 MHz, DX80
2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4 GHz
Cellular modem: LTE (United States) or GSM (outside
the United States)

Logic Controller—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute
concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller
supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation
systems.
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Action Rules
Supports simple logic, arithmetic and thresholding
Use for low complexity solutions
SMS text message Notifications
E-mail Notifications
Push data on conditions

Text Programming Language
ScriptBasic
Use when Action Rules cannot supply a solution

Scheduler
Time/calendar-based events
Astronomical clock

Data Logging
Cyclic Data/Event logging
E-mail log files

SMS Commanding
Read/Write Local Registers
Upload data to the cloud-based data service
Reboot controller

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system
status and setup, view user selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure
the user programmable LEDs to indicate the status of the DXM, processes, or equipment.

User programmable LCD
Binding Sure Cross radios
Conducting a Site Survey
Viewing sensor Information
Viewing the system's status

User Defined LED indicators

1.3 Hardware Overview
The DXM can have several different configurations. The DXM has a model number label on the housing. Use the model
number and model table to identify which boards are included in the your controller.
 

B1 =  

Radio Configuration

 

B1
Base

DXM100- R1

Modbus controller for data aggregation of sensors
and wireless networks
Power: 12−30  V DC/Solar/Battery
Comms: RS-485, CAN, RS-232 w/flow or secondary RS-485 
Inputs: (4) universal IN
Outputs: (4) NMOS OUT, (2) analog OUT (0–10 V or 4–20 mA)
Power Out: (2) Selected 5 V or 16 V switched power, 
(1) 5 V courtesy power

Blank = None
R1 = 900 MHz, 1 W PE5 Performance Radio (North America)
R2 = 900 MHz, 1 W HE5 MultiHop Data Radio (North America)
R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)
R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)
R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)
R8 = 900 MHz, Performance Radios approved for Australia/New Zealand
R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand 

 
 

B1 =  

Radio Configuration

 

B1
Base

DXM1000- R1

Modbus controller for data aggregation of sensors
and wireless networks
Power: 12−30  V DC / Solar / Battery
Comms: RS-485, CAN, RS-232 w/flow or secondary RS-485 
Inputs: (4) universal IN
Outputs: (4) NMOS OUT, (2) analog OUT (0–10 V or 4–20 mA)
Power Out: (2) Selected 5 V or 16 V switched power, 
(1) 5 V courtesy power

Blank = None
R1 = 900 MHz, 1 W PE5 Performance Radio (North America)
R2 = 900 MHz, 1 W HE5 MultiHop Data Radio (North America)
R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)
R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)
R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)
R8 = 900 MHz, Performance Radios approved for Australia/New Zealand
R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand 
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B2 =  

Radio Configuration

 

B2
Base

DXM100- R1

Blank = None
R1 = 900 MHz, 1 W PE5 Performance Radio (North America)
R2 = 900 MHz, 1 W HE5 MultiHop Data Radio (North America)
R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)
R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)
R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)
R8 = 900 MHz, Performance Radios approved for Australia/New Zealand
R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand 

Smart valve control, SDI-12 data collection
Power: 12−30 V DC/Solar/Battery
Comms: RS-485, (1) SDI-12 sensor interface
Inputs: (4) universal IN
Outputs: (4) NMOS OUT, (2) 0-10 V analog, (2) DC Latching
Power Out: (2) Adjustable 5 V to 24 V switched power, 
(1) SDI switched power, and (1) 5 V courtesy power

 
 

B2 =  

Radio Configuration

 

B2
Base

DXM1000- R1

Blank = None
R1 = 900 MHz, 1 W PE5 Performance Radio (North America)
R2 = 900 MHz, 1 W HE5 MultiHop Data Radio (North America)
R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)
R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)
R5 = 900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)
R8 = 900 MHz, Performance Radios approved for Australia/New Zealand
R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand 

Smart valve control, SDI-12 data collection
Power: 12−30 V DC / Solar / Battery
Comms: RS-485, (1) SDI-12 sensor interface
Inputs: (4) universal IN
Outputs: (4) NMOS OUT, (2) 0-10 V analog, (2) DC Latching
Power Out: (2) Adjustable 5 V to 24 V switched power, 
(1) SDI switched power, and (1) 5 V courtesy power

 
Not all combinations of base boards and radios are supported.

Important:
• Electrostatic discharge (ESD) sensitive device
• ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
• Use proper handling procedures to prevent ESD damage. Proper handling procedures include

leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and
assembling units on a grounded, static-dissipative surface.
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Cellular Modem Board

Processor Board

MultiHop or Gateway
Radio Board

DXM100 I/O Base Board

Cellular Antenna
Connection

ISM Radio
Antenna

Connection

Housing Catch

 
The DXM100 I/O Base Board is shown. The DXM1000 I/O Base Board is similar.
I/O Base Board—The DXM I/O base board provides connections for all inputs, outputs and power. The I/O base board
contains a 12 V solar controller that accepts connections to a solar panel and sealed lead acid (SLA) battery. The battery
connection can also be used with line power to provide a battery backup in case of line power outages.
ISM Radio—The ISM radio, either a MultiHop or DX80 Gateway, fits on the I/O base board in the parallel sockets. Install the
ISM radio so the U.FL antenna connection is to the side with the SMA antenna connectors. Connect the U.FL cable from the
ISM radio U.FL to the right side U.FL connector. The ISM radio boards are available with either a 900 MHz radio (North
America) or a 2.4 GHz radio (world-wide).
Processor—The processor board plugs into the base board using the two 20 pin socket connectors. The board sits above
the ISM radio socket and held by the base board standoffs. Position the processor board so the USB and RJ45 Ethernet
connection is to the front, away from the SMA antenna connections.
Cellular Modem (Optional)—The optional cellular modem (purchased separately) board plugs into the processor board with
the U.FL antenna connection to the left. Attach the antenna cable from the cellular modem to the left U.FL connection on the
base board.
In some DXM models, the cellular modem may be replaced with an ISM radio. In this configuration, position the top ISM radio
antenna connection to the left of the SMA antenna connector.
LCD (Display) Board—The top housing contains the LCD board. The display board is connected to the base board using a
ribbon cable with a 20 pin connector.

1.4 DXM Configuration Software
Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on
using the DXM Configuration Software, refer to the instruction manual (p/n 209933).
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Figure 1. Overview of the configuration software features

USB
Ethernet

DXM Configuration Software

Local Registers

Register 
View Utility

System
Settings

Register Mapping

Scheduler

Action Rules

Script Basic

XML Config File

The configuration software configures the DXM by creating an XML file that is transferred to the DXM using a USB or
Ethernet connection. The DXM can also receive the XML configuration file from a Web server using a cellular or Ethernet
connection.
This configuration file governs all aspects of the DXM operation.
The wireless network devices are a separate configurable system. Use the DX80 User Configuration Software to configure
the internal DX80 wireless Gateway and the attached wireless Nodes. Use the MultiHop Configuration Software if the internal
radio is a MultiHop device.
All tools can be connected to the DXM using a USB cable or an Ethernet connection.

1.5 DXM Automation Protocols
The DXM supports the following automation protocols.

Modbus RTU
The DXM manages two separate physical ports running the Modbus RTU protocol. The DXM is the Modbus Master
when operating the Modbus master RTU port. The DXM uses the master Modbus RTU bus to communicate with
locally connected Modbus devices or uses the Banner wireless radio to communicate with remote Modbus devices.
The other Modbus RTU port is used by a host system to access the DXM as a slave device. The slave Modbus RTU
port allows access all the internal registers concurrently with the master RTU port. Set the slave Modbus ID using
the LCD menu: SYSTEM CONFIG > DXM Modbus ID.
By default, the Modbus RTU ports are active. Configure the port parameters using the configuration software.

Modbus TCP/IP
A host system acting as a Modbus master can access the DXM using the Modbus TCP/IP protocol over Ethernet.
Standard Modbus port 502 is used by the DXM for all Modbus TCP/IP requests.
All internal registers are available to the host system concurrently with Modbus RTU.
By default, Modbus TCP/IP is active. Configure the DXM using Modbus TCP rules in the configuration software.

EtherNet/IP™

The Ethernet port is actively running EtherNet/IP. From the factory the DXM is configured to read and write registers
on DX80 wireless devices 1 through 16. Custom configurations can be set using the configuration software.
By default, EtherNet/IP is active.
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1.6 DXM Modbus Overview
The DXM uses internal 32-bit registers to store information. The processor's internal Local Registers serve as the main global
pool of registers and are used as the common data exchange mechanism. External Modbus device registers can be read into
the Local Registers or written from the local data registers.
The DXM, as a Modbus master or slave, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP)
uses the Local Registers as the accessible register data.
Using Action, Read/Write, and Threshold Rules allows you to manipulate the processor's Local Registers. The ScriptBasic
programming capabilities extends the use of Local Registers with variables to create a flexible programming solution for more
complex applications.
The processor's Local Registers are divided into three different types: integer, floating point, and non-volatile. When using
Local Registers internally, the user can store 32-bit numbers. Using Local Registers with external Modbus devices follows the
Modbus standard of a 16-bit holding register. Local Registers are accessible as Modbus ID 199.
Accessing the I/O base board and the LCD follows the same communication as an external Modbus device. Each device has
an ID number to uniquely identify itself. The I/O base board is Modbus ID 200 and the LCD is Modbus ID 201.

Figure 2. Overview of the DXM Modbus processor

Local Registers
(Modbus ID 199)

DXM Processor

Modbus Data
Traffic Control

Local Registers
Non-Volatile

Local Registers
Float

Local Registers
Integer 

Gateway or MultiHop
(Slave ID 1)

LCD (Slave ID 201)

I/O Base Board
(Slave ID 200)

Action Rules
Read/Write Rules
ScriptBasic
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2 Quick Start Guide

2.1 Device Setup

2.1.1 Apply Power to the Controller
Follow these instructions to apply 12–30 V DC power to the controller using a wall plug.
Equipment used:

• DXM Wireless Controller
• MQDMC-401 0.3 m (1 ft) cordset with a 4-pin M12/Euro-style quick disconnect fitting
• PSW-24-1 Wall plug power supply; 24 V DC, 1 A

Important:
• Never operate a 1 Watt radio without connecting an antenna
• Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
• To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure

Cross MultiHop (1 Watt) radio without an antenna connected.

1. Connect the brown wire from the MQDMC-401 cordset to the DXM's PW (+ power) terminal.
2. Connect the blue wire from the MQDMC-401 cordset to the DXM's GD (- ground) terminal.
3. Connect the PSW-24-1 power supply to the MQDMC-401 cordset.
4. Plug in the PSW-24-1 wall plug power supply.

2.1.2 Binding and Conducting a Site Survey with the ISM Radio
Before the ISM radio can communicate, the ISM radio within the DXM must be bound to the other radios in the wireless
network.
Use the DXM LCD menu to bind external radios to the internal ISM radio.
If you are having difficulty running binding or site surveys, it may be because of the speed of the XML configuration file or
script running on the DXM. To resolve this issue, try one of the following options:

• Disable the XML and script by setting DIP switch 4 on the processor board to ON and cycling the power to the DXM.
After binding the devices, turn DIP switch 4 back OFF and cycle power again to return to normal operation of the XML
and script.

• Adjust the XML or script to slow down the RTU read or write rules.
• Upload a blank XML, bind all devices, then upload the configured XML file.

Bind a DX80 Node to a DXM and Assign the Node Address
Binding Nodes to a Gateway ensures the Nodes only exchange data with the Gateway they are bound to. After a Gateway
enters binding mode, the Gateway automatically generates and transmits a unique extended addressing (XADR), or binding,
code to all Nodes within range that are also in binding mode. The extended addressing (binding) code defines the network,
and all radios within a network must use the same code.

1. Apply power to all the devices.
Separate radios by two meters when running the binding procedure. Put only one DXM Gateway into binding mode at
a time to prevent binding to the wrong Gateway.

2. Enter binding mode on the DXM radio:
a) Use the arrow keys to select the ISM Radio menu on the LCD and press ENTER.
b) Highlight the Binding menu and press ENTER.

3. Assign the Node address to the Node.
• For Nodes without rotary dials: Use the DXM arrow keys to select the Node address to assign to the DX80 Node

about to enter binding mode. The DXM assigns this Node address to the next Node that enters binding mode.
Only bind one Node at a time.

• For Nodes with rotary dials: Use the Node's rotary dials to assign a valid decimal Node Address (between 01 and
47). The left rotary dial represents the tens digit (0 through 4) and the right dial represents the ones digit (0
through 9) of the Node Address. You can leave the DXM "Bind to" address set to 1 because the Node's rotary
dials will override that setting.

4. Start binding mode on the DXM radio by pressing ENTER on the DXM radio.
5. Enter binding mode on the DX80 Node.

• For housed radios, triple-click button 2.
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• For board-level radios, triple-click the button.
• For Nodes without buttons, refer to the Node's datasheet for instructions on entering binding mode.
The left and right LEDs flash alternately and the Node searches for a Gateway in binding mode. After the Node binds,
the LEDs stay solid momentarily, then they flash together four times. The Node automatically exits binding mode and
reboots.

6. Label the Node with the assigned address number for future reference.
7. Press BACK on the DXM to exit binding mode for that specific Node address.

The Node LEDs continue to flash red until the DXM exits binding mode with that Node address.
8. Repeat these steps for as many DX80 Nodes as are needed for your network.
9. When you are finished binding, press BACK on the DXM until you return to the main menu.

Bind a MultiHop Radio to a DXM and Assign the Device ID
Before beginning the binding procedure, apply power to all the devices. Separate radios by two (2) meters when running
binding procedure. Put only one DXM MultiHop master radio into binding mode at a time to prevent binding the slave radios
to the wrong master radio.
Binding MultiHop radios ensures all MultiHop radios within a network communicate only with other radios within the same
network. The MultiHop radio master automatically generates a unique binding code when the radio master enters binding
mode. This code is then transmitted to all radios within range that are also in binding mode. After a repeater/slave is bound,
the repeater/slave radio accepts data only from the master to which it is bound. The binding code defines the network, and all
radios within a network must use the same binding code.

1. Enter binding mode on the DXM radio:
a) Use the arrow keys select the ISM Radio menu on the LCD and press ENTER.
b) Highlight the Binding menu and press ENTER.

2. Assign the device address to the repeater or slave radios. Valid device IDs are 11 through 60.
• For MultiHop radios without rotary dials: Use the DXM arrow keys to select the device ID to assign to the MultiHop

radio about to enter binding mode. The DXM assigns this device ID to the next radio that enters binding mode.
Only bind one slave radio at a time.

• For MultiHop radios with rotary dials: Use the MultiHop radio's rotary dials to assign a device ID . The left rotary
dial represents the tens digit (1 through 6) and the right dial represents the ones digit (0 through 9) of the device
ID. You can leave the DXM "Bind to" address set to 1 because the MultiHop's rotary dials will override that setting.

3. Start binding mode on the DXM radio by pressing ENTER on the DXM radio.
4. After entering binding mode on the DXM, put the MultiHop repeater or slave radio into binding mode.

• For housed radios, triple-click button 2.
• For board-level radios, triple-click the button.
• For radios without buttons, refer to the radio's datasheet for instructions on entering binding mode.
After binding is completed, the MultiHop radio automatically exits binding mode and begins operation.

5. Press BACK on the DXM to exit binding mode for that specific device address.
The Multihop radio's LEDs continue to flash red until the DXM exits binding mode with that MultiHop radio.

6. Label the MultiHop radio with the assigned address number for future reference.
7. Repeat these steps, changing the device address, for as many MultiHop radios as are needed for your network.
8. When you are finished binding, press BACK on the DXM until you return to the main menu.

All radio devices begin to form the network after the master data radio exits binding mode.

Conduct a Site Survey from the DXM
Conduct a Site Survey to verify the wireless communication between the radios within your wireless network. Conduct the
site survey when the Nodes and DXM Controller are at the proposed installation sites to determine each radio's signal
strength with the DXM.
For a DX80 network, the Gateway controls the site survey and the results display on the LCD. Running a site survey on a
DX80 network does not affect the throughput of the DX80 network. The DX80 Gateway-Node system can run a site survey
analysis while the network is operational. For a MulitHop network, the master device passes the site survey request to the
intended Modbus slave device. The Site Survey runs and the results display on the LCD. Running a site survey on a
MultiHop network stops all network traffic to that device.

1. On the DXM: Use the arrow buttons to select the ISM Radio menu and press ENTER.
2. Select the Site Survey menu and press ENTER.
3. Use the Up or Down arrows to select the device ID number and press ENTER to run the site survey with that radio.

The site survey results display as green, yellow, red, and missed packets. Green indicates the highest signal
strength, then yellow, and red. Missed packets were not received.

4. When you are finished running the Site Survey, press Back twice to return to the main menu and exit site survey
mode.
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If the Site Survey fails (100 missed packets), verify the radios are at least 10 feet from the DXM and/or rerun the binding
procedure. If you find poor signal quality, common solutions include moving the DXM to a more central location relative to the
Nodes or using higher-gain antennas on the DXM. Contact your local Banner Engineering representative for assistance.

2.1.3 Set a Static IP Address
Change the IP address of the DXM to connect to a local area network, Modbus TCP/IP host controller, or EtherNet/IP host
controller.
There are two ways to set the IP address: using the DXM's LCD menu or using the configuration software to change the XML
file. IP addresses entered into the LCD menu system override the IP addresses in the XML configuration files. To use the IP
addresses set in the XML configuration file, clear the IP addresses from the menu system.

Figure 3. System Config menu options

System Config
to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓
Ethernet DHCP Update DHCP Mode

IP: 
SN: 
GW: 
Reset

Update IP Address
Update SN
Update GW Address
Resets Ethernet parameters
to xml defaults.

After making changes to the 
Ethernet settings, restart the DXM.

1. On the DXM, use the arrows and move to the System Config menu. Press ENTER.
2. Use the arrow keys to select the Ethernet menu. Press ENTER.
3. Highlight the DHCP selection and press ENTER. Set DHCP to OFF.
4. The system will request a restart, press ENTER to confirm.
5. Follow steps 1 and 2 to reenter the Ethernet menu. Use the arrow keys to select IP. Press ENTER.

The IP address displays (for example, 192.168.0.1).
6. Use the up and down arrows to change the IP address. Press ENTER to move to the next octet.
7. Press ENTER on the final octet to accept the changes.
8. Cycle power to the DXM.

The changes are saved on the DXM and the new IP address will be used.
Use this same procedures to set the subnet mask (SN) and default gateway (GW) to match your network requirements. Your
IT department can provide these settings if needed.

2.2 Configuration Instructions

2.2.1 Configuring the Controller
Configure the DXM using the configuration software.
To configure the DXM, connect the DXM's USB or Ethernet port to a computer.
The DXM Configuration Software allows the user to define parameters for the
DXM, then saves the configuration in an XML file on the PC.
After the configuration file is saved, upload the XML configuration file to the
DXM for operation.
This quick start guide outlines the basic operations to set up a DXM using the
configuration software. For a more comprehensive explanation of features,
refer to the DXM Configuration Software Instruction Manual (p/n 209933).

Figure 4. DXM Configuration Software
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DXM Configuration Software
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View Utility
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2.2.2 Introduction to Traditional Setup Mode
This section will walk you through the traditional method of setting up the DXM Configuration Software and communicating
with a connected DXM device. Version 4 of the configuration software supports multiple DXM device models, each of which
incorporates different features.
As of DXM Configuration Software v4.10.28, the Simple Setup procedure is only available with the DXM100, DXM700, 
DXM1000, DXM1200, and DXM1500 models.
As soon as a DXM model is connected to your computer, the software automatically detects the correct model and loads the
appropriate screens. You may also manually select which model of DXM you are configuring if you intend to create a
configuration file without connecting a device. This ensures that the interface and the configuration file use the correct
features.
Not all screens are available for all models. To change to another model of DXM, go to the Connect to DXM screen and use
the drop-down list to select another model. If the active configuration is incompatible with the selected model, you will be
prompted to either proceed and wipe out the active configuration or cancel the model change and preserve the configuration.

Figure 5. Traditional Setup opening screen

Connect via USB or Ethernet. If connecting via Ethernet, set network parameters through the DXM LCD menu in the System
Cfg > Ethernet menu. Network parameters can also be set within the configuration software. Setting parameters on the LCD
menu overrides the parameters stored in the configuration file. To use the network parameters in the configuration file, reset
the network parameters on the DXM LCD menu.
Since the DXM-R90x connects only via TCP, its Connect to DXM screen differs from the other DXM models. When the
Select DXM Model drop-down is set to DXM-R90x, a new network discovery table is displayed. Click Scan Network for
DXMs to detect DXM devices on the host computer's network. Discovered DXMs are listed in the network discovery table.
Double-click any row entry to connect to that DXM. If the DXM's IP address is already known, the standard TCP connection
option is available below the network discovery table.
Banner recommends disconnecting the COMM port through the Device menu before turning off power or disconnecting the
USB cable. Use Device > Reboot to restart the DXM if needed; the tool automatically disconnects the COMM port, then
reconnect it again.

Tip: If connection attempts are failing (Application Status Icon in the footer of the tool is Red), close the
configuration software and disconnect the USB cable from the computer. Reconnect the cable, launch the
software, and attempt connecting again.

If you cannot connect to your DXM Controller, refer to for more information.

Important: Any model of DXM may connect to the configuration software regardless of which device model
is selected in the tool. Compatibility is checked before configuration files are uploaded to the device.

Configuration Example: Reading Registers on a Modbus Slave Device
The local registers are the main global pool of registers that are defined by the user to store data within the DXM. The local
registers are listed on the Local Registers > Local Registers in Use screen.
The bottom status bar displays the communications status, application status, and the DXM Configuration Software version.
In this short example, we will configure the DXM to read six registers on an external Modbus Slave device and save the data
into the local registers.
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Important: The software only loads a file to the DXM. Internal parameter settings that are changed in the
tool but not saved to the file will not be sent to the device.

Modify Multiple Registers
Modify a range of registers from the Local Registers > Local Registers in Use > Modify Multiple Registers screen.
Select which parameter fields to modify. Most parameters have three selections.

• Unchanged—no changes
• Default—change to default settings
• Set—modify parameter. Other selections will appear based on the parameter.

Figure 6. Modify Multiple Registers screen

1. Enter the Starting register and Ending register.
2. Select the value to change using the drop-down list next to each value.
3. Enter the new value in the field provided.
4. To push register values to the web server, set Cloud Permissions to read.

If the Cloud Permissions are set to Read, the web server only views data from the device and cannot write data to
the device. If the permissions are set to Write, the web server only writes to the device and cannot read the data. If
the permissions are set to Read/Write, the web server can read the data from the device and write to the device from
the web.

5. Click Modify Registers to save and apply the changes.

Define an RTU Read Rule
Follow these steps to create a new read rule.
This example screen shows a read rule created to read six registers (address 1 through 6), from Modbus Slave 4. The results
are stored in the Local Registers 1 through 6.

Figure 7. Read Rules - Configuration Example

1. From the Register Mapping > RTU > RTU Read screen, click Add Read Rule.
2. Click the arrow next to the name to display the parameters.
3. Name your rule.
4. Select the slave ID.
5. Select how many registers to read, and the beginning register.
6. Define the register type, how often to read the register, and any other appropriate parameters.
7. If necessary, select the error condition. For this example, if the read function fails after three attempts, the read rule

writes 12345 to the DXM local registers. Notice the list of local register names this read rule is using.
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Set the Time
Use the Settings > System screen to define the time zone and daylight saving option. The time zone and DST options are
saved into the configuration file.

Figure 8. Settings > System > Device Time

1. Go to the Settings > System screen.
2. If you connect the DXM to a computer, click Sync PC Time with Device to set the time on the DXM to match the

time of the computer.
3. Set your time zone and select whether or not your device observes daylight saving time (DST).

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.
Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending
the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving the
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File > Save As menu.
2. Go to the DXM > Send XML Configuration to DXM menu.

Figure 9. Status indicator bar

• If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in the
cable and reconnect the DXM to the software.

• If the Application Status indicator is green, the file upload is complete.
• If the Application Status indicator is yellow, the file transfer is in progress.
The device reboots and begins running the new configuration.

2.3 Banner Engineering Corp. Limited Warranty
Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner Engineering Corp. will
repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been defective during the warranty period. This
warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner product.
THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF
DEALING OR TRADE USAGE.
This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING CORP. BE
LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT, WHETHER
ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.
Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any product
previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for personal protection
applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior express approval by
Banner Engineering Corp will void the product warranties. All specifications published in this document are subject to change; Banner reserves the right to modify product
specifications or update documentation at any time. Specifications and product information in English supersede that which is provided in any other language. For the most
recent version of any documentation, refer to: www.bannerengineering.com.
For patent information, see www.bannerengineering.com/patents.
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3 ISM Radio Board (Slave ID 1)
Plug the ISM radio into the I/O base board with the U.FL antenna connector closest to the SMA connectors. Typically, users
will not need to adjust the DIP switch settings on the physical radio modules.
For the DXM1200 models, set the radio options using the LCD menu.

Figure 10. ISM radio board
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Button Operation
For DXM models without a LCD display, use the button to bind the ISM radio. For models with a LCD display, use
the ISM menu to bind the radio.

LED Operation
The LED located on the ISM radio module indicates power and communications traffic. ISM board LED operations
also display on the LED on the right side of the I/O base board.

• Solid green DX80 ISM radio LED indicates power.
• Flashing green MultiHop ISM radio LED indicates operation.
• Red and green combined: Communications traffic and binding.

3.1 MultiHop Radio DIP Switches
MultiHop ISM radio devices are defined with R2, R4, and R5 in the model number.

• DXMxxx-xxR2 - MultiHop 900 MHz
• DXMxxx-xxR4 - MultiHop 2.4 GHz
• DXMxxx-xxR5 - MultiHop 900 MHz, 100 mW
• DXMxxx-xxR9 - MultiHop 900 MHz, (Australia)

Making changes to the baud or parity settings requires that you make the same settings to the Modbus Master
Communications section within the DXM Configuration Software (Settings > General.

Important: Disabling the serial port disables the ISM radio in the DXM. Selecting Transparent mode
causes radio communications to be slower and denies access to device I/O register data.
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Table 1: DIP switch settings

D1 Switches D2 Switches

Device Settings 1 2 3 4 1 2 3 4

Serial line baud rate 19200 OR User defined receiver
slots

OFF* OFF*

Serial line baud rate 38400 OR 32 receiver slots OFF ON

Serial line baud rate 9600 OR 128 receiver slots ON OFF

Serial line baud rate Custom OR 4 receiver slots ON ON

Parity: None OFF* OFF*

Parity: Even OFF ON

Parity: Odd ON OFF

Disable serial (low power mode) and enable the receiver
slots select for switches 1-2

ON ON

Transmit power

900 MHz radios: 1.00 Watt (30 dBm)
2.4 GHz radios: 0.065 Watts (18 dBm) and 60 ms
frame

OFF

Transmit power

900 MHz radios: 0.25 Watts (24 dBm)
2.4 GHz radios: 0.065 Watts (18 dBm) and 40 ms
frame

ON *

Application mode: Modbus OFF*

Application mode: Transparent ON

MultiHop radio setting: Repeater OFF OFF

MultiHop radio setting: Master OFF ON

MultiHop radio setting: Slave ON OFF

MultiHop radio setting: DXM LCD Menu Control ON * ON *

* Default configuration. The default settings for D2 DIP switches 1, 3, and 4 are ON. This allows for forcing the device into
Master mode and DXM menu control for the radio power settings.

3.1.1 Application Mode
The MultiHop radio operates in either Modbus mode or transparent mode. Use the internal DIP switches to select the mode
of operation. All MultiHop radios within a wireless network must be in the same mode.
Modbus mode uses the Modbus protocol for routing packets. In Modbus mode, a routing table is stored in each parent
device to optimize the radio traffic. This allows for point to point communication in a multiple data radio network and
acknowledgement/retry of radio packets. To access a radio's I/O, the radios must be running in Modbus mode.
In transparent application mode, all incoming packets are stored, then broadcast to all connected data radios. The data
communication is packet based and not specific to any protocol. The application layer is responsible for data integrity. For
one to one data radios it is possible to enable broadcast acknowledgement of the data packets to provide better throughput.
In transparent mode, there is no access to the radio's I/O.

3.1.2 Baud Rate and Parity
The baud rate (bits per second) is the data transmission rate between the device and whatever it is physically wired to. Set
the parity to match the parity of the device you are wired to.

3.1.3 Disable Serial
Disable an unused local serial connection to reduce the power consumption of a data radio powered from the solar assembly
or from batteries. All radio communications remain operational.
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3.1.4 Transmit Power Levels/Frame Size
The 900 MHz data radios can be operated at 1 watt (30 dBm) or 0.250 watt (24 dBm). For most models, the default transmit
power is 1 watt.
For 2.4 GHz radios, the transmit power is fixed at 0.065 watt (18 dBm) and DIP switch 5 is used to set the frame timing. The
default position (OFF) sets the frame timing to 60 milliseconds. To increase throughput, set the frame timing to 40
milliseconds. For battery-powered devices, increasing the throughput decreases battery life.

Important: Prior to date code 15341 and radio firmware version 3.6, the frame timing was 40 ms (OFF) or
20 ms (ON).

3.2 DIP Switch Settings for the Performance Gateway Radio Module
The 900 MHz radios transmit at 1 Watt (30 dBm) or 250 mW (24 dBm). The 250 mW mode reduces the radio's range but
improves the battery life in short range applications. For 2.4 GHz models, this DIP switch is disabled. The transmit power for
2.4 GHz is fixed at about 65 mW EIRP (18 dBm).
DX80 Performance Gateway ISM radio devices are defined with R1, R3, and R8 in the model number.

• DXMxxx-xxR1 - DX80 Performance 900MHz
• DXMxxx-xxR3 - DX80 Performance 2.4GHz
• DXMxxx-xxR8 - DX80 Performance 900MHz (Australia)

Important: To adjust the transmit power on the Gateway radio, Banner recommends using the LCD menu
(System Conf > ISM Radio > RF CNTRL).

Figure 11. DIP switch bank 1 and bank 2
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Table 2: DIP switch settings for bank 1 (D1)

DIP Switch
1

OFF 1 Watt (30 dBm, 900 MHz models only) (default configuration)

ON 250 mW (24 dBm, 900 MHz models only), DX80 compatibility
mode
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4 Processor Board

4.1 Processor Board for the DXM1x0 Models
Figure 12. Processor board for the DXM
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Table 3: Processor board features

Callout Description Function

A
Cellular modem
connection

Install the cellular modem onto the processor board with the cellular modem's U.FL connector on the left. The
antenna cable will go between the cellular U.FL connector and the left I/O base board U.FL connector. Always
disconnect the power to the device before installing or removing a cellular modem.

B Button
Use the processor board button to force a cloud push. To force a push to the cloud, press and hold this button
for five (5) seconds to send an immediate push message from the device (if properly configured).

C Boot load jumpers

D DIP switches

E Micro SD card

F LED 1 Heartbeat, indicates the processor is running

G LED 2
Indicates the cellular modem power cutoff is active; if the incoming power is less than 11.2 V, the cellular modem
is powered down

H LED 3
XML configuration file was rejected; or file load in process; or the second phase of boot loading is in process
(flashing)

I LED 4
ScriptBasic program failed to load; or the beginning phase of boot loading is in process (flashing = in process, on
= complete)
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4.2 Processor Board for the DXM1x00 Models

1

1 ON

A

A

D

E
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C

F

A - Cellular modem connection
B - Bootload
C - LED
D - DIP switches
E - Micro SD card

Cellular Modem Connection—Install the cellular modem onto the processor board with the cellular modem's U.FL
connector on the left. The antenna cable will go between the cellular U.FL connector and the left I/O base board U.FL
connector. Always disconnect the power to the device before installing or removing a cellular modem.
Button Operation—Pressing and holding the button down during power up puts the processor into manual programming
mode. Programming requires Microchip SAM-BA programming application. To force a push to the cloud, press and hold this
button for five (5) seconds to send an immediate push message from the device (if properly configured)
LED Operation—The single LED indicates the processor is running.

• Flashing green—Processor is running
• Single red flash at power up time—Bootloader is present
• Toggling Red/Orange—Bootloader is examining the new file
• Toggling Red/Green—Bootloader is loading the new image

4.3 DIP Switch Settings for the Processor Board
After making changes to the DIP switch settings, cycle power to the device.
Table 4: DIP switches for the DXM processor board

Settings
DIP Switches

1 2 3 4

Disable Ethernet Port
OFF *

ON

Disable LCD Display
OFF *

ON

Not used OFF *

Bypass XML
OFF *

ON

Bypass XML
Turn on to have the XML file ignored at boot time. This is useful for ignoring a corrupt or questionable XML
configuration file. After the device is running, a new XML file can be loaded using the DXM configuration tool.
Turn on to stop the processor from executing defined configuration. This is useful if the loaded configuration is using
all the processing time and not allowing DXM Configuration Tool operations.
The factory default position is OFF.
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Disable Ethernet Port
Set to on to power down the Ethernet interface. Disabling the unused Ethernet port reduces power consumption.
The factory default position is OFF.

Disable LCD Display
Set to on to disable the LCD. This DIP switch should be on when the LCD display board is not connected.
The factory default position is OFF.

4.4 Ethernet
Before applying power to the DXM, verify the Ethernet cable is connected.
The number of times the processor attempts to connect to the Ethernet network is configured in the DXM Configuration
Software (Settings > Network Ethernet Connection Acquisition). The default setting is two retries one minute after the
device boots up another retry two minutes later.
The Ethernet connection supports the DXM Configuration Software, Modbus/TCP, and EtherNet/IP. ScriptBasic also has
access to Ethernet for custom programming. Use the software or LCD menu system to configure the characteristics of the
Ethernet connection, including the IP address. Any parameters not changeable from the menu system are configurable from
the configuration software.
Ethernet parameter changes entered through the LCD menu override the XML configuration parameters. To return to using
the network settings in the XML configuration file, remove the Ethernet parameters defined by the LCD menu using the
System Config > Ethernet > Reset menu.

4.5 USB
The USB port is used with the DXM Configuration Software to program the DXM100/1000-Bx Wireless Controller. The USB
port is also used as the console output for the processor and ScriptBasic.
Turn on debug messages to the serial console by selecting Print push debug messages to serial console in the DXM
Configuration Software Settings > Cloud Services screen.
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5 I/O Base Boards

5.1 I/O Base Board Connections for the B1 Models
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J

K
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1 18

1932

mA

V

A OUT 2
A OUT 1M

L

1 No connection 12 CT. RS-232 CTS 23 N3. NMOS OUT 3

2 PW. 12 to 30 V dc or solar power in (+) 13 S-. Secondary RS-485 – 24 N2. NMOS OUT 2

3 GD. Ground 14 S+. Secondary RS-485 + 25 N1. NMOS OUT 1

4 B+. Battery in (< 15 V dc) 15 CL. CANL 26 GD. Ground

5 GD. Ground 16 CH. CANH 27 U4. Universal Input 4

6 M-. Primary RS-485 – 17 GD. GND 28 U3. Universal Input 3

7 M+. Primary RS-485 + 18 P3. Courtesy Power 5 V 29 GD. Ground

8 GD. Ground 19 A2. Analog OUT 2 30
P1. Adjustable Courtesy Power (5 V or
16 V)

9 TX. RS-232 Tx 20 A1. Analog OUT 1 31 U2. Universal Input 2

10 RX. RS-232 Rx 21
P2. Adjustable Courtesy Power (5 V or
16 V)

32 U1. Universal Input 1

11 RT. RS-232 RTS 22 N4. NMOS OUT 4

A Base board LED E
Jumpers - Configures Analog Out 1
and 2 for mA or V

J Modbus Slave ID DIP Switches

B A1. Cellular or secondary antenna F Radio Binding Button K Modbus Slave ID DIP Switches

C Radio LED G Programming header L Processor Board Connection

D A2. ISM Antenna H ISM Radio Board Connection M Display Connection
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5.2 I/O Base Board for the B2 and S2 Models
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1 18
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M

L

1 No connection 12 2B. DLatch 2B 23 N3. NMOS OUT 3

2 PW. 12–30 V DC or solar power in (+) 13
S-. Secondary RS-485 – (not used for the
S2)

24 N2. NMOS OUT 2

3 GD. Ground 14
S+. Secondary RS-485 + (not used for
the S2)

25 N1. NMOS OUT 1

4 B+. Battery in (< 15 V DC) 15 SP. SDI-12 Courtesy Power 26 GD. Ground

5 GD. Ground 16 SD. SDI-12 Data 27 U4. Universal Input 4

6 M-. Primary RS-485 – 17 GD. GND 28 U3. Universal Input 3

7 M+. Primary RS-485 + 18 P3. Courtesy Power 5 V 29 GD. Ground

8 GD. Ground 19 A2. Analog OUT 2 (0–10 V) 30 P1. Adjustable Courtesy Power (5–24 V)

9 1A. DLatch 1A 20 A1. Analog OUT 1 (0–10 V) 31 U2. Universal Input 2

10 1B. DLatch 1B 21 P2. Adjustable Courtesy Power (5–24 V) 32 U1. Universal Input 1

11 2A. DLatch 2A 22 N4. NMOS OUT 4

A Base board LED J Modbus Slave ID DIP Switches

B A1. Cellular or secondary antenna K Modbus Slave ID DIP Switches

C Radio LED G Programming header L Processor Board Connection

D A2. ISM Antenna H ISM Radio Board Connection M Display Connection

5.3 DIP Switches for the I/O Board
The DXM100/1000-Bx Wireless Controller I/O board DIP switches are set from the factory to Modbus Slave ID 200.
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5.4 Setting the Modbus Slave ID on the I/O Base Board
Only DXM100-S1 and -S1R2 Slave models require that the Modbus Slave ID to be adjusted on the I/O base board. The
DXM100/1000-Bx Wireless Controller models use DIP switches J and K to set the Modbus Slave ID. This device can use a
Modbus register 6804 in the I/O board to access the full range of Modbus Slave IDs.
On the DXM100/1000-Bx Wireless Controller models, use the DIP switches at location K to define the lower digit of the
Modbus Slave ID.
DIP Switch location J defines the course group of Modbus Slave IDs. DIP Switch 4 must be set to ON for DXM100-S1,
DXM100-S2, DXM100-S1R2, and DXM100-S2R2 models.

Settings
Location J DIP Switches

1 2 3 4

Modbus Slave ID set to 11 through 19 OFF OFF

Modbus Slave ID set to 20 through 29 ON OFF

Modbus Slave ID set to 30 through 39 OFF ON

Modbus Slave ID set to 40 through 49 ON ON

Not Used -

Modbus Slave Configuration (DX100-S1 and -S1R2 models only) 1 ON

Standard Communication Mode OFF

DIP Switches J DIP Switch K, Switches 1, 2, 3, 4 (0 is OFF, 1 is ON)

1 2 0,0,0,0 1,0,0,0 0,1,0,0 1,1,0,0 0,0,1,0 1,0,1,0 0,1,1,0 1,1,1,0 0,0,0,1 1,0,0,1

OFF OFF x 2 11 12 13 14 15 16 17 18 19

ON OFF 20 21 22 23 24 25 26 27 28 29

OFF ON 30 31 32 33 34 35 36 37 38 39

ON ON 40 41 42 43 44 45 46 47 48 49

DXM100/1000-Bx Wireless Controller Example—To set the DXM100/1000-Bx Wireless Controller to a Modbus Slave ID of
34, set the following:

Location J DIP switches set to 1=OFF, 2=ON
Location K DIP switches set to 1=OFF, 2=OFF, 3=ON, 4=OFF

The location J DIP switches set the upper Modbus Slave ID digit to 3 while the location K DIP switches set the lower digit to
4.
Setting the DXM I/O Board Modbus Slave ID using Modbus Registers—Write to the I/O board's Modbus register 6804 to
set the Modbus Slave ID to any valid Modbus Slave ID (1 through 245).

• For the DXM100/1000-Bx Wireless Controller model, all switches on DIP switch K should be in the OFF position to
use the Modbus register slave ID.

5.5 I/O Board Jumpers for the B1 and S1 Models
Hardware jumpers on the DXM I/O board allow the user to select alternative pin operations. Turn the power off to the device
before changing jumper positions.

Jumper Function Positions

E Analog output characteristics for
AO2 (pin 19) and AO1 (pin 20)

Defines current (0–20 mA) or voltage (0–10 V) for analog output 1 and 2.
By default, current (0–20 mA) is selected using jumpers 1 and 2 and registers 4008 and 4028 contain
a value of 2.
To select voltage (0–10 V) for output Aout1, set jumper 1 in the voltage position (V) and set Modbus
register 4008 on the I/O board (SID 200) to 3.
To select voltage (0–10 V) for output Aout2, set jumper 2 in the voltage position (V) and set Modbus
register 4028 on the I/O board (SID 200) to 3.

1 Must be in the ON position for the -S1 and -S1R2 model)
2 Uses value in Modbus register 6804.
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5.6 Applying Power
Apply power to the DXM100/1000-Bx Wireless Controller using either 12 to 30 V DC or a 12 V DC solar panel and 12 V
sealed lead acid battery operating together.
The DXM100 has three power input and three power output options:

• Input Power:
◦ 12 to 30 V dc
◦ 12 to 30 V dc solar panel
◦ 12 V dc sealed lead acid battery with automatic charging

• Courtesy Output Power Supplies:
◦ One 5 V dc fixed
◦ Two 5 V dc or 16 V dc (DXM100-B1 models) or Two 5 V to 24 V dc (DXM100-B2 models)

The DXM continuously monitors the health of the power inputs. If a power input fault is detected, the DXM automatically
switches over to battery with continuous uninterrupted operation.
If the incoming voltage drops below 11.2 V dc, the cellular modem does not turn on and will not turn on until the voltage is
above 11.8 V dc. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of the incoming voltage.
If cellular operation stops because of voltage, it is logged in this file.

Pin Description

Pin 1 No connection

Pin 2 12 to 30 V DC input (+) or solar panel connection (+)

Pins 3, 5, 8, 17, 26, 29 Main logic ground for the DXM100/1000-Bx Wireless Controller

Pin 4 Solar or backup battery positive input. Battery voltage must be less than 15 V dc. Use only a sealed lead acid (SLA)
battery.

5.6.1 Connecting a Battery
When attaching a battery to the DXM as a backup battery or as a solar battery, verify the charging algorithm is set properly.
The factory default setting for the battery charging algorithm assumes you are using 12 to 30 V DC to recharge the battery.
The charging algorithm is designed to work with a sealed lead acid (SLA) battery only.

• When using 12 to 30 V DC, connect the 12 to 30 V DC + to pin 2 and connect the ground to pin 3.
• When using main dc power with a back up battery (default configuration), connect the incoming main power pin 2 (+)

and to pin 3 (-). Connect the 12 V sealed lead acid battery to pin 4 (+) and pin 5 (-). The incoming main power must
be 15 to 30 V dc to charge the battery.

5.6.2 Supplying Power from a Solar Panel
To power the DXM100/1000-Bx Wireless Controller from a 12 V dc solar panel, connect the solar panel to power pins 2(+)
and 3(-). Connect a 12 V dc sealed lead acid (SLA) rechargeable battery to pins 4(+) and 5(-).
The factory default setting for the battery charging configuration assumes you are using 12 to 30 V DC power to recharge the
battery. If the incoming power is from a solar panel, you must change the charging configuration.
The battery charging configuration defaults to a battery backup configuration. To change the charging configuration from the
menu system:

1. From the DXM LCD menu, navigate to System Config > I/O Board > Charger.
2. Select Solar for solar panel configurations or DC for battery backup configurations.

To change the charging configuration by writing to Modbus register 6071 on the I/O base board (Slave ID 200):
1. Write a 0 to select the solar power charging configuration.

5.7 Connecting the Communication Pins
The base board communications connections to the DXM100-B1 Wireless Controller are RS-485 (primary), RS-485
(secondary) or RS-232. The base board communications connections to the DXM100-B2 Wireless Controller are RS-485
(primary) and RS-485 (secondary).
RS-485. The primary RS-485 bus is a common bus shared with the ISM radio board (Modbus Slave ID 1) or optional cellular
board. The DXM100/1000-Bx Wireless Controller is defined as the Modbus Master on this bus. Other internal Modbus slaves
include the local processor registers (Modbus Slave ID 199), the base I/O controller (Modbus Slave ID 200), and the display
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board (Modbus Slave ID 201). When assigning Modbus Slave IDs to externally connected devices, only use IDs 2 through
198.
RS-232. The RS-232 bus is not currently defined for the DXM100-B1 models. There is no RS-232 for the DXM100-B2
models.

Pin Parameter Description

Pin 6 Primary RS-485 – Running Modbus protocol at 19.2k baud, use this bus to connect to other Modbus Slave devices.
The DXM100/1000-Bx Wireless Controller is a Modbus Master device on this RS-485 port.Pin 7 Primary RS-485 +

Pin 9 RS-232 Tx Serial RS-232 connection. This bus must use a ground connection between devices to operate
correctly. (DXM100-B1 models only; not available on the DXM100-B2 models)Pin 10 RS-232 Rx

Pin 13 Secondary RS-485 –
The DXM100/1000-Bx Wireless Controller is a Modbus slave on this bus (see I/O Base Board
Connections for the B1 Models on page 24).

Pin 14 Secondary RS-485 +

Pin 15 CANL –
DXM100-B1 models only. Not available on the DXM100-B2 models.

Pin 16 CANH +

5.8 Modbus RTU Master and Slave Ports
The DXM can be a Modbus RTU master device to other slave devices and can be a Modbus slave device to another Modbus
RTU master. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU master to control external slave devices. All
wired devices connected to the master RS-485 port must be slave devices.

• As a Modbus RTU master device, the DXM controls external slaves connected to the primary RS-485 port, the local
ISM radio, local I/O base board, and the local display board.

• As a Modbus RTU slave device, the DXM local registers can be read from or written to by another Modbus RTU
master device.

The secondary port (S+/S-) is the Modbus RTU slave connection. The secondary (slave) Modbus RS-485 port (S+/S-) is
controlled by another Modbus master device, not the DXM. The slave port is used by an external Modbus master device that
will access the DXM as a Modbus slave device.
Use the configuration software to define operational settings for both the Modbus RTU master port and the Modbus RTU
slave port.
Use the DXM's LCD menu to set the Modbus Slave ID for the secondary RS-485 port.

5.8.1 Set the Master and Slave Port Parameters
The basic communications parameters for the RS-485 ports are set in the DXM Configuration Software and are saved in the
XML configuration file.

Figure 13. Settings > General screen
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1. In the DXM Configuration Software, go to the Settings > General screen.
2. To set the parameters for the Modbus Master, change the settings in the Master Port Settings M+/M- section.
3. To set the parameters for the Modbus Slave, change the settings in the Slave Port Settings S+/S- section.

Baud Rate
Defined for both the Modbus master and slave
Settings include: 19200 (default), 1200, 2400, 9600, 38400, 57600, and 115200.

Delay between messages
Applies to the Modbus master port
Sets the minimum wait time from the end of a Modbus transaction to the beginning of the next Modbus transaction.

Parity
Defined for both the Modbus master and slave
Settings include: None (default), odd, even, space, and mark

Timeout
Applies to the Modbus master port
Covers the expected time for messages to be sent throughout the wireless network. For the DXM, the Timeout
parameter is the maximum amount of time the DXM should wait after a request is sent until the response message is
received from the Modbus slave device.

Wireless Modbus Backbone
Applies to the Modbus slave port
Define when there is an ISM radio plugged into the processor board. When this is done, the Modbus slave port uses
the MultiHop radio as the slave port instead of the terminal block connection on the I/O base board. Settings include:
None (default), Modbus, or Ethernet

5.8.2 Set the DXM Modbus Slave Port ID
Set the DXM Modbus slave port ID using the LCD menu system.

1. On the LCD, use the down arrow to highlight System Config and click the Enter button.
2. Highlight DXM Modbus ID and click Enter.
3. Use the up and down arrow buttons to change the DXM Modbus Slave Port ID.
4. Press Enter to accept the ID change.
5. Use the configuration software to cycle power to the device.

After cycling power to the device, the updated DXM Modbus ID is listed under the System Config menu.

5.9 Inputs and Outputs
The I/O base board is a Modbus slave device (Slave ID 200) that communicates to the processor board using Modbus
commands. Use the DXM Configuration Software to create a configuration using read/write maps that will access inputs or
outputs on the I/O board.
Communication with the I/O board runs at a maximum rate of 10 ms per transaction. The parameter setting for the bus with
the I/O board and the processor board are fixed. External Modbus communication runs at a maximum rate of 50 ms per
transaction. The parameter settings for the external RS-485 buses are controlled by the DXM Configuration Software.
Refer to Modbus Register Summary on page 66 for more descriptions of each Modbus register on the DXM100/1000-Bx
Wireless Controller.

5.9.1 Universal Inputs
The universal inputs on the DXM100/1000-Bx Wireless Controller can be programmed to accept several different types of
inputs:

• Discrete NPN/PNP
• 0 to 20 mA analog
• 0 to 10 V analog
• 10k temperature thermistor
• Potentiometer sense
• Bridge
• NPN raw fast

Any input can be used as a synchronous counter by configuring the input as a discrete NPN/PNP input.
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Use the DXM Configuration Software tool to write to the appropriate Modbus registers in the I/O board to configure the input
type. The universal inputs are treated as analog inputs. When the universal inputs are defined as mA, V, or temperature, use
Modbus registers to configure the operational characteristics of the inputs. These parameters are temperature conversion
type, enable full scale, threshold and hysteresis. Refer to the DXM100 Controller Instruction Manual (p/n 190037) for the
parameter definitions.
When a universal input is configured as an NPN or PNP input type, it can be enabled to be a synchronous counter. Enable
the counter function by setting Modbus register 'Enable Rising' or 'Enable Falling' to 1. See Modbus I/O Registers for the B1
I/O Base Board on page 75 for universal input register definitions.

Pin Universal Input Modbus Register Description

27 4 4 Program the universal inputs to accept input types NPN, PNP, 10k thermistor, 0 to 10 V, 0 to 20 mA,
or potentiometer. The default setting is 8: NPN raw fast. To set the input type, write the following
values to the Input Type Modbus registers defined in Modbus I/O Registers for the B1 I/O Base
Board on page 75.

0 = NPN
1 = PNP
2 = 0 to 20 mA
3 = 0 to 10 V dc
4 = 10k Thermistor
5 = Not used
6 = Not used
7 = Bridge
8 = NPN Raw Fast (default)

28 3 3

31 2 2

32 1 1

Thermistor Input
A thermistor input must use a 10k temperature thermistor between ground and the universal input. The thermistor
must be a 10k NTC (Banner model number BWA-THERMISTOR-002) or equivalent. Select the temperature
conversion of degrees C (default) or degrees F by writing Modbus registers defined in Modbus I/O Registers for the
B1 I/O Base Board on page 75.

Potentiometer Input
A potentiometer input is created from three inputs: a voltage source (pin 30) that supplies 5 V to the potentiometer
and two inputs set to voltage inputs to read the voltage across the potentiometer. See Using Universal Inputs to
Read a Potentiometer (p/n b_4462775) for more information.

Bridge Input
The bridge input is not implemented yet.

NPN vs NPN Raw Fast
The difference between NPN and NPN Raw Fast is the amount of settling time given to the input. Switch the input
type to NPN if the input is not detecting a transition.

Synchronous Counters
When an input is configured as a counter (inputs set to NPN/PNP), the input counts the input signal transitions. The
count value is stored into two 16-bit Modbus registers for a total count of 32-bits (unsigned). To program an input to
capture the edge transition counts, follow Example: Configure Input 1 as a Synchronous Counter on page 30.
Synchronous counter sample the inputs every 10 ms. The input logic does not detect rising or falling edges, but
instead samples the input every 10 ms to find level changes. The input signals must be high or low for more than 10
ms or the input will not detect transitions. Because most signals are not perfect, a realistic limit for the synchronous
counter would be 30 to 40 Hz.

Example: Configure Input 1 as a Synchronous Counter
1. Connect the DXM to the PC.
2. Launch the DXM Configuration Software software.
3. Connect to the DXM by selecting the Device > Connection Settings menu option. You may connect using either

USB or Ethernet.
4. Select a COMM port from the drop-down list and click Connect.
5. Click on the Register View tab on the left part of the page.
6. Change the Source Register selection to I/O Board Registers.
7. In the Write Registers area, write Modbus register 4908 to 1 to enable counting on the rising edge of the input

signal.
8. Read Modbus registers 4910 and 4911 to get the 32-bit value of the count.
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Example: Change Universal Input 2 to a 0 to 10 V dc Input
1. Connect the DXM to the PC.
2. Launch the DXM Configuration Software software.
3. Connect to the DXM by selecting the Device > Connection Settings menu option. You may connect using either

USB or Ethernet.
4. Select a COMM port from the drop-down list and click Connect.
5. Click on the Register View tab on the left part of the page.
6. Change the Source Register selection to I/O Board Registers.
7. Write a 3 to Modbus register 3326 on Modbus Slave ID 200 (I/O board).
8. Cycle power to the device.
9. Using the Register View tab, read register 3326 to verify it is set to 3.

Example: Change Analog Output 1 to a 0 to 10 V dc Output
1. Connect the DXM to the PC.
2. Launch the DXM Configuration Software software.
3. Connect to the DXM by selecting the Device > Connection Settings menu option. You may connect using either

USB or Ethernet.
4. Select a COMM port from the drop-down list and click Connect.
5. Click on the Register View tab on the left part of the page.
6. Change the Source Register selection to I/O Board Registers.
7. Set jumper 1 on the I/O base board to the 0 to 10 V position. Refer to the base board image for the analog output

jumper position.
8. Write a 3 to Modbus register 4008 on Modbus Slave ID 200 (I/O board).
9. Cycle power to the device.
10. Using the Register View tab, read register 4008 to verify it is set to 3.

5.9.2 NMOS Outputs for the DXM100
Table 5: NMOS output pins for the DXM100 models

Pin NMOS Discrete
Outputs

Modbus Register Description Wiring

22 4 504

Less than 1 A maximum current at 30 V DC
ON-State Saturation: Less than 0.7 V at 20 mA
ON Condition: Less than 0.7 V
OFF Condition: Open

Output

23 3 503

24 2 502

35 1 501

5.9.3 Analog (DAC) Outputs for the B1 and S1 Models
The B1 and S1 analog outputs may be configured as either 0 to 20 mA outputs (default) or 0 to 10 V outputs.
To change the analog (DAC) output type:

1. Remove power to the device.
2. Remove the DXM cover.
3. Change the hardware jumper position (see the table for the pin number and I/O Base Board Connections for the B1

Models on page 24 for the pin locations).
4. Replace the DXM cover.
5. Restore power to the DXM.
6. Set the Output Type Select Modbus register (on the I/O board, Slave ID 200) to a value of 2 (default) to select 0 to 20

mA or a value of 3 to select 0 to 10 V. For analog output 1 write to Modbus register 4008, for analog output 2 write to
Modbus register 4028 (see the table for the values).
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DXM100/1000-B1 and S1 Models

Pin Analog
Output

Modbus
Register

Description

20 1 507 0 to 20 mA or 0 to 10 V dc output (I/O board jumper selectable)

Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit19 2 508

5.9.4 Analog (DAC) Outputs for the B2 and S2 Models
The B2 and S2 analog outputs are 0 to 10 V dc outputs and cannot be changed.

DXM100/1000-B2 and S2 Models

Pin Analog
Output

Modbus
Register

Description

20 1 509 0 to 10 V dc output

Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit19 2 510

5.9.5 DC Latching Outputs for the B2 and S2 Models
Pin DC Latching Outputs Modbus Register Description Wiring

9 D1A
507 Write a 1 to the output register to activate the DC

Latching output from A to B.
Write a 0 to the output register to deactivate the DC
Latching output form B to A. DB

DA 2-wire
self-latching
solenoid

10 D1B

11 D2A
508

12 D2B

The DXM Configuration Software allows the user to adjust parameters that govern the operation of the DC latch outputs.
Most applications will not require any changes for correct operation. Software parameters include:

• Enable H-Bridge—Enable or disable the H-bridge output. Default Enabled.
• Voltage—The voltage applied to the output when the output is activated. Default 13 V dc.
• Cap Warmup Time—The amount of time given to charge the output capacitor. The more time given to charge the

output capacitor the more energy will be available to turn on the output. Default 80 ms
• Switch Time—The amount of time the output is turned on to be able to change the solenoid output. Default 40 ms

5.9.6 SDI-12 Interface for the B2 and S2 Models
The SDI-12 interface on the B2 Wireless Controllers can support up to five
devices with twelve 32-bit register values each. The SDI-12 interface can
be configured to increase the number of registers per device address for
devices with large register sets. The factory default enables one SDI-12
device using device address 1 with up to nine registers with a SDI-12
command of "M!".
Use the configuration software to adjust the SDI-12 parameters.

power

ground

serial SD

GD

SPSDI-12
device

B2
Controller

Basic SDI-12 Interface Parameters
Up to five devices/commands can be accessed using the SDI-12 interface. There are three parameters for each device/
command: Enable, Device Address, Device Command. For more information, refer to the SDI-12 Technical Notes.
Enable. Instructs the DXM device to activate or deactivate the SDI-12 device. Write a 1 to enable, and write a 0 to disable.
The factory default for device 1 is enabled; devices 2 through 5 are disabled.
Device Address. Each SDI-12 device must have a unique device address. This parameter is the ASCII code for the device
address. Valid device addresses are 0–9 and a–z that map to ASCII codes 48–57 and 97–122, respectively. The factory
default addresses are:

• SDI-12 Device 0 uses ASCII code 48
• SDI-12 Device 1 uses ASCII code 49
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• SDI-12 Device 2 uses ASCII code 50
• SDI-12 Device 3 uses ASCII code 51
• SDI-12 Device 4 uses ASCII code 52

Device Command The SDI-12 interface supports "M!" or "C!" commands. Use the Device Command parameter to define
which command to use for this device. The factory default is "M!" commands for all devices (value of 10 in the Modbus
register).

Supported M! Commands

SDI-12 Command Register Value

xM! 0 or 10

xM1! 11

xM2! 12

xM3! 13

xM4! 14

xM5! 15

xM6! 16

xM7! 17

xM8! 18

xM9! 19

Supported C! Commands

SDI-12 Command Register Value

xC! 1 or 20

xC1! 21

xC2! 22

xC3! 23

xC4! 24

xC5! 25

xC6! 26

xC7! 27

xC8! 28

xC9! 29

The Modbus configuration registers are listed. All registers are defined as Modbus holding registers. The factory default
values are shown in parentheses. All values are in decimal, unless noted otherwise.

Device/CMD Configuration
Registers (Default Value)

Enable Device Address Device Command

SDI-12 Device/CMD 1 1751 (1) 11001 (48) 3 11002 (10)

SDI-12 Device/CMD 2 1701 (0) 11201 (49) 11202 (10)

SDI-12 Device/CMD 3 1651 (0) 11401 (50) 11402 (10)

SDI-12 Device/CMD 4 1601 (0) 11601 (51) 11602 (10)

SDI-12 Device/CMD 5 1551 (0) 11801 (52) 11802 (10)

SDI-12 Device Result Registers
The result registers store all information received from the SDI-12 devices.
The registers are 16-bit registers and require two registers to store a 32-bit value. The factory default configuration defines
the result registers as 32-bit registers, floating point format, and the first nine result registers are enabled for use. A host
system reads the SDI-12 device data from these registers.

Result Registers Register 1 Register 2 Register 3 Register 4 Register 5 Register 6

SDI-12 Device/CMD 1 Result Upper 11101 11103 11105 11107 11109 11111

SDI-12 Device/CMD 1 Result Lower 11102 11104 11106 11108 11110 11112

SDI-12 Device/CMD 2 Result Upper 11301 11303 11305 11307 11309 11311

SDI-12 Device/CMD 2 Result Lower 11302 11304 11306 11308 11310 11312

SDI-12 Device/CMD 3 Result Upper 11501 11503 11505 11507 11509 11511

SDI-12 Device/CMD 3 Result Lower 11502 11504 11506 11508 11510 11512

SDI-12 Device/CMD 4 Result Upper 11701 11703 11705 11707 11709 11711

SDI-12 Device/CMD 4 Result Lower 11702 11704 11706 11708 11710 11712

3 The default device addresses 48 through 52 are in ASCII.
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Result Registers Register 1 Register 2 Register 3 Register 4 Register 5 Register 6

SDI-12 Device/CMD 5 Result Upper 11901 11903 11905 11907 11909 11911

SDI-12 Device/CMD 5 Result Lower 11902 11904 11906 11908 11910 11912

Result Registers Register 7 Register 8 Register 9 Register 10 Register 11 Register 12

SDI-12 Device/CMD 1 Result Upper 11113 11115 11117 11119 11121 11123

SDI-12 Device/CMD 1 Result Lower 11114 11116 11118 11120 11122 11124

SDI-12 Device/CMD 2 Result Upper 11313 11315 11317 11319 11321 11323

SDI-12 Device/CMD 2 Result Lower 11314 11316 11318 11320 11322 11324

SDI-12 Device/CMD 3 Result Upper 11513 11515 11517 11519 11521 11523

SDI-12 Device/CMD 3 Result Lower 11514 11516 11518 11520 11522 11524

SDI-12 Device/CMD 4 Result Upper 11713 11715 11717 11719 11721 11723

SDI-12 Device/CMD 4 Result Lower 11714 11716 11718 11720 11722 11724

SDI-12 Device/CMD 5 Result Upper 11913 11915 11917 11919 11921 11923

SDI-12 Device/CMD 5 Result Lower 11914 11916 11918 11920 11922 11924

SDI-12 Device Settings
The following are generic sampling, power and warmup parameters that should work for all SDI-12 devices. See the tested
device table below. In most cases, parameters will not need to be adjusted but if needed there are three common SDI-12
device parameters that control the communications and power of the SDI-12 device. Contact Banner Engineering Corp
support for more guidance.

• Sample Rate. Formed using two 16-bit parameters, a HI word and a LOW word. The sample rate is how often the
SDI-12 device is powered up, then interrogated for data. The value in the registers is the number of 0.010 second
counts. For example, the default value is 22,500, which calculates to a sample rate of 22500 × 0.010 seconds.
Adjusting this value affects the battery life.

• Warmup time. Amount of time to wait, in 0.010 second increments, from powering on the device to the time to send
communications to the device. The default value is 50, or 50 × 0.010 seconds. Adjusting this value affects the battery
life.

• Voltage. The default voltage setting is 6 volts or a register value of 168. Adjusting this value affects the battery life.

Registers (Default Value)

Device / Cmd Configuration Enable Device
Address

Switch
Power
Enable

Device
Command Sample Hi Sample Low Warmup

Time Voltage

SDI-12 Device/CMD 1 1751 (1) 11001 (48) 4 1754 (1) 11002 (10) 1752 (0)
1753

(22500)
1755 (50) 1756 (148)

SDI-12 Device/CMD 2 1701 (0) 11201 (49) 1704 (0) 11202 (10) 1702 (0)
1703

(22500)
1705 (50) 1706 (148)

SDI-12 Device/CMD 3 1651 (0) 11401 (50) 1654 (0) 11402 (10) 1652 (0)
1653

(22500)
1655 (50) 1656 (148)

SDI-12 Device/CMD 4 1601 (0) 11601 (51) 1604 (0) 11602 (10) 1602 (0)
1603

(22500)
1605 (50) 1606 (148)

SDI-12 Device/CMD 5 1551 (0) 11801 (52) 1554 (0) 11802 (10) 1552 (0)
1553

(22500)
1555 (50) 1556 (148)

These SDI-12 probes have been tested and are functional with the factory default settings.

MFG Models Technical Note

Acclima SEN-SDI (TDT SDI-12 Soil Moisture Sensor) SDI-12 and the Acclima TDT SDI-12 Soil Moisture Probe

Adcon Telemetry HydraProbeII

4 The default device addresses 48 through 52 are in ASCII.
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MFG Models Technical Note

AquaCheck Sub-surface Probe SDI-12 and the AquaCheck Sub-Surface Soil Moisture Probe

Decagon MPS-2, MPS-6, 5TE, TS1, T8
SDI-12 and the Decagon 5TE Soil Moisture Probe
SDI-12 and the Decagon GS3 Soil Moisture Probe
SDI-12 and the Decagon MPS-2 Soil Moisture Probe

HSTI HydraScout SDI-12 and the HydraScout HSTI Probe

Sentek EnviroSCAN SDI-12 and the Sentek EnviroScan Soil Moisture Probe
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6 Cellular Modem Boards

6.1 Cellular Modem Board
The LTE (United States) or GSM (outside the United States) cellular modem is an optional accessory that is installed on the
processor board on the two 12-pin sockets.

Figure 14. Cellular modem board

A

A - U.FL antenna connection
The U.FL connector should be to the left, with the antenna cable going to the left antenna U.FL connector. The SIM card
slides into the socket on the back of this board.

6.2 Cellular Power Requirements
If the incoming voltage drops below 11.2 V dc, the cellular modem does not turn on and will not turn on until the voltage is
above 11.8 V dc. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of the incoming voltage.
If cellular operation stops because of voltage, it is logged in this file.

6.3 Using the DXM Cellular Modem
The DXM cellular modem provides a remote network connectivity solution for the DXM.
To use the cellular modem:

1. Verify the cellular modem is installed and the correct antenna is connected to the cellular antenna port.
2. Activate the cellular service.
3. Configure the DXM to use the cellular network as the network interface.
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6.4 Activating a Cellular Modem
Follow these basic steps to activate the cellular capabilities of your DXM Controller.

1. Purchase a cellular modem kit from Banner Engineering Corp.
2. Activate a cellular plan to the SIM card, then insert the SIM card into the cellular modem.
3. Install the cellular modem, connect the antenna cable, and connect the cellular antenna.
4. Configure the DXM to use the cellular modem.

Table 6: Cellular modem kit models

Cellular Kit Model Kit Description

SXI-LTE-001

Verizon LTE cellular modem using Telit LE910 modem kit (Verizon part number SENSX002). Includes a cellular modem, SIM
card, antenna, and antenna cable. The SIM card is specific to the LTE technology and cannot be used in other cellular
modems. Requires a LTE Verizon cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International
Mobile Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

SXI-CATM1VZW-001

Verizon CAT M1 cellular modem using Telit ME910 modem kit (Verizon part number SXIM1V). Includes a cellular modem, SIM
card, and internal adhesive antenna. The SIM card is specific to the CATM1 technology and cannot be used in other cellular
modems. Requires a LTE Verizon cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International
Mobile Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

SXI-CATM1ATT-001

ATT CAT M1 cellular modem using Telit ME910 model kit. (ATT part number SXIM1A). Includes a cellular modem, SIM card.
and internal adhesive antenna. The SIM card is specific to the CATM1 technology and cannot be used in other cellular
modems. Requires a LTE AT&T cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International Mobile
Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

For additional information, refer to the Banner Cloud Data Services support center (support.bannercds.com). The support
center includes video tutorials, product documentation, technical notes, and links to download configuration software.

Important: Only the DXM100 and DXM150 models offer SMS/text messaging capabilities directly from the
device. SMS/text messaging can be delivered using the BannerCDS web service from any DXM model.

6.4.1 Install the Cellular Modem (DXM100, 150, 700, and 1000 Models)
Follow these steps to install the cellular modem and antenna cable.

Important:
• Electrostatic discharge (ESD) sensitive device
• ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
• Use proper handling procedures to prevent ESD damage. Proper handling procedures include

leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and
assembling units on a grounded, static-dissipative surface.

Before you activate your cellular plan, verify you have one of the following cellular modem kits.
Table 7: Cellular modem kit models

Cellular Kit Model Kit Description

SXI-LTE-001

Verizon LTE cellular modem using Telit LE910 modem kit (Verizon part number SENSX002). Includes a cellular modem, SIM
card, antenna, and antenna cable. The SIM card is specific to the LTE technology and cannot be used in other cellular
modems. Requires a LTE Verizon cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International
Mobile Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

SXI-CATM1VZW-001

Verizon CAT M1 cellular modem using Telit ME910 modem kit (Verizon part number SXIM1V). Includes a cellular modem, SIM
card, and internal adhesive antenna. The SIM card is specific to the CATM1 technology and cannot be used in other cellular
modems. Requires a LTE Verizon cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International
Mobile Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.
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Cellular Kit Model Kit Description

SXI-CATM1ATT-001

ATT CAT M1 cellular modem using Telit ME910 model kit. (ATT part number SXIM1A). Includes a cellular modem, SIM card.
and internal adhesive antenna. The SIM card is specific to the CATM1 technology and cannot be used in other cellular
modems. Requires a LTE AT&T cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International Mobile
Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

Figure 15. Installing the cellular modem

1

2 3

1. Insert the SIM card into the socket on the underside of the cellular modem. SIM cards come in a credit card sized
carrier. Snap it out and insert the SIM card into the holder on the cellular modem.
Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card. The numbers can be
found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM number to associate a
wireless plan to this SIM card.

2. Orient the cellular modem according to the pin layout and verify the pins are properly aligned. Firmly press the
modem into the 24-pin socket.
• For the DXM100, DXM150, and DXM1000 models—Install the cellular modem board onto the processor board as

shown. Use the diagram below to verify the orientation is correct.
• For the DXM700 models—Install the cellular modem board onto the base board as shown. Use the diagram

below to verify the orientation is correct.
3. Attach the antenna cable between the cellular modem board to the base board as shown.
4. Install the external cellular antenna on the DXM's SMA connector located next to the antenna cable.

Figure 16. DXM100, 150, and 1000

Modem

*SIM card is located on the underside of installed modem

SIM card* 
location

Antenna Cable

Figure 17. DXM700

Modem

*SIM card is located on the underside of installed modem

Antenna Cable

SIM card* 
location
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6.4.2 Install the Cellular Modem (DXM1200 Models)
Follow these steps to install the cellular modem and antenna cable.

Important:
• Electrostatic discharge (ESD) sensitive device
• ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
• Use proper handling procedures to prevent ESD damage. Proper handling procedures include

leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and
assembling units on a grounded, static-dissipative surface.

Before you activate your cellular plan, verify you have one of the following cellular modem kits.
Table 8: Cellular modem kit models

Cellular Kit Model Kit Description

SXI-LTE-001

Verizon LTE cellular modem using Telit LE910 modem kit (Verizon part number SENSX002). Includes a cellular modem, SIM
card, antenna, and antenna cable. The SIM card is specific to the LTE technology and cannot be used in other cellular
modems. Requires a LTE Verizon cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International
Mobile Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

SXI-CATM1VZW-001

Verizon CAT M1 cellular modem using Telit ME910 modem kit (Verizon part number SXIM1V). Includes a cellular modem, SIM
card, and internal adhesive antenna. The SIM card is specific to the CATM1 technology and cannot be used in other cellular
modems. Requires a LTE Verizon cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International
Mobile Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

SXI-CATM1ATT-001

ATT CAT M1 cellular modem using Telit ME910 model kit. (ATT part number SXIM1A). Includes a cellular modem, SIM card.
and internal adhesive antenna. The SIM card is specific to the CATM1 technology and cannot be used in other cellular
modems. Requires a LTE AT&T cellular wireless plan attached to the ICCID (SIM card) number and IMEI (International Mobile
Equipment Identity) number.
Cellular plans can be purchased through secure.bannercelldata.com.

Figure 18. Installing the cellular modem

1

2 3

1. Insert the SIM card into the socket on the underside of the cellular modem. SIM cards come in a credit card sized
carrier. Snap it out and insert the SIM card into the holder on the cellular modem.
Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card. The numbers can be
found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM number to associate a
wireless plan to this SIM card.

2. Apply the internal antenna as shown paying attention to the antenna cable position.
a) Pull back the adhesive protective paper from the middle of the antenna, only exposing the middle portion.

Antenna application is easier if just a small middle portion of the adhesive is uncovered.
b) Center the antenna on the side wall. Use the exposed adhesive in the middle of the antenna to hold the antenna

in place while aligning the antenna to the full length of the housing.
c) Slowly peel off the paper backing exposing the adhesive and stick to the plastic housing. The antenna should run

below the rim of the housing.
d) Press firmly.

3. Orient the cellular modem according to the diagram below and verify the pins are properly aligned. Firmly press the
modem into the 24-pin socket on the board.
The cellular modem is inserted into the main board with the antenna cable from the applied internal antenna attached
to the cellular modem PCB.

4. Attach the antenna cable between the cellular modem board to the base board. The antenna cable uses the top
antenna connection.
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Figure 19. Internal view of a DXM1200

*SIM card is located on the underside of installed modem

Cell Modem

Antenna Cable

SIM card*
location Micro USB

ISM
Radio
Board

Cellular Antenna Placement

6.4.3 Activate a 4G LTE or CAT M1 Cellular Plan
Activate a cellular plan for your DXM using the Banner Cloud Data Services website.

1. Go to secure.bannercelldata.com to purchase cellular data plans.
2. If you have previously created an account, click Login and enter your username and password to continue.
3. If you are creating a login for the first time:

a) Select the region in which the device will operate.
b) Select the cellular subscription plan. Please use the calculator and regional coverage information to determine the

plan needed for your device (https://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan).
c) Create a username and password (use an email address for the username).
d) Enter your payment information, mailing address, agree to the terms and conditions.

4. Go to the My Services and Equipment section.
5. Enter the SIM Number (ICCID) and the Module Number (IMEI).

The ICCID is the 20-digit number of the SIM, the bottom barcode number on the SIM card carrier. If the carrier card is
not available, the ICCID is also printed on the SIM card, but must be removed from its socket to be read. The IMEI is
the 15-digit number on top of the 4G LTE device.

6. Click Activate.

Note: Although new activations are typically functional in 20 minutes or less, it may take up to 24
hours for the cellular plan to become active on the wireless network.

6.4.4 Configure the DXM Controller for a Cellular Modem
Use the DXM Configuration Software to create a configuration using a cellular connection.

Important: Only the DXM100 and DXM150 models offer SMS/text messaging capabilities directly from the
device. SMS/text messaging can be delivered using the BannerCDS web service from any DXM model.

1. Go to the Settings > Cloud Services screen.
2. Set the Push Interface to Cell

All push data, SMS messages, or email alerts will be sent using the cellular modem.
3. Go to the Settings > Cellular screen. Under the Cell Configuration section, select the Cell module from the drop-

down list.
• For North America—For Verizon LTE/CATM modems, select VZW LTE/CATM and set the APN to vzwinternet.

For ATT LTE/CATM modems, select ATT LTE/CATM and set the APN to iot0119.com.attz. Requires a SIM
module to be purchased from a wireless carrier based on the IMEI number of the cellular modem. The wireless
carrier will provide the APN parameters. Not all parameters may be required.

4. To send data to the webserver, complete the parameters on the Settings > Cloud Services screen. Set the Cloud
push interval and the Web Server settings. (For more information, refer to the DXM Configuration Software
Instruction Manual (p/n 201127).

When the DXM is configured to use the cellular modem, the information on the cellular modem is found on the LCD menu
under System Info > Cell. The menu does not display values until a transaction with the wireless cell tower is complete.
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If there are no webserver parameters defined, the user must force a push to retrieve the data from the cellular network. On
the LCD menu, select Push > Trigger Data Push.
Obtaining LTE service outside of the Banner Cellular Data Plans—Customers have the option of securing a data plan for
the Verizon network themselves without using the Banner cellular data portal (secure.bannercelldata.com). Suitable plans
would include those available from Verizon directly or from a Mobile Virtual Network Operator (MVNO) licensed to resell
Verizon network data plans. (The SXI-LTE-001 will not function on AT&T, T-Mobile, or Sprint networks.) When purchasing a
data plan, it is important to refer to the modem by its official Verizon network name (for example, SENSX002) and give the
IMEI number (found on the cellular modem) to the plan provider. To use the SIM card that comes with the cellular modem kit,
give the SIM card number to the provider. The required SIM card form factor is 3FF - Micro.

6.5 Accessing the DXM Using SMS
The DXM with a cellular modem can be remotely accessed using SMS messages. Simple text messages can:

• Force a push to the cloud
• Reboot the controller
• Read/write local registers

The incoming firewall provides security; only defined phone numbers are permitted to access the controller. Use the DXM
Configuration Software to configure the SMS commanding feature. This feature requires firmware version 2.01 or later.
SMS command messages sent from approved phone numbers to the DXM cause the DXM to respond. See the examples
below for SMS responses. Responses may take 20 seconds or more, depending upon the network.
A DXM requires a few minutes after powering up before it can accept SMS messages. Initial cellular connection times vary
based on the wireless network. A SMS message sent to the controller while a push session is active delays any response or
the SMS message may be dropped based on the length of the push session.
Configuring the DXM for SMS Controlling— Configure the DXM for SMS messaging capability using the DXM
Configuration Software.

1. On the Settings > Cloud Services screen, set the network interface to Cell.
2. On the Settings > Network screen, enter the phone numbers that are allowed access to the DXM.
3. Save the configuration file (File > Save.
4. Load the XML file to the DXM.
5. After the device has been running for a few minutes, the cellular network should be operational. The phone number

(MDN) is visible on the DXM LCD menu (System Info > Cell).
6. Send a text message to the DXM from an approved phone number.

HTTP Push
Push triggers a http push to a webserver. The DXM accepts the message, executes the action, and sends an
acknowledgment text message back to the user.
Example: Texting push forces defined local registers to be sent to a webserver
push <send>
DXM acknowledgment text message: Register push requested

Reboot
Reboot triggers the DXM to reboot. The processor reloads the XML configuration file and zeroes all local register
data. This does not affect the other components of the DXM (ISM radio, I/O board, cellular modem). The DXM
accepts the message, executes the action, and sends an acknowledgment text message back to the user.
Example: Texting reboot forces the processor to reboot.
reboot <send>
DXM acknowledgment text message: rebooting…

Get Register
grN gets register number N (DXM Local Register) and sends a text with the value back to the user. The response
text message shows the value in floating point format regardless of register number.
Example: Text gr1 to retrieve the value for register 1.
gr1 <send>
DXM acknowledgment text message: Register 1 is 0
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Set Register
srN,X sets a register value, where N is the register number and X is the value. The DXM responds with a SMS
message indicating the register was set.
Example: Texting sr1,10 sets register 1 to value of 10
sr1,10 <send>
DXM acknowledgment text message: Register 1 has been set to 10

Additional information may be available in the DXM Controller API Protocol instruction manual, p/n 186221.
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7 LCD and Menu System
The LCD has four user-defined LED indicators, four control buttons, and an LCD. The four buttons control the menu system
on the LCD menu.

Figure 20. Top-level menu

Banner Eng 08:25:45
→ Registers
→ Push S → 08:25:15 
→ ISM Radio

→ System Config
→ System Info

↑

↓

ENTER

BACK

→ I/O Board

The top-level menu always displays the time in a 24-hour format.
• The up and down arrows scroll through display items.
• The ENTER button selects the highlighted items on the display
• The BACK button returns to a previous menu option.

The left display column shows an arrow at the beginning of the line if the menu has submenus. The right column shows a
vertical line with an arrow at the bottom if the user can scroll down to see more menu items.
The DXM can be configured to require a passcode be entered before the LCD and Menu system will operate. The passcode
configuration is defined in the DXM Configuration Software.

7.1 Registers
The Registers submenu displays the processor's local registers that can be configured using the DXM Configuration
Software.
To configure these local registers, launch the DXM Configuration Software. Go to Local Registers and expand the view for a
local register by clicking on the down arrow next to the register number. In the LCD Permissions field, select None, Read,
Write, or Read/Write.

Figure 21. Registers menu

Registers List of Local Register
Values and the Register Name to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Read allows the register to be displayed, and Write or Read/Write allows the register value to be changed using the LCD.
The Units and Scaling parameters are optional and affect the LCD.

7.2 Push
The Push menu displays information about the last data sent to the Webserver.

Figure 22. Push menu

Push Trigger Data Push Trigger Data Push

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓Status
Time (hh:mm:ss)
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The user can force an immediate push to the webserver using Trigger Push. If a current push is in process it may take
several minutes to complete over cellular.

• The Trigger Push submenu forces an immediate push to the web server.
• The status and time fields indicate success or failure of the last attempted push and time of the last attempted push.

7.3 ISM Radio
The ISM Radio menu allows the user to view the Modbus ID of the internal ISM radio, enter binding mode, or run a site
survey. This top-level ISM Radio menu is different from the System Config > ISM Radio submenu.
The first option under the ISM Radio menu only displays the type of radio in the DXM (MultiHop or DX80 Star) and the
Modbus ID of the radio. To change the ISM Radio Modbus ID refer to the System menu.
Select Binding to enter binding mode or select Site Survey to run a site survey.

Figure 23. ISM Radio menu

ISM Radio MultiHop/DX80 ID

Binding

Site Survey

Bind to > 1

Node/Modbus ID > 1

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Please Wait...

Site Survey results OR Failed to start Site Survey

Binding— All ISM radio devices must be bound to the internal Gateway/master device before the DXM can access the
wireless devices. The first submenu under binding allows the user to set the wireless address of the device to bind with. This
is required to bind with wireless devices that do not have rotary dials (for example: M-GAGEs, ultrasonic sensors, and Q45
devices). See Binding and Conducting a Site Survey with the ISM Radio on page 12. For more information on binding a
particular device, refer to the individual datasheet.
Site Survey—After creating a wireless network using the binding process, run a site survey on each device to see the link
quality. See Conduct a Site Survey from the DXM on page 13.

7.4 I/O Board
Use the I/O Board menu to view input values, output values, input counters values, and the charger status on the DXM I/O
board. To change the configuration parameters, use the System Config menu.
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Figure 24. I/O Board menu

I/O Board Inputs

Outputs

Counters

Charger

Input 1
Input 2
Input 3
Input 4

Output 1
Output 2
Output 3
Output 4
Output 5
Output 6

Counter 1
Counter 2
Counter 3
Counter 4

Supply (V)
Battery (V)
Charging (A)
Charge (%)

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

The I/O Board menu includes the following submenus.

Inputs
Lists the inputs. Depending upon the input type, the value and unit's information will also be displayed.

Outputs
The DXM base configuration can include discrete, current, or voltage outputs. The output values will be displayed
based on their configuration settings.

Counters
Counters on the DXM base board are associated to inputs but the count value is stored in different register. Adjust or
view the count registers using the LCD menu.

Charger
The on-board solar/battery charger of the DXM stores information about the charging circuit in Modbus registers.
Use the LCD menu to view information about the incoming voltage, charging current, battery voltage, and battery
charge percentage.
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7.5 System Config
Use the System Config menu to set DXM system parameters.

Figure 25. System Config menu

System Config ISM Radio

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

I/O Board

Ethernet

Provision Cell
DXM Modbus ID: xxx
LCD Contrast: xx
Restart

DX80 ID: x
Auto Detect Radio

Advanced Options

Max Node Count: xx
Binding #: xxxxxx
RF Ctrl: Dip 1.00W

Ref Type: DX80
Ref Modbus ID: x

New ISM Modbus ID: x
Radio Detected Type: DX80
ID: 1

New ISM Max Nodes: xx
New ISM Binding Code: xxxxxx

Inputs

Outputs

Counters
Charger

Input x In Type:
Cnt Rise:
Cnt Fall: 

Output x Default: 
Type:
Voltage:

Charger: DC

DHCP Update DHCP Mode
IP: 
SN: 
GW: 
Reset

Update IP Address
Update SN
Update GW Address
Resets Ethernet parameters
to xml defaults.

After making changes to the 
Ethernet settings, restart the DXM.

7.5.1 ISM Radio
DX80/MultiHop ID—The ISM radio is set at the factory to be Modbus device address 1 (Modbus ID 1). For some
applications, you may need to change the Modbus ID. Adjust the Modbus device address using the LCD menu system. Any
other method may cause issues with the DXM not knowing which Modbus device address is assigned to the radio, which
causes issues with running Binding or Site Survey from the LCD menu.
Set the radio Modbus ID to a valid number (1 through 247) that is not being used by the DXM system. Processor Local
Registers allocate ID 199, the I/O board is set to ID 200, and the display board is set to ID 201. With a DX80 Gateway (star
network), it's easy to choose a new ID. With a MultiHop network, remember that the master MultiHop radio allocates a range
of Modbus IDs for wireless devices, typically 11 through 110.
When setting the new ISM Modbus ID, the system changes the Modbus ID on the internal radio and changes the reference
to it on the DXM. The reference Modbus ID is what the DXM uses to access the internal radio when running Binding or Site
Survey.
Auto Detect Radio—If the internal Modbus ID of the radio was changed or the internal radio was changed, but not recorded,
use Auto Detect Radio to determine the radio ID and radio type. The auto-detect routine broadcasts discovery messages and
waits for a response. If other devices are connected to the external RS-485 ports, they may need to be disconnected for this
process to work properly.
Advanced Options—The Advanced Options menu is typically not used unless the Modbus ID is changed without the DXM
being involved, such as when you write directly to the radio Modbus registers.

• Reference Type selects the radio type between DX80 star architecture radios and a MultiHop radio. The DXM uses
this reference to determine how to communicate to the internal radio. If set incorrectly, the DXM may not be able to
run Site Survey from the LCD menu. Unless you are changing or adding the internal radio device, there should no
reason to change the radio type.

• Reference Modbus ID defines the Modbus ID the DXM uses when communicating with the internal radio. If this is
set incorrectly, the DXM will not be able to run Binding or Site Survey through the LCD menu.

Max Node Count—Defines the maximum number of devices for the DX80 wireless network.
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Binding #—This parameter allows the user to define the Binding code within the ISM radio. Typically, you will not have to
adjust this number unless you are replacing an existing Gateway or master radio.
RF Ctrl—Displays the status of the ISM radio DIP switch 1 (off or on). The menu doesn't allow the user to change the DIP
switch setting through the display.

7.5.2 I/O Board
Use the System Config > I/O Board submenu to change the configuration parameters for the inputs, outputs, counters, and
charger.
Use the Inputs menu to change the input type. The universal inputs on the DXM are defined from the factory as sinking
inputs. To change the input type:

1. Go to the System Config > I/O Board > Inputs menu.
2. Select which input to change.
3. Select the input type. The available parameters include the Input Type and the Counter Edge Detect.

Table 9: Input parameters

Input Type Description

Sinking Discrete input, low active, 0 = ON, 1 = OFF

Sourcing Discrete input, high active, 1 = ON, 0 = OFF

Current Analog input, 0–20 mA

Voltage Analog input, 0–10 V DC

Thermistor 2* Thermistor input, 10k - J (r-t curve), beta(K) 3890

Thermistor 1* Thermistor input, 10k - G (r-t curve), beta(K) 3575

Counter Description

In Type Sinking or sourcing

Cnt Rise Increment the count when the input transitions from 0 -> 1

Cnt Fall Increment the count when the input transitions from 1 -> 0

Use the Output menu to change the default condition, output type, and switched power voltage.
Table 10: Output parameters

Output Type Description

Default
Force output registers to a default condition if the I/O board has not been communicated with for a user-defined
time period. The communications timeout parameter must be set to use the Default condition.

Type Select the output type: NMOS Sinking, Switch Power (Swch Pwr), Analog.

Voltage Outputs defined as switched power can adjust the voltage: 5 V or 16 V

Use the Charger menu to change the charging algorithm for the battery. This parameter can also be set by writing Modbus
register 6071 of the I/O board. See Supplying Power from a Solar Panel on page 27.
Table 11: Charger parameters

Charger Parameters Description

DC Used when 12–24 V DC power supplies connected to the DXM power pins and the attached batteries are used as
backup batteries. This limits the current during the battery charging process. (factory default setting)

Solar Select Solar when a solar panel is connected to the power pins of the DXM. Solar panels are current limited by
their design and therefore can charge the battery without managing the input power.

7.5.3 Ethernet
Use the Ethernet submenu to sets the IP Address, Gateway Address, and Subnet mask of the DXM's Ethernet interface.
You may change these settings either from the LCD menu (System Config > Ethernet) or from the XML configuration file
created by the DXM Configuration Software.
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The network address settings from the LCD menu have the highest priority and override settings in the XML configuration
file. To use the parameter settings from the XML configuration file or use DHCP, execute the Reset under System Config >
Ethernet or use the LCD display to set the IP Address, Gateway Address, and Subnet Mask to 255.255.255.255. Reboot the
DXM after changing the Ethernet parameters.
The Ethernet cable should be attached before powering up the DXM.

7.5.4 Provision Cell
If the DXM has a cellular modem installed, the modem must be provisioned on the network. This menu provisions the cellular
modem on the network. For step by step directions, see Using the DXM Cellular Modem on page 36.

7.5.5 DXM Modbus ID
Use the secondary Modbus RS-485 port when the DXM is connected to a Modbus RTU network as a Modbus slave device.
Set the Modbus ID for the secondary RS-485 port using the LCD display menu System Config > DXM Modbus ID.

7.5.6 LCD Contrast
Use the LCD Contrast option to adjust the LCD contrast. Adjust the starting number lower to decrease the display contrast.
The factory default is 28. Do not set a number less than 15 or the display may not be bright enough to see to change back.

7.5.7 Reset
Use the Restart menu to force the main processor to restart. This does not affect the other boards in the system.

Sure Cross® DXM100-Bx and DXM1000-Bx Wireless Controllers   

48 www.bannerengineering.com - Tel: + 1 888 373 6767  

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2B



7.6 System Info
Various DXM system settings are shown in this menu. The Push, Ethernet, and Cell parameters are helpful for debugging
network connections. This is a read only menu.

Figure 26. System Info menu

System Info Controller

Push

ISM Radio

IO Board

Date: 
Firmware: 
Build: 
Model: 
Serial: 

Method: 
Interval: hh:mm
URL: 
Page: 
Https: on/off
Site ID: 

Serial: 
Model: 
Date: 
RF FW Pt: 
RF FW Ver: 
RF EE Pt: 
RF EE Ver: 

Serial: 
Model:  
Date: 
RF FW Pt: 
RF FW Ver: 
RF EE Pt: 
RF EE Ver: 

to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

Ethernet DHCP: 
IP: 
Subnet: 
Gate: 
Mac: 
DNS1: 
DNS2: 

Cell Signal: 
Phn#:
Dev#:
SIM:
CellVer:
CellMdl:
CellFw:
CellMask:

Wifi IP: 
Mode:
AP: 
Stat: 

Script Path: 
Baud: 
Code:  

LCD Board Serial: 
Model: 
Date:
RF FW Pt:
RF FW Ver: 
RF EE Pt:
RF EE Ver:

Cell
Shows the cellular MEID number (Mobil Equipment Identifier), MDN (Mobil Device Number), version, signal, firewall
setting, and firewall mask. Some of these parameters are not visible until the cellular network is accessed.

Controller
Displays the date, build, model, and serial number.

Ethernet
Displays the IP address, MAC address, DHCP, Gateway address, and DNS settings.

I/O Board
Displays the serial number, model, date, firmware part numbers, and version numbers.
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ISM Radio
Displays the serial number, model, date, firmware part numbers, and version numbers.

LCD Board
Displays the serial number, model, date, firmware part numbers, and version numbers.

Push
Shows the current parameters loaded from the XML configuration that applies to pushing data to a webserver,
including method (Ethernet or cellular), interval, URL, page, HTTPS, and site ID.

Sript
Displays the name of the ScriptBasic file running.

Wifi
Displays the Wifi IP address and other settings.

7.7 Display Lock
Display Lock protects the DXM LCD menu system from being used until the proper pass code is entered.

Figure 27. Display Lock menu

Display Lock Enter password
>> x to change the value

to acceptENTER

BACK to return to the previous menu

↑ ↓

The display lock feature uses the configuration software to set a passcode within the DXM. A valid passcode is 1 to 9 digits
long and uses numbers 0 through 9. For example 1234 or 209384754.
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8 Configuration Instructions

8.1 DXM Configuration Software
Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on
using the DXM Configuration Software, refer to the instruction manual (p/n 209933).

Figure 28. Overview of the configuration software features

USB
Ethernet

DXM Configuration Software

Local Registers

Register 
View Utility

System
Settings

Register Mapping

Scheduler

Action Rules

Script Basic

XML Config File

The configuration software configures the DXM by creating an XML file that is transferred to the DXM using a USB or
Ethernet connection. The DXM can also receive the XML configuration file from a Web server using a cellular or Ethernet
connection.
This configuration file governs all aspects of the DXM operation.
The wireless network devices are a separate configurable system. Use the DX80 User Configuration Software to configure
the internal DX80 wireless Gateway and the attached wireless Nodes. Use the MultiHop Configuration Software if the internal
radio is a MultiHop device.
All tools can be connected to the DXM using a USB cable or an Ethernet connection.

8.2 Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.
Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending
the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving the
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File > Save As menu.
2. Go to the DXM > Send XML Configuration to DXM menu.

Figure 29. Status indicator bar

• If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in the
cable and reconnect the DXM to the software.

• If the Application Status indicator is green, the file upload is complete.
• If the Application Status indicator is yellow, the file transfer is in progress.
The device reboots and begins running the new configuration.
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8.3 Register Flow and Configuration
The DXM register data flow goes through the Local Registers, which are data storage elements that reside within the
processor. Using the DXM Configuration Software, the controller can be programmed to move register data from the Local
Register pool to remote devices, the internal radio, the I/O base (if applicable), or the display.

Figure 30. Register flow
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8.3.1 Basic Approach to Configuration
When programming an application in the DXM, first plan the overall data structure of the Local Registers. The Local
Registers are the main storage elements in the DXM. Everything goes into or out of the Local Registers.

1. In the DXM Configuration Software, name the Local Registers to provide the beginning structure of the application.
2. Configure the read/write rules to move the data. The Read/Write rules are simple rules that move data between

devices (Nodes, Modbus slaves, sensors, etc) and the Local Registers.
3. Most applications require the ability to manipulate the Local Register data, not just move data around. Use the Action

rules to make decisions or transform the data after the data is in the Local Registers. Action rules can apply many
different functions to the Local Register data, including conditional statements, math operations, copy operations, or
trending.

4. To perform scheduled events in Local Registers, go to the Scheduler screen in the DXM Configuration Software.
These rules provide the ability to create register events by days of the week. The scheduler can also create events
based on sunrise or sunset.

8.3.2 Troubleshooting a Configuration
View Local Registers using the Local Registers > Local Registers in Use screen of the DXM Configuration Software.
When a configuration is running on the DXM, viewing the Local Registers can help you to understand the application's
operation. This utility can also access data from remote devices.
To configure the Local Register data to display on the LCD menu, go to the Local Registers screen, set the LCD
permissions to read or read/write.

8.3.3 Saving and Loading Configuration Files
The DXM Configuration Software saves its configuration information in a XML file. Use the File menu to Save or Load
configuration files.
Save the configuration file before attempting to upload the configuration to the DXM. The DXM Configuration Software
uploads the configuration file saved on the PC to the DXM; it will not send the configuration loaded in the tool.
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8.3.4 Uploading or Downloading Configuration Files
The DXM requires a XML configuration file to become operational. To upload or download configuration files, connect a
computer to the DXM using the USB port or Ethernet port. Then use the Upload Configuration to Device or Download
Configuration from Device under the Device menu.

8.4 Scheduler
Use the Scheduler screens to create a calendar schedule for local register changes, including defining the days of the week,
start time, stop time, and register values.
Schedules are stored in the XML configuration file, which is loaded to the DXM. Reboot the DXM to activate a new schedule.
If power is cycled to the DXM in the middle of a schedule, the DXM looks at all events scheduled that day and processes the
last event before the current time.
For screens that contain tables with rows, click on any row to select it. Then click Clone or Delete to copy/paste or remove
that row.

8.4.1 Create a Weekly Event
Use the Scheduler > Weekly Events screen to define weekly events.

Figure 31. Scheduler > Weekly Events screen

1. Click Add Weekly Event.
A new schedule rule is created.

2. Click on the arrow to the left of the new rule to expand the parameters into view.
The user-defined parameters are displayed.

3. Name your new rule.
4. Enter the local register.
5. Select the days of the week this rule applies to.
6. Enter the starting value for the local register.
7. Use the drop-down list to select the type of Start at time: a specific time or a relative time.
8. Enter the starting time.
9. Enter the end time and end value for the local register.

Register updates can be changed up to two times per day for each rule. Each rule can be set for any number of days in the
week by clicking the buttons M, T, W, Th, F, S, or Su.
If two register changes are defined for a day, define the start time to be before the end time. Select End Value to enable the
second event in a 24 hour period. To span across two days (crossing the midnight boundary), set the start value in the first
day, without selecting End Value. Use the next day to create the final register state.
Start and end times can be specified relative to sunrise and sunset, or set to a specific time within a 24 hour period. When
using sunrise or sunset times, set the GPS coordinates on the device so it can calculate sunrise and sunset.

8.4.2 Create a One-Time Event
Define one-time events to update registers at any time within a calendar year.
Similar to Weekly events, the times can be specific or relative to sunrise or sunset. Define one-time events using the
Scheduler > One Time Events screen.
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Figure 32. Scheduler > One Time Events screen

1. Click on Add One Time Event.
A new one-time event is created.

2. Click on the arrow to expand the parameters into view.
The user-defined parameters are displayed.

3. Name your one-time event by clicking on the name link and entering a name.
4. Enter the local register.
5. Enter the starting time, date, and starting value for the local register.
6. Enter the ending time, date, and ending value for the local register.

8.4.3 Create a Holiday Event
Use the Scheduler > Holidays screen to create date and/or time ranges that interrupt weekly events.

Figure 33. Scheduler > Holidays screen

1. Click on Add Holiday.
A new rule is created.

2. Enter a name your new holiday rule.
3. Select the start date and time for the new holiday.
4. Select the stop date and time for the new holiday.

8.5 Authentication Setup
The DXM has three different areas that can be configured to require a login and password authentication.

• Webserver/ Cloud Services Authentication
• Mail Server Authentication
• DXM Configuration Authentication

The webserver and mail server authentication depends upon the service provider.

8.5.1 Set the Controller to use Authentication
The DXM can be configured to send login and password credentials for every HTTP packet sent to the webserver. This
provides another layer of security for the webserver data.
Configuration requires both the webserver and the DXM to be given the same credentials for the login and password. The
webserver authentication username and password are not stored in the XML configuration file and must be stored in the
DXM.

1. From within the DXM Configuration Software, go to the Settings > Cloud Services screen.
2. In the upper right, select Show advanced settings.
3. Define the username and password in the Web Server Authentication section of the screen.

Figure 34. Web Server Authentication screen

The first time you select Require Authentication, a pop-up box appears with additional instructions. Since the data
is not stored in the XML configuration file, it is hidden from view of the DXM Configuration Software.
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4. Click on Send Authentication.
The controller must be connected to the PC for this operation to succeed.
The data transmits directly to the DXM's non-volatile memory. If successful, a pop-up window appears, asking to
reboot the device.

5. Select Yes to reboot the device.

8.5.2 Set the Web Services to Use Authentication
1. At the Banner Cloud Data Services website, go to Settings > Sites.
2. To edit the site settings, click Edit on the line of the site name.

Figure 35. Settings > Sites screen of the Banner CDS website

At the bottom of the pop-up window is a checkbox to enable authentication/validation.
3. Enter the same username and password as used in the DXM Configuration Software. The username and password

do not need to be a defined user within the Banner Cloud Data Services website.

8.5.3 Mail Server Authentication
Complete the mail server settings to have the DXM send email alert messages or to email the log files.
The SMTP password is stored in the DXM, not the XML configuration file. Use the Settings > Notifications screen to
complete this configuration.

Figure 36. Mail server settings

After selecting Enable SMTP Authentication for the first time, a pop-up box appears with additional instructions to complete
the mail server authentication process.

  Sure Cross® DXM100-Bx and DXM1000-Bx Wireless Controllers

 www.bannerengineering.com - Tel: + 1 888 373 6767 55

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2B



After entering the user name and password, click on Send SMTP Password to save the user name and password to the
DXM. The DXM must be connected to the PC to complete this operation. If successful, a pop-up window appears, asking to
reboot the device. Select Yes to reboot the device.

8.5.4 Controller Configuration Authentication
The DXM can be programmed to allow changes to the configuration files only with proper authentication by setting up a
password on the Settings > Administration screen in the DXM Configuration Software.
With the DXM connected to the PC, click Get Device Status. The DXM status displays next to the button.

Figure 37. Settings > Administration screen

Use the DXM Configuration Software to:
• Set the Admin Password
• Change the Admin Password
• Remove the Admin Password

To change or remove an admin password, the current password must be supplied. The DXM must be connected to the PC to
change the administration password.
The DXM can be unlocked without knowing the administration password, but doing this erases the configuration program,
logging files, and any ScriptBasic program on the device. For instruction on how to do this, see the Additional Information on
page 63 section.

8.6 EtherNet/IP™ Configuration
The DXM is defined from the factory to send/receive register data from the Gateway and the first 16 Nodes with an
EtherNet/IP™ 5 host.
To expand the number devices going to Ethernet/IP, change the Devices in system parameter in the DX80 Gateway
(default setting is 8) to 32. To change this value:

1. Launch the the DX80 Configuration Software.
2. In the menu bar, go to Device > Connection Settings and select Serial or Ethernet DXM.
3. In the Configuration > Device Configuration screen, click on the arrow next to the Gateway to expand and display

the Gateway's parameters.
4. In the System section, use the Devices in system drop-down list to make your selection.

This allows the user to maximize the use of the EtherNet/IP buffer to 28 devices.
EDS (Electronic Data Sheet) files allow users of the EtherNet/IP protocol to easily add a Banner DXM device to the PLC.
Download the EDS files from the Banner website.

• DXM EDS Configuration File (for PLCs) (p/n b_4205242)
• DXM EIP Config File for DXM Controller with Internal Gateway (Models: DXM1xx-BxR1, DXM1xx-BxR3, and

DXM1xx-BxCxR1) (p/n 194730)

8.6.1 Download an Existing Configuration from the DXM
If you have an existing configuration file, save the XML file locally as a back-up on your computer.

1. Apply power to the DXM.
2. Connect an ethernet or USB cable between your computer and the DXM.
3. Launch the DXM Configuration Software v4 and select your DXM model.

5 EttherNet/IP is a trademark of Rockwell Automation.
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4. On the Device > Connection Settings menu, select one of the following:
• Select TCP/IP as the connection type and enter the IP Address of the DXM Controller; or
• Select Serial as the connection type and select the appropriate Comm port

5. On the menu bar, select Device > Get XML configuration from DXM to download the XML configuration file.
6. Save the XML file locally on your computer.

8.6.2 Configuring the Controller
Use the configuration software to define the Protocol conversion for each local register to be EIP Originator > DXM or EIP
DXM > Originator from the Edit Register or Modify Multiple Register screens.
Define a DXM local register as EIP Originator > DXM when the host PLC (Originator) will send data to the DXM local
register (DXM).
Define a DXM local register as EIP DXM > Originator when that register data will be sent from the DXM (DXM) to the host
PLC (Originator).
Data from an EIP controller in assembly instance 112 is data destined for the DXM local registers. The PLC is normally
configured for INT or UINT data transfer. This allows for a seamless transfer of data.

EIP Assembly Instance 112 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 1 1122

1 3344 2 3344

2 5566 3 5566

3 7788 4 7788

4 9900 5 9900

Data from the DXM local registers is sent to the EIP controller using assembly instance 100. Each local register in the DXM
defined as EIP DXM > Originator is collected in numerical order and placed into the data buffer destined for assembly
instance 100. DXM local registers are capable of 32-bits, but only the lower 2-bytes (16-bits) for each local register are
transferred.

EIP Assembly Instance 100 (16-bit) DXM Local Registers

Adrs Data Adrs Data

0 1122 11 1122

1 3344 12 3344

2 5566 13 5566

3 7788 14 7788

4 9900 15 9900

Configure the Local Registers to Export Data to a PLC
1. On the DXM Configuration Software: Go to the Local Registers screen.
2. Select the register(s) that will be exported to a Host PLC.

A maximum of 228 registers can be read or written with Ethernet/IP.
3. In the Storage/Connectivity section, select EIP DXM -> Originator from the Protocol conversion drop-down list.

To change a block of continuous local registers, use the Modify Multiple Registers screen.

Configure the Local Registers to Import Data from a PLC
1. On the DXM Configuration Software: Go to the Local Registers screen.
2. Select the register(s) that will be imported from a Host PLC.

A maximum of 228 registers can be read or written with Ethernet/IP.
3. In the Storage/Connectivity section, select EIP Originator -> DXM from the Protocol conversion drop-down list.

To change a block of continuous local registers, use the Modify Multiple Registers screen.
To view the EIP Input and Output registers, go to the Tools > Protocol Conversion screen. You may also export the
register map to a CSV file.
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Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.
Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending
the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving the
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File > Save As menu.
2. Go to the DXM > Send XML Configuration to DXM menu.

Figure 38. Status indicator bar

• If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in the
cable and reconnect the DXM to the software.

• If the Application Status indicator is green, the file upload is complete.
• If the Application Status indicator is yellow, the file transfer is in progress.
The device reboots and begins running the new configuration.

8.6.3 Configuring the Host PLC
On the host PLC, install the DXM using an EDS file or by using the following parameters:

• Assembly1: Originator to DXM = Instance 112, 456 bytes (228 words)
• Assembly2: DXM to Originator = Instance 100, 456 bytes (228 words)

The Originator is the host PLC system, and the DXM is the DXM. The host system sees the DXM as a generic device with
the product name of Banner DXM (ProdType: 43 - Generic Device, ProdName: Banner DXM, Integer Type - INT).

Important: Do not set the Requested Packet Interval (RPI) any faster than 150 ms.

8.7 Setting up Email and Text Messaging
The DXM can be configured to send email or SMS messages based on threshold conditions.

Important: Only the DXM100 and DXM150 models offer SMS/text messaging capabilities.

Cellular-connected systems can use email or SMS. Ethernet-connected systems can only use email, but can send email to
cellular phones as a SMS message depending upon the network carrier. To send email to a Verizon phone, use the phone
number followed by @vtext.com, for example, 1234567890@vtext.com.
For more information, refer to the DXM Configuration Software Instruction Manual (p/n 209933). Internal log files may be sent
using email. Follow these instructions and use the DXM Configuration Software to program the controller for email and/or
SMS.

1. On the Settings > System screen, set the Device Time on the DXM.
2. On the Settings > Cloud Services screen, select either Ethernet or Cell for the Push Interface.
3. If you selected Ethernet, configure your Ethernet connection by setting the IP settings on the Ethernet screen. If you

selected a Push interface of Cell, use the Cellular screen to define parameters.
4. Set the email and message parameters on the Notifications screen.
5. To send alert messages, define the threshold rule to use email and/or SMS.
6. To send log files, define the log file parameters.

8.7.1 Define the Network Interface Settings
On the Cloud Services screen (shown with Show advanced settings selected), define the network connection settings by
selecting Ethernet or Cell from the Network Interface drop-down list. This determines how the DXM sends data.
If you don't require pushing data to a web server, set the Cloud Push interval to zero.
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Figure 39. Cloud Services screen

8.7.2 Configure your Ethernet Connection
To send email based on a threshold rule or to email log files, first define the network and email servers. When selecting
Ethernet, go to the Settings > Ethernet screen.

1. To define the Ethernet IP address, give the DXM a static IP address. In most cases you may select the device to use
DHCP and have the IP address automatically assigned.

2. DNS settings are not typically required. The DXM uses a public service to resolve Domain names, but if the network
connection does not have Internet access, the DNS settings may be required.

Figure 40. Settings > Ethernet screen

8.7.3 Configure your Cellular Connection
To use a cellular connection, select Cell as the network connection on the Settings > Cloud Services screen (see Configure
the DXM Controller for a Cellular Modem on page 40). The Cellular screen does not display unless the Network interface is
set to Cell.
Using a 4G LTE cell module requires a cellular plan; follow the instructions on p/n 205026 to activate a cell modem.

1. On the Settings > Cellular screen, select your cellular modem from the drop-down list.
2. Set the APN.

• If you are using a Banner 4G LTE Verizon Module (LE910), set the APN to vzwinternet.
• If you are using an Emnify 3G GSM Cellular Radio (HE910), set the APN to EM. This module does not require

an APN username or password.
• If you are using a third-party SIM card, the APN, APN Username, and Password must be provided by the

cellular service provider.
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8.7.4 Set the Email and Messaging Parameters
From the Settings > Notifications screen, enter the SMTP definition, login, and password for a mail server.

Important: Only the DXM100 and DXM150 models offer SMS/text messaging capabilities.

To send email, you must supply the SMTP Server, Server Port, and login credentials. When you are only sending SMS
messages over cellular, the SMTP Server is not required.
The default SMTP port is 25 but may need to be adjusted for Ethernet-based networks. Note that many facilities block port
25. Port 587 is another common SMTP submission port.
The SMTP password is not stored in the XML configuration file, but on the DXM. After the password is entered, click on Send
SMTP Password to send it to the DXM. The password is stored in non-volatile memory, so reboot the DXM to recognize the
new password.
When using a GMail server, select Situational encryption and Enable SMTP authentication. The GMail server will not
allow you to send email alerts using the cellular interface. GMail may notify you that you must allow access for less secure
apps in your email settings.
For other email servers, the parameters may vary and will require information from the provider.

Figure 41. Mail and email settings

At the bottom of the screen, define the recipient to receive emails. These recipients selected in the threshold definition for
sending alert messages.
Sending SMS alerts requires that the Cellular Radio chip be installed and configured, regardless of the Push Interface used.
This setting allows a user to receive SMS alerts directly on their cell phone in the case of critical component changes or
failures.

1. On the Settings > Notifications screen, add recipients for SMS alerts.
2. In this section, you may change the Name of the recipient, add a phone Number, and insert a Message for the

recipient.
3. SMS alerts will be received in the format: Message Active/Inactive or Threshold Rule Name Active/Inactive

depending on the configuration.
4. Enter the phone numbers for SMS messages.

• 4G LTE cellular: Enter phone numbers without dashes. For example, a US phone number of (234) 555-1212
would be entered as 2345551212.

• Emnify GSM cellular: Enter phone numbers using the country code, area code, and phone number. For
example, a US phone number of (234) 555-1212 would be entered as 12345551212. These cellular modems
are not certified for use in the US.
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8.7.5 Define Threshold Rules for Email
To define a threshold, go to Local Registers > Action Rules > Thresholds.
Depending upon which recipients are defined, select the appropriate email or SMS checkbox for the threshold rule (under
Email/SMS on state transition). When the threshold rules goes active or inactive, an email is generated.
For more information on how to set up threshold rules, refer to the DXM Configuration Software Instruction Manual (p/n 
209933).

8.7.6 Define Log File Parameters for Emailing Log Files
The DXM can email log files generated on the device.
Before emailing log files, set the Mail and Messaging parameters to provide the login credentials. When using Ethernet,
verify the IP address settings are defined on the Ethernet screen. Set the DXM time, under Settings > System, so that all
data is properly time stamped.
Use the Local Registers > Local Registers in Use > Edit Register screen to select which registers to log which log file (set
the SD card logging to the log file. Define the setup of the log file using the Settings > Logging screen. Typical settings are
shown.

1. Enable the log and timestamp with every entry.
2. Enter the filename, log rate, and the maximum file size to send via email (5 to 10k is an efficient size for a cellular

connection). Banner does not recommend setting the log file size larger than 100 kB as this cannot be read through
the configuration software and must be read directly from the SD card.

3. Define the email address.

Figure 42. Defining the data log files

4. Define the local register data put into the log file using the Local Registers > Local Register Configuration screen,
under the Logging and Protocol Conversion section. From the SD Card Logging drop-down list, select the log file
to write to. Log files are written in CSV format.

5. Use the DXM Configuration Software to read back the log files. Under Settings > Logging, click Refresh List,
highlight the file to download, then click Save Selected.

8.8 Ethernet and Cellular Push Retries
The DXM can be configured to send register data packets to a webserver. When the Ethernet or cell communications path is
not operating, the DXM retries the send procedure. The communications retry process is outlined below for each
configuration.
Regardless of the communications type (Ethernet or cellular), a failed attempt results in the register data packet being saved
on the local micro SD card 6. The number of retries will depend upon the network connection type.
When there is bad cellular signal strength or there is no Ethernet connection, the transmission attempts are not counted as
failed attempts to send data. Only when there is a good network connection and there are 10 failed attempts will the
controller archive the data on the SD card. Data archived on the SD card must be manually retrieved.

6 Enable HTTP logging to save data on the SD card; this is the factory default. See SETTINGS -> LOGGING in the DXM Configuration Tool.
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8.8.1 Ethernet Push Retries
With an Ethernet-based network connection, the DXM retries a message five times. The five retry attempts immediately
follow each other. After all attempts are exhausted, the register data packet is saved on the micro SD card.
At the next scheduled time, the DXM attempts to send the saved packet as well as the newly created register data packet. If
it cannot send the new register data packet, the new register data packet is appended to the saved file on the micro SD card
to be sent later. After 10 rounds of retries, the data set is archived on the micro SD card under folder _sxi. No additional
attempts to resend the data are made; the data file must be manually retrieved.
Using SSL on Ethernet will have no retries, but will save each failed attempt to the micro SD card until 10 failed rounds. At
this time, the register data packet is archived.

8.8.2 Cellular Push Retries
In a cellular-connected system there are no retries. Failed transmissions are saved on the micro SD card.
After 10 successive failed attempts, the data is archived in the _sxi folder. Send attempts with a low signal quality are not
counted against the 10 count limit. For example, if the cellular antenna is disconnected for period that the DXM controller
would have sent 20 messages under normal circumstances, all 20 messages would be saved and will be retried when the
antenna is reconnected. If the signal quality was good, but the cellular network was not responding, the DXM archives the
register data packets after 10 failed attempts.

8.8.3 Event/Action Rule or Log File Push Retries
Event-based pushes caused by Action rules and locally stored log files sent using email follow the same process when
failures occur, based on the network connection. The failed Event-based messages are resent with the next cyclical schedule
or the next event message that triggers a push message.

8.8.4 Email and Text Message Push Retries
There are no retries for emails or SMS messages that fail to be sent from the DXM.
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9 Additional Information

9.1 Working with Modbus Devices
The DXM has two physical RS-485 connections using Modbus RTU protocol.
The DXM can be a Modbus RTU master device to other slave devices and can be a Modbus slave device to another Modbus
RTU master. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU master to control external slave devices. All
wired devices connected to the master RS-485 port must be slave devices.

• As a Modbus RTU master device, the DXM controls external slaves connected to the primary RS-485 port, the local
ISM radio, local I/O base board, and the local display board.

• As a Modbus RTU slave device, the DXM local registers can be read from or written to by another Modbus RTU
master device.

The secondary port (S+/S-) is the Modbus RTU slave connection. The secondary (slave) Modbus RS-485 port (S+/S-) is
controlled by another Modbus master device, not the DXM. The slave port is used by an external Modbus master device that
will access the DXM as a Modbus slave device.

Figure 43. Processor Modbus system overview
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The DXM has dual Modbus roles: a Modbus slave device and a Modbus master device. These run as separate processes.
The Modbus slave port can only access the DXM local registers. To operate as a Modbus slave device, the DXM needs to be
assigned a unique Modbus slave ID as it pertains to the host Modbus network. This slave ID is separate from the internal
Modbus slave IDs the DXM uses for its own Modbus network. The DXM Modbus slave ID is defined through the LCD menu.
Other Modbus slave port parameters are defined by using the configuration software.
The DXM operates the Modbus master port. Each device on the master port must be assigned a unique slave ID. There are
slave IDs that are reserved for internal devices in the DXM.
Table 12: DXM Internal Modbus Slave IDs (factory default)

Modbus Slave ID Device

1 DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio
should be assigned Modbus Slave addresses starting at 11.

199 Local Registers—Internal storage registers of the DXM

200 I/O Base Board—All data and parameters for each input or output of the DXM.

201 LCD Display—The user has access to the LED indicators on the DXM.

9.1.1 Assigning Modbus Slave IDs
Assign the DXM Modbus Slave ID only if a Modbus master device is reading or writing the DXM Local Register data through
the Modbus RS-485 slave port (S+, S-).
Set the DXM Slave ID from the LCD menu under System > DXM Slave ID. The DXM can have any unique slave ID between
1 and 246, depending upon the host Modbus network. Other RS-485 slave port parameters are set in the configuration
software under the Settings > General tab.
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DXM Master Configuration—When the DXM operates as a Modbus master device, use the configuration software to
configure read or write operations of the DXM Modbus network. The DXM communicates with all internal and external
peripheral devices using the external Modbus bus RS-485 (M+, M-)
There are four internal Modbus slave devices that are configured from the factory with slave IDs. Assign slave IDs of 2
through 10 to Modbus slave devices that are physically wired to the DXM. Assign slave IDs or 11 through 60 to wireless
slaves within the MultiHop network.
Do not assign a slave ID of greater than 10 to Modbus slave devices that are physically wired using the RS-485 port if there
is an internal MultiHop ISM radio in the DXM. The MultiHop ISM radio attempts to send any Modbus data intended for slaves
11–60 across the radio network, which conflicts with wired slave devices if the slave IDs overlap. The MultiHop master radio
can be changed from the factory default of 11–60 Modbus slave IDs if more hardwired slaves are required.

9.1.2 Wireless and Wired Devices
Wireless DX80 Gateway—The DX80 Gateway architecture is a star architecture in which all Nodes in the system send their
data back to the Gateway. The host can access the entire network data from the Gateway, which is Modbus slave ID 1.
Because the DXM will not be sending any Modbus messages across the wireless link, the timeout parameter can be set low
(less than 1 second) and the device is treated like a directly connected device.
MultiHop Master—The MultiHop master radio forms a wireless tree network using repeaters and slave devices. Each device
in a MultiHop network must be assigned a unique Modbus Slave ID and is accessed as a separate device. For the DXM to
talk with a MultiHop device in the wireless network, the master MultiHop device interrogates every message on the RS-485
bus. If they are within the wireless devices range (slave IDs 11 though 60), the message is sent across the wireless network.
To change this range, the user must adjust the offset and range setting in the MultiHop master radio (Modbus Slave ID 1).
Modbus register 6502 holds the Modbus offset, default 11. Modbus register 6503 holds the number of Modbus slaves
allowed (maximum of 100).
Table 13: Modbus Slave IDs for wireless and wired devices

Modbus Slave ID Description

1 Allocated for the internal ISM radio device, either a DX80 Gateway or MultiHop Master

2–10 Slave addresses available for direct connected Modbus slave devices to the master RS485 port (M+ , M-)

11–60 Allocated for wireless MultiHop radio network devices. If there is not an internal MultiHop in the DXM, these slave addresses are
available to use for directly connected devices.

61–198 Available to user for direct connected Modbus slave devices or the expansion of the wireless network slave IDs to go past 50
wireless devices.

199 Allocated for internal Local Register

200 Allocated for the I/O base board, will be different for special DXM slave only models.

201 Allocated for the LCD display board, the user can read/write LEDs.

9.1.3 Modbus Communication Timeouts
A Modbus timeout is the amount of time a Modbus slave is given to return an acknowledgment of a message sent by the
Modbus master. If the Modbus master waits for the timeout period and no response is seen, the Modbus master considers it
a lost message and continues on to the next operation.
The timeout parameter is simple to set for Modbus devices directly connected to the DXM, if there are no MultiHop wireless
devices. Special considerations need to be made to set the timeout parameter when a MultiHop network uses the DXM as
the master radio.
Configure controllers operating wireless networks to allow for enough time for hardware transmission retries. Set the
Communications Timeout parameter to cover the expected time for messages to be sent throughout the wireless network.
For the DXM, the Communications Timeout parameter is the maximum amount of time the DXM should wait after a request
is sent until the response message is received from the Modbus slave device. Use the DXM Configuration Software to set the
timeout parameter on the Settings > System screen (select Show advanced settings).
The default setting for the timeout parameter is 5 seconds.

MultiHop Networks vs DX80 Star Networks
The DX80 star Gateway collects all the data from the Nodes, which allows the host system to directly read the data from the
Gateway without sending messages across the wireless network. This allows for DX80 Gateway to be treated like any other
wired Modbus device.
In a MultiHop network, the data resides at each device, forcing the controller to send messages across the wireless network
to access the data. For this reason, carefully consider the value of the wireless timeout parameter.
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Calculating the Communications Timeout for Battery-Powered MultiHop
Radios
Battery-powered MultiHop radios are configured to run efficiently to maximize battery life. By optimizing battery life, the
allowed communications window for receive messages is slow (once per 1.3 seconds) and sending message rates are
standard (once per 0.04 seconds).
A MultiHop device is set from the factory with the retry parameter of 8. This means that under worst-case conditions, a
message is sent from the DXM to an end device a total of nine times (one initial message and eight retry messages). The
end device sends the acknowledgment message back to the DXM a maximum of nine times (one initial message and eight
retries). A single Modbus transaction may send up to two messages + 16 retry messages before the transaction is complete.
In addition, the radios randomly wait up to one time period before retransmitting a retry message. So to allow for the random
wait time, add one extra time period for each in-between time of retries.
To calculate the communication timeout parameter for a Master radio to a slave radio (no repeaters):

Master to Slave Send time = (9 × 1.3 sec) + (8 retry wait × 1.3 sec) = 22 seconds
Slave to Master Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total Send/Receive time = 23 seconds
Minimum Timeout period = 23 seconds

If the link quality of the network is poor, the maximum transfer times may happen. Set the timeout parameter to
accommodate the maximum number of retries that may happen in your application.
When MultiHop repeaters are added into the wireless network, each additional level of hierarchical network increases the
required timeout period. Since MultiHop repeaters are running at the highest communications rate, the overall affect is not as
great.

Master to Repeater Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Repeater to Master Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Additional Timeout period for a repeater = 2 seconds

Using the timeout calculation above of 23 seconds, if a repeater is added to the network the timeout should be set to 25
seconds. For each additional MultiHop repeater device creating another level of network hierarchy, add an additional two
seconds to the timeout period.

Calculating the Communication Timeout for 10–30 VDC MultiHop Radios
Line-powered (10–30 V dc) MultiHop devices operate at the maximum communication rate, resulting in a much lower timeout
parameter setting. For each repeater added to the network, increase the timeout parameter 2 seconds.
For a Master radio to a 10–30 V dc powered slave radio (no repeaters):

Master to Slave Send time = (9 × 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Slave to Master Send time = (9 ×* 0.04 sec) + (8 retry wait × 0.04 sec) = 1 second
Total Send/Receive time = 2 seconds
Minimum Timeout period = 2 seconds

Adjusting the Receive Slots and Retry Count Parameters
The number of receive slots governs how often a MultiHop device can communicate on the wireless network.
Battery-powered devices typically have DIP switches that allow the user to set the number of receive slots, which directly
affects the battery life of the radio. Adjusting the receive slots changes how often a message can be received. By default, the
receive slots are set to 4 (every 1.3 seconds). When the receive slots are set to 32, the radio listens for an incoming
message every 0.16 seconds.
Users may also leave the retry mechanism to the application that is accessing the wireless network, in this case the DXM.
Adjust the number of retries in the MultiHop devices by writing the number of retries desired to Modbus register 6012. The
factory default setting is 8.

Calculating the Communication Timeout for a DX80 Star Network
In the DX80 network, all Node data is automatically collected at the Gateway to be read. The DXM does not use the wireless
network to access the data, which allows for much faster messaging and much lower timeout values.
For a DXM with an internal DX80 Gateway, set the timeout value 0.5 seconds. If other Modbus slave devices are connected
to the RS-485 lines, the timeout parameter governs all communication transactions and must be set to accommodate all
devices on the bus.
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9.1.4 Modbus TCP Client
The DXM can operate as a Modbus TCP client on Ethernet. Users may define up to five socket connections for Modbus TCP
server devices to read Modbus register data over Ethernet. Use the DXM Configuration Software to define and configure
Modbus TCP client communications with other Modbus TCP servers.

9.2 Modbus Register Summary

9.2.1 DXM Modbus Registers
The DXM may have up to four internal Modbus slave devices.
All Modbus registers are defined as 16-bit Modbus Holding Registers. When connecting external Modbus slave devices, only
use Modbus slave IDs 2 through 198. The local registers, the I/O base, and the LCD slave IDs are fixed, but the internal radio
slave ID can be changed if needed.
Table 14: DXM Internal Modbus Slave IDs (factory default)

Modbus Slave ID Device

1 DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio
should be assigned Modbus Slave addresses starting at 11.

199 Local Registers—Internal storage registers of the DXM

200 I/O Base Board—All data and parameters for each input or output of the DXM.

201 LCD Display—The user has access to the LED indicators on the DXM.

9.2.2 Modbus Registers for the MultiHop Radio Board Module
The DX80 MultiHop master radio is a tree-based architecture device that allows for repeater radios to extend the wireless
network. Each device in a MultiHop network is a Modbus device with a unique Modbus ID.
Modbus registers in a MultiHop network are contained within each individual radio device. To obtain Modbus register data
from a MultiHop device, configure the DXM to access each device across the wireless network as an individual Modbus slave
device.
Table 15: Example MultiHop Modbus registers with generic devices.

MulitHop Device Slave ID Modbus Registers

DXM Master radio 1 none

Slave radio 11 Modbus register 1–16 are inputs, 501–516 are outputs

Repeater radio 12 Modbus register 1–16 are inputs, 501–516 are outputs

Slave radio 15 Modbus register 1–16 are inputs, 501–516 are outputs

9.2.3 Modbus Registers for the Performance Gateway Radio Module
The DX80 Performance Gateway is a star-based architecture device that contains all the Modbus registers for the wireless
network within the Gateway. To access any input or output values within the entire wireless network, read the appropriate
Modbus register from Gateway.
There are 16 Modbus registers allocated for each device in the wireless network. The first 16 registers (1–16) are allocated
for the Gateway, the next 16 (17–32) are allocated for Node 1, the next 16 (33–48) are allocated for Node 2 and so forth.
There are no inputs or outputs on the DXM embedded Gateway but the Modbus registers are still allocated for them.
Although only seven Nodes are listed in the table, the Modbus register numbering continues for as many Nodes as are in the
network. For example, the register number for Node 10, I/O point 15 , is 175. Calculate the Modbus register number for each
device using the equation:

Register Number = I/O# + (Node# × 16)

Table 16: Modbus holding registers

I/O Point Gateway Node 1 Node 2 Node 3 Node 4 Node 5 Node 6 Node 7

1 1 17 33 49 65 81 97 113
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I/O Point Gateway Node 1 Node 2 Node 3 Node 4 Node 5 Node 6 Node 7

2 2 18 34 50 66 82 98 114

3 3 19 35 51 67 83 99 115

4 4 20 36 52 68 84 100 116

5 5 21 37 53 69 85 101 117

6 6 22 38 54 70 86 102 118

7 7 23 39 55 71 87 103 119

8 8 24 40 56 72 88 104 120

9 9 25 41 57 73 89 105 121

10 10 26 42 58 74 90 106 122

11 11 27 43 59 75 91 107 123

12 12 28 44 60 76 92 108 124

13 13 29 45 61 77 93 109 125

14 14 30 46 62 78 94 110 126

15 15 31 47 63 79 95 111 127

16 16 32 48 64 80 96 112 128

Table 17: Access all wireless network registers by reading Modbus slave ID 1

DX80 Device Slave ID Modbus Registers

DXM Gateway radio 1 Modbus registers 1–8 are inputs, 9–16 are outputs

Node 1 - Modbus registers 17–24 are inputs, 25–32 are outputs

Node 2 - Modbus registers 33–40 are inputs, 41–48 are outputs

Node 3 - Modbus registers 49–56 are inputs, 57–64 are outputs

Alternative Modbus Register Organization
The Sure Cross DX80 Alternative Modbus Register Organization registers are used for reordering data registers to allow host
systems to efficiently access all inputs or outputs using a single Modbus command. The register groups include the input/
output registers, bit-packed registers, and analog registers. This feature is only available with the Performance models using
version 3 or newer of the LCD firmware code.
Table 18: Alternative Modbus register organization

Name Modbus Register Address (Decimal)

Inputs and Outputs, in order by device 2201 through 4784

Discrete Bit Packed (Status, Discrete Inputs, Discrete Outputs) 6601 through 6753

Analog Inputs (1–8) and Analog Outputs (1–8) 6801 through 9098

Input Registers and Outputs Registers
Modbus registers 2201 through 2584 are used to organize all inputs together.
In this format, users can sequentially read all input registers using one Modbus message. Modbus registers 4401 through
4784 organize all outputs together to allow users to sequentially write to all outputs registers using one Modbus message.
Table 19: Input and output registers

Inputs (2201–2584) Outputs (4401–4784)

Modbus Register Address
(Decimal)

16-bit Register Value Modbus Register Address
(Decimal)

16-bit Register Value

2201–2208 Gateway Inputs 1 through 8 4401–4408 Gateway Outputs 1 through 8

2209–2216 Node 1 Inputs 1 through 8 4409–4416 Node 1 Outputs 1 through 8
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Inputs (2201–2584) Outputs (4401–4784)

Modbus Register Address
(Decimal)

16-bit Register Value Modbus Register Address
(Decimal)

16-bit Register Value

2217–2224 Node 2 Inputs 1 through 8 4417–4424 Node 2 Outputs 1 through 8

... ... ... ...

2577–2584 Node 47 Inputs 1 through 8 4777–4784 Node 47 Outputs 1 through 8

Refer to your device's datasheet for a list of the active inputs and outputs. Not all inputs or outputs listed in this table may be
active for your system.

Discrete Bit-Packed Registers
Discrete bit-packed registers include the discrete status registers, discrete inputs, and discrete outputs.
Bit packing involves using a single register, or range of contiguous registers, to represent I/O values.
When networks use similar Nodes to gather data using the same I/O registers for each Node, discrete data from multiple
Nodes can be bit packed into a single register on the Gateway. The bit-packed data is arranged by I/O point starting at
Modbus register 6601. For example, Discrete IN 1 for all the Nodes in the network is stored in three contiguous 16-bit
registers.
The most efficient way to read (or write) discrete data from a Sure Cross® DX80 Gateway is by using these bit-packed
registers because users can read or write registers for all devices using one Modbus message. The following registers
contain discrete bit-packed I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for each
Node in order of Node address.

Figure 44. Discrete bit-packed register addresses and bit positions

Bit-Packed Device Status Registers
Bit Position

Register Address 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
6601 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6602 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6603 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Input 1
Bit Position

Register Address 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
6611 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6612 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6613 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Output 1
Bit Position

Register Address 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
6691 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6692 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6693 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Table 20: Discrete bit-packed registers for inputs and outputs

Inputs Outputs

Modbus Register Address
(Decimal)

Description (Inputs) Modbus Register
Address (Decimal)

Description (Outputs)

6601–6603 Status for all devices

6611–6613 Input 1 from all devices 6691–6693 Output 1 from all devices

6621–6623 Input 2 from all devices 6701–6703 Output 2 from all devices

6631–6633 Input 3 from all devices 6711–6713 Output 3 from all devices

6641–6643 Input 4 from all devices 6721–6723 Output 4 from all devices

6651–6653 Input 5 from all devices 6731–6733 Output 5 from all devices

6661–6663 Input 6 from all devices 6741–6743 Output 6 from all devices

6671–6673 Input 7 from all devices 6751–6753 Output 7 from all devices
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Inputs Outputs

Modbus Register Address
(Decimal)

Description (Inputs) Modbus Register
Address (Decimal)

Description (Outputs)

6681–6683 Input 8 from all devices

Status registers (6601–6603) contain a bit-packed representation defining the devices that are operational in the wireless
system. Each bit indicates Node in Sync (1) or Node Not in Sync (0).
Input registers from all devices use Modbus registers 6611 through 6683 to organize the least significant bit into a
sequential array of registers. The first register contains the least significant bit from the input values for the Gateway through
Node 15. The second register contains the input values for Node 16 through Node 31, and the third register contains the
input values for Nodes 32 through 47.
For discrete inputs, only the least significant bit is used. For analog inputs, the least significant bit indicates if the analog
value is above or below the selected threshold value (when using the threshold parameter configured in the User
Configuration Software). For example, a least significant bit of one (1) indicates the analog value is above the selected
threshold value. A least significant bit of zero (0) indicates the analog value is below the threshold value.
Output registers from all devices use Modbus registers 6691 through 6753 to organize the least significant bit into a
sequential array of registers. Output 8 (I/O point 16) cannot be written using the discrete format.

Analog 16-Bit Registers (Registers 6801 through 9098)
The most efficient way to read (or write) analog data from a Gateway is by using these 16-bit analog registers. Most networks
consist of similar Nodes reporting data using the same I/O registers for each Node. For this reason, the analog data is
arranged by I/O point using Modbus registers 6801 through 9098.
For example, Input 1 for Gateway and all Nodes is stored in the first 48 contiguous blocks of 16-bit analog registers,
beginning with register 6801.
In this format, users can read a 16-bit holding register for all devices or write to a register for all devices using one Modbus
message. Using these registers is the most efficient way to read all status registers, read all analog inputs, or write all analog
outputs.
The following registers contain analog I/O values for the Gateway and all Nodes. Values are stored first for the Gateway,
then for each Node in order of Node address.
Table 21: Analog input and output registers

Inputs Outputs

Modbus Register Address
(Decimal)

Description (Inputs) Modbus Register Address
(Decimal)

Description (Outputs)

6801 Input 1 for Gateway 8001 Output 1 for Gateway

6802 Input 1 for Node 1 8002 Output 1 for Node 1

6803 Input 1 for Node 2 8003 Output 1 for Node 2

... ... ... ...

6951 Input 2 for Gateway 8151 Output 2 for Gateway

6952 Input 2 for Node 1 8152 Output 2 for Node 1

6953 Input 2 for Node 2 8153 Output 2 for Node 2

... ... ... ...

7101 Input 3 for Gateway 8301 Output 3 for Gateway

7102 Input 3 for Node 1 8302 Output 3 for Node 1

7103 Input 3 for Node 2 8303 Output 3 for Node 2

... ... ... ...

7851 Input 8 (Status Register) for Gateway 9051 Output 8 for Gateway

7852 Input 8 (Status Register) for Node 1 9052 Output 8 for Node 1

7853 Input 8 (Status Register) for Node 2 9053 Output 8 for Node 2

... ... ... ...

For example, 6801 contains the input 1 value for the Gateway, 6802 contains the input 1 value for Node 1, and 6848 contains
the input 1 value for Node 47.
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9.2.4 Internal Local Registers (Slave ID 199) for the DXM100 and
DXM150
The main storage elements for the DXM are its Local Registers, which can store 4-byte values that result from register
mapping, action rules, or ScriptBasic commands.

• Local Registers 1 through 850 are standard 32-bit unsigned registers.
• Local Registers 851 through 900 are non-volatile registers that are limited to 100,000 write cycles.
• Local Registers 1001 through 1900 are floating point format numbers. Each register address stores half of a floating

point number. For example, registers 1001 and 1002 store the first full 32-bit floating point number.
• Local Registers 10001 through 19000 are system, read-only, registers that track DXM data and statistics.

Table 22: Modbus Registers for Internal Local Registers (Modbus Slave 199)

Local Registers Type Description

1–845 32-bit unsigned Internal processor memory

846–849 32-bit unsigned Reset, Constant, Timer

851–900 32-bit unsigned Data flash, non-volatile

1001–1900 32-bit IEEE Floating Point Floating point registers, internal processor memory

> 10000 Read-only virtual registers

Local Registers 1–850 (Internal Processor Memory, 32-bit, Unsigned)—The Local Registers are the main global pool of
registers. Local Registers are used as basic storage registers and as the common data exchange mechanism. External
Modbus device registers can be read into the Local Registers or written from the Local Registers. The DXM, as a Modbus
master device or a Modbus slave device, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP)
uses the Local Registers as the accessible register data.
Local Registers 851–900 (Data Flash, Non-volatile, 32-bit, Unsigned)— The top 50 Local Registers are special non-
volatile registers. The registers can store constants or calibration type data that must be maintained when power is turned off.
This register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so these registers
should not be used as common memory registers that change frequently.
Local Registers 1001–1900 (32-bit IEEE Floating Point)— These Local Registers are paired together to store a 32-bit
IEEE floating point format number in big endian format. Registers 1001 [31:16], 1002 [15:0] store the first floating point value;
registers 1003, 1004 store the second floating point number. There are a total of 500 floating point values; they are
addressed as two 16-bit pieces to accommodate the Modbus protocol. Use these registers when reading/writing external
devices that require Modbus registers in floating point format. Since Modbus transactions are 16-bits, the protocol requires
two registers to form a 32-bit floating point number.
Virtual Registers— The DXM has a small pool of virtual registers that show internal variables of the main processor. Some
register values will be dependent upon the configuration settings of the DXM. Do not use Read Rules to move Virtual Local
Registers data into Local Registers. Use the Action Rule > Register Copy function to move Virtual Local Registers into
Local Registers space (1-850).
Table 23: Virtual registers

Virtual Registers Definition

10001 GPS latitude direction (N, S, E, W)

GPS Coordinate Data if the DXM is configured to read an external GPS unit.
10002 GPS latitude

10003 GPS longitude direction (N, S, E, W)

10004 GPS longitude

10011–10012 Resync timer Engineering use

10013–10014 Resync timer rollover Engineering use

10015–10016 Reboot cause (Restart Codes above) Reboot Type

10017–10018 Watchdog reset count Counter to track how many resets have been caused by the Watchdog

10021 IO Board Battery Voltage (mV) mV

10022 IO Board - Incoming Supply Voltage (mV) mV

10023 Cut-off Feature
0—No successful readings
1—Normal range
2—Cut-off engaged
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Virtual Registers Definition

10024 IO Board - Battery Charging Current (mA) mA

10025–10026 Http Push SSL Acquires
Statistical counts of connections, disconnections and forced disconnects when
the DXM creates a connection using SSL/TLS (Encrypted connections)

10027–10028 Http Push SSL Releases

10029–10030 Http Push SSL Forced Releases

10031–10032 Http Push Attempts
Statistical counts of connections, disconnections and forced disconnects when
the DXM controller creates a connection using HTTP non-encrypted

10033–10034 Http Push Successes

10035–10036 Http Push Failures

10037–10038 Http Push Last Status

Last DXM push status

0 = Initial state, no push attempt as finished yet
1 = Attempt complete
2 = Attempt aborted

10039–10040 Cellular Strength, BER

Cellular signal strength. Value range: 0–31

0 = –113 dBm or less
1 = –111 dBm
2–30 = –109 dBm through –53 dBm in 2 dBm steps
31 = –51 dBm or greater
99 = not known or not detectable; BER not used

10055–10056 Alarms, smtp, attempts Email attempts

10057–10058 Alarms, smtp, fails Email failures

10059–10060 Alarms, sms, attempts SMS text message attempts

10061–10062 Alarms, sms, fails SMS text message failures

10100 Number of read maps in default

Read Map statistics

10101 Number of read map successes

10102 Number of read map timeouts

10103 Number of read map errors

10104 Read map success streak

10105 Number of write map successes

Write Map statistics
10106 Number of write map timeouts

10107 Number of write map errors

10108 Write map success streak

10109 Number of passthrough successes

API message passing statistics
10110 Number of passthrough timeouts

10111 Number of passthrough errors

10112 Passthrough success streak

10113 Number of 43 buffer successes

DX80 Gateway automatic messaging buffer statistics
10114 Number of 43 buffer timeouts

10115 Number of 43 buffer errors

10116 43 buffer success streak

11000 Read map success count

Read/Write maps statistics

12000 Write map success count

13000 Read map timeout count

14000 Write map timeout count

15000 Read map error count
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Virtual Registers Definition

16000 Write map error count

17000 Read map success streak

18000 Write map success streak

19000 Read map is in default

Table 24: The reset codes are in virtual register 11015 and define the condition of the last restart operation.

Reset Code Definition

0 Undefined

1 Unknown

2 General

3 Brownout

4 Watchdog

5 User

6 Software

7 Return from backup mode

9.2.5 Internal Local Registers (Slave ID 199) for the DXM700,
DXM1000, and DXM1200
The main storage elements for the DXM are its local registers, which can store 4-byte values that result from register
mapping, action rules, or ScriptBasic commands.
Local registers updated from Modbus transactions are restricted to a16-bit data value to follow standard Modbus holding
register definition.
The local registers defined in action rules must all be within the same register group. For example, an action rule cannot have
inputs from an integer group with the result register defined as a floating point register. To move between integers and floats,
use the Register Copy Rule.

• Local registers 1–850 and 5001–7000 are 32-bit integer registers
• Local registers 851–900 and 7001–8000 are non-volatile 32-bit integer registers
• Local registers 901-1000 are reserved for internal use
• Local registers 1001–5000 are floating point format numbers, each address stores half of a floating point number; for

example, registers 1001 and 1002 store the first full 32-bit floating point number
• Local registers 10000 and higher are read only virtual registers; virtual registers collect various system-level data

Table 25: Modbus registers for internal local registers (Modbus slave ID 199)

Local Registers Type Description

1–845 32-bit integer Local data registers

846–849 32-bit integer Reset, Constant, Timer

851–900 32-bit non-volatile integer Data flash, non-volatile

901–1000 Reserved for internal use

1001–5000 Floating point Floating point registers, local data registers

5001–7000 32-bit integer Local data registers

7001–8000 32-bit non-volatile integer Data flash, non-volatile

> 10000 Read only virtual registers, system-level data

Local registers 1–850 and 5001–7000 (Internal Processor Memory, 32-bit, Unsigned)—The local registers are the main
global pool of registers. Local registers are used as basic storage registers and as the common data exchange mechanism.
External Modbus device registers can be read into the local registers or written from the local registers. The DXM, as a
Modbus master device or a Modbus slave device, exchanges data using the local registers. Modbus over Ethernet (Modbus/
TCP) uses the local registers as the accessible register data.
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Local registers 851–900 and 7001–8000 (Data Flash, Non-volatile, 32-bit, Unsigned)—The top 50 local registers are
special non-volatile registers. The registers can store constants or calibration type data that must be maintained when power
is turned off. This register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so
these registers should not be used as common memory registers that change frequently.
Local registers 1001–5000— These local registers are paired together to store a 32-bit IEEE floating point format number in
big endian format. Registers 1001 [31:16], 1002 [15:0] store the first floating point value; registers 1003, 1004 store the
second floating point number. There are a total of 2000 floating point values; they are addressed as two 16-bit pieces to
accommodate the Modbus protocol. Use these registers when reading/writing external devices that require Modbus registers
in floating point format. Since Modbus transactions are 16-bits, the protocol requires two registers to form a 32-bit floating
point number.
Virtual registers—The DXM has a small pool of virtual registers that show internal variables of the main processor. Some
register values will be dependent upon the configuration settings of the DXM. Do not use Read Rules to move virtual local
registers data into local registers. Use the Action Rule > Register Copy function to move virtual local registers into local
registers space (1–850).
Table 26: Modbus registers for virtual registers

Registers Definition

10001 GPS latitude direction (N, S, E, W)

GPS Coordinate Data if the DXM is configured to read an external GPS unit.
10002 GPS latitude

10003 GPS longitude direction (N, S, E, W)

10004 GPS longitude

10011–10012 Resync timer Engineering use

10013–10014 Resync timer rollover Engineering use

10015–10016 Reboot cause (Restart Codes above) Reboot Type

10017–10018 Watchdog reset count Counter to track how many resets have been caused by the Watchdog

10021 IO Board Battery Voltage (mV) mV

10022 IO Board - Incoming Supply Voltage (mV) mV

10023 IO Board Voltage Cut-off Feature
0—No successful readings
1—Normal range
2—Cut-off engaged

10024 IO Board - Battery Charging Current (mA) mA

10025–10026 Http Push SSL Acquires
Statistical counts of connections, disconnections and forced disconnects when
the DXM creates a connection using SSL/TLS (Encrypted connections)

10027–10028 Http Push SSL Releases

10029–10030 Http Push SSL Forced Releases

10031–10032 Http Push Attempts
Statistical counts of connections, disconnections and forced disconnects when
the DXM controller creates a connection using HTTP non-encrypted

10033–10034 Http Push Successes

10035–10036 Http Push Failures

10037–10038 Http Push Last Status

Last DXM push status

0 = Initial state, no push attempt as finished yet
1 = Attempt complete
2 = Attempt aborted

10039–10040 Cellular Strength, BER

Cellular signal strength. Value range: 0–31

0 = –113 dBm or less
1 = –111 dBm
2–30 = –109 dBm through –53 dBm in 2 dBm steps
31 = –51 dBm or greater
99 = not known or not detectable; BER not used

10055–10056 Alarms, smtp, attempts Email attempts

10057–10058 Alarms, smtp, fails Email failures

10100 Number of read maps in default Read Map statistics
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Registers Definition

10101 Number of read map successes

10102 Number of read map timeouts

10103 Number of read map errors

10104 Read map success streak

10105 Number of write map successes

Write Map statistics
10106 Number of write map timeouts

10107 Number of write map errors

10108 Write map success streak

10109 Number of passthrough successes

API message passing statistics
10110 Number of passthrough timeouts

10111 Number of passthrough errors

10112 Passthrough success streak

10113 Number of 43 buffer successes

DX80 Gateway automatic messaging buffer statistics
10114 Number of 43 buffer timeouts

10115 Number of 43 buffer errors

10116 43 buffer success streak

11000 Read map success count

Read/Write maps statistics

12000 Write map success count

13000 Read map timeout count

14000 Write map timeout count

15000 Read map error count

16000 Write map error count

17000 Read map success streak

18000 Write map success streak

19000 Read map is in default

TCP Client Stats—The "x" represents the socket 0 through 4. The flex socket is not used. This range repeats for the next
socket.
Table 27: TCP client statistics

Register Definition

2x001 Socket x connection attempts (20001 is the first socket, 21001 is the second socket...)

2x003 Socket x connections

2x005 Socket x disconnections

2x007 Socket x transmits

2x009 Socket x receives

2x011 Socket x resolver attempts (reserved)

2x013 Socket x resolvers (reserved)

2x015–2x020 Reserved

2x021 Socket x Rule 0 transmits

2x023 Socket x Rule 0 receives

2x025 Socket x Rule 0 timeouts
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Register Definition

2x027 Socket x Rule 0 broadcasts

2x029 Reserved

2x031 Socket x Rule 1 transmits

2x033 Socket x Rule 1 receives

2x035 Socket x Rule 1 timeouts

2x037 Socket x Rule 1 broadcasts

2x039 Reserved

Reset Codes—The reset codes are in virtual register 11015 and define the condition of the last restart operation.
Table 28: Reset codes

Reset Code Definition

0 Undefined

1 Unknown

2 General

3 Brownout

4 Watchdog

5 User

6 Software

7 Return from backup mode

9.2.6 Modbus I/O Registers for the B1 I/O Base Board
The I/O base board stores the input and output values in Modbus holding registers. Since the I/O base board is defined as a
separate device, configure the DXM to read or write the values on the I/O base board.

Base Board Input Connection

Modbus Register Range Description

1 0–65535 Universal input 1

2 0–65535 Universal input 2

3 0–65535 Universal input 3

4 0–65535 Universal input 4

Universal Input Register Ranges

Register Types Unit Minimum Value Maximum Value

Discrete input/output 0 1

Universal input 0 to 10 V mV 0 10000 *

Universal input 0 to 20 mA µA 0 20000 *

Universal input temperature (–40 °C to +85 °C) C or F, signed, in tenths of a degree –400 850

Universal potentiometer unsigned 0 65535

* Setting Enable Full Scale to 1 sets the ranges to a linear scale of 0 to 65535.

B1 Controller Base Board Output Connection

Modbus Register Range Description

501 0–1 NMOS Output 1
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B1 Controller Base Board Output Connection

Modbus Register Range Description

502 0–1 NMOS Output 2

503 0–1 NMOS Output 3

504 0–1 NMOS Output 4

505 0–1 Switched Power 1 (5 V or 16 V)

506 0–1 Switched Power 2 (5 V or 16 V)

507 0–20000 Analog Output 1 default (0-20.000 mA)

0–10000 Analog Output 1 (0-10.000 V)

508 0–20000 Analog Output 2 default (0-20.000 mA)

0–10000 Analog Output 2 (0-10.000 V)

9.2.7 Modbus I/O Registers for the B2 I/O Base Board
The I/O base board stores the input and output values in Modbus holding registers. Since the I/O base board is defined as a
separate device, configure the DXM to read or write the values on the I/O base board.

Base Board Input Connection

Modbus Register Range Description

1 0–65535 Universal input 1

2 0–65535 Universal input 2

3 0–65535 Universal input 3

4 0–65535 Universal input 4

Universal Input Register Ranges

Register Types Unit Minimum Value Maximum Value

Discrete input/output 0 1

Universal input 0 to 10 V mV 0 10000 *

Universal input 0 to 20 mA µA 0 20000 *

Universal input temperature (–40 °C to +85 °C) C or F, signed, in tenths of a degree –400 850

Universal potentiometer unsigned 0 65535

* Setting Enable Full Scale to 1 sets the ranges to a linear scale of 0 to 65535.

B2 Controller Base Board Output Connection

Modbus Register Range Description

501 0–1 NMOS Output 1

502 0–1 NMOS Output 2

503 0–1 NMOS Output 3

504 0–1 NMOS Output 4

505 0–1 Switched Power 1 (5 V to 24 V)

506 0–1 Switched Power 2 (5 V to 24 V)

507 0–1 DC Latching Output 1

508 0–1 DC Latching Output 2

509 0–10000 Analog Output 1 (0-10.000 V)

510 0–10000 Analog Output 2 (0-10.000 V)
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9.2.8 Modbus Configuration Registers for the Universal Inputs
Each input or output on the I/O base board has associated Modbus registers that configure its operation.

Universal Input Parameters Registers

Universal Inputs 1 2 3 4

Enable Full Scale Registers 3303 3323 3343 3363

Temperature °C/°F Registers 3304 3324 3344 3364

Input Type Registers 3306 3326 3346 3366

Threshold Registers 3308 3328 3348 3368

Hysteresis Registers 3309 3329 3349 3369

Enable Rising Registers 4908 4928 4948 4968

Enable Falling Registers 4909 4929 4949 4969

High Register for Counter Registers 4910 4930 4950 4970

Low Register for Counter Registers 4911 4931 4951 4971

9.2.9 Modbus Configuration Registers for the Analog Output
The I/O base board has two analog outputs that are selectable as 0 to 20 mA (factory default) or 0 to 10 V. To change the
analog output characteristic, physical jumpers must be change on the I/O board and a parameter Modbus register must be
changed.
For step by step instructions on changing the output characteristics see Analog (DAC) Outputs for the B1 and S1 Models on
page 31.
Parameters for Analog Output 1 start at 4001 through 4008. Parameters for Analog Output 2 start at 4021 through 4028.
Table 29: Registers for analog output (4xxxx) parameters

Analog output
1

Analog output
2 Description Values

4001 4021 Maximum Analog Value

4002 4022 Minimum Analog Value

4003 4023 Enable Register Full Scale
0 = Store readings in unit-specific data
1 = Linear rate from 0 to 65535

4004 4024 Hold Last State Enable
0 = Disables Hold Last State and uses the Default Output State setting during an
error condition
1 = Sets the output to its last known value

4005 4025 Default Output State

4008 4028 Analog Output Type

0 to 20 mA or 0 to 10 V DC output (I/O board jumper selectable)

Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

After changing the jumper position, write the appropriate value to the Modbus
registers to define your analog output to match the setting selected by the jumper.

2 = 0 to 20 mA output (default)
3 = 0 to 10 V output

2952
Enable Default
Communication Timeout

0 = Disable
1 = Enable

2953
Communication Default I/O
Timeout (100 ms/Count)

Number of 100 ms periods

2954 Enable Default on Power Up
0 = Disable
1 = Sends device outputs to their default condition

Analog Output Type—The analog outputs may be configured as either 0 to 20 mA outputs (default) or 0 to 10 V outputs. To
change the analog output type change the hardware jumper position and write to the Modbus register that defines the analog
output type. For analog output 1, write to Modbus register 4008, for analog output 2 write to Modbus register 4028. Write a
value of 2 (default) to select 0 to 20 mA; write a value of 3 to select 0 to 10 V.
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Default Output Conditions—Default output triggers are the conditions that drive outputs to defined states. Example default
output conditions include when radios are out of sync, when a device cycles power, or during a host communication timeout.

• 2952 Enable Default Communication Timeout— A “communication timeout" refers to the communication between
any Modbus master host and the DXM baseboard. Set this register to 1 to enable the default condition when the host
has not communicated with the DXM baseboard for the period of time defined by the Communication Default IO
Timeout.

• 2953 Communication Default I/O Timeout (100 ms/Count)—This parameter defines the host timeout period in 100
millisecond increments. If a host does not communicate within this timeout period, the device outputs are set to the
default values.

• 2954 Enable Default on Power Up—Setting this parameter to 1 sends the device outputs to their default condition
when the DXM baseboard is powered up. Set to 0 to disable this feature.

Default Output State—The Default Output State parameter represents the default condition of the analog output. When an
error condition exists, the outputs are set to this 16-bit user-defined output state. To define the error conditions for device
outputs, refer to the MultiHop default output parameters 2950–2954.
Enable Register Full Scale—Set to 1 to enable a linear range from 0 to 65535 for specified input range. For a 4 to 20 mA
output, a value of 0 represents 4 mA and 65535 represents 20 mA. Set this parameter to 0 to store readings in unit-specific
data. For example, the register data representing a 15.53 mA reading is 15530. For units of current (0 to 20 mA outputs),
values are stored as µA (micro Amps) and voltage values are stored as mV (millivolts).
Hold Last State Enable—Set the Hold Last State to 1 to set the output to its last known value before the error occurred. Set
this parameter to 0 to disable the Hold Last State and use the Default Output State setting during an error condition.
Maximum Analog Value—The Maximum Analog Value register stores the maximum allowed analog value. The specific
units of measure apply to the register value. For example, the register may contain 20000, for 20 mA, or for a voltage output
the register may contain 8000, for 8 volts.
Minimum Analog Value—The Minimum Analog Value register stores the minimum allowed analog value. The specific units
of measure apply to register value. For example, the register may contain 4000, for 4 mA, or for a voltage output the register
may contain 2000, for 2 volts.

9.2.10 Modbus Configuration Registers for the I/O (Definitions)
Enable Full Scale

Set to 1 to enable a linear range from 0 to 65535 for specified input range. For a 4 to 20 mA input, a value of 0
represents 4 mA and 65535 represents 20 mA. Set this parameter to 0 to store input readings in unit-specific data.
For example, the register data representing a 15.53 mA reading is 15530. For units of current (0 to 20 mA inputs),
values are stored as µA (micro Amps) and voltage values are stored as mV (millivolts).

Enable Rising/Falling
Use these registers to enable the universal input logic to count on a rising transition or a falling transition. Write a
one (1) to enable; write a zero (0) to disable.

High/Low Register for Counter
The low and high registers for the counter hold the 32-bit counter value. To erase the counter, write zeroes to both
registers. To preset a counter value, write that value to the appropriate register.

Hysteresis and Threshold
Threshold and hysteresis work together to establish the ON and OFF points of an analog input. The threshold
defines a trigger point or reporting threshold (ON point) for a sensor input. When the input value is higher than the
threshold, the input is ON. Hysteresis defines how far below the threshold the analog input is required to be before
the input is considered OFF. A typical hysteresis value is 10% to 20% of the unit’s range.
In the example shown, the input is considered on at 15 mA. To consider the input off at 13 mA, set the hysteresis to
2 mA. The input will be considered off when the value is 2 mA less than the threshold.

Threshold

ON point

Time

In
pu

t V
alu

e

Input

Hysteresis

OFF point
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Input Type
Program the universal inputs to accept input types NPN, PNP, 10k thermistor, 0 to 10 V, 0 to 20 mA, or
potentiometer. The default setting is 8: NPN raw fast. To set the input type, write the following values to the Input
Type Modbus registers.

0 = NPN
1 = PNP
2 = 0 to 20 mA
3 = 0 to 10 V DC
4 = 10k Thermistor
5 = Potentiometer Sense (DXM150 only)
6 = Not used
7 = Bridge
8 = NPN Raw Fast (default)

Temperature °C/°F
Set to 1 to represent temperature units in degrees Fahrenheit, and set to 0 (default) to represent temperature units in
degrees Celsius.

9.2.11 Modbus Configuration Registers for Power
To monitor the input power characteristics of the DXM, read the following power Modbus registers. The on-board thermistor
is not calibrated, but can be used as a non-precision temperature input.
Table 30: Configuration registers for power

Modbus Register Description

6071 Battery backup charging algorithm.

0 = Battery is recharged from a solar panel
1 = Battery is recharged from 12 to 30 V DC (default)

6081 Battery voltage (mV). If no battery is present, the value in this register is less than 5 V. If the value in this register is greater than
the incoming voltage register, the battery is powering the system.

6082 Battery charging current (mA). The charging configuration charges the battery when the incoming voltage register value is greater
than the battery voltage register value. This registers shows the charging current in milliamps.

6083 Incoming supply voltage (mV) (solar or power supply). The incoming power can be from a solar panel or from a power supply.
The battery is charging when the incoming voltage register value is greater than the battery voltage register value. The battery is
powering the system when the incoming voltage register value is less than the battery voltage register value.

6084 On-board thermistor temperature (⁰C). A thermistor measures the temperature of the solar controller board and its surrounding
area and uses the temperature as part of the battery charge calculations. This register stores the thermistor reading in tenths of
degrees C. This is not a calibrated input: divide by 10 to calculate the temperature in degrees C. For calibrated temperature
inputs, define one of the universal inputs as a temperature input.

9.2.12 Modbus Registers for the LCD Board (Modbus Slave ID 201)
Control the four user-defined LEDs using the display board's Modbus registers. Using write maps or ScriptBasic, write the
Modbus registers shown below with 0 (off) or 1 (on). The LCD display is Modbus Slave 201.

Modbus Register I/O Connection Modbus Register I/O Connection

1102 : bit 0 LED 1 1104 : bit 0 LED 3

1103 : bit 0 LED 2 1105 : bit 0 LED 4

Using the Display LEDs
Turn on the DXM LEDs by writing to the LEDs' Modbus registers.
This example shows how to configure the DXM using the configuration software to read four universal inputs and write the
state values to the display LEDs.

1. Using the configuration software, go to the Local Registers > Local Registers in Use screen.
2. Define the local registers by assigning names to the first four registers and setting the LCD permissions parameter to

read/write. The LCD permissions show the register contents on the LCD menu under the REGISTER menu. You can
also set the value from the LCD menu.
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Figure 45. Local Registers in Use screen

3. Create a Read Rule to read the four universal inputs from the I/O board (Modbus slave 200) and write the values in
local registers 1 through 4.

Figure 46. RTU Read rules

4. Create a Write Rule to write the four local register values to the DXM display registers 1102 through 1105 (Modbus
Slave 201). Define the Write Rule to only write the display registers when the inputs change.

Figure 47. RTU Write rules

5. Save the XML configuration from the File > Save As menu.
6. Connect to the DXM using a USB cable and select Device > Connection Settings from the menu bar.
7. Upload the XML configuration file to the DXM by selecting Device > Upload Configuration to Device from the menu

bar.
After a configuration file is uploaded, the DXM reboots. The new configuration is now running.
Turning on any one of the universal inputs 1 through 4 on the I/O base board of the DXM now turns on an LED on the
display.

9.3 Using Courtesy Power or Switch Power
Pin 18 of the DXM100/1000-Bx Wireless Controller is a constant power source that supplies 5 volts up to 500 mA.
Pins 21 (switch power 2) and 30 (switch power 1) are switched power outputs. Configure the switched power outputs using
Modbus registers or by using the DXM Configuration Software's Settings > I/O Board screen. The output voltage can be
selected and is controlled using a Modbus register on the I/O board (Modbus slave ID 200). The voltage options are:

• 5 volts or 16 volts for DXM100-B1 models; or
• 5 to 24 V dc for DXM100-B2 models.
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Turn the switched power on or off using the output register 505 for switch power 1 or 506 for switch power 2. For continuous
power, set the Default Output register to 1, then cycle the power.

Switch
Power

Enable
Register Enable Register Value Voltage

Register Voltage Register Value
Default
Output
Registe

r

Output
Registe

r

1 (pin 30) 2201

Write a 0 to turn OFF
Write a 1 to turn ON (default)

3601

Write a 0 to select 5 V (default)
Write a 1 to select 16 V
Write a __ to select 24 V (DXM100-B2 model only)

3602 505

2 (pin 21) 2251 3621 3622 506

Enable Register
Configuration registers that turn on the ability to use the switched power output.
Default setting = ON

Voltage Register
Configuration registers that define the output voltage to the switched power output.
Default setting = 5 V

Default Output Register
Configuration registers that turn on the switched power outputs for continuous power out.
Set register to 1 for continuous power. Cycle power if this register is changed.
Default setting = 0

Modbus Output Register
Turn on or turn off the voltage output. If both outputs 505 and 506 are turned on at the same time but are set to
different voltages, the output voltage is 5 V for DXM100-B1 models and set to the lower voltage setting for DXM100-
B2 models.

9.4 Associating a Switched Power Output to an Input
Use the DXM Configuration Software to associate a switched power output to a universal input.
Switched power 1 and 2 (pins 30 and 21) can be associated to any Universal input to apply power to a sensor, take a
reading, and then remove power from the sensor. This conserves power in battery-operated systems. The switched power
supply can be used in one of two different ways: supplying courtesy power to an output pin or associated to an input. (Only
one method can be active at a time.)
To manually configure the switched power output using I/O board Modbus registers, write the specified value to the listed
register.

Courtesy Power Output Configuration Parameters 7 Modbus Registers to Write To

Switched Power 1 Switched Power 2

Switched Power Enable 2201 2251

Voltage 3601 3621

Default Output 3602 3622

Output Register 505 506

Default Output
Set the register value to 1 for continuous power. The default setting is 0.
Cycle power if this register value is changed.

Output Register
Write to the Output register to turn on or turn off the voltage output.
If both Output Registers 505 and 506 are turned on at the same time, but are set to different voltages, the output
voltage is 5 V for DXM100-B1 models and set to the lower voltage setting for DXM100-B2 models.

7 Only used when supply courtesy power to the output pin, not when associating switched power to an input.
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Switched Power Enable
Enables the switched power supply. Set to 1 to enable; set to 0 to disable.
This does not enable the supply output to the actual output pin. To enable the supply output to the output pin, set
Modbus register 505 or 506 to 1. Set to 0 when associating the switched power supply to an input.

Voltage
For the B1 and S1 models, set the Modbus register value to 0 for a switched power supply at 5 volts. Set the
Modbus register value to 1 for a switched power supply at 16 volts.
For the B2 and S2 models, set one of the following register values to select your switched power output voltage.

For 5 V, set the Modbus register to 204.
For 7 V, set the Modbus register to 125.
For 10 V, set the Modbus register to 69.
For 15 V, set the Modbus register to 32.
For 20 V, set the Modbus register to 12.
For 24 V, set the Modbus register to 3.

When associating a switched power supply to an input, set the Switch Power Output Enable register to off (0). Set Modbus
register 2201 for switched power 1 and Modbus register 2251 for switched power 2. This allows the input sampling
mechanism to control the output.
Use the following configuration parameters to define the switch power associated with an input.

Input Parameter Universal Input Configuration Parameter Modbus Registers to Write To

Universal Input 1 Universal Input 2 Universal Input 3 Universal Input 4

Input Enable 1001 1051 1101 1151

Sample Interval (high) 1002 1052 1102 1152

Sample Interval (low) 1003 1053 1103 1153

Switched Power Enable
Mask

1004 1054 1104 1154

Switched Power Warmup 1005 1055 1105 1155

Switched Power Voltage 1006 1056 1106 1156

Extended Input Read 1007 1057 1107 1157

Input Out-of-Sync Enable 1008 1058 1108 1158

Extended Input Read
The Extended Input Read is a bit field parameter that allows multiple inputs to be sampled with the same switch
power parameters.
If the bit field is set to 0x000F, the first four inputs are sampled after the switch power parameters are satisfied.
If the Extended Input Read parameter is set in the Universal input 1 configuration registers, set Universal inputs 2
through 4 Extended Input Read and Sample Interval parameters to zero.

Input Enable
Set to 1 to enable the input. Set to 0 to disable the input.

Out-of-Sync Enable
To enable the input to continue operating when the device is out of sync with the master radio, set to 1.
To disable the input when the device is not synchronized to the master radio, set to 0.

Sample Interval (high), Sample Interval (low)
The sample interval (rate) is a 32-bit value (requires two Modbus registers) that represents how often the I/O board
samples the input.
The register value is the number of time units. One time unit is equal to 0.01 seconds.
For example, a Modbus register value of 1000 represents a sample interval of 10 seconds (1000 × 0.010 seconds =
10 seconds).

Sure Cross® DXM100-Bx and DXM1000-Bx Wireless Controllers   

82 www.bannerengineering.com - Tel: + 1 888 373 6767  

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2B



Switch Power Enable Mask
The Switch Power Enable Mask works with the warm-up and voltage parameters to define the switch power output.
The bit mask can select any number of switch powers.

0x0 - No switch power enabled
0x1 - Enable Switch Power 1
0x2 - Enable Switch Power 2
0x3 - Enable Switch Power 1 and Switch Power 2

Switch Power Voltage
The Switch Power Voltage parameter defines the output voltage of the switch power output.
This parameter applies only to inputs using switched power. If switch power is not used with an input, use the
Courtesty Power Voltage parameter to control the voltage.
See Voltage entry for Modbus register values used to select the output voltage.

Switch Power Warm-up
When an input controls power to external sensors, the Switch Power Warm-up parameter defines how long power is
applied to the external sensor before the input point is examined for changes.
The register value is the number of time units, and a time unit is 0.01 seconds. For a warm-up time of 1 second, this
parameter value is 100 (0.01 seconds × 100 = 1 second).

Associate Universal Input 1 with Switch Power 1
To associate universal input 1 with switched power 1, follow these instructions. Set Input 1 to sample every 60 seconds, with
a warmup time of 10 seconds.

1. Verify Switched Power 1 Output Enable is off (0). Set Modbus Register 2201 = 0
2. Set the Sample Interval to 1 minute. Modbus Registers 1002 = 0, 1003= 6000 (0.01 seconds × 6000 = 60 seconds).
3. Set the Switched Power Enable Mask to use Switch Power 1. Modbus Register 1004 = 1
4. Set the Switched Power Warm-up time to 10 seconds. Modbus Register 1005 = 1000 (0.01 seconds × 1000 = 10

seconds).
5. Set the Switched Power Voltage to 16 volts. Modbus Register 1006 = 1.

9.5 Working with Solar Power
A reliable solar system requires careful planning and monitoring to size the components correctly. The recommendations
provided are for the DXM system as an autonomous system.
Adding extra components increases the power requirements and likely requires increasing the solar system components.
Depending upon the geographical location, the size of the solar panel and battery may vary.

9.5.1 Setting the DXM for Solar Power
By default, the DXM is set from the factory to charge a backup battery from a line power source.
For DXM models with an LCD, use the buttons and menu system to change the charging algorithm to solar power. Go to
System Config > I/O Board > Charger. Use the up/down arrows to select Solar.
For DXM models without an LCD, use the configuration software to adjust the I/O board Modbus register 6071. Set the
register to 0 to select battery charging from a solar panel, and set to 1 to select battery charging from incoming 12 to 30 V DC
supply.
To minimize the power consumption (may not apply to all models):

• If Ethernet is not being used, save up to 25% of the consumed power by disabling Ethernet. Set DIP switch 1 to the
ON position on the processor board then reboot.

• Instead of powering external devices all the time, take advantage of the switched power mechanisms to turn off
devices when possible.

• Minimize the number of cellular transactions and the amount of data pushed across the cellular modem.

9.5.2 Solar Components
The components of a solar system include the battery and the solar panel.

Battery
The DXM solar controller is designed to use a 12 V sealed lead acid (SLA) battery. The characteristics of a solar system
require the battery to be of a certain type. There are two types of lead acid batteries:
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• SLI batteries (Starting Lights Ignition) designed for quick bursts of energy, like starting engines
• Deep Cycle batteries - greater long-term energy delivery. This is the best choice for a solar battery.

Since a solar system charges and discharges daily, a deep cycle battery is the best choice. There are different versions of a
lead acid battery: wet cell (flooded), gel cell, and an absorbed glass mat (AGM).
Wet cell batteries are the original type of rechargeable battery and come in two styles, serviceable and maintenance free.
Wet cell batteries typically require special attention to ventilation as well as periodic maintenance but are the lowest cost. The
gel cell and AGM battery are sealed batteries that cost more but store very well and do not tend to sulfate or degrade as
easily as a wet cell. Gel or AGM batteries are the safest lead acid batteries you can use.
Battery capacity is a function of the ambient temperature and the rate of discharge. Depending upon the specific battery, a
battery operating at –30 °C can have as much as 40 percent less capacity than a battery operating at 20 °C. Choose enough
battery capacity based on your geographical location.
Table 31: Average voltage readings relative to battery charge

State of Charge (%) Open Circuit Voltage

100 13.0 or higher

75 12.6

50 12.1

25 11.66

0 11.4 or less

A larger capacity battery typically lasts longer for a given solar application because lead-acid batteries do not like deep
cycling (discharging a large percentage of its capacity). Depending upon the battery, a battery discharging only 30 percent of
its capacity before recharging will have approximately 1100 charge/discharge cycles. The same battery discharging 50
percent of its capacity will have approximately 500 charge/discharge cycles. Discharging 100 percent leaves the battery with
only 200 charge/discharge cycles.
Use this information as a guide to the approximate state of charge and in determining when to apply conservation measures.
Batteries degrade over time based on discharge/charge cycles and environmental conditions. Always monitor the battery
system to obtain the best performance of the solar powered system.

Solar Panel
Banner solar panels come in two common sizes for the DXM: 5 Watt and 20 Watt. Both panels are designed to work with the
DXM but provide different charging characteristics. Use the 5 watt panel for light duty operation and use the 20 watt panel
when you require greater charging capabilities.

Solar Panel Voltage Current Typical DXM Configurations

5 Watt 17 V 0.29 A DXM Controller configured as a slave, ISM radio, I/O base board

20 Watt 21 V 1 A DXM Controller with ISM radio and Cellular modem

Photovoltaic panels are very sensitive to shading. Unlike solar thermal panels, PV solar panels cannot tolerate shading from
a branch of a leafless tree or small amounts of snow in the corners of the panel. Because all cells are connected in a series
string, the weakest cell will bring down the other cells' power level.
Good quality solar panels will not degrade much from year to year, typically less than 1 percent .
To capture the maximum amount of solar radiation throughout the year, mount a fixed solar panel to optimize the sun's
energy. For the northern hemisphere, face the panel true south. For the southern hemisphere, face the panel true north. If
you are using a compass to orientate the panels, compensate for the difference between true north and magnetic north.
Magnetic declination varies across the globe.
A solar panel's average tilt from horizontal is at an angle equal to the latitude of the site location. For optimum performance,
adjust the tilt by plus 15 degrees in the winter or minus 15 degrees in the summer. For a fixed panel with a consistent power
requirement throughout the year, adjust the tilt angle to optimize for the winter months: latitude plus 15 degrees. Although in
the summer months the angle may not be the most efficient, there are more hours of solar energy available.
For sites with snow in the winter months, the increased angle helps to shed snow. A solar panel covered in snow produces
little or no power.
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9.5.3 Recommended Solar Configurations
These solar panel and battery combinations assume direct sunlight for at least two to three hours a day. Solar insolation
maps provide approximate sun energy for various locations. The depth of battery discharge is assumed to be 50 percent.
Table 32: Solar panel and battery combinations for a DXM system

Solar Panel
Output (W)

Battery Capacity (Ahr) Days of
Autonomy

DXM Current
(mA)

DXM Model

5 10 10 25 DXM-Sx models with an ISM radio and I/O base board

20 14 10 30 DXM-Bx models with an ISM radio and no cellular modem

20 20 10 35 DXM-Bx models with an ISM radio and cellular modem

Battery capacity (amp hour) is a standard amp rating taken for 20 hours. Battery capacity should be monitored for reliable
system power and may need to be increased for cold weather locations.

9.5.4 Monitoring Solar Operation
The DXM solar controller provides Modbus registers that allow the user to monitor the state of the solar panel input voltage,
the battery voltage, the charging current, and the temperature in °C. The DXM can be configured to monitor the health of the
charging system as well as send an alert message when the battery is too low.
The charts show a typical charging cycle, with each vertical grid representing about eight hours. The chart shows three days
of charging.

Figure 48. Solar Panel Voltage (mV) -- Cloudy First Day

Figure 49. Battery Voltage (mV) - Cloudy First Day

9.6 Clear the Password for the DXM100 and DXM150 Models Only
By default, the DXM Controllers does not require a password to load a configuration file. If a password is defined, the
password must be entered before uploading a configuration file. To change the password, you must already know the current
password. If you do not know the current password, follow these steps to clear the password.

Important: Clearing the password erases the current configuration and any program files, log files, or
history files.

  Sure Cross® DXM100-Bx and DXM1000-Bx Wireless Controllers

 www.bannerengineering.com - Tel: + 1 888 373 6767 85

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2B



Important: DO NOT follow these instructions if you have a DXM700, DXM1000, or DXM1500 model. If you
attempt to clear the password of a DXM700, DXM1000, or DXM1500 with these instructions, the firmware
of your device will be erased and your controller will no longer function.

1. Turn the power OFF to the DXM Controller.
2. Set DIP switch 4 to the ON position.
3. Press and hold the processor button.
4. Turn the power ON to the DXM Controller.

The processor board's LED flashes to indicate the process is complete (about 10-20 seconds).
5. Set DIP switch 4 to the OFF position.
6. Cycle power to the DXM Controller.
7. Reload the configuration file before resuming normal operation.

9.7 Clear the Password on DXM700-Bx, DXM1000-Bx, or DXM1200-
Bx Models
By default, the DXM Controllers do not require a password to load a configuration file. If a password is defined, the password
must be entered before uploading a configuration file.
To change the password, you must already know the current password. If you do not know the current password, follow
these steps to clear the password.

Important: Clearing the password erases the current configuration and any program files, log files, or
history files.

1. Turn on the power to the DXM Controller.
2. Set DIP switch 4 to the ON position.
3. Press and hold the processor button until processor board LED flashes.
4. Set DIP switch 4 to the OFF position.
5. Cycle power to the DXM Controller.
6. Reload the configuration file before resuming normal operation.
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10 PROFINET®

PROFINET is a data communications protocol for industrial automation and processes. PROFINET IO defines how
controllers (IO controllers) and peripheral devices (IO devices) exchange data in real time. PROFINET® is a registered
trademark of PROFIBUS Nutzerorganisation e.V. and the standard is maintained by PROFIBUS & PROFINET International
(PI) , an organization headquartered in Karlsruhe, Germany.
Only the DXMR90, DXM700, DXM1000, and DXM1200 Controller models support PROFINET IO.

10.1 General Station Description Markup Language File
A PROFINET General Station Description (GSD) file is a description of an IO device provided by the device manufacturer in
an XML format (GSDML.xml).
The GSD file is a standardized way of describing the device information to engineering tools and the IO controller and can
work across a variety of tools as a standard set of device information.

10.2 DXM PROFINET IO Data Model
The PROFINET IO data model is based on the typical, expandable field device that has a backplane with slots. Modules
have different functionalities.
Modules are plugged into slots. In the PROFINET IO data model Slot 0, Subslot 1 is reserved for the Device Access Point
(DAP) or network interface.

• Inputs Integer Module sends integer data to the PLC
• Inputs Floats Module sends floating point data to the PLC
• Output Integer Module receives integer data from the PLC

10.3 Configure the DXM Controller for a PROFINET IO Connection
To use PROFINET, follow these instructions.

1. Using the DXM Configuration Software, go to the Settings > Ethernet screen.
2. Select Enable PROFINET.
3. Save the configuration file and upload it to the DXM Controller (see Save and Upload the Configuration File on page

17).
After PROFINET is enabled, the IP address for the DXM Controller is controlled by the PROFINET host. The LCD
display and DXM Configuration Software no longer control the setting of the IP address. The PROFINET IP address
settings are invisible to the LCD display and the DXM Configuration Software.

The PROFINET data type and data size to/from the DXM Controller is configurable. The PROFINET data is processed from
the Local Register of the DXM Controller.
Configure the Local Registers to match the PROFINET module definitions in the host PLC.

10.3.1 Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.
Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending
the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving the
configuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File > Save As menu.
2. Go to the DXM > Send XML Configuration to DXM menu.

Figure 50. Status indicator bar

• If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in the
cable and reconnect the DXM to the software.

• If the Application Status indicator is green, the file upload is complete.
• If the Application Status indicator is yellow, the file transfer is in progress.
The device reboots and begins running the new configuration.
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10.4 Slots and Modules
There are nine slots to accommodate the DXM Controller data.
Table 33: Slots for input and output values

Values Slots Maximum Data Size

Input values 1–6 1440 bytes

Output values 7–9 1440 bytes

Table 34: Listing of slots for input and output values

Slot
PLC DXM Local Register Module Size

Module Definition Start End 512

Slot 1 Inputs Integer <- 1 256

Slot 2 Inputs Integer <- 257 512

Slot 3 Inputs Integer <- 513 768

Slot 4 Inputs Float <- 1001 1256

Slot 5 Inputs Float <- 1257 1512

Slot 6 Inputs Float <- 1513 1768

Slot 7 Output Integer -> 5001 5256

Slot 8 Output Integer -> 5257 5512

Slot 9 Output Integer -> 5513 5768

The DXM Local Register association shown uses a Module size of 512 bytes, which equals 256 Local Registers in the DXM.
Module sizes supported are 64, 128, 256 and 512 bytes. Input Integers are data from the DXM to the PLC. Output integers
are data from the PLC to the DXM.
Table 35: Slots 1 through 3

Module Notes

Input Integer 512 Allowed in slots 1-3, Module Identifier= 0x30

Input Integer 256 Allowed in slots 1-3, Module Identifier= 0x31

Input Integer 128 Allowed in slots 1-3, Module Identifier= 0x32

Input Integer 64 Allowed in slots 1-3, Module Identifier= 0x33

Table 36: Slots 4 through 6

Module Notes

Input Float 512 Allowed in slots 4-6, Module Identifier= 0x34

Input Float 256 Allowed in slots 4-6, Module Identifier= 0x35

Input Float 128 Allowed in slots 4-6, Module Identifier= 0x36

Input Float 64 Allowed in slots 4-6, Module Identifier= 0x37

Table 37: Slots 7 through 9

Module Notes

Output Integer 512 Allowed in slots 7-9, Module Identifier= 0x40

Output Integer 256 Allowed in slots 7-9, Module Identifier= 0x41

Output Integer 128 Allowed in slots 7-9, Module Identifier= 0x42

Output Integer 64 Allowed in slots 7-9, Module Identifier= 0x43
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Example Configuration

Table 38: Example configuration for slots and modules

Slot Module Description

Slot 1 Input Integer 512 The two input integer modules have a total of 640 bytes (320 Modbus registers)
The data will come from DXM Local Registers 1 through 320Slot 2 Input Integer 128

Slot 4 Input Float 128
The input Floating register module has a total of 128 byes (64 Modbus registers)
Since it takes two Modbus registers to make a 32-bit floating value, there will be 32
floating point values coming from Local Registers 1001-1064

Slot 7 Output Integer 64
The output integer 64 module has a total of 64 bytes (32 Modbus registers).
The data will come from the PLC and be put into DXM Local Registers 5001 through
5032

10.5 Configuration Instructions

10.5.1 Install the GSD File
Although these instructions are specific for the Siemens TIA Portal (v14) software, you may use these instructions as a basis
for installing the GSD file into another controller.

1. Download the GSD file from www.bannerengineering.com.
2. Launch the Siemens TIA Portal (v14) software.
3. Click Open existing project.
4. Select a project and open it.
5. After the project is uploaded, click Devices & networks.

Figure 51. Devices and networks screen

6. Click Configure networks.
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Figure 52. Configure networks screen

7. Click Options and select Manage general station description file (GSD).
The Install general station decription file window opens.

8. Click the More options (...) icon to the right of the Source path field and browse to the location the DXM GSD file
was downloaded to.

9. Select the DXM GSD file.
10. Click Install.

Figure 53. Hardware catalog

The system installs the DXM GSD file and places it in the Hardware catalog. In the example, the DXM GSD file is
located under Other field devices > PROFINET IO > Banner Engineering Corp. > Banner.

If the DXM GSD file does not install properly, save the log and contact Banner Engineering Corp.
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10.5.2 Change the Device IP Address
Follow these instructions to change the IP address of the DXM device using the Siemens TIA Portal (v14) software. Use
these instructions as a basis if you are using another controller (PLC).

1. Launch the Siemens TIA Portal (v14) software.
2. Click Open existing project.
3. Select a project and open it.
4. Click Devices & networks.

Figure 54. Network view

The Network view displays.
5. Double-click on the DXM icon to open the Device view screen.
6. Click on the DXM icon in the graphic area of the Device view screen.

The Module properties window displays and the module can now be configured.
7. Click Properties.
8. Click General.
9. Select PROFINET Interface > Ethernet addresses.

Figure 55. Ethernet addresses

10. Select Set IP address in the project.
11. Enter the IP address.
12. Right-click on the device icon and select Online & diagnostics.
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Figure 56. Online & diagnostics menu and screen

The Online & diagnostics windows displays.
13. Select Assign IP address under Functions.
14. Click Accessible devices.

The Select device window searches the network for available devices.
15. Determine the device to be adjusted via the MAC address and select it.
16. Click Apply.

The IP address for the device is updated.
17. Click Assign IP address to complete the step.

This step is completed for every device.
By default, each DXM shipped from the factory is assigned the IP address 192.168.0.1.
Immediately after the PROFINET protocol is enabled, the DXM has an IP address of 0.0.0.0. We recommend using the TIA
Portal to give the DXM an IP address so that the address is saved in the unit. When the PLC powers up, this IP address is
accessible. The PLC can change the IP address if it is configured to do so.
If the PLC assigns the DXM IP address (for example, using the Set IP address in the project option in Siemens TIA Portal),
the DXM receives the specified address, but only after the program has been loaded into the PLC and is running. If the DXM
is restarted after it was discovered and configured by the PLC, the DXM retains the IP address that was assigned to it using
the LCD or software until after the PLC discovers the DXM and assigns it the specified address again. However, if this
address is different than what is specified in the PLC, the DXM reverts to the address specified in the PLC after the PLC
becomes active again.
These configuration options conform to the PROFINET standard.

10.5.3 Change the Device Name
Follow these instructions to change the name of the DXM using the Siemens TIA Portal (v14) software. Use these
instructions as a basis if you are using another controller (PLC).

1. Open a project and click on Devices & networks.
The Network view displays.

2. Right-click on the DXM icon and select Assign device name.
The Assign PROFINET device name window displays. The software searches for devices of the same type.
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3. Enter the desired name in the PROFINET device name field. Note that each name can be used only once.
4. Click Assign name.

The device now has a PROFINET name.
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11 DXM100 and DXM1000 Dimensions
All measurements are listed in millimeters, unless noted otherwise.

86 mm
[3.39”]

94.6 mm
[3.72”]

104 mm
[4.09”]

59.5 mm
[2.34”]

20.4 mm
[0.8”]

35 mm
[1.38”]
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12 Accessories
For a complete list of all the accessories for the Sure Cross wireless product line, please download the Accessories List (p/n 
b_3147091).

Cordsets
MQDC1-506—5-pin M12/Euro-style, straight, single ended, 6 ft
MQDC1-530—5-pin M12/Euro-style, straight, single ended, 30 ft
MQDC1-506RA—5-pin M12/Euro-style, right-angle, single ended, 6 ft
MQDC1-530RA—5-pin M12/Euro-style, right-angle, single ended, 30 ft

Misc Accessories
BWA-CG.5-3X5.6-10—Cable Gland Pack: 1/2-inch NPT, Cordgrip for 3
holes of 2.8 to 5.6 mm diam, 10 pack
BWA-HW-052— Cable Gland and Vent Plug Pack: includes 1/2-inch
NPT gland, 1/2-inch NPT multi-cable gland, and 1/2-inch NPT vent
plug, one each

Static and Surge Suppressor
BWC-LFNBMN-DC—Surge Suppressor, bulkhead, N-Type, dc
Blocking, N-Type Female, N-Type Male

Antenna Cables
BWC-1MRSMN05—LMR200 RP-SMA to N-Type Male, 0.5 m
BWC-2MRSFRS6—LMR200, RP-SMA Male to RP-SMA Female
Bulkhead, 6 m
BWC-4MNFN6—LMR400 N-Type Male to N-Type Female, 6 m

Short-Range Omni Antennas
BWA-2O2-D—Antenna, Dome, 2.4 GHz, 2 dBi, RP-SMA Box Mount
BWA-9O2-D—Antenna, Dome, 900 MHz, 2 dBi, RP-SMA Box Mount
BWA-9O2-RA—Antenna, Rubber Fixed Right Angle, 900 MHz, 2 dBi,
RP-SMA Male Connector

Medium-Range Omni Antennas
BWA-9O5-C—Antenna, Rubber Swivel, 900 MHz 5 dBi, RP-SMA Male
Connector
BWA-2O5-C—Antenna, Rubber Swivel, 2.4 GHz 5 dBi, RP-SMA Male
Connector

Long-Range Omni Antennas
BWA-9O8-AS—Antenna, Fiberglass, 3/4 Wave, 900 MHz, 8 dBi, N-
Type Female Connector
BWA-2O8-A—Antenna, Fiberglass, 2.4 GHz, 8 dBi, N-Type Female
Connector

Long-Range Yagi Antennas
BWA-9Y10-A—Antenna, 900 MHz, 10 dBd, N-Type Female Connector

Cellular Antenna
BWA-CELLA-002—Cellular multiband, 2 dBi, RP-SMA male
connection, 6.3 inch blade style. Datasheet: b_4475176

Enclosures and DIN Rail Kits
BWA-AH864—Enclosure, Polycarbonate, with Opaque Cover, 8 × 6 × 4
BWA-AH1084—Enclosure, Polycarbonate, with Opaque Cover, 10 × 8
× 4
BWA-AH12106—Enclosure, Polycarbonate, with Opaque Cover, 12 ×
10 × 6
BWA-AH8DR—DIN Rail Kit, 8", 2 trilobular/self-threading screws
BWA-AH10DR—DIN Rail Kit, 10", 2 trilobular/self-threading screws
BWA-AH12DR—DIN Rail Kit, 12", 2 trilobular/self-threading screws

Power Supplies
PSD-24-4—DC Power Supply, Desktop style, 3.9 A, 24 V dc, Class 2,
4-pin M12/Euro-style quick disconnect (QD)
PSDINP-24-13 —DC power supply, 1.3 Amps, 24 V DC, with DIN Rail
Mount, Class I Division 2 (Groups A, B, C, D) Rated
PSDINP-24-25 — DC power supply, 2.5 Amps, 24 V DC, with DIN Rail
Mount, Class I Division 2 (Groups A, B, C, D) Rated
BWA-SOLAR PANEL 20W—Solar Panel, 12 V, 20 W, Multicrystalline,
573 × 357 × 30, "L" style mounting bracket included (does not include
controller)
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13 Product Support and Maintenance

13.1 File System and Archive Process
The DXM file system consists of two physical components: the serial EEPROM that stores non-volatile configuration
information and a removable micro SD card that stores file backup data and user created files.
EEPROM Files—The serial EEPROM stores basic data that is required to be non-volatile, including network configuration
data, IP address, MAC address, network masks, firewall settings, and authentication information. The controller XML
configuration file created by the DXM Configuration Software is stored in EEPROM. The small section of non-volatile local
registers is also stored in EEPROM.
Micro SD Card Files—The micro SD card contains most files at the root level. The archive directory contains files kept by
the system for history backup. Archive files are stored in the directory _sxi and are only accessible by removing the SD card.

• Data Log Files
• HTTP Push Files
• User created ScriptBasic file
• ScriptBasic program file
• CmVMon file
• _sxi Archive directory

Data Log files
Users may create up to four data log files using the DXM Configuration Software. The log files are stored in the root
directory on the SD card. When the file size limit is reached, the filename is changed to include the date and time
and the file is moved into the archive directory _sxi. If a finished log file is to be e-mailed, it will be done at this time
and then moved into the archive directory. Archived log files are deleted based on the Clear Logs parameter.

HTTP Push File
If the DXM is configured to send data to a webserver or host system, the device creates an HTTP.LOG file on the
SD card. The HTTP log is created only if the Logging Interval is non-zero and the HTTP enable log is set. An entry is
placed in the HTTP log file at the Logging Interval specified by the user. At the Push Interval time, the HTTP log file
is sent to the webserver or host system. If the transmission is successful, the HTTP log file is time stamped and
placed into the archive directory (_sxi). If the transmission fails, the file remains in the root directory and subsequent
Logging Intervals are appended to the file and are sent at the next Push Interval. See Ethernet and Cellular Push
Retries on page 61.

User Created ScriptBasic Files
Users may use ScriptBasic to create files on the SD card by using the FILEOUT function. The filenames are fixed
and up to five files can be created in the root directory.

ScriptBasic Program File
The main ScriptBasic program that runs at boot time is stored on the SD card in the root directory.

CmVMon File
The CmVMon.txt file (Cellular milli-Volt Monitor) is created by the system and is used to track power events. Every
power-up cycle is date/time stamped with the voltage read from the I/O board. The value 24487 is equal to 24.487
volts. If the voltage drops below 11.2 V, another entry is put in the log file indicating the cellular modem will shut
down.

CM 2015-09-22 18:52:43 VMon Power entered normal range 24487

CM 2015-10-13 20:49:47 VMon Power entered normal range 24004

CM 2015-10-16 15:00:20 VMon Power entered normal range 24014

CM 2015-10-19 19:12:26 VMon Power entered normal range 12845

_sxi Archive Directory
Only two types of files are moved into the archive directory: data log files and HTTP log files. Data log files are date/
time stamped and placed into the archive directory when the size limit is reached. HTTP log files are date/time
stamped then placed into the archive directory when they are successfully sent to the webserver or host system. If
the HTTP log files were not successfully sent after the retries have been exhausted, the files are placed into a root
directory called sav.
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13.2 Troubleshooting

13.2.1 Restoring Factory Default Settings for the I/O Base Board
To reset the I/O base board to factory defaults, write to two Modbus registers in the base board. The default slave ID for the
base board is 200.
To reset the DXM I/O base board parameters back to factory defaults:

1. Write a 1 to Modbus register 4152
2. Write a 10 to Modbus register 4151

To reboot (cycle power) the DXM I/O base board:
1. Write a 0 to Modbus register 4152
2. Write a 10 to Modbus register 4151

Table 39: Restoring Factory Defaults for the I/O Base Board

Register Values Description

4151 0–255 Reset/restore trigger. This timer is based in 100 millisecond units. Once written, the timer starts to count down to zero. After the
timer expires, the restore factory defaults are applied if register 4152 = 1. If register 4152 is zero, the I/O board is reset.
Default value: 0
1 = 100 milliseconds, 10 = 1 second.

4152 0–1 0 = Reboots (cycles power) to the I/O base board
1 = Restores factory defaults for I/O parameters

13.2.2 Updating the DXM Processor Firmware
There are two different update procedures, depending on the DXM firmware version of your device.

Update Your DXM Processor Firmware (Prior to Version 2.0)
To update DXM Processor firmware prior to version 2.0, use the SAM-BA program from MicroChip/Atmel. Following these
instructions to update the DXM100 or DXM150 processor firmware.

1. Download the SAM-BA software from http://www.microchip.com/developmenttools/productdetails.aspx?partno=atmel
+sam-ba+in-system+programmer.

2. Install the SAM-BA program.
3. Set the processor board jumper (jumper C, shown below in the "boot load off" position).

Figure 57. Processor board
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a) Disconnect the DXM Controller from its power supply.
b) Open the hardware cover.
c) Using your fingers or tweezers, move the jumper to the "boot load on" position (jumper on the top two pins).
d) Connect the DXM back to its power supply.
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e) The lower left LED on the I/O base board is solid when power is turned on. After the LED begins flashing, remove
power.

f) Move the jumper back to its original position.
g) Replace the hardware cover.
h) Connect the DXM back to its power supply.

4. Launch the SAM-BA program. Select the COM port and correct board. Click CONNECT.
Figure 58. Popup screen

The SAM-BA program attempts to automatically detect the COM port and the correct device.
5. On the SCRIPTS pull-down m] enu select ENABLE FLASH ACCESS. Click EXECUTE.

Figure 59. SAM-BA popup window

6. In the SCRIPTS pull-down menu, select BOOT FROM FLASH (GPNVM1). Click EXECUTE. Click EXECUTE again if
the message indicates it failed.

7. In the Flash tab, click on the folder icon for the Send File Name field. Select the boot load file (must be a *.bin file)
and click SEND FILE. The file is: DXM PROCESSOR FIRMWARE V2.02 or go to the software section of the
Wireless Reference Library on www.bannerengineering.com.

Figure 60. SAM-BA popup window
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The load process takes a few seconds.
8. After the load is complete, the program asks if you want to lock the flash region. Click NO.
9. Close the SAM-BA bootloader program.
10. Cycle the power to the DXM.

The new code should now be running and the LEDs should be on.

Updating Your DXM Processor Firmware (Version 2 or Later)
DXMs with processor firmware version 2.0 or later have a built-in boot loader program to update the firmware. Use the
configuration software version 3 or later, the Banner Cloud Data Services webserver, or manually write the files on the SD
card to update the firmware.
The new firmware file loads into the BOOT directory of the SD card on the DXM. The configuration software or Banner Cloud
Data Services website handles the reprogramming process automatically. During the programming process, the internal
LEDs on the processor board indicate the status of the programming.
Table 40: Update process overview

Reprogramming Step Approximate time required Description

Loading new firmware file (*.HEX) configuration software: 2 minutes over Ethernet or
15 minutes over USB
Banner Cloud Data Services: 2 minutes over
Ethernet or 5 minutes over Cellular

Send the new firmware image to the DXM. After the new
image is on the device, the controller resets.
LED3 is red during the loading process.

Verify the contents of the new
firmware file

1 minute When the DXM finds a file that should be installed, LED4
(amber) flashes at about a 1 second rate while the contents of
the file are validated.

New firmware file is valid After validation successfully completes, LED4 is on (amber).

New firmware file is being loaded 2 minutes; do not remove power to the DXM
during the programming process.

LED3 (red) blinks approximately once per second. LED3
continues to blink during the application programming
process.

Finished After programming has completed, the DXM resets and begins
running the new firmware

The firmware file names follow an 8.3 filename convention. The first 5 characters are the firmware part number in
hexadecimal; the last 3 characters of the part number are the major/minor version number. For example, if 30FA9052.hex is
the firmware programming file, 200617 decimal (30FA9 hex) is the firmware part number and 0.5.2 (0502) is the decoded
version number.

Update Your DXM Processor Firmware Using the DXM Configuration Tool
To update your processor firmware using the DXM Configuration Software, follow these instructions.

1. Using the DXM Configuration Software version 3 or later, connect to the DXM via USB 8 or Ethernet.
File loads to the DXM will take about 15 minutes using USB or approximately 2 minutes using Ethernet.

2. On the DXM Configuration Software, go to Settings > General > Device Information to verify the current firmware
version.
You must load a different version with the same firmware number for the boot loader to operate. Download firmware
files from the Banner website.

Figure 61. Device Information

3. Under Settings > Reprogram, click Select upgrade file to select the firmware file to program.
After the file load is completed, the DXM restarts and loads the new firmware file. It takes about 2 minutes to complete the
programming process. The device reboots when finished. Verify the firmware has been updated, under Settings > General >
Device Information.

8 While the file download is in process over a USB connection, do not use other applications on the PC. After the DXM reboots for a firmware update,
the USB port may be unresponsive. Clear the connection by disconnecting the USB cable and restarting the DXM Configuration Software software.
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Update Your Processor Firmware Using the Banner Cloud Data Services Website
To update your processor firmware (version 2.0 or later) using the DXM website, follow these instructions.
To use the website to update the firmware file, first configure the DXM to push data to the website.

1. Go to Dashboard > Sites and click + to verify the current firmware part number and version on the DXM.
 

 
Data collected from the DXM is displayed.

2. From the main Dashboard > Sites screen, click on Update.
A popup box appears.

3. Set the Communications Type to Push Reply, and set the Update Type to Firmware file.
4. Choose the appropriate Upload File (*.HEX) and click Queue. Click Close.

At the next scheduled push interval, the DXM retrieves the new firmware file. The new firmware file must be the same
part number of firmware that is currently in the DXM.

Update Your Processor Firmware Manually
To manually update your processor firmware (version 2.0 or later) using SD card, follow these instructions.
The firmware file can manually be put on the SD card in the BOOT directory (must have version 2.0 or later on the DXM).

1. Disconnect the DXM from its power supply.
2. Remove the micro SD card from the DXM.

a) Open the cover housing to the DXM.
b) Use your fingernail to slide the top metal portion of SD card holder.
c) The metal cover hinges upward, allowing access to the remove the SD card.
d) Press down on the SD cover and slide back into position to close the SD card holder.

3. Insert the micro SD card into an SD card reader to access the data from a PC.
4. Load the new firmware file (*.hex) into the BOOT directory of the micro SD card.
5. Re-insert the micro SD card into the DXM by sliding the card into the holder.
6. Reconnect the DXM to its power supply.

The automatic boot process should begin. If the boot process does not begin, verify the firmware file is correct and it
is a different version than what is currently installed on the device.
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13.2.3 Troubleshooting Issues
Problem Solution

Communication contention between
the LCD and process

The LCD and the processor applications share the external Modbus connection. If the processor is configured to
constantly interact with Modbus, it may cause issues with the LCD attempting to use the functions of the ISM radio.
To alleviate the contention do one of these things:

• Load a DXM configuration file that slows down the read/write rules.
• Disable the DXM configuration file from loading into the processor by setting DIP switch 4 to ON (on the

processor board). Reboot the device. When the processor reboots, it will not load the configuration file
and remains idle.

Cellular modem did not turn on If the incoming voltage drops below 11.2 V dc, the cellular modem does not turn on and will not turn on until the
voltage is above 11.8 V dc. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of
the incoming voltage. If cellular operation stops because of voltage, it is logged in this file.

13.2.4 Modbus Operation
All Modbus transactions are managed by a central Modbus engine. If there are Modbus messages intended for a Modbus
slave that doesn't exist, the Modbus engine waits for a response until the timeout period is expired. This slows down the
Modbus polling loop for read and write operations.
For this reason, verify all Modbus read and write operations are intended for Modbus slave devices that are in the network. If
a Modbus slave is not in the network, either a wired or wireless device, the operation of the LCD menu system can be
compromised. Operations like Binding, Site Survey, or accessing the ISM menu may be slower. This is because all internal
devices (such as the ISM radio, LCD, etc) of the DXM are also Modbus slaves.

13.3 DXM100 Documentation
• DXM Wireless Controller Sell Sheet, p/n 194063
• DXM100-B1 Wireless Controller Datasheet, p/n 186724
• DXM100-B2 Wireless Controller Datasheet, p/n 195232
• DXM100-Bx Wireless Controller Instruction Manual, p/n 190037
• DXM100-S1 Modbus Slave Datasheet, p/n 195454
• DXM100-S2 Modbus Slave Datasheet, p/n 195231
• DXM100-Sx Modbus Slave Instruction Manual, p/n 188231
• DXM ScriptBasic Instruction Manual, p/n 191745
• DXM Controller API Protocol, p/n 186221
• DXM Controller Configuration Quick Start, p/n 191247
• SolutionsKit-AG1 Quick Start Guide, p/n212028
• DXM Configuration Software v4 (p/n b_4496867)
• DXM Configuration Software v4 Instruction Manual, p/n 209933
• DXM EDS Configuration filefor Allen-Bradley PLCs, p/n b_4205242
• EIP Configuration File for DXM 1xx-BxR1 and R3 models, p/n 194730
• Banner CDS Web Service Quick Start Guide, p/n 201126
• Banner CDS Web Service Instruction Manual, p/n 178337
• Activating a Cellular Modem, p/n b_4419353
• Additional technical notes and videos

For more information about the DXM100 family of products, including technical notes, configuration examples, and
ScriptBasic programs, please visit www.bannerengineering.com.

13.4 DXM1000 Documentation
• DXM Wireless Controller Sell Sheet, p/n 194063
• DXM1000-B1 Wireless Controller Datasheet, p/n 210852
• DXM100 and 1000-Bx Wireless Controller Instruction Manual, p/n 190037
• DXM ScriptBasic Instruction Manual, p/n 191745
• DXM Controller Configuration Quick Start, p/n 191247
• DXM Configuration Software (p/n b_4447978)
• DXM Configuration Software Instruction Manual, p/n 158447
• DXM EDS Configuration file for Allen-Bradley PLCs
• EIP Configuration File for DXM 1xx-BxR1 and R3 models (p/n 194730)
• Activating a Cellular Modem (p/n b_4419353)
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• Video tutorials: search "DXM Tutorial" at youtube.com/bannerengineering.
• Additional technical notes

For more information about the DXM1000 family of products, including technical notes, configuration examples, and
ScriptBasic program examples, please refer to the Banner website: www.bannerengineering.com.

13.5 DXM Support Policy
The DXM Wireless Controllers are industrial wireless controllers that facilitate Industrial Internet of Things (IIoT) applications.
As a communications gateway, it interfaces local serial ports, local I/O ports, and local ISM radio devices to the Internet using
either a cellular connection or a wired Ethernet network connection. In a continuing effort to provide the best operation for the
DXM, stay connected with Banner Engineering Corp to hear about the latest updates through the Banner website. Create a
login today to stay informed of all Banner product releases.

13.5.1 Firmware Updates
The DXM has been designed to be a robust and secure IOT device. To provide the most reliable and secure device possible,
periodic firmware updates are released to enhance and expand the capabilities of the DXM. Firmware updates and
description details are found on the Banner website. Customers with critical update requirements will get access to pre-
released firmware from the factory.

13.5.2 Website Information
The Banner website is the main method of disseminating DXM information to customers. The data found on the website
include:

• DXM instruction manuals
• Configuration manuals
• Firmware downloads
• Firmware release notes
• Errata data, any known issues with a release of firmware
• Possible work-around solutions for known issues
• DXM Solutions Guides

13.5.3 Feature Requests
Our customer is our most valuable resource to improve our DXM. If you have suggestions for improvements to the DXM or
configuration tools, please contact Banner Engineering Corp.

13.5.4 Potential DXM Issues
Potential issues with the DXM are collected from Banner's support engineers to provide solutions. Users can get help from
the website documentation or by calling Banner Engineering for support help. Solutions are as simple as configuration
adjustments, work-around configuration solutions, or potential new firmware updates.

13.5.5 DXM Security
The DXM was designed to collect local wireless sensor data, local sensor data, provide simple control, and send the data to
the cloud.
The DXM does not run a Linux or Windows based operating system but an embedded real-time operating system (RTOS)
environment. As a proprietary operating system, the security aspects are easier to manage and minimize.
Security updates are released through the Banner Engineering Corp website (www.bannerengineering.com) and New
Product Release Announcements (NPRA).

13.6 Contact Us
Banner Engineering Corp. headquarters is located at:

9714 Tenth Avenue North
Minneapolis, MN 55441, USA
Phone: + 1 888 373 6767

For worldwide locations and local representatives, visit www.bannerengineering.com.
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13.7 Mexican Importer
Banner Engineering de Mèxico, S. de R.L. de C.V.
David Alfaro Siqueiros 103 Piso 2 Valle oriente
San Pedro Garza Garcia Nuevo Leòn, C. P. 66269

81 8363.2714

13.8 FCC and ISED Certification, 900 MHz, 1 Watt Radios
This equipment contains transmitter module RM1809.

FCC ID: UE3RM1809
IC: 7044A-RM1809
HVIN: RM1809

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.
This device contains licence-exempt transmitters(s)/receiver(s) that comply with Innovation,
Science and Economic Development Canada’s licence-exempt RSS(s). Operation is subject
to the following two conditions: (1) This device may not cause interference, and (2) This
device must accept any interference, including interference that may cause undesired
operation of the device.
Cet appareil contient des émetteurs/récepteurs exemptés de licence conformes à la norme
Innovation, Sciences, et Développement économique Canada. L’exploitation est autorisée
aux deux conditions suivantes: (1) L’appareil ne doit pas produire de brouillage, and (2)
L’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le
brouillage est susceptible d’en compromettre le fonctionnement.

FCC Notices
IMPORTANT: The transmitter modules RM1809 have been certified by the FCC / ISED for use with other products without
any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by the manufacturer
could void the user’s authority to operate the equipment.
IMPORTANT: The transmitter modules RM1809 have been certified for fixed base station and mobile applications. If
modules will be used for portable applications, the device must undergo SAR testing.
IMPORTANT: If integrated into another product, the FCC ID label must be visible through a window on the final device or it
must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside
of the final device that contains the following text:

Contains Transmitter Module RM1809
FCC ID: UE3RM1809
IC: 7044A-RM1809
HVIN: RM1809
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device
may not cause harmful interference, and (2) this device must accept any interference received, including interference that
may cause undesired operation.

Note
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna,
• Increase the separation between the equipment and receiving module,
• Connect the equipment into an outlet on a circuit different from that to which the receiving module is connected,

and/or
• Consult the dealer or an experienced radio/TV technician for help.

Antenna WARNING: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in Table 41
on page 104. When integrated into OEM products, fixed antennas require installation preventing end-users from replacing
them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC Section 15.203
(unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.
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FCC and ISED Approved Antennas
WARNING: This equipment is approved only for mobile and base station transmitting devices. Antenna(s) used for this
transmitter must be installed to provide a separation distance of at least 20 cm from all persons and must not be collocated or
operating in conjunction with any other antenna or transmitter.
This radio transmitter module RM1809 have been approved by FCC and ISED Canada to operate with the antenna types
listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a gain greater
than the maximum gain indicated for any type listed are strictly prohibited for use with this device.
Table 41: Certified Antennas for 900 MHz 1 Watt

Model Number Antenna Type Maximum Gain Impedance Minimum Required Cable/
Connector Loss

- Integral Antenna Unity gain 0

BWA-9O1-x Omni, 1/4 wave dipole ≤2 dBi 50 Ω 0

BWA-9O2-C Omni, 1/2 wave dipole, Swivel ≤2 dBi 50 Ω 0

BWA-9O6-A Omni Wideband, Fiberglass Radome ≤8.2 dBi 50 Ω 2.2 dB

BWA-9O5-B Omni Base Whip ≤7.2 dBi 50 Ω 1.2 dB

BWA-9Y10-A Yagi ≤10 dBi 50 Ω 4 dB

13.9 FCC and ISED Certification, 2.4GHz
This equipment contains transmitter module DX80-2400 or SX243.

FCC ID:
UE300DX80-2400
IC: 7044A-DX8024
FCC ID: UE3SX243
IC: 7044A-SX243
HVIN: DX80G2 /
DX80N2 / SX243

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.
This device contains licence-exempt transmitters(s)/receiver(s) that comply with Innovation,
Science and Economic Development Canada’s licence-exempt RSS(s). Operation is subject to
the following two conditions: (1) This device may not cause interference, and (2) This device
must accept any interference, including interference that may cause undesired operation of the
device.
Cet appareil contient des émetteurs/récepteurs exemptés de licence conformes à la norme
Innovation, Sciences, et Développement économique Canada. L’exploitation est autorisée aux
deux conditions suivantes: (1) L’appareil ne doit pas produire de brouillage, and (2) L’utilisateur
de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est
susceptible d’en compromettre le fonctionnement.

FCC Notices
IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified by the FCC / ISED for use with other
products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.
IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified for fixed base station and mobile
applications. If modules will be used for portable applications, the device must undergo SAR testing.
IMPORTANT: If integrated into another product, the FCC ID/IC label must be visible through a window on the final device or
it must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the
outside of the final device that contains the following text:

Contains Transmitter Module [DX80-2400 or SX243]
FCC ID: [UE300DX80-2400 or UE3SX243]
IC: [7044A-DX8024 or 7044A-SX243]
HVIN: [DX80G2, DX80N2 or SX243]
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device
may not cause harmful interference, and (2) this device must accept any interference received, including interference that
may cause undesired operation.

Note
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
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that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna,
• Increase the separation between the equipment and receiving module,
• Connect the equipment into an outlet on a circuit different from that to which the receiving module is connected,

and/or
• Consult the dealer or an experienced radio/TV technician for help.

Antenna Warning: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in Table 42 on
page 105. When integrated into OEM products, fixed antennas require installation preventing end-users from replacing them
with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC Section 15.203 (unique
antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas
WARNING: This equipment is approved only for mobile and base station transmitting devices. Antenna(s) used for this
transmitter must be installed to provide a separation distance of at least 20 cm from all persons and must not be collocated or
operating in conjunction with any other antenna or transmitter.
The radio transmitter modules DX80-2400 and SX243 have been approved by FCC and ISED Canada to operate with the
antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a
gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.
Table 42: Certified Antennas for 2.4 GHz

Model Antenna Type 2.4 GHz Radio Module Maximum Gain Impedance

Integral antenna DX80-2400 Unity gain

BWA-2O2-C Omni, 1/2 wave dipole, Swivel DX80-2400 or SX243 ≤ 2 dBi 50 Ω

BWA-2O2-D Omni, Dome, Box Mount DX80-2400 ≤ 2 dBi 50 Ω

BWA-2O2-E Omni, 1/4 wave dipole, Swivel DX80-2400 ≤ 2 dBi 50 Ω

BWA-2O5-C Omni, Collinear, Swivel DX80-2400 ≤ 5 dBi 50 Ω

BWA-2O5-MA Omni, full-wave dipole, NMO DX80-2400 ≤ 4.5 dBi 50 Ω

BWA-2O6-A Omni, Dome, Box Mount DX80-2400 ≤ 6 dBi 50 Ω

BWA-2O7-C Omni, Coaxial Sleeve, Swivel DX80-2400 ≤ 7 dBi 50 Ω

13.10 ANATEL
Modelo (Model): DX80-2400—Este equipamento não tem direito à proteção contra interferência prejudicial e não pode causar
interferência em sistemas devidamente autorizados. Para maiores informações, consulte o site da ANATEL www.gov.br/anatel/pt-br/

13.11 Warnings
Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna
configurations installed without surge suppressors invalidate the manufacturer's warranty. Keep the ground wire as short as
possible and make all ground connections to a single-point ground system to ensure no ground loops are created. No surge
suppressor can absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected to the Sure
Cross device during a thunderstorm.
Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio
frequency emissions. Customers who want to re-export this product to a country other than that to which it was sold
must ensure the device is approved in the destination country. The Sure Cross wireless products were certified for use
in these countries using the antenna that ships with the product. When using other antennas, verify you are not exceeding
the transmit power levels allowed by local governing agencies. This device has been designed to operate with the antennas
listed on Banner Engineering’s website and having a maximum gain of 9 dBm. Antennas not included in this list or having a
gain greater that 9 dBm are strictly prohibited for use with this device. The required antenna impedance is 50 ohms. To
reduce potential radio interference to other users, the antenna type and its gain should be so chosen such that the equivalent
isotropically radiated power (EIRP) is not more than that permitted for successful communication. Consult with Banner
Engineering Corp. if the destination country is not on this list.
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Important: Please download the complete DXM100/1000-Bx Wireless Controller technical documentation,
available in multiple languages, from www.bannerengineering.com for details on the proper use,
applications, Warnings, and installation instructions of this device.

Important: Por favor descargue desde www.bannerengineering.com toda la documentación técnica de los
DXM100/1000-Bx Wireless Controller, disponibles en múltiples idiomas, para detalles del uso adecuado,
aplicaciones, advertencias, y las instrucciones de instalación de estos dispositivos.

Important: Veuillez télécharger la documentation technique complète des DXM100/1000-Bx Wireless
Controller sur notre site www.bannerengineering.com pour les détails sur leur utilisation correcte, les
applications, les notes de sécurité et les instructions de montage.

WARNING:
• Do not use this device for personnel protection
• Using this device for personnel protection could result in serious injury or death.
• This device does not include the self-checking redundant circuitry necessary to allow its use in

personnel safety applications. A device failure or malfunction can cause either an energized (on)
or de-energized (off) output condition.

Important:
• Never operate a 1 Watt radio without connecting an antenna
• Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
• To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure

Cross MultiHop (1 Watt) radio without an antenna connected.

Important:
• Electrostatic discharge (ESD) sensitive device
• ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
• Use proper handling procedures to prevent ESD damage. Proper handling procedures include

leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and
assembling units on a grounded, static-dissipative surface.

13.12 Banner Engineering Corp. Limited Warranty
Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner Engineering Corp. will
repair or replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been defective during the warranty period. This
warranty does not cover damage or liability for misuse, abuse, or the improper application or installation of the Banner product.
THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF
DEALING OR TRADE USAGE.
This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING CORP. BE
LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT, WHETHER
ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.
Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any product
previously manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for personal protection
applications when the product is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior express approval by
Banner Engineering Corp will void the product warranties. All specifications published in this document are subject to change; Banner reserves the right to modify product
specifications or update documentation at any time. Specifications and product information in English supersede that which is provided in any other language. For the most
recent version of any documentation, refer to: www.bannerengineering.com.
For patent information, see www.bannerengineering.com/patents.

13.13 Glossary of Wireless Terminology
This definitions list contains a library of common definitions and glossary terms specific to the Wireless products.
EtherNet/IP™ is a trademark of ODVA, Inc.
Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries.
Modbus® is a registered trademark of Schneider Electric USA, Inc.
PROFINET® is a registered trademark of PROFIBUS Nutzerorganisation e.V.
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active threshold An active threshold is a trigger point or reporting threshold for an analog input.

a/d converter An analog to digital converter converts varying sinusoidal signals from instruments into binary code for a
computer.

address mode The Sure Cross® wireless devices may use one of two types of addressing modes: rotary dial
addressing or extended addressing. In rotary dial address mode, the left rotary dial establishes the
network ID (NID) and the right rotary dial sets the device address. Extended address mode uses a
security code to "bind" Nodes to a specific Gateway. Bound Nodes can only send and receive
information from the Gateway they are bound to.

antenna Antennas transmit radio signals by converting radio frequency electrical currents into electromagnetic
waves. Antennas receive the signals by converting the electromagnetic waves back into radio frequency
electrical currents.

attenuation Attenuation is the radio signal loss occurring as signals travel through the medium. Radio signal
attenuation may also be referred to as free space loss. The higher the frequency, the faster the signal
strength decreases. For example, 2.4 GHz signals attenuate faster than 900 MHz signals.

baseline filter
(M-GAGE)

Under normal conditions, the ambient magnetic field fluctuates. When the magnetic field readings drift
below a threshold setting, the baseline or drift filter uses an algorithm to slowly match the radio device’s
baseline to the ambient magnetic field.

binding (DX80
star networks)

Binding Nodes to a Gateway ensures the Nodes only exchange data with the Gateway they are bound
to. After a Gateway enters binding mode, the Gateway automatically generates and transmits a unique
extended addressing (XADR), or binding, code to all Nodes within range that are also in binding mode.
The extended addressing (binding) code defines the network, and all radios within a network must use
the same code.
After binding your Nodes to the Gateway, make note of the binding code displayed under the *DVCFG >
XADR menu on the Gateway's LCD. Knowing the binding code prevents having to re-bind all Nodes if
the Gateway is ever replaced.

binding
(MultiHop
networks)

Binding MultiHop radios ensures all MultiHop radios within a network communicate only with other
radios within the same network. The MultiHop radio master automatically generates a unique binding
code when the radio master enters binding mode. This code is then transmitted to all radios within range
that are also in binding mode. After a repeater/slave is bound, the repeater/slave radio accepts data only
from the master to which it is bound. The binding code defines the network, and all radios within a
network must use the same binding code.
After binding your MultiHop radios to the master radio, make note of the binding code displayed under
the *DVCFG > -BIND menu on the LCD. Knowing the binding code prevents having to re-bind all radios
if the master is ever replaced.

binding (serial
data radio
networks)

Binding the serial data radios ensures all radios within a network communicate only with the other radios
within the same network. The serial data radio master automatically generates a unique binding code
when the radio master enters binding mode. This code is transmitted to all radios within range that are
also in binding mode. After a repeater/slave is bound, the repeater/slave radio accepts data only from
the master to which it is bound. The binding code defines the network, and all radios within a network
must use the same binding code.

bit packing i/o Bit packing uses a single register, or range of contiguous registers, to represent I/O values. This allows
you to read or write multiple I/O values with a single Modbus message.

booster (boost
voltage)

A booster is an electronic circuit that increases a battery-level voltage input (3.6V) to a sensor operating
voltage output (5 to 20 V).

CE The CE mark on a product or machine establishes its compliance with all relevant European Union (EU)
Directives and the associated safety standards.

change of state Change of state reporting is a report initiated by the Node when a change to the sensor’s input state is
detected. If the input does not change, nothing is reported to the Gateway.
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Something 
has changed

data

channel A channel may be either a path for communications or a range of radio frequencies used by a
transceiver during communication.

collision A collision is a situation in which two or more transmissions are competing to communicate on a system
that can only handle one transmission at a time. This may also be referred to as a data collision.

collocated
networks

To prevent interference between collocated wireless networks, assign each wireless network a different
Network ID. The Network ID is a unique identifier assigned to each wireless network using the rotary
dials on the Gateway.

contention
architecture

Contention architecture is a wireless communication architecture that allows all network devices access
to the communications channel at the same time. This may lead to transmission collisions.

counter - event The event counter counts the total number of times an input signal changes to the high/ON/1 state. The
counter increments on the falling edge of an input signal when the signal level crosses the threshold.
Event counters can be used to measure the total operational cycles of a spinning shaft or the total
number of items traveling down a conveyor.

counter -
frequency

The frequency counter calculates the frequency of the input signal, in Hz.
Frequency counters can be used to measure flow rates, such as measuring the flow rate of items on a
conveyor or the speed at which a windmill spins.

courtesy power
outputs

Courtesy power outputs provide continuous power and cannot be turned on or off.

cyclic reporting Cyclic reporting is when the Gateway polls the Node at user-defined intervals.

It is time to
report

data

debounce When a signal changes state using a mechanical switch or relay, the signal can oscillate briefly before
stabilizing to the new state. The debounce filter examines the signal’s transitions to determine the
signal’s state.

The signal oscillates between states after a mechanical switch
 or relay activates.

Without a debounce filter, the signal is interpreted to change
state multiple times.

With a debounce filter, the signal is interpreted to change state
only once.

The factory default setting is to activate the input filtering to compensate for unclean state transitions.

decibel A decibel is a logarithmic ratio between a specific value and a base value of the same unit of measure.
With respect to radio power, dBm is a ratio of power relative to 1 milliWatt. According to the following
equation, 1 mW corresponds to 0 dBm.
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Equation: PmW = 10x/10 where x is the transmitted power in dBm, or dBm = 10 log(PmW)
Another decibel rating, dBi, is defined as an antenna’s forward gain compared to an idealized isotropic
antenna. Typically, dBm = dBi = dBd + 2.15 where dBi refers to an isotropic decibel, dBd is a dipole
decibel, and dBm is relative to milliwatts.

deep sleep
mode

Potted Puck models, potted M-GAGE models: Some battery-powered M-GAGE radios ship in a "deep
sleep" mode to conserve battery power. While in "deep sleep" mode, the M-GAGE does not attempt to
transmit to a parent radio and remains in "deep sleep" until an LED light at the receiving window wakes
it up. M-GAGEs that ship in "deep sleep" mode are typically the potted M-GAGEs that require an LED
Optical Commissioning Device to configure the M-GAGE.
Wireless Q45 Sensors: If the Wireless Q45 Sensor fails to communicate with the Gateway for more than
5 minutes, it enters sleep mode. The radio continues to search for the Gateway at a slower rate and the
LEDs do not blink. To wake up the sensor, press any button. After the Q45 wakes up, it will do a fast
rate search for the Gateway for five more minutes.

default output
triggers

Default output triggers are the conditions that drive outputs to defined states. Example default output
conditions include when radios are out of sync, when a device cycles power, or during a host
communication timeout.
Device Power Up—Outputs are set to user-defined states every time the device is powered up.
Out of Sync—Outputs are set to user-defined states when the radio is out of sync with its parent radio.
Host Link Failure—Host link failure is when the defined timeout period has elapsed with no
communications between the host system (or Modbus master device) and the DX80 Gateway, typically
about four seconds. Outputs are set to user-defined states when a host link failure has been detected.
Node Link Failure—Node link failures are determined by the polling interval or the out-of-sync timing.
When a Node detects a communications failure with the Gateway and the Node Link Failure flag is set,
the output points are set to the user-defined states and the inputs are frozen.
Gateway Link Failure—Gateway link failures are determined by three global parameters: Polling
Interval, Maximum Missed Message Count and Re-link Count. When the Node’s Gateway Link Failure
flag is set and the Gateway determines a timeout condition exists for a Node, any outputs linked from
the failing Node are set to the user-defined default state.

default output
value

Default output values are specific values written to output registers. For discrete outputs, this is a 1 (on)
or 0 (off) value. For analog outputs the value can be any valid register value. When a default condition
occurs, these default output values are written to the output register.

delta The delta parameter defines the change required between sample points of an analog input before the
analog input reports a new value. To turn off this option, set the Delta value to 0.

determinism A deterministic system defines how network endpoints behave during the loss of communications. The
network identifies when the communications link is lost and sets relevant outputs to user-defined
conditions. Once the radio signal is re-established, the network returns to normal operation.

device, node, or
radio address/ID
(DX80
Networks)

The Node address is a unique identifier for each wireless device on a network and is set using the rotary
dials. For the DX80 networks, Gateways are identified as device 0. Nodes are assigned addresses
(NADR) from 01 to 47 using the rotary dials.

directional
antenna

A direction antenna, or Yagi, is an antenna that focuses the majority of the signal energy in one specific
direction.

Direct Sequence
Spread
Spectrum
(DSSS)

Direct Sequence Spread Spectrum is a method for generating spread spectrum transmissions where the
transmitted signal is sent at a much higher frequency than the original signal, spreading the energy over
a much wider band. The receiver is able to de-spread the transmission and filter the original message.
DSSS is useful for sending large amounts of data in low to medium interference environments.
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Direct Sequence
Spread Signal
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Frequency902 MHz 928 MHz

DX83 Ethernet
Bridge

The Ethernet Bridge acts as a communications bridge between the Modbus RTU network (Gateway)
and Modbus/TCP or EtherNet/IP host systems and includes the ability to configure the network using a
Web browser interface.

effective
isotropic
radiated power
(EIRP)

The EIRP is the effective power found in the main lobe of a transmitter antenna, relative to a 0 dB
radiator. EIRP is usually equal to the antenna gain (in dBi) plus the power into that antenna (in dBm).

Ethernet Ethernet is an access method for computer network (Local Area Networks) communications, defined by
IEEE as the 802 standard.

EtherNet/IP™ EtherNet/IP is Allen-Bradley’s DeviceNet running over Ethernet hardware.

extended
address mode

Using extended address mode isolates networks from one another by assigning a unique code, the
extended address code, to all devices in a particular network. Only devices sharing the extended
address code can exchange data. The extended address code is derived from the Gateway's serial
number, but the code can be customized using the manual binding procedure.

flash pattern Flash patterns are established by selecting timeslots to turn the output on or off. While originally the
flash pattern was designed to turn on and off an indicator light, the flash pattern can be set for any
discrete output or switch power output.

FlexPower Banner’s FlexPower® technology allows for a true wireless solution by allowing the device to operate
using either 10 to 30 V DC, 3.6 V lithium D cell batteries, or solar power. This unique power
management system can operate a FlexPower Node and an optimized sensing device for up to 5 years
on a single lithium D cell.

free space loss
(FSL)

The radio signal loss occurring as the signal radiates through free space. Free Space Loss = 20 Log
(4(3.1416)d/λ ) where d is in meters. Remembering that λf = c = 300 x 106 m/s, the equations reduce
down to:

For the 900 MHz radio band: FSL = 31.5 + 20 Log d (where d is in meters).
For the 2.4 GHz radio band: FSL = 40 + 20 Log d (where d is in meters.)

Frequency
Hopping Spread
Spectrum
(FHSS)

Frequency Hopping Spread Spectrum (FHSS) is a method for generating spread spectrum
transmissions where the signal is switched between different frequency channels in a pseudo-random
sequence known by both the transmitter and the receiver. FHSS is useful for sending small packets of
data in a high interference environment.

902 MHz 928 MHz

1 2 3 25 26 27. . . . . . . . . . . . . . . . . . . . 

Frequency

Po
we

r

Fresnel zone Fresnel zones are the three-dimensional elliptical zones of radio signals between the transmitter and
receiver. Because the signal strength is strongest in the first zone and decreases in each successive
zone, obstacles within the first Fresnel zone cause the greatest amount of destructive interference.
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1st Fresnel Zone

2nd Fresnel Zone

3rd Fresnel Zone

Tx Rx

gain Gain represents how well the antenna focuses the signal power. A 3 dB gain increase doubles the
effective transmitting power while every 6 dB increase doubles the distance the signal travels.
Increasing the gain sacrifices the vertical height of the signal for horizontal distance increases. The
signal is ‘squashed’ down to concentrate the signal strength along the horizontal plane.

gateway A gateway is a general network device that connects two different networks.

Gateway A Sure Cross® Gateway is the wireless sensor network master device used to control network timing
and schedule communication traffic. Similar to how a gateway device on a wired network acts as a
"portal" between networks, the Sure Cross Gateway acts as the portal between the wireless network
and the central control process. Every wireless I/O sensor network requires one Gateway device. Every
Sure Cross device is a transceiver, meaning it can transmit and receive data.

GatewayPro The GatewayPro combines the standard Gateway and the DX83 Ethernet Bridge into one device.

ground loop Ground loops are grounds within a system that are not at the same potential. Ground loops can damage
electrical systems.

ground plane A ground plane is an electrically conductive plate that acts as a ‘mirror’ for the antenna, effectively
doubling the length of the antenna. When using a 1/4 wave antenna, the ground plane acts to ‘double’
the antenna length to a 1/2 wave antenna.

heartbeat mode In heartbeat mode, the Nodes send "heartbeat" messages to the Gateway at specific intervals to
indicate the radio link is active. The heartbeat is always initiated by the Node and is used only to verify
radio communications. Using the Nodes to notify the Gateway that the radio link is active instead of
having the Gateway "poll" the Nodes saves energy and increases battery life.

I am here

hibernation/
storage mode

While in storage mode, the radio does not operate. To put any integrated battery Sure Cross® radio into
storage mode, press and hold button 1 for five seconds. To wake the device, press and hold button 1 for
five seconds. The radio is in storage mode when the LEDs stop blinking, but in some models, the LCD
remains on for an additional minute after the radio enters storage mode. After a device has entered
storage mode, you must wait one minute before waking it.
For the Wireless Q45 and Q120 Sensors: While in storage mode, the device's radio does not operate,
to conserve the battery. To put any device into storage mode, press and hold the binding button for five
seconds. The device is in storage mode when the LEDs stop blinking. To wake the device, press and
hold the binding button (inside the housing on the radio board) for five seconds.

hop As a verb, hopping is the act of changing from one frequency to another. As a noun, a hop is the device
to device transmission link, such as from the Master device to the Slave device.

hop table A hop table is a precalculated, pseudo-random list of frequencies used by both the transmitter and
receiver of a radio to create a hopping sequence.

hysteresis Hysteresis defines how far below the active threshold (ON point) an analog input is required to be before
the input is considered OFF. A typical hysteresis value is 10% to 20% of the unit’s range. For more
specific details, see Threshold.
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Hysteresis
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Industrial,
Scientific, and
Medical Band
(ISM)

The ISM, or Industrial, Scientific, and Medical band, is the part of the radio spectrum that does not
require a license for use. The Sure Cross radios operate in the ISM band.

latency A network's latency is the maximum delay between transmission and reception of a data signal.

lightning
arrestor

Also called a lightning suppressor, surge suppressor, or coaxial surge protection, lightning arrestors are
used in remote antenna installations to protect the radio equipment from damage resulting from a
lightning strike. Lightning arrestors are typically mounted close to the ground to minimize the grounding
distance.

line of sight Line of sight is the unobstructed path between radio antennas.

link failures A Host Link Failure occurs when the defined timeout period, typically about four seconds, elapses with
no communication between the host system (or Modbus master device) and the DX80 Gateway.
A Gateway Link Failure refers to the radio link between a Node and the Gateway and is determined by
three global parameters: Polling Interval, Maximum Missed Message Count, and Re-link Count. When
the Node’s Gateway Link Failure flag is set and the Gateway determines a timeout condition exists for a
Node, any outputs linked from the failing Node are set to the user-defined default state.
A Node Link Failure is determined by the polling interval or the out-of-sync timing. When a Node
detects a communications failure with the Gateway and the Node Link Failure flag is selected, the output
points are set to the user-defined states and the inputs are frozen.

local and non-
local registers

Local registers are registers specific to the device in question. When discussing a Gateway, the
Gateway's local registers include the registers specific to the Gateway in addition to all the Nodes'
registers that are stored in the Gateway. Non-local, or remote, registers refer to registers on other
Modbus slave devices, such as other MultiHop slave radios or third-party Modbus devices.

master/slave
relationship

The master/slave relationships is the model for a communication protocol between devices or processes
in which one device initiates commands (master) and other devices respond (slave). The Sure Cross
network is a master/slave network with the Gateway acting as the master device to the Nodes, which
are the slave devices. A PC can also be a master device to a wireless sensor network. See star
networks.

maximum bad
count

The maximum bad count refers to a user-established maximum count of consecutive failed polling
attempts before the Gateway considers the radio (RF) link to have failed.

maximum
misses

The maximum misses is the number of consecutive polling messages the Node fails to respond to. For
more information, see Polling Rate and Maximum Misses.

median filter When the median filter is turned on, three samples are taken for each analog sensor reading. The high
and low values are discarded and the middle value is used as the analog value. Set to zero (0) to turn
off the median filter. Set to one (1) to turn on the median filter.
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Modbus Modbus is a master-slave communications protocol typically used for industrial applications.

Modbus/TCP Modbus/TCP is an open standard protocol very similar to Modbus RTU except that it uses standard
Internet communication protocols.

MultiHop MultiHop networks are made up of one master radio and many repeater and slave radios. The MultiHop
networks are self-forming and self-healing networks constructed around a parent-child communication
relationship. A MultiHop Radio is either a master radio, a repeater radio, or a slave radio.
The master radio controls the overall timing of the network and is always the parent device for other
MultiHop radios. The host system connects to this master radio. Repeater radios extend the range of the
wireless network and slave radios are the end point of the wireless network.
For more information, refer to the Sure Cross MultiHop Radios Instruction Manual (p/n 151317).

multipath fade Obstructions in the radio path reflect or scatter the transmitted signal, causing multiple copies of a signal
to reach the receiver through different paths. Multipath fade is the signal degradation caused by these
obstructions.

network ID The Network ID (NID) is a unique identifier you assign to each wireless network to minimizes the
chances of two collocated networks interfering with each other. Assigning different NIDs to different
networks improves collocation performance in dense installations.

node A node is any communications point within a network.

Node Nodes are remote I/O slave devices within Banner's wireless sensor networks. Sensors and other
devices connect to the Node's inputs or outputs, allowing the Node to collect sensor data and wirelessly
transmit it to the Gateway. Every Sure Cross device is a transceiver, meaning it can transmit and
receive data.

noise Noise is any unwanted electromagnetic disturbances from within the RF equipment, especially the
receiver. Noise is more of a concern when signal levels are low.

omni-directional
antenna

Omni-directional antennas transmit and receive radio signals equally in all directions.

out of sync/link
loss (loss of
radio signal)

The Sure Cross wireless devices use a deterministic link time-out method to address RF link interruption
or failure. When a radio link fails, all pertinent wired outputs are sent to the selected default value/state
until the link is recovered, ensuring that disruptions in the communications link result in predictable
system behavior. Following a time-out, all outputs linked to the Node in question are set to 0, 1, or hold
the last stable state depending on the value selected.

path loss Path loss describes attenuation as a function of the wavelength of the operating frequency and the
distance between the transmitter and receiver.

path loss (or
link loss)
calculations

Link loss calculations determine the capabilities of a radio system by calculating the total gain or loss for
a system. If the total gain/loss is within a specific range, the radio signal will be received by the radio.
Total Gain = Effective output + Free space loss + Total received power . Because the transmitter
and receiver gains are positive numbers and the free space loss is a larger negative number, the total
gain of a system should be negative. A link loss calculation may also be called a link budget calculation.

peer to peer
network

Peer-to-peer is a model for a communication protocol in which any device in the network can send or
receive data. Any device can act as a Master to initiate communication.

polling interval/
rate

The Gateway communicates with, or polls, each Node to determine if the radio link is active. The polling
rate defines how often the Gateway communicates with each Node. Polling is always initiated by the
Gateway and only verifies radio signal communications.

Are you there?

Yes, I am here.

polling interval/
rate and
maximum
misses

The Gateway communicates with, or polls, each Node to determine if the radio link is active. The polling
rate, or interval, defines how often the Gateway communicates with each Node. Polling is always
initiated by the Gateway and only verifies radio signal communications. Nodes that fail to respond are
counted against the ‘Maximum Misses’ for that Node. If the ‘Maximum Misses’ is exceeded for any
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Node, the Gateway generates an RF timeout error in the Modbus I/O register 8 of the appropriate Node.
The ‘Maximum Misses’ is defined as the number of consecutive polling messages that the Node fails to
respond to.

radiation
pattern

An antenna's radiation pattern is the area over which the antenna broadcasts an easily received signal.
The radiation pattern/shape changes based on the antenna type and gain.

re-link count The re-link count is the number of completed polling messages the Gateway receives from a Node
before a lost RF link is considered re-established and normal operation resumes.

remote antenna A remote antenna installation is any antenna not mounted directly to the Sure Cross wireless device,
especially when coaxial cable is used. Always properly install and ground surge suppressors in remote
antenna systems.

repeater radio A repeater radio extends the transmission range of a wireless network. Repeaters are typically used in
long-distance transmission.

report interval/
rate

The report rate defines how often the Node communicates the I/O status to the Gateway. For battery-
powered applications, setting the report rate to a slower rate extends the battery life.

I/O Status

Change of state reporting sets the system to report only when the value crosses the threshold setting.

rotary dial
address mode

See: address mode

Received Signal
Strength
Indicator (RSSI)

An RSSI is the measurement of the strength of received signals in a wireless environment. See Site
Survey.

resistance
temperature
detector (RTD)

An RTD is a temperature measurement device that measures the electrical resistance across a pure
metal. The most commonly used metal is platinum because of its temperature range, accuracy, and
stability.
RTDs are used for higher precision applications or for longer wire runs because RTDs can compensate
for wire length. In industrial applications, RTDs are not generally used at temperatures above 660º C.
Though RTDs are more accurate, they are slower to respond and have a smaller temperature range
than thermocouples.

sample high/
sample low
(analog I/O)

For analog inputs, the sample high parameter defines the number of consecutive samples the input
signal must be above the threshold before a signal is considered active. Sample low defines the number
of consecutive samples the input signal must be below the threshold minus hysteresis before a signal is
considered deactivated. The sample high and sample low parameters are used to avoid unwanted input
transitions.

sample high/
sample low
(discrete I/O)

For discrete inputs, the sample high parameter defines the number of consecutive samples the input
signal must be high before a signal is considered active. Sample low defines the number of consecutive
samples the input signal must be low before a signal is considered low. The sample high and sample
low parameters are used to create a filter to avoid unwanted input transitions. The default value is 0,
which disables this feature. The value range is 1 through 255.

sample interval/
rate

The sample interval, or rate, defines how often the Sure Cross device samples the input. For battery-
powered applications, setting a slower rate extends the battery life.
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sample on
demand

Sample on demand allows a host system to send a Modbus command to a register and require the
inputs to immediately sample the sensor and report readings back to the host system and/or Gateway.
Sampling on demand can be used between the normal periodic reporting.
The sample on demand feature requires using a host-controlled system capable of sending Modbus
commands to the master radio.

signal-to-noise
ratio (SNR)

The signal-to-noise ratio is the ratio of the signal to any background noise or noise generated by the
medium. In radio terms, it a ratio of the transmitted radio signal to the noise generated by any
electromagnetic equipment, in particular the radio receiver. The weaker the radio signal, the more of an
influence noise has on radio performance. Like gain, the signal-to-noise ratio is measured in decibels.
The equations for calculating SNR are:

SNR = 20 × log (Vs/Vn) where Vs is the signal voltage and Vn is the noise voltage;
SNR = 20 × log (As/An) where As is the signal amplitude and An is the noise amplitude; or
SNR = 10 × log (Ps/Pn) where Ps is the signal power and Pn is the noise power.

single-point
ground

All grounds within a system are made to a single ground to avoid creating ground loops.

site survey Conducting a site survey, also known as a radio signal strength indication (RSSI), analyzes the radio
communications link between the Gateway (or master radio) and any Node (or slave radio) within the
network by analyzing the radio signal strength of received data packets and reporting the number of
missed packets that required a retry.

slave ID The slave ID is an identifying number used for devices within a Modbus system. When using more than
one Modbus slave, assign each slave a unique ID number.
By default, Gateways are set to Modbus Slave ID 1.

sleep mode During normal operation, the Sure Cross radio devices enter sleep mode after 15 minutes of operation.
The radio continues to function, but the LCD goes blank. To wake the device, press any button.

slow scan mode (All internal battery models)In slow scan mode, the device enters a deeper sleep mode to conserve
battery power after the device loses its communication link with its parent or master radio. The device
wakes up periodically to search for its parent radio. If a parent or master radio is not found, the device
goes back to sleep for another sleep cycle. If the parent or master radio is detected, the device exits
slow scan mode. To manually exit slow scan mode, press the binding button.

SMA connector An SMA connector (SubMiniature version A) is a 50 ohm impedance connector used for coaxial RF
connections and developed in the 1960s. An SMA connector is typically used between the radio and the
antenna.

spread
spectrum

Spread spectrum is a technique in which the transmitter sends (or spreads) a signal over a wide range
of frequencies. The receiver then concentrates the frequencies to recover the information. The Sure
Cross radio devices use a version of spread spectrum technology called Frequency Hop Spread
Spectrum.

star networks A star topology network is a point to multipoint network that places the network master radio in a center
or hub position. Slave radios only transmit messages to the master radio, not to each other. These
network layouts can be very flexible and typically operate relatively quickly. Slave radios acknowledge
receipt of messages transmitted from the master radio.
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For more information on Banner's star network products, refer to the Sure Cross Performance DX80
Wireless I/O Network Instruction Manual (p/n 132607)

switch power Efficient power management technology enables some FlexPower devices to include an internal power
output supply, called switch power (SP), that briefly steps up to power sensors (ideally, 4 to 20 mA loop-
powered sensors). The warmup time denotes how long the sensor must be powered before a reliable
reading can be taken. After the warmup time has passed, the input reads the sensor, then the switched
power shuts off to prolong battery life.

system
operating
margin (fade
margin)

The system operating margin, or fade margin, is the difference between the received signal level (in
dBm) and the receiver sensitivity (also in dBm) required for reliable reception. It is recommended that
the receiver sensitivity be more than 10 dBm less than the received signal level. For example, if the
signal is about –65 dB after traveling through the air and the radio receiver is rated for -85 dB, the
operating margin is 20 dB — an excellent margin.

tau filter Set to zero (0) to turn off the tau filter. Set to 1 (weakest filter) through 6 (strongest filter) to turn on the
tau filter. (In the DX80 products, the Low Pass Filter is a combination of the median filter and the tau
filter.)

TCP/IP TCP/IP stands for Transfer Control Protocol / Internet Protocol and describe several layers in the OSI
model that control the transfer and addressing of information.

time-division
multiple access
(TDMA)

TDMA is a wireless network communication architecture that provides a given slot of time for each
device on the network, providing a guaranteed opportunity for each device to transmit to the wireless
network master device.

thermistor A thermistor is a temperature-sensitive resistor that changes resistance based on temperature
fluctuation.

thermocouple A thermocouple is a temperature measuring device consisting of two dissimilar metals joined together so
that the difference in voltage can be measured. Voltage changes in proportion to temperature, therefore
the voltage difference indicates a temperature difference.
The different “types” of thermocouples use different metal pairs for accuracy over different temperature
ranges. Thermocouples are inexpensive, relatively interchangeable, have standard connectors, and
have a wide temperature range of operation. They can be susceptible to noise, with the wire length
affecting accuracy. Thermocouples are best suited for applications with large temperature ranges, not
for measuring small temperature changes over small ranges.

threshold and
hysteresis

Threshold and hysteresis work together to establish the ON and OFF points of an analog input. The
threshold defines a trigger point or reporting threshold (ON point) for a sensor input. When the input
value is higher than the threshold, the input is ON. Hysteresis defines how far below the threshold the
analog input is required to be before the input is considered OFF. A typical hysteresis value is 10% to
20% of the unit’s range.
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In the example shown, the input is considered on at 15 mA. To consider the input off at 13 mA, set the
hysteresis to 2 mA. The input will be considered off when the value is 2 mA less than the threshold.
Setting threshold and hysteresis points prevents inputs from oscillating between ‘on’ and ‘off’ when the
input remains close to the threshold point.

timeout interval The Timeout Interval is the total elapsed time before the system flags an error condition. This is a
calculated value from Polling Interval (sec) × Maximum Misses.

topology Topology is the pattern of interconnection between devices in a communication network. Some
examples include point to point, bus, ring, tree, mesh, and star configurations.

transceiver A transceiver includes both a transmitter and receiver in one housing and shares circuitry; abbreviated
as RxTx.

wireless sensor
network (WSN)

A wireless sensor network is a network of low-power electronic devices that combine sensing and
processing ability. The devices use radio waves to communicate to a gateway device, connecting
remote areas to the central control process.

Yagi Yagi is the name commonly given to directional antennas. The full name of the antenna is a Yagi-Uda
antenna, named for the developers Shintaro Uda and Hidetsugu Yagi, both of Tohoku Imperial
University in Sendai, Japan. Yagi antennas may also be called beam antennas or directional antennas.

  Sure Cross® DXM100-Bx and DXM1000-Bx Wireless Controllers

 www.bannerengineering.com - Tel: + 1 888 373 6767 117

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2B



Index
A

authentication 54, 55

C

cell modem
activate CAT M1 40
activate Verizon 4G LTE 40
configure DXM 40
install 37, 39
purchase 37, 39

configuration file
save 17, 51, 58, 87
upload 17, 51, 58, 87

create
holiday event 54
one-time event 53
weekly event 53

D
DXM

configure for cell 40

H
holiday event 54

M
modify

multiple registers 16

O
one-time event 53

R
registers

multiple registers 16

S

save
configuration file 17, 51, 58, 87

scheduler 53, 54

U

upload
configuration file 17, 51, 58, 87

W

webserver authentication 54, 55
weekly event 53

   

   

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2B



Datasheet
Sure Cross® Performance embeddable board modules provide connectivity where traditional wired connections are not possible or
are cost prohibitive. Wireless networks are formed around a Gateway, which acts as the wireless network master device, and one or
more Nodes. Sure Cross Performance embeddable board modules communicate with all Sure Cross Performance radios.

• Wireless industrial I/O device with two PNP discrete inputs, two PNP discrete outputs, two 0–
20 mA analog inputs, and two 0–20 mA analog outputs

• Selectable transmit power levels of 250 mW or 1 Watt for 900 MHz models and 65 mW for 2.4
GHz models

• 10 V DC to 30 V DC power input
• DIP switches for user configuration
• Modbus serial interface
• Frequency Hopping Spread Spectrum (FHSS) technology ensures reliable data delivery
• Transceivers provide bidirectional communication between the Gateway and Node, including

fully acknowledged data transmission
• Lost RF links are detected and relevant outputs set to user-defined conditions

Refer to document number 164886, packed with your PB2 Gateway, for a quick start guide to forming PB2 to PB2 networks.

Models
Models Frequency Inputs and Outputs

DX80G2M6S-PB2 2.4 GHz ISM Band Inputs: Two PNP discrete, two 0–20 mA analog
Outputs: Two PNP discrete, two 0–20 mA analog
Automatically maps I/O from a Node to the Gateway via DIP switches on the GatewayDX80G9M6S-PB2 900 MHz ISM Band

Configuration Instructions

Mixing Performance and Non-Performance (150 mW) Radios in the Same Network
To comply with federal regulations, the 150 mW radios and 1 Watt radios communicate differently. All Performance models offer the
ability to select between 250 mW and 1 Watt operation using the DIP switches.
To mix Performance radios with non-Performance radios, refer to the product datasheet and:

• Operate Performance radios in 250 mW mode, not 1 Watt mode
• Set non-Performance (150 mW) radios to use Extended Address Mode

The 150 mW, 250 mW, and 1 Watt networks operate when collocated, but verify the antenna separation distance between a
Gateway and Node or between two Gateways is at least 10 feet apart. For more detailed instructions about setting up your wireless
network, refer to the following documents:

• DX80 Performance Quick Start Guide (p/n 128185)
• DX80 Performance Wireless I/O Network Instruction Manual (p/n 132607)

Setting Up Your Wireless Network
To set up and install your wireless network, follow these steps.
For complete instructions, including binding, configuration, installation, weatherproofing, device menu maps, troubleshooting, and a
list of accessories, refer to Sure Cross® Wireless I/O Network Instruction Manual (p/n 132607)

1. Disconnect the power from your Sure Cross devices.
2. Configure the DIP switches of all devices. DIP switch configurations are always listed in the product's datasheet.
3. If your device has I/O, connect the sensors to the Sure Cross devices. Available I/O is always listed in the product's

datasheet. If your device does not have I/O, skip this step.
4. Refer to the wiring diagrams to apply power to all devices.

• For housed models, the Gateway's LED 1 is solid green and the Node's LED 2 flashes red to indicate there is no radio
link to the Gateway.

• For board-level models, the Gateway's LED is solid green and the Node's LED flashes red to indicate there is no radio
link to the Gateway.
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5. Form the wireless network by binding the Nodes to the Gateway.
6. Observe the LED behavior to verify the devices are communicating with each other.

• For housed models, the Gateway's LED 1 is solid green and the Node's LED 1 flashes green to indicate it is
communicating with the Gateway.

• For board-level models, the Gateway's LED is solid green and the Node's LED flashes green to indicate it is
communicating with the Gateway.

7. Configure any I/O points to use the sensors connected to the Sure Cross devices.
8. Conduct a site survey between the Gateway and Nodes.
9. Install your wireless sensor network components.

Configure the DIP Switches
Before changing DIP switch positions, disconnect the power. Any changes made to the DIP switches are not recognized until after
power is cycled to the device.
For devices powered by batteries integrated into the housing, triple-click button 2, then double-click button 2 to reset the device
without removing the battery.
For parameters not set using the DIP switches, use the configuration software to make configuration changes. For parameters set
using the DIP switches, the DIP switch positions override any changes made using the configuration software.

DIP Switch Settings

Transmit Power
The 900 MHz radios transmit at 1 Watt (30 dBm) or 250 mW (24 dBm). The 250 mW mode reduces the radio's range but improves
the battery life in short range applications. For 2.4 GHz models, this DIP switch is disabled. The transmit power for 2.4 GHz is fixed
at about 65 mW EIRP (18 dBm).

DIP Switch 1

OFF * 1 Watt (30 dBm, 900 MHz models only)

ON 250 mW (24 dBm, 900 MHz models only), DX80 compatibility mode

Modbus/Software Configured or DIP Switch Configured
In Modbus/Software Configured mode, use the DX80 Performance Configuration Software or a Modbus command to change the
device parameters. DIP switch positions 3 through 8 are ignored. In DIP Switch Configured mode, use the DIP switches to configure
the parameters listed in the table. By default, this Gateway uses Modbus commands or the DX80 Performance Configuration
Software to configure the device.

DIP Switch 2

OFF * Modbus or software configured (DIP switches 3-8 are ignored)

ON DIP switch configured

DIP Switch 3
DIP switch 3 must remain in the OFF position.

Link Loss Output State
The Sure Cross® wireless devices use a deterministic radio link time-out method to address RF link interruption or failure. When a
radio link fails, all pertinent wired outputs are set to defined states until the link is recovered, ensuring that disruptions in the
communications link result in predictable system behavior. Select the state the outputs are changed to during a link loss.

DIP Switches

4 5

OFF * OFF * Off (discrete) or 0 mA (analog)

OFF ON On (discrete) or 20 mA (analog)

ON OFF Hold last stable state

ON ON Reserved

* Default configuration
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Analog Scale
Use the DIP switch to select which current scale to use for all the device's analog inputs and outputs: 0 to 20 mA or 4 to 20 mA.
When using a 4-20 mA sensor with a 0-20 mA input, the sensor uses the 4-20 mA section of the total range. Using a 4-20 mA with a
0-20 mA input allows you to determine when you have an error condition with the sensor. A normal input reading between 4 and 20
mA indicates a functioning sensor whereas a value below 4 mA indicates an error condition, such as a broken wire or loose
connection. This DIP switch is used only on the 0 to 20 mA models, not the 0 to 10V models.

DIP Switch 6

OFF * 0–20 mA scale

ON 4–20 mA scale

* Default configuration

I/O Mapping
When using these DIP switches to set the I/O mapping, you must change the Node's rotary dials to 01 or 02, depending on which
mapping sequence you are using. By default, the Nodes ship from the factory set to 11.

DIP Switches

7 = OFF 8 = OFF

No I/O mapping via the DIP switches. Use the DX80 Performance
Configuration Software to configure the I/O.

One PB2 Node to a PB2 Gateway
DIP Switches

7 = OFF 8 = ON

Gateway Node

Node 01 Discrete IN 1 → Gateway Discrete OUT 1
Node 01 Discrete IN 2 → Gateway Discrete OUT 2
Node 01 Analog IN 1 → Gateway Analog OUT 1
Node 01 Analog IN 2 → Gateway Analog OUT 2
Gateway Discrete IN 1 → Node 01 Discrete OUT 1
Gateway Discrete IN 2 → Node 01 Discrete OUT 2
Gateway Analog IN 1 → Node 01 Analog OUT 1
Gateway Analog IN 2 → Node 01 Analog OUT 2

Two PB2 Nodes to a PB2 Gateway DIP Switches

7 = ON 8 = OFF

GatewayNode 1 Node 2

Node 01 Discrete IN 1 → Gateway Discrete OUT 1
Node 02 Discrete IN 1 → Gateway Discrete OUT 2
Node 01 Analog IN 1 → Gateway Analog OUT 1
Node 02 Analog IN 1 → Gateway Analog OUT 2
Gateway Discrete IN 1 → Node 01 Discrete OUT 1
Gateway Discrete IN 2 → Node 02 Discrete OUT 1
Gateway Analog IN 1 → Node 01 Analog OUT 1
Gateway Analog IN 2 → Node 02 Analog OUT 1
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Wire the I/O and Apply Power

Figure 1. Wiring board

1

Tens unit Ones unit

1

8

30.48 mm
[1.2”]

45.72 mm
[1.8”]

60.96 mm
[2.4”]

Hole for 
#6 screw (3)

53.34 mm
[2.1”]

ON

7

14

Binding 
button

Antenna 
connection

DIP 
switches

Rotary dials

LED

2

3

4

5

6

8

9

10

11

12

13

Figure 2. Input and output wiring
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1
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Pin Description Label Pin Description Label

1 Analog IN 1 (0 to 20 mA) AI1 8 Analog OUT 1 (0 to 20 mA) AO1

2 Analog IN 2 (0 to 20 mA) AI2 9 Analog OUT 2 (0 to 20 mA) AO2

3 Discrete IN 1 (PNP) DI1 10 RS-485 + Host communication connection 485+

4 Discrete IN 2 (PNP) DI2 11 RS-485 – Host communication connection 485–

5 Ground 1 GND 12 Ground GND

6 Discrete OUT 1 (PNP) DO1 13 10 to 30 V DC PWR

7 Discrete OUT 2 (PNP) DO2 14 Not used -

Refer to the Class I Division 2/Zone 2 control drawings (p/n 143086) for wiring specifications and limitations.

Bind Radios to Form Networks
Binding Nodes to a Gateway ensures the Nodes only exchange data with the Gateway they are bound to. For a more detailed
definition of binding mode, refer to the Advanced Setup section of the SureCross Wireless I/O Networks instruction manual.
Apply power to the board module Gateway and all Nodes.

Note: If you are binding a Gateway board module to a Wireless Q45 Sensor, refer to the binding instructions in
the Wireless Q45 Sensor's datasheet.

1. Enter binding mode on the Gateway by triple-clicking the binding button.
The green and red LED flashes. Any Node entering binding mode will bind to this Gateway.

2. Enter binding mode on the Node.
• If you have a two-button Node, triple-click button 2.
• If you have a one-button (board module) Node, triple-click the binding button.

1 The three ground connections are tied together internally.
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Two-Button Node One-Button Board Node

The Node enters binding mode and locates the Gateway in binding mode.
• For two LED models, the red LEDs flash alternately. After binding is complete, both LEDs are both solid red for a

few seconds.
• For one-LED models, the red and green LED flashes alternately while the Node searches for the Gateway. After

binding is complete, the LED is red and green for four seconds (looks amber), then the red and green flash
simultaneously (looks amber) four times.

• The Node automatically exits binding mode, cycles its power, then enters RUN mode.
3. Use the Node's rotary dials to assign a valid decimal Node Address (between 01 and 47). The left rotary dial represents the

tens digit (0 through 4) and the right dial represents the ones digit (0 through 9) of the Node Address.
4. Repeat steps 2 and 3 for all Nodes that will communicate to this Gateway.
5. Exit binding mode on the Gateway by single-clicking the binding button.

LED Behavior for the Gateways
Verify all devices are communicating properly. The radios and antennas must be a minimum distance apart to function properly.
Recommended minimum distances are:

900 MHz 150 mW and 250 mW radios: 6 feet
900 MHz 1 Watt radios: 15 feet
2.4 GHz 65 mW radios: 1 foot

LED (Bi-color) Gateway Status

Solid green Power ON

Green and red flashing alternately Binding mode

Flashing red Device Error

Green and red flashing together, looks amber Modbus Communication Active

Flashing red Modbus Communication Error

Solid red Gateway is trying to conduct a Site Survey with a Node that doesn't exist

Green and red solid together, looks amber) No radio communication detected

For Gateway and Ethernet Bridge systems, active Modbus communication refers to the communication between the Gateway and
the Ethernet Bridge. For Gateway-only systems, the Modbus communication LEDs refer to the communication between the Gateway
and its host system (if applicable).

Conduct a Site Survey from a Gateway Board Model
Conducting a Site Survey, also known as an RSSI (Radio Signal Strength Indication), analyzes the radio communications link
between the Gateway and any Node within the network by analyzing the radio signal strength of received data packets and reporting
the number of missed packets that required a retry.
Perform a Site Survey before permanently installing the radio network to ensure reliable communication. Only the Gateway can
initiate a Site Survey, and the Site Survey analyzes the radio communications link with one Node at a time. Follow these steps to
conduct a Site Survey from the board module Gateway.

1. Set the Gateway's rotary dials to the Node address you'd like to conduct a Site Survey with.
For example, to analyze the signal strength between this Gateway and Node 02, rotate the left rotary dial to 0 and the right
rotary dial to 2.
The Site Survey automatically begins running. If there is no device at address 02, the LED is solid red. If there is a device at
address 02, the LED flashes amber.

2. Evaluate the signal strength. The amber LED flashes at specific rates to indicate the Site Survey results. Each signal
strength represents the majority of the data packets being received at that signal strength. For example, a strong signal
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strength indicates the majority of the data packets were received at a strong signal, but a few may have been received at a
good or weak signal strength.
• Eight flashes per second: Very strong signal strength
• Four flashes per second: Strong signal strength
• Two flashes per second: Good signal strength
• One flash per second: Weak signal strength
• Solid amber LED: No radio communication detected

3. To exit the Site Survey, set the Gateway's rotary dials to 00. Otherwise, after 15 minutes the Gateway automatically exits
Site Survey mode.
The LED flashes green to indicate the Gateway is in standard operating mode.

Sure Cross® DX80 Performance Configuration Software
The configuration software offers an easy way to link I/O points in your wireless network, view I/O register values, and set system
communication parameters when a host system is not part of the wireless network. The software runs on any computer with the
Windows Vista, Windows 7, Windows 8, or Windows 10 operating system.

Figure 3. Device Configuration screen

Use a USB to RS-485 adapter cable to connect a standalone DX80 Gateway to the computer. For DXM Controllers with an internal
DX80 radio, connect a computer to the DXM Controller using the supplied USB or Ethernet connection. Download the most recent
revisions of the configuration software from Banner Engineering's website: https://www.bannerengineering.com/us/en/products/
wireless-sensor-networks/reference-library/software.html.
The USB to RS-485 adapter cable is not required for the DXM Controller. For standalone DX80 Gateway devices use:

• USB to RS-485 adapter cable model BWA-UCT-900 for 1 Watt radios
• USB to RS-485 adapter cable model BWA-HW-006 for all other radios

Installing the Board Modules
Sure Cross® board modules must be mounted inside a panel or OEM enclosure.

Holding Registers

Modbus Registers EIP Registers
I/O Type

I/O Range Holding Register
Representation (Dec)

Gateway Node Node Min. Max. Min. Max.

1 1 + (Node# × 16) 0 + (Node# × 8)

Instance 100 / N7

Discrete IN 1 0 1 0 1

2 2 + (Node# × 16) 1 + (Node# × 8) Discrete IN 2 0 1 0 1

3 3 + (Node# × 16) 2 + (Node# × 8) Analog IN 1 (mA) 0.0 20.0 0 65535

4 4 + (Node# × 16) 3 + (Node# × 8) Analog IN 2 (mA) 0.0 20.0 0 65535

...

7 7 + (Node# × 16) 6 + (Node# × 8) Reserved

8 8 + (Node# × 16) 7 + (Node# × 8) Device Message

9 9 + (Node# × 16) 0 + (Node# × 8)
Instance 112 / N14

Discrete OUT 1 0 1 0 1

10 10 + (Node# × 16) 1 + (Node# × 8) Discrete OUT 2 0 1 0 1
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Modbus Registers EIP Registers
I/O Type

I/O Range Holding Register
Representation (Dec)

Gateway Node Node Min. Max. Min. Max.

11 11 + (Node# × 16) 2 + (Node# × 8) Analog OUT 1 (mA) 0.0 20.0 0 65535

12 12 + (Node# × 16) 3 + (Node# × 8) Analog OUT 2 (mA) 0.0 20.0 0 65535

...

15 15 + (Node# × 16) 6 + (Node# × 8) Control Message

16 16 + (Node# × 16) 7 + (Node# × 8) Reserved

Discrete Bit-Packed Registers
Discrete bit-packed registers include the discrete status registers, discrete inputs, and discrete outputs.
Bit packing involves using a single register, or range of contiguous registers, to represent I/O values.
When networks use similar Nodes to gather data using the same I/O registers for each Node, discrete data from multiple Nodes can
be bit packed into a single register on the Gateway. The bit-packed data is arranged by I/O point starting at Modbus register 6601.
For example, Discrete IN 1 for all the Nodes in the network is stored in three contiguous 16-bit registers.
The most efficient way to read (or write) discrete data from a Sure Cross® DX80 Gateway is by using these bit-packed registers
because users can read or write registers for all devices using one Modbus message. The following registers contain discrete bit-
packed I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for each Node in order of Node
address.

Figure 4. Discrete bit-packed register addresses and bit positions

Bit-Packed Device Status Registers
Bit Position

Register Address 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
6601 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6602 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6603 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Input 1
Bit Position

Register Address 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
6611 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6612 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6613 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Bit-Packed Discrete Output 1
Bit Position

Register Address 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
6691 Node 15 Node 14 Node 13 Node 12 Node 11 Node 10 Node 9 Node 8 Node 7 Node 6 Node 5 Node 4 Node 3 Node 2 Node 1 Gateway
6692 Node 31 Node 30 Node 29 Node 28 Node 27 Node 26 Node 25 Node 24 Node 23 Node 22 Node 21 Node 20 Node 19 Node 18 Node 17 Node 16
6693 Node 47 Node 46 Node 45 Node 44 Node 43 Node 42 Node 41 Node 40 Node 39 Node 38 Node 37 Node 36 Node 35 Node 34 Node 33 Node 32

Table 1: Discrete bit-packed registers for inputs and outputs

Inputs Outputs

Modbus Register Address
(Decimal)

Description (Inputs) Modbus Register Address
(Decimal)

Description (Outputs)

6601–6603 Status for all devices

6611–6613 Input 1 from all devices 6691–6693 Output 1 from all devices

6621–6623 Input 2 from all devices 6701–6703 Output 2 from all devices

6631–6633 Input 3 from all devices 6711–6713 Output 3 from all devices

6641–6643 Input 4 from all devices 6721–6723 Output 4 from all devices

6651–6653 Input 5 from all devices 6731–6733 Output 5 from all devices

6661–6663 Input 6 from all devices 6741–6743 Output 6 from all devices

6671–6673 Input 7 from all devices 6751–6753 Output 7 from all devices

6681–6683 Input 8 from all devices

Status registers (6601–6603) contain a bit-packed representation defining the devices that are operational in the wireless system.
Each bit indicates Node in Sync (1) or Node Not in Sync (0).
Input registers from all devices use Modbus registers 6611 through 6683 to organize the least significant bit into a sequential array
of registers. The first register contains the least significant bit from the input values for the Gateway through Node 15. The second
register contains the input values for Node 16 through Node 31, and the third register contains the input values for Nodes 32 through
47.
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For discrete inputs, only the least significant bit is used. For analog inputs, the least significant bit indicates if the analog value is
above or below the selected threshold value (when using the threshold parameter configured in the User Configuration Software).
For example, a least significant bit of one (1) indicates the analog value is above the selected threshold value. A least significant bit
of zero (0) indicates the analog value is below the threshold value.
Output registers from all devices use Modbus registers 6691 through 6753 to organize the least significant bit into a sequential
array of registers. Output 8 (I/O point 16) cannot be written using the discrete format.

Analog 16-Bit Registers (Registers 6801 through 9098)
The most efficient way to read (or write) analog data from a Gateway is by using these 16-bit analog registers. Most networks
consist of similar Nodes reporting data using the same I/O registers for each Node. For this reason, the analog data is arranged by
I/O point using Modbus registers 6801 through 9098.
For example, Input 1 for Gateway and all Nodes is stored in the first 48 contiguous blocks of 16-bit analog registers, beginning with
register 6801.
In this format, users can read a 16-bit holding register for all devices or write to a register for all devices using one Modbus message.
Using these registers is the most efficient way to read all status registers, read all analog inputs, or write all analog outputs.
The following registers contain analog I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for
each Node in order of Node address.
Table 2: Analog input and output registers

Inputs Outputs

Modbus Register Address
(Decimal)

Description (Inputs) Modbus Register Address
(Decimal)

Description (Outputs)

6801 Input 1 for Gateway 8001 Output 1 for Gateway

6802 Input 1 for Node 1 8002 Output 1 for Node 1

6803 Input 1 for Node 2 8003 Output 1 for Node 2

... ... ... ...

6951 Input 2 for Gateway 8151 Output 2 for Gateway

6952 Input 2 for Node 1 8152 Output 2 for Node 1

6953 Input 2 for Node 2 8153 Output 2 for Node 2

... ... ... ...

7101 Input 3 for Gateway 8301 Output 3 for Gateway

7102 Input 3 for Node 1 8302 Output 3 for Node 1

7103 Input 3 for Node 2 8303 Output 3 for Node 2

... ... ... ...

7851 Input 8 (Status Register) for Gateway 9051 Output 8 for Gateway

7852 Input 8 (Status Register) for Node 1 9052 Output 8 for Node 1

7853 Input 8 (Status Register) for Node 2 9053 Output 8 for Node 2

... ... ... ...

For example, 6801 contains the input 1 value for the Gateway, 6802 contains the input 1 value for Node 1, and 6848 contains the
input 1 value for Node 47.

  Sure Cross® Performance PB2 Gateway Board Module

8 www.bannerengineering.com - Tel: + 1 888 373 6767 P/N 163211 Rev. K

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2C



Specifications

Performance Radio Specifications
Radio Range 2

900 MHz, 1 Watt: Up to 9.6 km (6 miles)
2.4 GHz, 65 mW: Up to 3.2 km (2 miles)

Antenna Minimum Separation Distance
900 MHz, 1 Watt: 4.57 m (15 ft)
2.4 GHz, 65 mW: 0.3 m (1 ft)

Radio Transmit Power
900 MHz, 1 Watt: 30 dBm (1 W) conducted (up to 36 dBm EIRP)
2.4 GHz, 65 mW: 18 dBm (65 mW) conducted, less than or equal to 20 dBm
(100 mW) EIRP

Spread Spectrum Technology
FHSS (Frequency Hopping Spread Spectrum)

Link Timeout (Performance)
Gateway: Configurable via User Configuration Software
Node: Defined by Gateway

Antenna Connection
Ext. Reverse Polarity SMA, 50 Ohms
Max Tightening Torque: 0.45 N·m (4 lbf·in)

900 MHz Compliance (1 Watt)
FCC ID UE3RM1809: FCC Part 15, Subpart C, 15.247
IC: 7044A-RM1809
IFT: RCPBARM13-2283

(NOM approval only applies to 900 MHz models)
2.4 GHz Compliance

FCC ID UE300DX80-2400: FCC Part 15, Subpart C, 15.247
Radio Equipment Directive (RED) 2014/53/EU
IC: 7044A-DX8024
ANATEL: 15966-21-04042 Este equipamento não tem direito à proteção
contra interferência prejudicial e não pode causar interferência em sistemas
devidamente autorizados. Para maiores informações, consulte o site da
ANATEL www.gov.br/anatel/pt-br/

Specifications for the PB2 Gateway

Supply Voltage
10 V DC to 30 V DC; Outside the USA: 12 V DC to 24 V DC, ± 10% (For
European applications, power this device from a Limited Power Source as
defined in EN 60950-1. )

Wiring Access
Terminal block

Current Draw (at 24 V DC)
900 MHz, 1 Watt: Approx. 30 mA
900 MHz, 250 mW: Approx. 25 mA
2.4 GHz, 65 mW: Approx. 20 mA

Interface
One bi-color LED indicator; One button

Discrete Inputs
Two, PNP
Rating: 3 mA max current at 30 V DC
Sample Rate: 62.5 milliseconds
Report Rate: On change of state
ON Condition: Greater than 8 V
OFF Condition: Less than 5 V

Analog Inputs
Two, 0–20 mA
Rating: 24 mA
Impedance: Approximately 100 Ohms; To verify the analog input's
impedance, use an Ohm meter to measure the resistance between the
analog input terminal (AIx) and the ground (GND) terminal.
Sample Rate: 62.5 milliseconds
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

Discrete Output
Two, PNP
Update Rate: 1 second
ON Condition (PNP): Supply minus 2 V
OFF Condition (PNP): Less than 2 V
Output State Following Timeout: De-energized (OFF)

Discrete Output Rating (PNP)
100 mA max current at 30 V DC
ON-State Saturation: Less than 3 V at 100 mA
OFF-state Leakage: Less than 10 μA

Analog Outputs
Two, 0–20 mA
Rating: 24 mA
Update Rate: 125 milliseconds
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

Operating Conditions
–40 °C to +85 °C (–40 °F to +185 °F) 3

95% maximum relative humidity (non-condensing)
Certifications

Banner Engineering
Europe Park Lane,
Culliganlaan 2F bus 3, 1831
Diegem, BELGIUM

(CE approval only
applies to 2.4 GHz
models)

CSA: Class I Division 2 Groups ABCD, Class I Zone 2 AEx/Ex nA II T4 —
Certificate: 1921239

ATEX: II 3 G Ex nA IIC T4 Gc (Group IIC Zone 2) — Certificate LCIE 10
ATEX 1012 X

Refer to the Class I Division 2/Zone 2 control drawings (p/n 143086) for
wiring specifications and limitations. Install the device in a suitable enclosure
with provision for connection of Division 2 / Zone 2 wiring methods in
accordance with local codes, as acceptable to the local inspection authority
having jurisdiction. All battery-powered devices must only use the lithium
battery manufactured by Xeno, model XL-205F (Banner model number
BWA-BATT-001).

RS-485 Communication Specifications
Communication Hardware (RS-485)

Interface: 2-wire half-duplex RS-485
Baud rates: 9.6k, 19.2k (default), or 38.4k
Data format: 8 data bits, no parity, 1 stop bit

2 Radio range is with the 2 dB antenna that ships with the product. High-gain antennas are available, but the range depends on the environment and line of sight. Always verify your wireless
network's range by performing a Site Survey.

3 Operating the devices at the maximum operating conditions for extended periods can shorten the life of the device.
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MultiHop M-HBx and Performance PBx Models Mounted on the Base
Figure 5. Most MultiHop M-HBx and Performance PBx models ship from the factory mounted on a plastic base.

94 mm
[3.70”]

84 mm
[3.31”]

26.8 mm
[1.06”]

53 mm
[2.09”]

26.5 mm
[1.04”]

4.5mm dia
[0.18”]

Accessories for the Board Models

BWA-HW-034
• DIN rail clip, black plastic

Warnings
Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna
configurations installed without surge suppressors invalidate the manufacturer's warranty. Keep the ground wire as short as possible
and make all ground connections to a single-point ground system to ensure no ground loops are created. No surge suppressor can
absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected to the Sure Cross device during a
thunderstorm.
Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio frequency
emissions. Customers who want to re-export this product to a country other than that to which it was sold must ensure the
device is approved in the destination country. The Sure Cross wireless products were certified for use in these countries using
the antenna that ships with the product. When using other antennas, verify you are not exceeding the transmit power levels allowed
by local governing agencies. This device has been designed to operate with the antennas listed on Banner Engineering’s website
and having a maximum gain of 9 dBm. Antennas not included in this list or having a gain greater that 9 dBm are strictly prohibited for
use with this device. The required antenna impedance is 50 ohms. To reduce potential radio interference to other users, the antenna
type and its gain should be so chosen such that the equivalent isotropically radiated power (EIRP) is not more than that permitted for
successful communication. Consult with Banner Engineering Corp. if the destination country is not on this list.

Important: Please download the complete Performance Gateway or Node technical documentation, available in
multiple languages, from www.bannerengineering.com for details on the proper use, applications, Warnings, and
installation instructions of this device.

Important: Por favor descargue desde www.bannerengineering.com toda la documentación técnica de los
Performance Gateway or Node, disponibles en múltiples idiomas, para detalles del uso adecuado, aplicaciones,
advertencias, y las instrucciones de instalación de estos dispositivos.

Important: Veuillez télécharger la documentation technique complète des Performance Gateway or Node sur
notre site www.bannerengineering.com pour les détails sur leur utilisation correcte, les applications, les notes de
sécurité et les instructions de montage.
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WARNING:
• Do not use this device for personnel protection
• Using this device for personnel protection could result in serious injury or death.
• This device does not include the self-checking redundant circuitry necessary to allow its use in

personnel safety applications. A device failure or malfunction can cause either an energized (on) or de-
energized (off) output condition.

Important:
• Never operate a 1 Watt radio without connecting an antenna
• Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
• To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure Cross

MultiHop (1 Watt) radio without an antenna connected.

Important:
• Electrostatic discharge (ESD) sensitive device
• ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
• Use proper handling procedures to prevent ESD damage. Proper handling procedures include leaving

devices in their anti-static packaging until ready for use; wearing anti-static wrist straps; and assembling
units on a grounded, static-dissipative surface.

Banner Engineering Corp. Limited Warranty
Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following the date of shipment. Banner Engineering Corp. will repair or
replace, free of charge, any product of its manufacture which, at the time it is returned to the factory, is found to have been defective during the warranty period. This warranty does not
cover damage or liability for misuse, abuse, or the improper application or installation of the Banner product.
THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED (INCLUDING, WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF DEALING OR
TRADE USAGE.
This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO EVENT SHALL BANNER ENGINEERING CORP. BE LIABLE TO
BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL
DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT, WHETHER ARISING IN CONTRACT OR WARRANTY,
STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHERWISE.
Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any obligations or liabilities relating to any product previously
manufactured by Banner Engineering Corp. Any misuse, abuse, or improper application or installation of this product or use of the product for personal protection applications when the
product is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior express approval by Banner Engineering Corp will void
the product warranties. All specifications published in this document are subject to change; Banner reserves the right to modify product specifications or update documentation at any time.
Specifications and product information in English supersede that which is provided in any other language. For the most recent version of any documentation, refer to: 
www.bannerengineering.com.
For patent information, see www.bannerengineering.com/patents.

Notas Adicionales
Información México: La operación de este equipo está sujeta a las siguientes dos condiciones: 1) es posible que este equipo o dispositivo no cause interferencia perjudicial y 2) este equipo
debe aceptar cualquier interferencia, incluyendo la que pueda causar su operación no deseada.
Banner es una marca registrada de Banner Engineering Corp. y podrán ser utilizadas de manera indistinta para referirse al fabricante. "Este equipo ha sido diseñado para operar con las
antenas tipo Omnidireccional para una ganancia máxima de antena de 6 dBd y Yagi para una ganancia máxima de antena 10 dBd que en seguida se enlistan. También se incluyen
aquellas con aprobación ATEX tipo Omnidireccional siempre que no excedan una ganancia máxima de antena de 6dBd. El uso con este equipo de antenas no incluidas en esta lista o que
tengan una ganancia mayor que 6 dBd en tipo omnidireccional y 10 dBd en tipo Yagi, quedan prohibidas. La impedancia requerida de la antena es de 50 ohms."

Antenas SMA Modelo

Antena, Omni 902-928 MHz, 2 dBd, junta de caucho, RP-SMA
Macho

BWA-9O2-C

Antena, Omni 902-928 MHz, 5 dBd, junta de caucho, RP-SMA
Macho

BWA-9O5-C

Antenas Tipo-N Modelo

Antena, Omni 902-928 MHz, 6 dBd, fibra de vidrio, 1800mm, N
Hembra

BWA-9O6-A

Antena, Yagi, 900 MHz, 10 dBd, N Hembra BWA-9Y10-A

Mexican Importer
Banner Engineering de Mèxico, S. de R.L. de C.V.
David Alfaro Siqueiros 103 Piso 2 Valle oriente
San Pedro Garza Garcia Nuevo Leòn, C. P. 66269
81 8363.2714

ANATEL
Modelo (Model): DX80-2400—Este equipamento não tem direito à proteção contra interferência prejudicial e não pode causar interferência
em sistemas devidamente autorizados. Para maiores informações, consulte o site da ANATEL www.gov.br/anatel/pt-br/
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Level Measurement
Continuous level measurement - Ultrasonic transducers

EchoMax XRS-5

4

■ Overview

EchoMax XRS-5 ultrasonic transducer provides reliable, contin-
uous level monitoring of liquids and slurries in narrow lift sta-
tions/wet wells, flumes, weirs and filter beds using a beam angle 
of just 10° and a CSM rubber face.

■ Benefits

• Narrow beam angle of only 10° 
• Chemically resistant PVDF copolymer enclosure and CSM 

rubber face 
• Measuring range: 8 m (26 ft) for measurement of liquids and 

slurries 
• Fully submersible: IP68 degree of protection 
• Easy installation with 1" NPT or R 1" BSPT connection 

■ Application

The XRS-5 is non-contacting with a measuring range from 0.3 to 
8 m (1 to 26 ft). Advanced echo processing ensures reliable 
data even in conditions with obstructions, turbulence, and foam.

The hermetically sealed CSM rubber face and the PVDF copoly-
mer enclosure are designed for maximum resistance to meth-
ane, salt water, caustics, and harsh chemicals common to 
wastewater installations. With an IP68 degree of protection, this 
rugged sensor is fully submersible in the event of flood condi-
tions. Use a submergence shield if full submergence is possible 
in the application. A submergence shield will maintain a high 
level reading output during submerged conditions.

The low-cost XRS-5 transducer is compatible with a full range of 
Siemens controllers, from a basic system for high/low alarm or 
simple pump control, up to advanced control systems with com-
munications, telemetry and SCADA integration capabilities.
• Key Applications: wet wells, flumes, weirs, filter beds 

■ Technical specifications

Mode of operation

Measuring principle Ultrasonic transducer

Input

Measuring range 0.3 ... 8 m (1 ... 26 ft), dependent on 
application

Output

Frequency 44 kHz

Beam angle 10°

Accuracy

Temperature error Compensated by integral tempera-
ture sensor

Rated operating conditions

Vessel pressure Normal atmospheric pressure

Ambient Conditions
• Ambient temperature -20 ... +65 °C (-4 ... +149 ° F)

Design

Weight (approximate shipping weight 
of sensor with standard cable length)

1.2 kg (2.6 lb)

Material (enclosure) PVDF copolymer enclosure and 
CSM face

Process connection 1" NPT [(Taper), ANSI/ASME 
B1.20.1] or R 1" [(BSPT), EN 10226]

Degree of protection IP65/IP68

Cable connection 2-core shielded/twisted, 0.5 mm2 
(20 AWG), PVC sheath

Cable (max. length) • 365 m (1 200 ft) with RG 62 A/U 
coaxial cable 

• 365 m (1 200 ft) with 2-core twisted 
pair, foil shield, 0.5 mm2

(20 AWG), PVC sheath, only for 
MultiRanger 100/200 

Options

Flange version Factory flange with PTFE face for 
ASME, EN or JIS configuration

Submergence shield For applications with flooding 
possible

Certificates and approvals CE, RCM, KCC

CSA Class I, Div. 2, Groups A, B, C, 
D, Class II, Div. 1 Groups E, F, G

FM Class I, Zone 1, AEx m IIC, T6 
Class II, III, Div. 1, Groups E, F, G T6

ATEX II 2GD / IECEx / INMETRO Ex 
mb IIC T6 Gb, Ex tb IIIC T85 °C Db
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Level Measurement
Continuous level measurement - Ultrasonic transducers

EchoMax XRS-5

4

 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix.

 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix.

Selection and Ordering data Article No.

EchoMax XRS-5 transducer
With a beam angle of 10°, the XRS-5 provides 
reliable, continuous level monitoring of liquids and 
slurries in narrow lift stations/wet wells, flumes, 
weirs and filter beds.
Measuring range: min. 0.3 m (1 ft), max. 8 m (26 ft)

7ML1106-

7777 0 - 07

Click on the Article No. for the online configura-
tion in the PIA Life Cycle Portal.

Process connection
1" NPT [(Taper), ANSI/ASME B1.20.1]  1
R 1" [(BSPT), EN 10226]  2

Cable length
5 m (16.40 ft)  A
10 m (32.81 ft)  B
30 m (98.43 ft) C

Facing
Standard (CSM rubber)  A
PTFE (flange versions) B

Approvals
CE, RCM, KCC, CSA Class I, Div. 2, 
Groups A, B, C, D, Class II, Div. 1, Groups E, F, G
FM Class I, Zone 1, AEx m IIC, T6 Class II, III, 
Div. 1, Groups E, F, G T6 ATEX II 2GD / IECEx / 
INMETRO Ex mb IIC T6 Gb, Ex tb IIIC T85 °C Db

 2

Mounting flange (flush mount)
None  A

3" ASME, 150 lb, flat faced B
4" ASME, 150 lb, flat faced C
6" ASME, 150 lb, flat faced D

DN 80, PN 10/16, Type A, flat faced J
DN 100, PN 10/16, Type A, flat faced K
DN 150, PN 10/16, Type A, flat faced L

JIS10K 3B style Q
JIS10K 4B style R
JIS10K 6B style S
Note: flange bolting patterns and facings 
dimensionally correspond to the applicable 
ASME B16.5 or EN 1092-1, or JIS B 2220 standard.

Operating Instructions

All literature is available to download for free, in a 
range of languages, at http://www.siemens.com/
processinstrumentation/documentation

Selection and Ordering data Order code

Further designs
Please add "-Z" to Article No. and specify Order 
code(s).

Acrylic coated, stainless steel tag
[13 x 45 mm (0.5 x 1.75 inch)]: Measuring-point 
number/identification (max. 16 characters) specify 
in plain text

 Y17

Accessories Article No.

Tag, stainless steel with hole,
12 x 45 mm (0.47 x 1.77 inch),
one text line for fastening on sensors

7ML1930-1BJ

Submergence shield kit 7ML1830-1BH

Easy Aimer 2, aluminum, NPT with ¾" x 1" PVC 
coupling

7ML1830-1AQ

Easy Aimer 2, aluminum with M20 adapter and
1" and 1½" BSPT aluminum couplings

7ML1830-1AX

Easy Aimer 304, NPT with 1" stainless steel 
coupling

7ML1830-1AU

Easy Aimer 304, with M20 adapter and 1" and 
1½" BSPT 304 stainless steel couplings

7ML1830-1GN

FMS-200 universal box bracket, mounting kit 7ML1830-1BK

FMS-210 channel bracket, wall mount 7ML1830-1BL

FMS-220 extended channel bracket, wall mount 7ML1830-1BM

FMS-310 channel bracket, floor mount 7ML1830-1BN

FMS-320 extended channel bracket, floor mount 7ML1830-1BP

FMS-350 bridge channel bracket, floor mount
(see Mounting Brackets on page 4/179 for 
more information)

7ML1830-1BQ

1" NPT locknut, plastic 7ML1830-1DS

1" BSPT locknut, plastic 7ML1830-1DR

Plastic adapter 1" BSP - 20 mm 7ML1830-1EA

Plastic adapter 1" NPT 7ML1930-1FX

Plastic adapter 1" NPT/M20 7ML1830-1EF
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Level Measurement
Continuous level measurement - Ultrasonic transducers

EchoMax XRS-5

4

 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix.

 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix.

Selection and Ordering data Article No.

EchoMax XRS-5C transducer
With a beam angle of 10°, the XRS-5 provides 
reliable, continuous level monitoring of liquids and 
slurries in narrow lift stations/wet wells, flumes, 
weirs and filter beds.
Measuring range: min. 0.3 m (1 ft), max. 8 m (26 ft)

7ML1105-

7777 1 - 07

Click on the Article No. for the online configura-
tion in the PIA Life Cycle Portal.

Process connection
1" NPT [(Taper), ANSI/ASME B1.20.1]  1

Cable length
5 m (16.40 ft)  A
10 m (32.81 ft)  B
30 m (98.43 ft) C

Facing
Standard (CSM rubber)  A
PTFE (flange versions) B

Approvals
CSA Class I Div. 1, Groups A, B, C, D; Class II 
Div. 1, Groups E, F, G; Class III

 1

Mounting flange (flush mount)
None  A

3" ASME, 150 lb, flat faced B
4" ASME, 150 lb, flat faced C
6" ASME, 150 lb, flat faced D
Note: flange bolting patterns and facings 
dimensionally correspond to the applicable 
ASME B16.5 or EN 1092-1, or JIS B 2220 standard.

Operating Instructions

All literature is available to download for free, in a 
range of languages, at http://www.siemens.com/
processinstrumentation/documentation

Selection and Ordering data Order code

Further designs
Please add "-Z" to Article No. and specify Order 
code(s).

Acrylic coated, stainless steel tag
[13 x 45 mm (0.5 x 1.75 inch)]: Measuring-point 
number/identification (max. 16 characters) specify 
in plain text

 Y17

Accessories Article No.

Submergence shield kit 7ML1830-1BH

Easy Aimer 2, aluminum, NPT with ¾" x 1" PVC 
coupling

7ML1830-1AQ

Easy Aimer 304, NPT with 1" stainless steel 
coupling

7ML1830-1AU

FMS-200 universal box bracket, mounting kit 7ML1830-1BK

FMS-210 channel bracket, wall mount 7ML1830-1BL

FMS-220 extended channel bracket, wall mount 7ML1830-1BM

FMS-310 channel bracket, floor mount 7ML1830-1BN

FMS-320 extended channel bracket, floor mount 7ML1830-1BP

FMS-350 bridge channel bracket, floor mount
(see Mounting Brackets on page 4/179 for 
more information)

7ML1830-1BQ

© Siemens AG 2017
Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2D

https://www.pia-portal.automation.siemens.com/SIE/Z3_PIA_PORTAL/?sap-language=EN&P_MATNR=7ML1105
http://www.siemens.com/processinstrumentation/documentation


4/169Siemens FI 01 · 2017

Level Measurement
Continuous level measurement - Ultrasonic transducers

EchoMax XRS-5

4

■ Dimensional drawings

XRS-5 ultrasonic transducer, dimensions in mm (inch)

■ Schematics

XRS-5 ultrasonic transducer connections

Non-metallic
coupling

Non-metallic
coupling

Non-metallic
coupling

Flexible
conduit

Steel 
channel

Rigid metal
conduit

Flexible conduit transducer should not be
subjected to wind, vibration or jarring.

Transducer with submergence shield, used in
applications where flooding is possible.

Plywood

Plywood mounting provides 
excellent isolation 
(must be rigid).

Submergence
shield

Submergence Shield
(optional)

Standard

Mounting:
Suspended Conduit

Bracket

Submersible

Transducer

Non-metallic
coupling

Rigid metal
conduit

Flange (optional)

ANSI, DIN, or JIS

25
(0

.9
8)

12
7 

(5
.0

)

124 (4.9)
15

5 
(6

.1
)

89 (3.5)

12
7 

(5
.0

)

*  For SITRANS LUT400, MultiRanger 100/200, HydroRanger 200

Direct connection

Coaxial extension

3 terminal direct*

Junction box

Extend cable using RG-62 A/U coax.

3 terminal extension*

Shield

Black
White

Shield

Black
White

Black/hot
White/shield

Shield

Black
White
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Level Measurement
Continuous level measurement - Ultrasonic controllers

SITRANS LUT400 series

4

■ Overview

The SITRANS LUT400 series controllers are compact, single 
point, long-range ultrasonic controllers for continuous level or 
volume measurement of liquids, slurries, solids, and high accu-
racy monitoring of open channel flow.

■ Benefits

• Small 1/2 DIN enclosure [144 h x 144 d x 146 w mm 
(5.7 x 5.7 x 5.75 inch)] with standard universal mounting 
bracket for wall, pipe, and DIN rail, plus an optional panel 
mount 

• Easy to use HMI display with local four-button programming, 
menu-driven parameters, and Wizard support for key applica-
tions 

• English, German, French, Spanish, Chinese, Italian, Portu-
guese, and Russian texts on the HMI.

• Level, Volume, OCM Flow monitoring 
• Three relays combined with a suite of pump, alarm, and relay 

control features 
• HART Communications 
• EDDs for SIMATIC PDM, AMS Device Manager, and Field 

Communicator 375/475, plus DTMs for FDTs (Field Device 
Tools) 

• Web browser for local programming from an intuitive web-
based interface 

• Two discrete inputs for backup level override and pump 
interlock functions 

• Echo profile and trend views from the local display 
• Patented digital receiver for improved performance in electri-

cally noisy applications (close proximity to VSDs) 
• Real time clock with daylight savings time, supporting an 

integrated datalogger and energy saving algorithms for 
minimizing pump operation during high cost energy periods 

• Removable terminal blocks for ease of wiring
• MCERTS Certified for Open Channel Flow

■ Application

The SITRANS LUT400 comes in three different models, depend-
ing on the application, level of performance and functionality re-
quired:
• SITRANS LUT420 Level Controller: Level or volume 

measurement of liquids, slurries, and solids, as well as basic 
pump control functions, and basic data logging capability 

• SITRANS LUT430 Level, Pump and Flow Controller: Includes 
all features of the LUT420 plus a full suite of advanced pump 
control and alarm functionality, open channel flow monitoring, 
and basic flow data logging capability 

• SITRANS LUT440 High Accuracy OCM: Our most featured, 
highest accuracy model. Includes all features of the LUT430, 
plus the industry’s best accuracy (± 1 mm within 3 m), full suite 
of advanced control functionality, and enhanced flow logging 
capability 

• Key Applications: wet wells, reservoirs, flumes/weirs, 
chemical storage, liquid storage, hoppers, crusher bins, dry 
solids storage 
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■ Technical specifications

Mode of Operation Ultrasonic level, volume, pump, and 
open channel flow

Measuring range 0.3 … 60 m (1 … 196 ft), 
transducer dependent

Input

Discrete 0 ... 50 V DC switching level
Logical 0  10 V DC
Logical 1 = 10 ... 50 V DC
Max. 3 mA 

Output

Transducer frequency 10 ... 52 kHz

Ultrasonic transducer Compatible transducers: All Echo-
Max and ST-H series transducers

Relays • 1 SPDT Form C, NO or NC relay, 
rated 1A at 250 V AC, non-inductive 
and 3A at 30 V DC 

• 2 SPST Form A, NO relays, rated 5A 
at 250 V AC, non-inductive and 3 A 
at 30 V DC 

mA output 4 … 20 mA, isolated

Max. load 600  max. in ACTIVE mode, 
750  max. in PASSIVE mode

Resolution 0.1 % of range

Accuracy

Error in measurement • Standard operation: ± 1 mm 
(0.04 inch) plus 0.17 % of measured 
distance 

• High accuracy OCM: ± 1 mm 
(0.04 inch), within 3 m (9.84 ft) range 

Resolution • Standard operation: 0.1 % of range 
or 2 mm (0.08 inch), whichever is 
greater 

• High accuracy OCM: 0.6 mm 
(0.02 inch), within 3 m (9.84 ft) range 

Temperature compensation • -40 ... +150 °C (-40 ... +300 °F) 
• Integral temperature sensor in 

transducer 
• External TS-3 temperature sensor 

(optional) 
• Programmable fixed temperature 

values 

Rated operating conditions

Installation conditions 
• Location Indoor/outdoor
• Installation category II
• Pollution degree 4

Ambient conditions
• Ambient temperature (enclosure) -20 … +50 °C (-4 … +122 °F)

Design

Weight
• Enclosure with display lid 1.3 kg (2.87 lb)
• Enclosure with blank lid 1.2 kg (2.65 lb)

Material (enclosure) Polycarbonate

Degree of protection
• Enclosure with display or blank lid IP65/Type 4X/NEMA 4X
• Enclosure with blank lid and knock-

out removed
IP20

Remote display lid IP65/Type 3/NEMA 3

Cable

Transducer and mA output signal • Transducer, mA output:
2 copper conductors, twisted,
with foil shield/drain wire, 300 V
0.5 … 0.75 mm² (22 … 18 AWG) 

• Relay/power to be copper
conductors per local
requirements to meet 250 V
5 A contact rating 

Max. separation between
transducer and transceiver

365 m (1 200 ft)

Displays and controls 60 x 40 mm (2.36 x 1.57 inch) remov-
able
LCD, 240 x 160 pixels resolution,
operational up to 5 m from
enclosure base

Programming
• Primary 4 Local push buttons
• Secondary • PC running SIMATIC PDM 

• PC running Emerson AMS Device
Manager 

• PC running a web browser 
• PC running a Field Device Tool

(FDT) 
• Field Communicator 375/475

(FC375/FC475) 

Memory • 512 kB flash EPROM 
• 1.5 MB flash for data logging 

Power supply

AC version 100 ... 230 V AC ± 15 %,
50/60 Hz, 36 VA
Fuse: 5 x 20 mm, Slow Blow,
0.25 A, 250 V

DC version 10 … 32 V DC, 10 W
Fuse: 5 x 20 mm, Slow Blow,
1.6 A, 125 V

Certificates and approvals

General CSAUS/C, CE, FM, UL listed, RCM, 
MCERTS certified for Open Channel 
Flow

Hazardous
• Non-incendive

(Canada) 
CSA Class I, Div. 2, Groups A, B,
C, D; Class II, Div. 2, Groups F, G;
Class III

• Shipping Lloyd's Register, ABS

Communication HART 7.0, USB
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SITRANS LUT420 SITRANS LUT430 SITRANS LUT440

Category Feature Level Controller Level, pump and flow 
controller

High accuracy OCM 
controller

Operations Level, space, and distance 
measurement

  

Open channel flow measure-
ment

 

Volume conversion   

Specifications Compatible with EchoMax and 
ST-H transducers

  

Standard accuracy: 
± 1 mm + 0.17 % of measured 
distance

  

High accuracy: 
± 1 mm within 3 meters



Mounting options: wall or 
panel, pipe, DIN-rail

  

Data logging and
communications

HART communications   

4 ... 20 mA output (active and 
passive)

  

Integrated datalogger for mea-
surement value and alarms

  

Integrated datalogger for fixed 
rate flow logging

 

Integrated datalogger for vari-
able rate flow logging trig-
gered by changes in flow 
condition



Daily data logging for maxi-
mum, minimum and average 
flow, daily totalized volume, 
and minimum and maximum 
temperature

 

Flow monitoring High accuracy open channel 
flow measurement



9 digit daily and running flow 
totalizers

 

High and low flowrate alarms  

External totalizer and sampler 
control

 

MCERTS Class 1 Certification 

MCERTS Class 2 Certification 

Pump control Energy saving algorithms for 
pump control

 

Wall cling reduction   

Pump run-on functionality  

Pump start and power 
resumption delays

 

Alternate duty pump routines   

Fixed duty and service ratio 
pump routines

 

Pumped volume totalizer  

Submergence detection   

Discrete input pump interlocks  

Time to spill calculation  
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 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix.

 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix.

Selection and Ordering data Article No.

SITRANS LUT420 and LUT430
Compact ultrasonic level controllers for continuous 
short to long-range level or volume measurement of 
liquids, slurries, and solids. Both units include 
basic relay functions for pumps, alarms, and other 
controls, plus onboard data logging. LUT430 offers 
additional advanced pump control and alarm 
functionality, open channel flow monitoring, 
and basic flow data logging capability. 
Functionality varies by model.

7ML5050-

00000 7777 0000- 777 00000

Click on the Article No. for the online configura-
tion in the PIA Life Cycle Portal.

Model 
SITRANS LUT420 - Level controller  A
SITRANS LUT430 - Level, Pump & Flow controller  B

Enclosure display options
With display  A
With remote panel mount display 
[Includes panel mount cable extension, 
2.5 m (8.2 ft)]

 B

No display (blank lid provided)  C
Note: Enclosure includes back-plate for wall 
and pipe mounting, and an integrated clip for 
DIN-rail mounting. DIN-rail mounting for standard 
TS35 x 7.5 and TS35 x 15 mm DIN-rail to 
IEC 60715, EN 60715

Input voltage
100 ... 230 V AC ± 15 %  1
10 ... 32 V DC  2

Cable inlet
3 cable inlets, cable glands not supplied  1
3 cable inlets, 3 M20 plastic cable glands supplied 2

Number of measurement points 
Single point system (includes one transducer input, 
one mA output, and one external temperature 
sensor input)

 1

Communications and I/O
HART, 2 discrete inputs, 3 relays  D

Approvals
General purpose CE, FM, CSAUS/C, UL, RCM  A
Hazardous locations CSA Class I, II, III, Div. 2, 
Groups A, B, C, D, F, G

C

Selection and Ordering data Order code

Further designs

Please add "-Z" to Article No. and specify Order 
code(s).

Manufacturer's test certificate M to DIN 55350, 
Part 18 and to ISO 9000

 C11

Stainless steel tag [69 x 50 mm (2.71 x 1.97 inch)]: 
Measuring-point number/identification 
(max. 27 characters) specify in plain text

 Y15

Namur NE43 failsafe setting - device preset to 
failsafe < 3.6 mA

 N07

Operating Instructions Article No.

English A5E33329501

German A5E35690863

Note: The Operating Instructions should be ordered 
as a separate line item on the order. 
All literature is available to download for free, in a 
range of languages, at http://www.siemens.com/
processinstrumentation/documentation

Selection and Ordering data Article No.

Accessories

Tag, stainless steel, 12 x 45 mm (0.47 x 1.77 inch), 
one text line, suitable for enclosure

7ML1930-1AC

TS-3 Temperature Sensor - see TS-3 on page 4/181 7ML1813-...

Panel mount cable extension, 2.5 m (8.2 ft) 7ML1930-1GF

Qty 3 cable glands and retaining nuts 7ML1930-1GB

USB cable, 2 m (6.56 ft) - Standard USB-A to 
USB-mini B

7ML1930-1GD

Hart modem/USB 
(for use with a PC and SIMATIC PDM)

7MF4997-1DB

Sunshield, 304 stainless steel 7ML1930-1GE

SITRANS RD100, loop powered display - 
see Chapter 7

7ML5741-...

SITRANS RD200, universal input display with 
Modbus conversion - see Chapter 7

7ML5740-...

SITRANS RD300, dual line display with totalizer and 
linearization curve and Modbus conversion - see 
Chapter 7

7ML5744-...

SITRANS RD500 web, universal remote monitoring 
solution for instrumentation - see Chapter 7

7ML5750-...

Spare parts

Panel mount retrofit kit (convert standard unit with 
display to panel mount version)

7ML1830-1PA

Terminal block replacement kit 
(5 piece kit with one of each removable terminal)

7ML1830-1PB

Wall/Pipe mount plate 7ML1830-1PC

Enclosure (include blank label) 7ML1830-1PD

SITRANS LUT400 Lid (with Display) 7ML1830-1PE

SITRANS LUT400 Lid (blank) 7ML1830-1PF

Fuse - AC (0.25 A, 250 V, Slow Blow) 7ML1830-1PG

Fuse - DC (1.6 A, 125 V, Slow Blow) 7ML1830-1PH

Panel mount gasket and fastener kit 7ML1830-1PK

DIN-rail clip 7ML1830-1PL
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1) Compatible with all EchoMax Transducers. High accuracy OCM 
performance with the use of an XRS-5 transducer and TS-3 temperature 
sensor (each sold separately).

 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix.

 We can offer shorter delivery times for configurations designated with the
Quick Ship Symbol . For details see page 10/11 in the appendix

Selection and Ordering data Article No.

SITRANS LUT440
The SITRANS LUT440 is the most accurate and 
featured model in the LUT400 series. It includes 
high accuracy open channel monitoring, relay 
functions for external samplers, totalizers, alarms, 
and enhanced data logging, as well as all pump 
and control functions available with other models in 
the LUT400 series.

7ML5050-

00000 7777 0000- 777 00000

Click on the Article No. for the online configura-
tion in the PIA Life Cycle Portal.

Model 
SITRANS LUT440 - High accuracy Open Channel 
Monitor1)

 C

Enclosure display options
With display  A
With remote panel mount display [includes 
panel mount cable extension, 2.5 m (8.2 ft)]

 B

No display (blank lid provided)  C
Note: Enclosure includes back-plate for wall 
and pipe mounting, and an integrated clip for 
DIN-rail mounting. DIN-rail mounting for standard 
TS35 x 7.5 and TS35 x 15 mm DIN-rail to 
IEC 60715, EN 60715

Input voltage
100 ... 230 V AC ± 15 %  1
10 ... 32 V DC  2

Cable inlet
3 cable inlets, cable glands not supplied  1
3 cable inlets, 3 M20 plastic cable glands supplied 2

Number of measurement points 
Single point system (includes one transducer input, 
one mA output, and one external temperature 
sensor input)

 1

Communications and I/O
HART, 2 discrete inputs, 3 relays  D

Approvals
General purpose CE, FM, CSAUS/C, UL, RCM  A
Hazardous locations CSA Class I, II, III, Div. 2, 
Groups A, B, C, D, F, G

C

Selection and Ordering data Order code

Further designs

Please add "-Z" to Article No. and specify Order 
code(s).

Manufacturer's test certificate M to DIN 55350, 
Part 18 and to ISO 9000

 C11

Stainless steel tag [69 x 50 mm (2.71 x 1.97 inch)]: 
Measuring-point number/identification 
(max. 27 characters) specify in plain text

 Y15

Namur NE43 failsafe setting - device preset to 
failsafe < 3.6 mA

 N07

Operating Instructions Article No.

English A5E33329501

German A5E35690863

Note: The Operating Instructions should be ordered 
as a separate line item on the order. 
All literature is available to download for free, in a 
range of languages, at http://www.siemens.com/
processinstrumentation/documentation

Selection and Ordering data Article No.

Accessories

Tag, stainless steel, 12 x 45 mm (0.47 x 1.77 inch), 
one text line, suitable for enclosure

7ML1930-1AC

TS-3 Temperature Sensor - see TS-3 on page 4/181 7ML1813-...

Panel mount cable extension 2.5 m (8.2 ft) 7ML1930-1GF

Qty 3 cable glands and retaining nuts 7ML1930-1GB

USB cable 2 m (6.56 ft) - Standard USB-A to 
USB-mini B

7ML1930-1GD

HART modem/USB 
(for use with PC and SIMATIC PDM)

7MF4997-1DB

Sunshield, 304 stainless steel 7ML1930-1GE

SITRANS RD100, loop powered display - 
see Chapter 7

7ML5741-...

SITRANS RD200, universal input display with 
Modbus conversion - see Chapter 7

7ML5740-...

SITRANS RD300, dual line display with totalizer and 
linearization curve and Modbus conversion - see 
Chapter 7

7ML5744-...

SITRANS RD500 web, universal remote monitoring 
solution for instrumentation - see Chapter 7

7ML5750-...

Spare parts

Panel mount retrofit kit (convert standard unit with 
display to panel mount version)

7ML1830-1PA

Terminal block replacement kit 
(5 piece kit with one of each removable terminal)

7ML1830-1PB

Wall/Pipe mount plate 7ML1830-1PC

Enclosure (include blank label) 7ML1830-1PD

SITRANS LUT400 Lid (with Display) 7ML1830-1PE

SITRANS LUT400 Lid (blank) 7ML1830-1PF

Fuse - AC (0.25 A, 250 V, Slow Blow) 7ML1830-1PG

Fuse - DC (1.6 A, 125 V, Slow Blow) 7ML1830-1PH

Panel mount gasket and fastener kit 7ML1830-1PK

DIN-rail clip 7ML1830-1PL
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■ Dimensional drawings

SITRANS LUT400, dimensions in mm (inch)

SITRANS LUT400

Back
mount

bracket

Enclosure

Cable entry 
(3 places)

190
(7.5)

198
(7.8)

98°

259
(10.2)

45
(1.2)

144
(5.7)

34
(1.34)

33
(1.34)

 22
(0.87)

155
(6.10)

146
(5.75)
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SITRANS LUT400, dimensions in mm (inch)

Cut-out 

Note: Cut-out template

(printed to scale) shipped

with remote panel mount 

model. 

6.25 (0.25) rad.
(4 places)

5.50 (0.22) dia.
(4 places)

97
.0

0 
± 

1.
00

(3
.8

1 
± 

0.
04

)

1.80 ± 1.00
(0.07 ± 0.04)

13.50 ± 1.00
   (0.53 ± 0.04)

110.00 ± 1.00
(4.33 ± 0.04)

12
5.

00
 (4

.9
2)

125.00
(4.92)
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■ Schematics

SITRANS LUT400 connections 
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Safety Guidelines: Warning notices must be observed to ensure personal safety as well as that of 
others, and to protect the product and the connected equipment. These warning notices are 
accompanied by a clarification of the level of caution to be observed. 

Qualified Personnel: This device/system may only be set up and operated in conjunction with this 
manual. Qualified personnel are only authorized to install and operate this equipment in accordance with 
established safety practices and standards. 

Unit Repair and Excluded Liability:  

 The user is responsible for all changes and repairs made to the device by the user or the user’s 
agent.  

 All new components are to be provided by Siemens Milltronics Process Instruments.  
 Restrict repair to faulty components only.  
 Do not reuse faulty components. 
 

Warning: Cardboard shipping package provides limited humidity and moisture protection. This product 
can only function properly and safely if it is correctly transported, stored, installed, set up, operated, and 
maintained. 
This product is intended for use in industrial areas. Operation of this equipment in a residential area 
may cause interference to several frequency based communications. 

 

Note:  Always use product in accordance with specifications. 

Copyright Siemens AG  2013.  All Rights 
Reserved 

Disclaimer of Liability 

This document is available in bound version and in 
electronic version. We encourage users to purchase 
authorized bound manuals, or to view electronic 
versions as designed and authored by Siemens 
Milltronics Process Instruments. Siemens Milltronics 
Process Instruments will not be responsible for the 
contents of partial or whole reproductions of either 
bound or electronic versions. 

While we have verified the contents of this 
manual for agreement with the 
instrumentation described, variations remain 
possible. Thus we cannot guarantee full 
agreement.  The contents of this manual are 
regularly reviewed and corrections are 
included in subsequent editions. We welcome 
all suggestions for improvement. 

Technical data subject to change. 
 
MILLTRONICS®is a registered trademark of Siemens Milltronics Process Instruments. 
 
Contact SMPI Technical Publications   European Authorized Representative 
at the following address: 
Technical Publications    Siemens AG 
Siemens AG    Industry Sector 
Siemens Milltronics Process Instruments  76181 Karlsruhe 
1954 Technology Drive, P.O. Box 4225  Deutschland 
Peterborough, Ontario, Canada,  K9J 7B1   
Email: techpubs.smpi@siemens.com 
 
 For a selection of Siemens Milltronics level measurement manuals, go to:  

www. siemens.com/processautomation. Under Process Instrumentation, select Level 
Measurement  and then go to the manual archive listed under the product family. 

 For a selection of Siemens Milltronics weighing manuals, go to:  
www. siemens.com/processautomation. Under Weighing Technology, select Continuous 
Weighing Systems and then go to the manual archive listed under the product family. 
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Introduction

The Manual

This manual will help you set up your SITRANS LUT400 for optimum performance. We 
always welcome suggestions and comments about manual content, design, and 
accessibility. Please direct your comments to techpubs.smpi@siemens.com. 

For other Siemens level measurement manuals, go to:
www.siemens.com/level, and look under Level Measurement.

Manual symbols
Please note their use carefully.

Application examples
The application examples used in this manual illustrate typical installations using 
SITRANS LUT400. As there is often a range of ways to approach an application, other 
configurations may also apply. 

In all examples, substitute your own application details. If the examples do not apply to 
your application, check the applicable parameter reference for the available options.

Notes:
• This product is intended for use in industrial areas. Operation of this equipment in a 

residential area may cause interference to several frequency based 
communications.

• Please follow the installation and operating procedures for a quick, trouble-free 
installation and to ensure the maximum accuracy and reliability of your SITRANS 
LUT400. 

• This manual applies to the SITRANS LUT400 series only.

Alternating Current

Direct Current

Earth (ground) Terminal

Protective Conductor Terminal

Caution (refer to instructions)

No co-axial cable connections
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Change History

Sensor node

LUI

Firmware 
Rev.

PDM
EDD Rev. Date Changes

1.00.00 1.00.00 August 3, 2012 • Initial release.

Firmware 
Rev. Date Changes

1.00.00 August 3, 2012 • Initial release.
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Safety Notes

Special attention must be paid to warnings and notes highlighted from the rest of the text 
by grey boxes.1

Safety marking symbols

WARNING: relates to a caution symbol on the product, and means 
that failure to observe the necessary precautions can result in 
death, serious injury, and/or considerable material damage.
WARNING1: means that failure to observe the necessary 
precautions can result in death, serious injury, and/or considerable 
material damage.

Note: means important information about the product or that part of the operating 
manual.

1. This symbol is used when there is no corresponding caution symbol on the product.

In manual On product Description

Earth (ground) Terminal (shield)

Protective Conductor Terminal

Dispose of in an environmentally safe manner, and 
according to local regulations.

WARNING: refer to accompanying documents (manual) 
for details.

CAUTION: Observe electrostatic discharge precautions 
prior to handling electronic components within the 
wiring compartment.
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FCC Conformity
US Installations only: Federal Communications Commission (FCC) rules 

CE Electromagnetic Compatibility (EMC) Conformity
This equipment has been tested and found to comply with the following EMC Standards:

WARNING: Changes or modifications not expressly approved by 
Siemens could void the user’s authority to operate the equipment.

Notes:
• This equipment has been tested and found to comply with the limits for a Class A 

digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment.

• This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference to radio communications, in which case 
the user will be required to correct the interference at his own expense.

EMC Standard Title

CISPR 11:2004/EN 55011: 2009, CLASS A
Limits and methods of measurements of radio 
disturbance characteristics of industrial, scientific, 
and medical (ISM) radio-frequency equipment. 

EN 61326-1: 2006
IEC 61326-1: 2005 

Electrical Equipment for Measurement, Control and 
Laboratory Use – Electromagnetic Compatibility.

EN61000-3-2: 2006
Electromagnetic Compatibility (EMC) Part 3-2: Limits 
for harmonic current emissions (equipment input 
current 16A per phase).

EN61000-3-3: 2008
A1: 2001 + A2: 2005

Electromagnetic Compatibility (EMC) Part 3-3: 
Limitation of voltage changes, voltage fluctuations, 
and flicker in public low voltage supply systems, for 
equipment with rated current 16A per phase and 
not subject to conditional connection.

EN61000-4-2:2009
Electromagnetic Compatibility (EMC) Part 4-2:Testing 
and measurement techniques – Electrostatic 
discharge immunity test. 

EN61000-4-3:2006 
Electromagnetic Compatibility (EMC) Part 4-3: 
Testing and measurement techniques – Radiated, 
radio-frequency, electromagnetic field immunity test.

EN61000-4-4:2004 
Electromagnetic Compatibility (EMC) Part 4-4: 
Testing and measurement techniques – Electrical 
fast transient/burst immunity test.

EN61000-4-5:2006
Electromagnetic Compatibility (EMC) Part 4-5: 
Testing and measurement techniques – Surge 
immunity test.
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EN61000-4-6:2009

Electromagnetic Compatibility (EMC) Part 4-6: 
Testing and measurement techniques – Immunity to 
conducted disturbances, induced by radio-frequency 
fields. 

EN61000-4-8:2010
Electromagnetic Compatibility (EMC) Part 4-8:
Testing and measurement techniques – Power 
frequency magnetic field immunity test. 

EN61000-4-11: 2004

Electromagnetic Compatibility (EMC) Part 4-11: 
Testing and measurement techniques - voltage clips, 
short interruptions and voltage variations immunity 
tests.

EMC Standard Title
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Description

Overview
The Siemens SITRANS LUT400 series controllers are compact, single point, long-range 
ultrasonic controllers for continuous level measurement of liquids, slurries, and solids, 
and high accuracy monitoring of open channel flow.

The series is compatible with Siemens full line of EchoMax® Transducers, allowing an 
operating range of 0.3 to 60 meters (dependent on transducer). The SITRANS LUT400 has 
been coupled with a backlit Local User Interface (LUI) display featuring menu driven 
programming and a host of wizards for plug and play performance. The LUT400 also 
features our next generation of Sonic Intelligence®, further strengthening our industry 
leading measurement performance while improving ease of use. With a number of 
advanced pump, alarm, and flow control features, plus a real time clock and an integrated 
datalogger, the LUT400 is a powerful and comprehensive solution for your Ultrasonic 
applications.

Features
• Small 1/2 DIN enclosure footprint with standard universal mounting bracket for wall, 

pipe, and DIN rail, plus an optional panel mount
• Easy to use LUI display with local four-button programming, menu-driven 

parameters, and Wizard support for key applications
• Level, Volume, High Accuracy OCM Flow monitoring
• Three relays combined with a suite of pump, alarm, and relay control features
• HART Communications
• EDDs for SIMATIC PDM, AMS Device Manager, and Field Communicator 375/475, 

plus DTMs for FDTs (Field Device Tools)
• Integrated web browser for local programming from an intuitive web-based 

interface
• Two discrete inputs for backup level override and pump interlock functions
• Echo profile and trend views from the local display
• Patented digital receiver for improved performance in electrically noisy applications 

(close proximity to VSDs)
• Real time clock with daylight savings time supporting an integrated datalogger and 

energy saving algorithms for minimizing pump operation during high cost energy 
periods

• Removable terminal blocks for ease of wiring
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Models
The SITRANS LUT400 comes in three different models, depending on the application, 
level of performance and functionality required:

• SITRANS LUT420 Level Controller - Level or volume measurement, basic pump 
control functions, and basic data logging capability

• SITRANS LUT430 Pump and Flow Controller - Full suite of advanced control 
functionality, open channel flow monitoring, and basic data logging capability

• SITRANS LUT440 High Accuracy OCM - Best performance (rated at 1 mm accuracy 
up to 3 meters), full suite of advanced control functionality, and enhanced data 
logging capability

Applications
• Liquids, solids and slurry monitoring in small to large process and storage vessels or 

outdoor applications (open air)
• Environmental, Mining/Aggregates/Cement, Food & Beverage, and Chemical market 

applications primarily
• Key sample applications include: wet wells, reservoirs, flumes/weirs, chemical 

storage, liquid storage, hoppers, crusher bins, dry solids storage

Approvals and Certificates
The SITRANS LUT400 is available with General Purpose and Hazardous Area approvals. 
It also has a number of approvals for specialized applications. For details, see chart 
below.

Note: The device nameplate lists the approvals that apply to your device.

Application 
Type

LUT400 
Approval 
Version

Approval Rating Valid for: 

Non-hazardous General Purpose CSAUS/C, CE, FM, UL listed, C-TICK
N. America, 
Europe, 
Australia

Hazardous Non-incendive
CSA Class I, Div. 2, Groups A, B, C, D; Class II, 
Div 2, Groups F, G; Class IIIa

a. Not available for devices with remote display.

Canada
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Installing and Mounting

Installing

Mounting locations

Recommended
• Ambient temperature is always within -20 to +50 °C (-4 to +122 °F)
• SITRANS LUT400 display window is at shoulder level, unless most interaction is 

through a SCADA system
• Easy access to local push buttons is provided 
• Cable length requirements are minimized
• Mounting surface is free from vibration
• Sufficient room to swing device lid open and have clear access.
• A place for a laptop computer is provided for on-site configuration (optional, as 

laptop not required for configuration).

Avoid 
• Exposure to direct sunlight. (Provide a sun shield to avoid direct sunlight.) 
• Proximity to high voltage/current runs, contactors, SCR or variable frequency motor 

speed controllers

Notes:
• Installation must only be performed by qualified personnel, and in accordance 

with local governing regulations.
• This product is susceptible to electrostatic shock. Follow proper grounding 

procedures.

 All field wiring must have insulation suitable for at least 250V.

 Hazardous voltages present on transducer terminals during 
operation.

 DC input terminals shall be supplied from a source providing 
electrical isolation between the input and output, in order to 
meet applicable safety requirements of IEC 61010-1.

• Relay contact terminals are for use with equipment that has no accessible live 
parts and wiring that has insulation suitable for at least 250 V. The maximum 
allowable working voltage between adjacent relay contacts shall be 250 V.

• The non-metallic enclosure does not provide grounding between conduit 
connections. Use grounding type bushings and jumpers.
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Mounting instructions
Mounting instructions differ for wall, pipe, DIN-rail, and remote display panel mount 
devices. Please follow the specific instructions for your device.

Wall or panel mount
All configurations of the SITRANS LUT400 are shipped with a mounting back plate. 
SITRANS LUT400 has the option of a lid with a Local User Interface (LUI) display, a 
remote display for panel mount configuration, or a blank lid. The panel mount model 
comes with both a LUI display and a blank lid.

Note: Some electrical codes require use of metal conduit. When routing cable 
through a conduit, please follow the Cable Routing instructions on page 11 before 
mounting the SITRANS LUT400. 

mounting back plate

enclosure with optional display lid

Note: Wall mount fasteners not included.

clips (2 places)

clips (2 places)
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For a more detailed dimension drawing, see SITRANS LUT400 Dimensions  on page 119.

Wall mounting of the enclosure 

1. Mark and drill four holes in the mounting surface for the four screws (customer 
supplied).

2. Fasten with a screwdriver.
3. Line up slotted features on back of device with clips on mounting back plate. Press 

the LUT400 flush against the back plate and slide downward to fasten in place.

Please note:

• Recommended fastener size: M8 or 5/16 
"
 
s
c
r
e
w
 

mounting back plate

enclosure with blank lid

Note: Wall mount fasteners not included.

slotted features

clips (2 places)

clips (2 places)

back of enclosure

mounting screw holes on back plate
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with washer of maximum 17 mm or 
5/8 " outside diameter

• Recommended mounting: mount directly 
to wall. If alternate mounting surface is 
used, it MUST be able to support four 
times the weight of the device.

Remote mounted lid

For a more detailed dimension drawing, see SITRANS LUT400 Dimensions  on page 119 
and Cutout Dimensions (for Remote Panel Mount)  on page 120.

Mounting the remote lid

1. Using the template provided, cut out the necessary hole for the remote LUI display 
lid. Place the gasket inside the lid, aligning the mounting holes. Align the back of the 
remote display lid with the panel hole cut-out. Mark and drill four holes in the 
mounting surface for the four screws (provided).

Note: Remote mounted lid can be mounted up to 5 m from the device using two 
optional cable extensions (each 2.5 m in length). For instructions on how to con-
nect an extension cable, see Remote mounted lid with extension cable  on page 
29.

gasketremote display lid

SITRANS LUT400

extension cable

4 panel mount 
fasteners provided
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2. Fasten with a screwdriver and wrench.

Please note:

• Recommended mounting: mount to panel, up to 5 m from the device. If alternate 
mounting surface is used, it MUST be able to support four times the weight of the 
device.

Pipe mount

For a more detailed dimension drawing, see SITRANS LUT400 Dimensions  on page 119.

Mounting the enclosure

1. Fasten the mounting back plate to the pipe using u-bolts, saddle clamps, (customer 
supplied) suitable to pipe diameter.

2. Fasten bolts with a wrench. Do not over-tighten so that plate becomes twisted or 
bent. This may hinder ability to clip the LUT400 to the back plate.

3. Fasten device to mounting back plate (as described in step 3 of Wall mounting of the 
enclosure  on page 7).

Note: Recommended torque on fastening screws for good seal:
• 1.1 N m
• 10 in-lbs

Note: Fasteners included: M5 screw, seal washer, M5 flat washer and nut. These 
fasteners are required to maintain IP65 rating on remote lid.

mounting back plate
u-bolt

saddle 
clamp

enclosure with optional display lid

pipe

Note: Pipe mount fasteners not included.
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Please note:

• Recommended mounting: directly to horizontal or vertical pipe. If alternate mounting 
surface is used, it MUST be able to support four times the weight of the device.

• Recommended pipe dimensions: maximum: 3" pipe, minimum: 3/4" pipe
• Recommended fastener sizes: 

• U-Bolts: 
maximum: 3" pipe size with M8 or 3/8" thread
minimum: 3/4" pipe size with M6 or 1/4" thread

• Hex Nuts:
M6 or 1/4" to M8 or 3/8"

• Washer:
maximum: 16 mm or 13/16" outside diameter.

DIN-rail mount

For a more detailed dimension drawing, see SITRANS LUT400 Dimensions  on page 119.

Mounting the enclosure
1. Angle top of enclosure toward DIN-rail, and position slightly above top of rail.

back of enclosure

DIN-rail

DIN-rail slide

clips (2)

slot
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2. Move enclosure downward against DIN-rail to hook clips on back of enclosure to 
top of DIN-rail.

3. Press device flush against DIN-rail to engage DIN-rail slide, which will fasten 
enclosure securely to DIN-rail.

Please note:
• Recommended mounting: directly to horizontal DIN-rail.
• Required DIN-rail dimensions: TH 35-7.5 or TH 35-15 per standard IEC 60715.
• The DIN-rail MUST be able to support four times the weight of the SITRANS LUT400.

Removing the enclosure
1. From the front of the device, place screwdriver in slot at bottom of DIN-rail slide and 

pry downward. This will unclip slide from bottom of DIN-rail.
2. While holding slide down, push upward on enclosure to release clips from top of 

DIN-rail.

Preparation for cable entry
Cables can be routed through conduit or enter the enclosure through cable glands. 
Follow steps 1 to 5 below to first uncover cable entry holes, then complete steps for use 
with conduit, or with cable glands.

1. Ensure enclosure lid is closed and fastener screws are locked.
2. Place tip of screwdriver into groove on the outer diameter of the knock-out tab (see 

illustration that follows).
3. Hit the end of the screwdriver with palm of hand to knock out entry hole.
4. Loosen screws and remove enclosure lid.
5. Remove plastic piece(s) that covered entry holes from enclosure. Be careful not to 

damage the electronics with static electricity, or the tools used to knock out entry 
holes.

Cable routed through conduit
(continued from steps 1 to 5 above)

6. After preparing for cable entry in steps 1 to 5 above, attach the conduit to the 
enclosure using only suitable size fittings approved for water-tight applications. 
(Conduit size is 1/2" NPT.)

Operation & Maintenance Plan
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7. Replace enclosure lid and tighten screws.

For a more detailed dimension drawing, see SITRANS LUT400 Dimensions  on page 119.
.

Cable exposed and entering through the cable glands
(continued from steps 1 to 5 on previous page)

6. After preparing for cable entry in steps 1 to 5 above, unscrew the glands and attach 
them firmly to the enclosure.

7. Thread the cables through the glands. Ensure the power cable is kept separated 
from the signal cables and then wire the cables to the terminal blocks.

8. Tighten the glands to form a good seal.
9. Replace enclosure lid and tighten screws.

Notes:
• When cable entry hole knock-out tabs have been removed, the entry hole is 21.4 

mm to 21.6 mm in diameter. 
• M20 cable glands (20 mm in diameter), and 1/2" NPT conduit (21.3 mm in diameter) 

fit this entry hole.
• Caution should be taken when selecting appropriate seal for entry holes. Flat 

gasket is recommended (instead of O-ring). If alternate cable glands are used, it is 
the customer’s responsibility to maintain IP65 rating of entry holes.

SITRANS LUT400

cable entry holes

knock-out tab 
(3 places)

groove for screwdriver 
(3 places)
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SITRANS LUT400 wiring compartment

The Battery
The SITRANS LUT400 is supplied with one battery installed. The battery (BR2032) has a 
life expectancy of ten years, and is affected by ambient temperature. If the LUT400 loses 
input power, the battery will maintain operation of the device’s real time clock until power 
has been restored.

When the battery reaches its end of life, refer to Replacing the Battery  on page 116.

 Disconnect power before replacing the battery.

BATTERY

BR2032

0.25 A, 250 V

SLOW BLOW
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L1 L2/N

12 13 14

100 - 230 V

B
L
K

S
H

L
D

W
H

T

B
L
K

TS-3

battery

display cable

USB 
connection

power 
supply

mA HART 
connection
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Connecting

Safety notes for connection
• Verify that all system components are installed in accordance with instructions.
• Connect all cable shields to the LUT400 shield terminals (denoted on device with 

symbol ). To avoid differential ground potentials ensure cable shields are 
properly connected to ground.

• Keep exposed conductors on shielded cables as short as possible to reduce noise 
on the line caused by stray transmissions and noise pickup.

SITRANS LUT400

Siemens 
Transducer

HART FC375/475 or a computer running 
SIMATIC PDM, AMS Device Manager, 
FDT, or a web browser

Customer Alarm, 
Pump, or Control 
Device

Siemens TS-3 
Temperature Sensor

Customer Device with 
Digital Output

Display, PLC, Chart recorder, or other 
Control Device

SITRANS LUT400
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Connecting SITRANS LUT400

To access the wiring compartment:

1. Loosen 1/4 turn locking screws. 
2. Lift lid up and to the left on its 

hinges.
3. The lid can remain open connected 

by hinges, or it can be unclipped 
from the hinges and set to one side, 
to access wiring compartment.

4. Make all connections as per instructions that follow.
5. When wiring complete, replace device lid.
6. Tighten locking screws.

Wiring compartment
The terminal board on the LUT400 allows all inputs and outputs to be connected 
simultaneously. Terminal strips can be removed to improve ease of wiring.

 WARNINGS: 
• Check the device label on your instrument, to verify the approval 

rating.
• Use appropriate conduit seals to maintain IP or NEMA rating.
Notes: 
• Separate cables and conduits may be required to conform to standard 

instrumentation wiring practices or electrical codes.

CAUTION: Ensure the terminal strips are terminated to the correct 
location during re-installation. Failure to do so may result in damage to 
the device, or external equipment that is attached.

Note: Recommended torque on terminal clamping screws.
• 0.56 - 0.79 N m
• 5 - 7 in-lbs

Please do not overtighten the screws.

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



A5E33329501 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS Page 21

m
m

m
m

m

Connecting

Power

WARNINGS:
The DC input terminals shall be supplied from a source providing 
electrical isolation between the input and output, in order to meet 
the applicable safety requirements of IEC 61010-1.

All field wiring must have insulation ratings suitable for the 
application.

Important!
Before applying power to the SITRANS LUT400 for the first time, ensure any 
connected alarm/control equipment is disabled until satisfactory system operation 
and performance is verified.

100 - 230V

100 - 230V

BATTERY

BR2032

0.25 A, 250 V

SLOW BLOW

DISPLAY

SERVICE

RELAYS

TRANSDUCER

W
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T

DISCRETE INPUTS
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POWER

mA OUT/HART

22 23 24
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PAS
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116

1 2
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RLY 1 RLY 2 RLY 3
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L1 L2/N

12 13 14
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TS-3

INPUT

POWER

L1 L2/N

12 13 14

0.25 A, 250 V

SLOW BLOW

cable gland 
(or NPT cable entry)
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L2/N

L1
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The SITRANS LUT400 is available in AC or DC power models.

1. To wire for power, strip the cable jacket for approximately 70 mm (2.75") from the end 
of the cable, and thread the wires through the gland1.

2. Connect the wires to the terminals as shown: the polarity is identified below the 
terminal block.

3. Ground the device according to local regulations.

Cables
The SITRANS LUT400 is designed to work with two conductor shielded transducer 
cables.

1. If cable is routed through conduit, use only approved suitable-size hubs for waterproof 
applications.

Notes for AC power connections:
• The equipment must be protected by a 15 A fuse, or circuit breaker on all 

current-carrying conductors in the building installation.
• A circuit breaker or switch in the building installation, marked as the disconnect 

switch, must be in close proximity to the equipment and within easy reach of the 
operator, and must disconnect all current-carrying conductors.

Connection Cable Type
mA output, sync, 
Temperature sensor, 
discrete input

2 copper conductors, twisted, with shielda/drain wire, 300V 0.324 - 
0.823 mm2 (22 - 18 AWG). 
Maximum length: 365 m

a. Preferred shielding is braided shield.

Transducer Shielded two-wire. Maximum length: 365 m

Relay output
AC input

Copper conductors per local requirements.

INPUT

POWER

INPUT

POWER

L1 L2/N

10 - 32 V

12 1213 1314 14

100 - 230 V

Note: Make sure device is connected to a reliable ground.

AC Power DC Power

AC: 100-230 V AC 15%, 50/60 Hz, 36 VA (10W) DC: 10-32 V DC, 10W

Warning: Do not use a coaxial transducer cable 
extension with the SITRANS LUT400. High voltage 
transmitted on shield of coaxial cable could result in 
personal injury, damage to equipment, or poor device 
performance.
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Transducers

Temperature sensor
The speed of sound changes as temperature changes. To ensure accurate level 
measurement, the SITRANS LUT400 compensates via an external temperature input. All 
Siemens EchoMax transducers have an internal temperature sensor for this purpose, 
and for the fastest temperature response, Siemens also offers a dedicated temperature 
sensor, the TS-3.

If the following conditions apply, a separate TS-3 temperature sensor will ensure 
optimum accuracy:

• the transducer is exposed to direct sunlight (or other radiant heat source)
• the temperature of the atmosphere between the transducer face and monitored 

surface differs from the temperature of the transducer
• faster response to temperature changes is required.

To achieve the best performance of temperature measurement in a typical open channel 
flow application, the temperature sensor should be shielded from direct sunlight and 
mounted half way between the ultrasonic transducer face and the maximum head 
achievable in the application. Care should be taken to not obstruct the direct sound path 
of the ultrasonic transducer.

Note: Use a TS-3 Temperature Sensor only. Leave terminals open (unused) if TS-3 
is not deployed.

 Warning: Hazardous voltage present on transducer terminals during 
operation.

Notes:
• Do not connect coaxial cable directly to SITRANS LUT400 due to high voltage 

transmitted on shield of coaxial cable
• Do not connect the LUT400 shield and white transducer wires together; wire to 

separate terminals
• Disregard older transducer manuals that recommend these practices

TRANSDUCER
W
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T

1 42 53
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Relays
Relay contacts are shown in the de-energized position. All relays can be configured as 
positive or negative logic (see 2.8.11. Relay Logic).

.

Communications
The USB port and the 4 to 20 mA HART terminal block (terminal numbers 22, 23, and 24) 
are located inside the enclosure of the device.

RELAYS

RLY 1 RLY 2 RLY 3

21201918171615

Relay Ratings

• one Form C (NO or NC) relay 
(relay 1), 1A at 250 V AC, 
non-inductive, 3A at 30 V DC

• two Form A (NO) relays 
(relays 2,3), 5A at 250 V AC, 
non-inductive, 3A at 30 V DC

Power Failure
Relays 2, 3 are normally 
open. 
Relay 1 can be wired either 
normally open or normally 
closed.
In the event of loss of input 
power, relays will revert to 
their normal states.

TO TRANSDUCER

TO OTHER

SIEMENS

UNIT

BATTERY

BR2032

0.25 A, 250 V

SLOW BLOW

DISPLAY

SERVICE
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USB cable 
connection

4 to 20 mA Hart 
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Connecting via USB

Use 5-pin USB Mini-B cable. The cable should not exceed 3 m (9.8 ft.).

Notes: 
• No data logs are written while device is connected to a PC via USB. 

(See 2.10. Data Logging on page 173 and 3.2.6. View Logs on page 201.) 
Connect USB cable for device configuration, and when configuration is 
complete, disconnect the USB cable to allow Data Logging to occur. (It is good 
practice to use MS Windows Safely Remove Hardware feature before 
unplugging any USB cable from your computer.)

• Do not use a USB extension cable with the LUT400. Data Logging may not 
occur, even after extension cable has been disconnected. (If a USB extension 
cable has been used in error, a power reset of the device is required to restart 
Data Logging.)

SITRANS LUT400

SITRANS LUT400

Typical USB configuration

Computer system

USB cable

BATTERY

BR2032

0.25 A, 250 V

SLOW BLOW
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RELAYS
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Connecting HART 1 2

 

For more information, consult the mA output parameters (2.5. Current Output) in the 
parameter reference section.

1. Depending on the system design, the power supply may be separate from the PLC, or integral to 
it.

2. The nominal value for the HART resistor is 250 Ohm. For more information see application guide 
Working with HART, which can be downloaded from the product page of our website. Go to: 
www.siemens.com/sitransLUT400 under Support and click on Application Guides.

SITRANS LUT400

SITRANS LUT400

PLC1

HART modemSITRANS LUT400

power supply 

Typical PLC/mA configuration with Passive HART connection

R = 250 

HART 
communicator

Typical PLC/mA configuration with Active HART connection

PLC1

HART modemSITRANS LUT400

R = 250 

HART 
communicator

mA OUT/HART

22 23 24

ACT

PAS

For PASSIVE HART 
connection (using 
external power 
supply), connect 
terminals 23 and 24.

mA Output (HART)

For ACTIVE HART 
connection (using 
LUT400 integral power 
supply), connect 
terminals 22 and 23.
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Level system synchronization

When transducer cables are run parallel with each other, synchronize the level monitors 
so that no device transmits while another is waiting for echo reception. If more than one 
ultrasonic device is being installed in the same application, the devices must be 
synchronized to prevent cross-talk. Optionally, the transducer cables can be run in 
separate grounded metal conduits.

Synchronizing with another SITRANS LUT400, or other Siemens devices

Other Siemens devices that can be synchronized with the SITRANS LUT400:

DPL+, SPL, XPL+, LU01, LU02, LU10, LUC500, DPS300, HydroRanger 200, 
HydroRanger Plus, EnviroRanger, MiniRanger, MultiRanger 100/200

• Mount the level monitors together in one cabinet
• Use a common power (mains) supply and ground (earth) for all devices
• Interconnect the SYNC terminals of all level monitors.
• Up to 16 Siemens devices can be synchronized together.
For more information or assistance, contact Siemens or your local distributor. Go to: 
www.siemens.com/processautomation. 

Note: The SITRANS LUT400 CANNOT be synchronized with the MultiRanger Plus, 
the original HydroRanger, or the OCMIII.

DISCRETE INPUTS

SYNC

116

1 2

97 108

DC

Other Siemens 
Transceiver
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Discrete inputs
The SITRANS LUT400 has a 24V power bias (terminal 10) for use with the discrete inputs, 
or the discrete inputs can be wired using external power.

DISCRETE INPUTS

SYNC

116

1 2

97 108

DC

Pos. Input for DI1

Pos. Input for DI2

Bias supply for Pos. DIs 
(ground to term

inal 6)

Com
m

on N
eg. for DIs

DISCRETE INPUTS

SYNC

116

1 2

97 108

DC

Discrete Inputs used with internal bias supply

Note: terminals 6 and 7 must be connected together.

DISCRETE INPUTS

SYNC

116

1 2

97 108

DC

Discrete Inputs used with external bias voltage
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Remote mounted lid with extension cable
The optional display lid can be mounted remotely up to 5 m from the device. The optional 
extension cable can be used for such an installation.

1. Remove display lid from the enclosure.
2. Carefully disconnect the existing display cable from the terminal board.
3. Separate from the device, knock out cable entry tab on blank lid:

a. With gasket in place, use snips to cut into lid on both sides of the cable entry 
knockout. Use cutting guideline to cut from bottom of lid, up to bottom of groove 
(as shown below).

b. Once both sides of knockout have been cut through all layers of the lid (including 
the gasket), pry upward with pliers on knockout to snap off plastic and uncover 
cable entry hole.

c. Use sand paper if necessary to smooth any sharp edges.
d. Replace the blank lid on the enclosure.

4. Connect the extension cable to the display connector on the terminal board. (If 
desired, attach second extension cable to the other end of the first extension cable.)

5. Feed the free end of the extension cable through cable entry hole on blank lid.
6. Connect extension cable to display cable on remote lid.

 WARNINGS: 
• Ingress protection of the enclosure is reduced to IP20, and Type 4X / 

NEMA 4X rating is void when cable entry knock-out in the blank lid is 
removed.

• An enclosure reduced to an IP20 rating and intended for use in non-
hazardous locations must be installed in an indoor location free of dust 
and moisture, or be installed in a suitably rated field enclosure IP54 or 
better.

cable entry
knockout

blank lid

bottom of groove
groove

cutting guideline

bottom of lid
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7. Secure blank lid on device and mount display lid remotely. See Remote mounted lid 

on page 8 for mounting instructions. 

Extension cable
Optional extension cables (2.5 m cables) are available to be used with remote mounted 
lid. Two cables can be connected together for an extension of up to 5 meters.

Note:  It is recommended that the exposed extension cable be secured along a 
wall, or run through conduit to prevent damage to device, should cable be 
accidentally subjected to stress.
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Connecting in hazardous area installations
Wiring setups for hazardous area installations

The following wiring options are available for hazardous area installations:
• Non-incendive wiring (Canada)

In all cases, check the device label on your instrument, and confirm the approval rating.

1. Non-incendive wiring (Canada)

Assembled in Canada with domestic and imported parts
Siemens Milltronics Process Instruments, Peterborough

SITRANS LUT420

7MLxxxx-xxxxx-xxxx
Serial No.: GYZ / B1034567
Power Rating: 100 – 230V ± 15%

50/60 Hz, 36 VA (10 W)
Contact Rating: 1A/5A @ 250V , Non-Inductive
Operating Temperature: – 20°C to 50°C
Enclosure: IP65 / TYPE 4X / NEMA 4X

Class I, Div.2, Gr. A, B, C & D T3C
Class II, Div. 2, Gr. F & G
Class III
Per Drawing A5E03936871159134

Assembled in Canada with domestic and imported parts
Siemens Milltronics Process Instruments, Peterborough

SITRANS LUT430

7MLxxxx-xxxxx-xxxx
Serial No.: GYZ / B1034567
Power Rating: 100 – 230V ± 15%

50/60 Hz, 36 VA (10 W)
Contact Rating: 1A/5A @ 250V , Non-Inductive
Operating Temperature: – 20°C to 50°C
Enclosure: IP65 / TYPE 4X / NEMA 4X

Class I, Div.2, Gr. A, B, C & D T3C
Class II, Div. 2, Gr. F & G
Class III
Per Drawing A5E03936871159134

Assembled in Canada with domestic and imported parts
Siemens Milltronics Process Instruments, Peterborough

SITRANS LUT440

7MLxxxx-xxxxx-xxxx
Serial No.: GYZ / B1034567
Power Rating: 100 – 230V ± 15%

50/60 Hz, 36 VA (10 W)
Contact Rating: 1A/5A @ 250V , Non-Inductive
Operating Temperature: – 20°C to 50°C
Enclosure: IP65 / TYPE 4X / NEMA 4X

Class I, Div.2, Gr. A, B, C & D T3C
Class II, Div. 2, Gr. F & G
Class III
Per Drawing A5E03936871159134

Assembled in Canada with domestic and imported parts

Siemens Milltronics Process Instruments, Peterborough

SITRANS LUT420

7MLxxxx-xxxxx-xxxx

Serial No.: GYZ / B1034567

Power Rating: 10 – 32V , 10W

Contact Rating: 1A/5A @ 250V , Non-Inductive

Operating Temperature: – 20°C to 50°C

Enclosure: IP65 / TYPE 4X / NEMA 4X

Class I, Div.2, Gr. A, B, C & D T3C
Class II, Div. 2, Gr. F & G
Class III
Per DWG. A5E03936871159134

Assembled in Canada with domestic and imported parts

Siemens Milltronics Process Instruments, Peterborough

SITRANS LUT430

7MLxxxx-xxxxx-xxxx

Serial No.: GYZ / B1034567

Power Rating: 10 – 32V , 10W

Contact Rating: 1A/5A @ 250V , Non-Inductive

Operating Temperature: – 20°C to 50°C

Enclosure: IP65 / TYPE 4X / NEMA 4X

Class I, Div.2, Gr. A, B, C & D T3C
Class II, Div. 2, Gr. F & G
Class III
Per DWG. A5E03936871159134

Assembled in Canada with domestic and imported parts

Siemens Milltronics Process Instruments, Peterborough

SITRANS LUT440

7MLxxxx-xxxxx-xxxx

Serial No.: GYZ / B1034567

Power Rating: 10 – 32V , 10W

Contact Rating: 1A/5A @ 250V , Non-Inductive

Operating Temperature: – 20°C to 50°C

Enclosure: IP65 / TYPE 4X / NEMA 4X

Class I, Div.2, Gr. A, B, C & D T3C
Class II, Div. 2, Gr. F & G
Class III
Per DWG. A5E03936871159134

CSA Class I, Div 2 connection drawing number A5E03936871 can be downloaded from the 
product page of our website at www.siemens.com/sitransLUT400.
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Commissioning

Local Commissioning
SITRANS LUT400 is an easy to use, and quick to commission device, with its numerous 
wizards, and menu driven parameters. The parameters can be modified locally using the 
LCD and the local push buttons, also known as the Local User Interface (LUI).

A Quick Start Wizard provides an easy step-by-step procedure to help you configure the 
device for a simple application. We recommend that you configure your application in the 
following order:

• First, run the appropriate Quick Start Wizard for your application (Level, Volume, 
Flow).

• Next, setup pumps via the Pump Control Wizard (if applicable).
• Lastly, configure alarms, or other controls, totalizers and samplers, referencing the 

respective parameters [see Parameter reference (LUI)  on page 137]. It is important 
that alarms, and other controls are configured last to avoid pump relay assignments 
being overridden by the Quick Start Wizard.

There are two ways to access the Quick Start wizards:

• locally (see Quick Start Wizards via LUI  on page 38)
• from a remote location (see Other Quick Start Wizards (QSW):  on page 38)

See Level Application Example  on page 58, or Flow application example  on page 59 for 
illustrations, and for the complete range of parameters, see Parameter reference (LUI)  on 
page 137.

Activating SITRANS LUT400
Notes: 
• Program Mode and Measurement mode refer to the display only. While the device is 

in Program mode, the output remains active and continues to respond to changes in 
the device.

• To enter Program mode using the device local push buttons, press . Press  to 
return to Measurement mode.

• The display will return to Measurement mode after ten minutes of inactivity (from 
last button press), when in Program Mode and from within a Wizard. Pressing  will 
then take you to the main navigation menu. (It will not return to the screen from 
which the timeout occurred.)

SITRANS LUT400

local push buttons
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1. Power up the device. SITRANS LUT400 automatically starts up in Measurement 
mode. A transition screen showing first the Siemens logo and then the current 
firmware revision of the LUI is displayed while the first measurement is being 
processed. 

2. The first time the device is configured, you will be prompted to select a language 
(English, German, French, Spanish, Chinese, Italian, Portuguese, or Russian). To 
change the language again (after initial setup), see Language  on page 217.

3. Device time is set to Eastern Standard Time (EST) at the factory. To modify, see Date 
and Time  on page 187. The correct date and time should be set prior to configuring 
the device.

The LCD Display
Measurement mode display: 1Normal operation

Fault present

1. Press UP or DOWN arrow to switch

SITRANS LUT400 1/2
MLEVEL

5 SAVING PARAMETERS

1 12 23
18.91

SITRANS LUT400 1/2

M

L/S
FLOW

5 SAVING PARAMETERS

HEAD

DAILY TOTAL,...

60.000

999999.99

500313..

1 112 223

1 – tag
2 – measured value (level, space, distance, 

volume, flow, or head)
3 – value being displayed [Primary Variable 

(PV)=1 of 2, Secondary Variable (SV)=2 of 2]
4 – toggle indicator1 for PV or SV
5 – units
6 – bar graph indicates level
7 – secondary region indicates configured 

relays (left) and discrete inputs (right)
8 – text area displays status messages
9 – device status indicator
10 – selected (primary) sensor mode: level, 

space, distance, volume, head, or flow
11 – secondary sensor mode = head when 

primary sensor mode = flow
12 – totalizer values: display alternates between 

daily totalizer and running totalizer

5

6

7

1 3 42

10

89

1

5

6

7

3 42

10

89

11

12

Level

Flow

0 LOE
8 – text area displays a fault code and an error message
9 – service required icon appears
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PROGRAM mode display

Navigation view

• A visible menu bar 
indicates the menu list is 
too long to display all 
items.

• The depth of the item 
band on the menu bar 
indicates the length of the 
menu list: a deeper band 
indicates fewer items.

• The position of the item band indicates the approximate position of the current item in the 
list. A band filled halfway down the menu bar indicates the current item is halfway down 
the list. 

Key functions in Measurement mode

Programming SITRANS LUT400

Change parameter settings and set operating conditions to suit your specific application. 
(For remote operation, see Operation via SIMATIC PDM 6 (HART)  on page 15 or 
Operation via AMS Device Manager (HART)  on page 19.)

Key Function Result

RIGHT arrow
opens PROGRAM mode.

Opens the top level menu.

UP or DOWN arrow
toggles between PV and SV. LCD displays primary or secondary value.

Notes: 
• To enter Program mode using the device local push buttons, press . Press  to 

return to Measurement mode.
• While the device is in Program mode, the output remains active and continues to 

respond to changes in the device.

TRANSDUCER 2.1.6
NO TRANSDUCER

XPS-10

XPS-15

XCT-8

XCT-12

XPS-30

XRS-5

parameter 
number

current item

current menu/
parameter 
name

menu bar

item band

SENSOR 2.1.6
UNITS

SENSOR MODE SECONDARY

TRANSDUCER

FREQUENCY

XRS-5

SENSOR MODE

TRANSDUCER 2.1.6
NO TRANSDUCER

XPS-10

XPS-15

XCT-8

XCT-12

XPS-30

XRS-5

parameter 
value/selection

parameter 
name

parameter 
number

Parameter view Edit view
menu in 
which 
parameter 
is located
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Parameter menus

Parameters are identified by name and organized into function groups, then arranged in a 
5-level menu structure, as in the example below. (For full menu see LCD Menu Structure  
on page 125.)

1. Enter PROGRAM mode

Using local push buttons:

• RIGHT arrow  activates PROGRAM mode and opens menu level 1. 

2. Navigating: key functions in Navigation view

Note: For the complete list of parameters with instructions, see .

Notes: 
• In Navigation view, ARROW keys move to the next menu item in the direction of the 

arrow.
• Press and hold any arrow key to scroll through a list of options or menus (in the 

direction of the arrow).

Key Name Menu level Function

 UP or DOWN 
arrow menu or parameter Scroll to previous or next menu or 

parameter.

RIGHT arrow 
menu

Go to first parameter in the selected 
menu, or open next menu.

parameter Open Edit mode.

LEFT arrow menu or parameter Open parent menu.

1. WIZARDS
2. SETUP

2.1 SENSOR
......
2.7 PUMPS

2.7.1 BASIC SETUP
2.7.2 MODIFIERS

2.7.2.1 WALL CLING REDUCTION
2.7.2.1.1 ENABLE
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3. Editing in PROGRAM mode

Selecting a listed option

a. Navigate to the desired parameter.

b. Press RIGHT arrow  to open Edit 
mode. The current selection is 
highlighted. 

c. Scroll to a new selection.

d. Press RIGHT arrow  to accept it. 
The LCD returns to parameter view and 
displays the new selection.

Changing a numeric value

a. Navigate to the desired parameter.
b. When selected, the current value is 

displayed.

c. Press RIGHT arrow  to open Edit 
mode. The cursor position is highlighted.

d. Use LEFT  and RIGHT arrow  to 
move cursor to digit position you wish to 
change.

e. As each digit is highlighted (selected), 

use the UP  and DOWN arrow  to increase or decrease the digit 
respectively.

f. While decimal point is selected, use UP  and DOWN arrow  to shift decimal 
position.

g. To escape without saving your changes, press LEFT arrow  continually until ESC 

is highlighted. Press LEFT arrow  again to escape without saving changes. 

Otherwise, when new parameter value is correct, press RIGHT arrow  
continually until OK is highlighted.

h. Press RIGHT arrow  to accept the new value. The LCD returns to parameter 
view and displays the new selection. Review for accuracy.

Key functions in Edit mode

Key Name Function

 UP or 
DOWN 
arrow

Selecting 
options Scrolls to item.

Alpha-
numeric 
editing 

- Increments or decrements digits
- Toggles plus and minus sign

SENSOR 2.1.6
UNITS

SENSOR MODE SECONDARY

TRANSDUCER

FREQUENCY

XRS-5

SENSOR MODE

TRANSDUCER 2.1.6
NO TRANSDUCER

XPS-10

XPS-15

XCT-8

XCT-12

XPS-30

XRS-5

parameter 
name

parameter
number

current 
value

menu 
name

CALIBRATION 2.2.1

LOW CALIB. PT.

SENSOR OFFSET

NEAR RANGE

FAR RANGE

2.00 M

HIGH CALIB. PT.

LOW CALIB. PT. 2.2.1

ESC + _ _ _ _ _ _ OK02. M

current
value

parameter
number

parameter 
name
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Quick Start Wizards
A Wizard provides an easy step-by-step Quick Start (QS) procedure that configures the 
device for a simple application. To configure the SITRANS LUT400 for applications of level, 
volume (standard vessel shapes), or flow, use the Quick Start Wizards via LUI  on page 38 of 
this chapter. 

Wizards for applications employing more complex vessel shapes are available via 
SIMATIC PDM. See Quick Start (Volume - Linearization) in the LUT400 Communications 
manual1.

Other Quick Start Wizards (QSW):

Other Quick Start Wizards using various software packages are also available:

• SIMATIC PDM (HART) (see page 15)
• AMS (HART) (see page 19)
• FC375/475 (HART) (see page 21)
• FDTs (HART) (see page 23)

Before initiating a Quick Start Wizard to configure the device, you may wish to gather the 
necessary parameter values. Parameter Configuration Charts that list all parameters and 
available options for each application type are available on our website. Go to 
www.siemens.com/sitransLUT400 > Support > Application Guides. You can record data 
and select from options on the chart that apply to your application, then with this data on 
hand, complete the Quick Start Wizards via LUI below, or via another Quick Start Wizard, 
as referenced above.

Quick Start Wizards via LUI

1) Press  to enter Program mode.

RIGHT 
arrow

Selecting 
options

- Accepts the data (writes the parameter)
- Changes from Edit to Navigation mode

Numeric 
editing 

- Moves cursor one space to the right
- or with selection highlighted, accepts the 

data and changes from Edit to Navigation 
mode

LEFT 
arrow: 

Selecting 
options

Cancels Edit mode without changing the 
parameter

Numeric 
editing 

- Moves cursor to plus/minus sign if this is the 
first key pressed

- or moves cursor one space to the left.
- or with cursor on Enter sign, cancels the entry

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01). (See DVD shipped with 
device or download manual from our website.)

Note: Device continues to measure while in Program Mode. If you wish to disable the 
device while it is configured, see 3.3.1. Transducer Enable on page 204.

Key Name Function (Continued)
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2) Choose Wizards (1.), Quick Start (1.1), and then the appropriate quick start: 

QS Level (1.1.1.), QS Volume (1.1.2.), or QS Flow (1.1.3.). 
[The QS Flow wizard will display on LUI for LUT430 (Pump and Flow), and LUT440 
(OCM) configured models only.]

3) Follow the steps then choose Finish to save Quick Start parameter changes and 

return to Program menu, then press  three times to return to Measurement 
mode.

1. Wizards

1.1. Quick Start

1.1.1. QS Level
Use this wizard to configure simple level applications.

a. Press RIGHT arrow  to activate PROGRAM mode and open menu level 1: MAIN 
MENU. 

b. Press RIGHT arrow  two times to navigate to menu item 1.1.1.

c. Press RIGHT arrow  to open QS Level. 

d. At each step, press DOWN arrow  to 
accept default values and move directly to 
the next item, 

or RIGHT arrow  to open Edit mode: the 
current selection is highlighted. 

e. Scroll to desired item and press RIGHT arrow 

 to store the change, then press DOWN 

arrow  to continue. 

f. At any time, you can press UP arrow  to 

go back, or LEFT arrow  to cancel the wizard.

Notes: 
• The Quick Start Wizard settings are inter-related and changes apply only after you 

choose Finish in the final step.
• Perform customization for your application only after the Quick Start has been 

completed.

QUICK START LEVEL

TRANSDUCER

XRS-5

NEXT

BACK

EDITCANCEL

QUICK START LEVEL

NO TRANSDUCER

XPS-10

XPS-15

XCT-8

XCT-12

XRS-5

TRANSDUCER
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Start of QS Level Wizard

Shows the type of Wizard to be executed.

Transducer
Specifies the Siemens transducer connected to the device.

Operation

Sets the type of measurement (and the corresponding mA output) required for the 
application.

Note: The introduction screen is displayed only on the device when using the local 
push buttons. This screen is not part of the Quick Start when using SIMATIC PDM.

Options CANCEL, START

Options
NO TRANSDUCER, XRS-5, XPS-10, XPS-15, XCT-8, XCT-12, XPS-30, XPS-40, 
XLT-30, XLT-60, STH

Default: NO TRANSDUCER

Start of QS 
Level Wizard

Select transducer Select operation

Select temperature 
source

Set level units and 
setpoints

Level Wizard 
complete

- Transducer - Operation

- Temperature Source
- Fixed Temperature

- Units
- High Calibration Point
- Low Calibration Point
- Response Rate

sensor reference point 

level 

Low Calibration Point

High Calibration Point
distance 

space 

Far Range
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Temperature Source
Source of the temperature reading used to adjust the speed of sound.

See Temperature Source  on page 180 for more details.

Fixed Temperature

Use this feature if a temperature sensing device is not used.

This parameter is only displayed if FIXED TEMPERATURE selected for Temperature 
Source.

Units

Sensor measurement units.

High Calibration Point
Distance from Sensor Reference Point to High Calibration Point: usually process full 
level.

Mode Description Reference point

LEVEL * Height of material
Low Calibration Point
(process empty level)

SPACE
Distance to material surface

High Calibration Point 
(process full level)

DISTANCE Sensor Reference Point

OTHER

Do NOT select. 
If Operation value displays as 
OTHER, the device is configured as a 
level controller, but has been set pre-
viously to a mode other than LEVEL, 
SPACE, or DISTANCE. 
The operation mode must be set to 
LEVEL, SPACE, or DISTANCE to pro-
ceed with the QS Level Wizard.

Options
TRANSDUCER, FIXED TEMPERATURE, EXTERNAL TS-3, AVERAGE OF SEN-
SORS

Default: TRANSDUCER

Value
Range: -100.0 to +150.0 °C

Default: +20.0 °C

Options
M, CM, MM, FT, IN

Default: M

Note: For the purpose of this example, all values are assumed to be in meters (m).

Value
Range: 0.000 to 60.000

Default: 0.000
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Low Calibration Point
Distance from Sensor Reference Point to Low Calibration Point: usually process 
empty level.

Response Rate

Sets the reaction speed of the device to measurement changes in the target range.

Use a setting just faster than the maximum filling or emptying rate (whichever is 
greater). Slower settings provide higher accuracy, faster settings allow for more 
rapid level fluctuations.

End of QS Level Wizard

For QS to be successful, all changes must be applied.

To transfer Quick Start values to the device and return to Program menu, press 

DOWN arrow  (Finish). Then press LEFT arrow  three times to return to 
Measurement mode.

Value
Range: 0.000 to 60.000

Default: 60.000

Notes: 
• Response Rate can only be set through the Quick Start Wizard, and any 

changes made to Fill Rate per Minute (2.3.1.), Empty Rate per Minute (2.3.2.), or 
Damping Filter (2.3.3.) parameters following the completion of the wizard will 
supersede the Response Rate setting.

• Response Rate always displays in m/minute.

Options

SLOW (0.1 M/MIN)

MEDIUM (1.0 M/MIN)

FAST (10 M/MIN)

Default: SLOW (0.1 M/MIN)

Options

BACK, CANCEL, FINISH 
(Display returns to 1.1 Quick Start menu when Quick Start is successfully com-
pleted or cancelled. If CANCEL is selected, no changes are written to the 
device.)
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1.1.2. QS Volume
Use this wizard to configure volume applications employing standard vessel shapes.

a. Press RIGHT arrow  to activate PROGRAM mode and open menu level 1: MAIN 
MENU. 

b. Press RIGHT arrow  two times to navigate to menu item 1.1.1.

c. Press DOWN arrow  and RIGHT arrow  to open QS Volume. 

d. At each step, press DOWN arrow  to accept 
default values and move directly to the next item, 

or RIGHT arrow  to open Edit mode: the 
current selection is highlighted. 

e. Scroll to desired item and press RIGHT arrow  

to store the change, then press DOWN arrow  
to continue. 

f. At any time, you can press UP arrow  to go 

back, or LEFT arrow  to cancel the wizard.

QUICK START VOLUME

TRANSDUCER

XRS-5

NEXT

BACK

EDITCANCEL

QUICK START VOLUME

NO TRANSDUCER

XPS-10

XPS-15

XCT-8

XCT-12

XRS-5

TRANSDUCER

Start of QS 
Volume Wizard

Select 
transducer

Select 
temperature source

Select 
vessel shape

Set 
level units and 
setpoints

Set 
vessel 
dimensions 
(vary by vessel)

Set 
vessel volume

Volume Wizard
complete

- Transducer - Temperature source
- Fixed Temperature

- Vessel Shape - Units
- High Calibration Point
- Low Calibration Point
- Response Rate

- Dimension A
- Dimension L

- Volume Units
- Maximum Volume
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Start of QS Volume Wizard

Shows the type of Wizard to be executed.

Transducer
Specifies the Siemens transducer connected to the device.

Temperature Source

Source of the temperature reading used to adjust the speed of sound.

See Temperature Source  on page 180 for more details.

Fixed Temperature

Use this feature if a temperature sensing device is not used.

This parameter is only displayed if FIXED TEMPERATURE selected for Temperature 
Source.

Vessel Shape

Defines the vessel shape and allows the SITRANS LUT400 to calculate volume 
instead of level. If NONE is selected, no volume conversion is performed. Select the 
vessel shape matching the monitored vessel or reservoir.

See Vessel Shape  on page 147 for illustration. If CURVE TABLE or LINEAR TABLE 
selected, enter values for level and volume breakpoints after completing the wizard 
(see 2.6.7. Table 1-8 on page 150).

Units

Sensor measurement units.

Note: The introduction screen is displayed only on the device when using the local 
push buttons. This screen is not part of the Quick Start when using SIMATIC PDM.

Options CANCEL, START

Options
NO TRANSDUCER, XRS-5, XPS-10, XPS-15, XCT-8, XCT-12, XPS-30, XPS-40, 
XLT-30, XLT-60, STH

Default: NO TRANSDUCER

Options
TRANSDUCER, FIXED TEMPERATURE, EXTERNAL TS-3, AVGERAGE OF 
SENSORS

Default: TRANSDUCER

Value
Range: -100.0 to +150.0 °C

Default: +20.0 °C

Options

NONE, LINEAR, CYLINDER, PARABOLIC BOTTOM, HALF SPHERE BOTTOM, 
FLAT SLOPED BOTTOM, PARABOLIC ENDS, SPHERE, CONICAL BOTTOM, 
CURVE TABLE, LINEAR TABLE

Default: LINEAR

Options
M, CM, MM, FT, IN

Default: M

Note: For the purpose of this example, all values are assumed to be in meters (m).
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High Calibration Point
Distance from Sensor Reference Point to High Calibration Point: usually process full 
level.

Low Calibration Point
Distance from Sensor Reference Point to Low Calibration Point: usually process 
empty level.

Response Rate

Sets the reaction speed of the device to measurement changes in the target range.

Use a setting just faster than the maximum filling or emptying rate (whichever is 
greater). Slower settings provide higher accuracy, faster settings allow for more level 
fluctuations.

Dimension A
The height of the vessel bottom when the bottom is conical, pyramidal, parabolic, 
spherical, or flat -sloped..

Dimension L
Length of the cylindrical section of a horizontal parabolic end vessel.

Volume Units

Determines volume measurement units.

* If USER DEFINED option selected, the value must be set after completing the 
wizard. See 2.6.6. User Defined Unit on page 149.

Value
Range: 0.000 to 60.000

Default: 0.000

Value
Range: 0.000 to 60.000

Default: 60.000

Notes: 
• Response Rate can only be set through the Quick Start Wizard, and any 

changes made to Fill Rate per Minute (2.3.1.) or Empty Rate per Minute (2.3.2.) 
parameters following the completion of the wizard will supersede the Response 
Rate setting.

• Response Rate always displays in m/minute.

Options

SLOW (0.1 M/MIN)

MEDIUM (1.0 M/MIN)

FAST (10 M/MIN)

Default: SLOW (0.1 M/MIN)

Value
Range: 0.000 to 99.999

Default: 0.000

Value
Range: 0.000 to 99.999

Default: 0.000

Options
L, USGAL, IMPGAL, CUM, USER DEFINED *

Default: L
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Maximum Volume

The maximum volume of the vessel. Enter the vessel volume corresponding to the 
High Calibration Point. For example, if your maximum vessel volume is 8000 L, enter a 
value of 8000.

End of QS Volume Wizard

For QS to be successful, all changes must be applied.

To transfer Quick Start values to the device and return to Program menu, press 

DOWN arrow  (Finish). Then press LEFT arrow  three times to return to 
Measurement mode.

Value
Range: 0.0 to 9999999

Default: 100.0

Options
BACK, CANCEL, FINISH (Display returns to 1.1 Quick Start menu when Quick 
Start is successfully completed or cancelled. If CANCEL is selected, no 
changes are written to the device.)
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1.1.3. QS Flow
Use this wizard to configure simple flow applications.
(Visible on LUT430 (Pump and Flow), and LUT440 (OCM) configured models only.

a. Press RIGHT arrow  to activate PROGRAM mode and open menu level 1: MAIN 
MENU. 

b. Press RIGHT arrow  two times to navigate to menu item 1.1.1.

c. Press DOWN arrow  two times and RIGHT arrow  to open QS Flow. 

d. At each step, press DOWN arrow  to 
accept default values and move directly to 
the next item, 

or RIGHT arrow  to open Edit mode: the 
current selection is highlighted. 

e. Scroll to desired item and press RIGHT arrow 

 to store the change, then press DOWN 

arrow  to continue. 

f. At any time, you can press UP arrow  to 

go back, or LEFT arrow  to cancel the wizard.

QUICK START FLOW

TRANSDUCER

XRS-5

NEXT

BACK

EDITCANCEL

QUICK START FLOW

NO TRANSDUCER

XPS-10

XPS-15

XCT-8

XCT-12

XRS-5

TRANSDUCER

Start of QS
Flow Wizard

Select
transducer

Select
temperature
source

Select 
PMD

Set 
calculation method, 
level units, and 
setpoints

Set 
calculation factors
(vary by PMD)

Set
PMD dimensions 
(vary by PMD)

Set 
flow units and 
calibration data

Flow Wizard
complete

- Transducer - Temperature Source
- Fixed Temperature

- Primary Measuring 
Device

- Method of Flow 
Calculation

- Units
- High Calibration Point
- Low Calibration Point
- Response Rate

- Flow Exponent
- K Factor
- V-Notch Angle
- Slope
- Roughness Coefficient

- OCM Dimension 1
- OCM Dimension 2
- OCM Dimension 3
- OCM Dimension 4

- Maximum Head
- Zero Head Offset
- Flowrate Units
- Maximum Flow at 20 mA
- Flowrate Decimal
- Low Flow Cutoff
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Start of QS Flow Wizard

Shows the type of Wizard to be executed.

Transducer
Specifies the Siemens transducer connected to the device.

Temperature Source

Source of the temperature reading used to adjust the speed of sound.

See Temperature Source  on page 180 for more details.

Fixed Temperature

Source of the temperature reading used to adjust the speed of sound.

This parameter is only displayed if FIXED TEMPERATURE selected for Temperature 
Source.

Primary Measuring Device

Defines the primary measuring device (PMD) to be used in the application.

* Option will be set to OTHER if the wizard was run previously via HART software tool 
(such as SIMATIC PDM), and the device was set to OFF or UNIVERSAL HEAD VS. 
FLOW. If this is initial configuration, the PMD can only be set for no calculation (OFF), 
or for linearization (UNIVERSAL HEAD VS. FLOW) via HART software tools (SIMATIC 
PDM, AMS, FC375/475).

Method of Flow Calculation
Sets the method of flow calculation.

Note: The introduction screen is displayed only on the device when using the local 
push buttons. This screen is not part of the Quick Start when using SIMATIC PDM.

Options CANCEL, START

Options
NO TRANSDUCER, XRS-5, XPS-10, XPS-15, XCT-8, XCT-12, XPS-30, XPS-40, 
XLT-30, XLT-60, STH

Default: NO TRANSDUCER

Options
TRANSDUCER, FIXED TEMPERATURE, EXTERNAL TS-3, AVGERAGE OF 
SENSORS

Default: TRANSDUCER

Value
Range: -100.0 to +150.0 °C

Default: +20.0 °C

Options

EXPONENTIAL DEVICES, RECTANGULAR FLUME BS-3680, ROUND NOSE 
HORIZONTAL CR. BS-3680, TRAPEZOIDAL FLUME BS-3680, U-FLUME BS-
3680, FINITE CREST WEIR BS-3680, THIN PLATE RECT. WEIR BS-3680, THIN 
PLATE V-NOTCH WEIR BS-3680, RECT. WEIR CONTRACTED, ROUND PIPE, 
PALMER BOWLUS FLUME, H-FLUME, OTHER*

Default: EXPONENTIAL DEVICES

Options
ABSOLUTE, RATIOMETRIC

Default: ABSOLUTE
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Units

Sensor measurement units.

High Calibration Point
Distance from Sensor Reference Point to High Calibration Point: usually process full 
level.

Low Calibration Point
Distance from Sensor Reference Point to Low Calibration Point: usually process 
empty level.

Response Rate

Sets the reaction speed of the device to measurement changes in the target range.

Use a setting just faster than the maximum filling or emptying rate (whichever is 
greater). Slower settings provide higher accuracy, faster settings allow for more level 
fluctuations.

Options
M, CM, MM, FT, IN

Default: M

Note: For the purpose of this example, all values are assumed to be in meters (m).

Value
Range: 0.000 to 60.000

Default: 0.000

Value
Range: 0.000 to 60.000

Default: 60.000

Notes: 
• Response Rate can only be set through the Quick Start Wizard, and any 

changes made to Fill Rate per Minute (2.3.1.) or Empty Rate per Minute (2.3.2.) 
parameters following the completion of the wizard will supersede the Response 
Rate setting.

• Response Rate always displays in m/minute.

Options

SLOW (0.1 M/MIN)

MEDIUM (1.0 M/MIN)

FAST (10 M/MIN)

Default: SLOW (0.1 M/MIN)
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Calculation factors:

Flow Exponent 

(PMD = EXPONENTIAL DEVICES)
The exponent for the flow calculation formula. (See Method of Flow Calculation  on 
page 266.)

K Factor

(PMD = EXPONENTIAL DEVICES)
The constant used in the flow calculation formula for absolute calculation of an 
exponential device only.

V-Notch Angle

(PMD = THIN PLATE V-NOTCH WEIR)

The V-Notch angle used in the flow calculation formula.

Slope

(PMD = TRAPEZOIDAL FLUME or ROUND PIPE)

The Flow Slope used in the flow calculation formula.

Roughness Coefficient

(PMD = ROUND PIPE)

The Flow Roughness Coefficient used in the flow calculation formula.

Notes: 
• The following five parameters will display in the wizard based on the PMD 

selected above.
• These parameters are used in the flow calculation formula (see Method of Flow 

Calculation  on page 266).

Value
Range: -999.000 to 9999.000

Default: 1.550

Value
Range: -999.000 to 9999.000

Default: 1.000

Value
Range: 25.000 to 95.000

Default: 25.000

Value
Range: -999.000 to 9999.000

Default: 0.000

Value
Range: -999.000 to 9999.000

Default: 0.000
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PMD Dimensions

Notes: 
• For each PMD excluding Exponential Devices, and Other, you must enter up to 

four dimensions. 
• In the wizard, you will be prompted for each dimension required for the PMD 

selected, and the respective PMD dimension name will be displayed.

PMD selected Wizard dimension name (parameter menu reference)

Rectangular Flume BS-3680 

APPROACH WIDTH B (2.15.4.5. OCM Dimension 1)

THROAT WIDTH B (2.15.4.6. OCM Dimension 2)

HUMP HEIGHT P (2.15.4.7. OCM Dimension 3)

THROAT LENGTH L (2.15.4.8. OCM Dimension 4)

Round Nose Horizontal Crest Weir BS-3680 

CREST WIDTH B (2.15.4.5. OCM Dimension 1)

CREST HEIGHT P (2.15.4.6. OCM Dimension 2)

CREST LENGTH L (2.15.4.7. OCM Dimension 3)

Trapezoidal Flume BS-3680 

APPROACH WIDTH B (2.15.4.5. OCM Dimension 1)

THROAT WIDTH B (2.15.4.6. OCM Dimension 2)

HUMP HEIGHT P (2.15.4.7. OCM Dimension 3)

THROAT LENGTH L (2.15.4.8. OCM Dimension 4)

U-Flume BS-3680 

APPROACH DIAMETER DA (2.15.4.5. OCM Dimension 1)

THROAT DIAMETER D (2.15.4.6. OCM Dimension 2)

HUMP HEIGHT P (2.15.4.7. OCM Dimension 3)

THROAT LENGTH L (2.15.4.8. OCM Dimension 4)

Finite Crest Weir BS-3680 

CREST WIDTH B (2.15.4.5. OCM Dimension 1)

CREST HEIGHT P (2.15.4.6. OCM Dimension 2)

CREST LENGTH L (2.15.4.7. OCM Dimension 3)

Thin Plate Rectangular Weir BS-3680 

APPROACH WIDTH B (2.15.4.5. OCM Dimension 1)

CREST WIDTH B (2.15.4.6. OCM Dimension 2)

CREST HEIGHT P (2.15.4.7. OCM Dimension 3)

Rectangular Weir Contracted

CREST WIDTH B (2.15.4.5. OCM Dimension 1)

Round Pipe

PIPE INSIDE DIAMETER D (2.15.4.5. OCM Dimension 1)
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Maximum Head

The maximum level value associated with the PMD.

Zero Head Offset
The difference (positive or negative) between Low Calibration Point and zero head 
(level at zero flow).

Flowrate Units

The volume units used to display total flow.

* If USER DEFINED option selected, the value must be set after completing the 
wizard. See 2.15.3.8. User Defined Unit on page 194.

Maximum Flow at 20 mA

The maximum flowrate.

Flowrate Decimal

The maximum number of decimal units to be displayed.

Low Flow Cutoff

Eliminates totalizer activity for head levels at or below the cutoff value.

PMD selected (cont’d) Wizard dimension name (parameter menu reference)

Palmer Bowlus Flume

MAXIMUM FLUME WIDTH HMAX (2.15.4.5. OCM Dimension 1)

H-Flume

MAXIMUM LISTED HEAD HMAX (2.15.4.5. OCM Dimension 1)

Value
Range: 0.000 to 60.000

Default: 60.000

Value
Range: -60.000 to 60.000

Default: 0.000

Options
L/S, L/MIN, CUFT/S, CUFT/D, GAL/MIN, GAL/D, IMPGAL/MIN, IMPGAL/D, 
CUM/H, CUM/D, MMGAL/D, USER DEFINED *

Default: L/S

Value
Range: -999 to 9999999

Default: 100

Options
NO DIGITS, 1 DIGIT, 2 DIGITS, 3 DIGITS

Default: NO DIGITS

Value
Range: 0.000 to 60.000

Default: 0.000
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End of QS Flow Wizard

For QS to be successful, all changes must be applied.

To transfer Quick Start values to the device and return to Program menu, press 

DOWN arrow  (Finish). Then press LEFT arrow  three times to return to 

Measurement mode.

Options
BACK, CANCEL, FINISH (Display returns to 1.1.1 Quick Start menu when Quick 
Start is successfully completed or cancelled. If CANCEL is selected, no 
changes are written to the device.)

Note: It is strongly recommended that an Auto Zero Head be performed after 
completion of the wizard to ensure best accuracy. See 2.15.2. Auto Zero Head on 
page 190.
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1.2. Pump Control
Use this wizard to configure pumps if they will be used in your application. Be sure to 
first complete the applicable Quick Start Wizard.

a. Press RIGHT arrow  to activate PROGRAM mode and open menu level 1: MAIN 
MENU. 

b. Press RIGHT arrow  to navigate to menu item 1.1.

c. Press DOWN arrow  and RIGHT arrow  to open Pump Control. 

d. At each step, press DOWN arrow  to accept default values and move directly to 
the next item, 

or RIGHT arrow  to open Edit mode: the current selection is highlighted. 

e. Scroll to desired item and press RIGHT arrow  to store the change, then press 

DOWN arrow  to continue. 

f. At any time, you can press UP arrow  to go back, or LEFT arrow  to cancel 
the wizard.

Start of Wizard - Pump Control

Shows the type of Wizard to be executed.

Number of Pumps

Select the number of pumps to be used with pump control.

If set to NONE, pump control is disabled.

Relay Pump 1

Selects the relay assigned to Pump 1.

Relay Pump 2
View only. Automatically sets the relay assigned to Pump 2 based on relay selected 
for Pump 1 in previous step.

Note: The introduction screen is displayed only on the device when using the local 
push buttons. This screen is not part of the Quick Start when using SIMATIC PDM.

Options CANCEL, START

Options
NONE, 2

Default: NONE

Options
RELAY 2, RELAY 3

Default: RELAY 2

Options 
(view only)

If Relay Pump 1 = RELAY 2, then Relay Pump 2 = RELAY 3

If Relay Pump 1 = RELAY 3, then Relay Pump 2 = RELAY 2
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Pump Control Mode

Sets the control algorithm used to trip the relay.

See Pump Control Mode 2.7.1.4. on page 151 for descriptions of each.

Service Ratio Pump 1

Selects pump usage based on the RUN time ratio rather than last used.

This parameter displays only if a Service Ratio algorithm is selected for Pump Control 
Mode.

Service Ratio Pump 2
Selects pump usage based on the RUN time ratio rather than last used.

This parameter displays only if a Service Ratio algorithm is selected for Pump Control 
Mode.

Run Time Relay 2
Set the amount of time that pump Relay 2 has run, defined in hours.

Use the default value for new pumps, or set this value for existing pumps with 
accumulated run time. (This parameter displays only if a Service Ratio algorithm is 
selected for Pump Control Mode.)

Run Time Relay 3

Set the amount of time that pump Relay 3 has run, defined in hours.

Use the default value for new pumps, or set this value for existing pumps with 
accumulated run time. (This parameter displays only if a Service Ratio algorithm is 
selected for Pump Control Mode.)

Options 
supported 
per model

LUT420 Level Controller:
ALTERNATE DUTY ASSIST, ALTERNATE DUTY BACKUP

LUT430 Pump and Flow Controller:
ALTERNATE DUTY ASSIST, ALTERNATE DUTY BACKUP, SERVICE RATIO 
DUTY ASSIST, SERVICE RATIO DUTY BACKUP, FIXED DUTY ASSIST, FIXED 
DUTY BACKUP

LUT440 High Accuracy OCM: 
ALTERNATE DUTY ASSIST, ALTERNATE DUTY BACKUP, SERVICE RATIO 
DUTY ASSIST, SERVICE RATIO DUTY BACKUP, FIXED DUTY ASSIST, FIXED 
DUTY BACKUP

Default (all models): ALTERNATE DUTY ASSIST

Value
Range: 0 to 255

Default: 1

Value
Range: 0 to 255

Default: 1

Value
Range: 0 to 999999

Default: 0

Value
Range: 0 to 999999

Default: 0
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ON Setpoint Pump 1
The level at which Pump 1 turns ON, defined in 2.1.1. Units.

ON Setpoint Pump 2

The level at which Pump 2 turns ON, defined in 2.1.1. Units.

OFF Setpoint Pump 1

The level at which Pump 1 turns OFF, defined in 2.1.1. Units.

OFF Setpoint Pump 2

The level at which Pump 2 turns OFF, defined in 2.1.1. Units.

End of Wizard - Pump Control

For Wizard to be successful, all changes must be applied.

To transfer values to the device and return to Program menu, press DOWN arrow  

(Finish). Then press LEFT arrow  two times to return to Measurement mode.

Value
Range: 0.000 to 99999.000

Default: 0.000

Value
Range: 0.000 to 99999.000

Default: 0.000

Value
Range: 0.000 to 99999.000

Default: 0.000

Value
Range: 0.000 to 99999.000

Default: 0.000

Options
BACK, CANCEL, FINISH (Display returns to Pump Control menu when Wizard 
is successfully completed or cancelled. If CANCEL is selected, no changes are 
written to the device.)
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Requesting an Echo Profile
• In PROGRAM mode, navigate to: Main Menu > Diagnostics (3.2.) > Echo Profile 

(3.2.1.).

• Press RIGHT arrow  to request a profile.

• Use UP  or DOWN arrow  to scroll to an icon. When an icon is highlighted, 

that feature becomes active.

• To move a cross-hair, press RIGHT arrow  to increase the value, LEFT arrow 

 to decrease.

• To Zoom into an area, position the intersection of the cross-hairs at the center of 

that area, select Zoom, and press RIGHT arrow . Press LEFT arrow  to Zoom 

out.

• To update the profile, select Measure and press RIGHT arrow .

• To return to the previous menu, select Exit then press RIGHT arrow .

Device Address
Setting a device address is not necessary for local operation, but must be set if 
configuring the SITRANS LUT400 for use on a HART network. See Device Address 4.1. on 
page 216.

Testing the configuration
After programming the device, it is recommended that you test the device to ensure that it 
performs to your specifications. This test can be run in simulation mode or by varying the 
actual level in the application. The latter is preferred as it more accurately represents 
running conditions. However, if it is not possible to do a physical test, a simulation will 
ensure that control programming is correct. For further details, see Simulation  on page 
120, and Application test  on page 123.

C: 38 A: BLF D: 9.00

DB

0 2.0 4.0 6.0
0

50

100

algorithm2: BLF (Best of First or Largest echo)
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distance from transducer face to target

TVT 
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measure
exit 

zoom

pan left/right - selected
pan up/down
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1. See Confidence (3.2.9.2.) on page 203.

2. See Algorithm (2.12.2.1.) on page 181.
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Application examples
In the examples that follow, substitute your own application details. If the examples do 
not apply to your application, check the applicable parameter reference for the available 
options.

Level Application Example

The application is a vessel that takes an average 3 hours (180 minutes) to fill and 3 weeks 
to empty.

Fill rate =  (Low Cal Pt. – High Cal Pt.) / fastest of fill or empty time
= (15.5 m – 1 m) / 180 min. 
= 14.5 m /180 min. = 0.08 m/min.

Quick Start Parameter Setting Description 
Transducer XPS-15 Transducer to be used with the LUT400.

Operation LEVEL Material level referenced from Low Cal. Point.

Temperature Source TS-3 Temperature source.

Units M Sensor measurement units.

High Calibration Point 1.0 Process full level.

Low Calibration Point 15.0 Process empty level.

Response Rate SLOW Sets Fill Ratea/ Empty Rate to 0.1 m/minute.

a. See Fill Rate per Minute 2.3.1. on page 142.

sensor reference point 

level 
6.5 m

Low Cal. Point

High Cal. Point

15.0 m

1.0 m

Far Range

space
7.5 m

distance
8.5 m
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Flow application example

Parshall Flume

In this example, a 12 inch (0.305 m) Parshall Flume has been installed in an open channel. 
As per the supplier’s data sheet, the device has been rated for a maximum flow of 1143 m3 
per hour at a maximum head of 0.6 m. 

The Parshall Flume is considered an exponential device, therefore the supplier’s data 
sheet includes a flow exponent value of 1.522. 

The SITRANS LUT400, and the XRS-5 transducer have been installed 1.6 m above the 
channel beside the TS-3 external temperature sensor.

During intermittent peak flow times, the head level can be expected to rise at a rate of 
approximately 0.12 m/minute. The application also calls for a flow sampler to be activated 
every 1000 m3, or 24 hours (whichever comes first), and for a fail-safe alarm to activate in 
the event of a loss of echo or cable fault.

Q

C

 2/3 C

Zero
Head

Front View

Plan View

transducer

Side View

Low Cal. 
= 1.6 m

XRS-5

Head 
= 0.6 m

TS-3

High Cal. 
= 1.0 m

C = Converging dimension
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Initial device setup

Fail-safe Alarm setup

Quick Start Parameter Setting/
Value Description 

Transducer XRS-5
For best accuracy, an XRS-5 transducer should 
be used in conjunction with the High Accuracy 
SITRANS LUT440.

Temperature Source TS-3
For best accuracy, a TS-3 external temperature 
sensor is required.

Primary Measuring Device 
(PMD)

Exponential Parshall Flumes are a type of exponential device.

Flow Exponent 1.522 Available from the PMD supplier data sheet.

Units m Units corresponding to the head measurement.

Low Calibration Point 1.6
The distance to the empty point or bottom of the 
flume. This sets the 4 mA setpoint.

High Calibration Point 1.0
The distance to the Max. Head. This sets the 20 
mA setpoint.

Response Rate
Medium
(1.0 m/min)

Response rate is set to be faster than the fastest 
rise in material level under typical operating con-
ditions. In this example, the rate is faster than the 
Peak Time rate provided by the end user.

Method of Flow Calculation Ratiometric
Used when the Max. Head and Max. Flow values 
are provided.

Maximum Head 0.6 m Available from the PMD supplier data sheet.

Flowrate Units Cum/hr Set per end user requirements.

Maximum Flow at 20 mA 1143 Available from the PMD supplier data sheet.

Flowrate Decimal No Digits
For the purpose of this example, decimals are 
not required.

Low Flow Cutoff 0.00

This parameter stops the LUT440 from totalizing 
if the head value corresponding to low flow is 
reached. This prevents flow from being totalized 
when the head level reaches the ineffective point 
of the PMD. Refer to the PMD data sheets for 
ratings.

Continue with alarm setup below.

Parameter Setting/
Value Description 

Enable (2.8.8.1.) Enabled
By selecting Enabled, the fail-safe alarm is now 
activated.

Assigned Relay (2.8.8.2.) Relay 1
Select relay to be used for fail-safe alarm. 
Relay 1 is the dedicated alarm relay for the 
LUT400.

Continue with sampler setup on next page.
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External Sampler setup

Parameter Setting/
Value Description 

Enable (2.11.4.1.) Enabled
By selecting Enabled, the external sampler is 
now activated.

Multiplier (2.11.4.2.) 1000

In this example, the LUT440 will activate the 
external sampler every 1000 flow units (Flowrate 
Units defined above during initial application 
setup).

Interval (2.11.4.3.) 24

In low flow conditions where the sampler may 
not activate for extended periods of time, a relay 
interval can be programmed to allow for sampler 
activation after a defined number of hours. In 
this example, activation should occur every 24 
hours.

Relay Duration (2.11.4.4.) 0.2
Duration of time in seconds that the relay will 
energize or "tick".

Assigned Relay (2.11.4.5.) Relay 2
Relay 2 has been selected for control in this 
example as relay 1 has been allocated to the 
Fail-safe alarm.

Relay Logic (2.11.4.6.)
Normally 
Open

Default for control relay functions is Normally 
Open. In this example, relay 2’s coil will be Nor-
mally Open, and will close for 0.2 seconds.
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Notes
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General Operation

This chapter provides details on the general operation and functionality of the SITRANS 
LUT400. For instructions on the use of the device LCD and local push buttons, refer to The LCD 
Display  on page 34.

Starting measurement
The SITRANS LUT400 is a single point device. The device starts in LEVEL mode with a 
preset of no transducer and a low calibration point of 60 meters. Change the following 
common parameters to reflect your application.

Measurement conditions
The following information will help you configure your SITRANS LUT400 for optimal 
performance and reliability.

Response Rate
The response rate of the device influences the measurement reliability. Use the slowest 
rate possible with the application requirements. 

Dimensions
Dimensions of the vessel, wet well, or reservoir (other than low and high calibration 
points) are only important if you require volume readings. In this case, all dimensions are 
used to calculate the volume value in terms of level. They are also used to calculate 
pumped volume.

Fail-safe
The fail-safe parameters ensure that the devices controlled by the SITRANS LUT400 
default to an appropriate state when a valid level reading is not available. (See list of 
faults that result in fail-safe in General Fault Codes  on page 231.)

Parameter Sample Value
2.1.2. Sensor Mode LEVEL

 Response Rate
(set via QS Level  on page 39)

MEDIUM

2.1.6. Transducer XPS-15
2.1.1. Units M

2.2.1. Low Calibration Point 12
2.2.2. High Calibration Point 2

Note: Changes to fill and empty rate parameters can override Response Rate 
setting. See “Response Rate” on page 42.
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• 2.4.2. LOE Timer activates if an error condition is detected. Upon expiration of the 

timer, the mA output value and the relay status default to values based on 2.4.1. 
Material Level.

• The fail-safe 2.4.1. Material Level determines the mA output if the 2.4.2. LOE Timer 
expires and the device is still in an error condition.

If fail-safe operation activates frequently, see Diagnosing and Troubleshooting  on page 
229.

Relays
Relays are the primary controls of external devices such as pumps or alarms. The 
SITRANS LUT400 comes with extensive control and alarm functions described below.

General introduction 
Three relays are provided on the SITRANS LUT400. Each relay may be independently 
assigned to one function (one or more functions for alarms), and has a corresponding 
status icon on the LCD.

Relay contact operation is NORMALLY CLOSED for alarms and NORMALLY OPEN for controls.

In software, all relays are programmed the same way, with ON setpoints indicating when to 
change the relay contact state (open or closed). Some parameters allow the reversal of the 
operation so that relay contacts can be NORMALLY CLOSED or NORMALLY OPEN (for 
example, when assigned to an alarm).

Mode Function (in normal state)

alarm alarm ON = LCD icon ON = relay coil de-energized

pump pump ON = LCD icon ON = relay coil energized

miscellaneous contact closed = LCD icon ON = relay coil energized

Options

Default Alarm Contact Pump or Control Contact

* Normally Closed Normally Open

Normally Open Normally Closed

SITRANS LUT400 1/2
MLEVEL

5 SAVING PARAMETERS

1 1 23
18.91

Relay icons: 
Relay 1, 3 programmed
Relay 2 not programmed*

Relay 1 active
Relay 3 inactive

Discrete Input icons:
DI 1, 2 programmed
DI 1 off
DI 2 on

*Icon will not display for relay or DI that is not programmed.
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Relay function 

Alarm

Level 

In high alarm, the alarm state becomes active when the level rises to High Level Value 
ON and inactive when it falls below High Level Value OFF. In low alarm, the alarm state 
becomes active when the level falls to Low Level Value ON and inactive when the level 
rises above Low Level Value OFF. 

In-bounds

The relay alarm becomes active if the level is inside a user-defined range. 

Out-of-bounds

The relay alarm becomes active if the level is outside a user-defined range. 

Temperature

In high alarm, the alarm state becomes active when the temperature rises to High 
Temperature Value ON and inactive when the temperature falls below High Temperature 
Value OFF. In low alarm, the alarm state becomes active when the temperature falls to 
Low Temperature Value ON and inactive when the temperature rises above Low 
Temperature Value OFF.

Switch (Discrete Input)

The relay alarm state associated with the discrete input becomes active when the 
discrete input is in a user-defined state.

Fail-safe fault

The relay alarm state becomes active when a fault that has caused a fail-safe condition 
is present. The relay alarm state becomes inactive when no faults that cause fail-safe are 
present.

Flowrate

Available for LUT440 (OCM) model only. 
In high alarm, the alarm state becomes active when the flowrate exceeds High Flowrate 
Value ON and inactive when the flowrate falls below High Flowrate Value OFF. In low 
alarm, the alarm state becomes active when the flowrate falls below Low Flowrate Value 
ON and inactive when the flowrate rises above Low Flowrate Value OFF.

Pump

Setpoint - ON / OFF 

If the ON setpoint is higher than the OFF setpoint, the relay operates as: 

• pump down control 

If the ON setpoint is lower than the OFF setpoint, the relay operates as: 

• pump up control 
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Miscellaneous 

Totalizer and samplers

Refer to Other Pump Controls  on page 87. Relays are normally de-energized, contact 
closure is approximately 200 ms duration. 

Relay behaviour under fail-safe conditions
A fail-safe condition generally indicates that the level reading is not reliable or is unknown. In 
such a situation, pumps will not run and alarms (that are based on level or a derivative 
reading) will not activate. The following describes this behaviour in detail, by relay function.

Alarm relays

Any alarm that is based on level, or a reading derived from level such as flow rate, will not 
activate if there is a fail-safe condition. If the fail-safe condition occurs and the alarm is 
already active, the alarm will de-activate. 

The following alarm types will de-activate during a fail-safe condition: 

• High Level
• Low Level
• In-bounds Level
• Out-of-bounds Level
• High Flow Rate
• Low Flow Rate. 

Pump relays

If a pump cycle is in progress at the time the fail-safe condition occurs, then the pump cycle 
will end prematurely (as if the 'off' setpoints were reached). This has the effect of turning off all 
pumps immediately. If a pump run-on occurrence was scheduled for the pump cycle, it will not 
occur. However, if a pump run-on occurrence has already begun at the time the fail-safe 
condition occurs, then the run-on will complete. 

If no pump cycle is in progress at the time the fail-safe condition occurs, then subsequent 
pump cycles will not occur (the fail-safe condition will prevent pumps from starting), until the 
fail-safe condition is cleared.

Miscellaneous relays

External Totalizer relay

If the external totalizer is in the process of recording volume (i.e. the relay is clicking) when a 
fail-safe condition occurs, then the current series of clicks will be allowed to complete. 

When totalizing volume:
Since pumps do not run when in fail-safe, then the external totalizer will in general not 
operate either. If a fail-safe condition occurs during a pump cycle then the volume 
pumped for that cycle will not be totalized. 

Note: A dedicated alarm exists for fail-safe condition as described above. See Fail-
safe fault  on page 65.
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When totalizing OCM flow:
The flow totalizers continue to operate during a fail-safe condition, thus the external 
totalizer relay will also continue to operate. 

External Sampler relay

The External Sampler relay operates the same as the External Totalizer relay described above. 
The periodic timeout-click will also continue to occur in fail-safe. 

Communications relays

Relays controlled by communications (HART) are not affected by a fail-safe condition. 

Relay states
The relays on the SITRANS LUT400 are programmable, allowing for many control 
schemes.

Relay output logic

Affects relay reaction. Reverses the logic (normally-open to normally-closed or vice 
versa). Relay logic can be modified separately for alarms, and controls. (Logic for pumps 
cannot be reversed.)

Relay related parameters
Some parameters affect how relays react during normal conditions: 

Setpoints

When a setpoint is reached, the corresponding action is taken. The setpoint can be an 
ON or OFF setpoint related to a process variable, or a timed setpoint based on interval 
and duration.

Relay Types
Relay 1 – NO / NC (Form C)
Relay 2,3 – NO (Form A)

Function Parameter

2.8.11. Relay Logic for 2.8. Alarms
2.8.11.1. Relay 1 Logic
2.8.11.2. Relay 2 Logic
2.8.11.3. Relay 3 Logic

2.11. Other Control

2.11.1. Elapsed Time Relay 2.11.1.5. Relay Logic
2.11.2. Time of Day Relay 2.11.2.5. Relay Logic
2.11.3. External Totalizer 2.11.3.5. Relay Logic
2.11.4. External Sampler 2.11.4.6. Relay Logic
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1. ON and OFF Setpoints

Sets the process point at which the relay is activated (ON setpoint) then reset (OFF 
setpoint). These setpoints are set separately for each pump within each pump control, 
and for each alarm type:

2. Timed Setpoints

Timed setpoints are based on interval, duration, or time of day. These setpoints are set 
separately for each pump within each pump control, and for each non-pump control 
function:

Function Parameter

2.7. Pumps 2.7.1. Basic Setup

2.7.1.6. ON Setpoint Pump 1
2.7.1.7. OFF Setpoint Pump 1
2.7.1.8. ON Setpoint Pump 2
2.7.1.9. OFF Setpoint Pump 2

2.7.2. Modifiers 
(for 2.7. Pumps)

2.7.2.2. Energy Savings

2.7.2.2.13. Peak ON Setpoint Pump 1
2.7.2.2.14. Peak OFF Setpoint Pump 1
2.7.2.2.15. Peak ON Setpoint Pump 2
2.7.2.2.16. Peak OFF Setpoint Pump 2

2.8. Alarms

2.8.1. High Level Alarm
2.8.1.2. High Level Value ON 
2.8.1.3. High Level Value OFF

2.8.2. Low Level Alarm
2.8.2.2. Low Level Value ON 
2.8.2.3. Low Level Value OFF

2.8.4. In-bounds Level 
Alarm

2.8.4.2. High Level Value
2.8.4.3. Low Level Value

2.8.5. Out-of-bounds 
Level Alarm

2.8.5.2. High Level Value
2.8.5.3. Low Level Value

2.8.6. Low Temperature 
Alarm

2.8.6.2. Low Temperature Value ON
2.8.6.3. Low Temperature Value OFF

2.8.7. High Tempera-
ture Alarm

2.8.7.2. High Temperature Value ON 
2.8.7.3. High Temperature Value OFF

2.8.9. High Flowrate 
Alarm

2.8.9.2. High Flowrate Value ON 
2.8.9.3. High Flowrate Value OFF

2.8.10. Low Flowrate 
Alarm

2.8.10.2. Low Flowrate Value ON
2.8.10.3. Low Flowrate Value OFF

Function Parameter

2.7.2. Modifiers 
(for 2.7. Pumps)

2.7.2.3. Pump Run-On
2.7.2.3.2. Run-On Interval
2.7.2.3.3. Run-On Duration Pump 1
2.7.2.3.4. Run-On Duration Pump 2

2.7.2.4. Pump Start 
Delays

2.7.2.4.1. Delay Between Starts
2.7.2.4.2. Power Resumption Delay

2.11. Other Control

2.11.1. Elapsed Time 
Relay

2.11.1.2. Interval
2.11.1.3. Relay Duration

2.11.2. Time of Day 
Relay

2.11.2.2. Activation Time
2.11.2.3. Relay Duration

2.11.3. External Totalizer 2.11.3.3. Relay Duration

2.11.4. External Sampler
2.11.4.3. Interval
2.11.4.4. Relay Duration
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Relays controlled by HART Communications
A relay can be controlled directly by a remote system through communications. HART 
commands can be used for this purpose. An expert knowledge of HART, and the use of 
HART commands is recommended. For further details on configuring relays controlled by 
HART, contact your Siemens representative.

Discrete Inputs
SITRANS LUT400 has two discrete inputs to trigger or alter the way SITRANS LUT400 controls 
devices. A Backup Level Override, Pump Interlock, or a Switch (DI) Alarm can be configured 
using discrete inputs, and discrete input logic can be reversed if necessary for the application.

Backup Level Override
Backup level override provides the option of overriding the ultrasonic input (signal from a 
transducer) with another contacting point level device, such as the Pointek CLS200, to 
determine the level output. 

The material reading is fixed at the programmed switch level until the discrete input is 
released. The LUT400 makes its decisions based on the override value.

Backup Level Override functionality is particularly useful in wet-wells and reservoirs that 
use pumps:

• place a backup level switch high in a vessel to indicate when it is about to overflow
• place a backup level switch low in a vessel, to indicate when it is almost empty.

Basic operation
Configuring Backup Level Override involves three steps (see 2.9.1. Backup Level Override).

1. Select a level override value. This will be the Level output produced by the 
instrument when the backup level override condition is present. 

2. Select the discrete input that is connected to the point-level device.
3. Enable the Backup Level Override function.

It may also be necessary to invert the logic of the discrete input, which is possible through the 
LUT400 discrete input logic parameters (see 2.9.2. Discrete Input Logic).

Backup Level Override parameters 
Example:

SITRANS LUT400 is configured for a level measurement. In the same application, 
Discrete Input 2 is connected to a Hi Level Backup switch at a level value of 4.3 m.

Note: A backup level override will prevent a fail-safe condition from occurring.
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Settings

When the level rises to 4.3 m and the switch is activated, the reading is forced to 4.3 m
where it stays until the switch is de-activated.

Level Override conditions
When the discrete input activates, the level output will immediately take on the value chosen 
in step 1 above. The LUT400 LCD will indicate that the discrete input has been activated. 

When a Backup Level Override condition clears (the discrete input is deactivated), the level 
will return to the value determined from the ultrasonic transducer or, if no echo is available, the 
device will enter the fail-safe condition.

Affect of Backup Level Override
The level produced by a Backup Level Override condition completely replaces the level that 
would otherwise be produced by normal echo processing algorithms. This means that the 
Backup Level will: 

• drive all readings that depend on Level (for example: space, distance, and flow)
• drive level alarms
• appear in system logs
• affect pump control
• affect totalizers (OCM and Pumped Volume) 

Additional considerations
A Backup Level Override condition will prevent a fail-safe condition from occurring: when a 
backup level override condition is present, a fail-safe response will never occur. This allows 
pumps and other controls such as level alarms to be active even during the backup level 
override condition. 

Pump Interlocks
Discrete inputs can be used to supply pump information to the SITRANS LUT400 to set 
actions that will occur when a pump is determined to be in a failed state.

For an example of how to configure a pump interlock, see Pump Control Interlocks  on 
page 87.

Switch (DI) Alarm
An alarm can be set to activate based on the state of a discrete input. See Switch (DI) 
Alarm  on page 70 for an example.

Parameter Sample Value
2.9.1.2. Level Override Value 4.3
2.9.1.3. Discrete Input Number DISCRETE INPUT 2
2.9.1.1. Enable ENABLED
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Discrete Input Logic
Discrete input logic affects the reaction of the discrete input. Normal state is standard 
operation, with the SITRANS LUT400 sensing the material level and controlling the 
pumps.

The contacts of the signalling device connected to the discrete inputs may be normally-
open or normally closed.

Example:

Normal state for a backup high level switch is open, and the contacts on the discrete 
input are wired as normally open.

This logic can also be reversed (NORMALLY OPEN to NORMALLY CLOSED or vice versa). 
Use the Discrete Input logic parameters to set the state of each discrete input.

Read the current state of discrete input 1 in 2.9.2.2. Discrete Input 1 Scaled State and the 
current state of discrete input 2 in 2.9.2.4. Discrete Input 2 Scaled State.

See Discrete inputs  on page 28 for complete details on wiring the discrete inputs. To 
override a level using a discrete input, see 2.9.1. Backup Level Override  on page 171.

Function Parameter

2.9. Discrete Inputs
2.9.2. Discrete Input Logic 2.9.2.1. Discrete Input 1 Logic

2.9.2.3. Discrete Input 2 Logic

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 72 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

G
en

er
al

 O
pe

ra
tio

n

mA Control

mA output
The SITRANS LUT400 has one mA output, used for communications with other devices.

Example:

Configuring the mA output to send a 4 to 20 mA signal corresponding to a scaled value of 
10% to 90% of maximum process level on a 60 m transducer:

Verifying the mA range
Checks that the external device can track the entire 4 to 20 mA range sent by the SITRANS 
LUT400. Follow the steps below if actual mA readings differ between the LUT400 (shown in 
2.5.8. Current Output Value) and an external device (such as a PLC).

1. To test the loop current, set 2.5.1. Current Output Function to Manual, then set the 
value to use in 2.5.7. Manual Value.

2. Check that the external device displays the same mA reading as the mA value set 
above.

3. If external device reading differs from the set manual value on the LUT400, adjust 
the reading on the external device to match the reading on the LUT400.

Parameter Sample 
Value Description

2.5.1. Current Output 
Function or 2.5.2. Cur-
rent Output Function

LEVEL send mA proportional to level reading

2.5.3. 4 mA Setpoint 6 set 4 mA at process level equal to 10% of maximum 
(Low Cal minus High Cal)a

a. If the level reading drops below 6 m, the mA output drops below 4 mA.

2.5.4. 20 mA Setpoint 54 set 20 mA at process level equal to 90% of maxi-
mum (Low Cal minus High Cal)b

b. If the level reading rises above 54 m, the mA output rises above 20 mA.

2.5.5. Minimum mA 
Limit

3.5 set minimum mA level below 4 mA

2.5.6. Maximum mA 
Limit

22.8 set maximum mA level above 20 mA

Note: If default values (4 and 20 mA) are used for the minimum and maximum mA 
limits, the mA output (shown in 2.5.8. Current Output Value) will remain at the set 
mA limit, even if the level reading falls below/rises above the mA setpoints.
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Volume
Volume is used in two situations:

1. Calculate and display volume instead of level. 
2. Calculate pumped volume to accomplish the following:

• Totalize the volume of material that is pumped out of the wet well

Readings
When using volume, readings are given in units specified in 2.6.2. Volume Units.

Vessel Shape and Dimensions
There are many common vessel shapes to select from. (See 2.6.1. Vessel Shape. If 
possible, use one of these.) Each vessel shape uses the2.2.1. Low Calibration Point in its 
calculations of volume.

Some vessel shapes also require extra dimensions to calculate the volume. Do not 
estimate these values. They must be correct to ensure the accuracy of your volume 
calculations.

Example:

To configure volume for a vessel with a half-sphere bottom, set 
the following:

Characterization chart
If you cannot use a pre-defined vessel, then use one of the universal vessel shapes and 
program the characterization curve.

1. Plot a volume to height chart. Usually a vessel supplier will provide this chart. 
However, if you have a custom-built vessel, then you will need access to complete 
drawings of the well or accurate measurements.

Parameter Sample 
Value Description

2.6.1. Vessel Shape HALF SPHERE 
BOTTOM

selects the correct vessel shape

2.6.3. Maximum Volume 100 sets maximum volume at 100 (defined in 
2.6.2. Volume Units)

2.6.4. Dimension A 1.3 sets dimension A to 1.3 m

Notes: 
• The default reading changes to a range from 0 to 100
• The process empty value is still measured to the bottom of the vessel (2.2.1. 

Low Calibration Point plus any 2.2.5. Far Range value), not the top of 
Dimension A.

Dimension A
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2. Enter the curve values from this chart into level and volume breakpoint tables (see 

2.6.7. Table 1-8). 

3. Ensure extra points are added around sharp transitions in the vessel volume (e.g: 
steps in a well wall).

Example chart (with 15 of possible 32 Level and Volume breakpoints defined):

Note: If breakpoints are entered via LUI, then an upload is performed via PDM, a 
second upload via PDM may be necessary to transfer the breakpoint values.

Note: The end points in the curve are 0,0 (fixed) and the point defined by 
Maximum Level and Maximum Volume. 

Parameter Value Description
2.6.7.1. Level 1 0.0

Determines the Level breakpoints at which 
the volumes are known.

Level 2 0.8
Level 3 2.0
Level 4 3.5
Level 5 4.1
Level 6 4.7
Level 7 5.1
Level 8 5.2
Level 9 5.3
Level 10 5.4
Level 11 5.5
Level 12 5.6
Level 13 6.0
Level 14 7.2
Level 15 9.0

LEVEL 
Breakpoints

0,0

VO
LU

M
E 

Br
ea

kp
oi

nt
s

MAX VOLUME 

MAX LEVEL
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2.6.7.2. Volume 1 0.0

Determines the volumes which correspond 
to the level breakpoints. The universal 
calculations interpret between the 
breakpoints to produce an accurate model of 
the volume at all level readings.

Settings
2.6.1. Vessel Shape = LINEAR TABLE for 
linear approximation 
2.6.1. Vessel Shape = CURVE TABLE for 
curved approximation

Linear approximation uses a linear 
algorithm; curved approximation uses a 
cubic spline algorithm.

Volume 2 2.1
Volume 3 4.0
Volume 4 5.6
Volume 5 5.9
Volume 6 6.3
Volume 7 6.7
Volume 8 7.1
Volume 9 7.8
Volume 10 8.2
Volume 11 8.8
Volume 12 9.2
Volume 13 10.9
Volume 14 13.0
Volume 15 15.0

Parameter Value Description
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Alarms
Set the common parameters 

Prerequisite: You must know the details of your application and substitute the values for 
the sample values provided. If you are bench testing the device, then set your test values 
to be the same as the sample values.

Level
The level alarm is the most common. Use this alarm to warn you when your process is in 
danger of being upset due to high or low levels.

High level and low level alarms can be set to activate when the material level rises above 
or falls below a set level. (See 2.8.1. High Level Alarm, 2.8.2. Low Level Alarm.)

Example: Setting a High Level Alarm

To assign Relay 3 to a high level alarm that activates when the level rises above 10 m:

1. Enable the High Level Alarm (set 2.8.1.1. Enable = Enabled)
2. Set 2.8.1.2. High Level Value ON = 10 m

Parameter Sample Value
2.1.2. Sensor Mode (for Level)
or 
2.1.3. Sensor Mode (for Flow)

LEVEL
FLOW

 Response Rate MEDIUM
2.1.6. Transducer XPS-10
2.1.1. Units (for Level Alarms)
2.15.3.7. Flowrate Units (for Flowrate Alarms)

M
L/S

2.2.1. Low Calibration Point 1.8
2.2.2. High Calibration Point 0.4

Note: When configuring alarms, more than one alarm can be assigned to the 
same relay.

High Cal. Point

Low Cal. PointLow Level Value

High Level
Value

material level
reading 1.8 m

0.4 m
sensor 
reference point

level
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3. Set 2.8.1.3. High Level Value OFF = 9 m
4. Set 2.8.1.4. Assigned Relay to Relay 3

Use the High Level alarm in conjunction with 2.8.12. Time To Spill feature. See page 170.

Example: Setting a Low Level Alarm

To assign Relay 3 to a low level alarm that activates when the level falls below 2 m:

1. Enable the Low Level Alarm (set 2.8.2.1. Enable = Enabled)
2. Set 2.8.2.2. Low Level Value ON = 2
3. Set 2.8.2.3. Low Level Value OFF = 3
4. Set 2.8.2.4. Assigned Relay to Relay 3

In-bounds/ Out-of-bounds Range
Use the bounded range alarms to detect when the level is inside or outside of the range. 

Example: Setting an In-bounds Level Alarm

To assign Relay 3 to an in-bounds level alarm do the following:

1. Enable the In-bounds Level Alarm (set 2.8.4.1. Enable = Enabled)
2. Set 2.8.4.2. High Level Value = 1.30 m
3. Set 2.8.4.3. Low Level Value = 0.30 m
4. Set 2.8.4.4. Assigned Relay to Relay 3.

Results:

• Activates alarm assigned to relay 3 when level is within range 0.3 to 1.3 m
• Resets alarm above 1.3 m or below 0.3 m
Use 2.8.4.5. Alarm State to view the current state of the In-bounds Level Alarm.

Example: Setting an Out-of-bounds Level Alarm

To assign Relay 3 to an out-of-bounds level alarm do the following:

1. Enable the Out-of-bounds Level Alarm (set 2.8.5.1. Enable = Enabled)
2. Set 2.8.5.2. High Level Value = 1.30 m
3. Set 2.8.5.3. Low Level Value = 0.30 m
4. Set 2.8.5.4. Assigned Relay to Relay 3.

Results:

• Activates alarm assigned to relay 3 when level is outside range 0.3 to 1.3 m
• Resets alarm below 1.30 m or above 0.30 m
Use 2.8.5.5. Alarm State to view the current state of the Out-of-bounds Level Alarm.

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 78 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

G
en

er
al

 O
pe

ra
tio

n

Temperature
Activates an alarm when the process temperature reaches a certain value (Low 
Temperature Value ON for Low Temperature Alarm or High Temperature Value ON for a 
High Temperature Alarm).

The temperature source can be the temperature sensor built into the transducer or an 
external TS-3, as set by  Temperature Source. (Temperature Source is set in the Quick 
Start Wizard, see page 39.)

Example: Setting a High Temperature Alarm

To assign Relay 3 to a high temperature alarm that activates when the temperature goes 
above 30 °C do the following:

1. Enable the High Temperature Alarm (set 2.8.7.1. Enable = Enabled)
2. Set 2.8.7.2. High Temperature Value ON = 30
3. Set 2.8.7.3. High Temperature Value OFF = 28
4. Set 2.8.7.4. Assigned Relay to Relay 3.
The high temperature alarm will not de-activate until the temperature falls to 28 °C.
Use 2.8.7.5. Alarm State to view the current state of the High Temperature Alarm.

Example: Setting a Low Temperature Alarm

To assign Relay 3 to a low level alarm that activates when the temperature falls below 
-10 °C do the following:

1. Enable the Low Level Alarm (set 2.8.6.1. Enable = Enabled)
2. Set 2.8.6.2. Low Temperature Value ON = -10
3. Set 2.8.6.3. Low Temperature Value OFF = - 8
4. Set 2.8.6.4. Assigned Relay to Relay 3.
Use 2.8.6.5. Alarm State to view the current state of the Low Temperature Alarm.

Switch (Discrete Input) Alarm
Activates an alarm when a discrete input is in a pre-defined state.

Example: Setting a Switch Alarm

To assign Relay 3 to a switch alarm that is activated when DI 1 turns ON do the following:

1. Enable the Switch (Discrete Input) Alarm (set 2.8.3.1. Enable = Enabled)
2. Set the 2.8.3.2. Discrete Input Number = 1
3. Set 2.8.3.3. Discrete Input State to ON.
4. Set 2.8.3.4. Assigned Relay to Relay 3.
Use 2.8.3.5. Alarm State to view the current state of the Switch Alarm.
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Fail-safe Fault Alarm
Activates an alarm when a fault that has caused a fail-safe condition is present.

Example: Setting a Fail-safe Fault Alarm

To assign a fail-safe fault alarm to Relay 3 do the following:

1. Enable the Fail-safe Fault Alarm (set 2.8.8.1. Enable = Enabled)
2. Set 2.8.8.2. Assigned Relay to Relay 3.
Use 2.8.8.3. Alarm State to view the current state of the Fail-safe Alarm.

Flowrate
Flowrate alarms are available on LUT440 (OCM) model only. They can activate an alarm if 
the OCM flowrate is above or below a given setpoint. 

Example: Setting a High Flowrate Alarm

To assign Relay 3 to a high flowrate alarm that activates when the flowrate rises above 
10 l/s:

1. Enable the High Flowrate Alarm (set 2.8.9.1. Enable = Enabled).
2. Set 2.8.9.2. High Flowrate Value ON = 10
3. Set 2.8.9.3. High Flowrate Value OFF = 8
4. Set 2.8.9.4. Assigned Relay to Relay 3

Example: Setting a Low Flowrate Alarm

To assign Relay 3 to a low level alarm that activates when the flowrate falls below 2 l/s:

1. Enable the Low Flowrate Alarm (set 2.8.10.1. Enable = Enabled)
2. Set 2.8.10.2. Low Flowrate Value ON = 2
3. Set 2.8.10.3. Low Flowrate Value OFF = 4
4. Set 2.8.10.4. Assigned Relay to Relay 3

Pump Control 
The SITRANS LUT400 has the pump control functionality to solve nearly any water / 
wastewater application.

To set up pump control for simple applications, see Pump Control Wizard  in LUT400 
Communications manual1.

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 80 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

G
en

er
al

 O
pe

ra
tio

n

Pump Control options
Methods of pump control are dependent on two variables:

Pump start method indicates in what sequence pumps are started; using Fixed, Alternate, or 
Service Ratio setpoints.

Pump duty indicates whether new pumps start and run with any currently running pumps 
(most common) or whether new pumps start and shut off currently running pumps; using 
Assist or Backup duty.

Pump Control algorithms
Algorithms are used to provide six modes of pump control. They can be used to start 
multiple pumps (assist) or one pump at a time (backup). These six modes can be grouped 
into three main methods of pump control used by the SITRANS LUT400: Fixed, Alternate, 
and Service Ratio. The LUT420 (Level) model operates with Alternate pump control only.

Fixed: Starts pumps based on individual setpoints and always starts the same pumps in 
the same sequence [Fixed Duty Assist (FDA), and Fixed Duty Backup (FDB)].

Alternate: Starts pumps based on the duty schedule and always leads with a new 
pump [Alternate Duty Assist (ADA), and Alternate Duty Backup (ADB)].

Service Ratio: Starts pumps based on user-defined ratio of running time [Service Ratio 
Duty Assist (SRA), and Service Ratio Duty Backup (SRB)].

Alternate Duty Assist (ADA) is set as the default.

Setting a pump down (wet well) group
Setting a group of two pumps to pump down a wet well.
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outflowHigh Cal. Pt.
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*

* ON Setpoint Pump 1 / Pump 2
** OFF Setpoint Pump 1 / Pump 2

Setpoint sample values:
(see tables below)
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Set the common parameters 

Prerequisite: Substitute the details of your application in place of the sample values 
provided. If you are bench testing the device, set your test values to be the same as the 
sample values.

Set Relays to ALTERNATE DUTY ASSIST (ADA)

Set the ON Setpoints

Set the OFF Setpoints

Parameter Sample Value
2.1.2. Sensor Mode Level
 Response Rate Medium
2.1.6. Transducer XPS-10
2.1.1. Units M
2.2.1. Low Calibration Point 1.8
2.2.2. High Calibration Point 0.4

Parameter Value Description
2.7.1.4. Pump Control Mode 

or 

2.7.1.5. Pump Control Mode

ADA Sets the control algorithm used to trip the pump 
relay to ALTERNATE DUTY ASSIST. Multiple 
pumps can run simultaneously.

Parameter
Sample 
Valuea

a. Sample values denoted by asterisks in illustration on page 80.

Description

2.7.1.6. ON Setpoint Pump 1 1.0 m * Sets the level at which pump 1 turns on. The 
first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the pumps.
For example: In cycle 1, pump 1 turns on at 1 m. 
In the next cycle, pump 2 will turn on at 1 m.

2.7.1.8. ON Setpoint Pump 2 1.1 m * Sets the level at which pump 2 turns on. 

Parameter
Sample 
Valuea

a. Sample values denoted by asterisks in illustration on page 80.

Description

2.7.1.7. OFF Setpoint Pump 1 0.5 m ** Sets the level at which pump 1 turns off. The 
first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the pumps.
For example: In cycle 1, pump 1 turns off at 
0.5 m. In the next cycle, pump 2 will turn off at 
0.5 m.

2.7.1.9. OFF Setpoint Pump 2 0.6 m ** Sets the level at which pump 2 turns off. 
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Other Pump Control algorithms

Set Relays to ALTERNATE DUTY BACKUP (ADB)

Set the ON Setpoints

Set the OFF Setpoints

Set Relays to FIXED DUTY ASSIST (FDA)

Set the ON Setpoints

Set the OFF Setpoints

Parameter Value Description
2.7.1.4. Pump Control Mode 

or 

2.7.1.5. Pump Control Mode

ADB Sets the control algorithm used to trip the pump 
relay to ALTERNATE DUTY BACKUP. Only one 
pump can run at a time.

Parameter Sample 
Value Description

2.7.1.6. ON Setpoint Pump 1 1.3 m Sets the level at which pump 1 turns on. The 
first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the pumps.

2.7.1.8. ON Setpoint Pump 2 1.2 m Sets the level at which pump 2 turns on. 

Parameter Sample 
Value Description

2.7.1.7. OFF Setpoint Pump 1 0.4 m Sets the level at which pump 1 turns off. The 
first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the pumps.

2.7.1.9. OFF Setpoint Pump 2 0.3 m Sets the level at which pump 2 turns off. 

Parameter Value Description
2.7.1.5. Pump Control Mode FDA Sets the control algorithm used to trip the pump 

relay to FIXED DUTY ASSIST. Multiple pumps 
can run simultaneously.

Parameter Sample 
Value Description

2.7.1.6. ON Setpoint Pump 1 1.3 m Sets the level at which pump 1 turns on.
2.7.1.8. ON Setpoint Pump 2 1.2 m Sets the level at which pump 2 turns on. 

Parameter Sample 
Value Description

2.7.1.7. OFF Setpoint Pump 1 0.4 m Sets the level at which pump 1 turns off.
2.7.1.9. OFF Setpoint Pump 2 0.3 m Sets the level at which pump 2 turns off. 
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Set Relays to FIXED DUTY BACKUP (FDB)

Set the ON Setpoints

Set the OFF Setpoints

Set Relays to SERVICE RATIO DUTY ASSIST (SRA)

Set the ON Setpoints

Set the OFF Setpoints

Parameter Value Description
2.7.1.5. Pump Control Mode FDB Sets the control algorithm used to trip the pump 

relay to FIXED DUTY BACKUP. Only one pump 
can run at a time.

Parameter Sample 
Value Description

2.7.1.6. ON Setpoint Pump 1 1.3 m Sets the level at which pump 1 turns on.
2.7.1.8. ON Setpoint Pump 2 1.2 m Sets the level at which pump 2 turns on. 

Parameter Sample 
Value Description

2.7.1.7. OFF Setpoint Pump 1 0.4 m Sets the level at which pump 1 turns off.
2.7.1.9. OFF Setpoint Pump 2 0.3 m Sets the level at which pump 2 turns off. 

Parameter Value Description
2.7.1.5. Pump Control Mode SRA Sets the control algorithm used to trip the 

pump relay to SERVICE RATIO DUTY ASSIST. 
Multiple pumps can run simultaneously. Pump 
usage is based on RUN time rather than last 
used.

2.7.1.10. Service Ratio Pump 1 25 Sets the ratio to: 25% for pump 1, i.e. pump 1 
will run 25% of the time.

2.7.1.11. Service Ratio Pump 2 75 Sets the ratio to: 75% for pump 2, i.e pump 2 
will run 75% of the time

Parameter Sample 
Value Description

2.7.1.6. ON Setpoint Pump 1 1.3 m Sets the level at which the first pump turns on. 
2.7.1.8. ON Setpoint Pump 2 1.2 m Sets the level at which the second pump turns 

on. 

Parameter Sample 
Value Description

2.7.1.7. OFF Setpoint Pump 1 0.4 m Sets the level at which the first pump turns off. 
2.7.1.9. OFF Setpoint Pump 2 0.3 m Sets the level at which the second pump turns 

off. 
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Set Relays to SERVICE RATIO DUTY BACKUP (SRB)

Set the Service Ratio for each pump

Set the ON Setpoints

Set the OFF Setpoints

When a pump start is required (ON Setpoint), the pump with the fewest running hours (with 
respect to the assigned ratio values) starts. 

Conversely, when a pump stop is required (OFF Setpoint), if multiple pumps are running 
simultaneously, the pump with the most running hours (as compared to the assigned ratio 
values) stops. 

Parameter Value Description
2.7.1.5. Pump Control Mode SRB Sets the control algorithm used to trip the 

pump relay to SERVICE RATIO DUTY BACKUP. 
Only one pump can run at a time. Pump usage 
is based on RUN time rather than last used.

Parameter Sample 
Value Description

2.7.1.10. Service Ratio Pump 1 25 Sets the ratio to: 25% for pump 1, i.e. pump 1 
will run 25% of the time.

2.7.1.11. Service Ratio Pump 2 75 Sets the ratio to: 75% for pump 2, i.e pump 2 
will run 75% of the time

Parameter Sample 
Value Description

2.7.1.6. ON Setpoint Pump 1 1.3 m Sets the level at which the first pump turns on.
2.7.1.8. ON Setpoint Pump 2 1.2 m Sets the level at which the second pump turns 

on. 

Parameter Sample 
Value Description

2.7.1.7. OFF Setpoint Pump 1 0.4 m Sets the level at which the first pump turns off. 
2.7.1.9. OFF Setpoint Pump 2 0.3 m Sets the level at which the second pump turns 

off.

Notes: 
• The SITRANS LUT400 will not sacrifice other pumping strategies to ensure that 

the service ratio is held true
• If the pump ratios are set to the same value, then the ratio equals 1:1 and all 

pumps are used equally (default)
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Setting a pump up (reservoir) group
Sets a group of two pumps to pump up a reservoir.

Set the common parameters 

Prerequisite: Substitute the details of your application in place of the sample values 
provided. If you are bench testing the device, set your test values to be the same as the 
sample values.

Set Relays to ALTERNATE DUTY ASSIST (ADA)

Parameter Sample Value
2.1.2. Sensor Mode or  2.1.3. Sensor Mode Level
 Response Rate Medium
2.1.6. Transducer XPS-10
2.1.1. Units M
2.2.1. Low Calibration Point 1.8
2.2.2. High Calibration Point 0.4

Parameter Value Description
2.7.1.4. Pump Control Mode 

or 

2.7.1.5. Pump Control Mode

ADA Sets the control algorithm used to trip the pump 
relay to ALTERNATE DUTY ASSIST.
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SITRANS LUT400
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level
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* ON Setpoint Pump 1 / Pump 2
** OFF Setpoint Pump 1 / Pump 2

Setpoint sample values:
(see tables below)
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Set the ON Setpoints

Set the OFF Setpoints

Parameter
Sample 
Valuea

a. Sample values denoted by asterisks in illustration on page 85.

Description

2.7.1.6. ON Setpoint Pump 1 0.4 m* Sets the level at which pump 1 turns on. The 
first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the pumps.
For example: In cycle 1, pump 1 turns on at 
0.4 m. In the next cycle, pump 2 will turn on at 
0.4 m.

2.7.1.8. ON Setpoint Pump 2 0.3 m* Sets the level at which pump 2 turns on. 

Parameter
Sample 
Valuea

a. Sample values denoted by asterisks in illustration on page 85.

Description

2.7.1.7. OFF Setpoint Pump 1 1.3 m** Sets the level at which pump 1 turns off. The 
first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the pumps. 
For example: In cycle 1, pump 1 turns off at 
1.3 m. In the next cycle, pump 2 will turn off at 
1.3 m.

2.7.1.9. OFF Setpoint Pump 2 1.2 m** Sets the level at which pump 2 turns off. 
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Pump Control Interlocks

These values will ensure that any pump reporting a failure is removed from the pumping 
rotation. For more information on pump interlocks and discrete inputs, see Discrete 
Inputs  on page 69.

Other Pump Controls

Prerequisite: Common parameters must first be set for each pump control below:

Parameter Sample 
Value Description

2.7.1.4. Pump Control Mode 

or 

2.7.1.5. Pump Control Mode

ADA Sets the control algorithm used to trip the 
pump relay to ALTERNATE DUTY ASSIST.

2.9.3.1. Enable Pump 1 ON Enables pump start interlock for Pump 1.
2.9.3.2. Pump 1 Discrete 
Input

Discrete 
Input 1

Sets the discrete input to use for pump start 
interlock on Pump 1.

2.9.3.3. Enable Pump 2 ON Enables pump start interlock for Pump 2.
2.9.3.4. Pump 2 Discrete 
Input

Discrete 
Input 2

Sets the discrete input to use for pump start 
interlock on Pump 2.

2.9.2.1. Discrete Input 1 
Logic

Normally 
Closed

Use if necessary to reverse logic for Discrete 
Input 1.

2.9.2.3. Discrete Input 2 
Logic

Normally 
Closed

Use if necessary to reverse logic for Discrete 
Input 2.

Parameter Sample Value
2.1.2. Sensor Mode or  2.1.3. Sensor Mode Volume
 Response Rate Medium
2.1.6. Transducer XPS-10
2.1.1. Units M
2.2.1. Low Calibration Point 1.8
2.2.2. High Calibration Point 0.4
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Totalizing pumped volume
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM model).

Prerequisite: The volume of the vessel must be known.

1. Display vessel volume on the LCD (set parameter 2.1.2. Sensor Mode to VOLUME).
2. Toggle to SV on LCD to display current level (set parameter  2.1.4. Sensor Mode 

Secondary to LEVEL).
3. See 2.7.3.1. Running Totalizer to view pumped volume. 

Setting a pump to run-on
This functionality is used to reduce sludge and sediment from building up at the bottom of 
a wet well, thereby reducing maintenance. This is achieved by running the pumps below 
the normal OFF setpoint and requires you to set a run-on duration and interval to control 
this event.

Parameter Sample 
Value Description

2.6.1. Vessel Shape LINEAR Vessel shape is linear (flat bottom)
2.6.3. Maximum Volume 17.6 Max volume is 17.6m3 or 17,600 liters.
2.7.1.4. Pump Control Mode 

or 

2.7.1.5. Pump Control Mode

ADA Sets the control algorithm used to trip the 
pump relay to ALTERNATE DUTY ASSIST.

2.7.1.6. ON Setpoint Pump 1 1.0 m Sets the level at which pump 1 turns on. The 
first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the 
pumps.

2.7.1.8. ON Setpoint Pump 2 1.2 m Sets the level at which pump 2 turns on.
2.7.1.7. OFF Setpoint Pump 1 0.2 m Sets the level at which pump 1 turns off. The 

first cycle will use this setpoint. Subsequent 
cycles rotate the setpoint among the 
pumps.

2.7.1.9. OFF Setpoint Pump 2 0.3 m Sets the level at which pump 2 turns off.
2.7.3.2. Totalizer Decimal 
Position

2 DIGITS Sets the totalizer display to 2 digits.

2.7.3.3. Totalizer Multiplier 1000 Actual volume is divided by 1000, prior to 
display on LCD.

2.7.3.4. Inflow/Discharge 
Adjust

RATE 
ESTIMATE

The inflow rate measured just prior to the 
start of the pump cycle is used to estimate 
the inflow for the duration of the cycle.
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Example:

Pump 1 is set to pump for an extra 60 seconds every 5 hours, pump 2 should not run-on.

Setting the pump start delays
In the event that power to the SITRANS LUT400 has been lost, the pump start delay 
ensures that all of the pumps do not start at once to avoid power surges. There are two 
parameters used here: Pump Start Delay and Power Resumption Delay.

Example:

The delay between pumps is set to 20 seconds and the delay of the first pump is set to 30 
seconds.

Parameter Sample 
Value Description

2.7.2.3.2. Run-On Interval 5 Five hours between pump run-on occurrences.
2.7.2.3.3. Run-On Duration 
Pump 1

60 The pump will run-on for 60 seconds. 

2.7.2.3.4. Run-On Duration 
Pump 2

0 Pump 2 will never run-on.

Parameter Sample 
Value Description

2.7.2.4.1. Delay Between 
Starts

20 Wait at least 20 seconds between pump starts.

2.7.2.4.2. Power Resumption 
Delay

60 Wait for 60 seconds when power is restored for 
the first pump to activate.

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 90 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

G
en

er
al

 O
pe

ra
tio

n

Reducing wall cling
Use the Wall Cling Reduction function to randomly alter the ON and OFF setpoints over a 
range. This eliminates the ridge of material that builds up at the setpoint that can give 
false echoes. 

This setting may increase the number of days between trips to clean the wet well.

Enable Wall Cling Reduction by setting 2.7.2.1.1. Enable = Enabled. Then set the range in 
2.7.2.1.2. Level Setpoint Variation. The pump ON and OFF setpoints are randomly varied 
inside this range so the material level does not stop at the same point each time.

Example:

A range of 0.5 meters is used to vary the setpoint. The randomly-selected setpoints are 
always inside the ON and OFF setpoints. 

Random Setpoint 
Range

ON Setpoint 

Level Setpoint 
Variation

OFF Setpoint
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Saving energy
Pumps can use different setpoints at different times of the day to account for variable 
energy costs. 

The following example illustrates high energy cost usage reduction and/or elimination by 
using the SITRANS LUT400 Energy Savings function on a wet well (pump down 
application) using pump 1.

Pre-requisite: enable Energy Savings function (set 2.7.2.2.1. Enable = Enabled)

Generally, you would cascade the timing of the pump downs so that the wells farthest 
from the treatment facility would begin first and the entire system would push material 
through during the low cost period.

Normal Operation
Uses the standard ON and OFF setpoints (2.7.1.6. 
ON Setpoint Pump 1 / 2.7.1.7. OFF Setpoint Pump 1). 
Energy cost is at minimum.

2.7.2.2.2. Peak Lead Time = 60 minutes.
Pumps down the wet well regardless of the pump 
ON Setpoints. This ensures that the wet well 
starts the high cost period at the 2.7.1.7. OFF 
Setpoint Pump 1. Energy cost is at minimum.

2.7.2.2.3. Peak 1 Start Time = 17:30.
Starts using the energy savings setpoints 
(2.7.2.2.13. Peak ON Setpoint Pump 1 and 2.7.2.2.14. 
Peak OFF Setpoint Pump 1). 
Energy cost is at maximum.

2.7.2.2.4. Peak 1 End Time = 21:30.
Returns to normal setpoints (2.7.1.6. ON Setpoint 
Pump 1 / 2.7.1.7. OFF Setpoint Pump 1). 
Energy cost returns to minimum.

Note: When the Peak ON Setpoint is not reached, no energy is used during the high 
cost period. If the Peak ON Setpoint is reached, the Wet Well is only pumped down to 
6 m, thereby minimizing high cost energy usage.

Parameter Value Description
2.7.2.2.1. Enable Enabled Enables Energy Savings function

2.7.2.2.3. Peak 1 Start Time 17:30 Starts the first high cost period at 5:30 pm

2.7.2.2.4. Peak 1 End Time 21:30 Ends the first high cost period at 9:30 pm

2.7.2.2.2. Peak Lead Time 00:60
Sets the pump down to happen 60 minutes 
before the high cost period

2.7.2.2.13. Peak ON Setpoint 
Pump 1 9

Sets the high cost ON setpoint at process level 
of 9 m

2.7.2.2.14. Peak OFF Setpoint 
Pump 1

6
Sets the high cost OFF setpoint at process level 
of 6 m

8 m (ON setpt.)

2 m (OFF setpt.)

8 m (ON setpt.)

2 m (OFF setpt.)

9 m (Peak ON)
8 m (ON setpt.)
6 m (Peak OFF)

2 m (OFF setpt.)

9 m (Peak ON)
8 m (ON setpt.)

2 m (OFF setpt.)

6 m (Peak OFF)

15:30
(3:30 pm)

16:30
(4:30 pm)

17:30
(5:30 pm)

21:30
(9:30 pm)

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 92 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

G
en

er
al

 O
pe

ra
tio

n

Tracking pump usage
You can find out how much an individual pump has been used by viewing the pump 
record parameters.

Other controls

Relays controlled by time
A relay can be controlled by time setpoints using Time of Day or Elapsed Time.

Set Time of Day Relay

Set Elapsed Time Relay

Information Available Parameter Access
Total running hours for a relay assigned 
to a pump.

3.2.7.1. Run Time Relay 2
3.2.7.2. Run Time Relay 3

Parameter Value Description
2.11.2.1. Enable Enabled Enables Time of Day Relay

2.11.2.2. Activation Time 17:30 Activates the relay at 5:30 pm

2.11.2.3. Relay Duration 60 Activates the relay for 60 seconds

2.11.2.4. Assigned Relay Relay 1 Sets relay 1 to be controlled by time of day

2.11.2.5. Relay Logic Normally 
Closed

Use (if necessary) to change the behaviour of 
the relay assigned to the time of day control. 
Default: Normally Open

Parameter Value Description
2.11.1.1. Enable Enabled Enables elapsed time relay

2.11.1.2. Interval 24 Activates the relay every 24 hours

2.11.1.3. Relay Duration 60 Activates the relay for 60 seconds

2.11.1.4. Assigned Relay Relay 1 Sets relay 1 to be controlled by elapsed time

2.11.1.5. Relay Logic
Normally 
Closed

Use (if necessary) to change the behaviour of 
the relay assigned to the elapsed time control. 
Default: Normally Open
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Flow

Flow calculation
The SITRANS LUT400 provides numerous open channel flow calculation features 
(see2.15. Flow).

The device can be configured to select the flow calculation specific to the primary measuring 
device (PMD), such as a flume or weir. If the PMD does not match any of the eleven preset 
PMD calculations, a universal flow calculation can be used (PMD = Universal Head 
Flow). See Flow Calculation  on page 265 for more details.

The SITRANS LUT400 converts the head measurement into flow rate. The flow rate is totalized 
and stored in a comprehensive data log to facilitate detailed flow analysis.

Totalizing flow
Totalizing of the calculated flow is ongoing. Daily and running totalizers can be viewed in 2.16. 
Totalizers. The daily totalizer resets automatically every 24 hours at 23:59:59, and both can be 
reset by the user.

In order to adjust the rate of filling of the totalizer, the 2.7.3.3. Totalizer Multiplier can be set to 
an appropriate value. Totalizing that is specific to a time and date can be viewed under View 
Logs for flow (see 3.2.6.2. OCM  on page 202).

The SITRANS LUT400 can be programmed to operate a remote totalizer by assigning any of 
the relays to act as a totalizer contact. Under this function, the maximum rate of contact 
closure is 5/s with a closure duration of 100 ms.1

External Totalizers and Flow Samplers
External totalizers are simple counters which count the number of relay clicks produced 
by the SITRANS LUT400. This is generally used to keep track of OCM or pumped volume 
totals. Note that both of these values are also stored in the SITRANS LUT400 and are 
available through communications.

Flow samplers are devices which take a sample of liquid when triggered by a relay click. 
These samples are used to monitor water quality over time. Flow samplers can be driven 
by OCM volume, pumped volume, or by time depending on the application requirements.

1. Typically the totalizer should be set for 300 to 3000 counts per day at maximum flow.
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Relay contacts
Pumped volume is calculated at the end of the pump cycle. Totalized volume when 
External Totalizer  function is enabled will be given in bursts at the end of the pump cycle, 
not throughout the pump cycle.

Use 2.11.3.3. Relay Duration to set the time in seconds from one change of state in the 
relay to the next. This parameter sets both the open and closed times for the relay 
contact and is preset to 0.2 seconds. Partial units are added to the next pump cycle.

Example:

Shows a relay set up to make one contact for every cubic metre (m3) of liquid.

The following parameters describe how to setup a Totalizer or Sampler.

Relay Duration ON time Relay Duration OFF time

4m3 2m3 2m3 3m3 1m3

Pump Cycle

relay contact closed

relay contact open
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Totalizer
Use the 2.11.3. External Totalizer function to set the totalizer to provide relay contact to an 
external counter.

The totalizer source, and units depend on the volume configuration:

Counter Formula
1 contact every x units, where x = value set in 
2.11.3.2. Multiplier
Example:
To click once every 4310 units, set 2.11.3.2. Multiplier 
to 4310.

2.11.3.2. Multiplier is preset to 1 so 
the default number of contacts is 
one contact per unit of volume.

Volume Configuration Totalizer Source Units 
Source

2.6.1. Vessel Shape = NONE 2.16. Totalizers (OCM 
flow totalizer)

2.15.3.7. Flowrate Units

2.6.1. Vessel Shape = any setting 
other than NONE

2.7.3. Totalizers (pumped 
volume totalizer)

2.6.2. Volume Units

Parameter Sample 
Value Description

2.11.3.1. Enable Enabled Enables External Totalizer Relay
2.11.3.2. Multiplier 4310 Click once every 4310 units
2.11.3.3. Relay Duration 0.2 Activates the relay for 0.2 seconds

2.11.3.4. Assigned Relay Relay 1
Sets relay 1 to be controlled by external 
totalizer

2.11.3.5. Relay Logic Normally 
Closed

Use (if necessary) to change the 
behaviour of the relay assigned to the 
totalizer. 
Default: Normally Open
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Flow Sampler
Use the 2.11.4. External Sampler function to activate the flow sampler relay based on 
volume and time.

The totalizer source, and units depend on the volume configuration:

By using 2.11.4.2. Multiplier, the relay contacts can be based on a volume other than a 
multiple of ten.

During the periods of low flow, the sampler may be idle for lengths of time. Program 
2.11.4.3. Interval time in hours to drive the sampler. The sampler will operate based on the 
volume of flow or the time interval, whichever comes first.

Counter Formula
1 contact every x units, where x = value set in 
2.11.4.2. Multiplier
Example:
To click once every 4310 units, set 2.11.4.2. Multiplier 
to 4310.

2.11.4.2. Multiplier is preset to 1 so 
the default number of contacts for 
a pumped volume cycle is one 
contact per unit of volume.

Volume Configuration Totalizer Source Units 
Source

2.6.1. Vessel Shape = NONE 2.16. Totalizers (OCM 
flow totalizer)

2.15.3.7. Flowrate Units

2.6.1. Vessel Shape = any setting 
other than NONE

2.7.3. Totalizers (pumped 
volume totalizer)

2.6.2. Volume Units

Parameter Sample 
Value Description

2.11.4.1. Enable Enabled Enables Flow Sampler Relay
2.11.4.2. Multiplier 4310 Click once every 4310 units
2.11.4.3. Interval

2
Sets the INTERVAL (in hours) of the relay 
contact, usually long.

2.11.4.4. Relay Duration
0.2

Sets the DURATION (in seconds) of the 
relay contact, usually short.

2.11.4.5. Assigned Relay
Relay 1

Sets relay 1 to be controlled by flow 
sampler

2.11.4.6. Relay Logic
Normally 
Closed

Use (if necessary) to change the 
behaviour of the relay assigned to the 
sampler. 
Default: Normally Open
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Open Channel Monitoring (OCM) 
An OCM installation is defined one of three ways, based on the Primary Measuring 
Device (PMD):

1. Dimensional

For some common weir and flume types. PMD dimensions (2.15.4. PMD Dimensions) are 
entered directly.

2. Exponential

For most other weir and flume types. PMD exponents provided by the manufacturer are 
entered. Flow is calculated using the exponent (2.15.3.2. Flow Exponent) and the 
maximum values (2.15.3.3. Maximum Head and 2.15.3.4. Maximum Flow at 20 mA).  

3. Universal

For all other PMDs, the head-to-flow curve can be plotted based on known breakpoints, 
usually supplied by the PMD manufacturer. 

Vessel Type See page:
BS- 3680 Rectangular Flume 105

BS- 3680 Round Nose Horizontal Crest Weir 106

BS- 3680 Trapezoidal Flume 107

BS- 3680 U-Flume 108

BS- 3680 Finite Crest Weir 109

BS- 3680 Thin Plate Rectangular Weir 110

BS- 3680 Thin Plate V-Notch Weir 111

Rectangular Weir Contracted 112

Round Pipe 113

Palmer Bowlus Flume 114

H-Flume 115

Vessel Type See page:
Standard Weirs  116
Parshall Flume 101
Leopold Lagco Flume 102
Cut Throat Flume 103

Vessel Type See page:
Typical flow characterization 116
Example flumes 117
Example weirs 118
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Method of Flow Calculation
When using the SITRANS LUT400 in a flow application, the Method of Flow Calculation 
(2.15.3.1.) must be selected. There are two possible methods for calculating flow with the 
SITRANS LUT400: absolute or ratiometric, and different information must be entered for the 
device to carry out the calculation. For more details, and an example, see Method of Flow 
Calculation  on page 266.

Common parameters
These common parameters are required for all installations.

Parameter Sample Value
 Flow
 Response Rate MEDIUM
2.1.6. Transducer XRS-5
2.1.1. Units M
2.2.1. Low Calibration Point 1.8
 2.2.2. High Calibration Point  0.4
2.2.5. Far Range 0.8
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Setting Zero Head
Many PMDs start flowing higher than the traditional empty distance of the application. 
You can account for the flow in one of two ways:

1. Use 2.15.3.5. Zero Head Offset to have OCM calculations ignore levels below that 
value. Possible head = 2.2.1. Low Calibration Point minus 2.2.2. High Calibration Point. 

2. Use 2.2.5. Far Range where the empty level is set to the bottom of the weir, and 
above the bottom of the channel. It should be used if the surface monitored can fall 
past the 2.2.1. Low Calibration Point level in normal operation without reporting an 
LOE. The value is added to 2.2.1. Low Calibration Point and can be greater than the 
range of the transducer.

The examples on the following pages show both methods.

Note: 2.15.3.3. Maximum Head is preset to 2.2.1. Low Calibration Point minus 2.2.2. 
High Calibration Point and is not updated when 2.15.3.5. Zero Head Offset is used. 
Make sure you set 2.15.3.3. Maximum Head to the correct value when using 2.15.3.5. 
Zero Head Offset. (Refer to PMD supplier documentation for Maximum Head.).

zero head

max. head

low cal. point

high cal. point

far
range

head

sensor ref. point

material surface
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PMDs with Exponential Flow to Head function
For Primary Measuring Devices (PMDs) that measure flow by an exponential equation, 
use these parameters. Ensure that you use the correct exponent for your PMD; the values 
below are samples only.

Standard Weirs

Applicable weir profiles

Parameter Value
2.15.1. Primary Measuring Device (PMD) Exponential Devices
2.15.3.2. Flow Exponent Weir Type Valuea

a. Values are samples only. Consult weir manufacturer’s documentation for cor-
rect flow exponent.

V-notch
Suppressed rectangular
Cipolletti or trapezoidal
Sutro or proportional

2.50
1.50
1.50
1.00

2.15.3.3. Maximum Head
2.15.3.4. Maximum Flow at 20 mA
2.15.3.7. Flowrate Units
2.2.5. Far Range
2.15.4.1. K Factorb

b. Required for exponential device absolute calculation only.

3 to 4 x hmax

weir profile

transducer

h

V-notch or 
triangular

suppressed
rectangular

cipolleti or 
trapezoidal

sutro or
proportional
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Parshall Flume

Application information

• Sized by throat width
• Set on solid foundation
• For rated flows under free flow conditions, the head is measured at 2/3 the length of 

the converging section from the beginning of the throat section

Note: C = Converging Dimension.

Parameter Value
2.15.1. Primary Measuring Device (PMD) Exponential Devices
2.15.3.2. Flow Exponent 1.522–1.607a

a. Typical Flow Exponent range for Parshall Flume; consult your flume documen-
tation.

2.15.3.3. Maximum Head
2.15.3.4. Maximum Flow at 20 mA
2.15.4.1. K Factorb

b. Required for exponential device absolute calculation only.

Q

C

 2/3 C

Zero
Head

Front View

Plan View

transducer*
Side View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

flow

Operation & Maintenance Plan
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Leopold Lagco Flume

Application information

• Designed to be installed directly into pipelines and manholes
• Leopold Lagco may be classed as a rectangular Palmer-Bowlus flume
• Sized by pipe (sewer) diameter
• For rated flows under free flow conditions, the head is measured at a point 

upstream referenced to the beginning of the converging section. Refer to the 
following table:

Parameter Value
2.15.1. Primary Measuring Device (PMD) Exponential Devices
2.15.3.2. Flow Exponent 1.547a

a. Typical Flow Exponent for Leopold Lagco Flume; consult your flume documen-
tation.

2.15.3.3. Maximum Head
2.15.3.4. Maximum Flow at 20 mA
2.15.3.5. Zero Head Offset
2.15.3.7. Flowrate Units
2.15.4.1. K Factorb

b. Required for exponential device absolute calculation only.

Flume Size
(pipe diameter in inches)

Point of Measurement
cm inches

4-12 2.5 1
15 3.2 1.25
18 4.4 1.75
21 5.1 2

point of measurement

divergingconverging

Front View

Zero 
Head

Plan View

Side View

transducer*

throat

flow

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).
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Cut Throat Flume

Application information

• Similar to Parshall flume except that the floor is flat bottomed and throat has no 
virtual length.

• Refer to manufacturer’s specifications for flow equation and point of head 
measurement.

24 6.4 2.5
30 7.6 3
42 8.9 3.5
48 10.2 4
54 11.4 4.5
60 12.7 5
66 14.0 5.5
72 15.2 6

Parameter Value
2.15.1. Primary Measuring Device (PMD) Exponential Devices
2.15.3.2. Flow Exponent 1.56 - 2.00a

a. Typical Flow Exponent range for Cut Throat Flume; consult your flume docu-
mentation.

2.15.3.3. Maximum Head
2.15.3.4. Maximum Flow at 20 mA
2.15.3.7. Flowrate Units
2.15.4.1. K Factorb

b. Required for exponential device absolute calculation only.

Flume Size
(pipe diameter in inches)

Point of Measurement
cm inches

Plan View
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Khafagi Venturi

Application information

• Similar to Parshall flume except that the floor is flat bottomed and the sidewalls are 
curved.

• For rated flows under free flow conditions, the head is measured 1 x (channel width) 
upstream from the beginning of the converging section.

Parameter Value
2.15.1. Primary Measuring Device (PMD) Exponential Devices
2.15.3.2. Flow Exponent 1.55 (Consult your flume documentation.)
2.15.3.3. Maximum Head
2.15.3.4. Maximum Flow at 20 mA
2.15.3.7. Flowrate Units
2.15.4.1. K Factora

a. Required for exponential device absolute calculation only.

Zero 
Head

Front View

Plan View

transducer*

Side View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

flow

channel 
width

1x 
channel 

width
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Applications supported by SITRANS LUT400

BS- 3680 Rectangular Flume

Parameter Value
2.15.1. Primary Measuring Device (PMD) BS-3680 Rectangular Flume
2.15.4. PMD Dimensions Approach width (B)

Throat width (b)
Hump Height (p)
Throat length (L)

2.15.3.5. Zero Head Offset
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

Diagonal View

Plan View

L

Flow

3 to 4 x hmax

B b

transducer*

Zero 
Head

p
flow

Front View Side View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

h

Operation & Maintenance Plan
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BS- 3680 Round Nose Horizontal Crest Weir

Parameter Value
2.15.1. Primary Measuring Device (PMD) BS-3680 Round Nose Horizontal Crest Weir
2.15.4. PMD Dimensions Crest Width b

Crest Height p
Crest Length L

2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

transducer*

3 to 4 x hmax

Diagonal View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

L

b

p

h

Operation & Maintenance Plan
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BS- 3680 Trapezoidal Flume

Parameter Value
2.15.1. Primary Measuring Device (PMD) BS-3680 Trapezoidal Flume
2.15.4. PMD Dimensions Slope m

Approach Width B
Throat Width b
Hump Height p
Throat length L

2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

1
m

Side ViewFront View

b

B

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

L

h

transducer*
3 to 4 x hmax

Plan View

p

b

B

flow

Zero Head

Operation & Maintenance Plan
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BS- 3680 U-Flume

Parameter Value
2.15.1. Primary Measuring Device (PMD) BS-3680 U-Flume
2.15.4. PMD Dimensions Approach Diameter Da

Throat Diameter D
Hump Height p
Throat Length L

2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

transducer*
3 to 4 x hmax

Plan View

Diagonal View

Front View Side View

Zero Head
h

p

L

D

Da

flow

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).
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BS- 3680 Finite Crest Weir

Parameter Value
2.15.1. Primary Measuring Device (PMD) BS-3680 Finite Crest Weir
2.15.4. PMD Dimensions Crest Width b

Crest Height p
Crest Length L

2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

transducer*

Diagonal View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

Front View

Side View

3 to 4 x hmax

h

p

L
flow

b

Zero Head

Operation & Maintenance Plan
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BS- 3680 Thin Plate Rectangular Weir

Parameter Value
2.15.1. Primary Measuring Device (PMD) BS-3680 Thin Plate Rectangular Weir
2.15.4. PMD Dimensions Approach Width B

Crest Width b
Crest Height p

2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

transducer*

Diagonal View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

Front View

3 to 4 x hmax

b

p

hflow

B

Side View
Zero Head

Operation & Maintenance Plan
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BS- 3680 Thin Plate V-Notch Weir

Parameter Value
2.15.1. Primary Measuring Device (PMD) BS-3680 Thin Plate V-Notch Weir
2.15.4. PMD Dimensions Notch angle (a)
2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

transducer*

Side View

Diagonal View

Front View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

4 to 5 x hmax

B

h

a

flow

bZero Head

Operation & Maintenance Plan
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Rectangular Weir Contracted

Parameter Value
2.15.1. Primary Measuring Device (PMD) Rectangular Weir Contracted
2.15.4. PMD Dimensions Crest Width b
2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

transducer*

Side View

Diagonal View

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).

Front View

4 to 5 x hmax

flow

b

p

h

B

Zero Head

Operation & Maintenance Plan
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Round Pipe

Parameter Value
2.15.1. Primary Measuring Device (PMD) Round Pipe
2.15.4. PMD Dimensions Pipe Inside Diameter D

Slope (fall/run) s
Roughness Coefficient n

2.15.3.3. Maximum Head
2.2.5. Far Range
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation
2.15.3.4. Maximum Flow at 20 mA

transducerDiagonal View

h

**

*

** The transducer must be above the maximum head by at least the blanking value.

* This dimension should be at least 15 cm (6") shorter than the blanking value (see 2.2.4. Near 
Range).

D

Operation & Maintenance Plan
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Palmer Bowlus Flume

Application information

• Sized by pipe diameter D
• Flume relief is trapezoidal
• Designed to install directly into pipelines and manholes
• Head is referenced to bottom of the throat, not bottom of the pipe
• For rated flows under free flow conditions, the head is measured at a distance of 

D/2 upstream from the beginning of the converging section

Parameter Value
2.15.1. Primary Measuring Device (PMD) Palmer Bowlus Flume
2.15.4. PMD Dimensions Maximum Flume width hmax

2.15.3.3. Maximum Head
2.15.3.4. Maximum Flow at 20 mA
2.15.3.5. Zero Head Offset
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation Ratiometric

Note: Palmer Bowlus Flume can only be setup using ratiometric calculations

Zero 
Head

transducer**D/2, point of measurement*

Flow

Plan View

Front ViewSide View

D = pipe or sewer diameter
* for rated flows under free flow conditions
** The transducer must be above the maximum head by at least the blanking value (see 2.2.4. 
Near Range).

D

Operation & Maintenance Plan
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H-Flume

• Sized by maximum depth of flume
• Approach is preferably rectangular, matching width and depth for distance 3 to 5 

times the depth of the flume
• May be installed in channels under partial submergence (ratio of downstream level 

to head). Typical errors are:
• 1% @ 30% submergence
• 3% @ 50% submergence

• For rated flows under free flow conditions, the head is measured at a point 
downstream from the flume entrance. Refer to the following table.

Parameter Value
2.15.1. Primary Measuring Device (PMD) H-Flume
2.15.4. PMD Dimensions Flume height (D)
2.15.3.3. Maximum Head
2.15.3.4. Maximum Flow at 20 mA
2.15.3.7. Flowrate Units
2.15.3.1. Method of Flow Calculation Ratiometric

Note: H-Flume can only be setup using ratiometric calculations

Flume Size
(Diameter in feet)

Point of Measurement
cm inches

0.5 5 1.75
0.75 7 2.75
1.0 9 3.75
1.5 14 5.5

continued on next page

Front View Side View

point of measurement

transducer*Plan View

flow

* The transducer must be above the maximum head by at least the blanking value (see 2.2.4. Near 
Range).
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• H-flumes come with a flat or sloping floor. The same flow table can be used 
because error is less than 1%.

Universal calculation support
When the primary measuring device (PMD) doesn’t fit one of the standard types, it can 
be programmed using a universal characterization. When Universal is selected as the 
PMD type [2.15.1. Primary Measuring Device (PMD)], then both head and flow breakpoints 
(2.15.5. Universal Head vs. Flow) must be entered to define the flow.

SITRANS LUT400 supports Universal curved (cubic spline) flow calculation shown in the 
following chart. (The 2.15.3.1. Method of Flow Calculation for universal support can be 
Ratiometric or Absolute. Refer to your PMD manufacturer’s documentation.)

Typical flow characterization

Characterization is achieved by entering the head and corresponding flow breakpoints, 
either from empirical measurement or from the manufacturer's specification. Increasing 
the number of defined breakpoints will increase the accuracy of the flow measurement. 

Breakpoints should be concentrated in areas exhibiting the higher degrees of non linear 
flow. A maximum of 32 breakpoints can be defined, with a minimum of four required. The 
curve’s end point is always specified by the parameters 2.15.3.3. Maximum Head and 
2.15.3.4. Maximum Flow at 20 mA. These two parameter values are in addition to the 32 
breakpoints available for definition. 

Use as many breakpoints as required by the complexity of your PMD.
See Volume  on page 73 for more information and parameter 2.15.5. Universal Head vs. 
Flow for characterization.

2.0 18 7.25
2.5 23 9
3.0 28 10.75
4.5 41 16.25

Flume Size
(Diameter in feet)

Point of Measurement
cm inches

Maximums (Max. 
Head, Max. Flow)

Curved

Head Breakpoints

Fl
ow

 B
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Example flumes
These example flumes would both require a universal calculation.

Trapezoidal 

Dual Range (nested) Parshall

Max. Flow

Zero Flow
Ze

ro
 H

ea
d

M
ax

. H
ea

dHead Breakpoints

Fl
ow

 B
re
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Example weirs
These weirs could require universal calculation.

Trends
To view trend lines, navigate to 3. Maintenance and Diagnostics > 3.2. Diagnostics > 3.2.2. 
Trend. The PV (in percentage) is logged at five minute intervals and trend displays up to 3000 
data points since last power up. 

• Press RIGHT arrow  to request a trend.

• Use UP  or DOWN arrow  to scroll to an icon. When an icon is highlighted, 

that feature becomes active.

• To move the cross-hair, press RIGHT arrow  to increase the value, LEFT arrow 

 to decrease.

• To Zoom into an area, position the cross-hairs at the center of that area, select 

Zoom icon, and press RIGHT arrow . Press LEFT arrow  to Zoom out.

• To return to the previous menu, select Exit icon then press RIGHT arrow .

Notes: 
• When a fail-safe condition has occurred, it will appear as a gap in the Trend line.
• Trend view will not timeout. This view will display on LUI until the exit icon is 

selected.

Poebing approximate 
exponential

compound

-1-2-3
0

50

100

0

current measurement

exit icon
zoom icon
pan left/right icon - selec

m
ea

su
re

m
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hours

cross-hairs
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Data logging
The SITRANS LUT400 provides an extensive logging feature which can be viewed on the 
local display or retrieved via USB port.

Enable data logging for a Process Value, an Alarm, or for Flow (see 2.10. Data Logging  on 
page 173).

For flow, the logging rate can be fixed or variable. The latter being useful in conserving 
logging space. The condition for variable logging is determined when selecting the 
logging rate.

Variable logging rate conditions are categorized as: percent change of flow per minute, 
percent change of maximum flow or percent change of maximum head. Logging occurs at 
the normal (slower) rate while the condition is less than the setpoint (2.10.3.6. Rapid Flow 
Log Setpoint). If the condition exceeds the rapid flow log setpoint, the rapid rate of logging 
takes effect until the condition falls below the standard flow log setpoint (2.10.3.4. 
Standard Flow Log Setpoint).

The setpoints represent the absolute value of the rate of change; that is, for either 
increasing or decreasing flowrate. The SITRANS LUT400 does not recognize negative 
entries for standard or rapid flow log setpoints.

Flow data is logged in flowrate units (with full resolution of flow measurement value) 
from 0 to 110% of maximum flow. Flows above 110% are logged at the 110% value (in 
flowrate units). Truncation of flows to 110% does not apply to daily totalization.

Viewing the Data Log
To view the data log, navigate to 3. Maintenance and Diagnostics > 3.2. Diagnostics > 
3.2.6. View Logs and select the desired log; Alarms, OCM, PV, or Daily Totals.

The log can be examined locally via LUI, or via USB. On LUI, viewing of the log is done by 
task and by method. The viewing tasks are: Alarms, OCM, Daily Totals, or Primary 
Variable (PV). The viewing methods are: by first entry, by last entry and by specified date. 
The scrolling keys are used to maneuver through the tasks, methods and time of day.

Log Capacity vs. Rates

e.g. rate = 15 / 5, capacity = 3.5 months max / 1 month min

Note: No data logs are written while the device is connected to a PC via USB.

Rate Capacity
1 min. 7 days

5 1 month
15 3.5 months
30 7 months
60 1.2 years

24 hr 27.8 years
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Log files copied to a local computer drive via USB, are comma-delimited files. For a list of 
field names, see Data Logging  on page 267.

Fault code 129 is displayed on the device when the data log memory becomes full. To 
clear entries when memory is full:

1. Disable all logging functions that are active (PV log: 2.10.1.1., Alarm log: 2.10.2.1., Flow 
log: 2.10.3.1. or 2.10.3.2.)

2. Browse to the USB drive on your computer and delete log files (or move files from 
the USB drive to another local computer drive). (If a file is deleted or moved without 
first disabling the associated logging function, the fault code will not clear.)

3. Re-enable logging functions that were disabled in step 1.

Simulation
The SITRANS LUT400 supports simulation from the LUI. Level and discrete inputs can be 
simulated, separately or concurrently.

Level simulation

In level simulation, the LCD reacts to the simulated level changes, and activates 
relays based on the setpoints programmed. The material level can be set to 
continuously sweep through the measurement range, from Low Calibration Point to 
High Calibration Point and back again (using 3.4.1.3. Ramp, 3.4.1.4. Ramp Rate), or the 
material level can be held at a specific value (using 3.4.1.2. Level Value).

Discrete Input simulation

When discrete inputs are simulated, the DI icon on the LCD will show the simulated 
states of the discrete inputs. Any programming that uses the discrete inputs, such as 
the backup level override, will use the simulated values.

In simulation mode, some of the LUT400’s configured functionality will respond to the 
simulated value, including:

• Readings that are based on Level - The LUT400 supports simulation of Level values 
only. Other simulated values cannot be entered, however, these values will be 
calculated correctly when Level is simulated. Space, Distance, Volume, Flow, and 
Head will be calculated [see Sensor Mode (2.1.2.) on page 138].

• The milliamp output - The current loop output will also track the corresponding 
reading (Level, Space, Distance, Volume, Flow, or Head depending on which of 
these it is configured to track). [See Current Output Function (2.5.1.) on page 144.]

• Alarms - Any alarms that have been configured, including any relays configured for 
alarms, will activate based on the simulated value. [See Alarms (2.8.) on page 162.]

• Relays configured for pumps - If the device is configured for a pump application then 
the corresponding relay indicators on the LCD will also show when the pumps 
would activate. By default the relay contacts themselves will not activate in 
simulation mode, but this behaviour can be changed if desired (see Pump relay 
behaviour during simulation  on page 121). 

• Logging - Log files will reflect the simulated values. This includes logging simulated 
high-flow/low-flow conditions, and any alarms. 
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The following functions will not respond to the simulated value when in simulation mode:

• Fault Conditions - The LUT400 will never enter the Fail-safe state when in simulation 
mode. For further details see Fail-safe and Simulation  on page 122.

• Backup Level Override - If a Backup Level Override switch is configured and it lies 
within the simulated Level range, it will not be simulated. To simulate a Backup Level 
Override, simulate the discrete input. See Simulating Discrete Inputs  on page 123. 

• Totalizing of OCM Flow - Totalizing of flow (OCM applications) does not occur during 
simulation. The OCM Daily Totalizer (2.16.1.) and Running Totalizer (2.16.2.) will not 
increase in value during simulation. 

• Totalizing of Pumped Volume - Totalizing of pumped volume does not occur during 
simulation if 3.4.3. Pump Activations is set to Disabled. If pumps are set to run during 
simulation, the material pumped will be totalized (2.7.3.1. Running Totalizer).

• External Sampler - The external sampler, if configured, will click at its timeout 
interval when in simulation mode (see 2.11.4.3. Interval). 

Pump relay behaviour during simulation
The 3.4.3. Pump Activations parameter allows you to choose how the physical relays that 
are assigned to pumps will behave when in simulation mode. 
This parameter has two possible values: 

Disabled: Pump relays are not activated in simulation (default value) 

Enabled: Pump relays are activated in simulation 

If 3.4.3. Pump Activations is Disabled, only the LCD indicators are affected (the 
corresponding relay icons will turn ON, but the relays will not energize). If 3.4.3. Pump 
Activations is Enabled, the relay icons will turn ON, and the relays will energize.

WARNING: Select Enabled only when there is no possibility of the pumps 
being damaged during simulation, or if the pumps have been locally disabled 
through some other means.

Notes: 
• If the pump relays are configured to physically activate in simulation mode, then any 

time activated will be recorded in the pump Run Time parameter (see Pump Records  
on page 202.).

• If a pump start delay has been programmed for the device (2.7.2.4.1. Delay Between 
Starts), it will be respected in Simulation mode.
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Fail-safe and Simulation
When simulating Level or Discrete Inputs, the LUT400 will never enter the Fail-safe state. 
Faults that would normally cause a fail-safe condition (such as a broken cable or LOE) 
may still occur, but a fail-safe condition will not be reported on the device during 
simulation.

HART status
When using HART communications via software tools such as PDM, AMS, FDT, and 
FC375/475, the Level value and the readings derived from level will display simulated 
values (when level or discrete input simulation is enabled on LUI). (See Process Variables 
within PDM, AMS, FDT, and FC375/475.) Device status conditions within each tool will also 
indicate that the device is in simulation mode (see Diagnostics).

Simulation process
Simulation is an iterative process whereby parameters are adjusted and corresponding 
results are viewed in Measurement Mode. Level and Discrete Inputs can be simulated 
separately, or concurrently. When either simulation is enabled, the LCD displays 
Simulation Enabled in the text area for status messages (see Measurement mode 
display: Normal operation  on page 34).

To stop simulation at any time, set the parameter for the function being simulated (3.4.1.1. 
Level Simulation Enable, 3.4.2.1. Discrete Input 1, 3.4.2.2. Discrete Input 2) to Disabled.

In general, to run a simulation:

1. Select the function to be simulated: Level or Discrete Input (can be simulated 
concurrently).

2. Set simulation parameters if performing a Level simulation.

3. Decide if pumps will be active during simulation (see Pump relay behaviour during 
simulation  on page 121).

4. Start simulation.

Simulating a fixed level

1. Set the desired fixed level value in 3.4.1.2. Level Value.
2. Set 3.4.1.3. Ramp to Disabled.
3. Enable 3.4.3. Pump Activations if desired (see Pump relay behaviour during 

simulation  on page 121).
4. Set 3.4.1.1. Level Simulation Enable to Enabled to start level simulation.
Set 3.4.1.1. Level Simulation Enable to Disabled when you wish to stop level simulation.

Note: As fail-safe will not be reported during simulation, a bench simulation of the 
LUT400 can be run without a transducer connected.

Note: Simulation Enabled status will display on LCD even if other faults are present.
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Simulating a changing level

1. Set the desired starting level value in 3.4.1.2. Level Value.
2. Set 3.4.1.3. Ramp to Enabled. 
3. Set 3.4.1.4. Ramp Rate to the desired speed, e.g. Medium.
4. Enable 3.4.3. Pump Activations if desired (see Pump relay behaviour during 

simulation  on page 121).
5. Set 3.4.1.1. Level Simulation Enable to Enabled to start level simulation.

The simulated level will initially begin ramping up from Level Value  (increasing level). 
When the level rises to 100% or falls to 0%, it reverses direction at the same rate.

Set 3.4.1.1. Level Simulation Enable to Disabled when you wish to stop level simulation.

Simulating Discrete Inputs

1. Enable 3.4.3. Pump Activations if desired (see Pump relay behaviour during 
simulation  on page 121).

2. Set the discrete input to be simulated (3.4.2.1. Discrete Input 1, 3.4.2.2. Discrete Input 
2 or both) to one of the following: 

• ON: the discrete input is simulated to be on
• OFF: the discrete input is simulated to be off.

Set parameter(s) for DI to be simulated (3.4.2.1. Discrete Input 1 and/or 3.4.2.2. Discrete 
Input 2) to Disabled if you do not wish to simulate a discrete input, or to stop DI simulation 
that is currently running.

Simulation timeout

Simulation will automatically be disabled and the LUT400 will return to normal 
measurement and control ten minutes after changing (editing) any simulation parameter 
(except Level Value ). When the timeout occurs, parameters used to enable simulation 
(Level Simulation Enable , Discrete Input 1 , Discrete Input 2 ), as well as Pump 
Activations  will switch to Disabled, and the message Simulation Enabled will no longer 
display on the LCD. (Device status conditions will also reset in PDM, AMS, FDT, and 
FC375/475.)

Application test
You can test the application by varying the actual material level (the preferred test 
method), or by simulating level changes.

If you are testing the application via simulation mode, decide if control devices, such as 
pumps, are to be operational during simulation by setting the Pump Activations  
parameter (see Pump relay behaviour during simulation  on page 121). 

While the level is being cycled, check the results of the discrete inputs either by closing 
the circuit externally (preferred), or by setting DI simulation parameter to force the input 
ON or OFF. Try all possible combinations to thoroughly test the setup. When simulating a 

WARNING: Only enable Pump Activations  when there is no possibility of the 
pumps being damaged during simulation, or if the pumps have been locally 
disabled through some other means.
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changing level, run a complete cycle (from Low Calibration Point to High Calibration Point 
and back again) to verify that the relays operate as expected. 

Monitor system performance carefully, under all anticipated operating conditions.

1. When the LUT400 performs exactly as required, programming is complete. 

2. If alternate reading units, fail-safe action, or relay operation is desired, update the 
parameters for the new functionality. 

3. If you experience problems with system performance, see Diagnosing and 
Troubleshooting  on page 229. 

If you cannot observe all possible operating conditions by varying the material level, use 
Simulation process  on page 122 to verify programming.

Retest the system each time you adjust any control parameters.

SITRANS LUT400 Communication Systems
The SITRANS LUT400 is an integrated level controller capable of communicating process 
information to a Supervisory Control and Data Acquisition (SCADA) system, via a HART 
modem.

LUT400 Communications (HART)
Highway Addressable Remote Transducer, HART, is an industrial protocol that is 
superimposed on the 4-20 mA signal. It is an open standard, and full details about HART 
can be obtained from the HART Communication Foundation at www.hartcomm.org

SITRANS LUT400 can be configured over the HART network using the HART 
Communicator 375/475 by Emerson (see Operation via Field Communicator 375/475 
(FC375/FC475) (HART)  on page 21), or a software package. The recommended software 
package is the SIMATIC Process Device Manager (PDM) by Siemens.

HART Version
SITRANS LUT400 conforms to HART rev. 7.2.

SITRANS LUT400

Connection via HART modem.
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Burst mode
SITRANS LUT400 does not support burst mode.

HART multi-drop mode
HART Multi-drop Mode allows the connection of multiple field devices via HART. To setup 
a device in Multi-drop Mode, see Device Address  on page 126. Details on the use of 
Multi-drop Mode are outlined in an application guide Working with HART, which can be 
downloaded from the product page of our website. Go to: 
www.siemens.com/sitransLUT400 under Support and click on Application Guides.

SIMATIC PDM
This software package is designed to permit easy configuration, monitoring, and 
troubleshooting of HART devices. The HART EDD for SITRANS LUT400 was written with 
SIMATIC PDM in mind and has been extensively tested with this software.

For more information, see Operation via SIMATIC PDM 6 (HART)  on page 15.

HART Electronic Device Description (EDD) 
In order to configure a HART device, the configuration software requires the HART 
Electronic Device Description for the instrument in question. 

You can download the HART EDD for SITRANS LUT400 from the product page of our 
website. Go to: www.siemens.com/sitransLUT400 and click on Support>Software 
Downloads. 

Older versions of the library will have to be updated in order to use all the features of 
SITRANS LUT400.

HART Status
Information on HART Status is outlined in an application guide Working with HART, which 
can be downloaded from the product page of our website. Go to: 
www.siemens.com/sitransLUT400 under Support and click on Application Guides. 

LUT400 Communication connections
The SITRANS LUT400 can be connected to a computer system via a HART modem (connected 
to the mA OUT/HART terminal block), or directly connected via a Universal Serial Bus (USB) 
cable (for use with the Web Browser interface). A HART network requires a device address be 
configured. For communications via USB, connect SITRANS LUT400 to your computer via the 
USB cable.
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Configuring communication ports

HART modem

Device Address

The unique identifier of the SITRANS LUT400 on a HART network.

Set the device address or poll ID on a HART network. 

Prior to HART 6, the device address was set to 0 for point to point operation. For HART 
Multi-drop mode, the device was set to any value other than 0 within the range. (Setting a 
non-zero address forced the device into fixed current mode.)

With HART 6 and above (version 7.2 supported by LUT400), Multi-drop mode no longer 
depends on the device address. (However, it is recommended that a non-zero address be 
set to avoid confusion based on previous HART requirements). 

To set the LUT400 in Multi-drop mode, disable Loop current mode via one of the HART 
communication software tools (such as SIMATIC PDM). When Loop current mode is 
disabled, a low fixed current is used, allowing for multiple devices to be connected.

See 4.1. Device Address  on page 216.

USB cable
See Communications  on page 24 for typical setup via USB, then follow instructions under 
Installing the USB driver  in the LUT400 Communications manual1.

Communication troubleshooting
See Communication Troubleshooting  on page 229 of Diagnosing and Troubleshooting .

Note: It is recommended that only HCF registered modems be used.

Values
Range: 0 to 63 (Set within range of 0 to 15 if HART 5 master used.)

Default: 0

Note: Loop current mode can not be disabled via LUI or Web Browser.

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01).
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Remote operation

SITRANS LUT400 supports several software tools for operation via remote communications:

• PC running SIMATIC PDM
• PC running Emerson AMS Device Manager
• PC running a web browser
• PC running a Field Device Tool (FDT)
• Field Communicator 375/475 (FC375/FC475).

This section of the manual covers basic information required to use these tools with your 
SITRANS LUT400. Further details for each are available in the Communications for SITRANS 
LUT400 (HART) Manual (7ML19985NE01). (See DVD shipped with device or download 
manual from product page of our website: Go to www.siemens.com/sitransLUT400 > 
Technical Info > Manuals/Operating instructions.)

Operation via SIMATIC PDM 6 (HART) 
(SITRANS LUT400 compatible with PDM version 6.1)

Features and Functions
SIMATIC PDM is a software package used to commission and maintain SITRANS LUT400 and 
other process devices. PDM monitors the process values, alarms and status signals of the 
device. It allows you to display, compare, adjust, verify, and simulate process device data; also 
to set schedules for calibration and maintenance. Please consult the LUT400 online help for 
details on using SIMATIC PDM. (You can find more information at: 
www.siemens.com/simatic-pdm.)

SIMATIC PDM features four Quick Start Wizards (Level, Volume, Volume-Linearization, and 
Flow) to easily configure the SITRANS LUT400. A Pump Control Wizard is also available. Other 
features include Echo Profile Utilities, Manual TVT Shaper adjustment, Auto False Echo 
Suppression screening, Process Variables monitoring, and Maintenance scheduling. 

Parameters are identified by name and organized into function groups. The menu 
structure for SIMATIC PDM is almost identical to that of the LCD. See LCD Menu 
Structure  on page 125 for a chart. For a complete list of parameters, see Parameter 
reference (LUI)  on page 137.

Startup and Configuration
To startup the SITRANS LUT400 using SIMATIC PDM, check that you have the latest version of 
PDM installed (update your installation if necessary - see SIMATIC PDM version  below), then 
install the EDD. Next, configure the device using the Quick Start Wizards in PDM.

Note: Italian, Portuguese and Russian are not supported in the software tools for 
remote operation. If the device is set to one of these languages, it may be necessary to 
switch the device to English, German, French, Spanish or Chinese.
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For more information on SIMATIC PDM functions, and details on how to configure the device 
using PDM, refer to the LUT400 Communications manual1. 

SIMATIC PDM version
Check the support page of our website to make sure you have the latest version of SIMATIC 
PDM, the most recent Service Pack (SP) and the most recent hot fix (HF). Go to:

http://support.automation.siemens.com/WW/
llisapi.dll?func=cslib.csinfo&lang=en&objiD=10806857&subtype=133100

Electronic Device Description (EDD)
You can locate the EDD in Device Catalog, under Sensors/Level/Echo/Siemens AG/
SITRANS LUT400. (The EDD is written for forward compatibility.) 
As a guideline to locate the correct EDD, the major and minor numbers should match 
between the EDD revision and the Firmware revision in the device (e.g. major and minor 
numbers in bold text: 1.00.00-04).

Installing a new version of SIMATIC PDM requires the most recent Service Pack (SP) and 
the most recent hot fix (HF). 

To install a new EDD
• Go to www.siemens.com/sitransLUT400 > Support > Software Downloads to 

download the most up-to-date EDD from the product page of our website.
• Save the files to your computer and extract the zipped file to an easily accessed 

location. 
• Launch SIMATIC PDM – Manage Device Catalog, browse to and select the folder 

which contains the unzipped EDD file.

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01).

matching 
Firmware 
and EDD 
revisions

To check it in PDM, go to SITRANS LUT400 HART > Identification > Device.
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Operation via Web Browser (USB)

Features and Functions
The web browser interface in SITRANS LUT400, designed to work with Windows XP, makes 
monitoring and adjustments easy. Internet Explorer installed on a computer can be used to 
configure the SITRANS LUT400, and the Web Server Abyss is supplied for your convenience.
The web browser is available in English only.

SITRANS LUT400 parameters, organized into six main function groups, allow you to configure 
and monitor the device:

• Identification
• Setup
• Maintenance and Diagnostics
• Communication
• Security
• Language

Startup and Configuration
To start up the SITRANS LUT400 using the Web Browser, you must first install the USB driver 
and web browser interface. On the small DVD shipped with the device you will find the driver 
and installation software1. Once installed, the communication port (COMPORT) must be set, 
then you can configure the device via the browser menu parameters. 

The menu structure for the web browser interface is almost identical to that of the LCD. See 
Browser Menu Parameter Function Groups  in the LUT400 Communications manual2 for a 
complete list of parameters that can be configured via the web browser.

For installation instructions and details on how to configure the device via the Web Browser, 
refer to the LUT400 Communications manual1.

1. Also available from the product page of our website. Go to: 
www.siemens.com/sitransLUT400 and click on Support>Software Downloads.

2. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01).
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Operation via AMS Device Manager (HART)

(SITRANS LUT400 compatible with AMS version 10.5 and higher)

Features and Functions
AMS Device Manager is a software package used to commission and maintain SITRANS 
LUT400 and other process devices. AMS Device Manager monitors the process values, 
alarms and status signals of the device. It allows you to display, compare, adjust, verify, and 
simulate process device data. The graphic interface in SITRANS LUT400 makes monitoring 
and adjustments easy. Please consult the operating instructions or online help for details on 
using AMS Device Manager. (You can find more information at: 
http://www.emersonprocess.com/AMS/.) 

AMS Device Manager features four Quick Start Wizards (Level, Volume, Volume-Linearization, 
and Flow) to easily configure the SITRANS LUT400. A Pump Control Wizard is also available. 
Other features include Echo Profile viewing, TVT setup, Process Variables monitoring, and 
Security. 

Parameters organized into three main function groups allow you to configure and monitor the 
device: 

• Configure/Setup
• Device Diagnostics (read only)
• Process Variables (read only)

For a chart1 of the AMS Menu Structure , see LUT400 Communications manual2. 

Startup and Configuration
To startup the SITRANS LUT400 using AMS Device Manager, you must first install the EDD 
(see below). You can then configure the device using the Quick Start Wizards in AMS.

For more information on AMS functions, and details on how to configure the device using 
AMS, refer to the LUT400 Communications manual2. 

Electronic Device Description (EDD)
SITRANS LUT400 requires the EDD for AMS Device Manager version 10.5.

You can locate the EDD in Device Catalog, under Sensors/Level/Echo/Siemens/SITRANS 
LUT400. Check the product page of our website at www.siemens.com/sitransLUT400, under 
Support->Software Downloads, to make sure you have the latest version of the EDD for 
AMS Device Manager.

1. The menu structure for AMS Device Manager is almost identical to that of the LCD. 
2. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01).
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Operation via Field Communicator 375/475 (FC375/
FC475) (HART)

Features and Functions
The FC375/FC475 HART Communicator is a handheld communication device that is easy 
to use, and provides universal support for other HART devices, such as the 
SITRANS LUT400.

For a list of parameters available with the Field Communicator, see HART FC375/FC475 Menu 
Structure  in the LUT400 Communications manual1. This menu structure is very similar to that 
of AMS Device Manager. 

Startup and Configuration
In order to configure this HART device, just as with AMS, the configuration software 
requires the HART Electronic Device Description (EDD) for the instrument. Once the EDD 
is installed, you can configure the device using the Quick Start Wizards within FC375/475.

For instructions on how to install the EDD, and how to configure a new device using 
FC375/475, refer to the LUT400 Communications manual2.

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01).
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Operation via FDT (Field Device Tool)

Features and Functions
FDT is a standard used in several software packages designed to commission and maintain 
field devices such as SITRANS LUT400. Two commercially available FDTs are PACTware and 
Fieldcare. 

FDT is very similar to PDM [see Operation via SIMATIC PDM 6 (HART)  in the LUT400 
Communications manual1 for more detail].

• To configure a field device via FDT, you need the DTM (Device Type Manager) for the 
device.

• To configure a field device via SIMATIC PDM, you need the EDD (Electronic Data 
Description) for the device. 

Startup and Configuration
To startup the SITRANS LUT400 using an FDT, you must first install the DTM (see below). You 
can then configure the device using the parameters available with the FDT. 

The full process to configure a field device via FDT is outlined in an application guide for 
SITRANS DTM, which can be downloaded from the product page of our website. Go to: 
www.siemens.com/sitransLUT400 under Support and click on Application Guides.

Device Type Manager (DTM)
A DTM is a type of software that ’plugs into’ FDT. It contains the same information as an EDD 
but an EDD is independent of the operating system. 

SITRANS DTM version 3.1
• SITRANS DTM is an EDDL interpreter developed by Siemens to interpret the EDD 

for that device. 
• To use SITRANS DTM to connect to a device, you must first install SITRANS DTM on 

your system and then install the instrument EDD written for SITRANS DTM.
• You can download SITRANS DTM from our website at: 

http://www.siemens.com/sitransdtm. 
Click on Support then go to Software downloads.

Electronic Device Description (EDD)
The SITRANS LUT400 HART EDD for SITRANS DTM can be downloaded from the product 
page of our website. 

Go to www.siemens.com/sitransLUT400 under Support and click on Software Downloads. 

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01).
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Parameter reference (LUI)

Parameters are identified by name and organized into function groups. See LCD Menu 
Structure  on page 125 for a chart.

Parameters accessible via the local push buttons are preceded by a number. Parameters 
not preceded by a number are accessible only via remote operation.

Based on model configuration (LUT420, LUT430, LUT440), some parameters will not 
appear on LUI. Exceptions are noted by parameter. 

Where the same parameter exists for more than one model, but is represented by a 
different menu number, both parameters are listed together (separated by "OR"), and the 
details are noted under the second of the two parameters.

For more details see: 
• Operation via SIMATIC PDM 6 (HART)  on page 15
• Operation via AMS Device Manager (HART)  on page 19 

1. Wizards
Several Wizards are available with the SITRANS LUT400. Wizards group together all the 
settings needed for a particular feature. All Wizards are available via the local push 
buttons, and many are also available via SIMATIC PDM under the Device menu.

For details on the Wizards listed below, see Quick Start Wizards  on page 38 of 
Commissioning.

Notes: 
• Parameter names and menu structure are almost identical for SIMATIC PDM 

and the local user interface (LUI). Access is described below for some 
parameters that do not appear in the SIMATIC PDM menu structure. 
(For further details on using these parameters within SIMATIC PDM, see the 
LUT400 Communications manuala.)

• Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

• Parameter range values are displayed in the default of the defined unit of 
measure. For example, if a parameter description states that it is defined in 
Units (2.1.1.), the range for that parameter will be shown in meters [as meters 
(M) is the default for Units (2.1.1.)]. 

• The number of decimals displayed for a parameter value will depend on the 
unit of measure, unless decimal places can be set by the user (e.g. Totalizers - 
2.7.3.2.Totalizer Decimal Position).
For example:
Values defined in default 2.1.1.Units will display 3 decimal places; default 
2.6.2.Volume Units - 1 decimal place, default 2.15.3.7.Flowrate Units - 0 decimal 
places.

• To enter Program mode using the local push buttons, press . Press  to 
return to Measurement mode.

a. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)
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1.1. Quick Start 

1.1.1. QS Level

1.1.2. QS Volume

1.1.3. QS Flow
Available only on LUT430 (Pump and Flow), and LUT440 (OCM) configured 
models.

1.2. Pump Control

2. Setup

2.1. Sensor

2.1.1. Units
Determines sensor measurement units used when 2.1.2.Sensor Mode set to 
Level, Space, Distance, or Head.

2.1.2. Sensor Mode
Menu number 2.1.2. visible on LUT420 (Level model).

OR

2.1.3. Sensor Mode
Menu number 2.1.3. visible on LUT430 (Pump and Flow model), and LUT440 
(OCM model).

Sets the type of measurement required for the application.

Notes: 
• See Local Commissioning  on page 33 or Operation via SIMATIC PDM 6 (HART)  on 

page 15 for instructions.
• Default settings in the parameter tables are indicated with an asterisk (*) unless 

explicitly stated.
• Values shown in the following tables can be entered via the local push buttons.

Options
M, CM, MM, FT, IN

Default: M

Options (Mode) Description Reference point

* LEVEL

Distance to material surface

Low Calibration Point
(process empty level)

SPACE
High Calibration Point 
(process full level)

DISTANCE Sensor Reference Point

VOLUME
Volume of material in volumetric 
units (based on level)

Low Calibration Point

HEAD a

a. Option available only on LUT430, LUT440.

Distance to material surface Zero Head

FLOW a
Flowrate in an open channel in 
Flowrate Units

Zero Head (zero flow level)
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2.1.4. Sensor Mode Secondary
Menu number 2.1.4. visible on LUT420 (Level model).

OR

2.1.5. Sensor Mode Secondary
Menu number 2.1.5. visible on LUT430 (Pump and Flow model), and LUT440 
(OCM model).
Sets the secondary measurement type to be used in the application.
See  Sensor Mode (2.1.3.) for illustration.

sensor reference point 

level 

low calibration point

high calibration point

far range

distance 
space 

low cal. point

high cal. point

far
range

max. head

sensor ref. point

zero head

material surface
head

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 140 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

Pa
ra

m
et

er
s

2.1.6. Transducer
Specifies the Siemens transducer connected to the device.

2.1.7. Frequency
Adjust the shot transmit pulse frequency (in kHz).

2.1.8. Long Shot Duration
Adjust the duration of the long shot transmit pulse (in s).

2.1.9. Short Shot Duration
Adjust the duration of the short shot transmit pulse (in s).

2.2. Calibration

2.2.1. Low Calibration Point
Distance from sensor reference point 1 to Low Calibration Point defined in Units 
(2.1.1.).

Options

* NO TRANSDUCER

XRS-5

XPS-10

XPS-15

XCT-8

XCT-12

XPS-30

XPS-40

XLT-30

XLT-60 

STH

Notes:
• When Transducer (2.1.6.) is set to NO TRANSDUCER, the LOE fault will 

display immediately.
• An Echo Profile (3.2.1.) cannot be requested from LUI when Transducer 

(2.1.6.) is set to NO TRANSDUCER. The local push button will not operate.

Values
Range: 10.000 to 52.000

Default: Depends on transducer selected in Transducer (2.1.6.).

Values
Range: 100.000 to 2000.000 

Default: Depends on transducer selected in Transducer (2.1.6.).

Values
Range: 100.000 to 2000.000 

Default: Depends on transducer selected in Transducer (2.1.6.).

1. The point from which level measurement is referenced (see Sensor Mode on page 138 for illus-
tration).

Values
Range: 0.000 to 60.000 

Default: 60.000
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2.2.2. High Calibration Point
Distance from sensor reference point1 to High Calibration Point defined in Units 
(2.1.1.).

When setting the High Calibration Point value, note that echoes are ignored 
within 2.2.4.Near Range.

2.2.3. Sensor Offset
The value altered when an Auto Sensor Offset (2.2.6.) is performed, defined in 
Units (2.1.1.).

Alternatively, if amount of Sensor Offset is known, enter the constant that can 
be added to or subtracted from sensor value1 to compensate if the sensor 
reference point has shifted.

2.2.4. Near Range
The range in front of the device (measured from the sensor reference point) 
within which any echoes will be ignored. This is sometimes referred to as 
blanking or a dead zone. Defined in Units (2.1.1.).

2.2.5. Far Range

Allows the material level to drop below Low Calibration Point without 
generating a Loss of Echo (LOE) state. See Sensor Mode (2.1.2.) on page 138 for 
an illustration. Defined in Units (2.1.1.).

Use this feature if the measured surface can drop below the Low Calibration 
Point in normal operation. 

Values
Range: 0.000 to 60.000 

Default: 0.000

Values
Range: -99.999 to 99.999

Default: 0.000

1. The value produced by the echo processing which represents the distance from sensor refer-
ence point to the target (see Sensor Mode on page 138 for illustration).

Values 
Range: 0.000 to 60.000 

Default: 0.300

Note: Far Range can extend beyond the bottom of the vessel.

Values
Range: Min. = Low Calibration Point
Max. = 61.000 M (200.13 FT)

Default: Value for Low Calibration Pt. + 1 m (3.281 ft.)
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2.2.6. Auto Sensor Offset

Calibrates actual distance if reported value is consistently high or low by a fixed 
amount. (Adjusts distance measurement by a fixed amount.) Defined in Units 
(2.1.1.).

Before using this feature, verify the following parameters are correct:

• 2.2.1.Low Calibration Point (or 2.15.3.5.Zero Head Offset, if using OCM)
• 2.12.1.2.Process Temperature
• 2.2.3.Sensor Offset
A correction to any one of these parameters may resolve the issue and an Auto 
Sensor Offset calibration may not be necessary.

Using Auto Sensor Offset:

Begin with a steady distance at a known low distance value (low distance value 
equates to a high level value).
1. Review the distance measurement via LUI for approximately 30 seconds to 
verify repeatability.
2. Measure the actual distance (for example, with a tape measure).
3. Enter the actual distance, defined in Units (2.1.1.)
The deviation between the calculated and the actual distance value is stored in 
2.2.3.Sensor Offset. 

2.3. Rate

2.3.1. Fill Rate per Minute
Defines the maximum rate at which the reported level is allowed to increase. 
Allows you to adjust the SITRANS LUT400 response to increases in the actual 
material level.

Enter a value slightly greater than the vessel’s maximum filling rate, in units per 
minute.

Note: Auto Sensor Offset supports adjustments to distance value only.

Values Range: 0.000 to 60.000

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Notes: 
• The following three rate parameters work in conjunction, and are affected by 

Response Rate (set in the Quick Start wizard).
• Fill Rate per Minute, Empty Rate per Minute, and Damping Filter automatically 

update when Response Rate is altered, but any change to these parameters 
will supersede a Response Rate set previously through the wizard.

• For more information, see Measurement Response  on page 260.

Values
Range: 0.000 to 99999.000 m/min

Default: 0.100 m/min
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2.3.2. Empty Rate per Minute
Defines the maximum rate at which the reported level is allowed to decrease. 
Adjusts the SITRANS LUT400 response to decreases in the actual material 
level.

Enter a value slightly greater than the vessel’s maximum emptying rate, in units 
per minute.

2.3.3. Damping Filter
Use this to stabilize the reported level (displayed and analog output), due to lev-
el fluctuations (such as a rippling or splashing liquid surface), defined in sec-
onds.

2.4. Fail-Safe
The fail-safe parameters ensure that the devices controlled by the SITRANS LUT400 
default to an appropriate state when a valid level reading is not available. The PV 
region on LUI will display dashes (– – – – – – –) until the fail-safe fault has been 
cleared. (See General Fault Codes on page 231 for a list of faults that will cause fail-
safe.)

2.4.1. Material Level

Defines the mA output to use (shown in Current Output Value) when the Fail-
safe Timer expires and the device is still in an error condition.

Values
Range: 0.000 to 99999.000 m/min

Default: 0.100 m/min

Values 
Range: 0.0 to 7200.0

Default: 100.0

Note: When a Loss of Echo occurs Material Level (2.4.1.) determines the material 
level to be reported when the Fail-safe timer expires. See Loss of Echo (LOE)  on 
page 261 for more detail.

Note: The default is a factory setting and depends whether or not your device 
was ordered as NAMUR NE43-compliant for Fail-safe.

Options 

HI  20.0 mA (max. mA Limit) 

LO  4.0 mA (min. mA Limit) 

HOLD Last valid reading 

VALUE
User-selected value [defined in Fail-Safe mA Value (2.4.3.): 
default 3.58 mA]

Default VALUE (if ordered with NAMUR NE43 compliant fail-safe preset)
HOLD (if ordered without NAMUR NE43 compliant fail-safe preset)
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2.4.2. LOE Timer
Sets the time to elapse since the last valid reading, before the Fail-safe Material 
Level is reported (defined in seconds).

2.4.3. Fail-Safe mA Value

Allows the user to define the mA value to be reported when the Fail-safe timer 
expires.  

2.5. Current Output

2.5.1. Current Output Function
Menu number 2.5.1. visible on LUT420 (Level model).

OR

2.5.2. Current Output Function
Menu number 2.5.2. visible on LUT430 (Pump and Flow model), and LUT440 
(OCM model).

Alters the mA output/measurement relationship.

Values
Range: 0 to 7200

Default: 100

Note: Material Level (2.4.1.) must be set to Value for the Material Level value 
to be reported.

Values 
Range 3.50 to 22.80 mA

Default 3.58

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Notes:
• The various options have different reference points.
• Use caution when changing Current Output Function while the device is 

connected to a HART network. Current Output Function controls the 
primary value and the loop current for the device.

Options Reference point Description

MANUAL a n/a
user can enter mA value for loop cur-
rent.

* LEVEL Low Calibration Point
measured as difference between the 
material level and 2.2.1.Low Calibration 
Point, defined in 2.1.1.Units

SPACE High Calibration Point 
measured as difference between the 
material level and 2.2.2.High Calibration 
Point, defined in 2.1.1.Units

DISTANCE Sensor reference point
measured as difference between the 
material level and sensor reference 
point, defined in 2.1.1.Units
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1. Refer to PMD supplier documentation for maximum head.

To modify Current Output Function via SIMATIC PDM:

Open the menu Device – Select Analog Output. 

VOLUME Low Calibration Point

converted from Level, defined in Length 
of the cylindrical section of a horizontal 
parabolic end vessel. See Vessel Shape 
(2.6.1.) for an illustration.

HEAD b Zero Head
measured as difference between the liq-
uid level and Zero Head, defined in 
2.1.1.Units

FLOW b Zero Head
converted from Head, defined in 
2.15.3.7.Flowrate Units

a. When Current Output Function is set to Manual, a power cycle will reset 
this parameter to its previous value.

b. Option available only on LUT430, LUT440.

Level Space Distance

distancespace

level

20 mA
100 %

4 mA 
0 %

high
cal. 
point

4 mA
0 %

20 mA 
100 %

4 mA
0 %

20 mA 
100 %

sensor 
ref. 
point

low 
cal. 
point

material
level

Zero Head
(4 mA or 0%)

Low Cal. Point

High Cal. Point

Far
Range

head

sensor ref. point
Head

liquid level

Max. Head
(20 mA or 100%)1
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2.5.3. 4 mA Setpoint
Sets the process level corresponding to the 4 mA value. 4 mA always defaults 
to 0 m, and Current Output Function (2.5.1.) determines the type of 
measurement. [See Current Output Function (2.5.1.) for an illustration.]

• Enter the reading that is to correspond to a 4 mA output.
• Units are defined in Units (2.1.1.) for Level, Space, Distance, or Head, and in 

Flowrate Units (2.15.3.7.) for Flow. Volume units are converted from a level 
value.

2.5.4. 20 mA Setpoint
Sets the process level corresponding to the 20 mA value. 20 mA always defaults 
to 60 m, and Current Output Function (2.5.1.) determines the type of 
measurement. [See Current Output Function (2.5.1.) for an illustration.]

• Enter the reading that is to correspond to a 20 mA output.
• Units are defined in Units (2.1.1.) for Level, Space, or Distance, or Head, and 

in Flowrate Units (2.15.3.7.) for Flow. Volume units are converted from a 
level value.

2.5.5. Minimum mA Limit
Prevents the mA output from dropping below this minimum level for a 
measurement value. This does not restrict the Fail-safe or Manual settings.

2.5.6. Maximum mA Limit
Prevents the mA output from rising above this maximum level for a 
measurement value. This does not restrict the Fail-safe or Manual settings

Values

Range: 
Level, Space, Distance, Head: 0.000 to 60.000 m
Volume: 0.0 to Max. Volume
Flow: 0 to Max. Flow

Default: 0 
(set to value corresponding to 0% as defined by Current Output 
Function and associated units)

Values

Range: 
Level, Space, Distance, Head: 0.000 to 60.000 m
Volume: 0.0 to Max. Volume
Flow: 0 to Max. Flow

Default:
Level, Space, Distance, Head: 60.000
Volume: Max. Volume
Flow: Max Flow
(set to value corresponding to 100% as defined by Current Out-
put Function and associated units)

Values
Range: 3.5 to 22.8 mA

Default: 4.0

Values
Range: 3.5 to 22.8 mA

Default: 20.0
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2.5.7. Manual Value
The mA value to use when Current Output Function (2.5.1.) is set to Manual. 
Allows you to use a simulated value to test the functioning of the loop. You can 
enter 4 mA, 20 mA, or any other user-defined value within the range.

a) First set Current Output Function (2.5.1.) to Manual. 
b) Set this parameter to the desired mA value.
c) After completing the test, remember to reset Current Output Function 

(2.5.1.) to the previous setting.

Via AMS Device Manager or FC375/475:
Open the menu Configure/Setup > Operation > Select Analog Output. 

Via SIMATIC PDM:
Open the menu Device – Loop Test. 

2.5.8. Current Output Value
Read only. Displays the current mA value, including a simulated value entered 
to test the functioning of the loop.

2.6. Volume

Carries out a volume conversion from a level value.

2.6.1. Vessel Shape
89Defines the vessel shape and allows the LUT400 to calculate volume 
instead of level. If None is selected, no volume conversion is performed. 
Select the vessel shape matching the monitored vessel or reservoir.  

Values
Range: 3.5 to 22.8 mA

Default: 3.58

Values Range: 3.5 to 22.8 mA

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Vessel Shape LCD DISPLAY/
Description

Also 
required 

* None
NONE/
No volume calculation 
required

N/A

LINEAR/
Upright, linear (flat bottom) 

maximum 
volume

CYLINDER/
Flat end horizontal cylinder

maximum 
volume

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 148 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

Pa
ra

m
et

er
s

PARABOLIC BOTTOM
maximum 
volume, 
dimension A

HALF SPHERE BOTTOM

maximum 
volume, 
dimension A

FLAT SLOPED BOTTOM
maximum 
volume, 
dimension A

PARABOLIC ENDS/
Parabolic end horizontal cyl-
inder

maximum 
volume, 
dimension A, 
dimension L

SPHERE
maximum 
volume

CONICAL BOTTOM/
Conical or pyramidal bottom

maximum 
volume, 
dimension A

CURVE TABLEa/
Linearization table
(level/volume breakpoints)

maximum 
volume, tables 
1-32 level and 
volume break-
points

LINEAR TABLEa/
Linearization table
(level/volume breakpoints)

maximum 
volume, tables 
1-32 level and 
volume break-
points

a. Linearization Table must be selected in order for level/volume values [see 
Table 1-8 (2.6.7.)] to be transferred.

Vessel Shape
 (cont’d)

LCD DISPLAY/
Description

Also 
required 

A

A

A

A L

A
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2.6.2. Volume Units
Determines volume measurement units used when 2.1.2.Sensor Mode set to 
VOLUME.

2.6.3. Maximum Volume
The maximum volume of the vessel. Enter the vessel volume corresponding to 
High Calibration Point. For example, if your maximum vessel volume is 8000 L, 
enter a value of 8000.

2.6.4. Dimension A
The height of the vessel bottom when the bottom is conical, pyramidal, 
parabolic, spherical, or flat -sloped. If the vessel is horizontal with parabolic 
ends, the depth of the end. See Vessel Shape (2.6.1.) for an illustration.

Defined in 2.1.1.Units.

2.6.5. Dimension L
Length of the cylindrical section of a horizontal parabolic end vessel. See 
Vessel Shape (2.6.1.) for an illustration.

Defined in 2.1.1.Units.

2.6.6. User Defined Unit
Set the unit text to display for current volume when 2.6.2.Volume Units set to 
user-defined. Limited to 16 ASCII characters.

Options

* L (Litres)

USGAL (US Gallons)

IMPGAL (Imperial Gallons)

CUM (Cubic Meters)

USER DEFINED (units defined in 2.6.6.User Defined Unit)

 Values
Range: 0.0 to 9999999

Default: 100.0

 Values
Range: 0.000 to 99.999

Default: 0.000

Values
Range: 0.000 to 99.999

Default: 0.000

Note: The text entered is simply for display purposes. No unit conversion 
occurs.
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2.6.7. Table 1-8
If your vessel shape is more complex than any of the preconfigured shapes, you 
can define the shape as a series of segments. A value is assigned to each level 
breakpoint and a corresponding value is assigned to each volume breakpoint. 
Level values are defined in Units (2.1.1.). Volume values are defined in Volume 
Units (2.6.2.)..

Enter up to 32 level breakpoints, where the corresponding volume is known. 
The values corresponding to 0% and 100% levels must be entered, and 
breakpoints can be ordered from top to bottom, or the reverse. 

Breakpoints are grouped into four tables: Table 1-8, Table 9-16, Table 17-24, and 
Table 25-32.

Entering breakpoints via SIMATIC PDM:
• See Using Linearization via the Quick Start wizard in the LUT400 

Communications manual1.

Entering breakpoints via the local push buttons:
a) The default unit for level values is m: to change it navigate to Setup (2.) > 

Sensor (2.1.) > Units (2.1.1.), and select the desired unit.
b) Navigate to Setup (2.) > Volume (2.6.) > Table 1-8 (2.6.7.), and enter the 

value.
c) Go to the appropriate table for the particular breakpoint you wish to adjust: 

for example, go to Table 1-8 for breakpoint 1. 
d) Under Table 1-8, go to Level 1 (2.6.7.1.) to enter the level value for the 

breakpoint 1. 
e) Under Table 1-8, go to Volume 1 (2.6.7.2.) to enter the volume value for the 

breakpoint 1.
f) Repeat steps c) to e), until values have been entered for all required 

breakpoints.

2.6.7.1. Level 1
a) Press RIGHT arrow to open Edit mode.
b) Enter level value and press RIGHT arrow to accept it.
c) Press Down ARROW to move to corresponding volume breakpoint.

2.6.7.2. Volume 1
a) Press RIGHT arrow to open Edit mode.
b) Enter volume value and press RIGHT arrow to accept it.
c) Press Down ARROW to move to next level breakpoint.

Level Values
Range: 0.000 to 60.000

Default: 0.000

Volume Values
Range: 0.0 to 9999999.0

Default: 0.0

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)
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Example (values are for example purposes only)

2.6.8. Table 9-16

2.6.9. Table 17-24

2.6.10. Table 25-32

2.7. Pumps

For details on relay behaviour under fail-safe conditions, see Pump relays  on page 
66.

2.7.1. Basic Setup

2.7.1.1. Pump Control Enable
Enables/disables pump control.

2.7.1.2. Relay Pump 1
Selects the relay assigned to Pump 1.

2.7.1.3. Relay Pump 2
Selects the relay assigned to Pump 2.

2.7.1.4. Pump Control Mode
Menu number 2.7.1.4. visible on LUT420 (Level model).

OR

2.7.1.5. Pump Control Mode
Menu number 2.7.1.5. visible on LUT430 (Pump and Flow model), and 
LUT440 (OCM model).

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Options
ENABLED

* DISABLED

Options
* RELAY 2

RELAY 3

Options
RELAY 2

* RELAY 3

4 19.5

Breakpoint 
number

3
2

1

Breakpoint 
Number

Level 
value 
(m)

Volume 
value (l)

1 0 0

2 5 500

3 9 3000

4 19.5 8000

Level
value

9
5
0

0.5 m

20 m
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Sets the control algorithm used to trip the relay.

Each algorithm defines a pump duty and pump start method.

2.7.1.6. ON Setpoint Pump 1
The level at which Pump 1 turns ON, defined in 2.1.1. Units.

This parameter is set according to level even when another reading, such 
as volume, is shown on the LCD.

2.7.1.7. OFF Setpoint Pump 1
The level at which Pump 1 turns OFF, defined in 2.1.1. Units.

This parameter is set according to level even when another reading, such 
as volume, is shown on the LCD.

2.7.1.8. ON Setpoint Pump 2
The level at which Pump 2 turns ON, defined in 2.1.1. Units.

This parameter is set according to level even when another reading, such 
as volume, is shown on the LCD.

Options 

*
ALTERNATE 
DUTY ASSIST 
(ADA) 

At rotating ON and OFF setpoints and allows 
multiple pumps to run

ALTERNATE 
DUTY BACKUP 
(ADB) 

At rotating ON and OFF setpoints and allows 
only one pump to run

SERVICE RATIO 
DUTY ASSIST 
(SRA) a

a. Option available only on LUT430, LUT440.

On service ratio at ON and OFF setpoints and 
allows multiple pumps to run

SERVICE RATIO 
DUTY BACKUP 
(SRB) a

On service ratio at ON and OFF setpoints and 
allows only one pump to run

FIXED DUTY 
ASSIST (FDA) a

At fixed ON and OFF setpoints and allows mul-
tiple pumps to run

FIXED DUTY 
BACKUP (FDB) a

At fixed ON and OFF setpoints and allows only 
one pump to run

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000
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2.7.1.9. OFF Setpoint Pump 2
The level at which Pump 2 turns OFF, defined in 2.1.1. Units.

This parameter is set according to level even when another reading, such 
as volume, is shown on the LCD.

2.7.1.10. Service Ratio Pump 1
Selects pump usage based on the RUN time ratio rather than last used. 
(See 3.2.7.1.Run Time Relay 2.)

This parameter only relates to relays with Pump Control Mode (2.7.1.4.) set 
to Service Ratio Duty Assist or Service Ratio Duty Backup.

The number assigned to each pump relay represents the ratio applied to 
decide the next pump to start or stop.

2.7.1.11. Service Ratio Pump 2
Selects pump usage based on the RUN time ratio rather than last used. 
(See 3.2.7.2.Run Time Relay 3.)

This parameter only relates to relays with Pump Control Mode (2.7.1.4.) set 
to Service Ratio Duty Assist or Service Ratio Duty Backup.

The number assigned to each pump relay represents the ratio applied to 
decide the next pump to start or stop.

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0 to 255

Default: 1

Notes:
• The SITRANS LUT400 will not sacrifice other pumping strategies to 

ensure that the ratio is held true.
• If the pump relays are set to the same value then the ratio equals 1:1 

and all pumps are used equally (default).

Values
Range: 0 to 255

Default: 1

Notes:
• The SITRANS LUT400 will not sacrifice other pumping strategies to 

ensure that the ratio is held true.
• If the pump relays are set to the same value then the ratio equals 1:1 

and all pumps are used equally (default).
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2.7.2. Modifiers

2.7.2.1. Wall Cling Reduction
2.7.2.1.1. Enable

Enables/disables 2.7.2.1.2.Level Setpoint Variation.

2.7.2.1.2. Level Setpoint Variation
Varies the ON and OFF setpoints to reduce material buildup on the 
walls (defined in 2.1.1. Units).

This value is the range in which the setpoints are allowed to deviate. 
The pump ON and OFF Setpoint values are randomly varied inside 
the range to ensure that the material level does not consistently 
stop at the same point.

Note: Default settings in the parameter tables are indicated with an asterisk 
(*) unless explicitly stated.

Options
ENABLED

* DISABLED

Values
Range: 0.000 to 99999.000

Default: 0.000

level setpoint ON

level setpoint variation

level setpoint OFF

random setpoint range
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2.7.2.2. Energy Savings
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM 
model).
Use these parameters to maximize your device’s operation during periods 
of low energy cost and minimize its operation during periods of high cost. 
The methods used to achieve this are:

• Emptying the wet well just prior to the high cost period, regardless of 
material level (2.7.2.2.2.Peak Lead Time).

• Changing setpoints for high cost and low cost periods (2.7.2.2.13.Peak 
ON Setpoint Pump 1, 2.7.2.2.14.Peak OFF Setpoint Pump 1, 2.7.2.2.3.Peak 
1 Start Time, 2.7.2.2.4.Peak 1 End Time).

One peak lead time is shared by all five peak zones. When one zone’s peak 
time interval (difference between peak start time and peak end time) 
overlaps another zone’s peak lead time, the lead time is chosen over the 
interval. If a zone’s start time matches its end time, the zone is treated as 
not configured.
2.7.2.2.1. Enable

Enables/disables the Energy Savings feature. The Energy Savings 
feature is used to minimize the pumping that occurs during periods 
of high energy cost.

2.7.2.2.2. Peak Lead Time
The time in minutes before the Peak Start Time that the SITRANS 
LUT400 will begin pumping.

This value determines when pumping should start to ensure the 
level is as far as possible from the 2.7.1.6.ON Setpoint Pump 1 level. If 
level is already within 5% of 2.7.1.7.OFF Setpoint Pump 1, no action 
occurs. If multiple pump stations are series linked, ensure the Peak 
Lead Time entered is sufficient to attain the desired level in all 
stations before the high-energy cost period occurs.

2.7.2.2.3. Peak 1 Start Time
Sets the start time of the high energy cost period 1.

Used in conjunction with 2.7.2.2.4.Peak 1 End Time to define the high 
cost period.

For instructions on how to edit parameters with a string editor, see 
Using the string editor:  on page 187.

Options
* DISABLED

ENABLED

Values
Range: 0 to 65535

Default: 60

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00
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2.7.2.2.4. Peak 1 End Time
Sets the end time of the high energy cost period 1.

Used in conjunction with 2.7.2.2.3.Peak 1 Start Time to define the 
high cost period.

For instructions on how to edit parameters with a string editor, see 
Using the string editor:  on page 187.

2.7.2.2.5. Peak 2 Start Time
Sets the start time of the high energy cost period 2.

Used in conjunction with 2.7.2.2.6.Peak 2 End Time to define the high 
cost period.

2.7.2.2.6. Peak 2 End Time
Sets the end time of the high energy cost period 2.

Used in conjunction with 2.7.2.2.5.Peak 2 Start Time to define the 
high cost period.

2.7.2.2.7. Peak 3 Start Time
Sets the start time of the high energy cost period 3.

Used in conjunction with 2.7.2.2.8.Peak 3 End Time to define the high 
cost period.

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00
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2.7.2.2.8. Peak 3 End Time
Sets the end time of the high energy cost period 3.

Used in conjunction with 2.7.2.2.7.Peak 3 Start Time to define the 
high cost period.

2.7.2.2.9. Peak 4 Start Time
Sets the start time of the high energy cost period 4.

Used in conjunction with 2.7.2.2.10.Peak 4 End Time to define the high 
cost period.

2.7.2.2.10. Peak 4 End Time
Sets the end time of the high energy cost period 4.

Used in conjunction with 2.7.2.2.9.Peak 4 Start Time to define the 
high cost period.

2.7.2.2.11. Peak 5 Start Time
Sets the start time of the high energy cost period 5.

Used in conjunction with 2.7.2.2.12.Peak 5 End Time to define the high 
cost period.

2.7.2.2.12. Peak 5 End Time
Sets the end time of the high energy cost period 5.

Used in conjunction with 2.7.2.2.11.Peak 5 Start Time to define the 
high cost period.

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 
5:30pm, set parameter to 17:30)

Default: 00:00
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2.7.2.2.13. Peak ON Setpoint Pump 1
Sets the process point at which Pump 1 will turn on when in a peak 
period.

To allow the level to go beyond the normal Relay ON Setpoint before 
a pump is started, enter the value to be used for the high-energy 
cost period.

2.7.2.2.14. Peak OFF Setpoint Pump 1
Sets the process point at which Pump 1 will turn off when in a peak 
period.

To stop the pump(s) before the normal relay OFF Setpoint and 
reduce pump-running time. Enter the value to be used for the high 
cost period.

2.7.2.2.15. Peak ON Setpoint Pump 2
Sets the process point at which Pump 2 will turn on when in a peak 
period.

To allow the level to go beyond the normal Relay ON Setpoint before 
a pump is started, enter the value to be used for the high-energy 
cost period.

2.7.2.2.16. Peak OFF Setpoint Pump 2
Sets the process point at which Pump 2 will turn off when in a peak 
period.

To stop the pump(s) before the normal relay OFF Setpoint and 
reduce pump-running time. Enter the value to be used for the high 
cost period.

Values
Range: 0.000 to 99999.000 

Default: 0.000

Values
Range: 0.000 to 99999.000 

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000
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2.7.2.3. Pump Run-On
Available only on LUT430 (Pump and Flow model) and LUT440 (OCM 
model). 
For details on relay behaviour under fail-safe conditions, see Pump relays  
on page 66.
2.7.2.3.1. Enable

Enables/disables Pump Run-0n.

2.7.2.3.2. Run-On Interval
The number of hours between pump run-on occurrences.

To clear sediment in a pump-down wet well, run the pump after the 
normal OFF setpoint is reached to force some solid material through. 
This parameter sets the time between such events. Only the last 
pump running can run-on. 

2.7.2.3.3. Run-On Duration Pump 1
The number of seconds that the pump will run-on.

Each pump capacity will determine the amount of material that can 
be removed. Choose a value long enough to clean out the vessel 
bottom, yet short enough not to run the pump dry. Also be sure that 
this value does not overlap with Run-On Interval (2.7.2.3.2.).

2.7.2.3.4. Run-On Duration Pump 2
The number of seconds that the pump will run-on.

Each pump capacity will determine the amount of material that can 
be removed. Choose a value long enough to clean out the vessel 
bottom, yet short enough not to run the pump dry. Also be sure that 
this value does not overlap with Run-On Interval (2.7.2.3.2.).

Options
ENABLED

* DISABLED

Values
Range: 0.00 to 1000.00 

Default: 0.00

Values
Range: 0 to 65535

Default: 0

Values
Range: 0 to 65535 

Default: 0
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2.7.2.4. Pump Start Delays
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM 
model).
2.7.2.4.1. Delay Between Starts

The minimum delay (in seconds) between pump starts.

Use this feature to reduce a power surge from all pumps starting at 
the same time. This delay determines when the next pump is 
permitted to start.

2.7.2.4.2. Power Resumption Delay
The minimum delay (in seconds) before the first pump restart after a 
power failure.

This reduces the power surge from multiple instruments starting 
their pumps immediately on power resumption. When this delay 
expires, other pumps will start as per 2.7.2.4.1.Delay Between Starts.

2.7.3. Totalizers
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM model).

2.7.3.1. Running Totalizer 
Current pumped volume totalizer value in 2.6.2.Volume Units.

Pumped volume is automatically calculated whenever both Volume and 
Pumps are configured.

2.7.3.2. Totalizer Decimal Position
Sets the maximum number of decimal places to be displayed on the LCD.

Values
Range: 0 to 65535

Default: 10

Note: If a delay is configured, it will be respected when in 
simulation mode (see Pump relay behaviour during simulation  on 
page 121).

Values
Range: 0 to 65535 

Default: 60

Note: Default settings in the parameter tables are indicated with an asterisk 
(*) unless explicitly stated.

 Values
Range: 0.00 to 999999999

Default: 0.00

Options

NO DIGITS No digits after the decimal position

1 DIGIT 1 digit after the decimal point

* 2 DIGITS 2 digits after the decimal point

3 DIGITS 3 digits after the decimal point
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2.7.3.3. Totalizer Multiplier
Use this feature if the LCD Total increments by an amount that is too large 
(or too small).

Enter the factor by which actual volume is divided, prior to display on LCD. 
Use a value such that the nine-digit totalizer doesn’t roll over between 
readings.

Example:

For an LCD Total display in 1000s of volume units, enter 1000. In this example, 
10,000 volume units would display as 10.

2.7.3.4. Inflow/Discharge Adjust
Determines how inflow (or discharge) adjustment is made.

For an illustration, see Pump Totalizers  on page 264.

2.7.3.5. Reset Running Totalizer
Select YES to reset pumped volume totalizer value to zero.

Options

.001

.01

.1

* 1

10

100

1000

10,000

100,000

1,000,000

10,000,000

Options

*
BASED ON 
RATE
ESTIMATION

The inflow rate measured just prior to the start 
of the pump cycle is used to estimate the 
inflow for the duration of the cycle.

BASED ON 
PUMP CYCLE

The inflow is calculated using the change of 
volume between the end of the last pump cycle 
and the start of the next one, and the time 
period between the last cycle and the current 
one.

NO ADJUST-
MENT

No inflow adjustment is made (assumes an 
inflow of zero).

Options
* NO

YES
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2.8. Alarms
The SITRANS LUT400 supports eight alarm types. Any alarm can be assigned to any 
available relay. 
It is possible to assign more than one alarm to the same relay. In this case, the relay 
will activate if any one of the alarms is activated. If no alarms are activated, the relay 
will become inactive.
For details on relay behaviour under fail-safe conditions, see Alarm relays  on page 
66.

2.8.1. High Level Alarm
Reported when material level is within a user-defined range (see 2.8.1.2.High 
Level Value ON and 2.8.1.3.High Level Value OFF). 
Can be used in conjunction with 2.8.12.Time To Spill feature.
2.8.1.1. Enable

Enables/disables High Level Alarm.

2.8.1.2. High Level Value ON
Sets the material level (defined in 2.1.1.Units) at which the High Level Alarm 
will activate.

Value must be lower than Level To Spill (2.8.12.1.) if Time to Spill feature is 
used.

2.8.1.3. High Level Value OFF
Sets the material level (defined in 2.1.1.Units) at which the High Level Alarm 
will de-activate.

2.8.1.4. Assigned Relay
Determines which relay (if any) will be activated when the High Level Alarm 
activates. 

2.8.1.5. Alarm State
Read only. Used to view the current state of the High Level Alarm.

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Options
ENABLED

* DISABLED

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE
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2.8.2. Low Level Alarm
Reported when material level is within a user-defined range (see 2.8.2.2.Low 
Level Value ON and 2.8.2.3.Low Level Value OFF).
2.8.2.1. Enable

Enables/disables Low Level Alarm.

2.8.2.2. Low Level Value ON
Sets the material level (defined in 2.1.1.Units) at which the Low Level Alarm 
will activate.

2.8.2.3. Low Level Value OFF
Sets the material level (defined in 2.1.1.Units) at which the Low Level Alarm 
will de-activate.

2.8.2.4. Assigned Relay
Determines which relay (if any) will be activated when the Low Level Alarm 
activates. 

2.8.2.5. Alarm State
Read only. Used to view the current state of the Low Level Alarm.

2.8.3. Switch (Discrete Input) Alarm
Reported when Discrete Input (2.8.3.2.Discrete Input Number) is in a pre-
defined state (2.8.3.3.Discrete Input State).
2.8.3.1. Enable

Enables/disables Switch Alarm.

2.8.3.2. Discrete Input Number
Determines which discrete input to monitor for Switch Alarm.

Options
ENABLED

* DISABLED

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE

Options
ENABLED

* DISABLED

Options
* DISCRETE INPUT 1

DISCRETE INPUT 2
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2.8.3.3. Discrete Input State
Sets the state of the discrete input (2.8.3.2.Discrete Input Number) that will 
cause the Switch Alarm to activate.

2.8.3.4. Assigned Relay
Determines which relay (if any) will be activated when the Switch Alarm 
activates.

2.8.3.5. Alarm State
Read only. Used to view the current state of the Switch Alarm.

2.8.4. In-bounds Level Alarm
Reported when material level is within a user-defined range (see 
2.8.4.2.High Level Value and 2.8.4.3.Low Level Value).

2.8.4.1. Enable
Enables/disables In-bounds Level Alarm.

2.8.4.2. High Level Value
Sets the upper level value for range within which the In-bounds Level 
Alarm will activate.

2.8.4.3. Low Level Value
Sets the lower level value for range within which the In-bounds Level Alarm 
will activate.

Options
* ON

OFF

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE

Options
ENABLED

* DISABLED

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000
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2.8.4.4. Assigned Relay
Determines which relay (if any) will be activated when the In-bounds Level 
Alarm activates.

2.8.4.5. Alarm State
Read only. Used to view the current state of the In-bounds Level Alarm.

2.8.5. Out-of-bounds Level Alarm
Reported when material level is outside a user-defined range (see 2.8.5.2.High 
Level Value or 2.8.5.3.Low Level Value).

2.8.5.1. Enable
Enables/disables Out-of-bounds Level Alarm.

2.8.5.2. High Level Value
Sets the upper level value for range outside of which the Out-of-bounds 
Level Alarm will activate.

2.8.5.3. Low Level Value
Sets the lower level value for range outside of which the Out-of-bounds 
Level Alarm will activate.

2.8.5.4. Assigned Relay
Determines which relay (if any) will be activated when the Out-of-bounds 
Level Alarm activates.

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE

Options
ENALBED

* DISABLED

Values
Range: 0.000 to 99999.000

Default: 0.000

Values
Range: 0.000 to 99999.000

Default: 0.000

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3
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2.8.5.5. Alarm State
Read only. Used to view the current state of the Out-of-bounds Level Alarm.

2.8.6. Low Temperature Alarm
Reported when process temperature is within a user-defined range (see 
2.8.6.2.Low Temperature Value ON and 2.8.6.3.Low Temperature Value OFF).

2.8.6.1. Enable
Enables/disables Low Temperature Alarm.

2.8.6.2. Low Temperature Value ON
Sets the temperature value (defined in ° C) at which the Low Temperature 
Alarm will activate.

2.8.6.3. Low Temperature Value OFF
Sets the material level (defined in ° C) at which the Low Temperature Alarm 
will de-activate.

2.8.6.4. Assigned Relay
Determines which relay (if any) will be activated when the Low 
Temperature Alarm activates. 

2.8.6.5. Alarm State 
Read only. Used to view the current state of the Low Temperature Alarm.

2.8.7. High Temperature Alarm
Reported when process temperature is within a user-defined range (see 
2.8.7.2.High Temperature Value ON and 2.8.7.3.High Temperature Value OFF).

The temperature used for the alarm is the same temperature used for sound 
velocity compensation (see 2.12.1.3.Temperature Source).

Options
ACTIVE

INACTIVE

Options
ENABLED

* DISABLED

Values
Range: -273.0 to +273.0 °C (-459.0 to +523.0 °F)

Default: 0.0 °C

Values
Range: -273.0 to +273.0 °C (-459.0 to +523.0 °F)

Default: 0.0 °C

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE
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2.8.7.1. Enable
Enables/disables High Temperature Alarm.

2.8.7.2. High Temperature Value ON
Sets the temperature value (defined in ° C) at which the High Temperature 
Alarm will activate. 

2.8.7.3. High Temperature Value OFF
Sets the material level (defined in ° C) at which the High Temperature Alarm 
will de-activate.

2.8.7.4. Assigned Relay
Determines which relay (if any) will be activated when the High 
Temperature Alarm activates.

2.8.7.5. Alarm State
Read only. Used to view the current state of the High Temperature Alarm.

2.8.8. Fail-safe Fault Alarm
Reported when fault that has caused a fail-safe condition is present.
2.8.8.1. Enable

Enables/disables Fail-safe Alarm.

Options
ENABLED

* DISABLED

Values
Range: -273.0 to +273.0 °C (-459.0 to +523.0 °F)

Default: 100.0 °C

Values
Range: -273.0 to +273.0 °C (-459.0 to +523.0 °F)

Default: 100.0 °C

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE

Options
ENABLED

* DISABLED
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2.8.8.2. Assigned Relay
Determines which relay (if any) will be activated when the Fail-safe Alarm 
activates.

2.8.8.3. Alarm State
Read only. Use to view the current state of the Fail-safe Alarm.

2.8.9. High Flowrate Alarm
Available only on LUT440 (OCM model).
Reported when the OCM flowrate is within a user-defined range (see 
2.8.9.2.High Flowrate Value ON and 2.8.9.3.High Flowrate Value OFF).

2.8.9.1. Enable
Enables/disables High Flowrate Alarm.

2.8.9.2. High Flowrate Value ON
Sets the flowrate value (defined in 2.15.3.7.Flowrate Units) at which the 
High Flowrate Alarm will activate. 

2.8.9.3. High Flowrate Value OFF
Sets the material level (defined in 2.15.3.7.Flowrate Units) at which the High 
Flowrate Alarm will de-activate.

2.8.9.4. Assigned Relay
Determines which relay (if any) will be activated when the High Flowrate 
Alarm activates.

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE

Options
ENABLED

* DISABLED

Values
Range: 0 to 9999999

Default: 0

Values
Range: 0 to 9999999

Default: 0

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3
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2.8.9.5. Alarm State
Read only. Used to view the current state of the High Flowrate Alarm.

2.8.10. Low Flowrate Alarm
Available only on LUT440 (OCM model).
Reported when the OCM flowrate is within a user-defined range (see 
2.8.10.2.Low Flowrate Value ON and 2.8.10.3.Low Flowrate Value OFF).

2.8.10.1. Enable
Enables/disables Low Flowrate Alarm.

2.8.10.2. Low Flowrate Value ON
Sets the flowrate value (defined in 2.15.3.7.Flowrate Units) at which the Low 
Flowrate Alarm will activate. 

2.8.10.3. Low Flowrate Value OFF
Sets the material level (defined in 2.15.3.7.Flowrate Units) at which the Low 
Flowrate Alarm will de-activate.

2.8.10.4. Assigned Relay
Determines which relay (if any) will be activated when the Low Flowrate 
Alarm activates.

2.8.10.5. Alarm State
Read only. Used to view the current state of the Low Flowrate Alarm.

2.8.11. Relay Logic
Relay contact operation is NORMALLY CLOSED for alarms and NORMALLY 
OPEN for controls.
By default an alarm contact is Normally Closed. When an alarm activates, the 
corresponding relay coil is de-energized. By setting this parameter to Normally 
Open, the relay coil will be energized when an alarm assigned to the relay 
activates.

Options
ACTIVE

INACTIVE

Options
ENABLED

* DISABLED

Values
Range: 0 to 9999999

Default: 0

Values
Range: 0 to 9999999

Default: 0

Options

* NO RELAY

RELAY 1

RELAY 2

RELAY 3

Options
ACTIVE

INACTIVE
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2.8.11.1. Relay 1 Logic
Use to change the behaviour of Relay 1 when assigned to an alarm.

2.8.11.2. Relay 2 Logic
Use to change the behaviour of Relay 2 when assigned to an alarm.

2.8.11.3. Relay 3 Logic
Use to change the behaviour of Relay 3 when assigned to an alarm.

2.8.12. Time To Spill
Used to predict when an overflow (spill) condition may occur. This feature 
works in conjunction with the 2.8.1.High Level Alarm.

2.8.12.1. Level To Spill
Value (defined in 2.1.1.Units) representing material level at which a spill will 
occur.

This value must be greater than high level alarm ON setpoint [High Level 
Value ON (2.8.1.2.)].

2.8.12.2. Minutes Left To Spill
Read only. Calculated value representing minutes remaining before a spill 
will occur.
Enter the level at which a spill condition will occur in 2.8.12.1.Level To Spill. 
When the High Level Alarm is tripped, the estimated time to spill is 
displayed in 2.8.12.2.Minutes Left To Spill.  The estimated time is calculated 
by the LUT400 based on the material level and the rate of change of the 
material level. If the High Level alarm is not tripped, or the material level is 
falling, then the estimated time to spill will display as zero.

2.9. Discrete Inputs
Discrete inputs are used to trigger or alter the way SITRANS LUT400 controls devices 
such as pumps and alarms. Discrete inputs can be used for the following:

• as a backup level override
• allowing the device to be more flexible by interlocking control functions with 

external conditions. 
For more detail see Discrete Inputs  on page 69.

Options
NORMALLY OPEN

* NORMALLY CLOSED

Options
NORMALLY OPEN

* NORMALLY CLOSED

Options
NORMALLY OPEN

* NORMALLY CLOSED

Options
-999999.000 to 999999.000 

Default: 0.000

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.
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2.9.1. Backup Level Override
Use this feature to override the material reading by a discrete input such as a 
contacting point device. The material reading will be fixed at the programmed 
switch level until the discrete input is released. The LUT400 makes decisions 
based on the override values.

2.9.1.1. Enable
Enables/disables the Backup Level Override function.

2.9.1.2. Level Override Value
This value is substituted for the current reading when the selected discrete 
input is enabled and ON.

Value is defined in current 2.1.1.Units, and is valid only for level (and head 
when 2.1.2.Sensor Mode set to Flow). (Volume is calculated based on the 
Backup level.)

2.9.1.3. Discrete Input Number
Sets the discrete input to act as the source for a level reading override 
when enabled.

Options
ENABLED

* DISABLED

Values
Range: 0.000 to 60.000

Default: 0.000

Options
* DISCRETE INPUT 1

DISCRETE INPUT 2
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2.9.2. Discrete Input Logic
Use the following parameters to configure the discrete input itself.
Normal state is standard operation, with the SITRANS LUT400 sensing the 
material level and controlling the pumps, and no faults or alarms present. The 
discrete input contacts are either NORMALLY OPEN or NORMALLY CLOSED 
when the system state is normal.

For example:
When discrete input logic is set to Normally Open and discrete input has no 
voltage applied on the terminal block, the discrete input will be inactive (OFF).

2.9.2.1. Discrete Input 1 Logic
Use to change the behaviour of the Discrete Input 1.

2.9.2.2. Discrete Input 1 Scaled State
Read only. Indicates the current state of Discrete Input 1.

2.9.2.3. Discrete Input 2 Logic
Use to change the behaviour of Discrete Input 2.

2.9.2.4. Discrete Input 2 Scaled State
Read only. Indicates the current state of Discrete Input 2.

Discrete Input Logic Terminal Block Discrete Input Scaled State

Normally Open
Voltage applied ON

No voltage applied OFF

Normally Closed
Voltage applied OFF

No voltage applied ON

Options
* NORMALLY OPEN

NORMALLY CLOSED

Options
ON

* OFF

Options
* NORMALLY OPEN

NORMALLY CLOSED

Options
ON

* OFF
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2.9.3. Pump Interlock
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM model).
Discrete inputs allow you to supply pump information to the SITRANS LUT400 
so that it can modify pump algorithms. The following parameters are used to 
program actions that should take place when a pump is determined to be in a 
failed state. For example, a pump interlock can be used to ensure that any pump 
reporting a failure is removed from the pumping rotation.

2.9.3.1. Enable Pump 1
Enables/disables the pump start interlock. If ON, then Pump 1 will not start 
if the corresponding discrete input [Pump 1 Discrete Input (2.9.3.2.)] is 
active.

2.9.3.2. Pump 1 Discrete Input
Sets the discrete input to use for pump start interlock on Pump 1.

2.9.3.3. Enable Pump 2
Enables/disables the pump start interlock. If ON, then Pump 2 will not start 
if the corresponding discrete input [Pump 2 Discrete Input (2.9.3.4.)] is 
active.

2.9.3.4. Pump 2 Discrete Input
Sets the discrete input to use for pump start interlock on Pump 2.

2.10. Data Logging
Use data logging to keep track of a parameter value on regular intervals or when an 
event is triggered. Up to 3 data logs can be configured, and collectively the logs can 
hold approximately 30,000 entries. [To view these data logs, see View Logs (3.2.6.).]

Options
ENABLED

* DISABLED

Options
* DISCRETE INPUT 1

DISCRETE INPUT 2

Options
ENABLED

* DISABLED

Options
* DISCRETE INPUT 1

DISCRETE INPUT 2

Notes: 
• No data logs are written while device is connected to a PC via USB.
• Always disable Data Logging before removing log files (when log memory 

becomes full). See Viewing the Data Log  on page 119.

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 174 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

Pa
ra

m
et

er
s

2.10.1. Process Value Log

2.10.1.1. Enable
Enables/disables Process Value (PV) Logging.

2.10.1.2. Process Values Log Rate
Sets Process Value (PV) Logging rate in minutes.

2.10.2. Alarm Log

2.10.2.1. Enable
Enables/disables Alarm Logging.

2.10.3. Flow Log
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM model).

2.10.3.1. Flow Log Mode
Menu number 2.10.3.1. visible on LUT430 (Pump and Flow model).

OR

2.10.3.2. Flow Log Mode
Menu number 2.10.3.2. visible on LUT440 (OCM model).

Sets flow log mode.

2.10.3.3. Standard Flow Log Interval
Sets standard flow log interval in minutes, when 2.10.3.1.Flow Log Mode set 
to a fixed or variable rate.

Options
ENABLED

* DISABLED

Values
Range: 1 to 1440

Default: 1

Options
ENABLED

* DISABLED

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Options 

* OFF

FIXED RATE

VARIABLE PERCENTAGE MAX FLOW / MIN a

a.Option available only for LUT440.

VARIABLE PERCENTAGE MAX FLOW a

VARIABLE PERCENTAGE MAX HEAD a

 Values
Range: 1 to 1440 

Default: 1
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2.10.3.4. Standard Flow Log Setpoint
Sets standard flow setpoint as a percent based on flow log mode, when 
2.10.3.1.Flow Log Mode set to a variable rate.

2.10.3.5. Rapid Flow Log Interval
Sets rapid flow log interval in minutes, when 2.10.3.1.Flow Log Mode set to 
a variable rate.

2.10.3.6. Rapid Flow Log Setpoint
Sets rapid flow setpoint as a percent based on flow logger mode, when 
2.10.3.1.Flow Log Mode set to a variable rate.

2.11. Other Control

2.11.1. Elapsed Time Relay
This function drives a relay based on an interval and duration of time. The relay 
toggles on and off at a rate set by the parameters below. (This relay is not 
affected by LOE, faults, alarms, or any other condition within the device.)
2.11.1.1. Enable

Enables/disables elapsed time relay control.

2.11.1.2. Interval
The interval in minutes from the activation of the relay until the next 
activation.

This value must be greater than the 2.11.1.3.Relay Duration or the relay will 
never reset. The first activation occurs when the device is powered on.

2.11.1.3. Relay Duration
The time in seconds from one change of state in the relay to the next.

This value must be less than the 2.11.1.2.Interval or the relay will never 
reset. 

 Values
Range: 0.000 to 110.000

Default: 0.000

 Values
Range: 1 to 1440

Default: 1

 Values
Range: 0.000 to 110.000

Default: 0.000

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Options
ENABLED

* DISABLED

Values 
Range: 0.1 to 99999 a

a. Fractional values are allowed, such as 0.5 for 30 seconds

Default: 60.0

Values 
Range: 1 to 9999

Default: 10
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2.11.1.4. Assigned Relay
Determines the relay assigned to elapsed time control.

2.11.1.5. Relay Logic
Use to change the behaviour of the relay assigned to elapsed time control.

Relay contact operation is NORMALLY CLOSED for alarms and NORMALLY 
OPEN for controls.

By default a control contact is Normally Open. For 2.11.1.3.Relay Duration 
the corresponding relay coil is energized. By setting this parameter to 
Normally Closed, the relay coil will be de-energized for the duration phase.

2.11.2. Time of Day Relay
This function drives a relay based on time of day. The relay toggles on and off 
at a rate set by the parameters below. This relay is not affected by LOE, faults, 
alarms, or any other condition within the device.
2.11.2.1. Enable

Enables/disables time of day relay control.

2.11.2.2. Activation Time
Sets time of day, using a 24-hour clock, at which the relay should activate.

For instructions on how to edit parameters with a string editor, see Using 
the string editor:  on page 187.

2.11.2.3. Relay Duration
The time in seconds from one change of state in the relay to the next.

2.11.2.4. Assigned Relay
Determines the relay assigned to time of day control. 

Options

* RELAY 1

RELAY 2

RELAY 3

Options
* NORMALLY OPEN

NORMALLY CLOSED

Options
ENABLED

* DISABLED

Values

Range: 00:00 to 23:59

Format: HH:MM (24 hour format, e.g. for 5:30 pm, set 
parameter to 17:30)

Default: 00:00

Values 
Range: 1 to 9999

Default: 10

Options

* RELAY 1

RELAY 2

RELAY 3
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2.11.2.5. Relay Logic
Use to change the behaviour of the relay assigned to time of day control.

Relay contact operation is NORMALLY CLOSED for alarms and NORMALLY 
OPEN for controls.

By default a control contact is Normally Open. For 2.11.2.3.Relay Duration 
the corresponding relay coil is energized. By setting this parameter to 
Normally Closed, the relay coil will be de-energized for the duration phase.

2.11.3. External Totalizer
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM model).
This function tracks the volume of material that passes through a system. The 
external totalizer controls a relay to signal an external totalizing device. The 
relay toggles on and off at a rate set by the parameters below. (For details on 
relay behaviour under fail-safe conditions, see Miscellaneous relays  on page 
66.)

2.11.3.1. Enable
Enables/disables external totalizer relay control.

2.11.3.2. Multiplier
Use to scale the external totalizer up or down as required.

This allows the totalizer relay to click for different values of volume.

Example:

To click once every 4310 units, set 2.11.3.2. Multiplier to 4310.

2.11.3.3. Relay Duration
The time in seconds from one change of state in the relay to the next.

2.11.3.4. Assigned Relay
Determines the relay assigned to external totalizer control.

Options
* NORMALLY OPEN

NORMALLY CLOSED

Note: Default settings in the parameter tables are indicated with an asterisk 
(*) unless explicitly stated.

Options
ENABLED

* DISABLED

Values
Range: 0.0000001 to 99999.000

Default: 1.000

Values
Range: 0.1 to 1024.0

Default: 0.2

Options

* RELAY 1

RELAY 2

RELAY 3
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2.11.3.5. Relay Logic
Use to change the behaviour of the relay assigned to external totalizer 
control.

Relay contact operation is NORMALLY CLOSED for alarms and NORMALLY 
OPEN for controls.

By default a control contact is Normally Open. For 2.11.3.3.Relay Duration 
the corresponding relay coil is energized. By setting this parameter to 
Normally Closed, the relay coil will be de-energized for the activation 
phase.

2.11.4. External Sampler
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM model).
This function uses a relay to signal a flow sampling device when a certain 
volume of material has passed through a system (set by the Multiplier), or after 
a defined period of time (set by the Interval). The relay toggles on and off at a 
rate set by the parameters below. (For details on relay behaviour under fail-safe 
conditions, see Miscellaneous relays  on page 66.)

2.11.4.1. Enable
Enables/disables flow sampler relay control.

2.11.4.2. Multiplier
Use to scale the external sampler up or down as required.

This allows the sampler relay to click for different values of volume.

Example:

To click once every 4310 flow units, set 2.11.4.2. Multiplier to 4310.

2.11.4.3. Interval
The time in hours from the activation of the relay until the next activation.

Set the time to activate the relay during low-flow conditions.

Options
* NORMALLY OPEN

NORMALLY CLOSED

Note: Default settings in the parameter tables are indicated with an asterisk 
(*) unless explicitly stated.

Options
ENABLED

* DISABLED

Values
Range: 0.0000001 to 99999.000

Default: 1.000

Values
Range: 0.10 to 99999.00

Default: 1.00
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2.11.4.4. Relay Duration
The time in seconds from one change of state in the relay to the next.

This value must be less than the 2.11.4.3.Interval or the relay will never 
reset.

2.11.4.5. Assigned Relay
Determines the relay assigned to flow sampler control.

2.11.4.6. Relay Logic
Use to change the behaviour of the relay assigned to flow sampler control.

Relay contact operation is NORMALLY CLOSED for alarms and NORMALLY 
OPEN for controls.

By default a control contact is Normally Open. For 2.11.4.3.Interval the 
corresponding relay coil is energized. By setting this parameter to Normally 
Closed, the relay coil will be de-energized for the activation phase.

2.12. Signal Processing

2.12.1. Temperature and Velocity

2.12.1.1. Sound Velocity
The value adjusted based on the Sound Velocity at 20 degrees C (2.12.1.5.) 
vs. Process Temperature (2.12.1.2.) characteristics of air.

Alternatively, enter the current sound velocity (if known), or perform an 
2.12.1.6.Auto Sound Velocity calibration. Value is always reported in m/s.

2.12.1.2. Process Temperature
View the transducer temperature in °C.
If Temperature Source (2.12.1.3.) is set to any value other than Fixed 
Temperature (2.12.1.4.), the value displayed is the temperature measured. If 
Temperature Source is set to Temp Fixed, the Fixed Temperature (2.12.1.4.) 
value is displayed.

Values
Range: 0.1 to 1024.0

Default: 0.2

Options

* RELAY 1

RELAY 2

RELAY 3

Options
* NORMALLY OPEN

NORMALLY CLOSED

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Values
Range: 125.000 to 20000.000 m/s

Default: 344.130 m/s
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2.12.1.3. Temperature Source
Source of the temperature reading used to adjust the speed of sound.

With this default, the SITRANS LUT400 uses the transducer’s internal 
temperature sensor (standard in all Siemens EchoMax Transducers).

If the transducer does not have an internal temperature sensor, Fixed 
Temperature value, or an External TS-3 temperature sensor can be used.

If the acoustic beam atmosphere temperature varies with distance from 
the transducer, connect a TS-3 Temperature Sensor and Ultrasonic/
Temperature Transducer, and select Average of Sensors (Transducer and 
TS-3).

In gasses other than air, the temperature variation may not correspond 
with the speed of sound variation. In these cases, turn off the temperature 
sensor, select value Fixed Temperature, and set a fixed temperature [see 
Fixed Temperature (2.12.1.4.)].

If Ultrasonic/Temperature Transducer, TS-3 Temperature Sensor, or 
Average of Sensors value is selected, faults on the temperature sensors 
will be displayed if the sensor appears open or short.

When a transducer temperature sensor fault occurs, Temperature Source 
can be set to FIXED. This allows the device to continue measuring (and no 
cable fault will display), until the transducer is replaced. Once replaced, set 
Temperature Source back to its original setting.

2.12.1.4. Fixed Temperature
Use this feature if a temperature sensing device is not used.

Enter the temperature (in °C) of the atmosphere within the transducer 
acoustic beam. If the temperature varies with distance from the 
transducer, enter the average temperature.

2.12.1.5. Sound Velocity at 20 degrees C 
This value is used to automatically calculate sound velocity.

If the acoustic beam atmosphere sound velocity at 20°C (68 °F) is known, 
and the sound velocity vs. temperature characteristics are similar to that 
of air (344.1 m/s), enter the sound velocity. Units displayed in meters per 
second (m/s).

Options * TRANSDUCER

FIXED TEMPERATURE

EXTERNAL TS-3

AVERAGE OF SENSORS (Transducer and TS-3)

Values
Range: -100.0 to +150.0 °C 

Default: +20.0 °C

Values
Range: 125.000 to 20000.000 m/s

Default: 344.13 m/s
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2.12.1.6. Auto Sound Velocity

Adjusts the speed of sound and changes the distance measurement 
calculations. Defined in 2.1.1.Units.

Condition for use of this feature: 

• The acoustic beam atmosphere is other than air
• The acoustic beam atmosphere temperature is unknown
• The Reading accuracy is acceptable at higher material levels only
For best results, calibrate with the level at a known value near Low 
Calibration Point.

Using Auto Sound Velocity:

Start with a steady distance at a known high distance value (high distance 
value equates to a low level value).

1. Review the distance measurement via LUI for approximately 30 seconds 
to verify repeatability.

2. Measure the actual distance (for example, with a tape measure).

3. Enter the actual distance, defined in 2.1.1.Units.

Repeat this procedure if the atmosphere type, concentration, or 
temperature conditions are different from when the last sound velocity 
calibration was performed.

2.12.2. Echo Select

2.12.2.1. Algorithm
Selects the algorithm to be applied to the echo profile to extract the true 
echo. 

For more details, see Algorithm  on page 257.

Note: Auto Sound Velocity supports adjustments to distance value only.

Values Range: 0.000 to 60.000

Note: In gasses other than air, the temperature variation may not 
correspond with the speed of sound variation. Turn off temperature 
sensor and use a fixed temperature.

Options

TF TRUE FIRST True First echo

TR TRACKER TRacker

L LARGEST ECHO Largest echo 

* BLF BEST F-L
Best of First and Largest 
echo 

ALF AREA LARGEST FIRST Area, Largest and First
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2.12.2.2. Echo Threshold
Sets the minimum echo confidence that the echo must meet in order to 
prevent a Loss of Echo condition and the expiration of the Fail-safe (LOE) 
timer. When Confidence (3.2.9.2.) exceeds Echo Threshold (2.12.2.2.), the 
echo is accepted as a valid echo and is evaluated. 

Use this feature when an incorrect material level is reported. 

2.12.2.3. Reform Echo
Smooth jagged peaks in the echo profile.

Use this feature when monitoring solids if the reported level fluctuates 
slightly though the monitored surface is still. Enter the amount (in ms) of 
Echo Profile smoothing required. When a value is keyed in, the nearest 
acceptable value is entered.

2.12.2.4. Narrow Echo Filter
Filters out echoes of a specific width.

Use this for transducer acoustic beam interference (e.g. ladder rungs). 
Enter the width of false echoes (in groups of 25 ms), to be removed from 
the Echo Profile. [For example, select value of 3 to remove 75 ms (3 x 25 
ms) of false echos from the profile.]

When a value is keyed in, the nearest acceptable value is entered.

2.12.2.5. Submergence Detection
Enables/disables submergence detection.

(Submergence Detection Shield must first be installed on transducer.) 
When this parameter is enabled and the transducer becomes submerged:

• fault code 26 is displayed (see General Fault Codes  on page 231),
• mA output immediately advances to Minimum mA Limit (2.5.5.) orMaxi-

mum mA Limit (2.5.6.), as defined by the application,
• DISTANCE is set to zero (corresponding to a high level),
• pumps and alarms operate normally (according to level), therefore they 

remain ON (or activate if not already ON).

Values
Range: -20 to 128

Default: 5

Values
Range: 0 to 50 intervalsa (greater = wider)

a. one interval = span of 24.5 micro seconds

Default: 0

Values
Range: 0 to 14 intervalsa (greater = wider)

a. one interval = span of 24.5 micro seconds

Default: 2

Values
Enabled

* Disabled
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The submergence condition remains in effect until the transducer is no 
longer submerged. A valid echo must then be detected before the LOE 
Timer expires or the device will enter fail-safe condition (see 2.4. Fail-
Safe).

2.12.3. TVT Setup

2.12.3.1. Auto False Echo Suppression
Used together with Auto False Echo Suppression Range (2.12.3.2.) to 
screen out false echoes in a vessel with known obstructions. A ’learned 
TVT’ (time varying threshold) replaces the default TVT over a specified 
range. See Shaper Mode and Auto False Echo Suppression  on page 258 
for a more detailed explanation.

a) Determine Auto False Echo Suppression Range. Measure the actual 
distance from the sensor reference point to the material surface 
using a rope or tape measure.

b) Subtract 0.5 m (20") from this distance, and use the resulting value.

To set Auto False Echo Suppression via SIMATIC PDM:

Open the menu Device – Echo Profile Utilities and click on the tab Auto 
False Echo Suppression. 
(For more detailed instructions see Auto False Echo Suppression in LUT400 
Communications manual1.)

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Notes: 
• Make sure material level is below all known obstructions when Auto 

False Echo Suppression is used to learn the echo profile. (An empty or 
almost empty vessel is recommended.)

• Note the distance to material level when Auto False Echo learns the 
environment. Set Auto False Echo Suppression Range to a shorter 
distance to avoid the material echo being screened out.

• Set Auto False Echo Suppression and Auto False Echo Suppression 
Range during startup, if possible.

• All other tuning and filter adjustments (such as 2.12.2.4. Narrow Echo 
Filter, 2.12.2.3. Reform Echo, 2.12.3.3. Hover Level, etc.) should be 
completed prior to using Auto False Echo Suppression to ensure that 
the learned profile is representative.

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)
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To set Auto False Echo Suppression via the local push buttons:

c) Navigate to Setup (2.) > Signal Processing (2.12.) > TVT Setup (2.12.3.) 
> Auto False Echo Suppression Range (2.12.3.2.), and enter the value 
calculated in step b).

d) Navigate to Setup (2.) > Signal Processing (2.12.) > TVT Setup (2.12.3.) 
> Auto False Echo Suppression (2.12.3.1.), and press RIGHT arrow to 
open Edit Mode

e) Select Learn. The device will automatically revert to On (Use 
Learned TVT) after a few seconds.

2.12.3.2. Auto False Echo Suppression Range
Specifies the range within which Learned TVT is used (see Auto False Echo 
Suppression  on page 183 for more detail). 

a) Calculate range according to Auto False Echo Suppression (2.12.3.1.) 
steps a) and b).

b) Press RIGHT arrow to open Edit mode.
c) Enter the new value and press RIGHT arrow to accept it.
d) Navigate to Setup (2.) > Signal Processing (2.12.) > TVT Setup (2.12.3.) 

> Auto False Echo Suppression (2.12.3.1.), and set value.

2.12.3.3. Hover Level
Defines how high the TVT (Time Varying Threshold) is placed above the 
noise floor of the echo profile, as a percentage of the difference between 
the peak of the largest echo in the profile and the noise floor. See Example 
before Auto False Echo Suppression  on page 259 for an illustration.

When the device is located in the center of the vessel, the TVT hover level 
may be lowered to increase the confidence level of the largest echo.

2.12.3.4. Shaper Mode
Enables/disables the TVT shaper.

Turn TVT Shaper Mode ON before using 2.12.4.TVT Shaper. Turn the TVT 
Shaper ON and OFF while monitoring the effect to pick up the true echo. 

2.12.4. TVT Shaper
Adjusts the TVT (Time Varying Threshold) at a specified range (breakpoint on 
the TVT). This allows you to reshape the TVT to avoid unwanted echoes. There 
are 40 breakpoints arranged in 5 groups. (We recommend using SIMATIC PDM 
to access this feature.)

Options
OFF Default TVT will be used.

* ON ’Learned’ TVT will be used.

LEARN ’Learn’ the TVT.

Values 
Range: 0.000 to 60.000 m

Default: 1.000

Values 
Range: 0 to 100

Default: 40

Options
ON

* OFF
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To use TVT shaper via SIMATIC PDM: 
a) Open the menu Device – Echo Profile Utilities and click on TVT Shaper. (For 

more details see TVT Shaper in LUT400 Communications manual1.)

To use TVT shaper via local push buttons:
a) Navigate to Setup (2.) > Signal Processing (2.12.) > TVT Setup (2.12.3.) > 

Shaper Mode (2.12.3.4.), and select ON.
b) From the TVT Setup menu, LEFT ARROW to the Signal Processing menu, 

and DOWN ARROW to TVT Shaper. RIGHT ARROW to enter the TVT 
Shaper menu and RIGHT ARROW to edit Breakpoint 1-8 (2.12.4.1.).

c) Open TVT Breakpoint 1 enter the TVT Offset value (between –50 and 50).
d) Go to the next TVT Breakpoint and repeat steps c) and d) till all desired 

breakpoint values have been entered.

2.12.4.1. Breakpoint 1-8

2.12.4.2. Breakpoint 9-16

2.12.4.3. Breakpoint 17-24

2.12.4.4. Breakpoint 25-32

2.12.4.5. Breakpoint 33-40

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Values 
Range: –50 to 50 dB

Default: 0 dB

Values 
Range: –50 to 50 dB

Default: 0 dB

Values 
Range: –50 to 50 dB

Default: 0 dB

Values 
Range: –50 to 50 dB

Default: 0 dB

Values 
Range: –50 to 50 dB

Default: 0 dB
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2.12.5. Measured Values 
Read only. Allows you to view measured values for diagnostic purposes.

To access measured values via SIMATIC PDM:
Open the menu View – Process Variables. 

2.12.5.1. Level Measurement
The distance to monitored surface referenced from Low Calibration Point 
(2.2.1.), defined in Units (2.1.1.).

2.12.5.2. Space Measurement
The distance to monitored surface referenced from High Calibration Point 
(2.2.2.), defined in Units (2.1.1.).

2.12.5.3. Distance Measurement
The distance to monitored surface referenced from the transducer face 
(sensor reference point), defined in Units (2.1.1.).

2.12.5.4. Volume Measurement
The calculated vessel volume (calculated from level and scaled according 
to vessel shape) in Volume Units (2.6.2.).

2.12.5.5. Head Measurement
Available only on LUT430 (Pump and Flow model), and LUT440 (OCM 
model). 
Corresponds to Head [the distance from Zero Head Offset (2.15.3.5.) to the 
monitored surface in Units (2.1.1.)].

2.12.5.6. Flow Measurement
Available only on LUT430 (Pump and Flow model) and LUT440 (OCM 
model).
The calculated flowrate, defined in Flowrate Units (2.15.3.7.). 

2.13. Display

2.13.1. Local Display Backlight
Time the backlight remains on.

Available only via LUI. 

Note: These parameters will display the simulated value when in simulation 
mode (see Simulation process  on page 122).

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Options

OFF

* ON

TIMED (on for five minutes after key 
press - takes effect in Measurement 
View only)
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2.13.2. LCD Contrast
The factory setting is for optimum visibility at room temperature and in average 
light conditions. Extremes of temperature will lessen the contrast.

Adjust the value to improve visibility in different temperatures and luminosity.
Available only via LUI and web browser.

2.14. Date and Time
Enter the current date and time using the local push buttons.

Parameter Edit mode displays a string editor.

Using the string editor:

a) Use RIGHT/LEFT arrow to select the character position in the parameter field to 
be edited.

b) As each character is highlighted (selected), use the UP/DOWN arrow to change 
the character. 

• Use the DOWN arrow to select a character from the string above the parameter 
value. 

• Use the UP arrow to select a character from the string below the parameter 
value.

c) To escape without saving your changes, press LEFT arrow continually until ESC is 
highlighted. Press LEFT arrow again to escape without saving changes. 
Otherwise, when new parameter value is correct, press RIGHT arrow continually 
until OK is highlighted.

d) Press RIGHT arrow to accept the new value. The LCD returns to parameter view 
and displays the new selection. Review for accuracy.

Special Characters:

Values 
Range: 0 (Low contrast) to 20 (High contrast)

Default: 10

Character Description Function
: colon enters colon in text string

space enters space in text string

/ slash enters slash in text string

- hyphen enters hyphen in text string

_ underscore enters underscore in text string

DATE (YYYY-MM-DD) 2.14.1

ESC. 2011-02-2

6789 ][ abcdefg

MNOPQRSTUVWXYZ:/-_01234

OK5
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2.14.1. Date
Date is the current date in the format: YYYY-MM-DD.

2.14.2. Time
Time is the current time in 24-hour format: HH:MM[:SS].

A value for seconds [:SS] is optional. If a value is not entered, the clock will 
default to 0 seconds.

2.14.3. Daylight Saving
Use the following parameters to enable and define start/end dates for daylight 
saving. (Start/end time of day is always 2:00am.)
Example:

Set the start of daylight saving to the second Sunday in February, and the end 
of daylight saving to the first Sunday in November:

Starting Ordinal = Second
Starting Day = Sunday
Starting Month = February
Ending Ordinal = First
Ending Day = Sunday
Ending Month = November

2.14.3.1. Enable
Enables/disables daylight saving.

2.14.3.2. Starting Ordinal
The order of the day within the month when daylight saving will begin.

’x’ in box deletes highlighted character in text string

][ square brackets
inserts space between two characters in text string (lim-
ited to one space between characters)

return arrow key
deletes characters (including currently highlighted charac-
ter) to end of text string

Values Range: 1900-01-01 to 2155-12-31

Values Range: 00:00:00 to 23:59:59

Options
ENABLED

* DISABLED

Options
FIRST, SECOND, THIRD, FOURTH

* FIRST

Character Description Function
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2.14.3.3. Starting Day
The day of the week on which daylight saving will begin.

2.14.3.4. Starting Month
The month in which daylight saving will begin.

2.14.3.5. Ending Ordinal
The order of the day within the month when daylight saving will end.

2.14.3.6. Ending Day
The day of the week on which daylight saving will end.

2.14.3.7. Ending Month
The month in which daylight saving will end.

2.15. Flow
Available only on LUT430 (Pump and Flow model) and LUT440 (OCM model).

Options
SUNDAY, MONDAY, TUESDAY, WEDNESDAY, 
THURSDAY, FRIDAY, SATURDAY

* SUNDAY

Options

JANUARY, FEBRUARY, MARCH, APRIL, MAY, 
JUNE, JULY, AUGUST, SEPTEMBER, OCTO-
BER, NOVEMBER, DECEMBER

* JANUARY

Options
FIRST, SECOND, THIRD, FOURTH

* FIRST

Options
SUNDAY, MONDAY, TUESDAY, WEDNESDAY, 
THURSDAY, FRIDAY, SATURDAY

* SUNDAY

Options

JANUARY, FEBRUARY, MARCH, APRIL, MAY, 
JUNE, JULY, AUGUST, SEPTEMBER, OCTO-
BER, NOVEMBER, DECEMBER

* JANUARY

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.
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2.15.1. Primary Measuring Device (PMD)
The type of primary measuring device (PMD) used.

The LUT400 is pre-programmed for common PMD flow calculations. If your 
PMD is not listed, use a Universal Flow calculation. SeeUniversal calculation 
support  on page 116.

2.15.2. Auto Zero Head
Calibrates 2.15.3.5.Zero Head Offset (defined in 2.1.1.Units) based on actual 
head measurements.

Use this parameter when the reported head is consistently high or low by a 
fixed amount.
Before using this feature, verify the following parameters are correct:
• 2.2.1.Low Calibration Point
• 2.12.1.2.Process Temperature
With HEAD steady...

a) Measure the actual head (e.g. with a tape measure or solid rule)
b) Enter the actual head value

The deviation between the entered head value and the calibrated value, is 
stored in 2.15.3.5.Zero Head Offset.

Values

* OFF (no calculation)

EXPONENTIAL DEVICES

RECTANGULAR FLUME BS-3680 

ROUND NOSE HORIZONTAL CR. BS-3680 

TRAPEZOIDAL FLUME BS-3680 

U-FLUME BS-3680 

FINITE CREST WEIR BS-3680 

THIN PLATE RECT. WEIR BS-3680 

THIN PLATE V-NOTCH WEIR BS-3680 

RECT. WEIR CONTRACTED

ROUND PIPE

PALMER BOWLUS FLUME

H-FLUME

UNIVERSAL HEAD FLOW

 Values
Range: -60.000 to 60.000 

Default: 0.000
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2.15.3. Basic Setup

2.15.3.1. Method of Flow Calculation
Sets the method of flow calculation.

Set this parameter to Ratiometric only if the primary measuring device 
(PMD) supports ratiometric calculations. (Note that Palmer Bowlus Flume 
and H-Flume support ratiometric calculations only.) For more details on 
Absolute and Ratiometric calculations, see Method of Flow Calculation  on 
page 266.

2.15.3.2. Flow Exponent
The exponent for the flow calculation formula.

Use this parameter if the PMD is set to Exponential devices. It creates an 
exponential curve with end points set by 2.15.3.3.Maximum Head and 
2.15.3.5.Zero Head Offset and with the curve based on the specified 
exponent.

Use the exponent specified by the PMD manufacturer, if available, or 
relevant Open Channel Monitoring reference material.

Options
* ABSOLUTE

RATIOMETRIC

 Values
Range: -999.000 to 9999.000

Default: 1.550

for flow exponent = 1

Max. Flow
(2.15.3.4.)

M
ax

. H
ea

d
2.1

5.
3.

3.

Ze
ro

 H
ea

d 
Of

fs
et

 
2.1

5.
3.

5.

Zero Flow

Exponents

The exponential equation is:
Q = KHFlow Exponent (2.15.3.2.)

Where:
Q = flow
K = constant factor
H = head
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2.15.3.3. Maximum Head
The maximum level value associated with the PMD and works in 
conjunction with 2.15.3.4.Maximum Flow at 20 mA for Ratiometric 
calculations. (Defined in 2.1.1.Units.)

This represents the highest head level supported by the Primary 
Measuring Device (PMD) and works in conjunction with 2.15.3.4.Maximum 
Flow at 20 mA to define the highest point in the exponential curve. Use it 
when the PMD requires a maximum head and flow reference point. 
Maximum Head must be set for all Absolute and Ratiometic PMDs.

2.15.3.4. Maximum Flow at 20 mA

The maximum flowrate associated with 2.15.3.3.Maximum Head shown in 
2.15.3.7.Flowrate Units.

This represents the flow at the highest head level supported by the 
Primary Measuring Device (PMD) and works in conjunction with 
2.15.3.3.Maximum Head to define the highest point in the exponential 
curve. Use it when the PMD requires a maximum head and flow reference 
point. Maximum Flow must be set for all Absolute and Ratiometic PMDs.

 Values
Range: 0.000 to 60.000 

Default: 60.000

Note: 
• The display of the measured value is limited to 7 Characters. Setting a 

Maximum Flow value larger than 7 characters will not display 
correctly.

• If measured value is larger than 7 characters, #### will be displayed. A 
larger unit (2.15.3.7.Flowrate Units) should be used, or number of 
decimal points (2.15.3.6.Flowrate Decimal) should be reduced.

 Values
Range: 0 to 9999999 

Default: 100
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2.15.3.5. Zero Head Offset
The difference (positive or negative) between Low Calibration Point and 
zero head (level at zero flow), defined in 2.1.1.Units.

This feature can be used for most weirs and some flumes (e.g. Palmer 
Bowlus) where the zero reference is at a higher elevation than the channel 
bottom.

2.15.3.6. Flowrate Decimal
The maximum number of decimal places to be displayed.

2.15.3.7. Flowrate Units
The volume units used to display total flow.

Values
Range: -60.000 to 60.000 

Default: 0.000

Options

* NO DIGITS no digits after the decimal point

1 DIGIT 1 digit after the decimal point

2 DIGITS 2 digits after the decimal point

3 DIGITS 3 digits after the decimal point

Options

* L/S (Litres per second)

L/MIN (Litres per minute)

CUFT/S (Cubic feet per second)

CUFT/D (Cubic feet per day)

GAL/MIN (US Gallons per minute)

GAL/D (US Gallons per day)

IMPGAL/MIN (Imperial Gallons per minute)

IMPGAL/D (Imperial Gallons per day)

CUM/H (Cubic meters per hour)

CUM/D (Cubic meters per day)

MMGAL/D (Mega-gallons per day)

USER DEFINED (units defined in 2.15.3.8.User Defined Unit)

transducer

Low Calibration Point

zero head

Material level 
at zero flow

PMD base

Zero Head Offset
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2.15.3.8. User Defined Unit
Set the unit text to display for current flow when 2.15.3.7.Flowrate Units set 
to user-defined. Limited to 16 ASCII characters.

2.15.3.9. Low Flow Cutoff
Eliminates totalizer activity for head levels at or below the cutoff value.

Enter the minimum head in 2.1.1.Units where totalizer activity should cease.

2.15.4. PMD Dimensions
The dimensions of the Primary Measuring Device (PMD). (The dimensions of 
the vessel, wet well, or reservoir are only important if you require volume.) 
The following table is a reference to the parameters that must be set for each 
PMD. Parameter definitions follow the table.

Notes: The text entered is simply for display purposes. No unit 
conversion occurs.

 Values
Range: 0.000 to 60.000 

Default: 0.000

Supported PMD Dimensions required

Exponential Devices

2.15.3.2. Flow Exponent

2.15.4.1. K Factor

Rectangular Flume BS-3680 

2.15.4.5. OCM Dimension 1 - approach width B

2.15.4.6. OCM Dimension 2 - throat width b

2.15.4.7. OCM Dimension 3 - hump height p

2.15.4.8. OCM Dimension 4 - throat length L

Round Nose Horizontal Crest Weir BS-3680 

2.15.4.5. OCM Dimension 1 - crest width b

2.15.4.6. OCM Dimension 2 - crest height p

2.15.4.7. OCM Dimension 3 - crest length L
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Supported PMDs (cont’d)

Trapezoidal Flume BS-3680 

2.15.4.5. OCM Dimension 1 - approach width B

2.15.4.6. OCM Dimension 2 - throat width b

2.15.4.7. OCM Dimension 3 - hump height p

2.15.4.8. OCM Dimension 4 - throat length L

2.15.4.3. Slope

U-Flume BS-3680 

2.15.4.5. OCM Dimension 1 - approach diameter Da

2.15.4.6. OCM Dimension 2 - throat diameter D

2.15.4.7. OCM Dimension 3 - hump height p

2.15.4.8. OCM Dimension 4 - throat length L

Finite Crest Weir BS-3680 

2.15.4.5. OCM Dimension 1 - crest width b

2.15.4.6. OCM Dimension 2 - crest height p

2.15.4.7. OCM Dimension 3 - crest length L

Thin Plate Rectangular Weir BS-3680 

2.15.4.5. OCM Dimension 1 - approach width B

2.15.4.6. OCM Dimension 2 - crest width b

2.15.4.7. OCM Dimension 3 - crest height p

Thin Plate V-Notch Weir BS-3680 

2.15.4.2. V-Notch Angle

Rectangular Weir Contracted

2.15.4.5. OCM Dimension 1 - crest width b

Round Pipe

2.15.4.5. OCM Dimension 1 - pipe inside diameter D

2.15.4.3. Slope

2.15.4.4. Roughness Coefficient
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2.15.4.1. K Factor
The constant used in the flow calculation formula for absolute calculation 
of an exponential device only.

Use this parameter if the PMD is set to Exponential devices. The Constant 
Factor is used to create an exponential curve with end points set by 
2.15.3.3. Maximum Head and 2.15.3.5. Zero Head Offset, and with the curve 
based on the specified exponent.

2.15.4.2. V-Notch Angle
The V-Notch angle used in the flow calculation formula.

Use when PMD is set to Thin Plate V-Notch Weir.

2.15.4.3. Slope
The Flow Slope used in the flow calculation formula. 

Use when PMD is set to Trapezoidal Flume or Round Pipe. 

2.15.4.4. Roughness Coefficient
The Flow Roughness Coefficient used in the flow calculation formula.

Use when PMD is set to Round Pipe.

2.15.4.5. OCM Dimension 1
2.15.4.6. OCM Dimension 2
2.15.4.7. OCM Dimension 3

Supported PMDs (cont’d)

Palmer Bowlus Flume

2.15.4.5. OCM Dimension 1 - maximum flume width hmax

H-Flume

2.15.4.5. OCM Dimension 1 - maximum listed head hmax

Universal Head Flow

2.15.5.1.1. Head 1 (up to 32)

2.15.5.1.2. Flow 1 (up to 32)

 Values
Range: -999.000 to 9999.000

Default: 1.000

 Values
Range: 25.000 to 95.000

Default: 25.000

 Values
Range: -999.000 to 9999.000

Default: 0.000

 Values
Range: -999.000 to 9999.000

Default: 0.000
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2.15.4.8. OCM Dimension 4
See table under PMD Dimensions (2.15.4.) to relate OCM Dimension 1-4 
above to a specific dimension for each directly supported Primary 
Measuring Device. For PMDs that are not directly supported (Universal 
Head Flow), use a Universal Flow calculation. See Universal calculation 
support  on page 116.

For more information on PMD, see Open Channel Monitoring (OCM)  on 
page 97.

2.15.5. Universal Head vs. Flow
In the following table, enter Head and Flow Breakpoints for universal 
PMDs.
Head Breakpoints: The head breakpoints for which flowrate is known, 
defined in Units (2.1.1.).
Flowrate Breakpoints: The flowrate corresponding to each Head 
Breakpoint entered, defined in Flowrate Units (2.15.3.7.).

See Universal calculation support  on page 116 for details on how to 
specify universal flows.

Entering breakpoints via SIMATIC PDM:
See Quick Start (Flow) in the LUT400 Communications manual1.

2.15.5.1. Table 1-8
2.15.5.1.1. Head 1
2.15.5.1.2. Flow 1

2.15.5.2. Table 9-16
2.15.5.2.1. Head 9
2.15.5.2.2. Flow 9

2.15.5.3. Table 17-24
2.15.5.3.1. Head 17
2.15.5.3.2. Flow 17

2.15.5.4. Table 25-32
2.15.5.4.1. Head 25
2.15.5.4.2. Flow 25

2.16. Totalizers
Available only on LUT430 (Pump and Flow model) and LUT440 (OCM model).

Head Values
Range: 0.000 to 60.000

Default: 0.000

Flowrate Values
Range: 0 to 9999999

Default: 0

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



Page 198 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS A5E33329501

m
m

m
m

m

Pa
ra

m
et

er
s

2.16.1. Daily Totalizer 
Read only. Current daily totalizer value. (Automatically resets daily and can be 
reset by user.)

2.16.2. Running Totalizer
Read only. Current running totalizer value. (Reset only by user.)

2.16.3. Totalizer Decimal Position
Sets the maximum number of decimal places to be displayed.

2.16.4. Totalizer Multiplier
Use this feature if the LCD Total increments by an amount that is too large (or 
too small).

Enter the factor (powers of 10 only) by which actual flow is divided, prior to 
display on LCD. Use a value such that the eight-digit totalizer doesn’t roll over 
between readings.

Example: For an LCD Total display in 1000s of flow units, enter 1000.

2.16.5. Reset Daily Totalizer
Select YES to reset daily totalizer value to zero.

 Values
Range: 0.00 to 999999999

Default: 0.00

 Values
Range: 0.00 to 999999999

Default: 0.00

Options

NO DIGITS no digits after the decimal point

1 DIGIT 1 digit after the decimal point

* 2 DIGITS 2 digits after the decimal point

3 DIGITS 3 digits after the decimal point

Options

.001

.01

.1

* 1

10

100

1000

10,000

100,000

1,000,000

10,000,000

Options
* NO

YES
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2.16.6. Reset Running Totalizer
Select YES to reset running totalizer value to zero.

3. Maintenance and Diagnostics

3.1. Identification
To edit parameters with a string editor (3.1.1. to 3.1.5.), see Using the string editor:  on 
page 187.

3.1.1. TAG
Text that can be used in any way. A recommended use is as a unique label for 
a field device in a plant. Limited to 32 alphanumeric characters (8 characters via 
HART). Appears in top left corner of display in measurement mode (see The LCD 
Display  on page 34).

3.1.2. Long TAG
Text that can be used in any way. A recommended use is as a unique label for 
a field device in a plant. Limited to 32 alphanumeric characters.

3.1.3. Descriptor
Text that can be used in any way. Limited to 32 ASCII characters (16 ASCII 
characters via HART). No specific recommended use.

3.1.4. Message
Text that can be used in any way. Limited to 32 ASCII characters. No specific 
recommended use. 

3.1.5. Installation Date
Date the device was first commissioned (YYYY-MM-DD). 
Manufacturer
Read only. The device manufacturer (e.g. Siemens).
Product Name
Read only. Identifies the product by name (e.g. SITRANS LUT400).

3.1.6. Product
Read only. Identifies the product by name and capability:
SITRANS LUT420 (Level)
SITRANS LUT430 (Pump and Flow)
SITRANS LUT440 (OCM)

3.1.7. Order No. (Order Number in PDM)
Read only. Order number for the current device configuration 
(e.g. 7ML5050-0CA10-1DA0).

Options
* NO

YES

Note: Default settings in the parameter tables are indicated with an asterisk (*) unless 
explicitly stated.
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3.1.8. Serial Number
Read only. Unique factory set serial number of the device.

3.1.9. Final Assembly Number
Integer used to identify the device on site, e.g. enter ’2’ to denote second 
SITRANS LUT400 in application.

3.1.10. Hardware Revision
Read only. Corresponds to the electronics hardware of the Field Device.

3.1.11. Firmware Revision
Read only. Corresponds to the software or firmware that is embedded in the 
Field Device.

3.1.12. Loader Revision
Read only. Corresponds to the software used to update the Field Device.
EDD Version
Read only. Corresponds to the Electronics Device Description (EDD) installed 
with the device.

3.1.13. Manufacture Date (Date of Manufacturing in PDM)
The date of manufacture of the SITRANS LUT400 (YYYY-MM-DD).

3.1.14. Order Option
Read only. Displays the device type: Standard or NAMUR 43-compliant.

3.2. Diagnostics

3.2.1. Echo Profile
Allows you to request the current echo profile either locally via the local push 
buttons, or remotely via SIMATIC PDM. 

To request a profile via the local push buttons: 

a) In PROGRAM mode, navigate to MAIN MENU > DIAGNOSTICS (3) > 
ECHO PROFILE (3.1)

b) Press RIGHT arrow to request a profile.

For more detail see Requesting an Echo Profile  on page 57.
For more details on how to interpret an Echo Profile, see Echo Processing  on 
page 255.

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Note: An Echo Profile (3.2.1.) cannot be requested from LUI when:
• Transducer Enable (3.3.1.) is set to DISABLED,

or when
• Transducer (2.1.6.) is set to NO TRANSDUCER.

In either case, the local push button will not operate.
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To request a profile via SIMATIC PDM: 

a) Open the menu Device – Echo Profile Utilities. (For more details see 
Echo Profile Utilities in LUT400 Communications manual.1)

3.2.2. Trend
Read only. Display of level trends. Captures last 3000 PV values (logged at five 
minute intervals) in percentage of range (defined in 2.1.1.Units). For more 
information, see Trends  on page 118.

3.2.3. Master Reset

Resets all parameter to factory defaults, with the following exceptions:
• Tag, Long Tag, Description, Message, Assembly Number
• Device Address (4.1.) and Language (6.) remain unchanged
• Write Protection (5.1.) value is not reset
• Auto False Echo Suppression (2.12.3.1.) learned TVT is not lost
• Shaper Mode (2.12.3.4.), and breakpoints for TVT Shaper (2.12.4.) are not 

lost
• Totalizers (2.7.3.) values are not reset
• Date (2.14.1.) and Time (2.14.2.) values are not reset

To perform a reset to factory defaults via SIMATIC PDM, open the menu Device 
– Master Reset.

3.2.4. Power-on Resets
The number of power cycles that have occurred since manufacture.
In SIMATIC PDM, open the menu Device – Wear.

3.2.5. Power-on Time
Displays the number of days the device has been powered on since 
manufacture.
In SIMATIC PDM, open the menu Device – Wear.

3.2.6. View Logs
View various log types with entries (to a collective maximum of approximately 
30,000) listed by day. For a list of field names that coincide with the comma 
delimited log file on the PC, see Data Logging  on page 267.

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Note: Following a reset to Factory Defaults, complete reprogramming is 
required.

Options
* DO NOTHING (Return to previous menu)

FACTORY DEFAULTS

Notes: 
• No data logs are written while device is connected to a PC via USB.
• To clear entries when log memory becomes full, see Viewing the Data Log  

on page 119.
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3.2.6.1. Alarms
History of alarms. Displays type of alarm, value at which alarm triggered, 
state of alarm.

3.2.6.2. OCM
Flow logs. Displays head and flow values.

3.2.6.3. Daily Totals
Daily totals for both totalizers. Displays maximum and minimum values for 
flow and temperature, average flow, and daily totalizer (DT) and running 
totalizer (RT) values.

3.2.6.4. PV
Primary Variable. Displays PV type (e.g. Level), PV value and temperature.

3.2.7. Pump Records
Relay usage.
3.2.7.1. Run Time Relay 2

Read or set the total running time of Relay 2 in hours.

3.2.7.2. Run Time Relay 3
Read or set the total running time of Relay 3 in hours.

3.2.7.3. Relay Pump 1
Read only. Relay assigned to Pump 1.
To change the relay assignment, see 2.7.1.2. Relay Pump 1.

3.2.7.4. Relay Pump 2
Read only. Relay assigned to Pump 2.
To change the relay assignment, see 2.7.1.3. Relay Pump 2.

3.2.8. Temperature Peak Values
This feature displays the high and low process temperatures in °C.
If the device is powered up without a temperature sensor connected, the 
default fixed temperature value 20 °C is displayed [see Fixed Temperature 
(2.12.1.4.)]. This information can help trace problems with both built in and 
external temperature sensors.

3.2.8.1. Highest Value
View the highest process temperature encountered, as measured by the 
transducer in ° C.

3.2.8.2. Lowest Value
View the lowest process temperature encountered, as measured by the 
transducer in ° C.

Note: PV is controlled by the mA function (see 2.5.1. Current Output 
Function). Therefore, the LUI operation can be changed (via 2.1.2. Sensor 
Mode) without affecting the process being controlled.

Values Range: 0 to 999999

Values Range: 0 to 999999
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3.2.9. Echo Quality

3.2.9.1. Figure of Merit
This value measures the quality of the reported echo value: higher values 
represent better quality. This measure combines the noise level, quality of 
tracking, and signal strength. (For more details see Echo Processing  on 
page 255.)

3.2.9.2. Confidence
Indicates echo reliability: higher values represent better echo quality. The 
display shows the echo confidence of the last measurement. Echo 
Threshold (2.12.2.2.) defines the minimum criterion for echo confidence.

In SIMATIC PDM, open the menu Device – Echo Profile Utilities and click 
on the tab Echo Profile. 

3.2.9.3. Echo Strength
Displays the absolute strength (in dB above 1 μV rms) of the echo selected 
as the measurement echo.

In SIMATIC PDM, open the menu Device – Echo Profile Utilities and click 
on the tab Echo Profile. 

3.2.9.4. Noise Average
Displays the average ambient noise (in dB above 1 μV rms) of a noise profile 
after each measurement.
The noise level is a combination of transient acoustic noise and electrical 
noise (induced into the transducer cable or receiving circuitry). See Noise 
Problems  on page 240.

3.2.9.5. Noise Peak
Displays the peak ambient noise (in dB above 1 μV rms) of a noise profile 
after each measurement.

Values (view only) Range: 0 to 100 %

Values (view only) Range: -20 to 128

Values (view only) Range: -20 to 128 dB
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3.3. Maintenance

3.3.1. Transducer Enable
Enables/disables transducer from taking measurements.

Set parameter to Disabled to stop transducer from measuring while calibration 
or maintenance work is performed. Set to Enabled to restart measurements 
after calibration or maintenance complete.

3.3.2. Backup Control
LUI only. Determine source of configuration recovery file when sensor has been 
replaced.

When sensor unit has been replaced, fault code 132 is displayed to note that LUI 
backup file does not match configuration file in sensor. To clear fault, set 
Backup Control option to location from where parameter configuration should 
be read; from the LUI backup file or from the new sensor.

Note: Default settings in the parameter tables are indicated with an asterisk (*) 
unless explicitly stated.

Options
* ENABLED

DISABLED

Notes:
• An Echo Profile (3.2.1.) cannot be requested from LUI when Transducer 

Enable (3.3.1.) is set to DISABLED. The local push button will not operate.
• When Transducer Enable (3.3.1.) is set to DISABLED, the LOE fault will 

display immediately.
• If Transducer Enable (3.3.1.) is set to DISABLED and power to the device is 

turned off, Transducer Enable (3.3.1.) will be reset to ENABLED when 
power is restored.

Options

* DONE
No change required (no fault displayed), or oper-
ation is complete

FROM SENSOR
Sensor parameters will be used as is, and LUI 
will receive these parameters as backup.

FROM LUI
Recovery of sensor parameters will come from 
LUI backup.
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3.3.3. Remaining Device Life

The device tracks itself based on operating hours and monitors its predicted 
lifetime. You can modify the expected device lifetime, set up schedules for 
maintenance reminders, and acknowledge them. 
The maintenance warnings and reminders are available through HART 
communications. This information can be integrated into an Asset 
Management system. For optimal use, we recommend that you use SIMATIC 
PCS7 Asset Management Software in conjunction with SIMATIC PDM.

To access these parameters via SIMATIC PDM:

• Open the menu Device – Maintenance and select the Remaining Device 
Lifetime tab. (For more details see Maintenance in LUT400 
Communications manual.1)

Time Units
Allows you to set the desired units.

3.3.3.1. Lifetime Expected

Allows you to override the factory default.

Notes: 
• Four sets of parameters allow you to monitor the Device/Sensor Lifetimes 

and set up Maintenance/Service schedules, based on operating hours 
instead of a calendar-based schedule. See also Remaining Sensor Life 
(3.3.4.), Service Schedule (3.3.5.), and Calibration Schedule (3.3.6.).

• Performing a reset to Factory Defaults will reset all the Maintenance 
Schedule parameters to their factory defaults.

• The device operates in years. To view Remaining Device Lifetime 
parameters in hours or days (only via SIMATIC PDM, PACTware FDT, and 
AMS) see Lifetime Expected (3.3.3.1.).

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Optionsa

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

HOURS

DAYS

* YEARS

Note: The device always operates in years. Changing the Time Units 
affects only the parameter view of the Remaining Device Lifetime 
parameters in SIMATIC PDM, PACTware FDT, and AMS.

Values

Unitsa: hours, days, years

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

Range: 0.000 to 20.000 years

Default: 10.000 years
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3.3.3.2. Time in Operation
Read only. The amount of time the device has been operating.

3.3.3.3. Remaining Lifetime
Read only. Lifetime Expected (3.3.3.1.) less Time in Operation (3.3.3.2.).

3.3.3.4. Reminder Activation

Allows you to enable a maintenance reminder.

a) First set the values in Reminder 1 before Lifetime (Required) 
(3.3.3.5.)/Reminder 2 before Lifetime (Demanded) (3.3.3.6.).

b) Select the desired Reminder Activation option.
3.3.3.5. Reminder 1 before Lifetime (Required)

If Remaining Lifetime (3.3.3.3.) is equal to or less than this value, the device 
generates a Maintenance Required reminder.

a) Modify values as required.
b) Set Reminder Activation (3.3.3.4.) to the desired option.

3.3.3.6. Reminder 2 before Lifetime (Demanded)
If Remaining Lifetime (3.3.3.3.) is equal to or less than this value, the device 
generates a Maintenance Demanded reminder.

a) Modify values as required.
b) Set Reminder Activation (3.3.3.4.) to the desired option.

3.3.3.7. Maintenance Status
Indicates which level of maintenance reminder is active.
In SIMATIC PDM, open the menu View – Device Status, click on the 
Maintenance tab, and check the Device Lifetime Status window.

3.3.3.8. Acknowledged Status
Indicates which level of maintenance reminder has been acknowledged.
In SIMATIC PDM, open the menu View – Device Status, click on the 
Maintenance tab, and check the Device Lifetime Status window.

Note: To modify this parameter via SIMATIC PDM it must be accessed 
via the pull-down menu Device – Maintenance. 

Options

REMINDER 1 (MAINTENANCE REQUIRED)

REMINDER 2 (MAINTENANCE DEMANDED)

REMINDERS 1 AND 2

* OFF

Values
Range: 0.000 to 20.000 years

Default: 0.164 years (8 weeks)

Values
Range: 0.000 to 20.000 years

Default: 0.019 years (1 week)
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3.3.3.9. Acknowledged
Acknowledges the current maintenance reminder.

To acknowledge a reminder via SIMATIC PDM: 

a) Open the menu View – Device Status and click on the tab 
Maintenance.

b) In the Device Lifetime section, click on Acknowledge Warnings.

To acknowledge a reminder via the local push buttons:

a) Navigate to Maintenance and Diagnostics (3.) > Maintenance (3.3.) 
> Remaining Device Life (3.3.3.) > Acknowledged (3.3.3.9.), and 
RIGHT arrow  to acknowledge the reminder.

3.3.4. Remaining Sensor Life

The device monitors the predicted lifetime of the sensor (the components 
exposed to the vessel environment). You can modify the expected sensor 
lifetime, set up schedules for maintenance reminders, and acknowledge them. 

To access these parameters via SIMATIC PDM:

• Open the menu Device – Maintenance and select the Remaining Sensor 
Lifetime tab. (For more details see Maintenance in LUT400 
Communications manual.1)

Time Units
Allows you to set the desired units.

Notes: 
• Four sets of parameters allow you to monitor the Device/Sensor Lifetimes 

and set up Maintenance/Service schedules, based on operating hours 
instead of a calendar-based schedule. See also Remaining Device Life 
(3.3.3.), Service Schedule (3.3.5.), and Calibration Schedule (3.3.6.).

• Performing a reset to Factory Defaults will reset all the Maintenance 
Schedule parameters to their factory defaults.

• The device operates in years. To view Remaining Sensor Lifetime 
parameters in hours or days (only via SIMATIC PDM, PACTware FDT, and 
AMS) see Lifetime Expected (3.3.4.1.).

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Optionsa

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

HOURS

DAYS

* YEARS
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3.3.4.1. Lifetime Expected

Allows you to override the factory default.

3.3.4.2. Time in Operation
The amount of time the sensor has been operating. Can be reset to zero 
after performing a service or replacing the sensor.

To reset to zero:

• In SIMATIC PDM, open the menu Device – Maintenance, click on the 
Remaining Sensor Lifetime tab, and click on Sensor Replaced to re-
start the timer and clear any fault messages.

• Via the local push buttons, navigate to Maintenance and Diagnostics 
(3.) > Maintenance (3.3.) > Remaining Sensor Life (3.3.4.) > Time in 
Operation (3.3.4.2.), and set to zero.

3.3.4.3. Remaining Lifetime
Read only. Lifetime Expected (3.3.4.1.) less Time in Operation (3.3.4.2.).

3.3.4.4. Reminder Activation

Allows you to enable a maintenance reminder.

a) First set the values in Reminder 1 before Lifetime (Required) 
(3.3.4.5.)/Reminder 2 before Lifetime (Demanded) (3.3.4.6.).

b) Select the desired Reminder Activation option.
3.3.4.5. Reminder 1 before Lifetime (Required)

If Remaining Lifetime (3.3.4.3.) is equal to or less than this value, the device 
generates a Maintenance Required reminder. 

a) Modify values as required.
b) Set Reminder Activation (3.3.4.4.) to the desired option. 

Note: The device always operates in years. Changing the Time Units 
affects only the parameter view of Remaining Sensor Life parameters in 
SIMATIC PDM, PACTware FDT, and AMS.

Values

Unitsa: hours, days, years

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

Range: 0.000 to 20.000 years

Default: 10.000 years

Note: To modify this parameter via SIMATIC PDM it must be accessed 
via the pull-down menu Device – Maintenance. 

Options

REMINDER 1 (MAINTENANCE REQUIRED)

REMINDER 2 (MAINTENANCE DEMANDED)

REMINDERS 1 AND 2

* OFF

Values
Range: 0.000 to 20.000 years

Default: 0.164 years (8 weeks)
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3.3.4.6. Reminder 2 before Lifetime (Demanded)
If Remaining Lifetime (3.3.4.3.) is equal to or less than this value, the device 
generates a Maintenance Demanded reminder.

a) Modify values as required. 
b) Set Reminder Activation (3.3.4.4.) to the desired option.

3.3.4.7. Maintenance Status
Indicates which level of maintenance reminder is active.
In SIMATIC PDM, open the menu View – Device Status, click on the 
Maintenance tab, and check the Sensor Lifetime Status window.

3.3.4.8. Acknowledged Status
Indicates which level of maintenance reminder has been acknowledged.
In SIMATIC PDM, open the menu View – Device Status, click on the 
Maintenance tab and check the Sensor Lifetime Status window.

3.3.4.9. Acknowledged
Acknowledges the current maintenance reminder.

To acknowledge a reminder via SIMATIC PDM: 

a) Open the menu View – Device Status and click on the Maintenance 
tab.

b) In the Sensor Lifetime section click on Acknowledge Warnings.

To acknowledge a reminder via the local push buttons: 

a) Navigate to Maintenance and Diagnostics (3.) > Maintenance (3.3.) 
> Remaining Sensor Life (3.3.4.) > Acknowledged (3.3.3.9.), and 

RIGHT arrow  to acknowledge the reminder.

3.3.5. Service Schedule

The device tracks service intervals based on operating hours and monitors the 
predicted lifetime to the next service. You can modify the Total Service Interval, 
set schedules for maintenance reminders, and acknowledge them.

Values
Range: 0.000 to 20.000 years

Default: 0.019 years (1 week)

Notes: 
• Four sets of parameters allow you to monitor the Device/Sensor Lifetimes 

and set up Maintenance/Service schedules, based on operating hours 
instead of a calendar-based schedule. See also Remaining Device Life 
(3.3.3.), Remaining Sensor Life (3.3.4.), and Calibration Schedule (3.3.6.).

• Performing a reset to Factory Defaults will reset all the Maintenance 
Schedule parameters to their factory defaults.

• The device operates in years. To view Service Interval parameters in hours 
or days (only via SIMATIC PDM, PACTware FDT, and AMS) see Service 
Interval (3.3.5.1.).
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The maintenance warnings and reminders are communicated to the end user 
through status information. This information can be integrated into any Asset 
Management system. For optimal use, we recommend that you use SIMATIC 
PCS7 Asset Management Software in conjunction with SIMATIC PDM.

To access these parameters via SIMATIC PDM:

• Open the menu Device – Maintenance and select the Service Schedule 
tab. (For more details see Maintenance in LUT400 Communications 
manual.1)

Time Units
Allows you to set the desired units.

3.3.5.1. Service Interval

User-configurable recommended time between product inspections.

3.3.5.2. Time Last Service
Time elapsed since last service. Can be reset to zero after performing a 
service. 

To reset to zero:

• In SIMATIC PDM, open the menu Device – Maintenance, click on the 
Service Schedule tab, and click on Service Performed to restart the 
timer and clear any fault messages.

• Navigate to Maintenance and Diagnostics (3.) > Maintenance (3.3.) > 
Service Schedule (3.3.5.) > Time Last Service (3.3.5.2.), and set to zero.

3.3.5.3. Time Next Service
Read only. Time Next Service (3.3.5.3.) less Time Last Service (3.3.5.2.).

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Optionsa

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

HOURS

DAYS

* YEARS

Note: The device always operates in years. Changing the Time Units 
affects only the parameter view of the Service Interval parameters in 
SIMATIC PDM, PACTware FDT, and AMS.

Values

Unitsa: hours, days, years

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

Range: 0.000 to 20.000 years

Default: 1.000 year
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3.3.5.4. Reminder Activation

Allows you to enable a maintenance reminder.

a) First set the values in Reminder 1 before Service (Required) (3.3.5.5.)/
Reminder 2 before Service (Demanded) (3.3.5.6.).

b) Select the desired Reminder Activation option.
3.3.5.5. Reminder 1 before Service (Required)

If Time Next Service (3.3.5.3.) is equal to or less than this value, the device 
generates a Maintenance Required reminder. 

a) Modify values as required.
b) Set Reminder Activation (3.3.5.4.) to the desired option.

3.3.5.6. Reminder 2 before Service (Demanded)
If Time Next Service (3.3.5.3.) is equal to or less than this value, the device 
generates a Maintenance Demanded reminder.

a) Modify values as required.
b) Set Reminder Activation (3.3.5.4.) to the desired option.

3.3.5.7. Maintenance Status
Indicates which level of maintenance reminder is active.
In PDM, open the menu View – Device Status, click on the Maintenance 
tab and check the Service Schedule Status window.

3.3.5.8. Acknowledged Status
Indicates which level of maintenance reminder has been acknowledged.
In PDM, open the menu View – Device Status, click on the Maintenance 
tab and check the Service Schedule Status window.

3.3.5.9. Acknowledged
Acknowledges the current maintenance reminder.

To acknowledge a reminder via SIMATIC PDM: 

a) Open the menu View – Device Status and click on the Maintenance 
tab.

Note: To modify this parameter via SIMATIC PDM it must be accessed via 
the pull-down menu Device – Maintenance. 

Values

* TIMER OFF

ON NO LIMITS - no reminders checked

ON REMINDER 1 (MAINTENANCE REQUIRED) checked

ON REMINDER 1 AND 2 checked

ON REMINDER 2 (MAINTENANCE DEMANDED) checked

Values
Range: 0.000 to 20.000 years

Default: 0.164 years (8 weeks)

Values
Range: 0.000 to 20.000 years

Default: 0.019 years (1 week)
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b) In the Service Schedule Status section click on Acknowledge 
Warnings.

To acknowledge a reminder via the local push buttons: 

Navigate to Maintenance and Diagnostics (3.) > Maintenance (3.3.) > 

Service Schedule (3.3.5.) > Acknowledged (3.3.5.9.), and RIGHT arrow  
to acknowledge the reminder.

3.3.6. Calibration Schedule

The device tracks calibration intervals based on operating hours and monitors the 
predicted lifetime to the next calibration. You can modify the Total Calibration 
Interval, set schedules for maintenance reminders, and acknowledge them.

To access these parameters via SIMATIC PDM:

• Open the menu Device – Maintenance and select the Calibration Schedule 
tab. (For more details see Maintenance in LUT400 Communications 
manual.1)

Time Units
Allows you to set the desired units.

Notes: 
• Four sets of parameters allow you to monitor the Device/Sensor Lifetimes 

and set up Maintenance/Service schedules, based on operating hours 
instead of a calendar-based schedule. See also Remaining Device Life 
(3.3.3.), Remaining Sensor Life (3.3.4.), and Service Schedule (3.3.5.).

• Performing a reset to Factory Defaults will reset all the Maintenance 
Schedule parameters to their factory defaults.

• The device operates in years. To view Calibration Interval parameters in 
hours or days (only via SIMATIC PDM, PACTware FDT, and AMS) see 
Calibration Interval (3.3.6.1.).

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)

Optionsa

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

HOURS

DAYS

* YEARS
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3.3.6.1. Calibration Interval

User-configurable recommended time between product calibrations.

3.3.6.2. Time Last Calibration
Time elapsed since last calibration. Can be reset to zero after performing a 
calibration.

To reset to zero:

• In SIMATIC PDM, open the menu Device – Maintenance, click on the 
Calibration Schedule tab, and click on Calibration Performed to re-
start the timer and clear any fault messages.

• Via the local push buttons, navigate to Maintenance and Diagnostics 
(3.) > Maintenance (3.3.) > Calibration Schedule (3.3.6.) > Time Last 
Calibration (3.3.6.2.), and set to zero.

3.3.6.3. Time Next Calibration
Read only. Calibration Interval (3.3.6.1.) less Time Last Calibration (3.3.6.2.)

3.3.6.4. Reminder Activation

Allows you to enable a maintenance reminder.

a) First set the values in Reminder 1 before Calibration (Required) 
(3.3.6.5.)/Reminder 2 before Calibration (Demanded) (3.3.6.6.).

b) Select the desired Reminder Activation option.
3.3.6.5. Reminder 1 before Calibration (Required)

If Time Next Calibration (3.3.6.3.) is equal to or less than this value, the 
device generates a Maintenance Required reminder. 

a) Modify values as required.
b) Set Reminder Activation (3.3.6.4.) to the desired option.

Note: The device always operates in years. Changing the units affects 
only the parameter view of the Calibration Interval parameters in 
SIMATIC PDM, PACTware FDT, and AMS.

Values

Unitsa: hours, days, years

a. Units are selectable only via SIMATIC PDM, PACTware FDT, and AMS.

Range: 0.000 to 20.000 years

Default: 1.000 year

Note: To modify this parameter via SIMATIC PDM it must be accessed 
via the pull-down menu Device – Maintenance. 

Values

* TIMER OFF

ON NO LIMITS - no reminders checked

ON REMINDER 1 (MAINTENANCE REQUIRED) checked

ON REMINDER 1 AND 2 checked

ON REMINDER 2 (MAINTENANCE DEMANDED) checked

Values
Range: 0.000 to 20.000 years

Default: 0.164 years (8 weeks)
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3.3.6.6. Reminder 2 before Calibration (Demanded)
If Time Next Calibration (3.3.6.3.) is equal to or less than this value, the 
device generates a Maintenance Demanded reminder.

a) Modify values as required.
b) Set Reminder Activation (3.3.6.4.) to the desired option.

3.3.6.7. Maintenance Status
Indicates which level of maintenance reminder is active.
In SIMATIC PDM, open the menu View – Device Status, click on the 
Maintenance tab and check the Calibration Schedule Status window.

3.3.6.8. Acknowledged Status
Indicates which level of maintenance reminder has been acknowledged.
In SIMATIC PDM, open the menu View – Device Status, click on the 
Maintenance tab and check the Calibration Schedule Status window.

3.3.6.9. Acknowledged
Acknowledges the current maintenance reminder.

To acknowledge a reminder via SIMATIC PDM: 

a) Open the menu View – Device Status and click on the Maintenance 
tab.

b) In the Calibration Schedule Status section click on Acknowledge 
Warnings.

To acknowledge a reminder via the local push buttons: 

Navigate to Maintenance and Diagnostics (3.) > Maintenance (3.3.) > 
Calibration Schedule (3.3.6.) > Acknowledged (3.3.6.9.), and RIGHT arrow 

 to acknowledge the reminder.

3.4. Simulation
Use simulation to test your application. For further details, see Application examples  
on page 58.

3.4.1. Level
Simulates level changes, and activates relays based on the setpoints 
programmed.
3.4.1.1. Level Simulation Enable

Enables/disables level simulation.

Values
Range: 0.000 to 20.000 years

Default: 0.019 years (1 week)

Options
* DISABLED

ENABLED
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3.4.1.2. Level Value
Sets the level for a fixed level simulation, or the starting level for a ramped 
simulation.

3.4.1.3. Ramp
Enables/disables ramped simulation.

3.4.1.4. Ramp Rate
Sets the rate at which the simulated level will change in a ramp simulation.

3.4.2. Discrete Inputs
Simulates behaviour of external contacts connected to a discrete input.
3.4.2.1. Discrete Input 1

Disables simulation of Discrete Input 1, or sets behaviour of DI during 
simulation.

3.4.2.2. Discrete Input 2
Disables simulation of Discrete Input 2, or sets behaviour of DI during 
simulation.

3.4.3. Pump Activations
Sets how physical relays (that are assigned to pumps) will behave in simulation 
mode.

Values
Range: Low Calibration Point to High Calibration Point

Default: 0.000

Options
* DISABLED

ENABLED

Options

SLOW 1% of spana per second

a. Low Calibration Point to High Calibration Point

* MEDIUM 2% of spana per second

FAST 4% of spana per second

Options

* DISABLED DI is not simulated

ON DI is simulated to be ON

OFF DI is simulated to be OFF

Options

* DISABLED DI is not simulated

ON DI is simulated to be ON

OFF DI is simulated to be OFF

Options
* DISABLED Pump relays are not activated in simulation

ENABLED Pump relays are activated in simulation
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4. Communication
4.1. Device Address

Sets the device address or poll ID on a HART network.

To reset Device Address via SIMATIC PDM:

• Open the project in Process Device Network View then right-click on the 
device.

• Go to Object Properties and open the Connection tab to access the field Short 
Address.

Manufacturer’s ID

Read only. Numerical code that refers to the manufacturer of the device (e.g. 42, which 
refers to Siemens).

Device Id

Read only. Unique identification of the device by manufacturer and device type.

Product Id

Read only. Unique identification of the product by model number.

Device Revision

Read only. Device revision associated with a specific EDD.

EDD Revision

Read only. Revision of a specific EDD associated with the device.

Universal Command Revision

Read only. Revision of the Universal Device Description associated with the device.

Protocol

Read only. The communication protocol supported by the device.

Common Practice Command Revision

Read only. Revision of the set of HART common practice commands supported by the 
device.

Values
Range: 0 to 63 (Set within range of 0 to 15 if HART 5 master used.)

Default: 0

Note: The following list of parameters are available in PDM. Unless otherwise 
stated, the options are displayed in integer format (as required by HART 
communications).
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Configuration Change Counter

Read only. Indicates the number of times the device’s configuration or calibration has 
been changed by a host application or from a local operator interface.

5. Security

5.1. Write Protection
A public password to prevent any changes to parameters via local push buttons, 
remote communication, or Windows-based web browser. 

• To turn Lock On, key in any value other than the Unlock Value.
• To turn Lock Off, key in the Unlock Value (2457).

6. Language

Selects the language to be used on the LCD.

Characteristics
Certificates & Approvals

Device Certification
The approvals certificates applicable to the device.

Note: Default settings in the parameter tables are indicated with an asterisk (*) unless 
explicitly stated.

Values
Range: 0 to 65535

* Unlock value (2457) Lock Off

Any other value Lock On

Note: Default settings in the parameter tables are indicated with an asterisk (*) unless 
explicitly stated.

Options

* ENGLISH

DEUTSCH

FRANCAIS

ESPANOL

ITALIANO

PORTUGUÊS

русский

����
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Alphabetical parameter list
Note: Maintenance Parameters are not listed below. See Remaining Device Life  on 
page 205, Remaining Sensor Life  on page 207, Service Schedule  on page 209, and 
Calibration Schedule  on page 212 for these parameters.

Parameter Name (Parameter Number)  Page Number
 4 mA Setpoint     (2.5.3.) 146
 20 mA Setpoint     (2.5.4.) 146
 Activation Time     (2.11.2.2.) 176
 Alarm Log     (2.10.2.) 174
 Alarm State     (2.8.1.5.):  High Level Alarm     (2.8.1.) 162
 Alarm State     (2.8.10.5.):  Low Flowrate Alarm     (2.8.10.) 169
 Alarm State     (2.8.2.5.):  Low Level Alarm     (2.8.2.) 163
 Alarm State     (2.8.3.5.):  Switch (Discrete Input) Alarm     (2.8.3.) 164
 Alarm State     (2.8.4.5.):  In-bounds Level Alarm     (2.8.4.) 165
 Alarm State     (2.8.5.5.):  Out-of-bounds Level Alarm     (2.8.5.) 166
 Alarm State     (2.8.6.5.):  Low Temperature Alarm     (2.8.6.) 166
 Alarm State     (2.8.7.5.):  High Temperature Alarm     (2.8.7.) 167
 Alarm State     (2.8.8.3.):  Fail-safe Fault Alarm     (2.8.8.) 166
 Alarm State     (2.8.9.5.):  High Flowrate Alarm     (2.8.9.) 169
 Alarms     (2.8.):  Setup     (2.) 162
 Alarms     (3.2.6.1.):  View Logs     (3.2.6.) 202
 Algorithm     (2.12.2.1.) 181
 Assigned Relay     (2.11.1.4.):  Elapsed Time Relay     (2.11.1.) 176
 Assigned Relay     (2.11.2.4.):  Time of Day Relay     (2.11.2.) 176
 Assigned Relay     (2.11.3.4.):  External Totalizer     (2.11.3.) 177
 Assigned Relay     (2.11.4.5.):  External Sampler     (2.11.4.) 179
 Assigned Relay     (2.8.1.4.):  High Level Alarm     (2.8.1.) 162
 Assigned Relay     (2.8.10.4.):  Low Flowrate Alarm     (2.8.10.) 169
 Assigned Relay     (2.8.2.4.):  Low Level Alarm     (2.8.2.) 163
 Assigned Relay     (2.8.3.4.):  Switch (Discrete Input) Alarm     (2.8.3.) 164
 Assigned Relay     (2.8.4.4.):  In-bounds Level Alarm     (2.8.4.) 165
 Assigned Relay     (2.8.5.4.):  Out-of-bounds Level Alarm     (2.8.5.) 165
 Assigned Relay     (2.8.6.4.):  Low Temperature Alarm     (2.8.6.) 166
 Assigned Relay     (2.8.7.4.):  High Temperature Alarm     (2.8.7.) 167
 Assigned Relay     (2.8.8.2.):  Fail-safe Fault Alarm     (2.8.8.) 166
 Assigned Relay     (2.8.9.4.):  High Flowrate Alarm     (2.8.9.) 168
 Auto False Echo Suppression     (2.12.3.1.) 183
 Auto False Echo Suppression Range     (2.12.3.2.) 184
 Auto Sensor Offset     (2.2.6.) 142
 Auto Sound Velocity     (2.12.1.6.) 181
 Auto Zero Head     (2.15.2.) 190
 Backup Control     (3.3.2.) 204
 Backup Level Override     (2.9.1.) 171
 Basic Setup     (2.15.3.):  Flow     (2.15.) 191
 Basic Setup     (2.7.1.):  Pumps     (2.7.) 151
 Breakpoint 1-8     (2.12.4.1.) 185
 Breakpoint 17-24     (2.12.4.3.) 185
 Breakpoint 25-32     (2.12.4.4.) 185
 Breakpoint 33-40     (2.12.4.5.) 185
 Breakpoint 9-16     (2.12.4.2.) 185
 Calibration     (2.2.) 140
 Communication     (4.) 216
 Confidence     (3.2.9.2.) 203
 Current Output     (2.5.) 144
 Current Output Function     (2.5.1.) 144
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 Current Output Value     (2.5.8.) 147
 Daily Totalizer     (2.16.1.) 198
 Daily Totals     (3.2.6.3.) 202
 Damping Filter     (2.3.3.) 143
 Data Logging     (2.10.) 173
 Date     (2.14.1.) 188
 Date and Time     (2.14.) 187
 Daylight Saving     (2.14.3.) 188
 Delay Between Starts     (2.7.2.4.1.) 160
 Descriptor     (3.1.3.) 199
 Device Address     (4.1.) 216
 Diagnostics     (3.2.) 200
 Dimension A     (2.6.4.) 149
 Dimension L     (2.6.5.) 149
 Discrete Input 1     (3.4.2.1.) 215
 Discrete Input 1 Logic     (2.9.2.1.) 172
 Discrete Input 1 Scaled State     (2.9.2.2.) 172
 Discrete Input 2     (3.4.2.2.) 215
 Discrete Input 2 Logic     (2.9.2.3.) 172
 Discrete Input 2 Scaled State     (2.9.2.4.) 172
 Discrete Input Logic     (2.9.2.) 172
 Discrete Input Number     (2.8.3.2.) 163
 Discrete Input Number     (2.9.1.3.) 171
 Discrete Input State     (2.8.3.3.) 164
 Discrete Inputs     (2.9.):  Setup     (2.) 170
 Discrete Inputs     (3.4.2.):  Simulation     (3.4.) 215
 Display     (2.13.) 186
 Distance Measurement     (2.12.5.3.) 186
 Echo Profile     (3.2.1.) 200
 Echo Quality     (3.2.9.) 203
 Echo Select     (2.12.2.) 181
 Echo Strength     (3.2.9.3.) 203
 Echo Threshold     (2.12.2.2.) 182
 Elapsed Time Relay     (2.11.1.) 175
 Empty Rate per Minute     (2.3.2.) 143
 Enable     (2.10.1.1.):  Process Value Log     (2.10.1.) 174
 Enable     (2.10.2.1.):  Alarm Log     (2.10.2.) 174
 Enable     (2.11.1.1.):  Elapsed Time Relay     (2.11.1.) 175
 Enable     (2.11.2.1.):  Time of Day Relay     (2.11.2.) 176
 Enable     (2.11.3.1.):  External Totalizer     (2.11.3.) 177
 Enable     (2.11.4.1.):  External Sampler     (2.11.4.) 178
 Enable     (2.14.3.1.):  Daylight Saving     (2.14.3.) 188
 Enable     (2.7.2.1.1.):  Wall Cling Reduction     (2.7.2.1.) 154
 Enable     (2.7.2.2.1.):  Energy Savings     (2.7.2.2.) 155
 Enable     (2.7.2.3.1.):  Pump Run-On     (2.7.2.3.) 159
 Enable     (2.8.1.1.):  High Level Alarm     (2.8.1.) 162
 Enable     (2.8.10.1.):  Low Flowrate Alarm     (2.8.10.) 169
 Enable     (2.8.2.1.):  Low Level Alarm     (2.8.2.) 163
 Enable     (2.8.3.1.):  Switch (Discrete Input) Alarm     (2.8.3.) 163
 Enable     (2.8.4.1.):  In-bounds Level Alarm     (2.8.4.) 164
 Enable     (2.8.5.1.):  Out-of-bounds Level Alarm     (2.8.5.) 165
 Enable     (2.8.6.1.):  Low Temperature Alarm     (2.8.6.) 166
 Enable     (2.8.7.1.):  High Temperature Alarm     (2.8.7.) 167
 Enable     (2.8.8.1.):  Fail-safe Fault Alarm     (2.8.8.) 167
 Enable     (2.8.9.1.):  High Flowrate Alarm     (2.8.9.) 168
 Enable     (2.9.1.1.):  Backup Level Override     (2.9.1.) 171
 Enable Pump 1     (2.9.3.1.) 173
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 Enable Pump 2     (2.9.3.3.) 173
 Ending Day     (2.14.3.6.) 189
 Ending Month     (2.14.3.7.) 189
 Ending Ordinal     (2.14.3.5.) 189
 Energy Savings     (2.7.2.2.) 155
 External Sampler     (2.11.4.) 178
 External Totalizer     (2.11.3.) 177
 Fail-Safe     (2.4.) 143
 Fail-safe Fault Alarm     (2.8.8.) 166
 Fail-Safe mA Value     (2.4.3.) 144
 Far Range     (2.2.5.) 141
 Figure of Merit     (3.2.9.1.) 203
 Fill Rate per Minute     (2.3.1.) 142
 Firmware Revision     (3.1.11.) 200
 Fixed Temperature     (2.12.1.4.) 180
 Flow     (2.15.) 189
 Flow Exponent     (2.15.3.2.) 191
 Flow Log     (2.10.3.) 174
 Flow Log Mode     (2.10.3.1.) 174
 Flow Measurement     (2.12.5.6.) 186
 Flowrate Decimal     (2.15.3.6.) 193
 Flowrate Units     (2.15.3.7.) 193
 Frequency     (2.1.7.) 140
 Hardware Revision     (3.1.10.) 200
 Head Measurement     (2.12.5.5.) 186
 High Calibration Point     (2.2.2.) 141
 High Flowrate Alarm     (2.8.9.) 168
 High Flowrate Value OFF     (2.8.9.3.) 168
 High Flowrate Value ON     (2.8.9.2.) 168
 High Level Alarm     (2.8.1.) 162
 High Level Value     (2.8.4.2.) 164
 High Level Value     (2.8.5.2.) 165
 High Level Value OFF     (2.8.1.3.) 162
 High Level Value ON     (2.8.1.2.) 162
 High Temperature Alarm     (2.8.7.) 166
 High Temperature Value OFF     (2.8.7.3.) 167
 High Temperature Value ON     (2.8.7.2.) 167
 Highest Value     (3.2.8.1.) 202
 Hover Level     (2.12.3.3.) 184
 Identification     (3.1.) 199
 In-bounds Level Alarm     (2.8.4.) 164
 Inflow/Discharge Adjust     (2.7.3.4.) 161
 Installation Date     (3.1.5.) 199
 Interval     (2.11.1.2.):  Elapsed Time Relay     (2.11.1.) 175
 Interval     (2.11.4.3.):  External Sampler     (2.11.4.) 178
 K Factor     (2.15.4.1.) 196
 Language     (6.) 217
 LCD Contrast     (2.13.2.) 187
 Level     (3.4.1.) 214
 Level Measurement     (2.12.5.1.) 186
 Level Override Value     (2.9.1.2.) 171
 Level Setpoint Variation     (2.7.2.1.2.) 154
 Level Simulation Enable     (3.4.1.1.) 214
 Level To Spill     (2.8.12.1.) 170
 Level Value     (3.4.1.2.) 215
 Loader Revision     (3.1.12.) 200
 Local Display Backlight     (2.13.1.) 186
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 LOE Timer     (2.4.2.) 144
 Long Shot Duration     (2.1.8.) 140
 Long TAG     (3.1.2.) 199
 Low Calibration Point     (2.2.1.) 140
 Low Flow Cutoff     (2.15.3.9.) 194
 Low Flowrate Alarm     (2.8.10.) 169
 Low Flowrate Value OFF     (2.8.10.3.) 169
 Low Flowrate Value ON     (2.8.10.2.) 169
 Low Level Alarm     (2.8.2.) 163
 Low Level Value     (2.8.4.3.):  In-bounds Level Alarm     (2.8.4.) 164
 Low Level Value     (2.8.5.3.):  Out-of-bounds Level Alarm     (2.8.5.) 165
 Low Level Value OFF     (2.8.2.3.) 163
 Low Level Value ON     (2.8.2.2.) 163
 Low Temperature Alarm     (2.8.6.) 166
 Low Temperature Value OFF     (2.8.6.3.) 166
 Low Temperature Value ON     (2.8.6.2.) 166
 Lowest Value     (3.2.8.2.) 202
 Maintenance     (3.3.) 204
 Maintenance and Diagnostics     (3.) 199
 Manual Value     (2.5.7.) 147
 Manufacture Date (Date of Manufacturing in PDM)     (3.1.13.) 200
 Master Reset     (3.2.3.) 201
 Material Level     (2.4.1.) 143
 Maximum Flow at 20 mA     (2.15.3.4.) 192
 Maximum Head     (2.15.3.3.) 192
 Maximum mA Limit     (2.5.6.) 146
 Maximum Volume     (2.6.3.) 149
 Measured Values     (2.12.5.) 186
 Message     (3.1.4.) 199
 Method of Flow Calculation     (2.15.3.1.) 191
 Minimum mA Limit     (2.5.5.) 146
 Minutes Left To Spill     (2.8.12.2.) 170
 Modifiers     (2.7.2.) 154
 Multiplier     (2.11.3.2.):  External Totalizer     (2.11.3.) 177
 Multiplier     (2.11.4.2.):  External Sampler     (2.11.4.) 178
 Narrow Echo Filter     (2.12.2.4.) 182
 Near Range     (2.2.4.) 141
 Noise Average     (3.2.9.4.) 203
 Noise Peak     (3.2.9.5.) 203
 OCM     (3.2.6.2.) 202
 OCM Dimension 1     (2.15.4.5.) 196
 OCM Dimension 2     (2.15.4.6.) 196
 OCM Dimension 3     (2.15.4.7.) 196
 OCM Dimension 4     (2.15.4.8.) 197
 OFF Setpoint Pump 1     (2.7.1.7.) 152
 OFF Setpoint Pump 2     (2.7.1.9.) 153
 ON Setpoint Pump 1     (2.7.1.6.) 152
 ON Setpoint Pump 2     (2.7.1.8.) 152
 Open the menu Device – Select Analog Output.     () 145
 Order Option     (3.1.14.) 200
 Other Control     (2.11.) 175
 Out-of-bounds Level Alarm     (2.8.5.) 165
 Peak 1 End Time     (2.7.2.2.4.) 156
 Peak 1 Start Time     (2.7.2.2.3.) 155
 Peak 2 End Time     (2.7.2.2.6.) 156
 Peak 2 Start Time     (2.7.2.2.5.) 156
 Peak 3 End Time     (2.7.2.2.8.) 157
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 Peak 3 Start Time     (2.7.2.2.7.) 156
 Peak 4 End Time     (2.7.2.2.10.) 157
 Peak 4 Start Time     (2.7.2.2.9.) 157
 Peak 5 End Time     (2.7.2.2.12.) 157
 Peak 5 Start Time     (2.7.2.2.11.) 157
 Peak Lead Time     (2.7.2.2.2.) 155
 Peak OFF Setpoint Pump 1     (2.7.2.2.14.) 158
 Peak OFF Setpoint Pump 2     (2.7.2.2.16.) 158
 Peak ON Setpoint Pump 2     (2.7.2.2.15.) 158
 PMD Dimensions     (2.15.4.) 194
 Power Resumption Delay     (2.7.2.4.2.) 160
 Power-on Resets     (3.2.4.) 201
 Power-on Time     (3.2.5.) 201
 Primary Measuring Device (PMD)     (2.15.1.) 190
 Process Temperature     (2.12.1.2.) 179
 Process Value Log     (2.10.1.) 174
 Process Values Log Rate     (2.10.1.2.) 174
 Product     (3.1.6.) 199
 Pump 1 Discrete Input     (2.9.3.2.) 173
 Pump 2 Discrete Input     (2.9.3.4.) 173
 Pump Activations     (3.4.3.) 215
 Pump Control     (1.2.) 138
 Pump Control Enable     (2.7.1.1.) 151
 Pump Control Mode     (2.7.1.4.) 151
 Pump Interlock     (2.9.3.) 173
 Pump Records     (3.2.7.) 202
 Pump Run-On     (2.7.2.3.) 159
 Pump Start Delays     (2.7.2.4.) 160
 Pumps     (2.7.) 151
 PV     (3.2.6.4.) 202
 QS Flow     (1.1.3.) 138
 QS Level     (1.1.1.) 138
 QS Volume     (1.1.2.) 138
 Quick Start     (1.1.) 138
 Ramp     (3.4.1.3.) 215
 Ramp Rate     (3.4.1.4.) 215
 Rapid Flow Log Interval     (2.10.3.5.) 175
 Rapid Flow Log Setpoint     (2.10.3.6.) 175
 Rate     (2.3.) 142
 Reform Echo     (2.12.2.3.) 182
 Relay 1 Logic     (2.8.11.1.) 170
 Relay 2 Logic     (2.8.11.2.) 170
 Relay 3 Logic     (2.8.11.3.) 170
 Relay Duration     (2.11.1.3.):  Elapsed Time Relay     (2.11.1.) 175
 Relay Duration     (2.11.2.3.):  Time of Day Relay     (2.11.2.) 176
 Relay Duration     (2.11.3.3.):  External Totalizer     (2.11.3.) 177
 Relay Duration     (2.11.4.4.):  External Sampler     (2.11.4.) 179
 Relay Logic     (2.11.1.5.):  Elapsed Time Relay     (2.11.1.) 176
 Relay Logic     (2.11.2.5.):  Time of Day Relay     (2.11.2.) 177
 Relay Logic     (2.11.3.5.):  External Totalizer     (2.11.3.) 178
 Relay Logic     (2.11.4.6.):  External Sampler     (2.11.4.) 179
 Relay Logic     (2.8.11.):  High Level Alarm     (2.8.1.) 169
 Relay Pump 1     (2.7.1.2.):  Basic Setup     (2.7.1.) 151
 Relay Pump 1     (3.2.7.3.):  Pump Records     (3.2.7.) 202
 Relay Pump 2     (2.7.1.3.):  Basic Setup     (2.7.1.) 151
 Relay Pump 2     (3.2.7.4.):  Pump Records     (3.2.7.) 202
 Reset Daily Totalizer     (2.16.5.) 198
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 Reset Running Totalizer     (2.16.6.):  Totalizers     (2.16.) 199
 Reset Running Totalizer     (2.7.3.5.):  Pumps     (2.7.) 161
 Roughness Coefficient     (2.15.4.4.) 196
 Run Time Relay 2     (3.2.7.1.) 202
 Run Time Relay 3     (3.2.7.2.) 202
 Run-On Duration Pump 1     (2.7.2.3.3.) 159
 Run-On Duration Pump 2     (2.7.2.3.4.) 159
 Run-On Interval     (2.7.2.3.2.) 159
 Running Totalizer     (2.16.2.):  Totalizers     (2.16.) 198
 Running Totalizer     (2.7.3.1.):  Pumps     (2.7.) 160
 Security     (5.) 217
 Sensor     (2.1.) 138
 Sensor Mode     (2.1.2.) 138
 Sensor Offset     (2.2.3.) 141
 Serial Number     (3.1.8.) 200
 Service Ratio Pump 1     (2.7.1.10.) 153
 Service Ratio Pump 2     (2.7.1.11.) 153
 Setup     (2.) 138
 Shaper Mode     (2.12.3.4.) 184
 Short Shot Duration     (2.1.9.) 140
 Signal Processing     (2.12.) 179
 Simulation     (3.4.) 214
 Slope     (2.15.4.3.) 196
 Sound Velocity     (2.12.1.1.) 179
 Sound Velocity at 20 degrees C     (2.12.1.5.) 180
 Space Measurement     (2.12.5.2.) 186
 Standard Flow Log Interval     (2.10.3.3.) 174
 Standard Flow Log Setpoint     (2.10.3.4.) 175
 Starting Day     (2.14.3.3.) 189
 Starting Month     (2.14.3.4.) 189
 Starting Ordinal     (2.14.3.2.) 188
 Submergence Detection     (2.12.2.5.) 182
 Switch (Discrete Input) Alarm     (2.8.3.) 163
 Table 1-8     (2.15.5.1.):  Universal Head vs. Flow     (2.15.5.) 197
 Table 1-8     (2.6.7.):  Volume     (2.6.) 150
 Table 17-24     (2.15.5.3.):  Universal Head vs. Flow     (2.15.5.) 197
 Table 17-24     (2.6.9.):  Volume     (2.6.) 151
 Table 25-32     (2.15.5.4.):  Universal Head vs. Flow     (2.15.5.) 197
 Table 25-32     (2.6.10.):  Volume     (2.6.) 151
 Table 9-16     (2.15.5.2.):  Universal Head vs. Flow     (2.15.5.) 197
 Table 9-16     (2.6.8.):  Volume     (2.6.) 151
 TAG     (3.1.1.) 199
 Temperature and Velocity     (2.12.1.) 179
 Temperature Peak Values     (3.2.8.) 202
 Temperature Source     (2.12.1.3.) 180
 Time     (2.14.2.) 188
 Time of Day Relay     (2.11.2.) 176
 Time To Spill     (2.8.12.) 170
 Totalizer Decimal Position     (2.16.3.):  Totalizers     (2.16.) 198
 Totalizer Decimal Position     (2.7.3.2.):  Pumps     (2.7.) 160
 Totalizer Multiplier     (2.16.4.):  Totalizers     (2.16.) 198
 Totalizer Multiplier     (2.7.3.3.):  Pumps     (2.7.) 161
 Totalizers     (2.16.):  Setup     (2.) 197
 Totalizers     (2.7.3.):  Pumps     (2.7.) 160
 Transducer     (2.1.6.) 140
 Transducer Enable     (3.3.1.) 204
 Trend     (3.2.2.) 201
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 TVT Setup     (2.12.3.) 183
 TVT Shaper     (2.12.4.) 184
 Units     (2.1.1.) 138
 Universal Head vs. Flow     (2.15.5.) 197
 User Defined Unit     (2.15.3.8.):  Flow     (2.15.) 194
 User Defined Unit     (2.6.6.):  Volume     (2.6.) 149
 V-Notch Angle     (2.15.4.2.) 196
 Vessel Shape     (2.6.1.) 147
 View Logs     (3.2.6.) 201
 Volume     (2.6.) 147
 Volume Measurement     (2.12.5.4.) 186
 Volume Units     (2.6.2.) 149
 Wall Cling Reduction     (2.7.2.1.) 154
 Wizards     (1.) 137
 Write Protection     (5.1.) 217
 Zero Head Offset     (2.15.3.5.) 193
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Service and Maintenance

SITRANS LUT400 requires no maintenance or cleaning under normal operating 
conditions.

Firmware updates
To update the LUT400 firmware, please contact your Siemens representative to obtain 
the installer (self-executable .exe file). For a complete list of representatives, go to 
www.siemens.com/processautomation. 

Two installers are available: one to update the firmware in the Local User Interface (LUI) 
node, and one for the sensor node. One or both may be required, depending on the 
reason for the update.
To complete an update, follow steps in the installer:

1. Connect your computer to the SITRANS LUT400 USB port.
2. Before running the .exe installer received from your Siemens representative, note 

the computer COM port to which the LUT400 is connected. 
3. From your computer, double-click the .exe, and follow the installer steps. The first 

step will prompt for Communication Options. These options are set to factory 
defaults. Ensure the COM Port is set to that noted in step 2 above. No other changes 
are required.

4. Follow remaining installer steps.
5. Once complete, verify the update was successful by checking the current firmware 

revision:
• If updating the LUI node, recycle the power on the LUT400. On power-up, you will 

see the current LUI firmware revision on the LUT400 display.
• If updating the sensor node, view parameter Firmware Revision (3.1.11.) to see 

the current sensor node firmware revision.

Complete a Master Reset (3.2.3.) to factory defaults after a successful upgrade of the 
sensor node, before re-entering parameters.

Transferring parameters using LUT400 display lid
If necessary to transfer parameters from one LUT400 to another, the LUI display 
maintains a backup file of the parameters on the device. With this backup file, it is 
possible to connect the remote lid to a second LUT400 to transfer parameters. 

When the remote lid is connected to a second device, a fault code is displayed to note 
that the LUI backup file does not match the configuration file in the sensor. You can then 
use the Backup Control parameter to specify that sensor parameters be copied from the 
LUI backup to the device [see Backup Control (3.3.2.) on page 204].
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Replacing the Battery
The battery (BR2032) has a life expectancy of ten years, and is affected by ambient 
temperature. If the device loses external power the battery will maintain the SITRANS 
LUT400’s Real Time Clock (date and time) until power is restored.

The flash memory is updated constantly. Therefore, data logs are unaffected by the loss 
of power.

 WARNING: Disconnect power before replacing the battery.
Notes:

• To replace, remove the existing battery from the holder as shown below, and 
reinstall replacement battery (BR2032).

• Battery Type: Lithium metal coin cell 
Battery Chemistry: solid-cathode Carbon Monofluoride

Dispose of battery in an environmentally safe manner, and according to 
local regulations.

1. Open the enclosure lid.
2. Slide the end of a 

screwdriver under the lip 
of the plastic battery 
cover, and lift cover with 
fingers. (Do not press 
back on fold.)

3. While holding cover in 
raised position, place end 
of screwdriver at an angle 
into slot below battery, 
and pry upward.

4. Lift out battery.
5. Insert new battery and 

press down on face of 
battery to secure in 
holder.

6. Press down on plastic 
battery cover to secure in 
place.

7. Close enclosure lid and 
tighten screws.

8. Reset the Real Time Clock 
(See Date and Time (2.14.) 
on page 187.)
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Decontamination Declaration
Any device returned to Siemens for repair must be accompanied by a Declaration of 
Decontamination. With this declaration you certify that the returned products/spare parts 
have been carefully cleaned and are free from any residues.

If the device has been operated together with toxic, caustic, flammable or water-
damaging products, clean the device before return by rinsing or neutralizing. Ensure that 
all cavities are free from dangerous substances. Then, double-check the device to ensure 
the cleaning is completed.

Siemens will not service a device or spare part unless the declaration of decontamination 
confirms proper decontamination of the device or spare part.

Shipments received without a declaration of decontamination will be cleaned 
professionally at your expense before further processing.

Decontamination Declaration form can be found on the internet at 
www.siemens.com/processinstrumentation, under Service – Decontamination 
Declaration.
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Diagnosing and Troubleshooting

Communication Troubleshooting
Generally

1. Check the following:

• There is power at the device
• The optional LCD is showing the relevant data
• The device can be programmed using the local push buttons.
• If any fault codes are being displayed, see “General Fault Codes” on page 231 

for a detailed list.

2. Verify that the wiring connections are correct.

Specifically

1. The SITRANS LUT400 is set to communicate via a HART modem but no 
communication is returning to the master.

• Check that the device address is set correctly for the HART network.

2. A SITRANS LUT400 parameter is set via remote communications, but the parameter 
remains unchanged.

• Try setting the parameter from the local push buttons. If it can not be set using 
the buttons, ensure 5.1. Write Protection is set to the unlock value.

If you continue to experience problems, go to our website at:
www.siemens.com/sitransLUT400, and check the FAQs for SITRANS LUT400, or contact 
your Siemens representative.

Notes: 
• Many of the parameters referenced and techniques described here require a good 

understanding of ultrasonic technologies and Siemens echo processing software. Use 
this information with caution.

• If the setup becomes too confusing do a 3.2.3. Master Reset and start again.
• As a further resource, Understanding Ultrasonic Level Measurement is available on our 

website. Go to www.siemens.com/level.
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Device Status Icons

LUI 
Icon

PDM
Icon

Priority
Levela

Meaning

1 • Maintenance alarm 
• Measurement values are not valid

2 • Maintenance warning: maintenance demanded immediately
• Measured signal still valid

3 • Maintenance required
• Measured signal still valid

1 • Process value has reached an alarm limit

2 • Process value has reached a warning limit

3 • Process value has reached a tolerance limit

1
• Configuration error
• Device will not work because one or more parameters/compo-

nents is incorrectly configured

2
• Configuration warning
• Device can work but one or more parameters/components is 

incorrectly configured

3
• Configuration changed
• Device parameterization not consistent with parameterization 

in project. Look for info text.

1 • Manual operation (local override)
• Communication is good; device is in manual mode.

2
• Simulation or substitute value
• Communication is good; device is in simulation mode or works 

with substitute values.

3 • Out of operation
• Communication is good; device is out of action.

(red)

(yellow)

(green)
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General Fault Codes

• Data exchanged

• No data exchange

• Write access enabled

• Write access disabled

a. Lowest priority number equals highest fault severity.

Notes: 
• If two faults are present at the same time, the device status indicator and text for the 

highest priority fault will display.
• Certain faults exist, such as with a loss of echo (LOE) or a broken cable, that when 

triggered cause the mA output to go to a fail-safe reading (see “Fail-Safe” on page 143) 
and LUI to display dashes (– – – – – – –) until fault is cleared. These faults are indicated 
with an asterisk (*) in the table below.

General Fault Codes
 

Code /
LUI 
Icon

Code /
PDM 
Icon

Meaning Corrective Action 

0 0
*

Loss of echo (LOE).
The device was unable to get a 
measurement within the Fail-safe 
LOE Timer period. Possible causes: 
faulty installation, foaming/other 
adverse process conditions, invalid 
calibration range.

• Ensure installation details are correct. 
• Adjust process conditions to minimize 

adverse conditions. 
• Correct range calibration. 
• If fault persists, contact your local Sie-

mens representative.

1 1
*

Cable fault.
Broken cable.

Inspect attached cabling and any termi-
nation points to ensure no disconnec-
tion or damage; repair/replace if 
necessary. If no issue with cabling, con-
tact your local Siemens representative.

3 3 Device is nearing its lifetime limit 
according to the value set in Main-
tenance Required Limit.

Replacement is recommended.

LUI 
Icon

PDM
Icon

Priority
Levela

Meaning (Continued)
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4 4 Device is nearing its lifetime limit 
according to the value set in Main-
tenance Demanded Limit.

Replacement is recommended.

5 Saving Parameters.
(LUI fault only.)
Saving is in progress. Do not turn off 
the device.

Wait for completion.

6 6 Sensor is nearing its lifetime limit 
according to the value set in Main-
tenance Required Limit.

Replacement is recommended.

7 7 Sensor is nearing its lifetime limit 
according to the value set in Main-
tenance Demanded Limit.

Replacement is recommended.

8 8
Service interval as defined in Main-
tenance Required Limit has expired.

Perform service.

9 9 Service interval as defined in Main-
tenance Demanded Limit has 
expired.

Perform service.

10 10

Configuration parameters are incor-
rect. The following conditions will 
cause this fault:
• Far Range < Low Cal. Pt.
• Near Range > Far Range
• Low Cal. Pt - High Cal. Pt. < 10 cm
• Far Range - Near Range < 10 cm
• Max. mA Limit ≤ Min. mA Limit
• Current Output Function set to 

Volume, but Vessel Shape set to 
None

• Current Output Function set to 
Volume, but Max. Volume has not 
been set.

Check device configuration.

17 17 Calibration interval as defined in 
Maintenance Required Limit has 
expired.

Perform calibration.

18 18 Calibration interval as defined in 
Maintenance Demanded Limit has 
expired.

Perform calibration.

25 25
Internal device error.

Reset power. If fault persists, contact 
your local Siemens representative.

General Fault Codes
  (Continued)

Code /
LUI 
Icon

Code /
PDM 
Icon

Meaning Corrective Action 

(red)
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26 26
*

Submergence detected.
The transducer appears submerged.

Correct the installation.

27 27 Incorrect product model.
Basic model does not support flow 
and advanced pump control 
features

Only configure the supported features.

39 39
*

Transducer temperature sensor has 
failed.

Inspect attached cabling and any 
termination points to ensure no 
disconnection or damage; repair/
replace if necessary. If no issue with 
cabling, contact your local Siemens 
representative.

46 46
* The TS-3 temperature sensor failed.

Inspect attached cabling and any 
termination points to ensure no 
disconnection or damage; repair/
replace if necessary. If no issue with 
cabling, contact your local Siemens 
representative.

47 47
Poor signal from the application.
Poor installation or high noise level.

Verify installation.

121 121 Flow calculations are not config-
ured properly. Incorrect parameter 
settings.

Reconfigure the unit. Check the configu-
ration. If fault persists, do a master 
reset.

122 122
Flow calculations encountered an 
error.

Reconfigure the unit. Check the break-
points. If fault persists, do a master 
reset.

123 123
Flow log could not restore the 
settings.

Reconfigure the unit. Check the flow log 
settings. If fault persists, do a master 
reset.

124 124

Flow log is not configured properly.
Reconfigure the unit. Check the flow log 
settings. If fault persists, do a master 
reset.

125 125
Flow log error.
Log failed.

Verify that the drive where the log file 
resides is not full. Copy the log file to a 
computer and delete it from the device.

126 126
Failed to open log file.

Verify that the drive where the log file 
resides is not full. Copy the log file to a 
computer and delete it from the device.

General Fault Codes
  (Continued)

Code /
LUI 
Icon

Code /
PDM 
Icon

Meaning Corrective Action 

(red)

(red)

(red)
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Common Problems Chart

127 127
Failed to close log file.

Verify that the drive where the log file 
resides is not full. Copy the log file to a 
computer and delete it from the device.

128 128
Log file read error. 
Error reading file. Unexpected error.

Verify that the drive where the log file 
resides is not full. Copy the log file to a 
computer and delete it from the device.

129 129 Log file write error.
Error writing file. The file could not 
be written; the disk is full.

Copy the log file to a computer and 
delete it from the device.

130 130
Configuration error.
One or more settings invalid.

Adjust/correct relay assignments or 
setpoints.

131 131 Parameter backup did not succeed.
Communication or file system 
problems.

Repair required. Contact your local 
Siemens representative.

132 132
User input required.
Serial numbers mismatch.

Manually force recovery. 
(Set parameter 3.3.2. Backup Control.)

133 133
Simulation Enabled.

Simulation is active.
Enable or disable simulation via LUI 
(3.4.1.1. Level Simulation Enable, 3.4.2.1. 
Discrete Input 1, 3.4.2.2. Discrete Input 
2).

Symptom Possible Cause Action
Display blank, trans-
ducer not pulsing

No power, incorrect power Check mains voltage at terminals;
Check fuse; 
Check wiring connections; 
Check wiring.

Display blank, trans-
ducer is pulsing

Loose or disconnected display 
cable

Reconnect display cable.

Display active, trans-
ducer not pulsing

Incorrect transducer connec-
tions or wiring; 
Incorrect transducer selection 
(or set to NO Transducer); 
Transducer has been disabled 
through the software

Verify terminal connections;
Check transducer field wiring;
Check any junction box connec-
tions;
Check that transducer is enabled 
(see Transducer Enable (3.3.1.) on 
page 204)

General Fault Codes
  (Continued)

Code /
LUI 
Icon

Code /
PDM 
Icon

Meaning Corrective Action 

(red)

(red)
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Symptom Cause Action
Reading fluctuates 
while material level is 
still

Material level is changing Visually verify, if possible.
Strong false echoes Determine source of false echoes;

Relocate transducer to avoid 
source.

Incorrect damping Adjust damping. See Damping Fil-
ter (2.3.3.) on page 143.

Improper echo Algorithm selec-
tion

Set algorithm to default. If no 
improvement, try a different algo-
rithm. See Algorithm (2.12.2.1.) on 
page 181.

High noise levels Verify source and minimize. See 
“Noise Problems” on page 240.

Weak echo Determine cause; 
Check noise, confidence, FOM, 
and echo strength. See Echo 
Quality (3.2.9.) on page 203.

Foam on surface of material Eliminate source of foaming; 
Use stilling well.

Rapid temperature changes Use an external temperature sen-
sor. See Temperature Source 
(2.12.1.3.) on page 180.

Faulty temperature sensor Verify operation;
Replace if required, or use fixed 
temperature. See Temperature 
Source (2.12.1.3.) on page 180.

Vapours If fluctuation is unacceptable, con-
sider an alternative technology. 
Contact your Siemens representa-
tive.
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Symptom Cause Action
Reading is fixed, but 
material level changes 
or reading does not fol-
low material level

Incorrect speed of response Verify response speed setting is 
adequate for process. See 
Response Rate (set in the Quick 
Start Wizard).

Loss of Echo condition (LOE) Check Noise, Echo Strength, Con-
fidence. See Echo Quality (3.2.9.) 
on page 203.
Check LOE Timer is not set too 
short. See LOE Timer (2.4.2.) on 
page 144.

Agitator blade stopped in front 
of transducer (false echo)

Ensure agitator is running.

Foam on surface of material Eliminate source of foaming. 
Use stilling well

Incorrect Algorithm used Set algorithm to default. If no 
improvement, try a different algo-
rithm. See Algorithm (2.12.2.1.) on 
page 181.

Transducer mounting: wrong 
location or incorrectly mounted

Ensure beam has a clear path to 
material surface;
Verify transducer is not too tight;
Use an isolation coupling.

Incorrect transducer used for 
the application

Use correct transducer. Contact 
your Siemens representative.

Unavoidable false echoes from 
obstructions

Relocate transducer to ensure 
beam has a clear path to material 
surface; 
Use manual TVT shaping or Auto 
False Echo Suppression. See TVT 
Shaper (2.12.4.) on page 184 or 
Auto False Echo Suppression 
(2.12.3.1.) on page 183.
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Symptom Cause Action
Accuracy Varies Faulty temperature sensor Verify operation; 

Replace if required, or use fixed 
temperature. See Temperature 
Source (2.12.1.3.) on page 180.

Vapours present in varying con-
centrations

Eliminate vapours or consider a 
different technology. Contact your 
Siemens representative.

Thermal gradients Insulate vessel; 
Consider external temperature 
sensor.

Calibration required If accuracy is better when level is 
close to transducer, and worse 
when level is far from transducer, 
perform calibration [see Auto 
Sound Velocity (2.12.1.6.) on page 
181].
If accuracy is consistently incor-
rect, use Sensor Offset (2.2.3.) on 
page 141 or perform calibration 
[see Auto Sensor Offset (2.2.6.) 
on page 142].

Reading erratic Transducer mounting: wrong 
location or incorrectly mounted

Ensure beam has a clear path to 
material surface; 
Verify transducer is not too tight;
Use an isolation coupling.

Unavoidable false echoes from 
obstructions

Use Auto False Echo Suppression. 
See Auto False Echo Suppres-
sion (2.12.3.1.) on page 183.

Confidence too low Check Noise, Echo Strength, Con-
fidence. See Echo Quality (3.2.9.) 
on page 203.
Check LOE Timer is not set too 
short. See LOE Timer (2.4.2.) on 
page 144.

Multiple echoes Check mounting location; 
Verify material is not entering 
Near Range zone. See Near 
Range (2.2.4.) on page 141.

Noise in the application Verify source and minimize. See 
“Noise Problems” on page 240.
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Symptom Cause Action
Incorrect reading (mA 
output and/or dis-
played value)

mA function not assigned to 
correct measurement

Check mA assignment. See Cur-
rent Output Function (2.5.1.) on 
page 144.

When device configured for 
flow: exponent or breakpoint 
not correctly selected

Check configuration: if 2.1.2. Sen-
sor Mode set to FLOW, verify cor-
rect exponent [Flow Exponent 
(2.15.3.2.) on page 191] and break-
points [Universal Head vs. Flow 
(2.15.5.) on page 197].

Incorrect vessel or PMD dimen-
sions

For volume application: Verify ves-
sel dimensions. See Vessel Shape 
(2.6.1.) on page 147.
For flow application: Verify PMD 
dimensions. See PMD Dimen-
sions (2.15.4.) on page 194

Relay not activating Relay not programmed Program relay.
Relay incorrectly assigned Verify with simulation. See Simu-

lation (3.4.) on page 214.
Incorrect relay function 
selected

Verify with simulation. See Simu-
lation (3.4.) on page 214.

Incorrect relay setpoints Verify setpoints.
Relay not activating 
correctly

Relay incorrectly assigned Verify with simulation. See Simu-
lation (3.4.) on page 214.

Incorrect relay function 
selected

Verify with simulation. See Simu-
lation (3.4.) on page 214.

Incorrect relay setpoints Verify setpoints.
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Symptom Cause Action
No response when 
echo profile requested 
via LUI (3.2.1. Echo Pro-
file)

Transducer is disabled. Set Transducer Enable (3.3.1.) on 
page 204 to ENABLED, then 
request an echo profile.

Configuration error 130 
displayed

Relay/pump configuration 
errors - possible causes 
include: 
• A relay is assigned to more 

than one function (e.g. relay 2 
is assigned to both an 
external totalizer and a 
pump).

• Pump setpoints are out of 
order.

• Wall Cling adjustment range 
is too large.

• Verify that each relay is 
assigned to one function only. 
Review relay assignments 
under Pump Control (page 151) 
and Other Control functions 
(page 175).

• Verify that all ’ON’ setpoints are 
greater than their respective 
’OFF’ setpoints for pump down 
applications (or vica versa for 
pump up applications).

• Ensure range set in Level 
Setpoint Variation (2.7.2.1.2.) on 
page 154 has not caused ’ON’ or 
’OFF’ setpoints to overlap.

Echo profile request 
results in an error icon 
that displays for 5 sec-
onds before returning 
to the echo profile 
request menu.

Another external communica-
tion is trying to access an echo 
profile at the same time.

Wait for several seconds and then 
retry the echo profile request, or
disconnect / disable any external 
communications that may be 
requesting an echo profile.

Data log files are empty 
or logging has stopped.

• Data Logging is not enabled.

• USB cable is connected.

• USB extension cable has 
been used (although may not 
currently be connected).

• Verify that Data Logging is 
enabled. See Data Logging 
(2.10.) on page 173.

• Disconnect USB cable, as no 
data logs are written while 
device is connected to a PC via 
USB.

• If a USB extension cable has 
been used (remove if currently 
connected), a power reset of 
the device is required to restart 
Data Logging.
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Noise Problems
Incorrect readings can be the result of noise problems, either acoustic or electrical, in the 
application.

The noise present at the input to the ultrasonic receiver can be determined by viewing the 
echo profile locally via the LUI, or alternatively, using remote software such as SIMATIC 
PDM, AMS Device Manager, FC375/475, or DTM. View also parameters 3.2.9.4. Noise 
Average and 3.2.9.5. Noise Peak. In general, the most useful value is the average noise. 

With no transducer attached the noise is under 5 dB. This is often called the noise floor. If 
the value with a transducer attached is greater than 5 dB, signal processing problems 
can occur. High noise decreases the maximum distance that can be measured. The exact 
relationship between noise and maximum distance is dependent on the transducer type 
and the material being measured. An average noise level greater than 30 dB may be 
cause for concern if the installed transducers maximum operation range matches the 
range of the application (e.g. 8 m application using an 8 m XRS-5). Using a larger 
transducer with greater transmitted energy should help to improve performance in a 
noise condition.

Determine the Noise Source
Disconnect the transducer from the SITRANS LUT400. If the measured noise is below 
5 dB, then continue here. If the measured noise is above 5 dB go to Non-Transducer 
Noise Sources below.

1. Connect only the shield wire of the transducer to the SITRANS LUT400. If the 
measured noise is below 5 dB, continue with the next step. If the noise is above 5 
dB, go to Common Wiring Problems below.

2. Connect the white and black transducer wires to the SITRANS LUT400. Record the 
average noise.

3. Remove the positive wire of the transducer. Record the average noise.
4. Re-connect the positive wire and remove the negative wire. Record the average 

noise.
Using the table below, determine the appropriate next step. The terms higher, lower and 
unchanged refer to the noise recorded in the previous steps. 

These are guidelines only. If the suggested solution does not solve the problem, try the 
other options also.

- removed + removed Go to:

no
is

e

higher higher Reducing Electrical Noise
unchanged Common Wiring Problems
lower Reducing Acoustical Noise

unchanged higher Reducing Electrical Noise
unchanged Contact Siemens representative.
lower Reducing Acoustical Noise

lower higher Common Wiring Problems
unchanged Common Wiring Problems
lower Reducing Acoustical Noise
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Acoustical Noise

To confirm that the problem is acoustical, place several layers of cardboard over the face 
of the transducer. If the noise is reduced, the noise is definitely acoustical.

Non-Transducer Noise Sources
Remove all input and output cables from the SITRANS LUT400 individually while 
monitoring the noise. If removing a cable reduces the noise, that cable may be picking up 
noise from adjacent electrical equipment. Check that low voltage cables are not being 
run adjacent to high voltage cables or near to electrical noise generators such as variable 
speed drives. 

Filtering cables is an option but is not recommended unless all other options have been 
exhausted.

The SITRANS LUT400 is designed to work near heavy industrial equipment such as 
variable speed drives. Even so, it should not be located near high voltage wires or switch 
gear.

Try moving the electronics to a different location. Often moving the electronics a few 
meters farther from the source of noise will fix the problem. Shielding the electronics is 
also an option, but it should be a last resort. Proper shielding is expensive and is difficult 
to install properly–the shielding box must enclose the SITRANS LUT400 electronics 
completely, and all wires must be brought to the box through grounded metal conduit.

Common Wiring Problems
• Make sure that the transducer shield wire is connected at the electronics end only. 

Do not ground it at any other location. 
• Do not connect the transducer shield wire to the white wire. 
• The exposed transducer shield wire must be as short as possible. 
• Connections between the wire supplied with the transducer, and any customer 

installed extension wire should only be grounded at the LUT400.
On Siemens transducers the white wire is negative and the black wire is positive. If the 
extension wire is colored differently, make sure that it is wired consistently.

Extension wire must be shielded twisted pair. See the installation section for 
specifications.

Reducing Electrical Noise
• Ensure that the transducer cable does not run parallel to other cables carrying high 

voltage or current.
• Move the transducer cable away from noise generators like variable speed drives.
• Put the transducer cable in grounded metal conduit.
• Filter the noise source.
• Check grounding.
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Reducing Acoustical Noise
• Move the transducer away from the noise source.
• Use a stilling well.
• Install a rubber or foam bushing or gasket between the transducer and the 

mounting surface.
• Relocate or insulate the noise source.
• Change the frequency of the noise. Ultrasonic devices are sensitive to noise in the 

frequency range of the transducer employed.
• Check that transducer is not mounted too tightly; only hand-tight.

Measurement Difficulties
If the 2.4.2. LOE Timer expires due to a measurement difficulty, the 2.4.3. Fail-Safe mA 
Value displays. In rare cases, the SITRANS LUT400 may lock on to a false echo and report 
a fixed or wrong reading. 

Loss of Echo (LOE)
The 2.4.3. Fail-Safe mA Value displays (seen in 2.5.8. Current Output Value) when the echo 
confidence is below the threshold value set in 2.12.2.2. Echo Threshold.

LOE occurs when:

• The echo is lost and no echo is shown above the ambient noise (see low 3.2.9.2. 
Confidence and low 3.2.9.3. Echo Strength)

• Two echoes are too similar to differentiate (when BLF algorithm used) (see low 
3.2.9.2. Confidence and low 3.2.9.3. Echo Strength)

• No echo can be detected within the programmed range (see 2.2.5. Far Range).

If 2.4.3. Fail-Safe mA Value is displayed, check the following:

• Surface monitored is within the transducer maximum range
• 2.1.6. Transducer model matches the transducer used
• Transducer is located and aimed properly
• Transducer (that is installed without a submergence shield) is not submerged

Adjust Transducer Aiming
See the transducer manual for range, mounting, and aiming details. For optimum 
performance, adjust transducer aiming to provide the best 3.2.9.2. Confidence and 3.2.9.3. 
Echo Strength for all material levels within the measurement range. 

Displaying Echoes

The most efficient method of checking echoes is locally via the LUI, or remotely using 
SIMATIC PDM, AMS, FC375/475, or DTM software.

Use LUI or remote software to graphically display the echo profile at the installation. 
Interpret the echo profile and change relevant parameters. For LUI, see “Requesting an 
Echo Profile” on page 57, and for details on how to interpret an Echo Profile, see “Echo 
Processing” on page 255.
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Increase Fail-safe Timer Value
Increase the 2.4.2. LOE Timer value, if fail-safe operation will not be compromised by the 
larger value.

Try this only if LOE exists for short periods of time.

Install a Transducer with a Narrower Beam
A consistent, incorrect level reading may result due to interference echoes from the sides 
of a vessel. If this occurs, try installing a longer range (narrower beam) transducer, enter 
the new 2.1.6. Transducer model, and (if necessary) optimize aiming and frequency again. 

Always contact Siemens service personnel before selecting a transducer to solve this 
type of problem.

Fixed Reading
If the Reading is a fixed value, regardless of the transducer to material surface distance, 
ensure the:

1. Transducer acoustic beam is free from obstruction.
2. Transducer is properly aimed 
3. Transducer is not in contact with any metal object. 
4. Material mixer (if used) is operating while the SITRANS LUT400 is operating. If it is 

stopped, ensure that the mixer blade is not stopped under the transducer.

Obstructions in the Sound Beam
Check for (and remove if present) any acoustic beam obstruction, or relocate the 
transducer.

If an obstruction cannot be removed or avoided, adjust the Time Varying Threshold (TVT) 
curve to reduce the Echo Confidence derived from the sound reflected by the obstruction. 
Use SIMATIC PDM to adjust the TVT curve. (SeeTVT Shaper under Echo Profile Utilities in 
LUT400 Communications manual1.)

Nozzle Mountings
If the transducer is mounted on or in a nozzle, grind smooth any burrs or welds on the 
inside or open end (the end that opens into the vessel). If the problem persists, install a 
larger diameter or shorter length nozzle, bevel the inside of the bottom end, or cut the 
open end of the nozzle at a 45° angle. 

See the transducer manual for complete mounting instructions.

If the mounting hardware is over tightened, loosen it. Over tightening changes the 
resonance characteristics of the transducer and can cause problems. 

1. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)
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Set the SITRANS LUT400 to Ignore the Bad Echo
If the preceding remedies have not fixed the problem, the false echo has to be ignored. 

If the Echo is Close to the Transducer
If there is a static, incorrect, high level reading from the SITRANS LUT400 there is 
probably something reflecting a strong echo back to the transducer. If the material level 
never reaches that point extend the 2.2.4. Near Range to a distance to just past the 
obstruction. 

Adjust the TVT to Ignore the Echo
Use 2.12.3.1. Auto False Echo Suppression. If this does not correct the problem, use 2.12.4. 
TVT Shaper to manually shape around false echoes.

Wrong Reading
If the Reading is erratic, or jumps to some incorrect value periodically, ensure the:

1. Surface monitored is not beyond the SITRANS LUT400’s programmed range or the 
transducer’s maximum range.

2. Material is not falling into the transducer’s acoustic beam.
3. Material is not inside the blanking distance (near range) of the transducer.

Types of Wrong Readings
If a periodic wrong Reading is always the same value, see “Fixed Reading” on page 243. 

If the wrong Reading is random, ensure the distance from the transducer to the material 
surface is less than 2.2.5. Far Range value plus one meter (i.e. ensure you are still within 
the measurement range programmed in the device). If the material/object monitored is 
outside this range, increase 2.2.5. Far Range as required. This error is most common in 
OCM applications using weirs.

Liquid Splashing
If the material monitored is a liquid, check for splashing in the vessel. Enter a lower 
Response Rate value (see page 42) to stabilize the Reading, or install a stilling well. 
(Contact Siemens representative.)

Adjust the Echo Algorithm 
Use SIMATIC PDM to view echo profiles and make adjustments to the Algorithm 
parameter. See 2.12.2.1. Algorithm on page 181 for details.

If the "TRACKER” algorithm is used and narrow noise spikes are evident on the Echo 
Profile, widen the 2.12.2.4. Narrow Echo Filter. Also, if the true echo has jagged peaks, use 
2.12.2.3. Reform Echo.

If multiple echoes appear on the Echo Profile, typical of a flat material profile (especially if 
the vessel top is domed), use the “TF ” (True First) algorithm.

Should a stable measurement still not be attainable, contact Siemens representative.
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Troubleshooting

Transducer Ringing
If the transducer is mounted too tightly, or if it is mounted so that its side touches 
something (such as a vessel wall, or standpipe), its resonance characteristics change 
and this can cause problems. Hand tighten only. PTFE tape is not recommended as it 
reduces friction resulting in a tighter connection that can lead to ringing.

Normal Ring Down 

Poor Ring Down

Ring down times that extend past the near range area can be interpreted by the SITRANS 
LUT400 as the material level and are characterized by a steady high level being reported.

Echo Profile Display
To assist in troubleshooting echo profiles, pan and zoom options are available. See 
“Requesting an Echo Profile” on page 57.

Trend Display
A trend display is available with pan and zoom options. See “Trends” on page 118.

ring down

time of correct echoTVT curve

echo profile

ring down

time of correct echo

TVT curve

echo profile
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Technical Data

Power 

AC model

• 100-230 V AC 15%, 50 / 60 Hz, 36 VA (10W)1

• Fuse: 5 x 20 mm, Slow Blow, 0.25A, 250V

DC model

• 10-32 V DC, 10W 1

• Fuse: 5 x 20 mm, Slow Blow, 1.6A, 125V

Performance

Range
• 0.3 to 60 m (1 to 196 ft), dependent on transducer

Accuracy (measured under Reference Conditions similar to IEC 60770-1)

• Standard operation: ±1 mm (0.04") plus 0.17 % of distance

• High accuracy OCM 2: ±1 mm (0.04"), within 3 m (9.84 ft) range

Resolution (measured under Reference Conditions similar to IEC 60770-1)

• Standard operation: 0.1 % of range or 2 mm (0.08”), whichever is greater

• High accuracy OCM 2: 0.6 mm (0.02"), within 3 m (9.84 ft) range

Reference operating conditions according to IEC 60770-1
• ambient temperature +15 to +25 °C (+59 to +77 °F)
• humidity 45% to 75% relative humidity
• ambient pressure 860 to 1060 mbar g (86 000 to 106 000 N/m2 g)

Temperature Compensation

• Range: -40 to +150 °C (-40 to +300 °F)

1. Power consumption is listed at maximum. 
2. A high accuracy configuration consists of the LUT440 (OCM) model using XRS-5 transducer, TS-3 

temperature sensor, and a Low Calibration Point of 3 m or less. 
Under severe EMI/EMC environments per IEC 61326-1 the DC powered device may have an 
additional error increase of up to 0.5 mm.
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Source

• Integral transducer sensor
• TS-3 temperature sensor
• Average (integral transducer and TS-3)
• Programmable fixed temperature

Temperature Error

Fixed

• 0.17 % per °C deviation from programmed value

Memory

• 512 kB flash EPROM
• 1.5 MB flash for data logging

Interface 

Outputs

mA Analog

• 4-20 mA
• 600 ohms maximum in ACTIVE mode, 750 ohms maximum in PASSIVE mode
• Resolution of 0.1%
• Isolated

Relays1 (3)

• 2 control 
• 1 alarm control 

Control Relays

• 2 Form A (SPST), NO relays
• Rated 5A at 250 V AC, non-inductive
• Rated 3A at 30 V DC

1. All relays are certified only for use with equipment that fails in a state at or under the rated 
maximums of the relays.
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Technical Data

Alarm Relay

• 1 Form C (SPDT), NO or NC relay
• Rated 1A at 250 V AC, non-inductive
• Rated 3A at 30 V DC

Inputs

Discrete (2)

• 0-50 V DC maximum switching level
• Logical 0 = < 10 V DC
• Logical 1 = 10 to 50 V DC
• 3 mA maximum draw

Programming

Primary

• Local push buttons

Secondary

• PC running SIMATIC PDM
• PC running Emerson AMS Device Manager
• PC running a web browser
• PC running a Field Device Tool (FDT)
• Field Communicator 375/475 (FC375/FC475)

Compatible Transducers

• EchoMax series and STH series

Transducer Frequency

• 10 to 52 kHz 

Communication

• HART 7.0
• USB

Display

• Back-lit LCD
• Dimensions:

• 60 x 40 mm (2.36 x 1.57")
• Resolution:

• 240 x 160 pixels
• Removable display, operational up to 5 m from enclosure base
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Mechanical 

Enclosure

• 144 mm (5.7") x 144 mm (5.7") x 146 mm (5.75")
• IP65 / Type 4X / NEMA 4X
• Polycarbonate

Remote Display Lid
• 144 mm (5.7") x 144 mm (5.7") x 22 mm (0.87")
• IP65 / Type 3 / NEMA 3
• Polycarbonate
• Operational up to 5 m from enclosure base

Blank Lid
• 144 mm (5.7") x 144 mm (5.7") x 22 mm (0.87")
• IP65 / Type 4X / NEMA 4X
• Polycarbonate

Back Mount Bracket
• 190 mm (7.5") x 190 mm (7.5") x 9 mm (0.35")
• Polycarbonate

Weight

• Enclosure with display lid: 1.3 kg (2.87 lbs)
• Enclosure with blank lid: 1.2 kg (2.65 lbs)

Environmental

Location
• Indoor / outdoor 

(only suitable for outdoor use with IP65 / Type 4X / NEMA 4X Enclosure)

Note: Use only approved, suitable size hubs in the enclosure’s conduit holes that 
maintain the applicable IP / Type / NEMA rating.

 WARNINGS: 
• Ingress protection of the enclosure is reduced to IP20, and Type 4X / 

NEMA 4X rating is void when cable entry knock-out in the blank lid is 
removed.

• An enclosure reduced to an IP20 rating and intended for use in non-
hazardous locations must be installed in an indoor location free of dust 
and moisture, or be installed in a suitably rated field enclosure IP54 or 
better.
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Technical Data

Altitude
• 2000 m max.

Ambient temperature
• -20 to +50 °C (-4 to +122 °F)

Relative humidity
• Suitable for outdoors 

(only with IP65 / Type 4X / NEMA 4X Enclosure)

Installation category
• II

Pollution degree
• 4

Approvals

• General
CSAUS/C, CE, FM, UL listed, C-TICK

• Hazardous
Non-incendive (Canada) CSA Class I, Div. 2, Groups A, B, C, D; Class II, 

Div 2, Groups F, G; Class III

Note: The device nameplate lists the approvals that apply to your device.
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Dimension Drawings

SITRANS LUT400 Dimensions

SITRANS LUT400

enclosure

back
mount

bracket

144 mm 
(5.7 ")

155 mm 
(6.10 ")

22 mm 
(0.87 ")

190 mm 
(7.5 ")

cable entry 
(3 places)

198 mm 
(7.8 ")

146 mm 
(5.75 ")

34 mm 
(1.34")

34 mm 
(1.34")
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Cutout Dimensions (for Remote Panel Mount)

110.00 ± 1.00
1.80 ± 1.00

13.50 ± 1.00

97.00 ± 1.00

6.25 RAD.
(4 PLACES)

5.50 DIA.
(4 PLACES)

125.00

125.00

DIMENSIONS ARE IN MILLIMETERS.

Note: Cut-out template (printed to scale) shipped with remote panel mount model.
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Appendix A - Technical Reference

Principles of Operation
The SITRANS LUT400 is a high quality ultrasonic controller, configured to meet the needs 
of different applications, from medium range solids applications to liquids management 
with open channel measurement capability. The LUT400 features our next generation of 
Sonic Intelligence® advanced echo-processing software for increased reading reliability. 

Process Variables
The Primary Variable (PV) is one of six process variables, and is set in 2.5.1.Current Output 
Function:

• Level (difference between material level and Low Calibration Point), 
• Space (difference between material level and High Calibration Point), 
• Distance (difference between material level and sensor reference point), 
• Head (difference between liquid level and Zero Head), 
• Volume (volume of material based on level), 
• Flow (flowrate in an open channel, based on head).

Transmit Pulse
The transmit pulse consists of one or more electrical “shot” pulses, which are supplied to 
the transducer connected to the SITRANS LUT400 terminals. The transducer fires an 
acoustic “shot” for each electrical pulse supplied. After each shot is fired, sufficient time 
is provided for echo (shot reflection) reception before the next (if applicable) shot is fired. 
After all shots of the transmit pulse are fired, the resultant echoes are processed. The 
transmit pulse frequency, duration, delay, and associated measurement range are 
defined by parameters in the Setup menu (see Setup on page 138.)

Echo Processing
SITRANS LUT400 uses next generation Sonic Intelligence® for echo processing.

Next generation Sonic Intelligence provides adaptive digital filtering of the transducer 
signal. For example, when noise levels are high, filters are adjusted to maximize the 
signal to noise ratio. This advanced Sonic Intelligence not only allows for better filtering, 
but provides improved tracking of echos, and more sophisticated echo positioning 
algorithms.

Echo processing consists of echo enhancement, true echo selection, and selected echo 
verification.

Echo enhancement is achieved by filtering (2.12.2.4. Narrow Echo Filter) and reforming 
(2.12.2.3. Reform Echo) the echo profile. 

Note: Where a number precedes a parameter name (for example, 2.12.2.4. Narrow Echo 
Filter) this is the parameter access number via the local display. See Parameter 
reference (LUI) on page 137 for a complete list of parameters. 
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True echo selection (selection of echo reflected by the intended target) occurs when that 
portion of the echo profile meets the evaluation criteria of Sonic Intelligence.

Insignificant portions of the echo profile outside of the measurement range (2.2.1. Low 
Calibration Point), below the TVT curve (2.12.4. TVT Shaper) are automatically 
disregarded. The remaining portions of the Echo Profile are evaluated using the echo 
select algorithm (2.12.2.1. Algorithm), and the Echo Profile portion providing the best echo 
confidence (3.2.9.2. Confidence) is selected. 

A confidence value is a static test of a single snapshot profile so to maintain a valid 
reading, it imposes that each individual profile show its peak above the threshold. The 
window may be locked on the profile for hours or days so if the profile drops below the 
TVT curve just once, a loss of echo may occur.

The SITRANS LUT400, with it’s advanced tracking ability, can find and track the real echo 
amongst stationary clutter echoes. Therefore, even if the echo drops below the tvt curve, 
it can be identified with near certainty for approximately 30 seconds. This capability is 
measured by the FOM (3.2.9.1. Figure of Merit).

Selected echo verification is automatic. The position (relation in time after transmit) of the 
new echo is compared to that of the previously accepted echo. When the new echo is 
within the Echo Lock Window, it is accepted and displays, outputs, and relays are 
updated. If the new echo is outside of the Window, it is not accepted until Echo Lock 
requirements are satisfied.

Echo Selection

Time Varying Threshold (TVT)
A TVT curve describes a threshold below which any echoes will be ignored. The default 
TVT curve is used, until 2.12.3.1. Auto False Echo Suppression and 2.12.3.2. Auto False Echo 
Suppression Range are used to create a new ’learned TVT curve’.

A TVT hovers above the echo profile to 
screen out unwanted reflections (false 
echoes).

In most cases the material echo is the 
only one which rises above the default 
TVT.

In a vessel with obstructions, a false 
echo may occur. See  Shaper Mode and 
Auto False Echo Suppression below for 
more details.

The device characterizes all echoes that rise above the TVT as potential good echoes. 
Each peak is assigned a rating based on its strength, area, height above the TVT, and 
reliability, amongst other characteristics.

default TVT 

material 
level

echo marker

echo profile
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Algorithm
The true echo is selected based on the setting for the Echo selection algorithm. For a list 
of options see Algorithm (2.12.2.1.) on page 181. All algorithms ultimately use confidence 
to select the true echo. However, when applications report a low confidence value, the 
TR algorithm (which tracks the moving echo) can be used to predict the primary variable.

Confidence
Confidence (3.2.9.2.) describes the quality of an echo. Higher values represent higher 
quality.

Echo Threshold
Echo Threshold (2.12.2.2.) defines the minimum confidence value required for an echo to 
be accepted as valid and evaluated.

Algorithm Echo Determination Suggested Usage

TF True First echo
Selects the first echo that crosses TVT 
curve.

Use in liquids applica-
tions free of obstruc-
tions when confidence 
of first echo is high.

TR TRacker

Selects the echo that is closest to the 
transducer, and is moving. (If echo loca-
tion is steady, BLF algorithm should be 
used.)

Only use TR algorithm in 
process applications 
with continuous level 
changes, and a risk of 
fixed obstructions that 
could interfere with true 
level, resulting in low 
confidence.

L Largest echo 
Selects the largest echo above the TVT 
curve.

Use in long range liq-
uids applications with 
large (tall) material 
return echoes.

BLF
Best of First and 
Largest echo 

Selects the echo (first and highest) with 
the highest confidence value.

Default and most com-
monly used. Use in all 
short to mid range gen-
eral liquids and solids 
applications where there 
is a relatively large (tall), 
sharp echo.

ALF
Area, Largest, 
and First

Selects the echo with the highest confi-
dence value based on the three criterion 
(widest, highest, and first).

Use in mid to long range 
solids applications 
where the material 
return echo is wide and 
large, and where com-
peting smaller echoes 
challenge BLF.
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Figure of Merit
Figure of Merit (3.2.9.1.) measures the quality of the reported process value: higher values 
represent better quality. Even when a low confidence value exists, a high FOM will 
ensure the true echo has been selected. Approximately 20 readings are used to support 
the FOM value.

Example:

FOM greater than 75% = good quality, 
FOM less than 50% = poor quality. 

Various things contribute to the FOM:

• success of the tracking (how closely can the next level vs. the actual next level be 
predicted)

• level of noise
• confidence of the last echo
• time interval since last valid echo
• speed at which the process is moving
• quality of the echo shape and how it helps the calculation of the echo position

If FOM is low, reduce the noise in the process, or check the installation to increase signal 
quality. 

Shaper Mode and Auto False Echo Suppression

False echoes can be caused by an obstruction in the transducer shot path (such as pipes, 
ladders, chains). Such false echoes may rise above the default TVT curve. 

Auto False Echo Suppression Range (2.12.3.2.) specifies the range within which the 
learned TVT is applied. Default TVT is applied over the remainder of the range. 

The material level should be below all known obstructions at the moment when Auto 
False Echo Suppression learns the echo profile. Ideally the vessel should be empty or 
almost empty.

The device learns the echo profile over the whole measurement range and the TVT is 
shaped around all echoes present at that moment. 

Notes: 
• For detailed instructions on using this feature via PDM, see Auto False Echo 

Suppression in LUT400 Communications manuala. 
• For detailed instructions on using this feature via the local push buttons, see Shaper 

Mode (2.12.3.4.) on page 184.

a. Communications for SITRANS LUT400 (HART) Manual (7ML19985NE01)
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Auto False Echo Suppression Range must be set to a distance shorter than the distance 
to the material level when the environment was learned, to avoid the material echo being 
screened out.

Measurement Range
Near Range
Near Range (2.2.4.) programs SITRANS LUT400 to ignore the area in front of the 
transducer. The default blanking distance is 27.8 cm (0.91 ft) from the sensor reference 
point.

Near Range allows you to increase the blanking value from its factory default. But Shaper 
Mode (2.12.3.4.) is generally recommended in preference to extending the blanking 
distance from factory values.

Far Range
Far Range (2.2.5.) can be used in applications where the base of the vessel is conical or 
parabolic. A reliable echo may be available below the vessel empty distance, due to an 
indirect reflection path. 

Increasing Far Range by 30% or 40% can provide stable empty vessel readings.

0 0 0 0

High Cal. Pt. = 1 m

obstruction at 13 m

material level at 31 m
false 
echo 

material
echo

default 
TVT 

sensor reference point

Example before Auto False Echo Suppression 

Low Cal. Pt. = 45 m

0 0 0 0

Distance

P
ro

fi
le

Example after Auto False Echo Suppression 

learned 
TVT 

material 
echo

false echo echo 
marker

Auto False Echo 
Suppression 
Range set to 20 m

Auto False Echo 
Suppression Range

default 
TVT 
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Measurement Response

Response Rate limits the maximum rate at which the display and output respond to 
changes in the measurement. There are three preset options: slow, medium, and fast.

Once the real process fill/empty rate (m/min by default) is established, a response rate 
can be selected that is slightly higher than the application rate. Response Rate 
automatically adjusts the three rate parameters that affect the output response rate. 

Damping
Damping Filter (2.2.3.) smooths out the response to a sudden change in level. This is an 
exponential filter and the engineering unit is always in seconds. 

In 5 time constants, the output rises exponentially: from 63.2% of the change in the first 
time constant, to almost 100% of the change by the end of the 5th time constant.

Note: Units are defined in Quick Start (1.1.) and are in meters by default.

When Response 
Rate set to:

Fill Rate per Minute (2.3.1.)/
Empty Rate per Minute (2.3.2.)
automatically adjust to:

Damping Filter 
(2.3.3.) automatically 
adjusts to:

* Slow 0.1 m/min 100.0 s

Medium 1.0 m/min 10.0 s

Fast 10.0 m/min 0.0 s

Note: Damping Filter can be set to 0 in order to display measurement readings as fast 
as fill/empty rates permit. Fill Rate per Minute, and Empty Rate per Minute work in 
conjunction with Damping Filter, therefore, if readings are slow to respond to changes, 
check that Fill and Empty Rates are set to values greater than or equal to the desired 
Response Rate.

Le
ve

l (
m

)

Time (s)

smoothed outputinput (level)

Damping example
time constant = 2 seconds
input (level) change = 2 m
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Analog Output
The mA output (current output) is proportional to material level in the range 4 to 20 mA. 
0% and 100% are percentages of the full-scale reading (m, cm, mm, ft, in). Typically mA 
output is set so that 4 mA equals 0% and 20 mA equals 100%.

Current Output Function (2.5.1.)
Current Output Function (2.5.1.) controls the mA output and applies any relevant scaling. 
By default it is set to LEVEL. Other options are Space, Distance, Volume, Head, Flow, or 
Manual. A MANUAL setting allows you to test the functioning of the loop.

You can also set the mA output to report when the device is in an error condition and the 
fail-safe timer has expired. By default, the reported value depends on the device type. A 
standard device reports the last valid reading, and a NAMUR NE43 compliant device 
reports the user-defined value for Material Level (3.58 mA by default).

Loss of Echo (LOE)
A loss of echo (LOE) occurs when the calculated measurement is judged to be unreliable 
because the echo confidence value has dropped below the echo confidence threshold. 

If the LOE condition persists beyond the time limit set in LOE Timer (2.4.2.) the LCD 
displays the Service Required icon, and the text region displays the fault code 0 and the 
text LOE.

If two faults are present at the same time, the device status indicator and text for the 
highest priority fault will display. For example, if both Loss of Echo and Broken cable 
faults are present, the Broken cable fault will display.

 1 Broken cable

Fail-safe Mode
The purpose of the Fail-safe setting is to put the process into a safe mode of operation in 
the event of a fault or failure. The value to be reported in the event of a fault (as displayed 
in 2.5.8. Current Output Value) is selected so that a loss of power or loss of signal triggers 
the same response as an unsafe level. 

LOE Timer (2.4.2.) determines the length of time a Loss of Echo (LOE) condition will persist 
before a Fail-safe state is activated. The default setting is 100 seconds.

Material Level (2.4.1.) determines the mA value (corresponding to the selected PV) to be 
reported when LOE Timer (2.4.2.) expires. The default setting is device dependent 
(standard or NAMUR NE 43-compliant).

Upon receiving a reliable echo, the loss of echo condition is aborted, the Maintenance 
Required icon and error message are cleared, and the mA output return to the current 
material level. [The PV region on the LUI display will show dashes (– – – – – – –) when a 
fault that causes fail-safe is present, and will return to the current reading when the fault 
is cleared.]
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Distance Calculation
To calculate the transducer to material level (object) distance, the transmission medium 
(atmosphere) 2.12.1.1. Sound Velocity is multiplied by the acoustic transmission to 
reception time period. This result is divided by 2 to calculate the one way distance.

Distance = Sound Velocity x Time / 2

The Reading displayed is the result of performing any additional modification to the 
calculated distance as determined by:

• 2.1.2. Sensor Mode, 
• 2.1.1. Units, 
• Volume conversion parameters - 2.6. Volume, 2.2.3. Sensor Offset, 
• Flow parameters - 2.15. Flow, 
• and/or Totalizer parameters - 2.16. Totalizers.

Sound Velocity
The sound velocity of the transmission medium is affected by the type, temperature, and 
vapor pressure of the gas or vapor present. As preset, the SITRANS LUT400 assumes the 
vessel atmosphere is air at +20 °C (+68 °F). Unless altered, the sound velocity used for the 
distance calculation is 344.1 m / s (1129 ft / s).

Variable air temperature is automatically compensated when a Siemens ultrasonic / 
temperature transducer is used. If the transducer is exposed to direct sunlight, use a 
sunshield or a separate TS-3 temperature sensor.

Also, if the temperature varies between the transducer face and the liquid monitored, use 
a TS-3 temperature sensor in combination with an ultrasonic / temperature transducer. 
The TS-3 must be installed as close to the material as possible to ensure best 
performance. It is acceptable to submerge the TS-3 if necessary. Set 2.12.1.3. Temperature 
Source for Average of Sensors, to average the transducer and TS-3 measurements.

Atmosphere composition other than air can pose a challenge for ultrasonic level 
measurement. However, excellent results may be obtained if the atmosphere is 
homogeneous (well mixed), at a fixed temperature, and consistent vapour pressure, by 
performing a 2.12.1.6. Auto Sound Velocity.

The SITRANS LUT400 automatic temperature compensation is based on the sound 
velocity / temperature characteristics of “air” and may not be suitable for the atmosphere 
present. If the atmosphere temperature is variable, perform frequent sound velocity 
calibrations to optimize measurement accuracy.

Sound velocity calibration frequency may be determined with experience. If the sound 
velocity in two or more vessels is always similar, future calibrations may be performed on 
one vessel and the resultant 2.12.1.1. Sound Velocity entered directly for the other 
vessel(s).

If the sound velocity of a vessel atmosphere is found to be repeatable at specific 
temperatures, a chart or curve may be developed. Then rather than performing a sound 
velocity calibration each time the vessel temperature changes significantly, the 
anticipated 2.12.1.1. Sound Velocity may be entered directly.
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Volume Calculation
The SITRANS LUT400 provides a variety of volume calculation features (see 2.6.Volume). 

If the vessel does not match any of the eight preset vessel shape calculations, a 
Universal Volume calculation may be used. Use the level/volume graph or chart provided 
by the vessel fabricator (or create one based on the vessel dimensions). Based on the 
graph, choose the Universal Volume calculation, and select the level vs. volume 
breakpoints to be entered (32 max). Generally, the more breakpoints entered, the greater 
the accuracy.

2.6.1.Vessel Shape set to Universal, Linear

This volume calculation creates a piece-wise linear approximation of the level/volume 
curve. This option provides best results if the curve has sharp angles joining relatively 
linear sections. 

Enter a Level Breakpoint at each point where the level/volume curve bends sharply (2 
minimum).

For combination curves (mostly linear but include one or more arcs), enter numerous 
breakpoints along the arc, for best volume calculation accuracy.

2.6.1.Vessel Shape set to Universal, Curved

This calculation creates a cubic spline approximation of the level/volume curve, providing 
best results if the curve is non-linear, and there are no sharp angles.

Select at least enough breakpoints from the curve to satisfy the following:

• two breakpoints very near the minimum level
• one breakpoint at the tangent points of each arc
• one breakpoint at each arc apex
• two breakpoints very near the maximum level
For combination curves, enter at least two breakpoints immediately before and after any 
sharp angle (as well as one breakpoint exactly at the angle) on the curve.
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Pump Totalizers

Inflow/Discharge Adjust
Pumped volume totals are affected by the inflow (or discharge) rate. This rate can be 
calculated based on rate of change estimation, or pump cycle timing. 

Using Inflow/Discharge Adjust (2.7.3.4.), set option Based on rate estimation to have the 
inflow rate measured just prior to the start of the pump cycle.

Set option Based on pump cycle to calculate the inflow based on the change of volume 
between the end of the last pump cycle and the start of the next one, and the time period 
between the last cycle and the current one.

well refillspump down

Time

Level
Inflow estimation = L

T

L

T

well refillspump down

L2–L1

T2–T1

T1 T2

L1

L2

Time

Level

Inflow estimation = L2–L1

T2–T1

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F



A5E33329501 SITRANS LUT400 (HART) – OPERATING INSTRUCTIONS Page 265

m
m

m
m

m

A
pp. A

 - Technical Ref.

Flow Calculation
Special emphasis has been placed on providing the most accurate flow calculations possible. 
To this end, specific routines have been written to comply with the British Standards Institute’s 
Specifications BS-3680. These routines calculate correction factors taking into account 
second order effects such as approach velocity and boundary layer.

If the PMD does not match any of the eleven preset PMD calculations, or if a PMD is not 
used, select a Universal flow calculation (PMD = Universal Head Flow). Use the head/
flow graph or chart provided by the PMD fabricator (or create one based on the PMD or 
channel dimensions).

The SITRANS LUT400 supports Universal curved flow calculation. This calculation 
creates a cubic spline approximation of the head/flow curve, providing best results if the 
curve is non-linear, and there are no sharp angles.

Select the head versus flow breakpoints to be entered (32 max). Generally, the more 
breakpoints entered, the greater the flow calculation accuracy.

Select at least enough breakpoints from the curve to satisfy the following:

• two breakpoints very near the minimum head
• one breakpoint at the tangent points of each arc
• one breakpoint at each arc apex
• two breakpoints very near the maximum head
For combination curves, enter at least 2 breakpoints immediately before and after any 
sharp angle (as well as 1 breakpoint exactly at the angle) on the curve.
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Method of Flow Calculation
The SITRANS LUT400 can be programmed to use either of two methods for calculating flow 
from the head measurement: absolute or ratiometric. The result is the same regardless of the 
method used. The main difference is the information that must be entered in order for the 
device to carry out the calculation. Refer to2.15.1.Primary Measuring Device (PMD), and 
2.15.4.PMD Dimensions for list of information required.

For the ratiometric method, it is usually sufficient that the user know the flow rate (Qcal) which 
occurs at maximum head (hcal).

On the other hand, absolute calculations require that the user enter information such as: the 
physical dimensions of the PMD and the constant relating to units of measure for both linear 
dimensions and flow rates.

Example:

the general formula for flow through a single exponent PMD is: 

Q = KH x

the specific formula for flow through a 45 ° V-notch weir is: 

cfs = 1.03H2.5

thus: Q = flow in cubic feet per second

K = constant of 1.03

H = head in feet

The absolute method is not applicable to the following:

• Palmer Bowlus Flume
• H-Flume
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Data Logging
Data logs are available for Alarms, OCM flow, Daily Totals, and Primary Variable. The logs 
can be examined locally via LUI (see View Logs (3.2.6.), or via USB on a computer. 

After connecting the USB cable, browse to the USB drive on the computer. Logs can be 
viewed on the USB drive, or can be copied from the USB drive to another local computer 
drive. 

Log files written to a local computer drive via USB, are comma-delimited files, and a list of 
file headings for each type of log is shown below.

To clear entries when log memory becomes full, see Viewing the Data Log on page 119.

Note: No data logs are written while device is connected to a PC via USB. 

Log type Headings
Alarms Current Date (YYYY/MM/DD)

Current Time (HH:MM:SS)

Alarm Name

Alarm Value

Alarm State

OCM Current Date (YYYY/MM/DD)

Current Time (HH:MM:SS)

Current Head Value (in level units)

Current Flow Value (in flowrate units)

Daily Totals Current Date (YYYY/MM/DD)

Maximum Daily Flow (in flowrate units)

Minimum Daily Flow (in flowrate units)

Daily Average Flow (in flowrate units)

Daily Totalized Volume (in volume units)

Daily Running Totalized Volume (in volume units)

Daily Maximum Temperature (in temperature units)

Daily Minimum Temperature (in temperature units)

PV Current Date (YYYY/MM/DD)

Current Time (HH:MM:SS)

PV (in Device Variable Code)
0 = Level
1 = Space
2 = Distance
3 = Volume
4 = Flow
5 = Head

PV Value (in PV units)

Temperature Value (in temperature units)
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Appendix B - Certificates and Support

Certificates
Certificates can be downloaded from the product page of our website at: 
www.siemens.com/sitransLUT400.

Technical Support
If you have any technical questions about the device described in these Operating 
Instructions and do not find the answers, you can contact Customer Support:

• Via the Internet using the Support Request:
Support request (http://www.siemens.com/automation/support-request)

• Via Phone:
• Europe: +49 (0) 911 895 7222
• America: +1 423 262 5710
• Asia-Pacific: +86 10 6475 7575

Further information about our technical support is available on the Internet at 
Technical support (http://support.automation.siemens.com/WW/view/en/16604318)

Service & Support on the Internet
In addition to our documentation, we offer a comprehensive knowledge base online on 
the Internet at:

Service & Support (http://www.siemens.com/automation/service&support)

There you will find:

• The latest product information, FAQs, downloads, tips and tricks.
• Our newsletter, providing you with the latest information about our products.
• Our bulletin board, where users and specialists share their knowledge worldwide.
• Your local contact partner for Industry Automation and Drives Technologies in our 

partner database.
• Information about field service, repairs, spare parts and lots more under "Services".

Additional Support
Please contact your local Siemens representative and offices if you have additional 
questions about the device.

Find your contact partner at:

Local contact person (http://www.siemens.com/automation/partner)
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Short form Long Form Description Units

AC Alternating Current power source

AFES Auto False Echo Suppression

CE / FM / CSA
Conformité Européene / Factory 
Mutual / Canadian Standards 
Association

safety approval

BS-3680 Flow standard from the British Standards Institute

DC Direct Current power source

DTM Device Type Manager

EDD Electronic Device Description

EMC Electromagnetic Compatibility

ESD Electrostatic Discharge

FCC Federal Communications Commission

FDT Field Device Tool

FOM Figure of Merit
measurement of 
echo quality

HART
Highway Addressable Remote 
Transducer

HCF Hart Communication Foundation

IEC
International Electrotechnical 
Commission

IP Ingress Protection

IS Intrinsically Safe safety approval

LCD Liquid Crystal Display

LOE Loss of Echo

LUI Local User Interface
view outputs via LCD display; 
make modifications via local 
push buttons

s microsecond 10-6 Second

V microvolt 10-6 Volt

mA Milliamp unit of electric current

N m Newton meter unit of torque
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PDM Process Device Manager

PLC Programmable Logic Controller

PV Primary Variable measured value

RC Resistance Capacitance
resistance x 
capacitance

s

SCADA
Supervisory Control and Data 
Acquisition

SCR Silicon-controlled rectifier switching device

SPDT Single Pole Double Throw relay configuration

SPST Single Pole Single Throw relay configuration

SV Secondary Variable equivalent value

TVT Time Varying Threshold sensitivity threshold

USB Universal Serial Bus

VSDs Variable Speed Drives

Short form Long Form Description Units
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MPS

L MODE
PUMP 1
PUMP 2
P 1
P 2
UMP 1
UMP 2
UMP 1
UMP 2

T420)
T430, 440)
ONDARY (LUT420)
ONDARY (LUT430, 440)

ION
TION

SET

E

LUT420)
LUT430, 440)

VALUE

T
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MAIN MENU
1. WIZARDS

1.1 QUICK START
1.1.1 QS LEVEL

INTRODUCTION
TRANSDUCER
OPERATION
TEMPERATURE SOURCE
FIXED TEMPERATURE
UNITS
HIGH CALIB. PT.
LOW CALIB. PT.
RESPONSE RATE
APPLY?

1.1.2 QS VOLUME
INTRODUCTION
TRANSDUCER
TEMPERATURE SOURCE
FIXED TEMPERATURE
VESSEL SHAPE
UNITS
HIGH CALIB. PT.
LOW CALIB. PT.
RESPONSE RATE
DIMENS. A
DIMENS. L
VOLUME UNITS
MAX. VOLUME
APPLY?

1.1.3 QS FLOW (LUT430, 440 only)
INTRODUCTION
TRANSDUCER
TEMPERATURE SOURCE
FIXED TEMPERATURE
PRIMARY MEASURING DEVICE
METHOD OF FLOW CALCULATION
UNITS
HIGH CALIB. PT.
LOW CALIB. PT.
RESPONSE RATE
Calculation factors (vary per PMD)
PMD dimensions (vary per PMD)
MAXIMUM HEAD
ZERO HEAD OFFSET
FLOWRATE UNITS
MAXIMUM FLOW AT 20MA
FLOWRATE DECIMAL
LOW FLOW CUTOFF
APPLY?

1.2 PUMP CONTROL
INTRODUCTION
NUMBER OF PU
RELAY PUMP 1
RELAY PUMP 2
PUMP CONTRO
SERVICE RATIO 
SERVICE RATIO 
RUN TIME PUM
RUN TIME PUM
ON SETPOINT P
ON SETPOINT P
OFF SETPOINT P
OFF SETPOINT P

2. SETUP
2.1 SENSOR

2.1.1 UNITS
2.1.2 SENSOR MODE (LU
2.1.3 SENSOR MODE (LU
2.1.4 SENSOR MODE SEC
2.1.5 SENSOR MODE SEC
2.1.6 TRANSDUCER
2.1.7 FREQUENCY
2.1.8 LONG SHOT DURAT
2.1.9 SHORT SHOT DURA

2.2 CALIBRATION
2.2.1 LOW CALIB. PT.
2.2.2 HIGH CALIB. PT.
2.2.3 SENSOR OFFSET
2.2.4 NEAR RANGE
2.2.5 FAR RANGE
2.2.6 AUTO SENSOR OFF

2.3 RATE
2.3.1 FILL RATE/MIN
2.3.2 EMPTY RATE/MIN
2.3.3 DAMPING FILTER

2.4 FAIL-SAFE
2.4.1 MATERIAL LEVEL
2.4.2 LOE TIMER
2.4.3 FAIL-SAFE MA VALU

2.5 CURRENT OUTPUT
2.5.1 CURR. OUT. FUNC. (
2.5.2 CURR. OUT. FUNC. (
2.5.3 4 MA SETPOINT
2.5.4 20 MA SETPOINT
2.5.5 MIN. MA LIMIT
2.5.6 MAX. MA LIMIT
2.5.7 MANUAL VALUE
2.5.8 CURRENT OUTPUT 

2.6 VOLUME
2.6.1 VESSEL SHAPE
2.6.2 VOLUME UNITS
2.6.3 MAX. VOLUME
2.6.4 DIMENS. A
2.6.5 DIMENS. L
2.6.6 USER DEFINED UNI

Notes: 
•In Navigation mode ARROW keys navigate the menu in the 
direction of the arrow. 
•See Parameter reference (LUI)  on page  137 for detailed 
information and instructions.

1. WIZARDS (cont’d)
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EL VALUE ON
EL VALUE OFF
D RELAY
TATE

EL VALUE ON
EL VALUE OFF
D RELAY
TATE

E INPUT NUMBER
E INPUT STATE
D RELAY
TATE

M

EL VALUE
EL VALUE
D RELAY
TATE
LARM

EL VALUE
EL VALUE
D RELAY
TATE
RM

PERATURE VALUE ON
PERATURE VALUE OFF

D RELAY
TATE
RM

MPERATURE VALUE ON
MPERATURE VALUE OFF
D RELAY
TATE

D RELAY
TATE

 (LUT440 only)

WRATE VALUE ON
WRATE VALUE OFF
D RELAY
TATE

2. SETUP - VOLUME (cont’d) 2. SETUP - ALARMS (cont’d)
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2.6.7 TABLE 1-8
2.6.8 TABLE 9-16
2.6.9 TABLE 17-24
2.6.10 TABLE 25-32

2.7 PUMPS
2.7.1 BASIC SETUP

2.7.1.1 PUMP CONTROL ENABLE
2.7.1.2 RELAY PUMP 1
2.7.1.3 RELAY PUMP 2
2.7.1.4 PUMP CONTROL MODE (LUT420)
2.7.1.5 PUMP CONTROL MODE (LUT430, 440)
2.7.1.6 ON SETPOINT PUMP 1
2.7.1.7 OFF SETPOINT PUMP 1
2.7.1.8 ON SETPOINT PUMP 2
2.7.1.9 OFF SETPOINT PUMP 2
2.7.1.10 SERVICE RATIO PUMP 1
2.7.1.11 SERVICE RATIO PUMP 2

2.7.2 MODIFIERS
2.7.2.1 WALL CLING REDUCTION

2.7.2.1.1 ENABLE
2.7.2.1.2 LEVEL SETPOINT VARIATION

2.7.2.2 ENERGY SAVINGS (LUT430, 440 only)
2.7.2.2.1 ENABLE
2.7.2.2.2 PEAK LEAD TIME
2.7.2.2.3 PEAK 1 START TIME
2.7.2.2.4 PEAK 1 END TIME
2.7.2.2.5 PEAK 2 START TIME
2.7.2.2.6 PEAK 2 END TIME
2.7.2.2.7 PEAK 3 START TIME
2.7.2.2.8 PEAK 3 END TIME
2.7.2.2.9 PEAK 4 START TIME
2.7.2.2.10 PEAK 4 END TIME
2.7.2.2.11 PEAK 5 START TIME
2.7.2.2.12 PEAK 5 END TIME
2.7.2.2.13 PEAK ON SETPOINT PUMP 1
2.7.2.2.14 PEAK OFF SETPOINT PUMP 1
2.7.2.2.15 PEAK ON SETPOINT PUMP 2
2.7.2.2.16 PEAK OFF SETPOINT PUMP 2

2.7.2.3 PUMP RUN-ON (LUT430, 440 only)
2.7.2.3.1 ENABLE
2.7.2.3.2 RUN-ON INTERVAL
2.7.2.3.3 RUN-ON DURATION PUMP 1
2.7.2.3.4 RUN-ON DURATION PUMP 2

2.7.2.4 PUMP START DELAYS (LUT430, 440 only)
2.7.2.4.1 DELAY BETWEEN STARTS
2.7.2.4.2 POWER RESUMPTION DELAY

2.7.3 TOTALIZERS (LUT430, 440 only)
2.7.3.1 RUNNING TOTALIZER
2.7.3.2 TOTALIZER DECIMAL POSITION
2.7.3.3 TOTALIZER MULTIPLIER
2.7.3.4 INFLOW/DISCHARGE ADJUST
2.7.3.5 RESET RUNNING TOTALIZER

2.8 ALARMS
2.8.1 HIGH LEVEL ALARM

2.8.1.1 ENABLE
2.8.1.2 HIGH LEV
2.8.1.3 HIGH LEV
2.8.1.4 ASSIGNE
2.8.1.5 ALARM S

2.8.2 LOW LEVEL ALARM
2.8.2.1 ENABLE
2.8.2.2 LOW LEV
2.8.2.3 LOW LEV
2.8.2.4 ASSIGNE
2.8.2.5 ALARM S

2.8.3 SWITCH (DI) ALARM
2.8.3.1 ENABLE
2.8.3.2 DISCRET
2.8.3.3 DISCRET
2.8.3.4 ASSIGNE
2.8.3.5 ALARM S

2.8.4 IN-BOUNDS LEVEL ALAR
2.8.4.1 ENABLE
2.8.4.2 HIGH LEV
2.8.4.3 LOW LEV
2.8.4.4 ASSIGNE
2.8.4.5 ALARM S

2.8.5 OUT-OF-BOUNDS LEVEL A
2.8.5.1 ENABLE
2.8.5.2 HIGH LEV
2.8.5.3 LOW LEV
2.8.5.4 ASSIGNE
2.8.5.5 ALARM S

2.8.6 LOW TEMPERATURE ALA
2.8.6.1 ENABLE
2.8.6.2 LOW TEM
2.8.6.3 LOW TEM
2.8.6.4 ASSIGNE
2.8.6.5 ALARM S

2.8.7 HIGH TEMPERATURE ALA
2.8.7.1 ENABLE
2.8.7.2 HIGH TE
2.8.7.3 HIGH TE
2.8.7.4 ASSIGNE
2.8.7.5 ALARM S

2.8.8 FAIL-SAFE FAULT ALARM
2.8.8.1 ENABLE
2.8.8.2 ASSIGNE
2.8.8.3 ALARM S

2.8.9 HIGH FLOWRATE ALARM
2.8.9.1 ENABLE
2.8.9.2 HIGH FLO
2.8.9.3 HIGH FLO
2.8.9.4 ASSIGNE
2.8.9.5 ALARM S
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ER (LUT430, 440 only)
ABLE
LTIPLIER
AY DURATION

SIGNED RELAY
AY LOGIC
R (LUT430, 440 only)

ABLE
LTIPLIER
ERVAL
AY DURATION

SIGNED RELAY
AY LOGIC

D VELOCITY
UND VELOCITY
OCESS TEMPERATURE

PERATURE SOURCE
ED TEMPERATURE
UND VELOCITY AT 20 DEGREES C
TO SOUND VELOCITY

ORITHM
O THRESHOLD
ORM ECHO

RROW ECHO FILTER
BMERGENCE DETECTION

TO FALSE ECHO SUPPRESSION
TO SUPP RANGE
VER LEVEL
APER MODE

KPT. 1-8
KPT. 9-16
KPT. 17-24
KPT. 25-32
KPT. 33-40

EL MEAS.
CE MEAS.
TANCE MEAS.

LUME MEAS.
AD MEAS.
W MEAS. (LUT430, 440 only)

CKLIGHT
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2.8.10 LOW FLOWRATE ALARM (LUT440 only)
2.8.10.1 ENABLE
2.8.10.2 LOW FLOWRATE VALUE ON
2.8.10.3 LOW FLOWRATE VALUE OFF
2.8.10.4 ASSIGNED RELAY
2.8.10.5 ALARM STATE

2.8.11 RELAY LOGIC
2.8.11.1 RELAY 1 LOGIC
2.8.11.2 RELAY 2 LOGIC
2.8.11.3 RELAY 3 LOGIC

2.8.12 TIME TO SPILL
2.8.12.1 LEVEL TO SPILL
2.8.12.2 MINUTES LEFT TO SPILL

2.9 DISCRETE INPUTS
2.9.1 BACKUP LEVEL OVERRIDE

2.9.1.1 ENABLE
2.9.1.2 LEVEL OVERRIDE VALUE
2.9.1.3 DISCRETE INPUT NUMBER

2.9.2 DISCRETE INPUT LOGIC
2.9.2.1 DISCRETE INPUT 1 LOGIC
2.9.2.2 DISCRETE INPUT 1 SCALED STATE
2.9.2.3 DISCRETE INPUT 2 LOGIC
2.9.2.4 DISCRETE INPUT 2 SCALED STATE

2.9.3 PUMP INTERLOCK (LUT430, 440 only)
2.9.3.1 ENABLE PUMP 1
2.9.3.2 PUMP 1 DISCRETE INPUT
2.9.3.3 ENABLE PUMP 2
2.9.3.4 PUMP 2 DISCRETE INPUT

2.10 DATA LOGGING
2.10.1 PROCESS VALUE LOG

2.10.1.1 ENABLE
2.10.1.2 PROCESS VALUES LOG RATE

2.10.2 ALARM LOG
2.10.2.1 ENABLE

2.10.3 FLOW LOG (LUT430, 440 only)
2.10.3.1 FLOW LOG MODE (LUT430)
2.10.3.2 FLOW LOG MODE (LUT440)
2.10.3.3 STANDARD FLOW LOG INTERVAL
2.10.3.4 STANDARD FLOW LOG SETPOINT
2.10.3.5 RAPID FLOW LOG INTERVAL
2.10.3.6 RAPID FLOW LOG SETPOINT

2.11 OTHER CONTROL
2.11.1 ELAPSED TIME RELAY

2.11.1.1 ENABLE
2.11.1.2 INTERVAL
2.11.1.3 RELAY DURATION
2.11.1.4 ASSIGNED RELAY
2.11.1.5 RELAY LOGIC

2.11.2 TIME OF DAY RELAY
2.11.2.1 ENABLE
2.11.2.2 ACTIVATION TIME
2.11.2.3 RELAY DURATION
2.11.2.4 ASSIGNED RELAY
2.11.2.5 RELAY LOGIC

2.11.3 EXTERNAL TOTALIZ
2.11.3.1 EN
2.11.3.2 MU
2.11.3.3 REL
2.11.3.4 AS
2.11.3.5 REL

2.11.4 EXTERNAL SAMPLE
2.11.4.1 EN
2.11.4.2 MU
2.11.4.3 INT
2.11.4.4 REL
2.11.4.5 AS
2.11.4.6 REL

2.12 SIGNAL PROCESSING
2.12.1 TEMPERATURE AN

2.12.1.1 SO
2.12.1.2 PR
2.12.1.3 TEM
2.12.1.4 FIX
2.12.1.5 SO
2.12.1.6 AU

2.12.2 ECHO SELECT
2.12.2.1 ALG
2.12.2.2 ECH
2.12.2.3 REF
2.12.2.4 NA
2.12.2.5 SU

2.12.3 TVT SETUP
2.12.3.1 AU
2.12.3.2 AU
2.12.3.3 HO
2.12.3.4 SH

2.12.4 TVT SHAPER
2.12.4.1 BR
2.12.4.2 BR
2.12.4.3 BR
2.12.4.4 BR
2.12.4.5 BR

2.12.5 MEAS. VALUES
2.12.5.1 LEV
2.12.5.2 SPA
2.12.5.3 DIS
2.12.5.4 VO
2.12.5.5 HE
2.12.5.6 FLO

2.13 DISPLAY
2.13.1 LOCAL DISPLAY BA
2.13.2 LCD CONTRAST

2.14 DATE AND TIME
2.14.1 DATE
2.14.2 TIME

2. SETUP - ALARMS (cont’d) 2. SETUP - OTHER CONTROL (cont’d)
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TALS

E RELAY 2
E RELAY 3

UMP 1
UMP 2
LUES
 VALUE
 VALUE

F MERIT
NCE
RENGTH
VERAGE
EAK

 EXPECTED
OPER.
. LIFETIME
ER ACTIV.
. 1 (REQ.)
. 2 (DEM.)
TAT
TUS

2. SETUP - DATE AND TIME (cont’d)

Operation & Maintenance Plan
 

Oven Run B Passive Treatment
System Redesign and Construction

Appendix 2F
A5E33329501 SITRANS LUT400 (HART) – INSTRUCTION MANUAL SITRANS LUT400 (HART) – INSTRUCT

A
pp

en
di

x 
C:

 m
en

u 
ch

2.14.3 DAYLIGHT SAVING
2.14.3.1 ENABLE
2.14.3.2 STARTING ORDINAL
2.14.3.3 STARTING DAY
2.14.3.4 STARTING MONTH
2.14.3.5 ENDING ORDINAL
2.14.3.6 ENDING DAY
2.14.3.7 ENDING MONTH

2.15 FLOW (LUT430, 440 only)
2.15.1 PRIMARY MEASURING DEVICE
2.15.2 AUTO ZERO HEAD
2.15.3 BASIC SETUP

2.15.3.1 METHOD OF FLOW CALCULATION
2.15.3.2 FLOW EXPONENT
2.15.3.3 MAXIMUM HEAD
2.15.3.4 MAXIMUM FLOW AT 20MA
2.15.3.5 ZERO HEAD OFFSET
2.15.3.6 FLOWRATE DECIMAL
2.15.3.7 FLOWRATE UNITS
2.15.3.8 USER DEFINED UNIT
2.15.3.9 LOW FLOW CUTOFF

2.15.4 PMD DIMENSIONS
2.15.4.1 K FACTOR
2.15.4.2 V NOTCH ANGLE
2.15.4.3 SLOPE
2.15.4.4 ROUGHNESS COEFFICIENT
2.15.4.5 OCM DIMENSION 1
2.15.4.6 OCM DIMENSION 2
2.15.4.7 OCM DIMENSION 3
2.15.4.8 OCM DIMENSION 4

2.15.5 UNIVERSAL HEAD VS FLOW
2.15.5.1 TABLE 1-8
2.15.5.2 TABLE 9-16
2.15.5.3 TABLE 17-24
2.15.5.4 TABLE 25-32

2.16 TOTALIZERS (LUT430, 440 only)
2.16.1 DAILY TOTALIZER
2.16.2 RUNNING TOTALIZER
2.16.3 TOTALIZER DECIMAL POSITION
2.16.4 TOTALIZER MULTIPLIER
2.16.5 RESET DAILY TOTALIZER
2.16.6 RESET RUNNING TOTALIZER

3. MAINTENANCE AND DIAGNOSTICS

3.1 IDENTIFICATION
3.1.1 TAG
3.1.2 LONG TAG
3.1.3 DESCRIPTOR
3.1.4 MESSAGE
3.1.5 INSTALLATION DATE
3.1.6 PRODUCT
3.1.7 ORDER NO.
3.1.8 SERIAL NUMBER
3.1.9 FINAL ASSEMBLY NUMB
3.1.10 HARDWARE REV
3.1.11 FIRMWARE REV
3.1.12 LOADER REV
3.1.13 MANUF. DATE
3.1.14 ORDER OPTION

3.2 DIAGNOSTICS
3.2.1 ECHO PROFILE
3.2.2 TREND
3.2.3 MASTER RESET
3.2.4 POWER-ON RESETS
3.2.5 POWER-ON TIME
3.2.6 VIEW LOGS

3.2.6.1 ALARMS
3.2.6.2 OCM
3.2.6.3 DAILY TO
3.2.6.4 PV

3.2.7 PUMP RECORDS
3.2.7.1 RUN TIM
3.2.7.2 RUN TIM
3.2.7.3 RELAY P
3.2.7.4 RELAY P

3.2.8 TEMPERATURE PEAK VA
3.2.8.1 HIGHEST
3.2.8.2 LOWEST

3.2.9 ECHO QUALITY
3.2.9.1 FIGURE O
3.2.9.2 CONFIDE
3.2.9.3 ECHO ST
3.2.9.4 NOISE A
3.2.9.5 NOISE P

3.3 MAINTENANCE
3.3.1 TRANSDUCER ENABLE
3.3.2 BACKUP CONTROL
3.3.3 REMAIN. DEV. LIFE

3.3.3.1 LIFETIME
3.3.3.2 TIME IN 
3.3.3.3 REMAIN
3.3.3.4 REMIND
3.3.3.5 REMIND
3.3.3.6 REMIND
3.3.3.7 MAINT S
3.3.3.8 ACK STA
3.3.3.9 ACK
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3.3.4 REMAIN SENS LIFE
3.3.4.1 LIFETIME EXPECTED
3.3.4.2 TIME IN OPER.
3.3.4.3 REMAIN. LIFETIME
3.3.4.4 REMINDER ACTIV.
3.3.4.5 REMIND. 1 (REQ.)
3.3.4.6 REMIND. 2 (DEM.)
3.3.4.7 MAINT STAT
3.3.4.8 ACK STATUS
3.3.4.9 ACK

3.3.5 SERVICE SCHED.
3.3.5.1 SERV. INTERVAL
3.3.5.2 TIME LAST SERV
3.3.5.3 TIME NEXT SERVICE
3.3.5.4 REMINDER ACTIV.
3.3.5.5 REMIND. 1 (REQ.)
3.3.5.6 REMIND. 2 (DEM.)
3.3.5.7 MAINT STAT
3.3.5.8 ACK STATUS
3.3.5.9 ACK

3.3.6 CALIB. SCHED.
3.3.6.1 CALIB. INTERVAL
3.3.6.2 TIME LAST CALIB
3.3.6.3 TIME NEXT CALIB
3.3.6.4 REMINDER ACTIV.
3.3.6.5 REMIND. 1 (REQ.)
3.3.6.6 REMIND. 2 (DEM.)
3.3.6.7 MAINT STAT
3.3.6.8 ACK STATUS
3.3.6.9 ACK

3.4 SIMULATION
3.4.1 LEVEL

3.4.1.1 LEVEL SIMULATION ENABLE
3.4.1.2 LEVEL VALUE
3.4.1.3 RAMP
3.4.1.4 RAMP RATE

3.4.2 DISCRETE INPUTS
3.4.2.1 DISCRETE INPUT 1
3.4.2.2 DISCRETE INPUT 2

3.4.3 PUMP ACTIVATIONS
4. COMMUNICATION

4.1 DEVICE ADDRESS
5. SECURITY

5.1 WRITE PROTECTION
6. LANGUAGE

3.  MAINTENANCE (cont’d)
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Glossary

accuracy: degree of conformity of a measure to a standard or a true value.

algorithm: a prescribed set of well-defined rules or processes for the solution of a problem in a 
finite number of steps.

ambient temperature: the temperature of the surrounding air that comes in contact with the 
enclosure of the device.

Auto False-Echo Suppression: a technique used to adjust the level of a TVT curve to avoid the 
reading of false echoes. (See TVT.)

Auto False-Echo Suppression Range: defines the endpoint of the TVT distance. (See TVT.) This 
is used in conjunction with auto false echo suppression.

blanking: a blind zone extending away from the reference point plus any additional shield 
length.The device is programmed to ignore this zone.

confidence: describes the quality of an echo. HIgher values represent higher quality. 
Confidence threshold defines the minimum value.

damping: term applied to the performance of a device to denote the manner in which the 
measurement settles to its steady indication after a change in the value of the level.

dB (decibel): a unit used to measure the amplitude of signals. 

derating: to decrease a rating suitable for normal conditions according to guidelines specified 
for different conditions. 

echo: a signal that has been reflected with sufficient magnitude and delay to be perceived in 
some manner as a signal distinct from that directly transmitted. Echoes are frequently 
measured in decibels relative to the directly transmitted signal.

echo confidence: the recognition of the validity of the echo. A measure of echo reliability.

echo lock window: a window centered on an echo in order to locate and display the echo’s 
position and true reading. Echoes outside the window are not immediately processed.

Echo marker: a marker that points to the processed echo.

Echo Processing: the process by which the device determines echoes.

Echo Strength: describes the strength of the selected echo in dB referred to 1 V rms.

Echo Profile: a graphical display of a processed echo.

false echo: any echo which is not the echo from the desired target. Generally, false echoes are 
created by vessel obstructions.

far range: the distance below the zero percent or empty point in a vessel.

figure of merit: combines noise level, tracking quality, and signal strength to measure the 
quality of the reported echo value.
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frequency: the number of periods occurring per unit time. Frequency may be stated in cycles 

per second.

Hertz (Hz): unit of frequency, one cycle per second. 1 Gigahertz (GHz) is equal to 109 Hz.

HART: Highway Addressable Remote Transducer. An open communication protocol used to 
address field devices. 

multiple echoes: secondary echoes that appear as double, triple, or quadruple echoes in the 
distance from the target echo.

parameters: in programming, variables that are given constant values for specific purposes or 
processes.

range: distance between a transducer and a target. 

shot: one transmit pulse or measurement.

speed of sound: the speed at which sound is propagated through some medium under 
specified conditions.

stillpipe: a pipe that is mounted inside a vessel parallel to the vessel wall, and is open to the 
vessel at the bottom.

stilling well: see stillpipe.

TVT (time varying threshold): a time-varying curve that determines the threshold level above 
which echoes are determined to be valid.
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Index

A
Abbreviations and Identifications

list 271
accuracy 247
alarm 76

bounded 77
common parameters 76
level 76
rate 79
temperature 78, 79

algorithms 181, 257
adjusting 244

alternate duty assist 80, 152
alternate duty backup 81, 82, 85
alternate duty service 83, 84
application

test 123
B
backup level override 69
blanking (see Near Range) 259
C
cable

routing 10
cables

requirements 20
characterization chart 73
coaxial cable 22, 23
communications 124
conduits

requirements 20
Connect 225
D
Damping

explanation 260
date 188
device description

HART 125
dimensions 63
discrete input

pump interlock 87
discrete inputs 69

wiring 69
display 249
distance calculation 262
E
echo profile

algorithms 181
echo selection

Algorithm 257
edit mode

handheld programmer 37
key functions 37

exponential flow 100
external totalizers 93
F
fail-safe 63
Fail-safe Mode

explanation 261
Fail-safe Timer

explanation 261
fat ring 90
Figure of Merit (FOM) 202, 256, 258
fixed duty assist 82
flow calculation 265
flume

cut throat 103, 104
H flume 115
Leopold Lagco 102
Palmer Bowlus 114
Parshall 101, 117
rectangular 105
universal trapezoidal 117

FOM 202, 256, 258
function keys

measurement mode 35
navigation mode 36

H
handheld programmer

edit mode 37
measurement mode 35
navigation 36

HART
device description 125
multi-drop mode 125

hazardous area installations
wiring requirements 31

I
Identifications and Abbreviations

list 271
in bounds 77
inputs 249
installation

hazardous area requirements 31
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interlock

pump 87
K
key functions

edit mode 37
L
LCD display

fast mode 201
measurement mode 34, 38
PROGRAM mode 35

level alarms 76
LOE

Fail-safe Mode 261
loss of echo (LOE) 63
LUI 7, 33

backup 225
commissioning 33
parameter reference 137
Quick Start wizards 38

M
measurement

difficulties 242
set up 63
setting up 63
single point 63
starting 63

mounting
wall mount 12

multi-drop mode 125
N
Near Range

explanation 259
noise problems 240
noise sources 241
O
OCM (open channel monitoring) 97

common parameters 98
cut throat 103, 104
flow characterization chart 116
flow exponent support 100
H flume 115
Leopold Lagco flume 102
Palmer Bowlus flume 114
Parshall flume 101
rectangular flume 105
universal calculation 116
universal Parshall flume 117
universal trapezoidal flume 117
V-Notch weir 106, 107, 109, 110, 111,

112

weirs 100
zero head 99

operation
single point 63

out of bounds 77
outputs 248
P
parameter

relays 67
parameters

record temperatures 202
power 21
programmer

handheld 35
programming 249

alarms 76
relays 64

pump
alternate duty backup 81, 85
discrete input 87
fault 87
interlock 87
off setpoint 81, 82, 83, 84, 86
on setpoints 81, 82, 83, 84, 86
other controls 82
pump down 80
pump up 85
reservoir 85
run-on 88
start delay 89
totalizing volume 88
wet well 80

pump control
algorithms 79, 80, 93
options 80

pump interlock 87
pump strategies 79
Q
quick start 63
R
randomize setpoints 90
range 247
relay

modifiers 67
parameters 67
programming 64
totalizer 94

resolution 247
Response Rate

explanation 260
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Index
response rate 63
run-on 88
S
samplers 93
SCADA 124
scum ring See wall cling 90
service ratio

overview 80
settings

adjust parameters via LUI 37
simulation 120

Discrete Input 120, 123
Level 120
level cycle 123
process 122
single measurement 122

single point 63
sound velocity 262
start delay 89
starting measurement 63
synchronization 27
T
tank shape 73
technical support

contact information 1, 4, 58, 269
temperature

alarm 78, 79
compensation 247
error 248

testing
application 123

time control 92
Time To Spill 170
totalizer 94
transducers 23, 249

connection 23
enable/disable 38, 203

transmit pulse 255
trends

viewing via LUI 118
troubleshooting

noise problems 240
TS-3 23
U
universal

example 74
volume 73

V
vessel shape

selection 147

volume
calculation 263
characterization chart 73
dimensions 63
readings 73
tank shape 73
universal example 74

W
wall cling 90
weight 250
weir

standard 100
V-Notch 106, 107, 109, 110, 111, 112

wet well 80
wiring

cables 20
hazardous areas 31
problems 241

wrong reading 244
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Sensors and Electrodes

Model S80 Intelligent Sensors

Measure pH, ORP, Specific Ion, Dissolved Oxygen,
Turbidity, Conduc6vity or Resis6vity with
Model T80 Universal Transmi+er

ELECTRO-CHEMICAL DEVICES
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Point Advantage

Intelligent sensor design with digital communica*on
Calibra6on data is stored in the sensor allowing field
installa6on of a pre-calibrated sensor. Detachable
cable op6on simplifies the installa6on of pre-calibrated
sensors.
Mul*ple individual measurement parameters in the
same mechanical configura6on- pH, ORP, Specific Ion,
Dissolved Oxygen, Conduc6vity & Resis6vity

Readily available applica*on specific electrode
cartridges. Many unique pH electrode design
formula6ons and materials of construc6on which are
field proven and selected for long life and accuracy.

Long life replaceable electrode cartridges lower the
over all opera6ng cost.

Submersible and Retractable Sensors Various process
fi8ngs with adjustable inser6on lengths - threaded
fi8ngs, sanitary fi8ngs, flanges and valve retractable
fi8ngs.

Industrial housing materials for compa*bility with
process fluid. Stainless Steel, Titanium, Hastelloy C-22,
Polypropylene or PVDF (Kynar TM). Standard 10” or 17”
lengths addi6onal lengths available.

Electro-Chemical Devices offers a complete line of liquid
analy6cal sensors: pH, ORP, Specific Ion, Dissolved
Oxygen, Conduc6vity & Resis6vity. The technical
advantage of the Model S80 Intelligent Sensors
are the 6 points of design flexibility to configure
a sensor that best fits your applica6on.
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Model S80 Intelligent Sensors

The S80 Sensor uses a
1” ball valve with a 1”

NPT process connec6on.
Loosening the rear
compression fi8ng

allows the sensor to slide
freely through the ball

valve for either inser6on
into the process or
retrac6on from the

process. Once retracted,
the ball valve can be

closed and the sensor
removed for

maintenance or
replacement without

shu8ng down the
process line.

S80 Sensor
Inser*on/Submersion

S80 Sensor
Valve Retractable

Pre-Calibrated
Detachable
Sensor Op*on
this detachable sensor has a
rugged IP68 rated industrial
connector. Just a simple
quarter turn locks the cable
connector in place. These
Pre-Calibrated sensors can be
easily installed in the field.

The S80 Sensor uses a ¾” MNPT
compression fi8ng as the process
connec6on. This allows a variable
inser6on length to accommodate
installa6on in pipe tees, flow cells, or
through tank walls. If the fi8ng is
reversed the sensor can be installed in
a stand pipe for submersion into a tank.

ECD Model S80 Sensor Overview - The intelligent sensor choice to
fit your applica6on. The S80 sensors have two Universal Sensor

Designs; Inser6on/Submersion or Valve Retractable with flaired
end to prevent blow out. The standard Model S80 sensors

have a rugged ¾” O.D. 316 stainless steel body with a 10 '.
cable or an op6onal waterproof detachable cable

assembly.
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2005145 – This General Purpose Electrode has a two 6ne Radel body,
double junc6on reference and slightly radiused pH bulb. While suitable for
higher temperatures it is op6mized for fast and stable readings in ambient
temperature applica6ons. Neutraliza6ons, waste effluent monitoring, rinse
applica6ons and potable water are just a few of the suggested applica6ons.

2005167 – This ORP (Oxida*on Reduc*on Poten*al) Electrode has a two
6ne PEEK body, double junc6on reference and a pla6num 6p. This general
purpose sensor can be used for monitoring the oxidant level of cooling
towers, swimming pools, aquariums or the de-chlorina6on of waste water.
Metal finishing and mining also provide applica6ons such as cyanide
destruc6on and monitoring chrome pla6ng baths.

2005066 – This Chemically Resistant Electrode has a two 6ne PEEK body,
double junc6on reference and slightly radiused pH bulb. The PEEK body is
suitable for use in most aggressive solvents, oxidizing solu6ons and acids
or bases. This electrode is op6mized for a harsh chemical environment and
is suitable for service up to 130°C. Chemical separa6ons and solvent
recovery in the CPI and pharmaceu6cal industries along with chlorine
produc6on and flota6on in mining are suggested applica6ons.

2005157 – This High Temperature Electrode has a two 6ne PEEK body,
triple junc6on reference and hemispherical pH bulb. This electrode is
designed for the process control or neutraliza6on of most mineral acids
and bases in applica6ons up to 130°C. The triple junc6on design is resistant
to sulfide ion poisoning making it ideal for use in petroleum refineries and
metal processing plants.

pH and ORP Electrodes

The Model S80 Intelligent Sensors use replaceable electrode cartridges to provide applica6on specific
solu6ons for the most demanding pH measurements.

• Radel (PES) or PEEK construc6on
• Single 6ne, double 6ne or full crown style pH bulb protec6on.
• Spherical bulbs (best response), hemispherical bulbs (more durable) or a slightly radiused flat
sssurface (easily cleaned)
• Pla6num 6p ORP electrodes.
• Double or Triple junc6on reference cells
• Porous Teflon® and ceramic junc6ons with various reference electrolytes.

One of these three widely used pH electrode cartridges will sa6sfy most installa6ons, Consult
our technical support staff for addi6onal configura6ons.

Point Advantage
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Specific Ion (pIon) Electrodes

The ECD Dissolved Oxygen electrodes are galvanic cells with a lead anode, silver cathode
and either the quick response 2 mil or rugged 5 mil Teflon membrane. The electrode is
ready to use as received, there are no solu6ons or membranes to install before the
electrode can be used. The membrane is protected by a double 6ne PEEK body allowing
for easy cleaning. Designed for ppm level measurements it is ideal for environmental
water measurements and aerobic waste treatment.

Dissolved Oxygen Electrodes

Part# Type Measurement Range pH Range Temperature Range

2005083 Ammonium 0.05 - 18,000 ppm 2-10 pH 0°-40°C

2005062 Bromide 1 - 80,000 ppm 2 - 12pH 0°-50°C

2005140 Cadmium 0.1 - 11,200 ppm 3 - 9 pH 0°-80°C

2005143 Calcium 0.1 - 40,000 ppm 2.5 - 10 pH 0°-40°C

2005008 Chloride 2 - 35,000 ppm 2 - 12 pH 0°-50°C

2005142 Cyanide 0.1 - 260 ppm 11 - 13 pH 0°-80°C

2005058 Cupric 1.0 ppb -6,300 ppm 2 - 6 pH 0°-80°C

2005163 Fluoride 0.02 - 2,000 ppm 5 - 8 pH 0°-80°C

2005141 Lead 2.0 - 20,700 ppm 4 - 8 pH 0°-80°C

2005086 Nitrate 0.1 - 1000 ppm 2 - 12 pH 0°-40°C

2005161 Nitrite 0.5 - 500 ppm 4.5 - 8 pH 0°-40°C

2005034 Potassium 0.1 - 40,000 ppm 2 - 12 pH 0°-40°C

2005031 Sodium 0.2 - 23,000 ppm 2 - 14 pH 0°-80°C

2005122 Sulfide 0.01 - 32,000 ppm 11 - 14 pH 0°-80°C

2005016 Silver 0.1 - 107,000 ppm 2 - 14 pH 0°-80°C

Part# Type Range Pressure Range Temperature Range

2005622
(2 mil)

Dissolved or
Gaseous Oxygen

0 - 20 ppm (mg/L)
250% Satura6on

0 - 50 psig -5°- 80°C

2005623
(5 mil)

Dissolved or
Gaseous Oxygen

0 - 20 ppm (mg/L)
250% Satura6on

0 - 50 psig -5°- 80°C

Specific Ion & Dissolved Oxygen Electrodes

Ion selec*ve electrodes are not limited to laboratory use; some are suitable for con6nuous online measurement.
ECD offers Specific Ion Electrode cartridges to measure the various ions listed below. Specific Ion electrodes

measure the ac6vity (concentra6on) of the ion in solu6on, the “free” ion, not a complexed version. Cyanide,
Fluoride and Sulfide ions only exist in a specific pH range as free ions and outside this pH range some

percentage of the total concentra6on is complexed as H(X) which is not seen by the sensor. These
measurements can be pH compensated using the dual channel transmi7er or controller with a pH

sensor to determine the total ion concentra6on. Most pIon sensors are subject to interfering ion
errors. A posi6ve interference caused by similar ions in the solu6on. Consult with the factory on

all new installa6ons to determine the suitability of the measurement.
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The CSX2 High Temperature- High Pressure sensor is designed for
service to 200°C and 250 psig, 400 psig at 100°C. This inser6on style
¾” MNPT, 316 stainless steel sensor has PEEK insulators and is
available with or without an integral signal condi6oner. An aluminum
junc6on box is mounted on the rear of the sensor that contains a
terminal block and op6onal signal condi6oner. The junc6on box is
rated Class I, Div I, Groups C & D, Class II, Groups E, F and G hazardous
loca6ons. It is an ideal choice for boiler control applica6ons,
blowdown control, condensate monitoring, leak detec6on on heat
exchangers, and steam purity measurements.

Conduc*vity and Resis*vity Sensors
The Model S80 Conduc*vity sensor is available for measurements
from 0.05µS to 50mS. The Model S80 Resis*vity sensor measures
from 0 - 20 MΩ. The design of the inner electrode defines the
measurement range of the sensor. The Open Style with its large
surface area inner electrode and short path length is best for
resis6vity and low conduc6vity measurements while the Closed Style
is best suited to high conduc6vity measurements. The standard
we7ed materials are 316 Stainless Steel, PEEK insulators and VITON
o-rings.

Induc*ve Conduc*vity Sensors - (non-contac*ng)
The Model S80 Induc*ve sensors have a ¾” diameter PVDF body.
These sensors are ideal for measuring high conduc6vity solu6ons and
% concentra6on measurements. Since the toroidal electrodes are
inside the PVDF body, the induc6ve sensors are ideal for any
applica6on that coats or corrodes the electrode of the standard
contac6ng conduc6vity sensors. The measurement range of the
induc6ve sensor is from 50 μS to 1000 mS.

High Temperature/Pressure Sensors

Open Style Closed Style

S80 Valve Retractable

S80 Inser6on/Submersion

Point Advantage

Conduc6vity Measurements

Two technologies are used to measure Conduc6vity. Contac*ng Conduc*vity is an impedance
measurement made between two metal contacts in the solu6on. Induc*ve Conduc*vity is a non-
contac6ng measurement made between two toroidal coils inside the sensor that are induc6vely
coupled through the solu6on’s conduc6vity. Induc6ve sensors excel in the higher conduc6vity
ranges and where coa6ng is a problem. The chemically resistant PVDF (KYNAR) body is excellent
for corrosive environments. Contac6ng sensors can measure from very low conduc6vi6es,
(resis6vity measurements) to very high conduc6vi6es but they are subject to coa6ng and
corrosion issues, condi6ons where the induc6ve sensors excel. The Contac6ng Conduc6vity
S80 sensors come in two ranges, Conduc6vity Range, 0.5µS – 50mS and Resis6vity Range,
0 – 20MΩ. Induc6ve Sensors measure from 50 µS to 1000 mS.
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Fi8ngs and Accessories

The proper installation and calibration of an analytical loop is critical for a successful measurement. Using the
flow of the sample in an insertion application to maximize the cleaning potential can be as simple as changing
the size of the Pipe Tee, changing the insertion depth or using an ECD Flow Cell with a spray cleaning port in
the most difficult applications. Spray Cleaning heads are also available for immersion applications where the
sample velocity is much lower and fouling is more common. Valve retractable units allow the sensor to be
removed, serviced and installed without shutting down the sample flow in a pipe or emptying a tank. A
compression gland fitting seals the sensor into a ball valve, loosening the gland fitting allows the sensor to
be retracted through the ball valve which is then closed, isolating the process solution, before removing the
sensor for service. Materials of construction for the Valves, Glands, Flanges and Immersion Assemblies vary
from PVC, PVDF and polypropylene plastics to 316 SS, Titanium and Hastelloy C-22. Contact our application
specialists for the most cost effective solution to your application.

Calibra*on Solu*ons
All of the S80 sensors require periodic calibra6on and ECD offers a full range of
calibra6on solu6ons. For pH applica6ons we offer pH 4.00, 7.00 and 10.00
buffers. ORP calibra6ons can be accomplished with a +465 mV ferric-ferrous
solu6on or by adding quinhydrone to pH 4 and pH 7 buffer solu6ons crea6ng
+267 mV ORP and +90 mV ORP respec6vely. Specific ion calibra6on solu6ons
are standardly 10 ppm and 100 ppm although any value can be formulated at no
extra cost. Conduc6vity solu6ons are made with KCl and Deionized water, values
from 10 μS to 500 mS are available. Solu6ons to simulate % acid or % caus6c are
labelled as the actual solu6on, i.e. 4% NaOH, even though the solu6on is made
from KCl with an equivalent conduc6vity providing a safe and accurate
calibra6on system.

Fi,ngs and Flow cells
The Model S80 sensors are offered with a wide array of fi8ngs, flow cells,
immersion assemblies and valve retrac6on assemblies. ¾” MNPT compression
fi8ngs are available for S80 inser6on into pipe Tees or flow cells and when
reversed, for coupling with Stand Pipes for immersion applica6ons. Flow cells of
PVC, PVDF or 316 SS have ⅜” or ½” FNPT ports on a 2” O.D.by 5” body. 316 SS
Sanitary 3A Flanges and 150# Flanges can be adapted for inser6on or valve
retractable service.Contact our Technical support staff for other configura6ons.

Model T80 Universal Transmi+ers
The ECD Model T80 transmi7er is a single or dual channel transmi7er for the
measurement of pH, ORP, pION, Conduc6vity, Resis6vity, Dissolved Oxygen and
Turbidity. The Model T80 transmi7er digitally communicates with any ECD
intelligent S80 digital sensor, automa6cally configuring the transmi7er’s menus
and display screens to the measured parameter. The ECD S80 digital sensors
facilitate two way communica6on with the Model T80 transmi7ers. The type of
sensor, iden6ty and serial number are stored in the sensor’s memory along with
calibra6on registers. Ordering pH, ORP or pION sensors with the SENTINEL op6on
automa6cally ac6vates the “Remaining Life” diagnos6c shown in the picture.
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Specifica�ons subject to change without no�ce.

Represented by:

S80 A1818

S80
All Sensors

Dimensions:
S80 Inser*on - ¾”OD x 10” Length
S80 Valve Retractable - ¾” OD x 17”
Cable Length:
10 '. standard, op6onal lengths in 10 '
increments, op6onal Detachable cable
connec6on
Housing Materials:
Standard: 316 Stainless Steel
Op6onal: Titanium (T), grade 2

Hastelloy C-22 (H),
PVDF (K)
Polypropylene (P)

O-Ring Materials:
Standard: Viton® (VIT)
Op6onal: Ethylene Propylene (EPR),

VITON® 75 (VIT75)
Kalrez® (KLZ)
CV75 (CV)

Process Connec*ons:
S80 Inser*on/Immersion
-75 ¾” 316 SS gland fi8ng

with nylon ferrule
-75HT ¾” 316 SS gland fi8ng

with Teflon® ferrule
-75SF ¾” 316 SS gland fi8ng

with stainless steel ferrule
-75TFE ¾” Teflon® gland fi8ng

with Teflon™ ferrule
-100P 1” Polypropylene gland fi8ng for

Polypropylene housing only
S80 Valve Retractable
-VSS 1” 316 SS valve retrac6on

assembly
-VSSE 1” 316 SS valve retrac6on

assembly for Induc6ve sensors
-VKY 1” PVDF valve retrac6on

assembly
-VPP 1” Polypropylene Valve Retrac6on

assembly

PHS80
pH measurement

Measurement Range:
0-14 pH
Temperature Range:
0?- 100? C
Op*onal HT version:
0?- 150?C
Pressure Range:
0 - 100 psig @ 90?C
Temperature Compensa*on:
Automa6c 0?- 100?C
Accuracy ± 0.2?C

MVS80
ORP & Specific Ion

Measurement Range:
ORP: -2000 mV to 2000 mV
pIon: Sensor Specific, ppb, ppm&ppt
Temperature Range:
ORP -0?- 90? C, pIon Sensor Specific
Pressure Range:
0 - 100 psig @ 90?C
Temperature Compensa*on:
Automa6c 0?- 100?C
Accuracy ± 0.2?C

DOS80
Dissolved Oxygen

Measurement Range:
0-20 ppm, 0-250% SAT
Temperature Range:
0?- 90? C
Pressure Range:
0 - 50 psig @ 80?C
Temperature Compensa*on:
Automa6c 0?- 100?C
Accuracy ± 0.2?C

CS98/RS80
Conduc6vity/Resis6vity

Measurement Ranges:
Conduc6vity: 0.5μS to 50 mS
Resis6vity: 0 - 20 MΩ

Temperature Range:
-5? to 100?C
Op*onal HT version:
-5? to 150?C
Pressure Range:
CS/RS80 0 - 100 psig
Temperature Compensa*on:
Automa6c 0?- 100?C
Accuracy ± 0.2?C,100K thermistor

CS80
Induc6ve Conduc6vity

Measurement Ranges:
50 μS to 1000 mS
Temperature Range:
-5? to 100?C
Pressure Range:
0 - 100 psig
Temperature Compensa*on:
Automa6c 0?- 100?C
Accuracy ± 0.2?C, 100K thermistor
Body material:
KYNAR (PVDF)

CSX2 Series
High Temperature Conduc6vity

Measurement Ranges:
1.0μS to 50mS
Temperature Range:
⁰? to 200?C
Pressure Range:
0 -250 psig ( 400psig @100°C)
Temperature Compensa*on:
Automa6c 0?- 200?C
Accuracy ± 0.2?C, 10K ohm pla6num RTD
We+ed Materials:
316 SS and PEEK
Shipping Weight:
S80 (10”) 2.5 lbs (1.2 kg)
S80 (17”) 2.75 lbs (1.25 kg)
S80-VSS 5.8 lbs (2.65 kg)

Product Specifica6ons

Electro-Chemical Devices
1500 North Kellogg Dr.
Anaheim, California, USA 92807
Phone: +1-714-695-0051

+1-800-729-1333
Fax: +1-714-695-0057
email: sales@ecdi.com
web: www.ecdi.com
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SCREEN MAP 

CAL  

(Calibration) 

Auto 
Cal 1 (Offset) using Calibration Solution 

Cal 2 (Slope) using Calibration Solution 

Standardize Enter Grab Sample Determined Value 

Manual 
Enter Offset, the PV value and associated mV 

Enter Slope, mV/pH, mV/decade, mV/ppm… 

Temp Enter measured Temperature 

CONFIG 

(Configuration) 

XMTR 

LCD 

Set Up 

Temp. Format °C or °F 

Contrast Adj. 0-100% 

Back Light Enter ON time 

Range Lock Choose: Auto, ppb, ppm, ppT 

Legend 
Icon buttons 

Text buttons 

Graph 

Line Screen Duration 

Gauge 

Bar 

Label 

TAG ID Enter Name 

TAG  ON/OFF 

POP UP  ON/OFF 

SENSOR Enter Name 

Output  

4-20 mA  

(1 or 2) 

Range (PV or 

Temp.) 

4 mA = 

20 mA = 

Cal (more) 
Trim 4.00 mA 

Trim 20.00 mA 

Fault (more) 

3.5 mA 

22 mA 

NONE 

RELAY 

Relay 1 

Alarm Set Point 

Timed Period, Duration 

Fault 

Relay 2 

Alarm Set Point 

Timed Period, Duration 

Fault 

Relay 3 

Alarm Set Point 

Timed Period, Duration 

Fault 

HOLD Time out: None, 15 min, 30 min… 

Serial 

Address 

Baud rate 

Format 

Password 

Menu Off/On  “ _ _ _ _ “ 

CAL Off/On  “ _ _ _ _ “ 

CNFG Off/On  “ _ _ _ _ “ 

SIM Off/On  “ _ _ _ _ “ 

Sensor  

Sensor 1 or 2 

Type  Choose Type: pH, Cond, ORP….. 

T COMP Enter % Comp 

ISO PT Enter mV value 

Qty of Sensors Choose 1 sensor or 2 sensors 

COMP Dissociation, Interference, Percentage, OFF 

Load Default Sensor/Transmitter Yes/No 

DAMP Enter Signal Dampening (# of readings to average, 0-100) 

INFO 

(Information) 

XMTR Configuration, Serial #, Name, Outputs 

Sensor Calibration logs, Serial #, Name 

SIM  

(Simulate) 

System Sensor 1 or 2 
Fixed value 

Ramp 

Relays 

#1 ON/OFF 

#2 ON/OFF 

#3 ON/OFF 

4-20 mA 
4-20 mA Ch 1 Enter Value 

4-20 mA Ch 2 Enter Value 

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2H



Model T80   Page 4 

 

PREFACE 

Purchasing products from Electro-Chemical Devices, Inc. provides you with the finest liquid analytical 

instrumentation available. If this is your first purchase from ECD, please read the entire manual before installing 

and commissioning your new equipment. 

Manuals are accessible on the ECD website at http://www.ecdi.com/literature/manuals.html . 

If there are any questions concerning this equipment, please contact your local ECD representative, or the 

factory directly at: 

Electro-Chemical Devices, Inc. 

1681 Kettering 

Irvine, CA 92614 USA 

Telephone: +1-949-336-6060 

FAX: +1-949-336-6064 

Website: www.ecdi.com 

Email: sales@ecdi.com 
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SYMBOLS USED IN MANUAL 

 

This symbol is used to designate important information, warnings and cautions. Failure to follow 

this information could lead to harm to the instrument or user. 

 

No operator serviceable parts, service by authorized service personnel only. 

 

This symbol is used to designate a WARNING “Risk of Electrical Shock”  

 

Disconnect supply before servicing  

 

Equipment protected throughout by double insulation. 

 

 

 

 

Contents of this manual are believed to be correct at the time of printing and are subject to change without 

notice. ECD is not responsible for damage to the instrument, poor performance of the instrument or losses 

resulting from such, if the problems are caused by: 

• Incorrect operation by the user. 

• Use of the instrument in incorrect applications. 

• Use of the instrument in an inappropriate environment or incorrect utility program (power supply). 

• Repair or modification of the related instrument by anyone not authorized by ECD. 

• There are no operator accessible parts. Service and maintenance to be done by authorized personnel only. 

• If the equipment is used in a manner not specified by the manufacturer, the protection provided by the 

equipment may be impaired. 

 

© 2014 Electro-Chemical Devices, Inc. All rights reserved. No part of this manual may be used or reproduced in 

any form or by any means, or stored in a database or retrieval system without prior written permission from 

Electro-Chemical Devices, Inc. Making copies of any part of this manual for any purpose other than personal use 

is a violation of United States copyright laws. Document printed in the United States of America. 

  

 

Read the complete manual before installing or using the equipment. 
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TERMS AND CONDITIONS OF SALE 
 

1. ACCEPTANCE.  If this writing differs in any way from the terms and conditions of Buyer's order or if this writing is construed as an acceptance or as a confirmation acting as an 

acceptance, then Seller’s acceptance is EXPRESSLY MADE CONDITIONAL ON BUYER’S ASSENT TO ANY TERMS AND CONDITIONS CONTAINED HEREIN THAT ARE DIFFERENT 

FROM OR ADDITIONAL TO THOSE CONTAINED IN BUYER'S WRITING.  Further, this writing shall be deemed notice of objection to such terms and conditions of Buyer.  If this 

writing is construed as the offer, acceptance hereof is EXPRESSLY LIMITED TO THE TERMS AND CONDITIONS CONTAINED HEREIN.  In any event, Buyer's acceptance of the 

goods shall manifest Buyer's assent to Seller's terms and conditions.  No addition to or modification of these terms will be effective, unless set forth in writing and agreed to by 

Seller.  
 

2. WARRANTIES AND REMEDIES  

a. Warranty.  Seller warrants to Buyer that it holds and will pass marketable title to the goods sold hereunder.  Seller warrants to Buyer that the items and components 

manufactured by Seller will be free from defects in material and workmanship (subject, however, to tolerances and variances permitted by the trade hereunder) for a 

period one (1) year for non-consumable products. Consumable electrodes and sensors have a conditional warranty based shelf life and process conditions and is 

determined by Seller. 

b.  Exclusion and Conditions.  Seller’s obligations with respect to the express warranties and remedies contained herein are conditioned on the following: (i) Buyer's return 

of the non-conforming goods, if authorized by Seller: (ii) Buyer shall not assign its rights under these express warranties and any attempted assignment shall render 

such warranties, but not any disclaimers or limitations, void and the goods sold shall be sold AS IS; and (iii) all products shall be carefully inspected for damage by Buyer 

upon receipt, be properly calibrated for Buyer's particular use, and be used, repaired, and maintained by Buyer in accordance with the instructions set forth in Seller’s 

product literature.  Repair and maintenance by non-qualified personnel, product subjected to misuse or negligence,  and/or damaged during shipment will invalidate 

the warranty, as will the use of non-approved consumables or spare parts.  As with any other sophisticated product, it is essential, and a condition of Seller’s warranty, 

that all personnel using the product be fully acquainted with its use, capabilities and limitations as set forth in the applicable product literature.  

3. DISCLAIMER OF IMPLIED WARRANTIES.  Seller gives no warranties except those expressly contained herein.  Seller disclaims all other warranties implied by law usage of the 

trade, course of dealing or course of performance including, but not limited to, the Implied warranties of MERCHANTABILITY and fitness for a particular purpose. 
 

4. LIMITATIONS OF LIABILITY.  The following limitations of Seller's liability are acknowledged by the parties to be fair and reasonable and shall apply to any act or omission 

hereunder, and to any breach of this contract of which these terms and conditions form a part:  

a. Disclaimer of Damage.  In no event shall Seller be liable for special, indirect, consequential or incidental damages whether arising under contract, warranty, 

tort, strict liability or any other theory of liability.  Such damages include but are not limited to loss of profits, loss of use of goods, damage to property, and 

claims of third parties. 

b. Suitability.  Buyer acknowledges that it alone has determined the intended purpose and suitability of the goods sold hereunder.  It is expressly agreed by the 

parties that any technical or other advice given by the Seller with respect to the use of the goods or services is given without charge and at Buyer's risk; 

therefore Seller assumes no obligation or liability for the advice given or results obtained. 

c. Notice and Time of Claims. 

i. Buyer agrees to check and inspect all products against shipping papers and for damage or shortage upon receipt of goods at destination. 

ii. Every claim for shortage, damage in transit, or other cause visible upon inspection shall be deemed waived by the Buyer, or the Buyer’s customer in 

the case of resale, unless delivered in writing to Seller by Buyer thirty (30) days from the tender of delivery of the goods to Buyer, provided, however, 

that claims for shortage must be made within seven (7) days of receipt. 

iii. The parties expressly waive the statute of limitations and agree that any legal proceeding for any breach of this contract shall be waived unless filed 

within one (1) year after the accrual of the cause of action thereof. 

 

5. FORCE MAJEURE.  Seller shall not be liable for any delay in delivery, or failure to deliver, due to any cause beyond the Seller’s control including but not limited to fires, floods, or 

other forces of the elements; strikes, or other labor disputes; accidents to machinery; acts of sabotage; riots; precedence or priorities granted at the request or for the benefit, 

directly or indirectly of the federal or any state government or any subdivision or agency thereof; delay in transportation or lack of transportation facilities; restrictions imposed 

by federal, state or other governmental legislation or rules or regulations thereof.  If Seller, in its sole discretion, determines that Seller’s performance hereunder would result in 

a loss to Seller’s on this sale as computed under Seller’s normal accounting procedures because of causes beyond Seller's control, then the Seller may terminate this agreement 

in whole or in part without liability for any delay in the delivery of, or failure to deliver, the goods sold hereunder 
 

6. TAXES AND OTHER CHARGES.  The Buyer will pay, or reimburse Seller if it pays, any and all taxes or tariffs or any other similar charges imposed upon this contract, the goods 

covered hereby or the delivery or use or resale thereof. 
 

7. FREIGHT CHARGES.  If the sale hereunder is other than F.O.B. Seller's facility, this acknowledgement is based upon the freight charges now in effect.  In the event of an increase 

or decrease in applicable freight charges before the goods are shipped, such charge in freight will be for the Buyer's account. 
 

8. PRICES AND DELIVERY.  Prices quoted herein are F.O.B. shipping point.  Deliveries specified are only our best estimate and are subject to change.  This quotation is based upon 

freight charges now in effect.  Buyer will be invoiced at the freight charge prevailing at the date of shipment.  Prices are firm for orders meeting Seller's normal shipping 

schedules.  If shipments are held or postponed for any reason other than Seller's fault, and a price increase becomes effective during the period of such hold or postponement, 

the increase will apply to all shipments that are held or postponed thirty (30) days or more from the effective date of the increase. 
 

9. PAYMENTS. If in the judgment of Seller the financial condition of Buyer at any time prior to shipment does not justify the terms of payment specified, Seller may cancel the 

order, withhold shipment, and/or require full or partial payment in advance.  If payment is not made when due, Seller may suspend all future delivery or other performance with 

respect to Buyer without liability or penalty and, in addition to all other sums payable hereunder, Buyer shall pay to Seller (i) the reasonable costs and expenses incurred by 

Seller in connection with all actions taken to enforce collection or to preserve and protect Seller’s rights hereunder, whether by legal proceedings or otherwise, including 

without limitation reasonable attorneys’ fees, court costs and other expenses and (ii) interest on all amounts unpaid after 30 days charged at the monthly rate of 1-1/2% or the 

highest rate permitted by law, whichever is lower. 
 

10. CANCELLATION OR ALTERATION.  Buyer may not alter or cancel any order without Seller’s written consent.  For any order altered or cancelled with Seller's consent, Buyer must 

pay for all expenses and labor incurred up to the time of Seller’s consent, plus a reasonable percentage for profit.  Any order delayed or deferred by Buyer will be subject to price 

escalation for increased costs of production, and any other expenses caused by the delay.  Material on such orders will be stored at Buyer's risk.  Seller reserves the right to 

invoice Buyer and require payment before shipment of any delayed or deferred order.  
 

11. TITLE AND RISK OF LOSS.  Title and risk of loss shall pass to buyer at Irvine, California, unless otherwise specified in the contract.  If delivery is made by common carrier, risk of 

loss shall pass upon delivery to the carrier.  Claims for loss or damage in transit must be made by Buyer to the carrier.  Seller accepts no responsibility for loss or damage to 

product in transit. 
 

12. PATENT OR TRADEMARK INFRINGEMENT.  If the goods sold hereunder are to be prepared for manufacture according to Buyers specification, Buyer shall indemnify Seller 

against any claim or liability for patent, trademark, service mark or trade name infringement on account of preparation, manufacture and/or sale. 
 

13. NON-WAIVER.  If Government Contract Regulations require the addition, deletion, or modification of these terms and conditions upon prior notification to Seller and Seller's 

written acceptance thereof, such changes shall become a part of these terms and conditions. Seller shall not be bound by any Government Contract Regulations applicable to 

Buyer’s contracts with the U.S. Government unless Buyer has expressly acknowledged, on the face of this document, the applicability of such Regulations to the transaction 

between Buyer and Seller contemplated herein.  Absent such acknowledgement, Seller is making the assumption in issuing this document that no such Regulations apply.  
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14. JURISDICTION.  All such disputes shall be resolved in a court of competent jurisdiction in Orange County, California.  Buyer hereby consents to the jurisdiction of the State and 

Federal Courts sitting in Orange County.  Not withstanding the above, should either party contest the jurisdiction of such courts, the other party may institute its suit in any court 

of competent jurisdiction.  
 

15. APPLICABLE LAW.  All questions arising hereunder or in connection with the quotations or any order submitted in connection therewith and/or the performance of the parties 

hereunder shall be interpreted and resolved in accordance with the laws of the state of California without regard to its conflict of law provisions and excluding the United 

Nations Convention on the International Sale of Goods. 

RETURN GOODS POLICY 
All requests for returned goods must be initiated through our Customer Service Department.  Please call our 

phone number (949) 336-6060 with the specifics of your request. The following conditions must be satisfied for 

consideration of applicable credit for the return of products purchased from Electro-Chemical Devices: 

1) The item is unused and in the original package. 

2) The item was shipped directly from Electro-Chemical Devices. 

3) The item has not been damaged in shipment to Electro-Chemical Devices. 

4) Items containing date-sensitive parts such as electrodes, must be returned within 1 month of the 

invoiced date.  

5) Items without date-sensitive parts must be returned within 3 months of the invoiced date. 

A Return Merchandize Authorization Number must be obtained from Customer Service and be provided on all 

paperwork and packaging.  To obtain a Return Merchandize Authorization Number, please provide the reason 

for return, the date of purchase, your original purchase order number, and either our order number or our 

invoice number.  The issuance of a Return Merchandize Authorization Number is a verbal approval for return 

only and does not guarantee credit or allowance.  Returned goods must be received within 30 days of the 

issuance date of the Return Merchandize Authorization Number or it will become null and void.  

Necessary physical and mechanical inspection is completed upon receipt of the item.  Applicable credit or 

equivalent allowance is determined after inspection of the returned item. If all of the above conditions are met, 

and the item has been approved to return to our stock, a restocking charge of 25% of the purchase price is 

deducted from the applicable credit.  

 

 

  

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2H



Page 13  Model T80 

 

UNPACKING THE INSTRUMENT 
Your Electro-Chemical Devices instrument has been carefully packaged to protect it from damage during 

shipment and dry storage. Upon receipt please follow the procedure outlined below. 

1. Before unpacking, inspect the condition of the shipping container to verify proper handling by the 

carrier. If damage is noted, save the shipping container as proof of mishandling for the carrier. 

2. Check the contents of the shipping container with the items and quantities shown on the packing list. 

Immediately report any discrepancies to ECD. 

3. Save the original packing material until you are satisfied with the contents. In the event the product(s) 

must be returned to ECD, the packing material will allow you to properly ship it to ECD. 

4. Familiarize yourself with the instrument before installation, and follow proper installation and wiring 

procedures. 

5.  

Installation and wiring 

Failure to follow the proper instructions may cause damage to this instrument and warranty invalidation. 

Use only qualified personnel to install, operate and maintain the product. 

The Model T80 transmitter should only be used with equipment that meets the relevant IEC, American or 

Canadian standards. ECD accepts no responsibility for the misuse of this unit. 

Basic Parts List 

1. Model T80 Transmitter 

2. Mounting Hardware 

3. Instruction Manual 

INSTRUCTION MANUAL REVISION 
Revision Date  Remarks  

A  07/12  Initial release  

B  03/13  Added Sensors and Conductivity Data 

C  03/13  Updated Symbols 

D  07/13  MODBUS Update 

E  07/13  Turbidity, Conductivity, Cal Menu 

F  05/14  Two Channels, MODBUS Update,   

 

WARNING Electrical installation must be in accordance with the National Electrical Code 

(ANSI/NFPA-70), Canadian Electrical Code and/or any other applicable national or local 

codes. 
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1.0 GENERAL DESCRIPTION 
The ECD Model T80 transmitter is a single or dual channel, intelligent, multi-

parameter transmitter designed for the online continuous measurement of pH, ORP, 

pION, dissolved oxygen, conductivity, resistivity and turbidity in a general purpose 

industrial environment. The Model T80 transmitter digitally communicates with any 

ECD S80 digital sensor, automatically configuring the transmitter’s menus and 

display screens to the measured parameter.  

The Model T80 transmitter can be loop powered, 24 VDC powered or 100-240 VAC line powered. The standard 

configuration has a 4-20 mA output and a RS485 serial communication port with MODBUS®RTU output. A HART® 

communication version (single channel version only) is also available. Alarm relays are optionally available on 

either line powered transmitter. 

1.1 FEATURES 

• Multi-Parameter, pH, ORP, Specific Ion, Dissolved Oxygen, Conductivity, Resistivity 

• Simple, user friendly menu structure 

• Noise free digital communication with sensors 

• Reads and writes calibration data to sensor 

• Dual Channel option has interactive channels, pH compensated readings, interfering ion corrections… 

• Isolated 4-20 mA output and MODBUS® RTU standard, optional HART® 

1.2 SPECIFICATIONS 

1.2.1 INPUT SPECIFICATION 

Digital protocol, all ECD S80 sensors 

Optional analog to digital converter, 5 inputs [mV+, mV-, solution ground, temp + temp - (100 K-ohm)] 

1.2.2 INPUT RANGES 

pH   -1.00 - 15.00 pH 

ORP   -1500 - +1500 mV 

pION   000.1 - 999.9, Auto Ranging: ppb ↔ ppm ↔ ppT (thousand) 

Dissolved Oxygen 000.1 - 999.9, Auto Ranging: ppb ↔ 20.00 ppm, % SAT, mg/L 

Conductivity  0.000 - 2.000, Auto Ranging: µS ↔ mS ↔ S 

   TDS 0.00 - 9999 ppm 

Resistivity  0.000 - 20.00 MΩ 

Turbidity  0 - 4000 NTU/FNU, 0 – 9999 ppm, mg/l, 0 - 100% % solids 

Temperature  100 K-ohm TC, -30°C - 140°C 

1.2.3 ACCURACY 

pH   0.02 pH 

ORP   ± 1 mV 

pION   Specific to electrode type 

Dissolved Oxygen 2% of range 

Conductivity  2% of range 
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Resistivity  2% of range 

Turbidity  2% of reading 

Temperature  ± 0.3°C 

1.2.4 OUTPUT SIGNALS 

4-20 mA output (standard, one per Channel), Fault Condition: 3.5 mA, 22 mA or none 

Modbus RTU (standard) 

HART® (optional) 

1.2.5 CONTACT RELAYS 

(Optional) Three (3) SPDT, 1 form C, 250 VAC, 10 Amp resistive maximum, relays, user configurable as Hi/Lo 

alarms with expiration timer, Periodic Timers or Fault alarms 

1.2.6 DISPLAY 

128 x 64 pixels (2.75” x 1.5”) LCD, Black on Grey background on loop powered instruments, Blue on White 

background with LED backlight on 100-250 VAC and 24 VDC powered instruments, English or icon based 

menus, numeric and graphical displays 

1.2.7 ENCLOSURE 

Beige Polycarbonate, IP65, weatherproof, ½ DIN, (L x W x D) 5.7” X 5.7” X 3.5” (14.4cm X 14.4cm X 9.0cm) 

1.2.8 POWER 

Code -0 Loop powered, 24 VDC 600 Ω maximum load (18-36VDC @ 35 mW minimum) 

Code -1 24 VDC (18-36 VDC @ 250 mW minimum) 

Code -2 100-240 VAC, 50/60 Hz, 4W, protected with 250V, 1A, Slow Blow fuse 

1.2.9 ENVIRONMENTAL CONDITIONS 

Outdoor use (IP65) 

Ambient Temperature  -20°C - 70°C (24 VDC Models) 

     -20°C - 60°C (100-240 VAC Models) 

Storage Temperature   -30°C - 85°C 

Relative Humidity   0 – 80%, up to 31°C 

     Decreasing linearly to 50% RH a 40°C  

Altitude    Up to 2000 m (6500 ft) 

Mains Supply Voltage   Fluctuations up to ±10% of the nominal voltage 

     Transient over voltages: CAT II 

     Pollution Degree: 2 

1.2.10 SHIPPING 

Size  8” x 8” x 5” (20.5 cm x 20.5 cm x 12.7 cm) 

Weight 1.6 lbs. (0.75 kg) 
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1.3 MODEL CODES 

Model T80- 

1
st

 Channel 
1     (S80) S80 Digital Sensor, pH, ORP, pION, DO, DO90 ppb DO, Conductivity, Resistivity 

2    Triton® DO80 Optical DO  

3     Internal Preamp,  Digital to S10/S17 pH, ORP, pION (+mV, -mV, 100K TC, SG) 

4     Internal Preamp, Digital to SGTC  Conductivity/Resistivity (CSX2 or 2 electrode contacting ) 

5     Internal Preamp, Digital to SGTC  Dissolved Oxygen, (Steam Sterilizable Products) 

6     Triton® TR6 Turbidity 

2
nd

 Channel 
 0   No Second Channel 

 1   (S80) S80 Digital Sensor, pH, ORP, pION, DO, Conductivity, Resistivity 

 2   (ODO) Triton® DO80 Optical DO 

Power Supply 
-0     Loop Powered Transmitter 

-1     24 VDC Powered Transmitter 

-2     100-240 VAC powered Transmitter 

Relay Option 
0     No Relays 

1     (3) form 1C 250 V 3A relays 

Outputs 
0    4-20 mA output and MODBUS 

RTU 1     HART® 

2     2 x 4-20 mA & MODBUS 

Mounting 

Hardware 

00     No Mounting 

Hardware 01     Universal 

Mount 02     Panel Mount 

03     Handrail Mount 

04     Sunshield 

pVertical Rail Mount 05     Sunshield 

Horizontal Rail Model T80- 1 1 -2 1 2 01 

 

Example above shows part# T80-11-212-01, a two channel T80 transmitter for use with two S80 sensors, 

110/220 VAC powered with two 4-20 mA outputs and MODBUS RTU and a universal mounting bracket. 
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2.0 INSTALLATION 

2.1 MOUNTING 

Mount the T80 in a location where there is easy access to the analyzer and sensors.  Install the system in an area 

where vibrations, electromagnetic and radio frequency interference are minimized or absent. Do not mount in 

direct sunlight or areas of extreme heat (temperature > 120°F). The IP65 T80 is suitable for outdoor use but it is 

best to mount it with a protective cover or sunshield to prevent discoloring over the years. 

 

Universal Mounting Brackets 

 

Rail Mounting 
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Panel Mounting 

 

Cut Out: 5.35” x 5.35” (13.6 cm x 13.6cm) 

2.2 WIRING 

Electrical wiring should only be conducted by qualified personnel. See the T80 wiring diagram in Figure 2.2.X 

 

Figure 2.2.1 Loop Powered Transmitter 
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Figure 2.2.2 4-Wire Transmitter, 24VDC or /110/22 VAC, MODBUS, Relays/Optional Digital Preamp 

 

Warning: RISK OF ELECTRICAL SHOCK 

 

Disconnect Power before opening instrument. 

 

2.2.1 WIRING, POWER 

ECD recommends using a thermoplastic, outdoor sunlight resistant jacketed cable, wet location rated and ½” 

flexible conduit. The power should be hard wired with a switch or breaker to disconnect the analyzer from the 

main power supply. Install the switch or breaker near the analyzer and label it as the Power Switch for the 

analyzer. 

Loop Powered (2 wire configuration) 

Attach the 24VDC signal cable to terminals #1 and #2 as shown in Figure 2.2.1 and on the diagram inside of the 

T80 cover. Feed the cable through the gland fitting on the right hand side of the T80. Tighten the cable gland to 

 

WARNING Electrical installation must be in accordance with the National Electrical Code 

(ANSI/NFPA-70), Canadian Electrical Code and/or any other applicable national or local 

codes. 
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provide a good seal to the cable. The instrument can be powered up at this point with no harm to the analyzer 

but it is best to wait until the sensor is installed.  

24VDC (4 wire configuration) 

Attach the 24VDC power cable to terminals #1 and #2 as shown in Figure 2.2.2 and on the diagram inside of the 

T80 cover. Attach the 4-20 mA1 cable to terminals #3 (out) and #2 (return)single channel unit and attach the 4-

20 mA2 cable to terminals #4 (out) and #2 (return) for a two channel instrument. Feed the cables through the 

gland fitting on the right hand side of the T80. Tighten the cable gland to provide a good seal to the cable. The 

instrument can be powered up at this point with no harm to the analyzer but it is best to wait until the sensor is 

installed.  

110/220 VAC (4 wire configuration) 

Attach power cable as shown in Figure 2.2.2 or as on the diagram inside of the T80 cover. Feed the cable 

through the gland fitting on the right hand side of the T80. Tighten the cable gland to provide a good seal to the 

cable. The instrument can be powered up at this point with no harm to the analyzer but it is best to wait until 

the sensor is installed.  

2.2.2 WIRING, SENSOR 

Attach the sensor wires as described on the diagram inside the T80 cover. Feed the sensor cable through the 

gland fitting on the left hand side of the T80. Do not use the same gland fitting for the AC power or 

Alarm/Relays. The green terminal strip connectors are detachable from the circuit boards. Remove the 

connector by pulling straight back from the circuit board.  

2.2.3 WIRING, 4-20 MA OUTPUTS 

Loop Powered Instruments: 

Connect the 4-20 mA cable to terminals #1 (+24V) and #2 (-24V), Model T80-XX-0 X-XX.  

24 VDC or 110/220 VAC powered instruments: 

For instruments powered with 24VDC or the internal power supply, Model T80-XX-1X-XX (24VDC) and T80-XX-

2X-XX (110/220 VAC), connect the 4-20 mA cable(s) to terminals #3 (out) for channel 1 and #2 (return) and to 

terminals #4 (out) for channel 2 and #2 (return).  

Transmitters with HART® Communication can be wired as shown below. See HART® Communication menu in 

Appendix 9.2: 
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2.2.4 WIRING, CONTACT RELAY OUTPUTS 

The standard configuration has three SPDT 230V 5 A relays that can be wired either normally open (NO) or 

normally closed (NC). The default configuration is set to use the relays as normally open.  

2.2.5 WIRING, SERIAL OUTPUT MODBUS RTU 

Attach the sensor wires as shown in Figure 2.2.2 or as described on the diagram inside the T80 cover. Feed the 

sensor cable through the gland fitting on the left hand side of the T80. Do not use the same gland fitting for the 

AC power or Alarm/Relays. See MODBUS command register in Appendix D. 
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3.0 OPERATION 
The ECD Model T80 transmitter is an intelligent, single or dual 

channel multi-parameter transmitter designed for the online 

continuous measurement of pH, ORP, pION, conductivity, resistivity 

or Dissolved Oxygen in a general purpose industrial environment. 

The Model T80 transmitter digitally communicates with any ECD S80 

digital sensor. The measurement identity is contained in the 

sensor’s memory. When an S80 sensor is connected to the 

transmitter it automatically configures the transmitter’s menus and 

display screens to the measured parameter.  

3.1 KEYS 

The functions associated with each key are displayed on the screen, above the key for the Selection Adjustment 

Keys and to the left of the key for the HOME and BACK keys. Press any Selection Adjustment key twice within 

one second to enter the HOME Menu Screen. 

3.1.1 HOME/EXIT KEY 

The HOME key performs two functions, it selects which Home Screen is displayed and it returns the active 

screen to the HOME Menu Screen from anywhere inside the menu structure.   

Three Display screens are available: 

1. DATA SCREEN: Displays the measurement type, numerical value, 

engineering Units, % Output of the 4-20 mA channel and temperature. 

2. mV SCREEN: Displays the measurement type, the sensor’s raw millivolt 

Value, % Output of the 4-20 mA channel and temperature. 

3. GRAF SCREEN: Displays a Graphical representation of the 4-20 mA channel 

% Output, the measurement type, the engineering units, and temperature. 

Only one of the three graphical display styles is available through the HOME 

key, either the Bar, Gauge or Line display. Choose which style will be 

displayed in the Graph Menu. (pathway to Graph Menu: CONFIG → XMTR 

→ LCD → Graph menu)  

Each of the above screens also displays the condition of the optional Alarm Relays, 

black if energized and white if de-energized.   

The HOME key changes to the EXIT key in the HOME Menu Screen, pressing EXIT prompts the user to “Save 

Changes” YES/NO when exiting the HOME Menu. YES applies any changes made in 

the menus, NO exits the HOME Menu without applying any changes made in the 

menus.  

3.1.2 BACK/HOLD KEY 

The BACK key changes the screen to the previously displayed screen when inside a 

menu, it moves BACK one screen. On a dual channel transmitter it toggles between the PV1, PV2 and Dual 

Channel Screens. The HOLD key toggles the output HOLD function ON/OFF in the MENU HOME screen. 
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3.1.3 SELECTION ADJUSTMENT KEYS 

The (4) Selection/Adjustment keys allow navigation and numerical adjustments to be made in the MENUs. To 

enter the HOME Menu screen press any of the Selection/Adjustment keys twice within one second. The 

various Menu choices and adjustment tools are displayed above the buttons once inside the MENU. 

3.1.4 ALPHA NUMERIC ENTRY 

The LABEL and PASSWORD (Caps and Numbers only) Menus allow alphanumeric entry. Entry is accomplished by 

scrolling through the alphanumeric list with the ▲ (forward) and ▼ (backwards) arrows to the character of 

choice and then moving to the NEXT digit. Pressing and holding the ▲ or ▼ keys will initiate two speed auto 

scrolling. The character set is sequentially listed below.  The first character in the set is an empty space. 

  ! ” # $ % & ‘ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C D E F G H I J K L M N O P Q R S T U V W X Y Z [ ¥ ] ^ _  

‘ a b c d e f g h I j k l m n o p q r s t u v w x y z { | } → ← 

3.2 MENU STRUCTURE 

Double tap any Selection/Adjustment key to enter the HOME Menu Screen. Five menu choices will appear, CAL, 

CONFIG, INFO, SIM and HOLD.  Each of the Menus is detailed below.  

3.2.1 HOLD (OUTPUT HOLD) 

Pressing the HOLD Key activates the HOLD function, HOLD is ON, displayed.   

� Freezes the 4-20 mA output at the last value prior to activation  

� Freezes optional Alarm Relays in the current state 

� While in the HOLD mode the % Output display toggles between the last 

value and HOLD 

Pressing HOLD again turns the hold function off, Hold is OFF, displayed. The HOLD function remains ON until it is 

turned OFF. (See Time Out in CONFIG>XMTR>OUTPUT>HOLD) 

3.2.2 CAL (CALIBRATION MENU) 

Four options are available, AUTO, STAND, MANUAL and TEMP. On dual channel instruments choose Sensor 1 or 

Sensor 2 when prompted. 

The first screen asks, “Is this a New Sensor, YES / NO”. If YES the calibration history 

from the previous sensor is cleared from memory and a new register is started, if NO 

then the calibration is written to the memory stack, (3) sets of data are stored. 

� AUTO is a two point calibration. The calibration proceeds in two steps, AutoCal 1 is an offset calibration 

and AutoCal 2 is a slope calibration. Auto Cal provides automatic solution recognition of the calibration 

solutions used for each measurement in accordance with the following list:  

1. pH Calibration Buffers (US Standard), pH 4.01, pH 7.00 and pH 10.00 (see Appendix A)  

2. ORP Calibration Solutions: Quinhydrone saturated:  pH 4.01= +89 mV,  pH 7.00= +266 mV  

3. pIon Calibration Solutions: 1.00, 10.00, 100.0 ppb, ppm, ppt 

(thousand) 

4. Dissolved Oxygen: Zero ppm (Sodium sulfite, Na2SO3 in water), Air 

saturated water, 8.25 ppm 
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Any two solutions can be used for AUTO calibration however if solutions other than those listed above 

are used for calibration then the calibration values must be entered manually.

� STAND is standardization, a single point calibration

process reading to agree with a laboratory determined “grab sample” reading. 

� MANUAL is a data entry screen. Manual calibration allows the user to enter a concentration with the 

corresponding mV value and a slope for an electrode.  Laboratory generated calibration data for an 

electrode can be input to a remote analyzer where calibrati

� TEMP allows the displayed temperature to be trimmed to agree with 

process temperature.  

3.2.3 CONFIG (CONFIGURATION MENU

Four options are available in the Configure Menu, 

and Dampen.  

� XMTR enters the Transmitter Configuration menu.

o LCD access  the Display Configur

� SETUP adjust screen light

• Temp. 

• CONT adjust Contrast

• BACK LIGHT 

� LEGEND provides the choice of 

� GRAPH provides the choice of

displayed on the Home screen.

• LINE , Moving average

of the 4

• GAUGE

• BAR, Current

� LABELS 

• TAG, Enter

Name, tag #... 

• TAG ON, 

Display Sequence

• POP UP

• SENSOR

o OUTPUT access the Output Configuration Menu

� 4-20 mA configure 4

• RANGE

• CAL  Trim 

• FAULT 

� Optional 2
nd

 4-

� RELAY 

• RLY1 Choose 

o 

 

Any two solutions can be used for AUTO calibration however if solutions other than those listed above 

are used for calibration then the calibration values must be entered manually. 

single point calibration. Standardizations are typically used to adjust the 

process reading to agree with a laboratory determined “grab sample” reading.  

is a data entry screen. Manual calibration allows the user to enter a concentration with the 

a slope for an electrode.  Laboratory generated calibration data for an 

electrode can be input to a remote analyzer where calibration is difficult or impractical.

displayed temperature to be trimmed to agree with actual 

ENU) 

options are available in the Configure Menu, XMTR, SENSOR, LOAD DEFAULT 

enters the Transmitter Configuration menu.  

the Display Configuration Menu 

adjust screen lighting characteristics 

Temp. Choose °C or °F 

adjust Contrast 

LIGHT adjust Backlight Timeout, from always ON to OFF after 10 minutes

provides the choice of Text Menus or Icon based Menus 

provides the choice of which Graph style is 

displayed on the Home screen. 

Moving average, vertical scale set to 0-100% 

of the 4-20 mA output and user defined time scale 

GAUGE, Current reading 0-100% of 4-20 mA range 

Current reading 0-100% of 4-20 mA range 

Enter up to 2 lines x 16 characters, example, 

Name, tag #... Displayed in INFO screen 

ON, Turn TAG ON/OFF, adds TAG to Main 

Display Sequence, DATA → mV → GRAF → TAG → DATA 

POP UP, Turns ON/OFF, the double tap HOME Screen pop up memo

SENSOR, Enter up to 2 lines x 16 characters 

access the Output Configuration Menu 

configure 4-20 mA output (PV or Temp or More) 

RANGE  Enter 4 mA value and 20 mA value 

Trim 4.00 mA output  and 20.00 mA output 

FAULT Choose fault condition 3.5 mA, 22 mA, None  

-20 mA for Temperature Output only 

Choose relay type: 

 Alarm, enter the Set point ON, Set Point OFF, 
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Any two solutions can be used for AUTO calibration however if solutions other than those listed above 

. Standardizations are typically used to adjust the 

is a data entry screen. Manual calibration allows the user to enter a concentration with the 

a slope for an electrode.  Laboratory generated calibration data for an 

on is difficult or impractical. 

always ON to OFF after 10 minutes 

 

the double tap HOME Screen pop up memo 
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Expiration time, Delay ON and Delay OFF times and the State, energize: 

changes state from de-energized to energized on alarm.  

o Timed, Enter Period, Duration times and Hold On/Off 

o Fault, No input required, relay condition changes from energize to de-

energize. 

o Disable, Inactivates relay and removes the relay 1 button from the 

HOME Screen display. 

• RLY2 Same features as Relay 1 

• RLY3 Same features as Relay 1 

� HOLD, Freezes outputs at current value and locks relays in 

their current state. 

• Hold Timeout, Removes HOLD after a certain period 

of time, default setting: No Timeout, selections 

include 15 minutes, ½ hour, 1 hour 

o SERIAL MODBUS configure serial output,  

� ADDRESS, enter address: 001 to 247  

� BAUD, Choose baud rate, default 9600 

� FORMAT, set serial data format, default value: 8N1, 8 bit, no 

parity bit, 1 stop bit 

o SERIAL HART configure output,  

� ADDRESS, enter address: 01-63  

� BAUD, default 1200, no adjustment available 

� FORMAT, default value: 8O1, 8 bit, Odd parity bit, 1 stop bit, no adjustment available 

o PASSWD Enter 4 character password to protect access to MENU Level, CAL Menu, CONFIG 

Menu and SIM Menu (simulate). Each level can be turned ON or OFF and can have a unique 

password.  

� MENU   ON/OFF  _ _ _ _   Locks Main Menu 

� CAL    ON/OFF  _ _ _ _  Locks CAL and CONFIG 

� CONFIG  ON/OFF  _ _ _ _  Locks CONFIG 

� SIM  ON/OFF  _ _ _ _  Locks SIM and CONFIG 

� SENSOR enters the sensor configuration menu.  

o Choose SENSOR 1 or 2 

� TYPE, Allows T80 transmitter to configure the S80 sensor. 

For use only when switching the measurement electrode 

type in an S80 sensor, i.e. for a pH electrode to a pION 

electrode.  Select Sensor Type: pH, ORP, DO2, NH3, NH4
+, Br-, Ca++, Cl-, Conductivity, 

Resistivity, Cu++, CN-, F-, NO3
-, K+, Ag+, Na+, S--

 

� T COMP, Enter % temperature compensation per degree: pH, pION 0.33%, ORP 0.00%, 

DO2 4% 

� ISO PT, Enter Iso Potential value in mV. The Iso Potential is 

the point where changes in the temperature do not cause 

changes to the signal. 

o COMP Dual Channel Only, Sets interaction Type: Dissociation (pKa), 

Interference, X ppm Sensor 1 = 1 ppm Sensor 2, Percentage per pH. 
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o Qty of SENSORS, Choose 1 or 2 

� Load Default resets all Menus to factory default configuration. 

3.2.4 INFO (INFORMATION MENU) 

The Information Menu provides two choices,  

� Transmitter Screen, details the Name, Power type, Serial #, Firmware 

version and the output configuration(s).  

� Sensor Screen, details the Name, Part #, Serial # and three sets of 

Calibration data.  

3.2.5 SIM (SIMULATION MENU)  

The Simulation menu allows the Input or Output signals to be simulated.  

� SYSTEM allows the Input to be simulated. Two choices are available, FIXED is 

a fixed value, RAMP varies the signal across the 4-20 mA range, from the 

lowest value to the highest value and back, activating and deactivating relays 

if present. The RAMP has two adjustments the Ramp period, 30 seconds to 2 

minutes and Duration; 1 cycle, 5, 10, 20, 30 minutes. 

� RELAYS allows individual relays, #1, #2, and #3 to be activated and deactivated 

� 4-20 mA allows the output to be simulated from 4.00 mA to 20.00 mA. 

3.2.6 FAULT SCREENS 
Fault Definition Recommendation 

Memory Error 

AN ERROR WAS FOUND 

WITH THE MEMORY OF 

THE MICROCONTROLLER 

RETURN TO FACTORY 

FOR SERVICE 

Input Voltage OOT 
POWER IS OUT OF 

TOLERANCE 

CHECK WIRING TO 

THE TRANSMITTER 

+12V OOT 
ONBOARD 12V IS 

OUT OF TOLERANCE 

RETURN TO FACTORY 

FOR SERVICE 

+3.3V OOT 
ONBOARD 3.3V IS 

OUT OF TOLERANCE 

RETURN TO FACTORY 

FOR SERVICE 

Loss of Comm 
COMMUNICATION WITH 

THE SENSOR WAS LOST 

CHECK WIRING TO 

THE SENSOR 

No Sensor 
NO SENSOR WAS FOUND 

AT START-UP 

CHECK WIRING TO 

THE SENSOR 

Cal Failed 
SENSOR CALIBRATION 

FAILED 

1) CLEAN SENSING TIP 

2) VERIFY SOLUTIONS 

3) DO NOT LEAVE 

   UNATTENDED 

4) RE-CALIBRATE 

Relay 1 Expired 
RELAY 1 TIME 

ON EXPIRED 

1) CHECK SENSOR OP 

2) CHECK AUX EQUIP 

   A) PUMPS 

   B) TANKS 

Relay 2 Expired 
RELAY 2 TIME 

ON EXPIRED 

1) CHECK SENSOR OP 

2) CHECK AUX EQUIP 

   A) PUMPS 

   B) TANKS 

Relay 3 Expired 
RELAY 3 TIME 

ON EXPIRED 

1) CHECK SENSOR OP 

2) CHECK AUX EQUIP 

   A) PUMPS 

   B) TANKS 
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3.2.7 SENTINEL® SCREENS 

The SENTINEL feature allows the Model T80 transmitter to provide Pre-pHault 

diagnostic information about the accuracy of a pH, ORP or pIon measurement. The 

SENTINEL displays a filled triangular gauge that decreases proportionally to the 

degradation of the reference electrode. A filled gauge indicates a properly 

functioning measurement while the emptying gauge indicates the remaining life of 

the electrode. This Pre-pHault diagnostic alerts the user to potential problems and 

provides a visual indicator of the sensor’s remaining life before the measurement 

actually fails. 

The Model T80 transmitter only displays the SENTINEL functions when a Model S80 

SENTINEL sensor is connected. The Model S80 SENTINEL sensor uses Diagnostic 

electrodes designated by Part#’s 20053XX, these electrodes use a triaxial connector with a, PV connection (pH, 

ORP, Ion), Reference connection and Diagnostic connection. 

On a dual channel instrument an asterisk *, will be displayed in the sensor name block, SENSOR 2 *. The 

SENTINEL function will only be visible in the Single Screen mode, not in the Dual Screen mode. Toggle the BACK 

Key from Dual → Sensor 1 → Sensor 2 to see the SENTINEL function. 

Configure SENTINEL Function 

The SENTINEL function is located in the Configure Sensor menu: 

 CONFIG → SENSOR → SENSOR 1 or 2 →MORE → SNTL 

There are three values displayed:   

Vo = SENTINEL Voltage offset, The diagnostic voltage of a new electrode 

Ve = SENTINEL expiration Voltage, Vo + Range 

RANGE = The shift in the diagnostic voltage required to trigger diagnostic fault. 

The default values of Vo = 0.0 mV and the Range = 60 mV are good for most 

situations. The starting diagnostic voltage is typically near 0 mV on a new electrode 

and if the readings have drifted 60 mV apart (a full pH unit) then electrode service is 

required. 
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3.3 START UP GUIDE 

Install and wire the T80 Transmitter as described in Sections 2.1 and 2.2 above.  

Connect the sensor to the transmitter as described in Section 2.2 above. 

Supply power to the Model T80 transmitter. 

Verify the proper measurement type is displayed, pH, ORP or Ion. The sensor automatically uploads the 

measured parameter, the calibration data and the range of measurement to the transmitter. The default 

configuration of the 4-20 mA output is the range of the sensor, 0-14 pH for pH sensors, -1500 - +1500 for ORP or 

0-XXXX ppm for a pIon Sensor. To change the 4-20 mA range, follow the instructions in Section 3.3.1 below.  

3.3.1 CONFIGURE 4-20 MA OUTPUT RANGE 

� Double press any key except the HOME key to enter the HOME Menu. Follow the path below to set the 

4-20 mA range. 

� HOME Menu → Press  CONFIG → XMTR → OUTPUT → 4-20 (1)(2) → PV or 

TEMP 

� Press CHANGE to enter New Values. 

� Choose 4 mA value, press OK 

� Enter value using ▲ or ▼and NEXT  to move to the next digit, press OK→Back 

� Choose 20 mA value, press OK,  

� Enter value using ▲ or ▼and NEXT  to move to the next digit, press OK→Back 

� Press BACK to return to the CONFIGURE 4-20 mA screen or HOME to return to 

the HOME Menu screen. 

3.3.2 CONFIGURE 4-20 MA FAULT CONDITION 

� In the CONFIGURE 4-20 mA screen, Press MORE → FAULT or  

� Choose Low Fault 3.5 mA or Hi Fault 22 mA or NONE, (default setting NONE), 

Press OK 

� Press BACK → CAL, connect DVM to 4-20 mA line, Press 4.00 mA then adjust value to the DVM reading, 

Press 20.00 mA and adjust value to the DVM reading. The 4-20 mA output is calibrated.  

3.3.3 CONFIGURE ALARM RELAYS (RELAYS OPTIONAL)  

� HOME Menu → Press  CONFIG → XMTR → OUTPUT → RELAYS→RLY1   

� Choose the ALARM, TIMER, FAULT or DISABLE mode for Relay 1 

� ALARM Displays:  

o SET POINT ON: The Process Variable Value that activates the relay. 

o EXPIRATION: Enter a time that should not be exceeded before the PV should have changed 

enough to activate the OFF set point. At the Expiration time the relay is deactivated and a Fault 

condition is initiated. Fault: Relay 1 Time expired: Cause: Loss of reagent, failed sensor …. 

o Delay ON: The amount of time the PV must remain above/below the set point before the relay 

activates. 

o SET POINT OFF: The Value of the process variable that deactivates 

the relay.  

� SET POINT OFF > Set Point → Low Set Point 

� SET POINT OFF < Set Point → Hi Set Point 
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o Delay OFF: The amount of time the PV must remain above/below the hysteresis point before 

the relay deactivates. 

o STATE: Energize (relay is energized on activation)/De-energize (relay is de-energized on 

activation) 

� TIMER activates the relay periodically for a specific duration, user configured period and duration 

� FAULT sets the relay condition to a de-energize state and NC relay closes in response to a Fault 

condition.  

� DISABLE turns off the relay and removes it’s icon from the HOME screen 

Setting up an Alarm Relay 

� Choose ALARM 

� Press CHANGE to enter new values 

� Choose ON Set Point, Press OK 

� Enter value using ▲ or ▼and NEXT  to move to the next digit, press OK, press BACK (Min –Max values 

indicate the range of acceptable values) 

� Choose Expiration, Press OK, 

� Choose time from drop down menu using ▲ or ▼, press OK, press BACK 

� Choose OFF Set Point, Press OK 

� Enter value using ▲ or ▼and NEXT  to move to the next digit, press OK, press BACK 

� Choose Delay ON, Press OK 

� Enter value using ▲ or ▼and NEXT  to move to the next digit, press OK, press BACK 

� Choose Delay OFF, Press OK 

� Enter value using ▲ or ▼and NEXT to move to the next digit, press OK, and press BACK when done to 

exit Relay 1. 

� Repeat for Relay 2 and Relay 3. 

3.3.4 EXIT MENUS AND RETURN TO MAIN DISPLAY 

� Press HOME Key to return to the Home Menu Screen 

� Press Hold to turn OFF Hold 

� Press EXIT Key to exit the menu 

� “Save Changes?” press YES 

� Choose Display Mode, DATA, mV or GRAF by pressing selection Key. The 

selection key displays which screen will be displayed next. 

o The type of graphical display used, Line, Bar or Gauge is selected in 

CONFIG → XMTR → LCD → GRAPH  → LINE, GAUGE, BAR 

3.3.5 SENSOR START UP 

All sensors are supplied with protective caps over the sensing end. Remove the 

cap(s) from the sensor before installing in the process. All sensors were calibrated 

at the factory before shipment, no calibration should be necessary before use. 

Allow the sensor to equilibrate to the process solution conditions for ½ hour before 

verifying the reading against a grab sample. If calibration is required follow the 

instruction in Section 4.0 below. 
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3.4 USER SELECTABLE OPTIONS 

3.4.1 SCREEN LIGHTING 

LED back lighting is available on AC and DC powered instruments only, this feature is 

inactive on loop powered instruments. 

Contrast can be adjusted for optimal viewing. The Backlight can be adjusted to 

timeout after a set period of time or remain on.  

Location: CONFIG → XMTR → LCD → Set Up → CONT, BACK LIGHT 

3.4.2 SCREEN LEGEND 

The keys can be displayed as English Text or Icons. See Appendix C for Button/Icon 

legend. 

Location: CONFIG → XMTR → LCD → LEGEND → ICON, TEXT 

3.4.3 GRAPHICAL DISPLAY 

There are three graphical display choices: 

� LINE, The Line graph is a moving average of the process variable with the 4-20 mA range as the 

maximum/minimum values and a choice of time scales.  

The Time scale is the amount of time displayed across the full screen. Choices include: 

Full Screen Period 15 minutes 1 hour 12 hours 1 day 2 days 

Sample Rate ( 1 point every) 10 seconds 40 seconds 8 minutes 15 minutes 30 minutes 

 

� GAUGE, Live reading displaying 0-100% of 4-20 mA range. The Alarm Relay number(s), #1, #2 and#3 

mark the respective set points on graph. 

� BAR, Live reading displaying 0-100% of 4-20 mA range. The Alarm Relay number(s), #1, #2 and#3 mark 

the respective set points on graph. 

Pressing OK after selecting a Graphical Display will exit the menu structure and 

return to the Main Display. 

Location: CONFIG → XMTR → LCD → GRAPH 

3.4.4 TAG TRANSMITTER NAME 

Two 16 character lines are available for naming the transmitter, Upper and Lower case characters, Numbers and 

Punctuation are available. The information entered will be displayed in the INFO screen and optionally in the 

Main display sequence if activated in the TAG ON menu. The character set is listed 

below sequentially; the first character in the set is an empty space. 

  ! ” # $ % & ‘ ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C D E F G H I J K L M N O 

P Q R S T U V W X Y Z [ ¥ ] ^ _  ‘ a b c d e f g h I j k l m n o p q r s t u v w x y z { | } → 

← 
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Entry is accomplished by scrolling through the alphanumeric list with the ▲ (forward →) and ▼ (backwards ←) 

arrows to the character of choice and then pressing NEXT to advance the cursor to the next digit. Pressing and 

holding the ▲ or ▼ keys will initiate two speed auto scrolling. Press BACK to exit the screen. 

 Location: CONFIG → XMTR → LCD → LABELS → TAG 

3.4.5 SENSOR NAME 

Two 16 character lines are available for naming the Sensor, Upper and Lower case characters, Numbers and 

Punctuation are available. The information entered will be displayed in the INFO screen. Entry is accomplished 

by scrolling through the alphanumeric list with the ▲ (forward →) and ▼ (backwards ←) arrows to the 

character of choice and then pressing NEXT to advance the cursor to the next digit. Pressing and holding the ▲ 

or ▼ keys will initiate two speed auto scrolling. Press BACK to exit the screen. 

 Location: CONFIG → XMTR → LCD → LABELS → SENSOR 

3.4.6 PASSWORD PROTECTION 

PASSWD Enter 4 character password to protect access to MENU Level, CAL Menu, 

CONFIG Menu and SIM Menu (simulate). Each level can be turned ON or OFF and can 

have a unique password. Upper Case Characters and Numbers are available for use. 

Place the cursor in front of the level to be changed and Press OK. Move the cursor to 

ON and press OK to change the password status from OFF to ON.  

Entry is accomplished by scrolling through the alphanumeric list with the ▲ (forward 

→) and ▼ (backwards ←) arrows to the character of choice and then pressing NEXT 

to advance the cursor to the next digit. Pressing and holding the ▲ or ▼ keys will 

initiate two speed auto scrolling.  

o MENU   ON/OFF  _ _ _ _   Locks Main Menu 

o CAL    ON/OFF  _ _ _ _  Locks CAL and CONFIG 

o CONFIG  ON/OFF  _ _ _ _  Locks CONFIG 

o SIM  ON/OFF  _ _ _ _  Locks SIM and CONFIG 

In the case of a Lost or Forgotten password enter MSTR to access the screen.  

Location: CONFIG → XMTR → PSSWD 

 

  

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2H



Model T80   Page 32 

 

4.0 CALIBRATION 
The Model T80 transmitter provides three methods of calibration: 

4.0.1 AUTO CALIBRATION DESCRIPTION 

Auto calibration is the primary calibration method for all measurements. AUTO calibration automatically 

recognizes the calibration solution the sensor is in and proposes the actual temperature compensated value for 

acceptance. AUTO calibration can be a single point or two point calibration. A single point calibration sets the 

zero point or offset value of the sensor. The second calibration sets the slope or span of the sensor. 

When the AUTO key is pressed the transmitter displays the PV (Process Variable) 

and the associated mV signal from the sensor. When the reading has stabilized a 

calibration value is AUTOmatically proposed, i.e. 7.00 pH, 10 ppm Fluoride ion, 0.00 

mg/L Dissolved Oxygen. The user is prompted to accept the proposed calibration 

value or enter and accept another value. Once Cal 1 is accepted the user is ask to 

continue to Cal 2, yes/no. If yes, then a second calibration value is proposed when the sensor has stabilized in 

the second calibration solution. Accept the value and the calibration is complete. 

At the end of each calibration the Offset and Slope are displayed in the respective units, pH, mV, ppm, mg/l. 

4.0.2 STANDARDIZE CALIBRATION DESCRIPTION 

A Standardize Calibration is a single point calibration where the transmitter’s 

reading is adjusted to agree with a solution of known value, either a calibration 

standard, a grab sample or laboratory determined value. In many cases the 

constituents and the pressure and temperature of the process solution are very 

different from the calibration solution. In these cases, once the sensor has 

equilibrated, the Zero Point or Offset value may have shifted from the original calibration point. Standardization 

allows  for correction of this type of offset. 

When the STAND key is pressed, the user is prompted to ENTER VALUE. The user enters the value they want the 

transmitter to read and press OK. The user is then prompted to accept the value, yes/no, and the calibration is 

complete. Standardizations are single point calibrations. 

At the end of each calibration the Offset and Slope are displayed in the respective units, pH, mV, ppm, mg/l. 

4.0.3 MANUAL CALIBRATION DESCRIPTION 

Manual calibration allows the user to enter calibration data for an electrode into the transmitter without 

performing a calibration. A MANUAL Calibration requires the entry of three pieces of 

data, (1) A concentration with the (2) corresponding mV value and (3) a slope for an 

electrode.  This allows laboratory generated calibration data for an electrode to be 

entered in a remote analyzer where calibration is difficult or impractical. 

Example: MANUAL Calibration for a pH electrode 

1. Calibrate the pH electrode in the laboratory 

2. Record the mV value of some pH Standard, pH 7.00 buffer = 6.8 mV (any pH 

– mV pair will work) 
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3. Calculate and Record the slope of the electrode, 58.2 mV/pH 

4. Install the electrode into the field mounted sensor 

5. Press MANUAL and enter the pH value, 7.00 pH, press mV and enter the 

corresponding mV value, 6.8 mV, press OK, Accept Offset?, press YES, enter 

slope 58.2 mV/pH, press OK, Accept Slope?, Press YES  

6. The Calibration is complete, the Offset and Slope values are displayed, press 

OK to exit. 
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4.1 PH CALIBRATION PROCEDURES 

AUTO Calibration recognizes pH 4.01, pH 7.00 and pH 10.00 buffer solutions for automatic, temperature 

compensated calibrations. Any calibration solutions can be used but the pH value will have to be entered 

manually. Follow the steps below to accomplish a pH calibration. Example uses pH 7.00 and pH 4.01 buffers. 

4.1.1 AUTO CAL USING PH 4.01, 7.00, 10.00 BUFFERS 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 

Press Yes/NO Place Sensor in CAL Solution ( use pH 7.00 buffer) 

Press AUTO then CAL 1 STABILIZING, 7.00 pH x.x mV, 7.00 pH corrected Accept Cal 1? 

Press YES CAL1 Value 7.00 pH, Continue to CAL2? Move sensor to 4.01 pH buffer solution 

Press YES STABILIZING, 4.00 pH xxx.x mV, 4.00 pH corrected Accept Cal? 

Press YES OFFSET: 7.00 pH  x.x mV, SLOPE: 59.16 mV/pH (data written to Log) 

Press OK Calibration complete  

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.1.2 AUTO CAL USING OTHER PH BUFFERS 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 

Press YES/NO Place Sensor in CAL Solution  

Press AUTO then CAL 1 STABILIZING, xx.xx pH x.x mV, 7.00 pH corrected Accept Cal? 

Press NO Enter CAL 1 Value 

Press ▲ ▼ NEXT xx.xx pH (use arrows and NEXT to enter pH Buffer value) 

Press OK xx.xx pH, xxx.x mV, Accept this Value 

Press YES CAL 1 Value xx.xx pH, Continue to CAL 2? (Place Sensor in 2nd calibration buffer) 

Press YES STABILIZING, xx.xx pH xxx.x mV, 4.00 pH corrected Accept Cal? 

Press NO Enter CAL 2 Value 

Press ▲ ▼ NEXT xx.xx pH (use arrows and NEXT to enter pH Buffer value) 

Press OK xx.xx pH, xxx.x mV, Accept this Value 

Press YES OFFSET: xx.xx pH  x.x mV, SLOPE: 59.16 mV/pH (data written to Log) 

Press OK Calibration complete  

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.1.3 STANDARDIZE 

Leave the sensor in the process solution, take a grab sample from the process and determine the pH. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes, erases CAL Log in INFO, NO adds CAL to existing Log) 
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Press NO Place Sensor in CAL Solution (or leave in the process solution) 

Press STAND Enter Value  

Press ▲ ▼ NEXT xx.xx pH (use arrows and NEXT to enter process pH value) 

Press OK xx.xx pH, xxx.x mV, Accept Value? 

Press YES OFFSET: xx.xx pH  x.x mV, SLOPE: xx.xx mV/pH (this data written to Log) 

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.2 ORP CALIBRATION PROCEDURES 

AUTO Calibration recognizes Quinhydrone solutions (mVa), pH 7.00 quinhydrone solution (90 mV) and pH 4.01 

quinhydrone solution (267 mV) for automatic ORP calibrations. Any calibration solutions can be used but the 

ORP value will have to be entered manually. Follow the steps below to accomplish an ORP calibration. 

4.2.1 AUTO CAL WITH QUINHYDRONE 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 

Press Yes/NO Place Sensor in CAL Solution ( use pH 7.00 Q solution) 

Press AUTO  then CAL 1 STABILIZING, xxx.x mV, xxx.x mVa, 90.0 mV corrected Accept Cal? 

Press YES CAL1 Value 90.0 mV, Continue to CAL2? Move sensor to pH 4.01 Q solution 

Press YES STABILIZING, 269.2 mV 267.0 mVa, 267 mV corrected Accept Cal? 

Press YES OFFSET:  90.0 mVa, 87 mV, SLOPE: 1.02 mV/ mVa (data written to Log) 

Press OK Calibration complete  

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.1.2 STANDARDIZE 

Leave the sensor in the process solution, take a grab sample from the process and determine the ORP. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes, erases CAL Log in INFO, NO adds CAL to existing Log) 

Press NO Place Sensor in CAL Solution (or leave in the process solution) 

Press STAND Enter Value  

Press ▲ ▼ NEXT xx.xx mV (use arrows and NEXT to enter process ORP value) 

Press OK xxx.x mV, xxx.x mV, Accept Value? 

Press YES OFFSET: xxx.x mV  xxx.x mV, SLOPE: xx.xx mV/mV (this data written to Log) 

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

 

Operation & Maintenance Plan Oven Run B Passive Treatment System Redesign and Construction

Appendix 2H



Model T80   Page 36 

 

4.3 PION CALIBRATION PROCEDURES  

AUTO Calibration recognizes 1, 10 or 100 ppm/ppb calibration solutions. Any calibration solutions can be used 

but the ppm value will have to be entered manually. Follow the steps below to accomplish a pION calibration. 

4.3.1 AUTO CAL USING 1, 10, 100 PPM SOLUTIONS 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 

Press Yes/NO Place Sensor in CAL Solution ( use 10 ppm solution) 

Press AUTO then CAL 1 STABILIZING, 10.00 ppm, xxx.x mV, 10.00 ppm corrected, Accept Cal? 

Press YES/NO CAL1 Value 10.00 ppm, Continue to CAL2? Move sensor to 100 ppm solution 

Press YES STABILIZING, 100.0 ppm, xx.xx mV, 100 ppm corrected, Accept Cal? 

Press YES OFFSET:  10.00 ppm, 310 mV, SLOPE: 55.1 mV/ decade (data written to Log) 

Press OK Calibration complete  

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.3.2 AUTO CAL USING NON-DECIMAL PPM SOLUTIONS 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 

Press YES/NO Place Sensor in CAL Solution  

Press AUTO then CAL 1 STABILIZING, xx.xx pH x.x mV, 10.00 ppm corrected Accept Cal? 

Press NO Enter CAL 1 Value 

Press ▲ ▼ NEXT xxxx.x ppm (use arrows and NEXT keys to enter Cal  value) 

Press OK xxxx.x ppm, xxx.x mV, Accept this Value 

Press YES CAL 1 Value xxxx.x ppm, Continue to CAL 2? (Place Sensor in 2nd calibration 

solution) 

Press YES STABILIZING, xxxx.x ppm xxx.x mV, xxx.x ppm corrected Accept Cal 2? 

Press NO Enter CAL 2 Value 

Press ▲ ▼ NEXT xxxx.x ppm (use arrows and NEXT keys to enter Cal  value) 

Press OK xxxx.x ppm, xxx.x mV, xxx.x ppm corrected Accept Cal 2? 

Press YES OFFSET: xxxx.x ppm  xxx.x mV, SLOPE: 55.40mV/decade (data written to Log) 

Press OK Calibration complete  

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.3.3 STANDARDIZE  

Leave the sensor in the process solution, take a grab sample from the process and determine the Ion 

concentration. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 
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Press CAL Is this a new Sensor?  (Yes, erases CAL Log in INFO, NO adds CAL to existing Log) 

Press NO Place Sensor in CAL Solution (or leave in the process solution) 

Press STAND Enter Value  

Press ▲ ▼ NEXT xxxx.x ppm (use arrows and NEXT to enter process Ion ppm value) 

Press OK xxxx.x ppm, xxx.x mV, Accept Value? 

Press YES OFFSET: xxxx.x ppm  xxx.x mV, SLOPE: xx.xx mV/DEC (this data written to Log) 

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

 

4.4 S80/DO90 DISSOLVED OXYGEN CALIBRATION PROCEDURES 

There are two separate calibration procedures for Dissolved Oxygen sensors, Section 4.4 for S80 DO and DO90 

ppb DO and Section 4.5 for TRITON® DO80 Optical. 

The dissolved oxygen AUTO Cal acknowledges zero ppm, mg/l, % SAT for CAL 1 and the temperature 

compensated value for atmospheric oxygen, 8.25 ppm, mg/l at 25°C or 100 % SAT for CAL 2. 

The zero point is set by placing the sensor into an oxygen free solution and verifying the displayed value drops to 

a value below 1 mV. The sensor will take a few minutes to equilibrate to the zero oxygen solution but for the 

highest accuracy it is best to wait 15-20 minutes before initiating a calibration. The typical sensor will burn down 

to 0.5 – 0.7 mV in an hour or so in a zero ppm solution. A zero ppm O2 solution can be made by adding 

approximately 5 grams of sodium sulfite to a liter of distilled water or purging the sample with nitrogen gas. 

The slope (CAL 2) is set by placing the sensor in air saturated distilled water or water saturated (100% humidity) 

air. The easiest method is to suspend the sensor vertically in beaker with a ½” of water in the bottom slightly 

above the water. 

 A STANDardize calibration adjusts the CAL 2 value, resetting the slope of the sensor, mV/ppm. 

The actual concentration in mg/L (C) is equal to the Saturation value at the given temperature multiplied by the 

altitude and air pressure corrections. Determine the calibration temperature and look up the saturation value 

(S) in Table 1 below. Then determine the altitude correction (K) from Table 2 and the current air pressure in bar 

(P), 1 bar equals 14.7 psi. Use 1 bar if the actual air pressure is unknown. 

C = S x K x P  

Example: 

Temperature = 20°C → Saturation = 9.08 mg/L, Altitude = 1200 ft → K = 0.960, Air Pressure 1.014 bar 

C = 9.08 x 0.960 x 1.014 = 8.84 mg/L    

The T80 transmitter uses the temperature compensated Saturation Index for AUTO Cal, however the user can 

enter the altitude and pressure compensated value of 8.84 ppm as the calibration value when prompted to 

“Accept Value?” in CAL 2. 

Table 1   Saturation Index 

Temperature 

°C (°F) 

Saturation 

mg/L 

Temperature 

°C (°F) 

Saturation 

mg/L 

Temperature 

°C (°F) 

Saturation 

mg/L 

0 (32) 14.64 14 (57) 10.28 28 (82) 7.82 
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1 (34) 14.23 15 (59) 10.06 29 (84) 7.69 

2 (36) 13.83 16 (61) 9.85 30 (86) 7.55 

3 (38) 13.45 17 (63) 9.64 31 (88) 7.42 

4 (39) 13.09 18 (64) 9.45 32 (90) 7.30 

5 (41) 12.75 19 (66) 9.26 33 (91) 7.18 

6 (43) 12.42 20 (68) 9.08 34 (93) 7.06 

7 (45) 12.11 21 (70) 8.90 35 (95) 6.94 

8 (46) 11.81 22 (72) 8.73 36 (97) 6.83 

9 (48) 11.53 23 (73) 8.57 37 (99) 6.72 

10 (50) 11.25 24 (75) 8.41 38 (100) 6.61 

11 (52) 10.99 25 (77) 8.25 39 (102) 6.51 

12 (54) 10.75 26 (79) 8.11 40 (104) 6.41 

13 (55) 10.51 27 (81) 7.96   

Table 2   Altitude Correction 

Altitude 

m (ft) 

K Altitude 

m (ft) 

K Altitude 

m (ft) 

K 

Sea Level 0 1.000 700 (2300) 0.922 1400 (4600) 0.849 

50 (160) 0.994 750 (2450) 0.916 1450 (4750) 0.844 

100 (330) 0.988 800 (2600) 0.911 1500 (4900) 0.839 

150 (500) 0.982 850 (2800) 0.905 1550 (5100) 0.834 

200 (660) 0.977 900 (2950) 0.900 1600 (5250) 0.830 

250 (820) 0.971 950 (3100) 0.895 1650 (5400) 0.825 

300 (980) 0.966 1000 (3300) 0.890 1700 (5600) 0.820 

350 (1200) 0.960 1050 (3450) 0.885 1750 (5750) 0.815 

400 (1300) 0.954 1100 (3600) 0.879 1800 (5900) 0.810 

450 (1500) 0.949 1150 (3775) 0.874 1850 (6050) 0.805 

500 (1650) 0.943 1200 (3950) 0.869 1900 (6200) 0.801 

550 (1800) 0.938 1250 (4100) 0.864 1950 (6375) 0.796 

600 (2000) 0.932 1300 (4250) 0.859 2000 (6550) 0.792 

650 (2150) 0.927 1350 (4400) 0.854   

4.4.1 AUTO CAL USING ZERO PPM SOLUTION AND AIR  

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 

Press Yes/NO Place Sensor in CAL 1 Solution ( use 0.00 ppm solution) or CAL 2 Solution (Air) 

 To perform zero CAL press CAL 1, to skip zero cal press CAL 2 

Press AUTO then CAL ? STABILIZING, 0.00 ppm, xxx.x mV, 0.00 ppm corrected, Accept Cal? 

Press YES CAL 1 Value 0.00 ppm, Continue to CAL2? Move sensor to Air or saturated water  

Press YES STABILIZING, 8.25 ppm, xxx.x mV, 8.25 ppm corrected, Accept Cal? 

Press YES OFFSET:  0.00 ppm, 2.3 mV, SLOPE: 40.1 mV/ ppm (data written to Log) 

Press OK Calibration complete  

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 
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4.4.2 STANDARDIZE  

Leave the sensor in the process solution or in the air, take a grab sample from the process and determine the 

dissolved oxygen concentration or enter the temperature and pressure corrected value for air. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes, erases CAL Log in INFO, NO adds CAL to existing Log) 

Press NO Place Sensor in Air or the process solution  

Press STAND Enter Value  

Press ▲ ▼ NEXT xxx.xx ppm or % SAT (use arrows and NEXT to enter process value) 

Press OK xxx.xx ppm, xxx.x mV, Accept Value? 

Press YES OFFSET: 0.00 ppm  xx.x mV, SLOPE: xx.xx mV/ppm (this data written to Log) 

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.4.3 MANUAL CAL  

Leave the sensor in the process solution or in the air, take a grab sample from the process and determine the 

dissolved oxygen concentration or enter the temperature and pressure corrected value for air. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes, erases CAL Log in INFO, NO adds CAL to existing Log) 

Press NO Place Sensor in Air or the process solution, it doesn’t matter which  

Press MANUAL Enter Zero Value  

Press ▲ ▼ NEXT 000.00 ppm or % SAT (use arrows and NEXT to enter ppm value) 

Press mV Button Enter mV value for zero ppm solution (default use 0.5 mV) 

Press ▲ ▼ NEXT 000.00 mV  (use arrows and NEXT to enter mV value) 

Press OK OFFSET: 0.00 ppm 00.5 mV, Accept Value? 

Press YES Slope 000.0 mV/ppm or 000.0 mV/% SAT 

Press ▲ ▼ NEXT 048.00 mV/ppm  (use calculated value or 45 mV/ppm or 4.0 mV/% SAT) 

Press OK Slope 48.00 mV/ppm, Accept this Value?  

Press YES Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

 

4.5 TRITON® DISSOLVED OXYGEN CALIBRATION PROCEDURES 

Before starting a calibration Enter the Salinity and Barometric pressure in the CONFIG→SENSOR menu. The 

default values are Salinity 0% and 1013 mbar. Use Table 2 above to calculate the pressure using elevation if the 

actual pressure is not known. 

The TRITON® DO80 sensor was calibrated at the factory prior to shipment and should not require a re-

calibration at start up. Calibration is required whenever the fluorescence cap/membrane cap is replaced. 
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Calibrations can be performed as a one point (Air cal), a two point (zero point & Air cal) or a standardization, 

there is no Manual Cal option available for the TRITON® dissolve oxygen sensors. 

The Auto Cal allows both 0% and100% calibrations. The sensor senses the oxygen partial pressure and if it is less 

than 20% of saturation it assumes a Zero Point calibration and calibrates to 0.00% saturation, 0.00 mg/l or 0.00 

mbar depending on the measurement mode. If the sensed value is above 75% of saturation it assumes an Air 

Calibration and calibrates to the value equivalent to 100% saturation. 

The zero point of the sensor is relatively stable through the life of the fluorescence/membrane cap. The zero 

point is checked by placing the sensor into an oxygen free solution and verifying the displayed value drops to a 

value near zero ppm. The sensor will take a few minutes to equilibrate to the zero oxygen solution but it is best 

to wait 15-20 minutes before initiating a calibration (up to a 10 minute cycle time) for the highest accuracy. A 

zero ppm O2 solution can be made by adding approximately 5 grams of sodium sulfite to a liter of distilled water 

or purging the sample with nitrogen gas.  

Air saturated water and water saturated air (100% humidity) have the same oxygen partial pressure. The 

preferred calibration method uses water saturated air. The Protective Guard can be removed from the front of 

the sensor and filled a small amount of distilled water, ~5 ml, for an easy to use Calibration Cap. 

The calibration cycle takes up to 10 minutes once initiated. The DO80 sensor should be equilibrated for 10-15 

minutes to the air sample (100% humidity, 0% Salinity) and the ambient temperature before starting the 

calibration. When measuring in the “% Saturation mode”, 100% will be reported as the calibration value.  

4.5.1 AUTO CAL USING ZERO PPM SOLUTION AND AIR 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL  Place Sensor in Zero Solution (0.00 ppm solution) (Optional Zero Cal) 

Press AUTO(Optional) CALIBRATING, SAVING CAL, AUTO CAL COMPLETE, OK? (up to 10 minutes) 

Press OK (Optional)  

AIR CALIBRATION Move sensor to Air (100% humidity) or Air saturated water 

Press AUTO CALIBRATING, SAVING CAL, AUTO CAL COMPLETE, OK? 

Press OK Returned to Cal Menu 

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 
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4.5.2 STANDARDIZE  

Leave the sensor in the process solution or in the air, take a grab sample from the process and determine the 

dissolved oxygen concentration or enter the temperature and pressure corrected value for air. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Place Sensor in Air or with the sensor in the process solution 

Press STAND Enter Value  

Press ▲ ▼ NEXT xx.xx ppm or % SAT (use arrows and NEXT to enter process value) 

Press OK xx.xx ppm, Accept Value? 

Press YES CALIBRATING, SAVING CAL, CURRENT VALUE: x.xx ppm, DESIRED VALUE: x.xx 

ppm, OFFSET xxx ppb or ppm  

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.6 TRITON® TR6 TURBIDITY/SUSPENDED SOLIDS SENSOR 

The TRITON® TR6 turbidity sensors are dual range sensors available in four different ranges. The TR6 turbidity 

sensors have a non-linear output. The calculation of the turbidity is accomplished using a 2nd order polynomial of 

the millivolt output, NTU = ax2 + bx + c, where x = millivolt output of the sensor. A three point calibration is 

required to define the shape of the curve. The Model T80 turbidity analyzer was calibrated at the factory before 

shipment in three Formazine solutions using the values listed below. The calibration was performed with the 

three solutions specific for the NTU range of the sensor ordered.  

Changing the range of the sensor (Hi to Low or Low to Hi) or changing the measurement unit will require a new 

three point calibration. The calibration points for the three point calibration are 0%, 50% and 100% of the 

measurement range, NTU, FNU, ppm, mg/L or % Solids. Calibrations of NTU or FNU can be made with formazine 

solutions diluted from the 4000 NTU stock solution to the values listed in the table below. Calibrations of ppm, 

mg/L, and % Solids require the actual process solutions to be used for the calibration. The 100% solution for the 

ppm, mg/L and % solids should be near the high point of the measurement, it does not need to be the maximum 

value but it should be in the upper range of the measurement. The value of the solution must be known or 

determined by another method such as a grab sample and laboratory measurement. Then make the 50% 

solution from 1 part of the high sample to one part deionized water, its value is half of the high value and finally 

use deionized water for the 0% solution.  

Calibrations should be performed in a vessel with similar characteristics to the actual process installation. Black 

plastic containers work best, minimizing reflectance problems in lower NTU solutions. ECD offers a TRITON® TR6 

Turbidity Calibration Kit that includes a TR6 Calibration Cup, 250 ml, 100 ml and 50 ml graduated cylinders and a 

1 liter volumetric flask. The kit provides the necessary laboratory equipment to make calibration standards from 

a 4000 NTU formazine stock solution and an easy to use calibration cup. This kit is ideal for calibration of inline 

pipe mounted TR6 turbidity sensors. 

Example of a mg/L Calibration: The process solution ranges around 3000 mg/L. A 2 liter sample was taken from 

the process and tested, it was determined to be 2850 mg/L. Keep one liter of the 2850 mg/L solution for the 

(100%) solution calibration and mix 500 mls of the 100% solution with 500 mls of deionized water, making the 
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(50%) solution, 1425 mg/L and one liter of deionized water (0%). Start the calibration in the deionized water in 

the calibration cup and accept 0.00 mg/L when prompted, then put the sensor into the 1425 mg/L solution and 

enter 1425 mg/L when prompted and finally into the 2850 mg/L solution and enter 2850 mg/L. Accept the 

calibration and put the sensor back into the process. 

Sensor Measurement Ranges Low Calibration Values High Calibration Values 

0-250 NTU and 0-1000 NTU 0 NTU, 125 NTU, 250 NTU   0 NTU, 500 NTU, 1000 NTU 

0-500 NTU and 0-2000 NTU 0 NTU, 250 NTU, 500 NTU 0 NTU, 1000 NTU, 2000 NTU 

0-1000 NTU and 0-4000 NTU 0 NTU, 500 NTU, 1000 NTU 0 NTU, 2000 NTU, 4000 NTU 

0-2000 NTU and 0-4000 NTU 0 NTU, 1000 NTU, 2000 NTU 0 NTU, 2000 NTU, 4000 NTU 

4.6.1 AUTO CAL 

The TRITON® TR6 turbidity sensors use a three point AUTO Cal sequence. Cal 1 is a zero point calibration, Cal 2 is 

a 50% of the measured range calibration and Cal 3 is a 100% of range calibration. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 

Press YES/NO Place Sensor in 0.00 NTU (or FNU, mg/L, ppm, % Solids)CAL Solution  

Press AUTO (CAL 1) STABILIZING, xx.xx NTU x.xx V, 0.00 NTU corrected Accept Cal 1? 

Press YES Place sensor in 50 % solution  

 STABILIZING, 492.0 NTU 1.18V, 500.0 ppm corrected, Accept Cal 2? 

Press YES/NO If suggested corrected value is not correct press NO, Enter CAL 2 Value 

Press ▲ ▼ NEXT xxxx.x NTU (use arrows and NEXT keys to enter Cal  value) 

Press OK xxxx.x NTU, xxx.x V, 500.0 NTU corrected Accept Cal 2? 

Press YES Place sensor in 100% solution 

 STABILIZING, 1000 NTU 2.46V, 1000.0 ppm corrected, Accept Cal 3? 

Press YES/NO If suggested corrected value is not correct press NO, Enter CAL 3 Value 

Press ▲ ▼ NEXT xxxx.x NTU (use arrows and NEXT keys to enter Cal  value) 

Press OK 1000 NTU, 2.46 V, 1000.0 NTU corrected Accept Cal 3? 

Press OK Calibration complete, returns to Cal Menu 

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.6.2 STANDARDIZE 

Standardize is an online/in process Zero Point Calibration Only. To change a non-zero value to a new value use 

the Slope feature in the Manual Cal section. (see below) Standardize is used to zero out the reflectance effects 

generated by the installation. The sensor will generate a mV signal in a zero NTU environment and this will be 

different than the zero point value recorded in the AUTO Cal. Standardize shifts the calibration curve to the new 

zero value. Perform a Standardize calibration with the sensor installed in the process line or tank and immersed 

in clear water only. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Place Sensor in Air or with the sensor in the process solution 
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Press STAND Enter Zero Value  

Press ▲ ▼ NEXT 0.00 NTU or ppm, mg/L, % Solids (use arrows and NEXT to enter process value) 

Press OK 0.00 NTU, Accept Value? 

Press YES Stand Cal Complete: 8.61 NTU, DESIRED VALUE: 0.00 NTU, OFFSET 8.61 NTU  

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.6.3 MANUAL CAL 

Manual Cal provides two options, OFFSET and SLOPE. OFFSET is an online/in process Zero Point Calibration 

Only. It is the same value that is adjusted in Standardize and it is the set same way. SLOPE is an adjustment of 

the NTU/volt aspect of the turbidity curve pivoting from the Offset point. The SLOPE window displays a unit less 

number that is changed to adjust the calibration. 

Example: TRITON® TR6 in 400 NTU solution but reads 380 NTU. The SLOPE reads 108. The slope of the 

calibration curve needs to increase so that the voltage that is generating 380 NTU will generate 400NTU. To 

determine the new slope, first divide the desired value (400 NTU) by the actual value (380 NTU) and multiply the 

current slope by that number. 400 NTU/380 NTU * 108 = 113.7 the new slope. Enter 113.7 in the SLOPE window, 

Save the calibration and the analyzer will read 400 NTU. 

SLOPE ADJUSTMENT 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Place Sensor in Air or with the sensor in the process solution 

Press MANUAL OFFSET or SLOPE 

Press SLOPE Enter SLOPE Value108.00 

Press ▲ ▼ NEXT  113.7 (use arrows and NEXT to enter process value) 

Press OK 113.7 Accept Value? 

Press YES Manual Cal Complete: OFFSET 8.61 NTU, SLOPE 113.7  

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.7 CONDUCTIVITY SENSORS 

AUTO Calibration recognizes Air for zero point (Cal 1) and 50µS, 100µS, 500µS, 1mS, 5mS, 10mS, 50mS and 

100mS solutions for the span (Cal 2). Any calibration solutions can be used but the conductivity value will have 

to be entered manually. Use a calibration standard near the conductivity of the process solution. Example uses 

air and 1mS. 

4.7.1 AUTO CAL USING AIR AND CONDUCTIVITY STANDARD 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes erases CAL Log in INFO, NO adds CAL to existing Log) 
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Press Yes/NO Remove the Sensor from Solution and dry the front end, Air = 0.00 µS  

To perform zero CAL press CAL 1, to skip zero cal press CAL 2, only if a zero cal was previously done on the sensor 

Press AUTO then CAL 1 STABILIZING, 0.00 µS, 1.17 V, 0.00 µS corrected, Accept Cal? 

Press YES CAL 1 Value 0.00 µS, Continue to CAL2? Move sensor to 1.00 mS solution  

Press YES STABILIZING, 1.00 mS, 98X.X mV, 1.000 µS corrected, Accept Cal? 

Press YES OFFSET:  0.00 ppm, 174.4 mV, SLOPE: 984 (data written to Log) 

Press OK Calibration complete  

Press HOME Hold is ON  

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.7.2 STANDARDIZE  

With the sensor in the process solution, take a grab sample from the process and determine the conductivity 

using a qualified laboratory conductivity meter. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes, erases CAL Log in INFO, NO adds CAL to existing Log) 

Press NO With the sensor in the process solution  

Press STAND Enter the laboratory determined conductivity value  

Press ▲ ▼ NEXT xxx.xx µS/mS (use arrows and NEXT to enter process value) 

Press OK xxx.xx µS/mS, xxx.x mV, Accept Value? 

Press YES OFFSET: 0.00 µS  1.0 mV, SLOPE: xx.xx mV/ppm (this data written to Log) 

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 

4.8 TDS CONDUCTIVITY SENSORS 

The Total Dissolved Solids measurement (TDS) on the Model T80 transmitter is made with an S80 conductivity 

sensor and a correlation factor. (Conductivity in µS x correlation factor = ppm)  

Conductivity is a measurement of a solution’s electrolytic conductivity, 1/ohms. The type of dissolved ions in the 

solution is irrelevant to the measurement. TDS is a measurement of concentration, ppm (mg/L). Since different 

salts contribute different amounts of conductivity to a solution, TDS measurements are only valid between 

solutions of the same chemical makeup. As an example, 1000 ppm of TDS in natural waters has a conductivity 

around 1400 µS (correlation factor 0.6712), 1000 ppm of KCl has a conductivity around 2000 µS (correlation 

factor 0.5000) and 1000 ppm of NaOH has a conductivity around 6000 µS (correlation factor 0.1667). All three 

solutions have a TDS of 1000 ppm but the conductivities are 1400 µS, 2000 µS and 6000 µS. A TDS measurement 

is only valid for a solution with the same chemical make up as the solution used for calibration.  

Calibration is accomplished in two steps; Step 1 Conductivity AUTO Calibration of the sensor (see section 4.7.1 

above) and then Step 2 correlation of conductivity to the TDS. The second step can be done by entering the 

correlation factor into the CONFIG →SENSOR→ TDS menu or by standardizing the sensor in a solution of known 

TDS in the CAL→STAND menu by entering the TDS value. Since the correlation of conductivity to concentration is 

not linear it is best to calibrate the sensor near the measured value. 
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4.8.1 STANDARDIZE  

With the sensor in the process solution, take a grab sample from the process and determine the TDS using a 

qualified laboratory method. 

Action Prompt 

Double Press any Button MENU HOME, Hold is OFF  

Press HOLD Hold freezes 4-20 mA Output and locks Alarm Relays during Calibration 

Press CAL Is this a new Sensor?  (Yes, erases CAL Log in INFO, NO adds CAL to existing Log) 

Press NO With the sensor in the process solution or calibration standard 

Press STAND Enter the laboratory determined TDS value  

Press ▲ ▼ NEXT xxx.xx ppm (use arrows and NEXT to enter process value) 

Press OK xxx.xx ppm, xxx.x mV, Accept Value? 

Press YES Current value: xx.xx ppm, Desired value: xx.xx ppm, Offset: xx.xx ppm 

Press OK Back to Cal Menu 

Press HOME Hold is ON (Press HOLD to turn off Hold) 

Press HOLD Turn off Hold 

Press EXIT Main Display 
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5.0 MAINTENANCE 
No periodic maintenance is required for the ECD Model T80 Transmitter. 

When you open the front cover and/or cable glands, make sure that the seals are clean and correctly fitted 

when the unit is re-assembled in order to maintain the housing’s NEMA 4X weatherproof integrity against water 

and water vapor. 

Fuse: There is a circuit board mounted fuse protecting the instrument. If you suspect that this needs to be 

replaced, contact the ECD service center for parts and instructions. 

5.1 CLEANING 

The Model T80 transmitter requires no periodic maintenance, except to make sure the front window is kept 

clean in order to permit a clear view of the display and allow proper operation of the navigation buttons. If the 

window becomes soiled, clean it using a soft damp cloth or soft tissue. To deal with more stubborn stains, a 

neutral detergent or spray cleaner like Windex may be used. Never use harsh chemicals or solvents. 
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6.0 TROUBLESHOOTING 
Symptom Probable cause Remedy 

Blank Display No Power 

 

 

Sensor Failure, causing power draw 

down below transmitter threshold 

 

Check power source, 24VDC loop, 

24VDC, 110/220VAC 

 

Unplug sensor from transmitter, 

replace sensor if instrument 

powers up. 

Incorrect Readings Sensor needs calibration 

 

 

Incorrect Temperature 

measurement 

 

Temperature Compensation set up 

incorrectly 

 

Perform a standardization 

calibration. See INFO for calibration 

log 

Calibrate/Trim Temperature to 

correct value 

 

Verify: 0.33% for pH, pIon 

              0.00% for ORP 

              4.0% for DO 

“Looking For Sensor” prompt Lost connection between sensor 

and transmitter 

Check sensor connection to 

transmitter, loose connector? 

Visually inspect cable for cuts or 

crushed areas, replace sensor if 

cable is compromised  
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7.0 PARTS AND ACCESSORIES 

7.1 FRONT PANEL CONTROL BOARD EXPLODED 

 

7.2 FRONT PANEL CONTROL BOARD EXPLODED, WITH RELAYS 

 

Item # Part # Description 

1 9630005 Spring, Mounting Screw Set 

2 9870621 Retaining Washer, Mounting Screw Set 

3 3600390 8-32 x 1” SS Screw, Mounting Screw Set 

4 3400152 Front Housing 

5 9560005 Sealing O-ring, grey silicone 

6 9240503-1 Touch pad membrane 

7 2101800-1 PCB, Control Board, Loop Powered 

7 2101800-2 PCB, Control Board, Loop Powered, Relays 

7 2101800-3 PCB, Control Board, Loop Powered, HART 

8 9870650 Locking Washer, PCB Screw Set 

9 9730905 6-32 x 5/16” SS Screw, PCB Screw Set 

10 9870620 Flat Washer, PCB Screw Set 

11 3400006-1 Control Board Cover 

12 9090112 24 VDC, 4-20 mA Terminal Block/2 pins 

13 9090114 Sensor Terminal Block/4 pins 

14 9090113 Serial connection Terminal Block/3 pins 

15 9090119 Relay Connection Terminal Block/9 pins 
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7.3 TRANSMITTER CASE, BACK WITH CABLE GLANDS 

 

Item # Part # Description 

1 3600449 Transmitter Case 

2 9360005 PVC Cable Gland, ½” NPT, Grey 

3 9300034 Locking Nut, ½” NPT, Steel 

4 9300017 Sealing ring, ½” elastomer 

5 9870650 Split Washer, PS mounting  

6 9870620 Flat Washer, PS mounting 

7 2101820-1 Power Supply Board 

8 9730604 6-32 x ¼” screw, SS, PS mounting 

7.4 REPLACEMENT PARTS 

Part # Description 

2000002-1 Front Panel, Loop-Powered 

2000002-2 Front Panel, AC/DC Powered 

2000002-3 Front Panel, Loop-Powered, Hart Output 

2101820-1 Power Supply Board, 110/220 VAC Input 

2101820-3 Power Supply Board, 110/220 VAC Input, w/preamp 

2101820-4 Preamp Board 

3400006 Control Board Cover 

9090112 Connector Plug, 2 Position (Loop, AC/DC, or Hart Versions) 

9090113 Connector Plug, 3 Position (Loop or AC/DC Versions) 

9090114 Connector Plug, 4 Position (Loop, AC/DC or Hart Versions) 

9090119 Connector Plug, 9 Position (AC/DC Version) 

9240503-1 Front Panel Membrane Switch 

9300017 Sealing ring, Cable Gland 

9300034 Locking Nut, Cable Gland 

9360005 Fitting, Cable Gland 

9830214 Screw, Front Panel 
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7.5 ACCESSORIES 

Part # Description 

2000006 Kit, Universal Mount 

2000007 Kit, Handrail Mount 

2000008 Kit, Panel Mount 

1000300-1 4-20 mA USB Data Logger 

9130007 Replacement Battery for Data Logger 

1000260-1 Sunshield for Pole Mount 

1000260-2 Sunshield for Rail Mount 
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8.0 S80 SENSORS 
S80 sensors are a family of digital sensors designed for use with ECD digital analyzers, the Model T80 transmitter 

or the Model C80 controller. S80 sensors accept the standard ECD electrode cartridges. The S80 sensors convert 

the analog signals into a temperature compensated digital protocol that allows two way communications with 

the transmitter. The type of sensor, identity and serial number are stored in the sensor’s memory along with 

three calibration registers. When connected to an ECD digital analyzer the sensor’s information is uploaded to 

the analyzer configuring the displays and outputs to the values appropriate to the sensor’s measured parameter. 

Connect an S80 pH sensor to a Model T80 Transmitter and the Transmitter configures itself into a calibrated pH 

transmitter. 

The internal components of the S80 sensors, the signal conditioner, temperature sensor and cable assembly are 

epoxy encapsulated inside the ¾” O.D. housing. Epoxy encapsulation of the components increases the reliability 

of the sensor by eliminating failures caused by wiring and connector breakage. The S80 sensors use the same 

easily replaceable electrode cartridges as the S10 and S17 sensor assemblies.  

8.1 S80 INSTALLATION 

Four typical installation configurations are available for ECD sensors: insertion, immersion, flow-through and 

valve-retraction. Although there are many ways to accomplish these mounting configurations, ECD recommends 

the following installation configurations. 

8.1.1 INSERTION 

The S80 sensor is installed using a ¾” MNPT compression fitting with choice of nylon, Teflon or 316 SS ferrule.  

The ¾” MNPT can be inserted into a pipe Tee or through a tank wall, the S80 is then inserted through the fitting 

and compression gland is tightened to secure the sensor in place. The torque specification for the gland fitting is 

20-ft/lbs. Over-tightening of the nut may swage the nylon or Teflon ferrules to the housing crushing the internal 

sensor components. 

 

 

8.1.2 IMMERSION 

The ¾” MNPT compression fitting is reversed and threaded into an extension/immersion pipe so the 

compression gland is facing the measurement end of the sensor. Feed the cable through the immersion tube, 

insert the S80 sensor at least 5” into the tube and tighten the sensor in place. 
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8.1.3 FLOW THROUGH 

Although the insertion configuration can be used as a flow-through mounting by inserting the S80 sensor into a 

pipe tee, ECD has various flow cells available for convenience. The flow cells are 2.0” diameter by 5” long, ported 

½” FNPT through and ¾” FNPT for the sensor. The flow cells are available in 316 Stainless Steel, PVC and Kynar. 

Use of the flow cell can facilitate an optional spray cleaning nozzle for the electrode. Connecting 40+ psi of water 

or air to the nozzle will remove particulate materials or biofilms from the sensor tip. Detergents or solvents can 

be used to remove greases or oils from the sensor while acids can be used for hard water scale. 

8.1.4 VALVE RETRACTABLE  

The S80 sensor is optionally designed for valve retraction service, (-1) Sensor Style. Mounting is directly into a 

process line or through a tank wall. The ball valve system allows the sensor to be removed from service without 

shutting down the line or emptying the tank. ECD recommends the valve-retraction mounting for ease of 

maintenance or in applications where the process line cannot be shut down and the pressure does not exceed 

100 psig. 

To remove the sensor from the valve assembly refer to the following directions: 

CAUTION:  Do not put hands or fingers between the safety lanyard cables and any part of the sensor. Use the 

external cable seal/handle to pull or guide the sensor through the valve. 

1. Loosen the small swage nut at the rear of the fitting assembly slowly as this compression fitting is 

holding the sensor in place. CAUTION the sensor may snap back quickly if it is under pressure. (do not 

remove the nut from the body of the fitting).  

2. Slide the sensor to its stop by pulling it through the ball valve. The safety lanyards will be extended, 

confirming that the sensor is fully retracted. Note: the safety lanyards are redundant protection; the 

sensor will come to a stop when the high pressure stop reaches the front of the retainer fitting. 

3. Close the ball valve. 

4. Remove the handle retaining nut and the valve handle. 

5. Remove the safety lanyards from the valve stem. 

6. For the stainless steel ball valves, loosen and remove the large retainer nut from the retainer fitting. For 

Kynar ball valves, loosen and remove the union nut on the sensor side of the ball valve. 

7. Firmly pull the retainer fitting from the valve. The sensor will be removed with the fitting.  
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8.1.5 FLANGE FITTINGS 

Flange mountings can be accomplished with the insertion and valve-retraction configurations using the desired 

flange and by mounting the gland fitting or valve-retraction assembly to the flange.  

8.2 S80 PART NUMBER CONFIGURATOR 

S80 sensors are available in five measurement types, (-0) a millivolt style for pH, ORP and ion selective 

measurements, (-1) dissolved oxygen style, (-2) contacting conductivity style, (-3) inductive conductivity style 

and (-4) resistivity style. Each style is available in a variety of materials and insertion lengths. 

S80  Digital Sensor  

 Measurement Type 

-0   S80 Digital Sensor, pH, ORP, pION measurement 

-1   S80 Digital Sensor, Dissolved Oxygen measurement 

-2   S80 Digital Sensor, Contacting Conductivity, 1µS to 50 mS 

-3   S80 Digital Sensor, Inductive Conductivity, 50 mS to 1000 mS 

-4   S80 Digital Sensor, Resistivity 

-5  S80 Diagnostic Sensor, pH, ORP, pION measurement    SENTINEL S80 Sensor 

 Sensor Style 

0  Insertion Style (Standard) 

1  Valve Retractable Style with flanged blow out protector 

 Housing Material 

-0  Stainless Steel, ¾” O.D., (Standard) 

-1  Titanium, ¾” O.D. 

-2  Hastelloy, ¾” O.D. 

-4  Kynar, ¾” O.D., Inductive Conductivity Only 

-9  Other Material, Consult with Factory 

 Housing Length 

0  10” length, ¾” O.D. 

1  17” length, ¾” O.D. 

2  24” length, ¾” O.D. 

3  30” length, ¾” O.D. 

4  36” length, ¾” O.D. 

 Process Connection 

00  No Fitting or Valve Assembly 

01  (75)       ¾” MNPT SS Fitting with Nylon Ferrule 

02  (75HT)    ¾” MNPT, 316 SS gland, Teflon ferrule 

03  (75SF)     ¾” MNPT, 316 SS gland, SST ferrule 

04  (75HC)    ¾” MNPT, Hastelloy gland, Teflon ferrule 

05  (75TT)     ¾” MNPT, Titanium gland, Teflon ferrule 

06  (75PP)     ¾” MNPT, All Polypropylene gland fitting 

07 (75K)       ¾” MNPT, All Kynar gland Fitting  

08  (75TFE)   ¾” MNPT, All Teflon gland fitting 

29  Other Fittings, Consult Factory 

30  (VSS)       1” NPT 316 Stainless Steel Valve Retraction Assembly, nylon 

31  (VSSHT) 1” NPT 316 Stainless Steel Valve Retraction Assembly, Teflon 

32  (VSSE)     1” NPT 316 Stainless Steel Valve Retraction Assembly Toroidal 

33  (VHC)      1” NPT Hastelloy Valve Retraction Assembly 

34  (VTT)       1” NPT Titanium Valve Retraction Assembly 

36  (VPP)      1” NPT All Poly Propylene Valve Retraction Assembly 

37  (VKY)      1” NPT All Kynar Valve Retraction Assembly 

59  Other Assemblies, Consult Factory  

80  1/1.5” Sanitary Flange, 316ss, Viton o-rings, nylon ferrule 

81  2” Sanitary Flange, 316ss, Viton o-rings, nylon ferrule 

82  2 ½” Sanitary Flange, 316ss, Viton o-rings, nylon ferrule 

99  Other Fittings, Consult Factory 

 Cable Length 

-0  10 ft. (Standard) 

-2  20 ft. 

-3  30 ft. 

-4  40 ft. 

-5  50 ft. 

-A  100 ft. 
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 “T” Handle 

0  No “T” Handle 

1  “T” Style handle, ¾” polypro fitting 

2  “T” Style handle, ¾” stainless steel fitting 

3  “T” Style handle with Lanyards 

 Detachable Cable Connector 

0  None 

1  Straight (axial) Connector 

2  Right Angle Connector 

 O-rings Guard & Fittings 

0  Viton Any/All 

1  HF Viton Cond Guard 

2  EPR Cond Guard 

3  Kalrez Cond Guard 

4  CV75 Cond Guard 

5  HF Viton Valve & Fitting 

6  EPR Valve & Fitting 

7  Kalrez Valve & Fitting 

9  CV-75 Valve & Fitting 

A  HF Viton Grd & Val & Fit 

B  EPR Grd & Val & Fit 

C  Kalrez Grd & Val & Fit 

D  CV-75 Grd & Val & Fit 

S80 -0 0 - 0 0 01 -0 1 1 0 

8.3 TRITON® DO80 SENSORS 
DO80 Dissolved Oxygen Sensor 

 Sensor Style 

-0   (I) Immersion Style Sensor - ¾” MNPT Mounting Thread 

-1   (IM) Immersion Style Sensor - G1 thread Mounting Thread 

-2   (F) Flow Cell and Sensor - ¾” FNPT entries 

-3   (FM) Flow Cell and Sensor – 1” Slip entries 

 Spray Cleaner 

00   No Spray Cleaner 

01   (SC) Spray Cleaner 

02   PVC Compression Fitting, DO80 to 1¼” MNPT 

 Cable Style 

-0   Fixed Cable 

-1   (DA) Axially Detachable Cable 

 Cable Length 

00  No Cable 

10 10 ft (3 meters) 

20 20 ft (6.1 meters) 

30 30 ft (9.1 meters) 

40 40 ft (12.2 meters) 

50 50 ft (15.2 meters) 

X0 Specify Length 

DO80 -1 00 -1 10 

8.4 TRITON® TR6 SENSORS 
TR6 Turbidity Suspended Solids Sensor 

 Optical Style 

1   Front Mounted Optics, for use with Immersion assembly 

2   Side Mounted Optics, for use with Immersion assembly 

3   Side Mounted Optics, for use with Flow Through Cell 

 Process Connection 

0   None 

1   1” MNPT Nylon Gland Fitting 

2   Flow Through Cell, 2 x 2” FNPT entries, 1 x 1” FNPT sensor port 

 Cable Type and Length 

01   10 ft (3.0 meters) (Waterproof/Submersible Cable Style) 
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02   20 ft (6.1 meters) (Waterproof/Submersible Cable Style) 

03   30 ft (9.1 meters) (Waterproof/Submersible Cable Style) 

04   10 ft (3.0 meters) (Water Resistant Cable Style) 

05   20 ft (6.1 meters) (Water Resistant Cable Style) 

06   30 ft (9.1 meters) (Water Resistant Cable Style) 

 Measurement Range 

0   0-250 NTU and 0-1000 NTU 

1   0-500 NTU and 0-2000 NTU 

2   0-1000 NTU and 0-4000 NTU 

3   0-2000 NTU and 0-4000 NTU 

TR6 3 2 01 1 
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8.3 S80 SENSOR MAINTENANCE 

All electrochemical sensors require periodic cleaning and/or replacement. The life of an electrode is dependent 

on the process conditions it is exposed to, a pH electrode may last a year or longer in potable water and only a 

few weeks in a hot caustic bath. The chemical constituents in the process may coat the electrode surfaces 

requiring the electrode to be removed and cleaned or replaced.  

Cleaning agents should be specific to the type of coating, detergents and alcohols for removing greases and oils, 

acids for removing hard water scales and metallic deposits or spray washing for flocculants and biofilms.  

8.3.1 ELECTRODE CARTRIDGE INSTALLATION 

Unless ordered separately, electrode cartridges are generally shipped installed in a sensor. Sensors ordered 

without an electrode are shipped with a shipping plug to keep contamination from getting inside the sensor 

during shipment or storage. The following procedure explains how to install the electrode cartridge in the sensor 

assembly: 

1. Remove the shipping plug by turning it counterclockwise.  

2. Remove the electrode cartridge from the protective soaker boot. Be careful not to flex the electrode 

body while removing the tape and the protective boot.  

3. Rinse the electrode tip in tap water and wipe the electrode body dry then lubricate the o-ring seals with 

the included lubricant. Save the protective soaker boot in the event the electrode must be stored at a 

future time.  

4. Carefully insert the electrode cartridge into the sensor assembly by turning until hand tight. The first o-

ring, closest to the front of the electrode, will be slightly visible if held horizontally.  

NOTE: IF EXCESS FORCE IS REQUIRED DURING ELECTRODE INSTALLATION, CHECK FOR PROPER THREAD 

ENGAGEMENT OR FOR AN OBSTRUCTION. 

8.3.2ELECTRODE CARTRIDGE REPLACEMENT  

Periodic replacement of the electrode cartridge is required for pH, ORP and Specific Ion sensors. The following 

procedure explains how to replace the electrode cartridge in the sensor assembly: 

1. Remove the electrode cartridge from the front of the sensor assembly by turning it counterclockwise.  

2. For installation procedure follow steps 2, 3, and 4 in section 8.3.1 electrode cartridge installation.  

8.3.3 ELECTRODE CLEANING 

An important aspect of sensor maintenance is the service of the electrode cartridge. After being in operation, an 

electrode may begin to exhibit slow response or non-reproducible measurements. This may be due to coating of 

the measurement electrode or clogging of the reference junction. Regular electrode cleaning reduces problems 

associated with the coating and clogging. Frequency of cleaning will depend on the process and application. The 

following procedures are used to clean pH and ORP electrodes. 

If possible, the electrode should be cleaned without removing it from the sensor body. However, if the electrode 

must be removed, the o-rings must be inspected and re-lubricated. See section 3.10. 
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8.3.4 PH ELECTRODE CARTRIDGE CLEANING 

Remove the sensor from the process and carefully wash the wetted end of the electrode cartridge in a mild 

solution of detergent and water or with methyl alcohol. If the electrode response is not improved, soak the 

electrode in 0.1 Molar HCl for 5 minutes. Remove and rinse the electrode with tap water and soak in 0.1 Molar 

NaOH for 5 minutes. 

Remove the electrode from the NaOH solution, rinse the electrode and soak in a 4 pH buffer solution for 10 

minutes. This should improve the response of the electrode. If not, replace the electrode. 

If the electrode must be left out of the process for an extended period of time, store it in a solution of water 

saturated with KCl or a 4.0 pH buffer solution. ECD does not recommend the storage of electrodes in distilled or 

deionized water. 

8.3.5 ORP ELECTRODE CARTRIDGE CLEANING 

Cleaning the platinum surface to remove coating can be done using an abrasive cleaner like 600-800 grit wet/dry 

sand paper or chemical reagents specific for the type of coating. Abrasive cleaning is the most common method 

of cleaning and is usually sufficient to restore the platinum surface; however, some processes can form a hard 

coating requiring chemical cleaning with a strong acid solution. Acid solutions greater than 10% are not 

recommended. 

8.3.6 PION ELECTRODE CARTRIDGE CLEANING 

Ion selective electrodes require periodic service. Weekly checks should be performed to assure the accuracy of 

the measurement. 

The ion selective crystal that senses the ion concentration can become sluggish in response due to coating or 

reactions with the process solution. Periodic cleaning or polishing will minimize drift and maintain the sensors 

response. 

CLEANING 

The solid state crystal based electrodes, bromide, chloride, copper, cyanide, fluoride, silver, sulfide are fairly 

robust and can be cleaned with alcohols, detergents or dilute acids to remove coatings caused by greases, oils or 

films. A soft tooth brush or paper towel should be used to remove stubborn coatings. Do not clean with a wire 

brush. Metal carryover from the brush will compromise the measurement. Cleaning should be followed by 

polishing before calibrating the sensor. 

The PVC membrane sensors, Ca++, K+, NH4+, NO3- are fragile membranes and should be cleaned using a soft 

artist style paint brush while rinsing with a stream of water. Dilute dish washing detergents can be used to 

remove oily films Solvents or strong acid/alkaline solution will irreparably harm the electrode. 

Calibration may be necessary after cleaning. 

POLISHING 

Abrasive polishing is only recommended for the solid state crystal style Combination Electrodes. ECD supplies 

two styles of abrasive cleaning kits, a package of light blue colored polishing strips or a small vial of 0.3 micron 

alumina powder with Q-tips with the fluoride electrodes. 

The sensing surface of solid state electrodes can wear over time, which causes drift, poor reproducibility and 

loss of response in low level samples. The electrode can be restored by polishing the sensing surface with a 

polishing kit. The polishing kit can also be used if the sensing surface has been etched or chemically poisoned. 
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Fluoride Electrodes 

a. Moisten the end of the Q-tip with water and dip it in the alumina polishing powder to pick up a 

small amount of the powder. 

b. Rub the polishing powder onto the fluoride crystal in a circular motion and moisten the tip if 

necessary to produce a liquid consistency more than a paste.  

c. Polish the electrode for about 30 seconds and examine the tip for a shiny surface, repeat if 

necessary.  

d. Rinse the electrode with distilled water and soak the electrode in a low ppm Calibration solution 

for a few minutes. 

e. Perform a Two Point Calibration. 

Other Solid State electrodes, Bromide, Cadmium, Chloride, Copper, Lead, Sulfide, Silver… 

a. Place a few drops of distilled water on the blue polishing strip to wet the polishing surface.  

b. Hold the electrode with the sensing surface facing up. 

c. Slide the polishing strip back and forth across the electrode tip, the sensing tip will be abraded 

and a new electrode surface will be generated. 

d. Polish the electrode for about 30 seconds and examine the tip for a shiny surface, repeat if 

necessary.  

e. Rinse the electrode with distilled water and soak the electrode in a low ppm Calibration solution 

for a few minutes. 

f. Perform a Two Point Calibration. 

8.3.7 DISSOLVED OXYGEN CARTRIDGES 

The Teflon membrane of the Dissolved Oxygen sensors is fragile and should be cleaned using a soft cloth or an 

artist style paint brush while rinsing with a stream of water. Dilute dish washing detergents can be used to 

remove oily films. Solvents are not recommended as they could diffuse through the membrane and harm the 

electrode. Strong acid/alkaline solutions should not harm the electrode but should only be used as a last resort 

before replacing the electrode. 

8.3.8 TRITON DO80 DISSOLVED OXYGEN 

The Triton DO80 sensor should receive maintenance on a regular basis. The maintenance interval should be 

determined empirically as it will depend on the installation conditions and the nature of the media being 

measured. The interval should be no greater than every two months. 

Maintenance Procedure 

The typical procedure would include; 

• Cleaning the sensor (See section 5.2) 

• Check the measuring function: 

o Remove the sensor from the medium. 

o Clean and dry the sensor/membrane. 

o After about 10 minutes in air, measure the oxygen saturation index (without recalibration). 

o The measured value should be at 100 ± 4 % SAT 

• If necessary, replace a defective membrane or one which cannot be cleaned any more. 

• Recalibration, if necessary. 
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Cleaning the Sensor 

The fluorescence cap of the Triton DO80 sensor must be clean to ensure an accurate measurement. The 

measurement will degrade as the fluorescence cap gets coated. Build-up of material on the cap will increase the 

response time and decrease the slope. The sensor should be cleaned on a regular basis and before every 

calibration. 

*** Do Not Scrub the Sensing Portion of the Cap with any abrasive material, use only a soft sponge or cloth 

and water to clean the tip*** 

The cleaning method depends on the nature of the coating. For insoluble mineral or salt deposits, the sensor 

should be soaked in a 1-5 % solution of HCl, hydrochloric acid, for no more than 10 minutes. After this acid 

treatment rinse the sensor with copious amounts of tap water and then allow it to soak in the tap water for at 

least 5 minutes before evaluating the performance. Repeat if necessary. 

For biological films or dirt, rinse the tip with tap water and gently wipe the sensing surface with a soft sponge or 

cloth. 

Cleaning Internal Optics 

The internal optical surface should only need cleaning if the Fluorescence Cap is broken or defective. The 

following steps should be followed in the case of a leaking cap. 

1. Unscrew the protective guard and the fluorescence cap from the sensor head. 

2. Carefully clean the optical surface with a soft cloth and water until the buildup is fully removed. 

3. Use only drinking or distilled water to clean the optics, do not scratch the optical surface. 

4. Dry the optics with a soft lint free cloth and screw on a new fluorescence cap. 

8.3.8.1 Replacing the Fluorescent Cap 

The Fluorescence Cap (P/N 2500207) can provide up to two years service, if damaged or when it expires, it is 

easily replaced.  

Removing the Old Fluorescence Cap 

• Remove the sensor from the medium. 

• Unscrew the protection guard. 

• Clean the outside of the sensor. 

• Unscrew the fluorescence cap. 

• Clean and dry the optical surface if necessary. 

Installing the New Fluorescence Cap 

• Make sure that there are no dirt particles on the sealing surface. 

• Visually inspect the sealing o-ring, replace if necessary. (P/N 1000225) 

• Carefully screw the fluorescence cap onto the sensor head until the stop. 

• Screw the protection guard back on. 

*** After replacing the Fluorescence Cap the sensor must be calibrated. *** 

8.3.9 TRITON TR6 TURBIDITY 
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The TR6 turbidity sensors don’t require periodic service except in coating applications. Quarterly checks should 

be performed to assure the accuracy of the measurement. 

The TR6 response can become sluggish due to coating from materials in the process solution. Periodic cleaning 

will minimize drift and maintain the sensors response. 

CLEANING 

The most important maintenance item is keeping the optically clear epoxy window clean. The TR6 turbidity 

sensors are fairly robust and can be cleaned with alcohols, detergents or dilute acids to remove coatings caused 

by greases, oils or films. Do not use solvents such as MEK, Toluene, Acetone, or trichloroethylene on TR6 

sensors. A soft tooth brush or paper towel should be used to remove soft coatings. A Scotch Brite scouring pad 

works well for most types of stubborn window fouling. First wet the pad and then place it on a counter with a 

plastic-laminate top so that the side of the pad is aligned with the edge of the counter. Work the window of the 

TR6 sensor back and forth on the pad until it is clean while removing as little epoxy as possible. If encrusting 

organisms such as barnacles or tube worms have attached to the sensor, it will have to be gently scraped with a 

flexible knife blade prior to using the pad.  

POLISHING  

Some applications will result in pitting of the sensor face. Pits can be removed with abrasive cloth. Polish the 

sensor window as follows:  

1) Tape a strip of 400 grit wet-or-dry abrasive cloth to the edge of a counter.  

2) Add a few drops of water to the abrasive and work the sensor window in smooth one-way 

strokes on the cloth using the counter edge as a guide.  

3) Continue until the sensor is shiny and pit free. 

It is important to remove as little epoxy as possible. 
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8.4 S80 SENSOR SPECIFICATIONS 

Dimensions: 

S80 - ¾”OD x 10” Length, optional lengths, 17”, 24”, 30”, 36” .… in 6” increments to 8 ft. 

Cable Length: 

10 ' standard, Optional lengths in 10 ' increments 

4 conductors shielded  

Housing Materials: 

Standard, 316 Stainless Steel, Optional, Titanium (T), grade 2, Hastelloy (H), C-22, PVDF (K),  

O-Ring Materials: 

Viton™ (VIT), Standard, Ethylene Propylene (EPR), Optional, Fluoro-silicone (FSIL), Optional, Silicone (SIL), 

Optional, KALREZ™ (KLZ), Optional, CV75 (CV), Optional 

Process Connections: 

-75  ¾” 316 SS gland fitting with nylon ferrule 

-75PP  ¾” poly propylene gland fitting with ferrule 

-75SF  ¾” 316 SS gland fitting with stainless steel ferrule 

-75TFE  ¾” Teflon™ gland fitting with Teflon™ ferrule 

-100 1” Teflon™ glands fitting for PVDF housing only 

-VSS  1” 316 SS valve retraction assembly 

-VKY  1” PVDF valve retraction assembly 

Shipping Weight: 

S80 2.5 lbs (1.2 kg) 

S80 with VSS 5.8 lbs (2.65 kg)  

8.4.1 PH ELECTRODES 

Part# Description pH Range Temperature Max. Pressure 

2005005-HPW 
High Purity Water, RADEL Body, dbl jct TFE Ref, Full 

bulb pH glass, 
2-12 pH -10°-90°C 150 psig 

2005145 
General Purpose, RADEL body, dbl jct TFE Ref, Flat pH 

glass, 
0-14 pH -10°-90°C 150 psig 

2005146 
General Purpose, PEEK body, dbl jct ceramic Ref, Flat 

pH glass, 
0-14 pH -10°-90°C 150 psig 

2005148 
Non aqueous service, RADEL body, dbl jct TFE Ref, Flat 

pH glass, 
0-14 pH -10°-90°C 150 psig 

2005157 
Hi Temp/ Hi pH, PEEK body, dbl jct TFE Ref, Hemi pH 

glass, 
0-14 pH 0°-130°C 150 psig 

2005059 
Recessed Bulb, RADEL Body, dbl jct TFE Ref, Hemi pH 

glass, 
0-14 pH -10°-90°C 150 psig 

2005066 
Chemical Resistant, PEEK body, triple jct TFE Ref, Flat 

pH glass, 
0-14 pH 0°-130°C 150 psig 

2005169 
Chemical Resistant, PEEK body, dbl jct TFE Ref, Hemi 

pH glass, 
0-14 pH 0°-130°C 150 psig 

2005130 
Sulfide Resistant, PEEK body, triple jct TFE Ref, Hemi 

pH glass, 
0-14 pH 0°-130°C 150 psig 

2005150 
Solvent Resistant, PEEK body, dbl jct TFE Ref, Flat pH 

glass, 
0-14 pH -10°-90°C 150 psig 
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2005103 
Fluoride resistant, Peek body, Rugged pH glass, dbl jct 

TFE Ref, 
0-14 pH -10°-90°C 150 psig 

2005013 pH, antimony, RADEL body, TFE junction 3-10 pH 10°-50°C 150 psig 

8.4.2 ORP ELECTRODES 

Part#: 2005167 (2005367 SENTINEL) 

ORP sensor: Platinum  

Construction: PEEK body,  

Reference Electrode: double porous Teflon junction  

Measurement Range: -1500 mV - +1500 mV 

Temperature Range: -10° - 80°C 

Pressure Range: 150 psig 

8.4.3 DISSOLVED OXYGEN 

Part#: 2005622 

2 mil Teflon membrane 

Galvanic cell: Silver/Lead 

Construction: PEEK body,  

Measurement Range: 0-20 ppm 

Temperature Range: -10° - 130°C 

Pressure Range: 30 psig 

8.4.4 AMMONIUM ELECTRODE 

Part #: 2005083 (2005383 SENTINEL) 

ISE sensor: PVC membrane  

Construction: Radel (PES) body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.05 - 18,000 ppm  

pH Range: 2-10 pH  

Temperature Range: 0°- 40°C  

Pressure Range: 50 psig 

8.4.5 BROMIDE ELECTRODE 

Part #: 2005062 (2005362 SENTINEL) 

ISE sensor: solid state AgS/AgBr membrane  

Construction: Radel (PES) body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0. 1 - 80,000 ppm  

pH Range: 2-12 pH  

Temperature Range: 0°-50°C  

Pressure Range: 150 psig 

8.4.6 CALCIUM ELECTRODE 

Part #: 2005043 (2005343 SENTINEL) 

ISE sensor: PVC membrane  

Construction: Radel (PES) body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.1 - 40,000 ppm  

pH Range: 2.5 - 10 pH  
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Temperature Range: 0°-40°C  

Pressure Range: 50 psig 

8.4.7 CHLORIDE ELECTRODE 

Part #: 2005008 (2005308 SENTINEL) 

ISE sensor: solid state AgS/AgCl membrane  

Construction: Radel (PES) body,  

Reference Electrode: double porous Teflon junction   

Measurement range: 2 - 35,000 ppm  

pH Range: 2-12 pH  

Temperature Range: 0°-80°C  

Pressure Range: 150 psig 

8.4.8CUPRIC ELECTRODE 

Part #: 2005058 (2005358 SENTINEL) 

ISE sensor: solid state CuS membrane  

Construction: Radel (PES) body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 1 ppb – 6,300 ppm  

pH Range: 2 - 8 pH  

Temperature Range: 0°-80°C  

Pressure Range: 150 psig 

8.4.9 CYANIDE ELECTRODE 

Part #: 2005042 (2005342 SENTINEL) 

 ISE sensor: solid state AgS/AgCN membrane  

Construction: Radel (PES) body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.1- 260 ppm  

pH Range: 11-13 pH  

Temperature Range: 0°-80°C  

Pressure Range: 150 psig 

8.4.10 FLUORIDE ELECTRODE 

Part #: 2005163 (2005363 SENTINEL) 

ISE sensor: solid state LaF crystal  

Construction: PEEK body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.02 - 2,000 ppm  

pH Range: 5-8 pH  

Temperature Range: 0°- 80°C  

Pressure Range: 50 psig 

8.4.11 POTASSIUM ELECTRODE 

Part #: 2005034 (2005334 SENTINEL) 

ISE sensor: PVC membrane  

Construction: Radel (PES) body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.1- 40,000 ppm  

pH Range: 2-12 pH  
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Temperature Range: 0°-40°C 

 Pressure Range: 50 psig 

8.4.12 SILVER ELECTRODE 

Part #: 2005016 (2005316 SENTINEL) 

ISE sensor: solid state AgS membrane 

Construction: PEEK body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.1-107,000 ppm 

pH Range: 2-14 pH  

Temperature Range: 0°-80°C  

Pressure Range: 150 psig 

8.4.13 SODIUM ELECTRODE 

Part #: 2005031 (2005331 SENTINEL) 

ISE sensor: Sodium selective Glass membrane 

Construction: PEEK body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.2 - 23,000 ppm  

pH Range: 2-14 pH (pH must be 3 units higher than pNa) 

Temperature Range: 0°-80°C 

 Pressure Range: 150 psig 

8.4.14 SULFIDE ELECTRODE 

Part #: 2005122 (2005322 SENTINEL) 

ISE sensor: solid state AgS membrane 

Construction: PEEK body,  

Reference Electrode: double porous Teflon junction  

Measurement range: 0.01 - 32,000 ppm  

pH Range: 11-14 pH  

Temperature Range: 0°-80°C  

Pressure Range: 150 psig 

8.4.15 TRITON® DO80 

Measurement Range:  0 - 20 mg/l (0 - 20 ppm) 

0 - 200 % Saturation 

0 - 400 mbar (0 - 6 psi) 

Pressure Range:   Maximum Pressure 10 bar (159 psi) 

Temperature Range:  -5° - 50°C (20° - 120°F) Measuring 

-20° - 60°C (0° - 140°F) Ambient 

Response Time:   T90 = 60 sec 

Accuracy:   Max. Error < 2 % of measured range 

Repeatability:   ±0.5 % of measured range 

Resolution:   0.01 ppm or 0.01 % Saturation 

Operating Lifetime of Sensor Cap: Up to 2 years in recommended service, typically > 1 year 

Wetted Materials:  316 SS, POM, PVC, Silicone 

Sensor Cable:   Shielded 7 core cable, 7 meter (23 ft) or 15 meter (49 ft) lengths 

Process Connection:  G1 Thread (¾” FNPT adapter available) 

Maximum Cable Length: 100 m maximum from C-22 controller 

Dimensions:   Length 8.7” (220 mm), Diameter 1.6” (40 mm) 
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Weights:   Cable length 7 m (23 ft): 0.7 kg (1.5 lbs) 

   Cable length 15 m (49 ft): 1.1 kg (2.4 lbs) 

8.4.16 TRITON® TR6 

Measuring principle: 

Particle caused back scattering of 850 nm near infrared light with sunlight rejection filter 

Measuring Range: 

-1 Sensor 

0.0 ... 250.0 NTU, FNU & 0 ... 1000 NTU, FNU 

-2 Sensor 

0.0 ... 500.0 NTU, FNU & 0 ... 2000 NTU, FNU 

-3 Sensor 

0 ... 1000 NTU, FNU& 0 ... 4000 NTU, FNU 

-4 Sensor 

0 ... 2000 NTU, FNU & 0 ... 4000  

NTU, FNU ppm, mg/L and %solids to equivalent NTU value  

Accuracy: 

2% of reading or 0.5 NTU, whichever is larger 

Process Temperature Range: 

–5 ... 50°C 

Temperature Compensation: 

Internal Temperature compensation 

Process pressure range: 

50 psi maximum in Flow Cell  

500meter submersion depth (50 bar, 725 psi) 

Vacuum operation is not permitted 

Drift: 

< 1% / month 

Wetted Materials 

Sensor body: stainless steel AISI 316 Ti 

Sensing end: epoxy 

Process Connection: 

1” NPT Nylon compression fitting 

Electrical connection 

Waterproof 5-wire measuring cable or 

Water Resistant 5-wire measuring cable (Standard) 

Cable Length: 

10ft. (3.0 m), 20ft (6.1 m), 30ft (9.1 m) cables  
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APPENDIX 

A. AUTO CAL BUFFER TABLES 

°C pH pH pH 

0 4.00 7.115 10.32 

5 4.00 7.085 10.25 

10 4.00 7.06 10.18 

15 4.00 7.04 10.12 

20 4.00 7.015 10.06 

25 4.005 7.00 10.01 

30 4.015 6.985 9.97 

35 4.025 6.98 9.93 

40 4.03 6.975 9.89 

45 4.045 6.975 9.86 

50 4.06 6.97 9.83 

55 4.075 6.97  

60 4.085 6.97  

65 4.10 6.98  

70 4.13 6.99  

75 4.14 7.01  

80 4.16 7.03  

85 4.18 7.05  

90 4.21 7.08  

B. T80 HART MENU 
T80 Root Menu 

1 DEVICE SETUP

 

DEVICE SETUP CALIBRATION    

1 CALIBRATION 1 AUTO    

2 STANDARDIZE    

3 MANUAL    

4 TEMP    

    

2 BASIC SETUP CONFIG    

1 XMTR XMTR CONFIG ANALOG CONFIG  

1 ANALOG 1 SCALE ANALOG SCALE 

1 UPPER 

2 LOWER 

 

2 PID PID CONFIG 

1 P Term 

2 I Term 

3 D Term 

 

3 CALIBRATE CALIBRATE 

1 Zero cal 

2 Gain cal 

3 Save 

2 ALARMS ALARM CONFIG  

1 Alrm 1 thresh  

2 Alrm 1 hyst  
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3 Alrm 1 dly on  

4 Alrm 1 dly off  

5 Alrm 2 thresh  

6 Alrm 2 hyst  

7 Alrm 2 dly on  

8 Alrm 2 dly off  

9 Alrm 3 thresh  

10 Alrm 3 hyst  

11 Alrm 3 dly on  

12 Alrm 3 dly off  

3 Address   

    

2 Device 

information 

DEVICE 

INFORMATION 

  

1 Distributor   
2 Model   
3 Dev ID   
4 Cfg chng count   
5 Tag   
6 Long tag   
7 Date   
9 Descriptor   
10 Message   
11 Final asmbly num   

3 INFORMATION INFORMATION    

1 XMTR XMTR INFO   

1 Serial #   

2 FW Rev   

3 HW Rev   

4 Fld dev rev   

   

2 SENSOR SENSOR INFO   

1 Serial #   

2 FW Rev   

3 HW Rev   

   

3 DEVICE DEVICE 

INFORMATION 

  

1 Distributor   

2 Model   

3 Dev ID   

4 Cfg chng count   

5 Tag   

6 Long tag   

7 Date   

9 Descriptor   

10 Message   

11 Final asmbly 

num 

  

2 PV      

3 Temperature      

4 Output %      

5 Sensor Name      
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C. TEXT/ICON LEGEND 

The Text button is paired with its corresponding Icon Button 
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MODBUS RTU REGISTER LISTING 

03 (0X03) READ HOLDING REGISTERS 

This function code is used to read the contents of a contiguous block of holding registers in a remote device.  

The Request Protocol Data Unit specifies the starting register address and the number of registers.  In the 

Protocol Data Unit Registers are addressed starting at zero.  Therefore registers numbered 1-16 are address as 

0-15. 

The register data in the response message are packed as to bytes per register, with the binary contents right 

justified within each byte.  For each register, the first byte contains the high order bits and the second contains 

the low order bits. 

Request 

Modbus ID (Slave Address) 1 Byte 1 to 247 (0x01 to 0xF7) 

Function code 1 Byte 0x03 

Starting Address 2 Bytes 0x0000 to 0xFFFF 

Quantity of Registers 2 Bytes 1 to 125 (0x01 to 0x7D) 

CRC 2 Bytes calculated 

Response 

Modbus ID (Slave Address) 1 Byte 1 to 247 (0x01 to 0xF7) 

Function code 1 Byte 0x03 

Byte Count 1 Byte 2 X N* 

Register Value(s) *N X 2 Bytes   

CRC 2 Bytes calculated 

*N = Quantity of Registers 

Error 

Modbus ID (Slave Address) 1 Byte 1 to 247 (0x01 to 0xF7) 

Error Code 1 Byte 0x86 

Exception Code 1 Byte 01, 02, 03 or 04 

CRC 2 Bytes calculated 

06 (0X06) WRITE SINGLE REGISTER 

This function code is used to write a single holding register in a remote device.   

The Request Protocol Data Unit specifies the address of the register to be written.  Registers are addressed 

starting at zero.  Therefore register number 1 is addressed as 0.   

The normal response is an echo of the request, returned after the register contents have been written. 

Request 

Modbus ID (Slave Address) 1 Byte 1 to 247 (0x01 to 0xF7) 

Function code 1 Byte 0x06 

Register Address 2 Bytes 0x0000 to 0xFFFF 

Register Value 2 Bytes 0x0000 to 0xFFFF 

CRC 2 Bytes calculated 

Response 

Modbus ID (Slave Address) 1 Byte 1 to 247 (0x01 to 0xF7) 

Function code 1 Byte 0x06 

Register Address 2 Bytes 0x0000 to 0xFFFF 
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Register Value 2 Bytes 0x0000 to 0xFFFF 

CRC 2 Bytes calculated 

*N = Quantity of Registers 

Error 

Modbus ID (Slave Address) 1 Byte 1 to 247 (0x01 to 0xF7) 

Error Code 1 Byte 0x86 

Exception Code 1 Byte 01, 02, 03 or 04 

CRC 2 Bytes calculated 

REGISTERS 

Per the Modbus Application Protocol Specification (V1.1b) 
Name Meaning (2 bytes each register) Number 

of 

Registers 

Return 

Data 

Format 

Read 

Write 

Requires 

Storage 

Initiate 

Register # 

dec hex 

Modbus ID (slave address) 
Defined as 1 to 247 per the Modbus Application 

Protocol Specification (V1.1b) 
1 

16 bit 

Integer 
RW   0 00 

Data Format 
Data Format of the User Bus to the T80 (0-DF8N2, 1-

DF8O1, 2-DF8E1, 3-DF8N1) 
1 

16 bit 

Integer 
RW   1 01 

Baud Rate 
Baud Rate of the User Bus to the T80 (0-1200, 1-

2400, 2-4800, 3-9600) 
1 

16 bit 

Integer 
RW   2 02 

BusMessage 
total message count detected by the slave (remote 

device)  
1 

16 bit 

Integer 
R   3 03 

BusCommunicationsError total CRC error count 1 
16 bit 

Integer 
R   4 04 

SlaveExceptionError total count of exceptions detected 1 
16 bit 

Integer 
R   5 05 

SlaveMessage 
total messages addressed to the slave (remote 

device) 
1 

16 bit 

Integer 
R   6 06 

SlaveNoResponse 
total count of messages not responded to by the 

slave (remote device) 
1 

16 bit 

Integer 
R   7 07 

SlaveNAK 
 total Negative Acknowledges returned by slave 

(remote device)  
1 

16 bit 

Integer 
R   8 08 

SlaveBusy 
total count of "slave busy" was returned for an 

address message  
1 

16 bit 

Integer 
R   9 09 

BusCharacterOverrun 
count of messages that couldn't be handled due to 

character over-run condition 
1 

16 bit 

Integer 
R   10 0A 

Reset all Modbus Error 

Counters 

Resets all of the Modbus Error counters (defined in 

Modbus spec) to 0, Write any value. 
1 

16 bit 

Integer 
W   11 0B 

Product T80 Model Number 

(Modbus) 
The Model Number of the Unit polled 1 

16 bit 

Integer 
R   12 0C 

T80 Serial Number (hi word) 
Unit Serial Number (32 bit integer hi word, bytes 3 

and 2) 
2 

32 bit 

Long 

Integer 

R 
  

  

13 0D 

T80 Serial Number (lo word) 
Unit Serial Number (32 bit integer lo word, bytes 1 

and 0) 
14 0E 

T80 Mode 
Unit operating mode (1-Startup, 2-Sensor Search, 3-

Operate) 
1 

16 bit 

Integer 
R   15 0F 

T80 Fault Status Unit Fault flags, bit defined 1 
16 bit 

Integer 
R   16 10 

T80 2nd Fault Status 
Unit Fault flags (2nd word reserved, currently not 

used) 
1 

16 bit 

Integer 
R   17 11 

T80 Warning Status Unit Warning flags, bit defined 1 
16 bit 

Integer 
R   18 12 

T80 2nd Warning Status 
Unit Warning flags (2nd word reserved, currently not 

used) 
1 

16 bit 

Integer 
R   19 13 

T80 FW Rev Firmware revision of the Control BD in ASC, ex. " 1".  1 
16 bit 

Integer 
R   20 14 

Relay Number to read/write 
Relay number to access data (0 - Relay 1, 1 - Relay 2, 

2 - Relay 3) 
1 

16 bit 

Integer 
RW   21 15 

 Relay Type 
Read/Write Relay Type (0 - Fault Type, 1 - Alarm 

Type, 2 - Disabled, 3 - Timed) 
1 

16 bit 

Integer 
RW Y 22 16 
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Relay ON Setpoint (hi word) Read/Write Relay ON Setpoint (byte 3 and byte 2) 

2 

32 bit 

Floating 

Point 

RW Y 

23 17 

 Relay ON Setpoint (lo word) Read/Write Relay ON Setpoint (byte 1 and byte 0) 24 18 

 Relay OFF Setpoint (hi 

word) 
Read/Write Relay OFF Setpoint (byte 3 and byte 2) 

2 

32 bit 

Floating 

Point 

RW Y 

25 19 

 Relay OFF Setpoint (lo 

word) 
Read/Write Relay OFF Setpoint (byte 1 and byte 0) 26 1A 

 Relay ON Delay (hi word) 
Read/Write Relay turn on Delay time (byte 3 and 

byte 2) 
2 

32 bit 

Floating 

Point 

RW Y 

27 1B 

 Relay ON Delay (lo word) 
Read/Write Relay turn on Delay time (byte 1 and 

byte 0) 
28 1C 

 Relay OFF Delay (hi word) 
Read/Write Relay turn off Delay time (byte 3 and 

byte 2) 
2 

32 bit 

Floating 

Point 

RW Y 

29 1D 

 Relay OFF Delay (lo word) 
Read/Write Relay turn off Delay time (byte 1 and 

byte 0) 
30 1E 

 Relay Energized State Read/Write Relay 0 - Energized, 1 - De-Energized 1 
16 bit 

Integer 
RW Y 31 1F 

 Relay Expiration 
Read/Write Expiration Time, used with alarm type (0 

- None, 2 - 5min., 3 - 10min., 4 - 15min., 6 - 30min.) 
1 

16 bit 

Integer 
RW Y 32 20 

 Relay Period 
Read/Write Timed Relay Period (0 - 15min., 1 - 

30min., 2 - 1hr., 3 - 2hr., 4 - 4hr., 5 - 8hr., 6 - 24hr.) 
1 

16 bit 

Integer 
RW Y 33 21 

 Relay Duration 

Read/Write Timed Relay Duration (0 - 15sec., 1 - 

30sec., 2 - 1min., 3 - 2min., 4 - 5min., 5 - 15min., 6 - 

10min.) 

1 
16 bit 

Integer 
RW Y 34 22 

 Relay Hold Time 

Read/Write Timed Relay Hold Time (0 - Off, 1 - held 

for the duration time, 2 - duration + 15sec., 3 - duration 

+ 30sec., 4 - duration + 1min., 5 - duration + 2min., 6 - 

duration + 5 min., 7 - duration + 15min., 8 - duration + 

30min.) 

1 
16 bit 

Integer 
RW Y 35 23 

4-20 mA Channel Number to 

read/write 

4-20 mA channel number to access data (0 - 1st 4-

20mA, 1 - 2nd 4-20) 
1 

16 bit 

Integer 
RW Y 36 24 

4-20 Analog Type 
Read/Write 4-20 Type (0 - Range, 1 - Temperature, 2 

- Sentinel) 
1 

16 bit 

Integer 
RW Y 37 25 

4-20 Analog Range, 4mA 

range (hi word) 

Read/Write 4mA range (bytes 3 and 2) applies to 

both range and temperature types 
2 

32 bit 

Floating 

Point 

RW Y 

38 26 

4-20 Analog Range, 4mA 

range (lo word) 

Read/Write 4mA range (bytes 1 and 0) applies to 

both range and temperature types 
39 27 

4-20 Analog Range, 20mA 

range (hi word) 

Read/Write 4mA range (bytes 3 and 2) applies to 

both range and temperature types 
2 

32 bit 

Floating 

Point 

RW Y 

40 28 

4-20 Analog Range, 20mA 

range (lo word) 

Read/Write 4mA range (bytes 1 and 0) applies to 

both range and temperature types 
41 29 

Long Tag Line number to 

read/write 
Tag Line number to access data (0 - Line 1, 1 - Line 2) 1 

16 bit 

Integer 
RW Y 42 2A 

Long Tag Line 1 (16 

characters max) 

ASCII character bytes 0 and 1, ex. "AB" A - 65 (41 

hexadecimal), B - 66 (42 hex), send 6566 (4142 hex).  

The characters permitted are space ' ' (32 base 10, 20 

hex) through '}' 125 base 10, 7D hex). 

1 
16 bit 

Integer 
RW Y 43 2B 

Long Tag Line ASCII bytes 2 and 3 1 
16 bit 

Integer 
RW Y 44 2C 

Long Tag Line ASCII bytes4 and 5 1 
16 bit 

Integer 
RW Y 45 2D 

Long Tag Line ASCII bytes 6 and 7 1 
16 bit 

Integer 
RW Y 46 2E 

Long Tag Line ASCII bytes 8 and 9 1 
16 bit 

Integer 
RW Y 47 2F 

Long Tag Line ASCII bytes 10 and 11 1 
16 bit 

Integer 
RW Y 48 30 

Long Tag Line ASCII bytes 12 and 13 1 
16 bit 

Integer 
RW Y 49 31 

Long Tag Line ASCII bytes 14 and 15 1 
16 bit 

Integer 
RW Y 50 32 

Initiate T80 Parameter 

Storage 

Signals the user has completed entering the data and 

wants it stored.  Write any value. 
1 

16 bit 

Integer 
RW   51 33 

Sensor Channel to 

read/write 

Sensor channel number to access data (0 - Sensor 1, 

1 - Sensor 2) 
1 

16 bit 

Integer 
RW   52 34 

S80 Mode Unit operating mode (0- 1 
16 bit 

Integer 
R   53 35 
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S80 Serial Number (hi word) Unit Serial Number (32 bit integer hi word) 

2 

32 bit 

Long 

Integer 

R 
  

  

54 36 

S80 Serial Number (lo word) Unit Serial Number (32 bit integer lo word) 55 37 

S80 Fault Status   1 
16 bit 

Integer 
R   56 38 

S80 Sensor  Type Specific S80 sensor type (see S80 Sensor Types tab) 1 
16 bit 

Integer 
R   57 39 

S80 Sensor Chemical Type 
Specific chemicals the S80 is set to detect (see S80 

Sensor Types tab) 
1 

16 bit 

Integer 
RW Y 58 3A 

S80 Max Range (hi word)  Max sensor range (bytes 3 and 2) 
2 

32 bit 

Floating 

Point 

R 
  

  

59 3B 

S80 Max Range (lo word) Max sensor range (bytes 1 and 0) 60 3C 

S80 Min Range (hi word)  Min sensor range (bytes 3 and 2) 
2 

32 bit 

Floating 

Point 

R 
  

  

61 3D 

S80 Min Range (lo word)  Min sensor range (bytes 1 and 0) 62 3E 

S80 Sensor Value (hi word)  Current sensor value (bytes 3 and 2) 
2 

32 bit 

Floating 

Point 

R 
  

  

63 3F 

S80 Sensor Value (lo word) Current sensor value (bytes 1 and 0) 64 40 

S80 Sensor Voltage (hi 

word) 

Corresponding sensor voltage to the sensor value 

(byte 3 and byte 2) 
2 

32 bit 

Floating 

Point 

R 
  

  

65 41 

S80 Sensor Voltage (lo 

word) 

Corresponding sensor voltage to the sensor value 

(byte 1 and byte 0) 
66 42 

S80 Sensor Temperature (hi 

word) 
Sensor Temperature (bytes 3 and 2) 

2 

32 bit 

Floating 

Point 

R 
  

  

67 43 

S80 Sensor Temperature (lo 

word) 
Sensor Temperature (bytes 1 and 0) 68 44 

S80 Sensor is a Sentinel Sensor is a Sentinel Type (0 - No, 1 - Yes) 1 
16 bit 

Integer 
R   69 45 

S80 Sentinel Life % % of Sensor life remaining 1 
16 bit 

Integer 
R   70 46 

S80 Sentinel Vs (hi word) 
Scaled Sentinel Voltage (in mV) normalized to Vo  

(bytes 3 and 2) 
2 

32 bit 

Floating 

Point 

R 
  

  

71 47 

S80 Sentinel Vs (lo word) 
Scaled Sentinel Voltage (in mV) normalized to Vo   

(bytes 1 and 0) 
72 48 

S80 Sentinel Vo (hi word) 
Sentinel 100% value (in mV) on the life relative to 0V  

(bytes 3 and 2) 
2 

32 bit 

Floating 

Point 

RW Y 

73 49 

S80 Sentinel Vo (lo word) 
Sentinel 100% value (in mV) on the life relative to 0V  

(bytes 1 and 0) 
74 4A 

S80 Sentinel Range (hi word) Sentinel Range (bytes 3 and 2) 
2 

32 bit 

Floating 

Point 

RW Y 
75 4B 

S80 Sentinel Range (lo word) Sentinel Range  (bytes 1 and 0) 76 4C 

Sensor Full Name (18 

characters max) 

ASCII character bytes 0 and 1, ex. "AB" A - 65 (41 

hexidecimal), B - 66 (42 hex), send 6566 (4142 hex).  

The characters permitted are space ' ' (32 base 10, 20 

hex) through '}' 125 base 10, 7D hex). 

1 
16 bit 

Integer 
RW Y 77 4D 

Sensor Full Name ASCII bytes 2 and 3 1 
16 bit 

Integer 
RW Y 78 4E 

Sensor Full Name ASCII bytes 4 and 5 1 
16 bit 

Integer 
RW Y 79 4F 

Sensor Full Name ASCII bytes 6 and 7 1 
16 bit 

Integer 
RW Y 80 50 

Sensor Full Name ASCII bytes 8 and 9 1 
16 bit 

Integer 
RW Y 81 51 

Sensor Full Name ASCII bytes 10 and 11 1 
16 bit 

Integer 
RW Y 82 52 

Sensor Full Name ASCII bytes 12 and 13 1 
16 bit 

Integer 
RW Y 83 53 

Sensor Full Name ASCII bytes 14 and 15 1 
16 bit 

Integer 
RW Y 84 54 

Sensor Full Name ASCII bytes 16 and 17 1 
16 bit 

Integer 
RW Y 85   

Sensor Abbreviated Name (8 

characters max) 

ASCII character bytes 0 and 1, ex. "AB" A - 65 (41 

hexidecimal), B - 66 (42 hex), send 6566 (4142 hex).  

The characters permitted are space ' ' (32 base 10, 20 

hex) through '}' 125 base 10, 7D hex). 

1 
16 bit 

Integer 
RW Y 86 56 

Sensor Abbreviated Name ASCII bytes 2 and 3 1 
16 bit 

Integer 
RW Y 87 57 
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Sensor Abbreviated Name ASCII bytes 4 and 5 1 
16 bit 

Integer 
RW Y 88 58 

Sensor Abbreviated Name ASCII bytes 6 and 7 1 
16 bit 

Integer 
RW Y 89 59 

Initiate S80 Storage 
Signals the user has completed entering the data and 

wants it stored.  Write any value. 
1 

16 bit 

Integer 
W   90 5A 

Cal log number to read 
Cal log number to read (0 - Cal Log 1, 1 - Cal Log 2, 2 - 

Cal Log 3) 
1 

16 bit 

Integer 
RW   91 5B 

S80 Cal Log slope (hi word)  (bytes 3 and 2) 
2 

32 bit 

Floating 

Point 

R 
  

  

92 5C 

S80 Cal Log slope (lo word)  (bytes 1 and 0) 93 5D 

S80 Cal Log offset (hi word)  (bytes 3 and 2) 

2 

32 bit 

Floating 

Point 

R 
  

  

94 5E 

S80 Cal Log offset (lo word)  (bytes 1 and 0) 95 5F 

S80 Cal Log  offset Voltage 

(hi word) 
 (bytes 3 and 2) 

2 

32 bit 

Floating 

Point 

R 
  

  

96 60 

S80 Cal Log offset Voltage 

(lo word) 
 (bytes 1 and 0) 97 61 

FAULT STATUS 
Bit # bit meaning 

0 Memory Error, either a Program Flash, RAM or NVM RAM checksum error has occurred 

1 Input Voltage Out Of Tolerance 

2 The On Board +12V is Out of Tolerance 

3 The On Board +3.3V is Out of Tolerance 

4 The Transmitter has lost communication link with the Sensor 

5 There is no Sensor connected 

6 Sensor Calibration Failed 

7 Relay 1 on-time expired 

8 Relay 2 on-time expired 

9 Relay 3 on-time expired 

10 Sentinel Error (useable life has expired) 

11 Sentinel Poisoned 

12 Membrane Error 

13 NU 

14 NU 

15 NU 

WARNING STATUS 
Bit # bit meaning 

0 The Sensor has changed from previously connect Sensor 

1 Not Used (NU) 

2 NU 

3 NU 

4 NU 

5 NU 

6 NU 

7 NU 

8 NU 

9 NU 

10 NU 

11 NU 

12 NU 

13 NU 

14 NU 

15 NU 
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SENSOR TYPE 

Data Meaning 

Decimal Hexadecimal Chemical Sensor Type 

Measurement 

Units 

0 0000 

Unknown 

Chemical None None 

1 0001 Ammonia mV ppm 

2 0002 Ammonium mV ppm 

3 0003 Bromide mV ppm 

4 0004 Calcium mV ppm 

5 0005 Chloride mV ppm 

6 0006 Conductivity Conductivity S 

7 0007 Cupric mV ppm 

8 0008 Cyanide mV ppm 

9 0009 DO mV ppm 

10 000A DO mV % saturation 

11 000B DO mV mg/L 

12 000C Fluoride mV ppm 

13 000D Hardness (CaCO₃) mV ppm 

14 000E Nitrate mV ppm 

15 000F ORP mV mVa 

16 0010 pH mV none 

17 0011 Potassium mV ppm 

18 0012 Resistivity Conductivity Ohm (W) 

19 0013 Silver mV ppm 

20 0014 Sodium mV ppm 

21 0015 Sulfide mV ppm 

22 0016 Turbidity TR6 FNU 

23 0017 Turbidity TR6 NTU 

24 0018 Turbidity TR6 ppm 

25 0019 Turbidity TR6 mg/L 

26 001A Turbidity TR6 % solid 

27 001B DO DO80 ppm 

28 001C DO DO80 % saturation 

29 001D DO DO80 mg/L 

30 001E Calcium mV mg/L 

31 001F TDS Conductivity ppm 

32 0020 Nitrite mV ppm 

33 0021 TCA (max range) TCA mg/L 

34 0022 TCA (min range) TCA mg/L 

35 0023 FCA (max range) FCA mg/L 

36 0024 FCA (min range) FCA mg/L 
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E. SOFTWARE HISTORY 

Date Version Changes 

July 2012 Rev. A Initial Release 

Feb. 2013 Rev. B Conductivity Resistivity specifications added 

June 2013 Rev. C TRITON® DO80 and TR6 added 

July 2013 Rev. D Conductivity Resistivity Calibrations added 

July 2013 Rev. E MODBUS Register update 

May 2014 Rev. F  2 Channel addition, MODBUS Register update 
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Level Measurement
Continuous level measurement

Radar level transmitters

SITRANS LR100

4

■ Overview

SITRANS LR100 is a 2 wire loop powered radar transmitter for 
continuous level measurement of liquids and slurries to a range 
of 8 m (26 ft).

■ Benefits

• Bluetooth connectivity for easy setup with SITRANS mobile IQ 
• Chemically resistant PVDF enclosure
• W band FMCW radar yields narrow beam with small antenna 

for superior performance in short range applications
• Approved for open air applications outside of a tank
• Compact design fits in limited space installations

■ Application

SITRANS LR100 is a W band FMCW radar level transmitter, 
packaged in a hermetically sealed PVDF enclosure for years of 
trouble-free reliable measurement service. 

4 to 20 mA loop powered, it provides accurate level measure-
ment to ranges of 8 m (26 ft). Measurement is possible 
non-intrusively through plastic vessel tops for easy installation. 
Programming is convenient using the Bluetooth connection and 
SITRANS mobile IQ application on your smart device.

■ Technical specifications
Mode of operation

Measuring principle W band FMCW radar

Measuring range 0 ... 8 m (0 ... 26 ft)

Frequency 80 GHz nominal

Beam angle 8°

Power Supply

Voltage 12 ... 35 V DC

Current 4 ... 20 mA

Accuracy ± 5 mm

Rated operating conditions

Vessel pressure -1 ... +3 bar (14.50 ... 43.51 psi g)

Ambient temperature -40 ... +60 °C (-40 ... +140 °F)

Process temperature -40 ... +60 °C (-40 ... +140 °F)

Storage temperature -40 ... +80 °C (-40 ... +176 °F)

Design

Weight 0.5 kg (1.1 lb), plus 0.1 kg/m 
(0.2 lb/ft) cable length

Material (enclosure) PVDF

Process connection 1-½" NPT, 1-½" BSPT, or 
1-½" BSPP

Degree of protection IP66/IP68

Cable connection • 8 m (26 ft) long, 2 conductor, twist-
ed with shield 18 AWG, PVC jacket 

• 1" NPT or 1" BSPT threaded 
connection

Certificates and approvals General Purpose CE

Programming

SITRANS mobile IQ App SITRANS mobile IQ is a Bluetooth 
app that provides an intuitive inter-
face to quickly configure, set up and 
monitor SITRANS LR100 series.

For more information:
http://www.siemens.com/mobileIQ

© Siemens 2020
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Level Measurement
Continuous level measurement
Radar level transmitters

SITRANS LR100

4

■ Dimensional drawings

SITRANS LR100, dimensions in mm (inch)

■ Circuit diagrams

SITRANS LR100 connections

Selection and Ordering data Article No.

SITRANS LR100 Radar level transmitter
Continuous, non-contact, 8 m (26 ft) range, for 
liquids and slurries, integrated cable connec-
tion.

7ML530

7 - 1 A7 0 6 - 0 A A 0

Click on the Article No. for the online confi-
guration in the PIA Life Cycle Portal.

Process connection
1-½" NPT [(Taper), ASME B1.20.1]/electrical 
connection 1" NPT

A

R 1-½" [(BSPT), EN 10226]/electrical 
connection 1" BSPT

B

G 1-½” [(BSPP), EN ISO 228-1]/electrical con-
nection 1" BSPT

C

Selection and Ordering data Order code

Further designs
Please add "-Z" to Article No. and specify Order 
code(s).

Tag (device parameter, max. 32 characters) 
plate stainless steel 304/1.4301

Y15

Operating Instructions

All literature is available to download for free, 
in a range of languages, at http://www.sie-
mens.com/processinstrumentation/documen-
tation

Accessories Article No.

Easy Aimer 2, aluminum, NPT with ¾" x 1" 
PVC coupling

7ML1830-1AQ

Easy Aimer 2, aluminum with M20 adapter 
and 1" and 1½" BSPT aluminum couplings

7ML1830-1AX

Easy Aimer 304, NPT with 1" stainless steel 
coupling

7ML1830-1AU

Easy Aimer 304, with M20 adapter and 1" and 
1½" BSPT 304 stainless steel couplings

7ML1830-1GN

FMS-200 universal box bracket, mounting kit 7ML1830-1BK

FMS-210 channel bracket, wall mount 7ML1830-1BL

FMS-220 extended channel bracket, wall 
mount

7ML1830-1BM

FMS-310 channel bracket, floor mount 7ML1830-1BN

FMS-320 extended channel bracket, floor 
mount

7ML1830-1BP

FMS-350 bridge channel bracket, floor mount
(see Mounting Brackets on page 4/186 for 
more information)

7ML1830-1BQ

1" NPT locknut, plastic 7ML1830-1DS

1" BSP locknut, plastic 7ML1830-1DR

Plastic adapter 1" BSP - 20 mm 7ML1830-1EA

Plastic adapter 1" NPT 7ML1930-1FX

Plastic adapter 1" NPT/M20 7ML1830-1EF

SIMATIC RTU3010C compact, remote data 
manager with alarming

6NH3112-0BA00-
0XX0

SIMATIC RTU3030C compact, remote data 
manager with alarming

6NH3112-3BA00-
0XX0

Selection and Ordering data Article No.

SITRANS RD100, loop powered display - 
see Chapter 7

7ML5741-.....-.

SITRANS RD150, remote digital display for 
4 to 20 mA and HART devices - see Chapter 7

7ML5742-.....-....

SITRANS RD200, universal input display with 
Modbus conversion - see Chapter 7

7ML5740-.....-..

SITRANS RD300, dual line display with total-
izer and linearization curve and Modbus con-
version - see Chapter 7

7ML5744-.....-..

For applicable back up point level switch - 
see point level measurement section

76.0

35.7

23.3

132.2

(1.40)

(5.20)

(0.95)

(3.0)

1" NPT, 1" BSPT 

1 1/2 NPT
BSPT
BSPP

12 ... 35 V DC
4 ... 20 mA
Loop powered

WHT
BLK

SHIELD
+

HART

© Siemens 2020
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